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Pinnacle End User License Agreement

This End User License Agreement ("License") is a legal agreement between you and Pinnacle Systems ("Pinnacle") regard-
ing Pinnacle's software and the accompanying documentation  (collectively, the "Software").  CAREFULLY READ THE 
FOLLOWING LICENSE. USING THIS SOFTWARE INDICATES YOUR ACCEPTANCE OF THIS LICENSE.  IF YOU 
DO NOT ACCEPT OR UNDERSTAND THE TERMS OF THIS LICENSE, YOU SHOULD NOT INSTALL THE SOFT-
WARE AND SHOULD PROMPTLY RETURN THIS PRODUCT TO THE PLACE OF PURCHASE..

1 License Grant.  Subject to the restrictions set forth below, this License grants you a non-exclusive, perpetual license 
to (a) install the Software on only one computer; (b) use or authorise use of the Software on only one computer; (c) 
make one copy of the Software, in machine-readable form, solely for backup purposes; provided you include all 
copyright and other proprietary rights notices on the copy and (d) transfer the Software and this License to another 
party if the other party agrees to accept the terms and conditions of this License.  If you transfer the Software, you 
must at the same time either transfer all copies to the same party or destroy any copies not transferred.  If you trans-
fer possession of any copy of the Software to another party, your License is automatically terminated.  Some features 
of the Software may be locked and require that you activate, either for free or subject to payment of additional 
license fees, the features before you may use them.  Additionally, Pinnacle may, either for free or subject to payment 
of additional license fees, grant  you a license for plug-ins to the Software produced or distributed by Pinnacle (the 
"Plug-ins").  Your use of any such features and any of the Plug-ins shall be subject to the terms of this Agreement, 
unless accompanied by another license agreement, in which case the Plug-ins license agreement shall prevail.  

2 License Restrictions.  You may not, or allow any third party to, (a) rent, lease, sell, loan or otherwise transfer the 
Software or any of your rights and obligations under this License; (b) install the Software on a network for use by 
multiple users, unless each user has purchased a license; (c) reverse-engineer, decompile or disassemble the Soft-
ware or hardware in whole or in part; (d) remove or destroy any copyright notices or other proprietary markings of 
the Software or any third-party software; (e) modify or adapt the Software, merge the Software into another pro-
gram or create derivative works based on the Software; (f) make copies of or distribute, for profit or otherwise, the 
Software, except as expressly provided above; (g) make any alteration, modification, connection, disconnection, 
improvement or adjustment of any kind to or use the Software except as explicitly contemplated in the enclosed 

documentation and in this License and (h) sublicense, transfer or assign this License or any of the rights and obliga-
tions granted under this License, except as explicitly contemplated in this License.  Any purported transfer or 
assignment will be void.  License Restrictions for Dolby Digital 5.1 Creator.  You may not use the Dolby Digital 5.1 
Creator technology to encode content that you intend to distribute commercially.



3 Export Restrictions.   The export and re-export of Pinnacle software products are controlled by the United States 
Export Administration Regulations and such software may not be exported or re-exported to any country to which 
the United States embargoes goods.  In addition, Pinnacle software may not be distributed to persons on the Table 
of Denial Orders, the Entity List, or the List of Specially Designated Nationals.  By downloading or using a Pinnacle 
software product you are certifying that you are not a national of any country to which the United States embargoes 
goods and that you are not a person on the Table of Denial Orders, the Entity List, or the List of Specially Desig-
nated Nationals.  

4 Ownership.  The license granted hereunder does not constitute a transfer or sale of ownership rights in or to the 
Software.  Except for the license rights granted above, Pinnacle retains all rights, title and interest in and to the Soft-
ware including all intellectual property rights therein.  The Software is protected by applicable intellectual property 
laws, including United States copyright laws and international treaties.  

5 Third Party Proprietary Property.  This Software may contain the proprietary property of others, which has been 
licensed to Pinnacle.  Your use of the Software is expressly subject to your agreement not to remove any copyright 
notices or other proprietary markings of the third party software.  

6 Security.  You acknowledge and agree that in order to protect the integrity of certain third party content, Pinnacle 
and/or its licensors may provide for Software security related updates that will be automatically downloaded and 
installed on your computer.  Such security related updates may impair the Software (and any other software on your 
computer which specifically depends on the Software) including disabling your ability to copy and/or play "secure" 
content, i.e. content protected by digital rights management.  In such an event, Pinnacle and/or its licensors shall 
use reasonable efforts to post notices promptly on Pinnacle's web site explaining the security update and providing 
instructions to end-users for obtaining new versions or further updates of the Software that restore access to secure 
content and related features.

7 Updates.  You acknowledge and agree that Pinnacle may automatically check the version of the Software and/or its 
components that you are using and may provide updates or fixes to the Software that may be automatically down-
loaded to your computer.  Updates provided after the expiry of the Limited Warranty period set forth in Section 9 
below are not covered by any warranty, express, implied, or statutory.

8 Term and Termination.  This License shall be effective upon installation of the Software and shall terminate upon 
the earlier of (a) your failure to comply with any term of this License; (b) return, destruction or deletion of all copies 
of the Software in your possession or (c) transfer of the Software and this License to another party in accordance 
with Section 1(d).  Pinnacle's rights and your obligations shall survive termination of this License.  

9 Limited Warranty.  Pinnacle warrants to the original licensee that the Software, as delivered, will perform in accor-
dance with the accompanying documentation for a period of 30 days from the date of the original purchase ("Lim-

ited Warranty").  Pinnacle's entire liability and your exclusive remedy for breach of the preceding Limited Warranty 
shall be, at Pinnacle's sole option, repair or replacement of the Software that does not meet the warranty set forth 
herein and that is returned to Pinnacle.  This limited warranty shall be void if failure of the Software has resulted 
from any accident, abuse, misuse or misapplication by you.  Any replacement Software will be warranted for 30 
days.  



10 NO OTHER WARRANTIES.  EXCEPT AS SET FORTH ABOVE, THE SOFTWARE IS PROVIDED ON AN "AS 
IS" BASIS.  YOU ASSUME ALL RESPONSIBILITIES FOR THE QUALITY AND PERFORMANCE OF THE 
SOFTWARE.  TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, PINNACLE DISCLAIMS 
ALL WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WAR-
RANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.  
THE LICENSOR DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL 
MEET YOUR REQUIREMENTS, BE UNINTERRUPTED OR ERROR FREE.  

11 LIMITATION OF LIABILITY.  YOU AGREE THAT IN NO EVENT WILL PINNACLE BE LIABLE FOR ANY 
CONSEQUENTIAL, SPECIAL, INDIRECT, INCIDENTAL OR PUNITIVE DAMAGES WHATSOEVER, EVEN IF 
PINNACLE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  IN NO EVENT SHALL PIN-
NACLE'S LIABILITY EXCEED THE TOTAL AMOUNT OF THE FEES PAID FOR THE SOFTWARE. Some states/
jurisdictions do not allow the limitation or exclusion of incidental or consequential damages in certain circum-
stances, so the above limitations may not apply in some circumstances.  

12 General.  This License is governed by the laws of the State of California and by the federal laws of the United States, 
without reference to conflict of laws principles.  The federal and state courts within the County of Santa Clara, Cali-
fornia shall have exclusive jurisdiction to adjudicate any dispute arising out of this License and you hereby consent 
to the personal jurisdiction of the federal and state courts within the County of Santa Clara, California.  This 
License is the entire agreement between you and Pinnacle and supersedes any other communication with respect to 
the Software.  No modification of or amendment to this License will be effective unless in writing signed by both 
parties.  If any provision of this License is held invalid or unenforceable, the remainder of this License will continue 
in full force and effect. 
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PINNACLE
Pinnacle Liquid Version 6.x represents an important step forward, bringing with it a new look and a variety of 
new functions. Pinnacle Liquid 6 is HD-capable, permits multicamera editing, project backup and restoration 
and much, much more.

This document provides an overview of all the innovations.

Manuals and online help  page N-3

Software user interface and general improvements  page N-4

High definition: Beyond NTSC and PAL  page N-5

Logging Tool and Batch Digitize  page N-6

Exchanging and importing media files and project data  page N-7

Project management  page N-8

Editing  page N-11

Effects  page N-13

Audio postproduction and audio effects  page N-14

Networking  page N-17

Titler  page N-17

Output (DVD, tape, etc.)  page N-18

Settings  page N-20

Recommendation: Complete any current or important Projects in your existing version before installing 
the new version. Projects in Version 6 can no longer be opened in Version 5.x (or earlier). 
See also “Project and Version Compatibility” on page N-8.
Be sure to read the ReadMe file on this version, which describes the latest additions to the manual and 
to this document (Windows Start menu > Programs > Pinnacle Liquid > Help).

Some of the innovations introduced here will already be familiar to Version 5.6x users. We have 
included them because Liquid Edition users skip Version 5.6x when upgrading to 6.
Volume II New in Version 6N - 2
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Manuals and Online Help

The Reference Manual has been restructured for Version 6. Several new chapters have been added (such as 
“High Definition”) and existing longer chapters have been subdivided. The Reference Manual is the same for all 
products running under Pinnacle Liquid.
The Product Manual, on the other hand, is product-specific (for example, Liquid Edition). If you don’t see 
a particular topic such as system settings in the Reference Manual, look for it in the Product Manual. Online 
Help and Online PDF (both accessed by pressing F1) contain the exact same information as the Reference 
Manual.
The User’s Guide was also updated for Version 6. 
Volume II New in Version 6 N - 3
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Software User Interface and General Improvements

� Creating long Sequences on the Timeline is now much faster.

� Software startup for large Projects (checking media data) is also much faster.

User Interface Design

� The user interface has a more modern and brighter appearance. The tool buttons stand out more clearly 
from the background.

If you want to continue working with the old familiar user interface and Start menu, start Pinnacle Liq-
uid by selecting Windows Start menu > Programs > Liquid 6 (classic). 

� Red borders around the Master Viewer or Source Viewer Inlay indicate the area that is currently active.

� In the redesigned Project Browser, you can choose between the Library (effect) tab and the available 
Racks and Rack Folders.

� The effect lines on the clips are wider and easier to click on.

Menu Bar

� Pinnacle Liquid 6 has a Windows-standard menu bar with the usual menu options, including File, Edit, 
View, etc. The selection sequences in the manuals are based on this menu bar: File > New > Project. 
Many functions and modules can be accessed in two different ways: Via a shortcut menu (as before) and 
via a menu bar.

� When you select a function from the menu bar, an information line is displayed on the taskbar that 
briefly describes the particular function.

For Beginners: Input and Output Wizards

The Input and Output Wizards were specially developed for novice Pinnacle Liquid users who want to get right 
down to work.
The Wizards guides you directly to the correct modules (for example, to the Logging Tool when you want to 
capture a video).

� Menu bar > File > Input Wizard/Output Wizard
Volume II New in Version 6N - 4
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High Definition: Beyond NTSC and PAL

High definition TV (HDTV) is one of the main themes of Pinnacle Liquid 6.

� Reference Manual, Chapter 5, High Definition

Importing, Editing and Outputting HDV

The prosumer HD format HDV can be imported and output via an IEEE-1394 port (also MicroMV and D-
VHS). 

� Logging Tool, Record to Tape

� Before output, select Menu bar > Edit > Settings > Site > System or Player Settings > Inputs / Outputs tab 
> Video outputs > IEEE 1394 to adapt the MPEG output format to the recording device.

Multiformat in a Project and on the Timeline

� Pinnacle Liquid can handle clips in all existing formats in a Project and on the Timeline (PAL, NTSC, 
HD). On the Timeline, HD clips (MPEG2) can be mixed with SD clips and edited as usual.

� You can import and edit HD formats that cannot (yet) be captured directly.

HD effects

You can apply realtime effects to HD(V) clips. The effect editors automatically adapt to the format and frame 
rate. All the other effect editors and special effects (Color Correction, Timewarp) can also be used with HD 
material.

TC Systems and TC Displays

In the software timecode displays, the characters “, ; . :” (comma, semicolon, period and colon) are used in dif-
ferent positions to indicate the clip’s timecode system. For example:
00:00.00;00 (HDV 1080 60i)
Eleven different timecode systems are possible with SD and HD, based on the large number of frame rates (fps).

� All TC displays (including Logging Tool, Master Viewer, Source Viewer, etc.)

� Chapter 5, High Definition, Timecode Systems
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Logging Tool and Batch Digitize

Codecs/Media Formats

When using analog inputs, users of Liquid Edition  can now also choose from among a large number of 
capture formats (codecs): In addition to DV(DIF) and DV(AVI), these also include DVCPro25, MPEG2 IPB 
and uncompressed.

Codec presets can be configured to match individual presets.

� See Chapter 6, Input, Selecting a Media Forma/Codec 
and Chapter 8, Administration, System Formats and Codecs in Pinnacle Liquid

New Functions in the Logging Tool

� Multicam Capture -
Captures sources with identical TCs (also see “Multicamera Editing”  on page N-11).

� RapidCapture -
Starts the capture procedure as soon as the video input signal is stable.

� Auto 3pt -
Captures a clip and inserts it directly on the Timeline with exactly the right length (mark-in/out).

� Video Tool: VCR -
Option for capturing poor audio signals (such as old VHS).

� Logging Tool Options -
Rearrangement of options.

� See Chapter 6, Input, Options.

� Media tab -
Choice of Quality Ranks (for more on this topic, see the chapter on High Definition)

� Audio Playback display -
Up to four level bars((+++scales?)) for up to four incoming audio signals.

Batch Digitize: Audio and Media Tabs

Both the Media and Audio tab are present, just like in the Logging Tool.
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Exchange and Import of Media Data and Project Data 

� All topics related to exchange are described in Chapter 7: “Exchange”.

Importing Data from Pinnacle Studio

You can import Timelines from Pinnacle Studio 9.3 to Pinnacle Liquid.

� For more information, refer to the ReadMe file.

Exchanging Project Data in XML and XCE

� In addition to exchanging Projects in the ALE standard, there is now an XML-standard interface for 
both Projects and individual clips (XCE).

� Batch Lists, Shot Lists -
The transfer of Project data based on standard ALE lists (such as logging lists) to other applications is 
described.

� Menu bar > File > Import/Export > XML, ALE

XReceive and XSend to...

� XReceive -
This function is now also possible with SONY XDCAM (ftp and browser), SONY eVTR (ftp) and 
Panasonic P2.

� XSend to ... -
... Location: Two new options for saving data under specific names or with metadata.

� Menu bar > File > XReceive; XSend to ... (shortcut menu; object-specific dialog boxes)

New Import Formats

The existing formats are joined by:

� MPEG formats -
*.mpg, *.mpeg, *.ts and *.vob

� Windows media; *.wmv (video)

� and audio/video files inside an *.mxf wrapper.

� Menu bar > File > Import > Media
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Project Management

Project and Version Compatibility

As soon as you upgrade to Version 6, the following applies:

� Projects from Version 5.6x (or earlier) are converted to Version 6. A dialog box is displayed asking 
whether you want to retain a backup copy of the Project to be opened. The backup copy retains the old 
version.
If in doubt, click Yes.

� Projects in Version 6 cannot be opened or edited in Version 5.6x (or earlier).

As a general rule, we advise you to complete Projects in one version; do not upgrade Pinnacle Liquid to 
the new version until you have finished.

Backing Up and Restoring Projects

This function lets you back up or restore entire Projects, including media files and render files. You can back 
them up directly on CD or DVD and can select the individual components to be backed up (for example, 
Project data only).

� Menu bar > File > Manage Projects > ...

� See Chapter 8, Administration, Backing Up and Restoring Projects.

Finding and Importing Media Files

This function combines a powerful search tool with the possibility of importing the media files found directly 
into a Project. It sorts the clips by the categories Video, Audio and Image and stores them in Racks of the same 
name.

� Menu bar > File > Import > ...

� See Chapter 8, Administration, Media Management / Finding and Importing Media Files.

Editing Multiple Clips Simultaneously

Specific clip Properties, such as the clip Name or video/audio Source Tracks, can be modified for multiple clips 
in a single step. This applies to clips in Racks as well as to Timeline clips.

� Select multiple clips > Shortcut menu for one of the clips > Properties
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Marking Clips Used on the Current Timeline in the Project

In the Picon View, a checkmark appears above the image; in the Detail View, the value Yes appears in the Used 
column.

� Menu bar > Edit > Settings > User > Project Properties > Mark clips used in current sequence

Media Management

The HD capabilities of Pinnacle Liquid 6 have resulted in several changes to media management. With the pos-
sible exception of the codec presets, however, these changes will not affect the daily editing tasks of most users.

C o d e c  S e t t i n g s

Users now have a great deal of freedom when creating video data. Codecs (such as DV and MPEG2) can be 
combined with certain file formats (*.avi, *.mxf, etc.). Frame rates can be set for I-frame MPEG, (such as 25 
Mbit/s).

The presets can be saved individually and retrieved in the Logging Tool. Naturally, native transfer (DV-DIF, DV-
AVI) continues to be possible.

� Menu bar > Edit > Settings > Site > Codec Presets

� See Chapter 8, Administration, Media Management / System Formats and Codecs in Pinnacle Liquid

C o p y i n g  M e d i a  F i l e s  t o  O t h e r  M e d i a ,  I n c l u d i n g  L o c a l

Media files that appear on the Media tab in the Project window can be copied to a local medium or another net-
work medium (optionally with clip generation). The destination medium is defined in the Media Management 
Settings.

� Project window, Media tab > Shortcut menu > Copy selected media to capture volume

� See Chapter 8, Administration, Media Management / Media Tab in the Project Window /Media Files: 
Functions

I m p o r t  P a t h

In addition to the Primary Media Directory (for storing capture data), Pinnacle Liquid’s Media Management 
Settings now also manage an import directory to which external files (e.g. files accessible via the network) are 
copied or moved.

� Menu bar > Edit > Settings > Site > Media Management Settings

� See Chapter 8, Administration, Media Management / Media Management Settings
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F i l e / R e e l  N a m e s

The reel path and file names assigned by Media Management in Version 6 differ from those assigned in Version 
5.6x and earlier.

� For example, recognizable in the clip Properties, V tab, information on the name of a media file

� See Chapter 8, Administration, Media Management / Basics / Naming of Media Files

F o r m a t  R a n k i n g

This tab in the Media Management Settings is especially important in larger networked installations of Pinnacle 
Liquid where identical media files (“offline/online”) are circulated in different file formats.

� Menu bar > Edit > Settings > Site > Media Management Settings

� Chapter 8, Administration, Media Management / Media Management Settings, Format Ranking
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Editing

Matte Tracks and Subtracks
� Subtracks 

Subtracks are configured as subunits of Timeline Tracks. Subtracks can be displayed or hidden as 
desired by clicking the plus or minus sign and they help to achieve clarity when setting up complex 
Timelines.

� Matte Tracks 
Matte tracks are a special type of subtrack with an integral sensitivity to an alpha level in the clip. They 
eliminate the need for an additional Track Matte effect or key. The key and fill areas of the image are 
assigned automatically. The resulting matte effects can also be animated.

� Chapter 9, Edit, Special Functions / Matte Track and Track Matte
and, in the same chapter, Basics / Configuring Tracks

� Timeline header > Shortcut menu for Name area > Add Matte Track/Sub Track

Multicamera Editing
Using the MulticamSync command or in the Logging Tool, up to 16 video clips or video tapes can be synchro-
nized (ganged) and played simultaneously in the Source Viewer. The “multicam clip” produced by this synchro-
nization can in turn be ganged with video on the Timeline.

This allows you to cut synchronously from one video source to another (Cameras 1 to 16) at any time, includ-
ing directly on the Timeline. The tapes do not necessarily have to have identical timecodes for multicam editing.

� Chapter 9, Edit, Special Functions / Multicamera Editing

� Menu bar > Project > [or Rack shortcut menu >] MultiCamSync; Logging Tool > Multicam Capture; Mul-
ticam functions in the Source Viewer; Shortcut menu for a Timeline Multicam Clip.

Creating a New Sequence: Options
As a result of the HD capabilities of Pinnacle Liquid 6, the New Sequence function is now a dialog box with all 
sorts of options. However, PAL and NTSC editors can continue simply selecting PAL or NTSC, while HDV 
enthusiasts can select one of the preset Timeline formats that goes with the prevalent clip material in the Project. 
Specialists can create an individual format using various parameters, such as Frame rate and Resolution.

This dialog box (also accessible from the Timeline Properties) is the switching center for the available render 
and Fuse formats. Timeline Layouts can also be accessed here.

� Chapter 9, Edit, Sequence Editor / Sequence / New Sequence

� Menu bar > File > New > Sequence or click the usual button; Timeline Properties
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HD (MPEG2) Editing on the Timeline/Mixed Sequences

HD clips and generally all MPEG2-IPB clips can be edited frame by frame on the Timeline and combined with 
clips in other formats

Source Timecode

The Track Header’s name area indicates the timecode of a clip at the current Timeline Playline position.

� Chapter 9, Edit, Basics / Adjusting All Tracks / View

� Menu bar > Timeline > [or Timeline header > Shortcut menu for Name area >] View > Source timecode

4-Point Editing (Auto-Timewarp)

If the distance between the mark-in and mark-out in the Source Viewer differs from the distance between the 
mark-in and mark-out on the Timeline, an inserted clip is immediately and automatically edited with a Linear 
Timewarp, meaning that it is either shortened or lengthened. The same applies to the clip’s audio component.

Additional Functions and Changes

� Zoom Control (timeline zoom) -
The existing slider was replaced by a more finely adjustable version (more levels).

� Additional options in the Timeline Properties -
For example, Show Dupes during Trim; extended Sync Break display; with Match Frame, a mark-in can 
also be set at the Playline position.

� Deactivate/Activate All -
Simultaneously toggles all Timeline Tracks between active and inactive (click column header)

� Source Viewer/Master Viewer: Sorting lists -
Expanded options for sorting the loaded clips or Sequences (right-click on list box).

� High/Low Quality function -
The button was eliminated from the user interface and the function taken from the Q menu.

� Trim Editor: New option -
New option in the Properties relating to the display of edits with effects.

� Goto next/previous edit -
Applies only to edits on active tracks.
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Effects

New Effect Editors for CPU/GPU Realtime Effects

� The most important innovation here is the parameter curves. Each parameter (such as Size) can be 
edited independently of the other parameters using separate Key Frames. The Key Frames are linked 
either by a Bezier curve or by a line.

� You can selectively show or hide parameter curves as well as edit them using a variety of options, 
including moving and reshaping them directly by means of the mouse.

� Project Library tab > Realtime Clip FX and Realtime Transition FX > Editors

� Chapter 11, Realtime FX / Functions and Parameters of the Effect Editors (Non-Classic)

Applying Clip Effects to Entire Tracks

� Simply drag the effect to the name of a Track. The purple effect line appears. Right-click this line to open 
the effect editor. The effect is applied to all the clips on this Track (including subtracks).
Audio effects can be applied in the same way.

Additional Effect-Related Innovations

� The Classic 2D and Classic 3D Editors were ported along with all their parameters (except Trailing) 
based on realtime CPU (2D and 3D CPU).

� The quality of 3D realtime effects has been improved.

� Processing separated by channels (channel processing: R,G,B, Alpha) for effects that support it (such as 
Blur and 2D CPU).

� Blur CPU and Mosaic CPU now have a cropping parameter that can be used to render image areas uni-
dentifiable (“privacy FX”).

� Advanced quality settings for CPU effect editors (Options tab).
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Audio Postproduction and Audio Effects

ASIO 2.0

Pinnacle Liquid 6 supports ASIO, the professional audio driver standard. For multichannel output (more than 
two audio channels, 5.1/7.1 surround), you must have a sound card that is compatible with the ASIO 2.0 stan-
dard (or a suitable breakout box). Naturally, you can continue to use your existing sound card but you will be 
limited to two channels.

� Chapter 14, Audio, Basics / ASIO Driver Standard

� Menu bar > Edit > Settings > Site > System or Player Settings > Inputs/Outputs > Audio Outputs > ASIO 
Output 

Audio Editor

The Audio Editor has been entirely reworked, including its Mixer, Output Mapping and Settings components:

M i x e r

The central module of the Audio Editor now offers:

� The assignment of Fader Units by means of Audio Playback On/Off (loudspeaker icon in the Track Hea-
der). Each Track activated for Audio Playback is assigned a separate fader.
Any number of faders (= mixer channels) possible.

� Track-specific faders possible for audio levels and panorama/balance (i.e. for all the clips on a Timeline 
Track). (It is also still possible to adjust clips individually.)

� A peak meter for each Fader Unit; faders can be toggled between sliders and knobs.

� Mixer configuration can be customized (for example, switchable audio faders before/after SendFX/
InsertFX section.

� Each individual Fader (channel) can be routed to a Logical Output Bus.

� Multiple Logical Output Busses are possible.

� Insert and send effects are possible (see below).

� Different fader types are identified by color.

� Chapter 14, Audio, Audio Editor / The Audio Mixer

� Audio Mixer; accessed by clicking Timeline icon or pressing F4.
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S e n d  E f f e c t s / I n s e r t  E f f e c t s

� Up to 16 audio effects can be inserted (therefore “insert effects”) directly into the signal path of each 
Fader Unit (channel).

� Signals from different channels can be fully or partially diverted in the fader and routed to send busses 
where they are processed with identical effects. SendFX Busses (multiple possible) can be routed to dif-
ferent Logical Output Busses.

� Insert effects are VST-compatible effect plugins (see below).

� All audio effects can also be applied directly to a Track (drag and drop on a Track name).

� Chapter 14, Audio, Audio Editor / Working with Insert Effects, Send Effects and Busses

� Audio Mixer; accessed by clicking Timeline icon or pressing F4. (Insert/Send FX segment on the Settings 
tab of the Audio Editor.)

O u t p u t  M a p p i n g  a n d  C l a s s i c  R o u t i n g
The redesigned Output Mapping serves to assign audio signals to actual system outputs (physical outputs on 
the connection box, sound card/chip, IEEE 1394/SDI-embedded, and virtual, such as Fuse audio files). All 
existing outputs in the system can be linked to Logical Output Busses.

To maintain compatibility with older versions, the earlier Audio Routing continues to be available in its previous 
form as Classic (A1 to A4) Routing but must be activated on a case-to-case basis.

� Chapter 14, Audio, Audio Editor / Output Mapping: Assigning Signals

� Output Mapping tab; in the Audio Editor, accessed by clicking Timeline icon or pressing F4.

Audio Timewarp
Audio clips, which were previously excluded from Timewarp, can now also be accelerated or decelerated in real 
time while the pitch remains the same. Computation can be optimized for voice or music.

� Chapter 13, Special FX, Linear Timewarp and Timewarp Editor

� Timeline clip (shortcut menu) > Linear Timewarp > Audio Computation

Compatibility with VST Plugins 
Audio effect plugins based on the popular VST standard are compatible with Pinnacle Liquid 6 and, if desired, 
can be integrated in the program.
Version 6 comes already equipped with about a dozen VST plugins. These plugins can, as usual, be used as 
audio clip effects, but they can also be used as Insert effects in the Audio Mixer.

� Chapter 14, Audio, Audio Effects / Pinnacle Liquid Plugin Audio Effects (VST) 

� Library tab > Realtime Clip FX > Audio; Audio Mixer with Insert/SendFX segment: right-click > effect 
list
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Surround Sound 5.1 / Matrix Surround

Pinnacle Liquid Version 6 lets you produce genuine 5.1 surround sound mixes and output these mixes - pro-
vided you have an ASIO-2.0-capable multichannel sound card or a connection box with enough outputs in the 
system. If not, you can use the integrated Matrix Surround Encoder to create an impression of spatial sound in a 
two-channel stereo downmix that can be played by virtually any state-of-the-art surround system.

� Assignment of surround channels (Left, Right, Center, Left Surround, Right Surround) in the Audio 
Mixer’s Surround Panner.

� LFE (Low Frequency Subwoofer) adjustable for each individual channel.

� Display of room position on the Timeline using special Surround Pan Lines.

� Creation of DVDs with AC3 (Dolby Digital) and Matrix Surround Sound is possible.

� Export of Matrix Surround (stereo downmix) by means of Export Sequence...

� Audio Mixer with channels routed to Surround 5.1 Bus; Export > DVD, (S)VCD > Destination tab > Vir-
tual Surround; Export > Sequence > Audio > ...

� Chapter 14, Audio, Audio Editor / Surround 5.1 Sound; Chapter 17, Output, Exporting Sequences; 
Export to VCD, SVCD, DVD
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Networking

If Pinnacle Liquid is installed several times within the same network, exciting possibilities are available for 
cooperation. For example, tapes can be captured on a central storage medium at one station while editing 
already begins at another station. Pinnacle Liquid has two new functions that support such cooperative Pro-
jects:

Intercom

Intercom is a compact tool that allows Liquid editors registered in a joint workgroup to exchange messages.

� On the Pinnacle Liquid Taskbar, icon with two heads; double-click to open a dialog box.

� Chapter 7, Exchange, Networking with Pinnace Liquid/InterCom for editors sharing a common project

Sharing projects

Two or more users can work on the same Project simultaneously. It is recommended that you use the Intercom 
function described above to coordinate your efforts. Another function, which can be assigned to a key on the 
keyboard, serves to refresh the Project viewer.

� Refresh Project Viewers function (for details, see manual)

� Chapter 7, Exchange, Networking with Pinnace Liquid / Shared Projects

Titler

The procedure using the F11 and F12 keys no longer exists. Title graphics are now simply saved in the Rack. 
TitleDeko remains open until you choose to exit the application.

� Menu bar > Tools > CG Editor; in TitleDeko: File > Save as new in Liquid (CTRL-E)

� Chapter 15, Titler, Saving Title Graphics, etc.
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DVD Authoring

� Transparent menu background -
The background of a DVD menu can be rendered fully transparent with the click of a button.

� DVD Editor’s function library, Editor tab (button with checkerboard pattern)

� Set return marker with AutoLink -
Added to the AutoLink options; a return marker to the menu is also set for each link.

� Menu bar > Tools > DVD > Editor > Options tab

� Chapter 16, DVD Authoring, DVD Authoring: Reference / Options tab

Output (DVD, Tape, Etc.)

Export to DVD, (S)VCD, Etc.

� Improved and faster MPEG encoder,

� I-frame-only export selectable in the IPB Settings by means of a single click,

� Standard file format for DVD images: *.iso (instead of *.img), achieving greater compatibility with soft-
ware DVD players, *.psd for (S)VCD,

� Audio files can now be generated as AC3 (Dolby Digital),

� Up to 99 titles per disk, up to 99 chapters per title,

� Extended audio bit rates (64 to 448 kbps),

� Editable volume name,

� HD support for advanced profile/level and bit rate settings (422P@HL, MP@HL, 422P@ML, MP@ML; 
422 optional),

� plus the functions described below:

B u r n  D i r e c t o r y  P a t h  t o  a  C D  o r  D V D

Used, for example, to save media data directly to a disk medium. This function is also used by Project Backup.

� Menu bar > File > Export > DVD, (S)VCD > Source and Destination tabs

� Chapter 17, Output, Export to VCD, SVCD, DVD / Source tab
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B u r n  M i n i - D V D s

Provided you have a compatible burner, you can also use Version 6 to burn mini-DVDs (1.46 Gbytes or 2.92 
Gbytes with double-sided medium).

B u r n  D u a l - L a y e r  D V D s

Provided you have the correct hardware, you can also burn double-sided DVDs and CDs (including 8.5-Gbyte 
media). Pinnacle Liquid 6 detects and uses the available capacity.

5 . 1  M a t r i x  S u r r o u n d  a n d  D o l b y  D i g i t a l  A C 3

You can burn a 5.1 surround mix (see audio innovations above) to a DVD in the form of a two-channel stereo 
downmix. However, the material used can also be a standard (non-5.1) mix; in this case, the resulting surround 
effect is somewhat less impressive.

Audio files can now be generated as AC3 (Dolby Digital).

� Menu bar > File > Export > DVD, (S)VCD > Destination tab

� Chapter 17, Output, Export to VCD, SVCD, DVD / Destination tab

Record to Tape
� The Used Video Output function in the Record to Tape module has been eliminated. Define the output 

used for the connected recorder in the Player Settings.

� Menu bar > Edit > Settings > Site > Player Settings > Connections (Video/Audio Output)

� If Timeline Slices still have to be rendered before recording to tape, the process can now be monitored on 
a progress bar.

� Chapter 17, Output, Record to Tape

Fuse Sequence
� This function also involves Output Mapping (see Audio Editor). The number of audio files generated 

depends on the settings in Output Mapping; up to eight files are possible.

� Fuse to MPEG2 IPB (Elementary Stream) -
This is achieved by means of the Post Processing Module in the Fuse Sequence dialog box and the IPB Set-
tings, which are also accessible from this dialog box.

� Menu bar > File > Fuse Sequence > Create separate audio streams and Post Processing Module (Options)

� Chapter 17, Output, Fuse Sequence 
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Settings

For descriptions of the system- and user-specific software settings, refer to the individual product manual that 
came with your version of Pinnacle Liquid 6.

The following is an overview of the changes and additions in this area:

� The Inputs/Outputs tab has been moved from System Settings to Player Settings.

� The Connections tab for the Player Settings now offers drop-down lists of the system’s AV outputs, 
except in the case of the Live player (you control this player by means of the Monitor icon on the task-
bar).

� The settings for aspect ratio and TV format (NTSC, PAL, etc.) have been eliminated because they have 
been rendered unnecessary by the multiformat capabilities of Pinnacle Liquid 6.
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PINNACLE
This purpose of this introduction is to provide you with an overview of Pinnacle Liquid and familiarize you 
with existing documentation. 

About Pinnacle Liquid page 1-3

Sources of Information page 1-4

List of Chapters page 1-5
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Preface
Preface

Pinnacle Liquid is the professional solution for professional video editing on a computer. All its functions are 
specifically adapted to meet the requirements of today’s video editing. Its main focus is on the basics: image, 
audio and editing. Pinnacle Liquid is operated intuitively. Beginners will quickly produce successful results and 
professional editors will achieve the highest productivity and precision.

Efficient Project management and extensive storyboarding functions help you develop your ideas. The inte-
grated video and audio viewers allow you to monitor and control active processes (for example, when reading 
in video material or editing clips). A Timeline as well as effect and audio editors provide you with options for 
optimally transforming your visions into reality. Moreover, Pinnacle Liquid relies on proven, future-oriented 
standards, enabling the generated results to be effectively integrated in the latest video production processes. 

You can tailor the Pinnacle Liquid user interface to your own particular language, working style and Projects. 
You can flexibly configure the views, tools and keyboard assignments. You can also save your customized set-
tings and transfer them to other systems. 

Users with more sophisticated requirements can take advantage of numerous possibilities for expanding Pinna-
cle Liquid. 
If you have any further questions concerning options and expansions for Pinnacle Liquid, contact Pinnacle Sys-
tems GmbH or one of our authorized Pinnacle Systems GmbH partners.
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Sources of Information
Sources of Information

Product Manual

This separate manual describes hardware and software installation, the connection of system components and 
hardware, non-product-specific settings, etc.

Pinnacle Liquid Reference Manual

This manual is available in hardcopy form and as well as Acrobat pdf. It describes all functions of Pinnacle Liq-
uid. It is suitable for learning the basics of operation as well as for looking up specific functions as you need 
them. 

Note that this Reference Manual was written for the Liquid blue  and Liquid Edition  products. 
Although these products share most of the same functions of Pinnacle Liquid (i.e. the software), they also differ 
in many respects. Differing passages are clearly marked. Occasionally you may see a function in one of the 
screenshots (Menu, Checkbox, Tab, etc.) that does not appear in your own software, or you may not see a func-
tion that does appear. For reasons of space, we were unable to include all versions of the screenshots in the man-
ual. In case of doubt, the manual text and your own software apply.

Pinnacle Liquid Help

Help offers you instant access to the information you currently need. It is context-sensitive and includes an 
interactive table of contents and comprehensive index with a find function. Its other components include the 
Pinnacle Liquid Online Manual, a glossary and a readme file. See also “The Online Help” on page 2-5. You can 
call Help either from the menu bar or by pressing F1.

World Wide Web

Pinnacle Systems GmbH has set up contact and information options specifically aimed at Pinnacle Liquid 
users, which you can access via our Web page at www.pinnaclesys.com. For example, you can retrieve current 
product information or contact other Pinnacle Liquid users through discussion forums. There is also an over-
view of current updates, options and trainings that keeps our customers informed of all the latest develop-
ments.

Tooltips

All Pinnacle Liquid toolbar buttons have tooltips. These miniature information windows (pop-ups) are dis-
played when you rest the mouse pointer on a button for more than one second.
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List of Chapters
List of Chapters

Introduction

This chapter provides you with an initial introduction to Pinnacle Liquid. It also tells you about sources of 
information that will help you work with Pinnacle Liquid (page 1-1).

Documentation

This chapter familiarizes you with the user interface and Online Help and offers you tips on the effective use of 
this documentation (page 2-1).

Basics

This chapter describes the Pinnacle Liquid user interface and introduces you to the terminology used 
(page 3-1).

Signup

Logging on to the system; working with user names and user profiles, password protection (page 4-1).

High Definition Television (HDTV)

This chapter describes everything you need to know about the HDTV and multiformat capabilities of Pinnacle 
Liquid (page 5-1).

Input

This chapter describes everything you need to know about the raw materials of editing: Digitizing audio/video 
(capture); importing graphics, titles, etc. (page 6-1). 

Data Exchange and Networking

This chapter describes all the functions for exchanging data with other applications, including EDL, ALE, 
XML, batch/shot lists, XReceive/XSend, etc. It also provides a basic description of a simple Pinnacle Liquid net-
work (page 7-1).

Administration

Explains arranging and viewing the material inside a Project; working with Media Files (media management); 
creating a rough cut (storyboarding); batch digitizing. page 8-1 
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List of Chapters
Edit

Editing (cutting) films with sample applications; basics of audio editing; special functions (nesting and consol-
idating Sequences). page 9-1 

Finish

This chapter provides general and introductory information on the effects in Pinnacle Liquid, as well as 
descriptions of the Classic Effect Editors (page 10-1).

Software-Based Realtime Effects

These effects take advantage of the performance capabilities of modern computer systems by using the graph-
ics-card and mainboard processors for the realtime processing of effects.
This chapter also contains a description of newer ( > V 6.0) effect editors with individual key frames for each 
parameter (page 11-1).

Special Effects

This chapter provides information on Pinnacle Liquid’s powerful color correction functions as well as the 
Linear and Dynamic Timewarp Editors for smooth, dynamic increase/decrease of video speed (page 12-1).

Audio

This chapter describes everything you need to know about audio editing in Pinnacle Liquid (page 13-1).

Titler 

Pinnacle Liquid comes bundled with a title generator, a powerful software for creating roll, crawl and still titles, 
which can easily be integrated in your Projects (page 14-1).

DVD Authoring

Pinnacle Liquid guides you from the importing of material to its editing and authoring and all the way to burn-
ing it to DVD. The entire production process is seamlessly coordinated. You can even design the DVD menus in 
Pinnacle Liquid (page 15-1).
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Output

How to output on tape an edited film (in Pinnacle Liquid lingo, a Sequence), burn to CD or DVD. exporting 
various data formats (single images, animation, etc) (page 16-1).

Customize Pinnacle Liquid (User and Site Settings)

How to configure your Pinnacle Liquid workstation and how to create, customize and save your own user pro-
files (page 17-1). 

Glossary and Index

The Appendix contains a comprehensive glossary of video, editing and computer terms, as well as the
index .
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This manual for Pinnacle Liquid contains all information available at the time of printing of this manual.

Conventions and Symbols  page 2-3

Comments and Suggestions for Documentation  page 2-4

The Online Help  page 2-5
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Conventions and Symbols

This section describes the conventions used to identify special texts, such as warnings. 

Caution

Calls the reader’s attention to particularly important information, or especially “dangerous” actions, i.e. 
actions that could lead to a loss of data.

Note

Calls the reader’s attention to important information and practical tips.

Functions of Specific Products

Some of the functions described in the manual apply only to a specific product. The Pinnacle Liquid software is 
the basis for a number of products that differ with regard to hardware (such as connection boxes, plug-in cards, 
etc.). The following format is used to differentiate among functions:

LiquidEdition

If a paragraph with this format does not mention your product specifically, the function does not apply to your 
product.

Italics

Terms from the Pinnacle Liquid user interface are written in “italics” when they are part of instructions on how 
to perform a given function (for example, the Import option in the Rack shortcut menu).

>Click Sequence >

The symbol “>” is used to indicate a string of menus, buttons, etc. that have to be selected to access a given 
function. For example:

Rack shortcut menu > Picon View > Medium. Meaning: In the Rack shortcut menu, click Picon View. In the 
pop-up menu that appears, click Medium.

As of Version 6 or later, Pinnacle Liquid comes with a Windows-compatible menu bar.

� � Menu bar  > File > New > Project

This paragraph applies only to Liquid Edition .
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Keyboard Symbol

� Many of the functions in Pinnacle Liquid can be executed by means of keyboard shortcuts. This 
symbol identifies a keyboard shortcut. The key names are written in small caps (example: DEL, 
SHIFT, CTRL).

Mouse Wheel 

� If your mouse has a wheel for scrolling, you can also execute some functions using the mouse 
wheel; move the Playline, for instance. 

Comments and Suggestions for Documentation

If you have any suggestions, requests, corrections or additions relating to the Pinnacle Liquid manuals and help 
files and would like to share them with us, please contact us at:

liquid.documentation@pinnaclesys.com

Write your message in either English or German and be as precise as possible about the subject of your com-
ments. While we will not be able to respond to your e-mail directly (though it may happen), rest assured that 
your input is important to us. 
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The Online Help

You can call Help either from the menu bar or by pressing F1. 

Simplified View of the Help Window

Title Bar

The title bar is the same as in all Windows windows (see Windows manual).

Title Bar

Tabs

Contents/
Index

Toolbar

Information
Window
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Tabs in the Help Window

Clicking one of the rear tabs brings to front its corresponding content:

Online Help

The “Online Help” tab contains the table of contents, the index and the contents window for Online Help. Texts 
within the paragraphs that are marked in blue indicate cross-references. 

Online Manual

The Pinnacle Liquid Online Manual reflects the contents of the (hardcopy) Reference Manual. To use the 
Online Manual, you must have the Adobe Acrobat Reader (new version included on the Pinnacle Liquid instal-
lation CD). Click the tab to start the Acrobat Reader and display the Online Manual.

You will also find the PDF file in your Pinnacle Liquid installation directory under:
..\[ProductName]\Help\FS\Frames\Manual\.

Glossary

The glossary contains general terms and information on video, computer and audio technology as well as ter-
mini technici concerning the art of editing.

Info

Provides product information on Pinnacle Liquid, including the version, copyright information and trade-
marks.

Readme

The readme file contains important information that could not be incorporated in this document (printed 
manual as well as online help). 
You should read this file.
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Toolbar

Contents/Index

Click the “display table of contents” button to view a list of topics by chapter. Then double-click a chapter or 
topic to open the particular document. Under “List of Chapters”  on page 1-5 of the Introduction, you will find a 
brief overview of the contents of each chapter.

Click the “display index” button to view a list of index entries in alphabetical order. In the entry field above the 
list, enter either the entire word you are searching for or the first few letters. Double-click an index entry to dis-
play the particular topic. 
If you then go back to Content view, you can see where the index topic is situated within the context of the man-
ual.

Previous Topics

The function of the “back” and “forward” buttons depends on what pages or chapters you have already 
retrieved and the order in which you opened them. The left arrow (“back”) takes you back through the pages 
you previously viewed.

The right arrow (“forward”) reverses this step. The “forward” button is enabled only if you previously used the 
“back” button to go back one or more pages. 

Previous Document/Next Document

Click the up arrow to view the previous page in the chapter. 

Click the down arrow to view the next page in the chapter.

Print

Click the “print” button to print out the help topic currently displayed. 
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Information Window

The information window displays text and illustrations of the help topics. If the topic does not fit in the current 
window size, scrollbars appear along the margin. Drag the bar downward to advance toward the end of the 
topic or click the top or bottom arrow. 

An arrow button appears in the bottom left-hand corner of each help page. Clicking this arrow returns you to 
the beginning of the help page.
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This chapter features a quick introduction in Pinnacle Liquid: the most important software modules, the most 
important terms, the general principles behind their operation. 

Starting and Exiting Pinnacle Liquid  page 3-3

Menus, dialogs boxes and tool buttons  page 3-4

Tour de Pinnacle Liquid  page 3-9
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Starting and Exiting

Starting Pinnacle Liquid

1 Switch on all the peripherals, including the VGA monitor(s), A/V disks, video recorder and A/V moni-
tor, etc. 

2 Start your computer.

3 Start Pinnacle Liquid either via the program shortcut on the Windows desktop or from the Windows 
Start menu.

If you want to start Pinnacle Liquid with the traditional interface, go Windows Start menu > Programs 
> Pinnacle Liquid and select the “Classic” start option. The desktop icon launches the new (V6 or later) 
interface and menu structure.

4 The Pinnacle Liquid interface is displayed in the standard view (first launch). See also “Pinnacle Liquid 
Desktop” on page 3-11.

� When you start Pinnacle Liquid for the first time after installation, the User Login dialog box does not 
appear. (See also “Signup” on page 4-1.) Then, a default Project is opened.

� Each time you log on after this, the last Project you worked on is opened automatically. You then have 
the option of logging on under a different user name or opening another Project.

Exiting Pinnacle Liquid

1 In the Pinnacle Liquid menu bar, click File and select Exit Pinnacle Liquid. A dialog box is displayed 
containing two options: 

� Select Quit Pinnacle Liquid and click OK. This terminates Pinnacle Liquid.

� Select Clear Pinnacle Liquid desktop and log on as different user? and click OK to log on as another user 
(“Signup”  on page 4-1).
Volume II Chapter Basics 3 - 3



PINNACLE

Menus, Dialog Boxes and Tool Buttons
Menus, Dialog Boxes and Tool Buttons

This section provides you with an overview of elements frequently used in Pinnacle Liquid.

Menu bar

As of Version 6, a standard Windows menu bar is available along the top of the program window. It contains the 
usual menus, including File, Help and Edit, as well as menus specific to Pinnacle Liquid. See also “Standard 
Windows Menu Bar” on page 3-19.

Shortcut Menus

Note: Shortcut menus are always available.

Calling Shortcut Menus

1 Right-click an object or an area to open the corresponding shortcut menu.

2 Left-click an entry in the shortcut menu to call this function.

Sample shortcut menu
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Tool Buttons and Toolbars

In Pinnacle Liquid, functions (such as “Play”) are called and executed either via a shortcut menu or via tool 
buttons. 
Tool buttons are generally found in toolbars (appear horizontally or vertically in the interface). 
Sometimes the button you need may not be included in the toolbar (due to restricted space). Nevertheless, you 
can determine for almost each toolbar which buttons it will contain and how these buttons will be arranged. To 
learn how to do this, see “Customizing Toolbars”  on page 17-8.

Most of the buttons in Pinnacle Liquid have tooltips, which are miniature information windows con-
taining a brief description of the function. Tooltips are displayed when you rest the mouse pointer on a 
button for more than one second.

Button & Text Status

For all tool buttons, the following visual clues tell you the tools’ status:

� Gray button, no glow highlight: function off, tool not in range to be selected (mouse is not pointing at 
the button).

� Gray button with glow highlight: function off, tool in range to be selected (mouse is pointing at the but-
ton). This tells you which tool is currently selected with the mouse and will be enabled when you click 
the mouse button. Example: moving the mouse across the buttons on a toolbar without clicking or 
dragging highlights each button as the mouse passes over it.

� Yellow button, no glow highlight: function on, tool not in range to be selected (mouse is not pointing at 
the icon). Example: Play tool remains yellow while a clip plays.

� Yellow button, yellow glow highlight: function on, tool in range to be selected. Example: mouse is point-
ing at Play tool while a clip plays.

Button & text status

Normal

Selected

Active selected

Active

Normal

Selected
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Dialog Boxes

Dialog boxes contain information, let you specify functions and select options.

Sample dialog box
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Typical Elements in Dialog Boxes

Most dialog boxes have a similar layout and contain the following basic elements:

Tabs

Clicking one of the rear tabs brings its content to the front. 

Entry Fields

Entry fields allow you to enter text. Simply click in the entry field and make your entry via the keyboard. Usu-
ally you confirm with ENTER.

Check Boxes 

Click a check box or to select the corresponding option.

Circular check boxes are either-or selections. 
Several square boxes can be checked at the same time.

Sliders and Knobs

Sliders and knobs allow you to set values or ranges of values. Sliders and knobs can assume various forms 
depending on the dialog box.

To set a value using a slider or knob, click the corresponding element and drag it to the desired position. You 
can also enter the values in entry fields via the keyboard.

Drop-Down List Boxes

Some windows have drop-down list boxes. Click the arrow or the visible list entry to open the 
list. Then select an entry by clicking it. 

Sample tab

Sample drop-
down list box
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Buttons in Dialog Boxes

These buttons apply to all settings of a dialog box.

Apply and Close

Click to apply the dialog box settings to the current item and close the dialog box.

Cancel

Click to close the dialog box without applying any changes. This is the same as closing the dialog box from the 
title bar or the ESC key.

Restore Initial State

Restores all settings to the state they were in when the dialog box was first opened.

Restore Default State

Resets all changes to the default software settings.

Customize Dialog Box

Some dialog boxes can be customized. This button opens the corresponding tool box.
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Tour de Pinnacle Liquid

If your are not familiar with Pinnacle Liquid, please have a look at the next few pages. We would like to intro-
duce to you some of the most important software modules, viewers and editors.

That’s how Pinnacle Liquid may look on a dual monitor setup
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Inlays

Inlay windows let you have a look at your video (moving or still), titles and graphics, effects to be rendered, etc. 
Even audio is displayed - as wave form. 
Placed around the inlay windows you find all kinds of functions and displays. The example below (a snapshot 
taken from the Clip Viewer) shows the position of the Playline and the duration of the clip between the mark-in 
and mark-out points.
See also “Full-Size Monitor”  on page 9-117 and “Inlay Quality Menu / Inlay Size”  on page 9-119.

Sample inlay window (here shown with position bar
and two TC displays)

Mark-In Mark-OutPlayline

Position Duration
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Picons

All objects in Pinnacle Liquid can also be displayed in Picon view. Picons 
(picture icons) are still images that help you identify clips. Picon view is ideal, 
for example, for developing a storyboard.

Picons are found on the Pinnacle Liquid desktop, in the Project window, on 
the Timeline and in numerous dialog boxes. For more information on 
Picons, see “Picon View”  on page 8-34 and “Picon Play”  on page 8-74.

Pinnacle Liquid Desktop

The Pinnacle Liquid desktop is the backdrop for all other elements of Pinnacle Liquid, like Picons, for instance. 
Three things can always be found on the desktop:
The Trash icon, the taskbar and the Project window.

Otherwise, the Pinnacle Liquid desktop functions much like the Windows desktop (please refer to the 
Windows manual for further information).

The Taskbar

The taskbar appears at the bottom of the desktop.

Taskbar functions

Additional functions (from left):

Picon
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Error/fps/drop frame Indicator 

The “thumbs up” sign tells you that the system started correctly.
If a problem occurs, a flashing exclamation point is displayed that is either yellow, orange or red, depending on 
the severity of the problem. Left-click the symbol to obtain detailed information on the current problem. 

Right-click the symbol to display a shortcut menu with the following options:

� Show latest line of error log -
Opens a text box in the taskbar displaying the latest message.

� Show error log -
Opens the list box with all the lines.

� Reset error indicator -
Deletes all lines.

� Show system info -
Displays system info (same as Control Panel > Site > System Settings > System Info).

LiquidEdition Liquidblue

Render Viewer

The icon (���the Greek letter Sigma) represents the Render Viewer window. “Rendering” means the computa-
tion of effects. Click the ��icon to open the Render Viewer window, where you can monitor the rendering pro-
cess, and start and stop rendering. (See also “Effect Rendering” on page 10-35.)

The horizontal bar next to the window shows the rendering progress.

Once the rendering process begins, the Sigma icon is replaced by a miniature of the image, provided you have 
not disabled this function in the shortcut menu (right click). You can also use this menu to hide the progress 
bar and stop the rendering process.

� Show current playback speed -
During Timeline playback, indicates the current number of frames per second (fps; stadard PAL: 25 
fps, standard NTSC: 30 fps). Its main purpose is to allow you to check computer performance for real-
time software effects.

� Show minimum playback speed -
Indicates the lowest fps value reached.

� Reset speed indicator -
resets speed to default fps

� Reset speed indicator always at start playback -
As soon as the Timeline is replayed, resets the last fps information identified.
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Key Caps

Click this icon to open the Key Caps window. For any software module, this window provides you with a quick 
reference showing the functions assigned to the keys of the computer keyboard.
Refer to “Assign Functions to Keyboard”  on page 17-11 for information on how you can change these assign-
ments.

LiquidEdition

Audio Tool 

Click this icon to open the Audio Tool, which you can use to control outgoing levels. 
The adjacent rows of squares serve as an auxiliary level. The two uppermost segments in particular are dis-
played in red to warn of an overload. For related information, refer to “Audio Tool”  on page 13-14.

Digital or analog audio scrub: Right-click on the icon to open a shortcut menu. Select either one of the two 
modes, then enable scrub by pressing the SCROLLLOCK key on your keyboard: In the icon an A or D indicates 
active scrub mode, and the type.
For further information on this subject see “Audio Scrubbing - Digital or Analog”  on page 13-11.

View Switcher

To access several views for the Pinnacle Liquid interface, click the View Switcher (eye icon) and select an avail-
able desktop view (“Desktop Views”  on page 3-14).

In a dual monitor setup, we generally suggest to select a desktop view that positions the Source and 
Master Viewers on the left monitor (“primary”): viewers on the right may cause dropped frames when 
playing back video.

Liquidblue

Select Video Output 

None means Master Viewer Inlay only. S-video enables a special signal filter. 

Audio Monitor

Click this icon to open the Audio Monitor, which you can use to monitor and control signals of the 
analog output. For more information, see “Audio Monitor”  on page 13-16.
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InterCom

Click this icon to open a dialog box that can be used by members of a workgroup to exchange information. 
When a message is received, this icon is replaced by a flashing reddish-orange telephone icon ( page 7-28).

D e s k t o p  V i e w s

The Pinnacle Liquid desktop is able to display several windows at once, and you can configure them on the 
desktop in different ways. The current configuration of windows visible on the desktop is called a “view.” The 
View Switcher (eye icon) on the taskbar opens a shortcut menu that sets the current view on the VGA monitor. 

You can arrange icons such as those for the Trash and for Racks via the desktop shortcut menu.

Single VGA Mode

To change the arrangement of windows on the desktop:

1 Click the View Switcher icon at the right end of the taskbar to display the selection menu. 

2 Click the particular view that you want. 
You have now selected the view and the desktop is arranged accordingly. 

or

1 Drag an object that you want to edit in another module to the View Switcher icon, keeping the mouse 
button depressed. The selection menu is displayed. 

2 Now drag the object to the particular view that you want and rest it on this view for a few moments. The 
view changes and you can now continue working with the object.
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Views (One Monitor)

The most common views are “Project window only” for developing Projects and “Project window above, 
Timeline below” or “Sequence Editor above, Timeline below” for the actual editing. 

- Timeline only

- Sequence Editor above, Project window below

- Project window above, Timeline below

- Project window only

- Sequence Editor above, Timeline below
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Using the Project Browser 

The Project Browser proves especially useful when working on a single monitor system. When active, the Project 
Browser takes up some space of the Timeline.

Project Browser

The Project Browser is a miniature Project window. Use the this tool button to call up the browser. If you do not 
find the button on the Timeline tool bar, retrieve it from the corresponding tool box (see “Customizing Toolbars”  
on page 17-8). To close the Project Browser, click the tool button again.

� Change size and positions of browser - 
The boundaries between Timeline and Project Browser as well as between content area and Rack/Folder 
area can be moved. Place the mouse on the separating line and drag it to the desired position (see 
arrows in screen shot above).
You may also change the positions of content area and Rack/Folder area. Right-click on the separating 
line between the areas and select a combination. Relative preserves the relative size of both areas when 
dragging bigger or smaller.
To move the Project Browser to, say, top of the Timeline, right-click the separating line between browser 
and Timeline Headers and select an option from the shortcut menu.

Views Project shortcut menu
Show/hide rack/

folder areaContent area

Rack/folder
area
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� Show/Hide Rack Tree -
Click here to either show or hide the rack/folder area, depending on the current view.

� Toggle tabs -
Click to toggle available Project tabs.

� Switch Project - 
In case you need material from a Project other than the current, it is possible to switch Projects. The cur-
rent Sequence remains on the Timeline.
To do so, right-click the Show/Hide Rack Tree button. You get a list of the most recent Projects you 
worked on (same list as in the Open/Create Project submenu). Click the Project’s name to select it.
If you need a different Project, you will first have to open and close it the conventional way in order to 
get it on the most recent list. 

More information on “The Project Browser”  on page 8-14.

Dual VGA Mode

To change the arrangement of windows on the desktop:

1 Click the View Switcher icon at the right end of the taskbar to display the selection menu. 

2 Click the particular view that you want. 
You have now selected the view and the desktop is arranged accordingly. 

In a dual monitor setup, we generally suggest to select a desktop view that positions the Source and 
Master Viewers on the left or primary monitor: Viewers on the right may cause dropped frames when 
playing back video.
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Views (Two Monitors)

- The Timeline appears on both monitors

- The Project window appears on both monitors

- Left monitor: Sequence Editor above, 
Project window below.

- Right monitor: 
Timeline occupies entire monitor

- Left monitor: Sequence Editor above

- Right monitor: Project window above,
Timeline occupies bottom of both monitors

- Left monitor: Sequence Editor above, 
Timeline below

- Right monitor: 
Project window occupies entire monitor

- Left monitor: 
Project window occupies entire monitor

- Right monitor: 
Sequence Editor above, Timeline below
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S t a n d a r d  W i n d o w s  M e n u  B a r

The menu bar is located along the top of the program window. You can use the usual Windows buttons in the 
top right-hand corner to minimize or maximize the program window, but not to scale it to a particular size.

� Most of the menu commands can also be accessed in other ways. For example, it is also possible to open 
the Logging Tool for capturing video and audio by clicking a tool button or pressing a function key. 
Other commands can be selected from the specific shortcut menus.

� For some commands, you must first select a Rack or several clips in order to indicate where you want to 
apply the function. For example, if you want to import a clip, first select the Rack to which you want to 
import it.

� You’ll notice that the background of certain windows starts to flash (light-gray – dark-gray). This means 
that the subsequent action will be applied to this particular area. This is especially helpful when, for 
instance, you have opened or selected multiple Racks.

� Moreover, the contents of a menu can change depending on which area is currently activated. Thus, for 
example, the Project menu is much shorter when you're working in the Project window on the Library 
tab.
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The Trash

To remove items from Racks, or shortcuts from the desktop, you can drag them to Trash. The can expands to 
indicate that there are items in it. The Trash tooltip, which appears when the mouse pointer rests on the icon for 
more than one second, indicates the number of items in Trash.

Right-click Trash to access its shortcut menu.

� Open - 
opens a window that displays Trash contents. You can drag items from 
the Trash window to the Project window to restore them. Dragging an 
item from the Trash window to the desktop creates a shortcut to the 
item, but you cannot access the target object unless it also exists in the 
Project window.

� Empty Trash - 
removes the items in Trash from the Project. Note that this does not delete the media, effect, etc. files on 
the hard drive, it just removes them from the Project. 

� Clean Up Project -
The complete undo history of the current Project including all deleted objects will be erased. This func-
tion should be used to minimize the size of a Project file, for example in the case of having finished a 
program.

� Delete Render Files Of Project -
See “Deleting Render Files” on page 8-131.

� Diagnose Project -
see “Diagnose Project”  on page 8-18

� Paste -
puts the clipboard contents (an object you copied or cut from its original location) in Trash. This is the 
same as using the Trash button or the Delete key, or selecting Delete in the shortcut menu.

Right-click in the Trash window to select a Detail or Picon view of its contents.
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The Project Window

In this window, you can administer all the items needed for editing with Pinnacle Liquid. The Project window 
displays all the elements for the currently open Project, including audio and video clips, effects, graphics, etc. 
Similar in design and function to the Windows Explorer, the Project window uses a hierarchy of folders that you 
can customize to suit the Project and your own preferences.

The tree area on the left is used for creating and selecting folders and subfolders (called Racks). The content 
area on the right is used for organizing and viewing objects. 

For more information on administration, see “The Project”  on page 8-4.

Project window

ToolsTabs

Rack/folder (tree) area

Rack menu iconQuick Finder

Content area
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The Timeline

The Timeline is the workspace in which you compile a film (in Pinnacle Liquid known as Sequence) from the 
individual objects in the Project. Objects are placed on Timeline Tracks. You can select the number and size of 
the Tracks. Other elements used with the Timeline include the toolbar, Playline, Timecode Display and Timecode 
Bar. 

For more information on the Timeline and on editing video, see “Timeline Layout”  on page 9-4.

Timeline window

Zoom controller Timecode barTimecode display Scroll bars

ClipsToolbarPlaylineTracks
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The Sequence Editor

The Sequence Editor combines the Source Viewer, Master Viewer and the Timeline. The Source Viewer (“player”) 
displays the clip that you want to edit. The Master Viewer (“recorder”) lets you play the Sequence located on the 
Timeline.

For more information, see “Sequence Editor”  on page 9-38.

Sequence Editor and Timeline

Source Viewer Master Viewer
Sequence Editor
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The Logging Tool

Before you can edit a video in Pinnacle Liquid, the corresponding raw material must be available on your com-
puter. The Logging Tool lets you transfer the video data to your hard disk (mostly from a tape). Plus, you can 
control incoming audio and name clips, and apply a primary realtime color correction (Liquid blue  only).

For information on working with the Logging Tool, see the chapter “Input”  on page 6-1.

Logging Too
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The Effect Editors

With the Effect Editors, you can create Transitions and clip effects (FX). 

Sample (Classic) Effect Editor

 ToolbarPosition barVideo inlayToolbar

Acceleration curveTabs Playline position FX duration
Toggle incoming/

outgoing
Close 
editor
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The Audio Editor

Most of the work that you do with audio material requires the Audio Editor. In the standard view, the Audio Edi-
tor replaces the Source Viewer above the Timeline and starts with the Mixer tab in front. The second tab contains 
Output Mapping. It allows you to mix audio signals in subgroups and distribute them to the available outputs.

See “Audio Editor” on page 13-17.

Audio Editor 

Fader units
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Tour de Pinnacle Liquid
The Trim Editor

With the Trim Editor, you can optimally coordinate movement in the image for editing purposes and precisely 
trim transitions between individual cuts. The two inlays show you the frames before and after the edit point. 
You can check the edit in Preview mode. The Slip Clip function allows you to trim the mark-in and mark-out 
simultaneously. 

See also “Trim Editor” on page 9-70.

Duration of incoming clipEdit point on the TimelineDuration of outgoing clip Shortcut menu

TC +/- of trimmed clips Incoming clipOutgoing clip Toolbar

Select trim points
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You do not necessarily have to log on to Pinnacle Liquid in order to work with the system, but doing so offers 
certain advantages, especially when several users are working on the same system. If you log on under a specific 
user name,

- The last Project edited under this name is opened with exactly the same status that it had when it was last 
exited.

- The Pinnacle Liquid user interface is configured with the customized settings for this user (toolbars, keyboard 
assignment, etc.).

- If applicable, you are prompted to enter a password that protects the settings against unauthorized accesses.

All your individual settings (User Profile) can be saved on a diskette and used on any system running under 
Pinnacle Liquid, thus providing you with a portable, personalized working environment.

If the User Login dialog box does not appear on the system you are working on (because the software is 
being launched for the first time or the dialog box was not used by previous users), exit Pinnacle Liquid 
by selecting File > Exit Pinnacle Liquid >... log on as a different user. This will activate the login proce-
dure. 
If you do not need the User Login dialog box, select Cancel or press ESC to bypass it.

Logging on as an existing user  page 4-3

New user/initial login  page 4-4

Loading a user profile  page 4-5

User Details  page 4-6

� Comment  page 4-6

� Password protection  page 4-7

Removing a user  page 4-8

Save user  page 4-8
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Logging on As an Existing User
Logging on As an Existing User

If other users are already registered on the system, the User Login 
dialog box will contain a list of names. Select the appropriate name 
and click OK. 

On initial installation of Pinnacle Liquid in a directory where no 
previous installations exists, only one Default User setting is being 
created instead of the usual six predefined User Settings you may 
know from erlier versions (see figure). You can, however, save any 
existing User Settings on a disk and import them in the new instal-
lation. Also, if Pinnacle Liquid is installed on top of an older ver-
sion, the old settings remain accessible.

User Login 
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New User/Initial Login
New User/Initial Login

1 In the User Login dialog box, select New User to cre-
ate a new user.

2 Then enter a name and select a user profile from the 
list; you can select either: 

� Default - Basic software setting

or

� If any are present, another registered user or a sample 
user (basic, etc.) with his or her customized settings. 
In other words, you can either work with the settings 
of another user or use these settings as a basis for 
defining your own settings.

� Click OK. 

New User/Load User Profile
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Load User Profile
Load User Profile

If you have been working on a different Pinnacle Liquid system, you can load your own individual settings here.

In the dialog box, enter the source of this file (such as a diskette) and then open the file. The user name appears 
in the list and you can now select it.

For information on saving User Profiles, refer to “Save User”  on page 4-8.
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User Details

You can set up a new user by clicking User Details in either the User Login or New User dialog box. The User 
Details dialog box lets you add or change the password and comments for a user.

User Details

Comments

This option is intended not so much for biographical information as for a description of the user profile; you 
can configure your own aliases and optimize them for special applications (for example, “Audio User”). 
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User Details
Passwords

Pinnacle Liquid permits you to use a password to protect registered user settings against unauthorized access.

Note that a password does not protect a Project against access; it protects a user profile. If you wish to 
protect the overall system, use a Windows password (see the Windows manual).

Adding/Changing Passwords

In the User Details dialog box, click Password Protection to enable it. This opens the Change Password dialog 
box. Type the password in the New Password box, then type it again in the Confirm Password box. 

Click OK to close the dialog box and assign the password to the user.

Change Password

Removing Passwords

In the User Details dialog box, a check mark in the Password Protection item indicates that the user name is pro-
tected. To remove the password protection, click Password Protection. Pinnacle Liquid prompts you to enter the 
existing password to remove the protection.
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Remove User

The User Selection box also lets you remove users. Select the user to be removed in the Registered Users list, then 
click Remove User. If the user has password protection, you must enter the password to delete the user name 
from the list. Pinnacle Liquid prompts you to confirm before removing the user from the list.

Save User 

To save the settings of a specific user, use this function. For example, you can save the settings on floppy disk so 
that you can use them on a different system; see also “Load User Profile”  on page 4-5).

1 Select a User from the list and click this button. In the dialog box that appears...

2 ... specify where you want the data to be saved.

The following configurations are saved:

� Toolbars

� Object Properties dialog box settings 

� Property sets saved under Control Panel > User tab 

� Layout of software interface (desktop) 

Project templates and Timeline templates cannot be saved together with a User Profile. However, with a 
suitable storage medium, you can transfer Timeline and/or Project templates in the Pinnacle Liquid 
folder, from one system to another.
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This chapter describes the HD capabilities of Pinnacle Liquid.

Basics of high definition TV  page 5-3

Better image, better sound: The TV of the future

High definition in Pinnacle Liquid  page 5-10

� Timecode systems  page 5-11

� Multiformat in Projects and on the Timeline page 5-12

� Quality ranks  page 5-16

High definition at the input page 5-18

� HDV capture in the Logging Tool  page 5-18

High definition on the timeline page 5-19

� Editing HD clips  page 5-19

� HD and effects  page 5-19

� HD monitoring  page 5-19

� Combining SD and HD clips  page 5-20

High definition at the output  page 5-21

Record to tape  page 5-21

Output as MPEG2 (tape and DVD)  page 5-21
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Basics of High Definition TV
Basics of High Definition TV 

This section contains basic information on HDTV.

TV of the future 

The meaning and benefits of HDTV  page 5-4

Filming in HD

What changes...  page 5-6

Editing HDTV

What stays the same...  page 5-6

HDTV basic data

Overview of the standards  page 5-7
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Basics of High Definition TV
TV of the future

High Definition TV (HD or HDTV) means better images and better sound that is almost cinema quality.
HDTV is a general term for the TV of the future that will, over the medium-term, replace the existing PAL, 
SECAM and NTSC television standards. Just how fast this will occur, and which of the substandards within the 
many-branched standard family will prevail is not yet known. In the US, where the transition has been stipu-
lated by law, the conversion to digital television is expected to be completed by 2006. In Asia, Europe and other 
regions of the world, there is no fixed agenda for the introduction of HDTV. Japan, however, has been experi-
menting with high-resolution formats since the early ’90s. 
Industry, TV stations and production houses are preparing for HDTV. More and more HD cameras are avail-
able, not just for professionals but in the consumer sector as well (keyword: HDV). Major events are being 
recorded and distributed as HD productions. HD television sets are available in markets where HD programs 
are already being broadcast.

Here is an overview of HD properties:

� Standardized -
The HDTV standard, meaning all the essential technical standards and specifications, is defined by the 
SMPTE (Society of Motion Pictures & Television Engineers). The ATSC (Advanced Television System 
Committee) has formulated a number of “standard sets” comprising all possible combinations of reso-
lutions, aspect ratios, frame rates, progressive vs. interlaced, etc. A distinction is made between produc-
tion formats and transmission formats (more later). 

� Digital -
HDTV is digital, from its recording to its output on the TV set. It is digitally recorded, digitally edited, 
digitally broadcast or transmitted via a cable network, and received on a digital device.
(Converters make it possible to continue using analog TVs and video monitors.)

� Compressed/uncompressed -
HD video is generally compressed as per the MPEG2 Standard in order to reduce the data rate.
Uncompressed HD video also exists but, in this case, the standards are only manufacturer-specific and 
not global.

� High resolution = better image -
HDTV provides “more image” in two ways:
Spatially: Up to 1920 x 1080 pixels (as compared to NTSC: 720 x 486).
Time-wise: Up to 60 frames per second in progressive mode (see below).
HDTV images are much sharper and more detailed than conventional TV images. They are suitable for 
projection onto a big screen.

� “Widescreen” 16:9 -
Although HDTV also supports various 4:3 formats, the emphasis is clearly on the 16:9 widescreen 
aspect ratio. The real strengths of HDTV can be appreciated only in 16:9.
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Basics of High Definition TV
� Better audio, surround sound -
HDTV supports 5.1 spatial sound audio (AC-3). This means five channels plus one, where the latter 
provides the bass sound (low frequencies) and the other five channels (two in the rear, three in the 
front) surround viewers/listeners with sound. Most feature film DVDs are already equipped with 5.1 
sound.

� Progressive -
NTSC and PAL/SECAM work with fields. Each of the 30/25 images recorded per second is played twice 
on the TV screen - once on the even-numbered lines (2, 4, 6, etc.) and once on the odd-numbered lines 
(1, 3, 5, etc.). This interlacing keeps the image from flickering.
TV that is based on the HD standard can (but does not necessarily have to) display full frames, at a rate 
of up to 60 fps (frames per second).

Interlaced: The lines are clearly visible
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Basics of High Definition TV
Filming in HD

When filming in HD video, PAL and NTSC filmmakers face a new set of creative challenges:

� The cinematic widescreen format (16:9) requires a new type of image composition and a different reso-
lution for scenes. There tends to be “more” in the image.

� Progressive mode (frames at a frequency from 24 to 60 fps) can make movements in the image appear 
differently than they typically did in interlaced mode (field mode). Each still is either sharp or shows 
motion blur, depending on the shutter speed. The comb-like artifacts produced by interlacing in NTSC 
and PAL do not occur with progressive HD.

� This detailed recording causes things that used to disappear into the background, such as skin blem-
ishes, a forgotten coffee cup and the like, to suddenly become much more noticeable. Consequently, the 
preparation and setup of scenes for film shoots can turn out to be more costly and time-consuming.

Editing HDTV

HD clips are processed on the Timeline in exactly the same way as PAL or NTSC clips. Before you begin editing, 
you set the Timeline to the particular HD version, which also means that you can now edit MPEG2 IPB clips 
frame by frame on the Timeline.

Once you’ve committed yourself to a particular HD format, all the other visual elements adopt this format. To 
prevent unpleasant scaling effects, you should make sure graphics, titles and image menus have the same reso-
lution as the video HD format. Basically, however, it is possible to combine different formats in a Project and on 
the Timeline.

For more information on HD and MPEG2 IPB editing, see page 5-19.
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HDTV Basic Data

There is no definitive HD standard, but a whole range of different substandards. It is not yet clear which of these 
substandards will prevail. The individual substandards listed below are not directly compatible.

Standard Television (SD) Production and Transmission Standards

“i” = interlaced

Digital TV Transmission Standards (to ATSC)

“p” = progressive; “i” = interlaced

This table covers only the current NTSC market and only the Send formats.
NTSC drop frame formats (29.97 fps) are no longer supported.

Lines (total) Lines (active) Aspect ratio Frame rate / mode

525 (NTSC) 486 4:3 (rectangular pixels) 29.97 i

625 (PAL/SECAM) 576 4:3 (rectangular pixels) 25 i

625 (PAL plus) 576 16:9 (rectangular pixels) 25 i

525 (NTSC) 486 16:9 (rectangular pixels) 29.97 i

Vertical lines (active) Horizontal 
lines (active)

Aspect ratio Frame rate / mode

(HD)1080 1920 16:9 (square pixels) 24p, 30p, 30i

(HD) 720 1280 16:9 (square pixels) 24p, 30p, 60p

(SD) 480 704 4:3 (rectangular pixels) 24p, 30p, 30i, 60p

(SD) 480 704 16:9 (rectangular pixels) 24p, 30p, 30i, 60p

(SD) 480 640 4:3 (square pixels) 24p, 30p, 30i, 60p
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Basics of High Definition TV
Digital TV Production Standards

Production standards are relevant for filming (recording) and post-production. The table below lists the drop 
frame formats that are eliminated by the send standard.

“p” = progressive; “i” = interlaced
“h x v” = horizontal x vertical resolution

Active resolu-
tion (h x v)

Resolution 
(all lines)

Aspect ratio Frame rate / mode

1920 x 1080 2376 x 1250 16:9 (square pixels) 50p, 25i

1920 x 1080 2640 x 1125 16:9 (square pixels) 25p, 25i

1920 x 1080 2200 x 1125 16:9 (square pixels) 60p, 59.94p, 30p, 29.97p, 
30i, 29.97i

1920 x 1080 2750 x 1125 16:9 (square pixels) 24p, 23.98p

1920 x 1035 2200 x 1125 16:9 (rectangular pixels) 30i

1280 x 720 1650 x 750 16:9 (square pixels) 60p, 59.94p

960 x 486 1144 x 525 16:9 (rectangular pixels) 29.97i

720 x 483 858 x 525 16:9 (rectangular pixels) 59.94p

720 x 486 858 x 525 16:9 (rectangular pixels) 29.97i

720 x 576 864 x 625 4:3 (rectangular pixels) 25i

948 x 486 1135 x 525 4:3 (rectangular pixels) 29.97i

948 x 576 1135 x 625 4:3 (rectangular pixels) 25i

768 x 486 910 x 525 4:3 (rectangular pixels) 29.97i
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Basics of High Definition TV
HDV: HDTV for Consumers and Semiprofessionals

The HDV standard introduced by Canon, JVC, Sharp and Sony is intended to make HDTV available in the 
consumer sector as well. This format, which is also based on MPEG2 compression, is transmitted via the IEEE-
1394 interface (DV, FireWire) and provides two audio channels (MPEG1 Layer 2, 16-bit, 48 kHz @ 384 kbps). It 
is recorded on standard (mini) DV tape. 
Pinnacle Liquid can record and output HDV via the IEEE-1394 interface in the native format.

Active resolu-
tion (h x v)

 Bit rate
compressed

Aspect ratio Frame rate / mode

1440 x 1080 25 mbps 16:9 60i, 50i

1280 x 720 19 mbps 16:9 60p, 50p, 30p, 25p
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High Definition in Pinnacle Liquid

The advent of high definition video resulted in several changes in Pinnacle Liquid. This section summarizes the 
what, where and why of those changes.

Timecode systems  page 5-11

Multiformat in projects and on the timeline page 5-12

How HD and SD clips coexist

Quality ranks  page 5-16

For greater clarity in the network
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High Definition in Pinnacle Liquid
Timecode Systems

HDTV comes with a variety of frame rates (i.e. the number of frames played per second of 
video). As a result, the previously manageable range of timecode systems offered has grown 
slightly. The eleven different TC systems in Pinnacle Liquid’s TC displays are identified by 
the separator between the positions (period, comma, semicolon, colon). Initially, this only 
indicates the number of images per second - for example, how many frames are counted 
before the timecode display jumps forward one second.

Note that all TC fields in Pinnacle Liquid are always frames and never fields. The list below 
specifies the last frame before the full second.

Frames/second (Hz) Used for TC display 

23.98 HD 0 0:0 0 .00 ,2 3  

23.98 HD DropFrame 0 0.0 0 .00 ,2 3

24 Film 0 0:0 0 :00 ,2 3

25 PAL 0 0:0 0 :00 :2 4

29.97 NTSC 0 0:0 0 :00 .2 9

29.97 NTSC DropFrame 0 0.0 0 :00 .2 9

30 HD 0 0:0 0 :00 ;2 9

50 HD 0 0:0 0 .00 :4 9

59.94 HD 0 0:0 0 .00 .5 9

59.94 HD DropFrame 0 0.0 0 .00 .5 9

60 HD 0 0:0 0 .00 ;5 9

These TC formats appear, for example, in the timecode indicators for the Timeline, for the Master, Source and 
Clip Viewers, for the Logging Tool and for Record to Tape.

There can be only one TC system with a specific frame rate on the same Timeline and in the same Sequence (see 
the next section).

Timecode sys-
tems, e.g. for 
LIVE Player

(Logging Tool)
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Multiformat in Projects and on the Timeline

Multiformat in Pinnacle Liquid means: 
You can import any clips and media data to one and the same Project and view and edit them in the Project and 
on the Timeline, regardless of their origin (PAL, NTSC, HD or SD).

Pinnacle Liquid can handle all formats and timecode systems.

Differences in the aspect ratio and image resolution

There may be differences in the aspect ratio (4:3 or 16:9) and in the vertical and horizontal resolution of the 
image formats (e.g. NTSC = 720 x 486 vs. HDV 720 = 1280 x 720).

C l i p  V i e w e r  a n d  S o u r c e  V i e w e r

The Clip Viewer and Source Viewer adopt the setting of the current Sequence (check Timeline Properties). In the 
case of clips and objects that do not match this setting, the Scaling settings for these clips and objects have pri-
ority.
The Scaling options for the clip or object can be found in the clip’s or object’s Properties (also see “Media Mana-
gement and Object Properties”  on page 8-122).
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Depending on the setting for Scaling, one of the following may occur:

� Scaling not activated -
The image is centered in the image window. At a higher resolution, part of the image is displayed out-
side the image window; at a lower resolution, a border is visible on all or just two sides:

4:3 PAL clip in a 16:9 1280 x 720 image window without scaling

� Scaling activated -
The image is scaled, that is, stretched or squeezed, depending on the scaling option selected.

� Use image alpha activated or not activated -
If this option is not activated, objects with a lower resolution are displayed with a black border or bars. 
Otherwise, the area is transparent.

When converting to higher-quality formats, you can also use the Effect Editors (2D, 3D, Classic or RT).
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T i m e l i n e  a n d  M a s t e r  V i e w e r

Basically, the same applies to the Timeline and Master Viewer as to the other two viewers. It is possible to com-
bine clips with different aspect ratios and resolutions in one Sequence. However, you will probably prefer to try 
adapting the non-conforming clips to the Timeline or Sequence format selected, because a mixed master is gen-
erally undesirable.
The Master Viewer also adopts the setting for the Timeline: If the Timeline is set to an HDV format of 1280 x 
720, 16:9, square pixels, the Master Viewer has the same aspect ratio and clips with a different format are han-
dled as described in the section above (i.e. according to their Scaling).

True and Pseudo 16:9

Many camcorders (including semiprofessional ones) have a 16:9 switch. Although this switch produces the 
desired aspect ratio, 72 lines at the top and 72 lines at the bottom are simply displayed as black bars. The loss of 
these lines results in a poorer image quality when the image is scaled to the greater width.

This type of 16:9 should not be confused with HD; it is merely modified NTSC or PAL.

Different Timecode Systems

The timecode systems differ with regard to the frame rate (fps) and, to a certain extent, with regard to the drop 
frame/non drop frame problem (also see “Timecode Systems”  on page 5-11).

C l i p  V i e w e r  a n d  S o u r c e  V i e w e r

The Clip Viewer and Source Viewer always load and play clips and objects, both audio and video, using their 
original TC system. This means you can always work frame by frame and insert objects on the Timeline from 
mark-in to mark-in or at the Playline position.
If several clips with different TC systems are loaded in the Clip Viewer at one time, the TC system for the current 
Sequence applies (Timeline Properties).

Converting TC Systems

Normally, the TC systems of objects are automatically detected when these objects are imported or captured. 
This is controlled by an option in the Media Import dialog box. If you wish to impose a certain TC system on a 
clip, re-import it in the desired TC system with the automatic feature disabled (see “Default TC System”  on page 
6-51). This generates a copy of the clip at the selected frame rate. However, it may cause the associated audio to 
become asynchronous, so you should only import the video clip.
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T i m e l i n e  a n d  M a s t e r  V i e w e r

On the Timeline, there can be only one timecode system per Sequence. Timeline clips whose TC system differs 
from the TC system configured for the current Sequence are always played at the current frame rate. This means 
either that frames are omitted or that new frames are interpolated; the clip length remains the same. The system 
first attempts to accomplish this using a realtime effect. If it is unsuccessful, the relevant clips are rendered.

Converting TC Systems

Linear Timewarp provides a high-quality conversion. Apply this Timewarp to the relevant clips (Timeline clip 
shortcut menu), leaving the Speed at 100%. The clips are re-rendered with the TC system of the current Time-
line/Sequence.
This action has no effect on audio, which remains synchronous following the conversion.

As is always the case with Timewarps, this action must be performed before any other modifications 
take place (scaling, effects).

E f f e c t  V i e w e r

If the effect is applied to a Timeline clip, the Effect Editors and their Effect Viewers adopt the settings of the 
Timeline and Master Viewer.

If the effect is applied to a Project clip, the clip retains the original TC system, aspect ratio and resolution.

Nevertheless, the effect parameters themselves are non-format-specific, meaning that stored effects can 
be applied to all possible TC systems, formats and resolutions.
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Quality Ranks

“Quality” is a subjective rather than an exact variable. The final decision belongs to you or your customer. A 
scale of 31 levels (ranks) is provided for differentiating among the materials you work with in Pinnacle Liquid, 
where level 1 is the worst quality and level 31 the best. “Normal” quality, as we define it, lies exactly halfway 
between the two extremes at level 16. You will find these quality levels in the Logging Tool, clip Properties and 
Timeline properties. These ranks can be assigned to any media formats (codecs), regardless of HD or SD.

But note the following: The final decision is entirely up to you. We offer you only a prepared list of possible des-
ignations for these ranks. It is not until you capture one or more clips with the media format I-MPEG2 5 Mbit/s 
and designate them as “Quality Rank 7” that they really adopt this rank. Or to put it another way: The preset 
quality ranks are not permanently linked to any particular media format.

If you do not want to work with different material “quality ranks”, you would be better off leaving the 
default as is (16 Normal). Then you won’t have to adjust the setting in other modules and will not 
encounter any problems due to filtered-out media data ( page 9-49).

So why use quality ranks?

They help you distinguish among different versions of the same material. The individual ranking results in a 
hierarchy of media files with “Quality Rank 1” at the bottom and “Quality Rank 31” at the top. This is useful, 
for example, when performing offline editing. Or in the case of:

� Problems with storage media capacity. First select a format that requires less storage space.

� Shortage of bandwidth in the network. Formats with a lower data rate require less bandwidth.

A typical offline-online workflow involving quality ranks might look like this:

1 Select a quality rank (Logging Tool).

2 Capture the material in a format with a low data rate (e.g. DV (AVI)). Assign each clip the “Quality 
Rank 7” property, for example.

3 Edit the Sequence(s) on the Timeline.

4 Batch the Sequence(s) in the master format using, for example, Uncompressed (Batch Digitize module). 
Call this format “Quality Rank 20”, for example (it basically makes no difference).
The media files retain “Rank 7”.

5 In the Timeline Properties, change the Sequence(s) to the master-compatible format (in our example, to 
“Rank 20”). When playing the material, the system now accesses the uncompressed media files.

6 Output to tape/disk medium/export/etc.
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When are the quality ranks relevant and what do they do?

To summarize once again:

� Logging Tool, Media tab -
Establish the link between a selected media format and a particular quality rank.

� Clip Properties, V tab -
Assign an individual clip to media files with the same timecode but with a different quality rank.

� Timeline properties -
Switch all the clips in a Sequence to different media files by assigning them a different quality rank.
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High Definition at the Input

An HDV or MPEG2 signal can be played via the DV (IEEE 1394) interface of the editing computer and 
recorded with the Pinnacle Liquid Logging Tool.

HDV Capture

HDV does not require any additional hardware; you need only the IEEE-1394 (DV) port on your editing com-
puter or the 1394 port on the connection box. Simply configure your camcorder or player to output MPEG2 
HDV.

The Logging Tool automatically adapts to the imported signal, meaning that the image window is set to the 16:9 
aspect ratio. The system records MPEG2 video 1:1 native, i.e. without transcoding. 
Audio is decompressed and recorded as WAV.

At this time, only a live signal can be imported (i.e. no mark-in and mark-out set).

In contrast to DV devices, Windows does not necessarily identify HDV/MPEG2 devices automatically 
or correctly. You may have to install the necessary drivers manually. If so, consult the manual for your 
device or, if necessary, for Windows.

HD Import

Import HD material (whether HDV or uncompressed) using Pinnacle Liquid’s standard import commands.
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High Definition on the Timeline

This section provides information on HD clips and effects on the Timeline. Basically, you can combine clips of 
all formats and codecs in one and the same Sequence. For the smoothest workflow and best performance, how-
ever, try to use material that is as homogenous as possible.

Editing HD (MPEG2) Clips

Usually, high definition video is a compressed digital video signal of the type MPEG2 IPB. HD clips (e.g. 
imported native from HDV) can be edited frame by frame on the Timeline and in the Viewers. At each edit or 
trim point, the MPEG2 codec generates an I frame and organizes a new GOP (for more information, see the 
Output chapter, DVD Export, IPB Settings). 

Because MPEG2 IPB is not one of the possible render formats, any render files are generated with either 
the RGB or the MPEG2 I frame codec. You can define the Render/Fuse Codec in the Timeline Properties 
or when you create a new Sequence (“New Sequence”  on page 9-47)

The Consolidate function cannot be used for working with HD (MPEG2 IPB) material.
ALE and OMF data exchange based on HD Sequences is not possible.

High Definition and Effects

Continue to use effects (video and audio) as usual. Realtime performance for playback also depends on the HD 
format (i.e. the data rate) used.

HD Monitoring

The image of the HD clips from the Timeline is displayed in the Master Viewer inlay.
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Combining SD and HD Clips in the Same Sequence

As mentioned above, you can combine all possible formats and resolutions on the Timeline. Each time you cre-
ate a new Sequence, however, you must define a specific output format for each Sequence so that a uniform mas-
ter of the Timeline can be output. Clips that do not exactly match the defined output format are converted to the 
master format. This includes 

� Frame rate (fps) -
This property is adapted automatically by duplicating or eliminating frames. One second is always one 
second; each clip always retains its original length. The system initially tries to accomplish this by per-
forming a realtime adaptation (also see “Different Timecode Systems”  on page 5-14).

� Interlaced/progressive -
Automatic adaptation to a uniform interlaced or progressive mode.

� Aspect ratio -
This adaptation must be defined for each clip individually (or for several together) in the clip Properties. 
According to the default setting, each clip initially retains its original aspect ratio.

� Image resolution (size) -
Images that are too big or too small are initially centered in the Master Viewer inlay; clips that are too 
big are partially trimmed and those that are too small are displayed with black bars of varying widths. 
In order for these clips to fill the inlay, you must set the Scaling option in the clip Properties accordingly.
An NTSC clip in an HDV 720p Sequence is initially displayed with a black border but can be expanded 
to fill the window by changing the resolution to 1280 x 720 pixels. Note that this “upgrade” from SD to 
HD will not improve image quality (sharpness or richness of detail).
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High Definition at the Output
High Definition at the Output

Before it can be output, an MPEG2 Sequence that you have finished editing must be rendered in a uniform 
MPEG2 format. The IPB structure of the clips used, which was modified by editing and effects, is now con-
verted to a new, consistent IPB structure.

HDV Output via the DV Interface

With HDV, the Sequence is output by means of the Output to Tape module. You must select one of several possi-
ble recording formats offered by the recording device.

If the sequence has not yet been rendered or rendering is not complete when the module is called, output is 
delayed until rendering has been completed.

MPEG2 IPB and Output Using a Fuse Process

If you wish to output a Sequence that is completely or partially comprised of HD clips as an MPEG2 IPB file, use 
the Fuse process. In the Fuse dialog box under Post Processing Module, select the necessary parameters for the 
IPB structure. This generates an elementary stream (*.m2v).

The system encodes only those areas in which the original GOP structure was modified by editing or effects.
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This chapter describes the integration of material (objects) for editing and processing in Pinnacle Liquid. This 
material will generally originate from external sources (for example, digitizing via the video interfaces); how-
ever, some object types can be created using local resources (for example, title and color clips)
For information on data exchange and networking, refer to the next chapter (as of page 7-1); all the ways to out-
put from Pinnacle Liquid are described in the Output chapter ( page 16-1).

Logging and digitizing (Capture)  page 6-3

� Basics  page 6-4

� The Logging Tool and its functions  page 6-7

� Logging and digitizing methods  page 6-35

� Automatic scene detection  page 6-40

� File Ingest  page 6-42

� Background capture (Liquid blue) page 6-45

Import objects  page 6-47

� Import - where from, where to?  page 6-47

� What can be imported?  page 6-48

� Media clips  page 6-49

� Image import: Global settings  page 6-52

� Media management and object import  page 6-55

Transfer objects from other Projects  page 6-54

Create objects  page 6-56

� Color clip  page 6-57

� Generate signal clip (reference level tones)  page 6-59

� Titles  page 14-1

� Effects  page 10-3

� Voice-over (audio clip)  page 13-65
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Logging and Digitizing (Capture)
Logging and Digitizing (Capture)

In Pinnacle Liquid, the Logging Tool is responsible for logging (views) and digitizing (saving to hard disk) A/V 
signals or A/V data played via the system’s video and audio interfaces. In the process, clips and Media Files are 
generated with specific properties such as mono or stereo, an aspect ratio of 4:3 or 16:9, in a specific Media For-
mat and in offline or online quality (product-dependent). 
The Batch Digitize module permits the automatic digitizing of multiple clips ( page 8-77).

About timecodes: 
With regard to tapes in the player, make sure there is a continuous timecode without interruptions, 
jumps or repeated TC areas (for example, repeated positioning at 00:00:00.00). 
Pinnacle Liquid’s internal Media File management depends on unique Reel (tape) names and a correct 
and continuous TC. It is recommended that you either digitize problematic tapes live (for example, with 
a system TC, generated by the computer system clock) or first copy to tapes with a clean timecode.

Basics  page 6-4

The Logging Tool and its functions  page 6-7

Methods  page 6-35

Logging  page 6-36

Digitizing  page 6-37
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Logging and Digitizing (Capture)
Basics

Logging and/or digitizing defines clip properties:

� “Logging” and “digitizing”  page 6-4

� Clip-in/clip-out and mark-in/mark-out  page 6-5

� Stereo or mono  page 6-6

“Logging” and “Digitizing” (Capture)

Let’s begin by defining our terms:

� “Logging” means viewing (and listening to) played A/V material, where clips can be defined by means 
of their mark-in and mark-out. You can name and attach comments to these clips, store them in Project 
Racks and, if desired, transfer them directly to the Timeline. 
You can but do not necessarily have to digitize logged clips. You can make this decision later on. 

� “Digitizing” means transferring A/V data to the system’s A/V storage media so that it can be played and 
edited in Pinnacle Liquid. Since this term has come into common usage, it is also used where there is no 
actual “digitizing” (conversion via codec) taking place but data is simply being copied as when, for 
example, DV material is “digitized” (when it is transferred via i.Link/IEEE 1394). Another term for the 
very same process is “capture”.
Digitized clips are normally stored in Project Racks but can also be inserted directly on the Timeline (see 
“Send Clips To Timeline (Direct Insert)”  on page 6-30).
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Logging and Digitizing (Capture)
Clip-In/Clip-Out and Mark-In/Mark-Out

There is a fine distinction between the two:

The clip-in defines the first frame of a clip and the clip-out defines the last frame. Clip-in and clip-out points 
cannot be moved. If the Playline is positioned on the clip-in (for example, in the Clip Viewer), a triangle is dis-
played in the lower left-hand corner of the video inlay indicating that “there is no material to the left of (i.e. 
before) this point.”
Mark-in and mark-out points can be moved within the boundaries of clip-in and clip-out points but cannot be 
moved outside them:

Similar but different: The clip-in and mark-in for a clip

If, for example, you define a new clip in the Logging Tool, the clip-in and mark-in as well as the clip-out and 
mark-out start out in the same position and stay this way until you edit the mark-in and /or the mark-out. Any 
number of (sub)clips with many mark-in/out points can be attached to a single Media File, i.e. they point to the 
same Media File and refer to its data when played back.

Sometimes the software refers to a “Handle Length”. This means that a few frames are added before a clip’s exist-
ing mark-in and/or after its mark-out and that the mark-in/out is shifted accordingly. However, the boundaries 
of the clip-in/out cannot be exceeded.

Subclips are clips without their “own” clip-in and clip-out points whereas master clips each have their “own” 
clip-in and clip-out points. 

Mark-OutMark-In

Clip-In Clip-Out

Clip

Media File

Source Viewer

X X
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Logging and Digitizing (Capture)
Stereo or Mono?

Whether an audio clip is logged and digitized as “stereo” or “mono” has a decisive influence on audio editing in 
Pinnacle Liquid. Its behavior at the audio output of the system is determined, i.e. which sound tracks of the 
recording device are recorded. For detailed information on this topic, see “Stereo and Mono, Panorama and 
Balance”  on page 13-8. 

S t e r e o  a n d  M o n o  F u n c t i o n s

The symbol of a single ring or of the two engaged rings below the Source Track icons in the Logging Tool enable 
you to switch between mono (ring) and stereo (engaged rings) and assign the audio clips to “mono” or “stereo”. 
The main difference becomes evident as soon as the clips are placed on the Timeline:

� As a standard, stereo-audio clips are assigned to left/right. This means, uneven Source Tracks (A1/A3) 
are assigned to the outputs CH-1/CH-3, even ones (A2/A4) to the outputs CH-2/CH-4. This corre-
sponds with the convention left=uneven, right=even.

Also one individual audio clip can be a “stereo” clip: the Source Tracks A1/A3 are placed on the left out-
put, the Source Tracks A2/A4 on the right one (this is true for standard stereo routing).

� Mono audio clips are panned centrically by default, which means that their levels are uniformly 
assigned to the even and odd output.

In the Project Racks, the stereo/mono status of a clip is indicated in the Tracks column by an attached S or M, for 
example VA1A2-M (this refers to enabled Detail View). 

The mono/stereo setting is not final! You can change this assignment simultaneously for several selected 
clips via Properties or Adjust Audio. 

B a l a n c e  a n d  P a n o r a m a

One more important thing:

� The balance is controlled in stereo clips (like in your stereo system): the signal amplitude of one channel 
is reduced leaving the other one unchanged. The left/right signal assignment remains unchanged.

� The panorama is controlled in mono clips: the signal of a channel “migrates” e.g. from left to right. This 
does not change the signal amplitude, only the left/right assignment.
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Logging and Digitizing (Capture)
The Logging Tool and Its Functions

The Logging Tool is used for logging and digitizing (=capturing) material played from either a live source or a 
controllable player. In other words, it defines every aspect of clips from their length to their volume level and 
even their Media Format. 

To open the Logging Tool, press the F6 KEY on the keyboard or select File > Capture.
To close the Logging Tool click the exit symbol in the upper right corner.

This section describes the individual functions of the Logging Tool (sometimes also applicable to Batch Digi-
tize); logging and digitizing methods are described in the subsequent section ( page 6-35). 

The Logging Tool (Functions) 

� Display (inlay, timecode and status)  page 6-8

� Select player source  page 6-10

� Racks and Reels  page 6-12

� Controls (player and edit buttons)  page 6-14

� A/V inputs (select Source Tracks) page 6-17

� Stereo or mono?  page 6-18

� Select Media Format and Codec  page 6-18

� Destination drives for digitizing  page 6-19

� Select Audio Out  page 6-20

� Video Tool  page 6-20

� Clip tab: Name and number clips  page 6-21

� Liquid blue: Color Correction tab  page 6-22

� Audio tab: Control and edit level  page 6-27

� Master tab: Timeline video in the Logging Tool  page 6-29

� Media tab: where to store the media data  page 6-29

� Insert clips directly on the Timeline  page 6-30

� Properties  page 6-31
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Logging and Digitizing (Capture)
Logging Tool (letters refer to descriptions in text)

Video Inlay, Timecode Fields and Status Field
The video inlay displays the video signal currently being applied. If you are logging/digitizing audio data only 
(video Source Track not activated;  page 6-17), a loudspeaker icon appears in the inlay. 

T i m e c o d e  P o s i t i o n  F i e l d  ( A )
Depending on current settings, this field (to the left above the inlay, A) indicates 

� the player’s current TC position -
(if the player’s timecode is being used; may include a selected shift,  page 6-13). TC data is transmitted 
via the remote interface (RS 422 or IEEE 1394).

� the system time -
if the TC generated from the system clock is used (only in connection with the Live Player; Time of Day 
option).
TC count starts immediately after opening the Logging Tool or the selection of the Live Player, respec-
tively.

� an individually defined TC -
only in connection with the Live Player; Custom TC option).
Click in the TC field and enter a value.
To start or stop the TC count, use the Play function.

� an LTC -
supplied at an analog audio input (optional with some products; LTC In).

When a mark-in and mark-out are set, the current value in the TC position field is used. The same happens 
when you hit the Log and Digitize functions.

A

B

C D E F

J K

G

G

H

I
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Logging and Digitizing (Capture)
Timecode Systems

With the advent of HDTV, the previously straightforward offering of PAL and NTSC timecode systems has 
been expanded considerably: 11 different TC systems are identified by the separator between the numbers 
(period, comma, semicolon, colon). For a list of timecode systems, refer to the section entitled “Timecode 
Systems”  on page 5-11.

Go to a Specific TC Position:
Click the position field, enter a valid TC value and press ENTER. The player cues up the tape to the desired posi-
tion. If you enter invalid values (such as 25:00:01:01), the digits are displayed in red.

The same method is used in the Source Viewer, Clip Viewer and MasterViewer and in Record to Tape.

T i m e c o d e  M a r k - I n ,  M a r k - O u t  a n d  D u r a t i o n  F i e l d s  ( B )

These three fields below the inlay specify (from left to right):

� Mark-in (start of a scene or take)

� Duration (from mark-in to mark-out)

� Mark-out (end of a scene or take)

Edit TC Fields/Calculate a Timecode/Clear Fields

You can edit these fields. Missing values are automatically inserted. For example, if you set a mark-in and enter 
a duration via the keyboard, the mark-out is calculated. To add times to or subtract times from values, press the 
PLUS or MINUS key on the keyboard before entering the number. Example: To move the mark-in timecode 
10:01:02:03 ahead (towards the beginning of the tape) two minutes, click the field and enter: 
-00:02:00:00. Then press ENTER.

In the case of invalid entries, the TC digits are displayed in red.

� To clear all timecode fields (except Position), hold the SHIFT-KEY while clicking Cancel.

S t a t u s  F i e l d  ( C )

This field located above the inlay displays player status messages in plaintext (PLAY, STOP, STILL, REWIND, 
LOCAL, DIGITIZING, etc.). 

Graphical Display of Player Status
Alternatively, you can right-click the field to display the shortcut menu and switch to a graphical display. The 
player status messages are then displayed as “LEDs” with accompanying text (Servo, Color Servo, Reference, 
Remote, Rec Inhibit). 
This can help to identify a player problem, such as a missing or bad reference signal.
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Logging and Digitizing (Capture)
Player Source (D)

From the drop-down list box to the right of the status field, select a player source: either the LIVE Input or a 
controllable player/recorder (mandatory for Batch Digitize) connected via an interface (such as RS 422 or IEEE 
1394/i.Link DV/Firewire). Timecode data for the material is usually transferred via the control interface.

Selecting a player

The options available in this list reflect the settings under Edit > Control Panel > Site > Player Settings. The cor-
responding video and audio inputs are switched to the Logging Tool. To display this dialog box directly, click the 
icon to the left in the drop-down list. For descriptions of the various devices, refer to the separate product man-
ual. 

Liquidblue

L i v e  I n p u t

The LIVE input is used for non remote-controllable video and audio signals, i.e. when you feed in a signal 
directly from a camera or simultaneously edit the TV program. In Pinnacle Liquid, the LIVE input is treated as 
a player, but without the option of controlling it via RS 422 or IEEE 1394 (DV). 
Its video and audio inputs are configured in the same way as any other player (Edit > Control Panel > Site > 
Player Settings > Connections).

The LIVE input must have a timecode, which is defined under the LIVE Player options: 

1 From the Logging Tool, click the player icon next to the player drop-down list box (see figure above) to 
display the Player Settings as shown below:

In the case of MPEG IMX transfer via the SDTI video input, and depending on the IMX system, the 
video inlay continues to be displayed as long as the tape is running (even at double speed). In Pause 
(Still) mode, the input automatically switches over to SDI 3. This means that you can connect this 
input to the same machine that supplies the SDTI signal in order to view a frame in the video inlay 
even in Pause (Still) mode.
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Logging and Digitizing (Capture)
Selecting a timecode for the LIVE player

2 Click the plus sign in front of the LIVE entry, then select Options and double-click Timecode source. 
Select:
- Custom: Lets you enter a start TC in the Logging Tool’s TC display (“Timecode Position Field (A)”  on 
page 6-8).
- Time of Day: Generates the TC from the computer’s system clock.
- Video: Takes the TC from the video signal played (DV timecode). Note: VITC is ignored.

3 Custom TC: Select the Timecode System that matches the material being played.

 For more information on timecode systems, refer to the chapter “High Definition”.

LiquidEdition

Timecode sys-
tems for the 
Live Player 
(Live input)

A remark for users of Pinnacle Liquid in combination with analog input/output hardware: Use the Live 
Player to capture analog signals. One exception: with RS 422 remote it is possible to input analog sig-
nals and control a player device.
With IEEE 1394 (i.Link DV) remote control there is DV in/out exclusively. 
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Logging and Digitizing (Capture)
Reels and Racks (E, F)

Reel names define where the material originates. Racks define its destination. A Reel is usually a (video) tape 
but generally stands for a specific source.

An unambiguous and unique Reel name for each source is especially important in networked systems 
and for a subsequent Batch Digitizing operation. In the first instance it is important because Pinnacle 
Liquid Media Management is primarily Reel-name-oriented; in the second instance because automatic 
digitization is based on timecode data alone and can function only if the correct tape/source is inserted 
in the player.

If you are wondering what a “unique” Reel name is and how to come up with one as easily as possible, 
here is a suggestion: Use the day’s date in the Reel name:
For example, Reel01 12-09-02 (or a four-digit year to avoid the next millennium bug).
If you digitize live, you are certain to have a unique name if you combine a realtime TC (24-hour for-
mat!) and the day’s date. In a network, you can achieve further clarity by appending the editor’s initials. 
For example, Reel07 12-09-02 CPR.

The Shift Timecode function allows you to define a TC shift for a tape.

Racks permit you to arrange logged/digitized material. See “What Are Rack Folders and Racks?”  on page 8-8.

S e l e c t i n g / C r e a t i n g  a  R e e l  ( E )

The top middle list box allows you to select or create a new Reel. The term Reel generally refers to the source of 
the material (video tape, audio CD, DAT, etc.). Live sources are also assigned a Reel name. 

� To create a new Reel, click the icon to the left in the list box. A dialog box is displayed over the inlay 
where you can enter a name for the Reel.
Click the double-plus symbol to the right of the text box to append a digit to the Reel name entered that 
will automatically be incremented by 1 each time you change Reels (Tape 1, Tape 2, Tape 3, etc.). This 
option is per default active.

� If one or more Reels already exist in the Project, select a suitable Reel from the list:
The three most recently used Reels are at the top; below them are all the Reels available in the Project 
(provided that Media Files already exist for them).

� Optionally you can configure the Change Reel dialog box to not open when you call the Logging Tool 
( page 6-31). Per default the dialog will come up.

Pinnacle Liquid Media Management requires that Media Files be assigned to specific Reels. The Reel 
name should be unique (especially in a networked environment) to provide Media Management with 
unambiguous access to the material ( page 8-97). 
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About timecodes: 
With regard to tapes in the player, make sure there is a continuous timecode without interruptions, 
jumps or repeated TC areas (for example, repeated positioning at 00:00:00.00). 
Pinnacle Liquid’s internal Media File management depends on unique Reel (tape) names and a correct 
TC. It is recommended that you either digitize problematic tapes live (for example, with a system TC) or 
first copy to tapes with a clean timecode.

S h i f t  T i m e c o d e

This function in the Select Reel dialog box allows you to shift the timecode supplied by the source to a specific 
value. This shift applies to the entire Reel. Enter a value in the field preceded either by a “+/plus” or “-/minus” 
sign. This value is added to or subtracted from the TC specified in the Position field and used for a mark-in/
mark-out.

If this function is not available in the dialog box, this means it has been deactivated in the Logging Pro-
perties.  page 6-31.

S e l e c t i n g / C r e a t i n g  a  R a c k  ( F )

The top right list box allows you to select or create a new Rack. 

� To create a new Rack, click the icon to the left in the list box. A dialog box is displayed over the inlay 
where you can enter a name for the Rack. The logged clips will be stored in this Rack until you select 
another one. See“Creating New Folders/Racks”  on page 8-9.

� If one or more Racks already exist in the Project, double-click a suitable Rack in the list. The list also 
contains Rack Folders for the Project, which you can also open by double-clicking them.

You can also configure that the last Rack used will be activated when the Logging Tool is called. See 
“Start Logging Tool with last selected Rack” on page 6-31.
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Controls (Player and Edit Buttons, G)

The buttons for controlling the player and for defining clips are located on the left below the inlay. These but-
tons and their specific icons are found in many Pinnacle Liquid modules. 

The toolbars are configurable (see “Customizing Toolbars”  on page 17-8). You can also call these but-
tons via the keyboard. See “Modifiers and Keyboard Shortcuts (Defaults)”  on page 17-15 and “Assign 
Functions to Keyboard”  on page 17-11.

P l a y e r  B u t t o n s

These buttons allow you to control a connected (linear) player. In other modules where non-linear data is 
played, these buttons are used in the same way, i.e. for a digitized clip, “rewind” means a direct jump to the first 
frame in the clip/Sequence. 

Play

Starts play. To stop play, click this button again or click Stop.

Stop

Stops play at the current position. To stop play, you can also click the Play button again. 

Goto Start/Rewind

Rewinds the tape/jumps to the start of a clip/Sequence.

Goto End/Forward

Forwards the tape/jumps to the end of a clip/Sequence.

Step Back 1 Frame

Goes back one frame. 
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Step Forward 1 Frame

Goes forward one frame.

Shuttle Slider

Shuttles the tape ahead (drag to the right) and back (drag to the left). 

� You can also fix the slider in one position: Press the SHIFT key and release the mouse button at 
the desired speed.

Goto Mark-In

Cues up/jumps to mark-in, if any; otherwise to clip-in.

Goto Mark-Out

Cues up/jumps to mark-out, if any; otherwise to clip-out.

Play In to Out

Plays in a continuous loop from the mark-in to the mark-out, if both are set. If no mark-out is set, plays from 
mark-in to end. If no mark-in is set, plays from the beginning to the mark-out, if one is set, or to the end.

To stop “in to out loop play,” press the SPACEBAR on the keyboard, or click the Play or Stop button.

Shuttle Playback (JKL)

For forward and reverse playback at specific speeds, the Shuttle Playback button is also available in the Logging 
Tool, provided that the player supports this type of control. See also “Shuttle Playback (JKL)” on page 8-60.
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E d i t  B u t t o n s

These buttons (in the default configuration, located in the two vertical toolbars next to the inlay) allow you to 
define clips.

Mark-In

Sets the mark-in point at the current Playline position. You can set the mark-in point “on the fly” (during play-
back), or use the player commands to move to the point for the mark-in. If the mark-in point is already defined 
when you click this button, it moves the mark-in to the new position.

At this point the video image in the form of a Picon (miniature) is used as a visual reference. For a pure 
audio clip, a loudspeaker icon serves as the Picon. 
See also “Views” on page 8-31.

Mark-Out

Sets the mark-out point at the current Playline position. You can set the mark-out point on the fly (during play-
back), or use the jog/shuttle commands to move to the point for the mark-out. If the mark-out point is already 
defined when you click on this button, it moves to the new position. At this point the video image in the form of 
a Picon (miniature) is used as a visual reference.

If you set a mark-in at a position after the mark-out, the mark-out is deleted. If you set a mark-out at a 
position before the mark-in, the mark-in is deleted.
The frames which designate mark-in and mark-out points are included in the total duration.

Clear Mark-In and Mark-Out

Removes both the mark-in and mark-out points, if set. If only one is set, removes it.

Clear Mark-In

Removes the mark-in point.

Clear Mark-Out

Removes the mark-out point.

� To clear all timecode fields (except Position), hold the SHIFT-KEY while clicking Cancel.
Volume II Chapter Input6 - 16



PINNACLE

Logging and Digitizing (Capture)
Set Index Picture

In some cases the first frame and last frame index pictures may not clearly represent the content of a clip, i.e. in 
a pan the most telling images may only appear towards the end of the pan. Click Set Index Picture to select 
another frame, which will serve as the Picon of the clip. See also “Views” on page 8-31.

Set Marker

You can set markers at any position and attach comments to them. Also see “Setting Markers and Adding Com-
ments”  on page 8-57. 
When a live source is used, the marker button is not available.

A/V Inputs (Selecting Source Tracks, H)

The A/V signals (Source Tracks) to be digitized are determined by a series of buttons to the right of the inlay. 
Click the appropriate buttons to select (icon highlighted) or deselect them. 

Source Track selection affects Media File generation. See also “Media Management” on page 8-97. 

For example, activate the Video Source Track and Audio Source Tracks A1 to A4. The system then creates five dif-
ferent Media Files, one for each signal.

However, this occurs only when digitizing. 

LiquidEdition

It is possible to later add Source Tracks to clips and to re-capture these clips with all active Tracks. Add 
Tracks by clicking the appropriate checkboxes in the clip’s Properties. 
The number of Audio Source Tracks available depends on the system configuration and the current 
audio input.
If V is not selected, the video signal will not be displayed in the inlay.

Please note that even if you want to capture audio only, there must be a video signal present (to ensure correct 
synchronization).
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Stereo or Mono (I)

Whether an audio clip is logged and digitized as “stereo” or “mono” has a decisive effect on audio editing in 
Pinnacle Liquid. 

Click this button to switch between Mono (single ring) and Stereo (engaged rings). 

Also see “Stereo or Mono?”  on page 6-6 or for detailed information on this topic, see “Stereo and Mono, 
Panorama and Balance”  on page 13-8.

Selecting a Media Format/Codec Preset (J)

Here you can define the format in which the Media Files are digitized (or cap-
tured), in other words, determine the codec to be used (if any).

Depending on your editing system and the options installed, and selected sig-
nal inputs, the list box contains a varying selection of Media Formats or Codec 
Presets. If you read Native Transfer [format], this means: The incoming signal 
will be transferred bit by bit, unaltered by any codec. In all other cases (except 
Uncompressed) a codec will be involved in the capture process - for example 
when an analog signal is fed. Native Transfer is restricted to certain inputs and 
is generally not available with analog inputs.

The icon on the left in the list box takes you directly to the Codec Presets (Edit > Control Panel > Site), but only if 
this is a supported feature of the selected Media Format or codec. 

For more information on how to create a custom Media Format, see “Define Codec Presets”  on page 8-104. 

T h e  P r o b l e m  o f  S e l e c t i n g  F o r m a t s

Depending on the particular product, a large selection of media formats is now available for selection. Advice 
as to which one to actually select is hard to give. If you shoot and output DV or HDV, Native Transfer [avi] is 
probably a good choice: the image quality will be preserved throughout, its storage capacity demands are mod-
erate, and AVI files are compatible with many applications in the field.
In a more professional environment there are other things to consider. Sometimes it can become necessary to 
first edit in “offline” quality and later finish the project in Uncompressed media quality (“online”). Network 
bandwidth, compatibility with playout servers or news editing systems can also be important and thus influ-
ence the selection of a certain format.

List of Media 
Formats (sample)
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“Media Format” or “Codec”?

The way we use these two terms they’re basically interchangeable. Though “Uncompressed” is, strictly spoken, 
a Media Format, but not a codec - because there is no encoding or decoding by a codec involved. The Codec 
Presets are pairs of a codec and file format (see “Define Codec Presets”  on page 8-104).

Information in TV signal lines 9 through 22

Closed captioning (under titles) in Pinnacle Liquid only works with the Uncompressed (2vuy, yuv) format. It 
does not work with DV, DVCPro, MPEG, MXF and IPB formats. Uncompressed is the only capture format 
(Logging Tool, File Ingest) that preserves the CC data in the video stream. Please also note that applying an effect 
to two streams of video (that is, mixing the video) causes the CC data to be discarded.
Generally, all information that is contained in the lines 9 to 22 of the video signal (such as VITC, video text, 
CC) will be discarded in formats other than Uncompressed.

Liquidblue

Destination Volumes for Digitizing / Capture Volumes (K)

The two fields at the bottom right allow you to select the volumes (i.e. hard disk drives or directories) on which 
the A/V data should be saved (captured), one for video data (V) and one for audio data (A). 

List of available volumes (V and A)

If only one field AV is visible, separate recording of video and audio was deactivated (see also Video Tab/Audio 
Tab on page 8-117). 
These list boxes combine several functions:

� Display recording capacity - 
The remaining recording capacity of the current selected volume is displayed and continuously updated 
(time remaining, percentage of total capacity, absolute capacity remaining) during digitizing.

� Select volume -
On the list boxes, the mouse pointer changes to a triangle; click it to display the list of available drives 
and directories from which you can select a volume for digitizing.
This also changes the Primary Volume Definition,  page 8-117.

In the case of MPEG IMX transfer via the SDTI video input, and depending on the system, the video 
inlay continues to be displayed only for as long as the tape is running (even at double speed). In Pause 
(Still) mode, the input automatically switches over to SDI 3. Therefore, you should connect this input 
to the same machine that supplies the SDTI signal.
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� Edit Media Management settings - 
Whatever you can select from the list is defined in the Media Management Settings (Edit > Control Panel 
> Site > Media Management Settings;  page 8-116). Click the V or A icon to go there directly.

� Tooltip with volume information - 
When you rest the mouse pointer on the field, a tooltip is displayed indicating the complete path of the 
volume currently selected.

� Warning before capacity limit is reached - 
If you define a clip whose dimensions exceed the available memory, a warning flashes in the list box.

For capturing (digitizing) purposes, please use NTFS partitioned hard disk drives exclusively. FAT32 
may cause problems with longer clips (i.e. > 18 minutes).

Select Audio Monitor /Mute

With more than two audio signals at the system’s input you may select the inputs you wish to monitor while 
working with the Logging Tool.
Select an option from the menu that appears after you clicked the button.

Video Tool 
Note: The Video Tool / Calibration Control is an Pinnacle Liquid feature only in combination with an analog 
break-out box and with an analog input selected.

Click this button to open the Video Tool / Calibration Control window to adjust the Black Level, Video Level 
(luminance) and Chroma of the incoming video signal, among others. All changes made are automatically 
reflected in the video inlay and on the connected video monitor.

Check the VCR box when the incoming signal is unstable or otherwise of questionable quality (e.g., coming 
from an old VHS tape). A bad video signal can throw the capture process.

The Video Tool/Calibration Control has an immediate effect, meaning that an appropriately modified 
Media File is generated during the digitizing process. For this reason, the procedure is also said to be 
“destructive”.
During logging, no Video Tool parameters are written to the clip data, nor are they taken into account 
for a subsequent Batch Digitize operation.

If you are working with uncompressed video signal, the Video Tool is not available.
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Clip Tab: Naming and Numbering Clips
The Clip tab contains text fields and functions for naming and (automatically or manually) numbering clips.

Taken all together (but also individually), the entries in the Title, Scene, Take/Shot and Attribute fields produce 
the Clip Name specified above the text fields. Textual Presets can also be used ( page 6-31).

� Activate the checkbox to the right of an input field to add a particular entry to the clip name. 

� Use the TAB key to move from field to field.
As soon as you press ENTER, the keyboard returns to player control mode. For example, you then can 
start or stop the player by pressing the SPACEBAR. 
Press TAB again to return you to text input mode: Pressing TAB once takes you to the Clip tab and press-
ing it a second time takes you to the Title text field.

� Click an individual plus sign to increment the count by one. For the first clip, a “1” is appended to the 
text. If you activate automatic counting (double plus sign), numbering is performed automatically for 
each newly logged or digitized clip.

Automatic numbering is especially helpful with default textual presets. You can define these presets in 
the Logging Tool properties.  page 6-31

 

Clip tab for naming and numbering clips (Color Correction not in all products)
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Color Correction Tab 

This tab contains the functions for primary color correction. 
Pinnacle Liquid Color Correction works non-destructively, i.e. the material played is digitized or saved without 
modification, just as it is received via the interface.

The correction attributes are saved with the clip metadata and used in real time for playing back the digitized 
material.

The correction attributes are saved with the clip metadata and used for rendering. This ensures that the original 
material is always available for editing.

For information on the Legalizer and Reference Sets see: “Tools”  on page 12-26.

Primary Color Correction in the Logging Tool is identical to Primary Color Correction in the Color Cor-
rection Editor only with regard to its mode of functioning. These correction types are separate applica-
tions that have no effect on one another.

Logging Tool Color Correction

Liquidblue
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C o l o r  C o r r e c t i o n :  B a s i c s  

Color correction is a science in itself; for this reason, only an outline can be presented here.

The Color Wheel 

The color wheel - a physiologically inspired reflection of 
the phenomenon of color vision - is based on the 
assumption that four basic colors form two opposite 
pairs: red and cyan, blue and yellow.

Add to this the brightness, which ranges between white 
and black. These three pairs can be spread over a three-
dimensional coordinate grid (color space) in which each 
color that can possibly be displayed is defined by its blue 
or yellow component, red or green component and a 
brightness. In color television technology, the opposite 
color pairs are replaced by the color difference signals R-
Y (Cr,U) and B-Y (Cb, V). The luminance signal Y forms 
the third coordinate. 
The basic colors red, green and blue and the mixed colors 
magenta (violet), cyan and yellow that lie in between are 
points (color signal locuses) within this wheel. Thus the 
color phenomenon is also displayed in the vectorscope 
(the use of this measuring device for color manipulation 
is highly recommended). 

When examining a color bar in the vectorscope, each of the colors named above is represented by a glowing dot 
at a specific location of the screen (like the tip of an arrow; see figure). The arrows are called vectors. With the 
aid of these vectors, all the possible points (= colors or hues) within the wheel can be precisely defined mathe-
matically.

The position of a point relative to the center of the wheel affects the colorfulness (saturation) of a color; a pale 
blue is close to the center and a vibrant, fire-engine red is located near the wheel’s periphery. A hue (red, green, 
blue, etc.) is an angle in the color wheel. Pure red is located at approx. 104 degrees and red-violet (magenta) at 
approx. 92°. Note that in the degree scale of the vectorscope, 0° is located at “3 o’clock”. 
Thus a color is adequately defined by the length of the vector and the angle. On this basis, color corrections are 
performed in the “YUV” color space. 

Red 104°

Yellow 
167°

Green 241°

Magenta 61°

Blue 347°

Cyan 284°

90°

270°

180° 0°

Color wheel and color vectors 
(vectorscope view)
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RGB Color Model 

It is also possible, however, to use three bars for quantitatively displaying a hue. These bars (one red, one green, 
one blue) can be seen in Pinnacle Liquid Color Correction. A color appears to be composed of different percent-
ages (bar lengths) of the three basic colors RGB, apart from the pure basic colors themselves. RGB is generally 
specified in values from 0 to 255. Example: (0,255,0) is pure green; (0,0,0) is black; (255, 255,255) is white. 
Computer monitors and TV screens generate colors from “packages” of red, green and blue dots illuminated at 
different intensities. 

S h a d o w s ,  M i d t o n e s ,  H i g h l i g h t s ,  B l a c k ,  G a m m a ,  G a i n  

Pinnacle Liquid Color Correction can be applied in measured doses in three graduated luminance areas:

� Shadows (black, pedestal)

� Midtones (gamma)

� Highlights (gain, lift, white value)

By selecting an area, you can perform selective color corrections. In each of these areas, you can control the red, 
green and blue color channels and the brightness (luminance - gray bar) separately or together ( page 6-25).

H u e  a n d  S a t u r a t i o n  

These two functions affect the entire image. 

� Hue -
With this function you travel once around the entire color wheel either clockwise or counter-clockwise 
(“Color wheel and color vectors (vectorscope view)”  on page 6-23).
To view the effect, try applying this function to the color bars test image. Each color gradually changes 
to the color adjacent to it in the color wheel.
This function is especially important in the NTSC standard because it can be used to balance the color 
shifts typical of NTSC.
Value range: +/- 255.

� Saturation - 
This function adjusts the colorfulness of the image from achromatic (black-and-white, completely de-
saturated) to very, very colorful (over-saturated). 
Value range: +/- 255.
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S e p a r a t e  a n d  L i n k e d  C o n t r o l  

Pinnacle Liquid Color Correction in the Logging Tool is primary color correction (as opposed to secondary or 
selective color correction). It is clip-based, meaning that modifications apply from a mark-in to a mark-out (no 
key frames). Later on you can edit the parameters in the Clip Viewer.

Your settings are retained from clip to clip unless a Reel change has since been performed and a restoration of 
values is activated (see Logging Tool Properties,  page 6-31). 
The Restore to Default button shown here resets all the parameters to zero.

Separate Control (RGB) 

Red, green, blue and brightness (luminance) can be controlled separately. Nevertheless, a change in a color 
channel also causes a change in luminance. Proceed as follows:

1 Start playing the play source and define a mark-in point ( page 6-36). 

2 Click the Black, Gamma or Gain (shadows, midtones or highlights) button to select a correction area. 

3 Drag one of the color bars or the luminance bar to the desired position or enter a value from -255 to 
255. Single-click the small button next to a bar to reset it to the original value.

4 The effect is instantly visible in the video inlay. 

5 The correction parameters are transferred to the clip properties as soon as the clip has been completely 
logged or digitized.
A blue five-point star appears on the clip Picon in the Rack indicating that Color Correction attributes 
exist for the clip.

6 To deactivate the modified attributes, see the sections on Attributes, “Tab: Special”  on page 8-70 or “FX 
Properties”  on page 8-71.

7 Liquid blue  continuously displays the modifications in real-time.

Subsequent RGB color corrections are always possible. See also “Primary Color Correction, Playback Level and 
Scene Detection” on page 8-61.
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Linked Control 

In this mode, the hues are linked in order to keep the luminance value at a constant level. A color cast can be 
corrected much faster in this mode than if the components are regulated separately. It is applied directly in the 
inlay using the mouse.

1 Start playing the play source and define a mark-in point ( page 6-36). 

2 Click the Black, Gamma or Gain (shadows, midtones or highlights) button to select a correction area. 

3 The modifications are performed directly in the inlay:
Hold down the right mouse button and drag the pointer up and down to change the luminance.
Hold down the left mouse button to change the color: Imaging the color wheel ( page 6-23) superim-
posed on the image; dragging the mouse toward “11 o’clock” intensifies the red and dragging it toward 
“5 o’clock” diminishes it. The same applies to the other color locuses in the color wheel. The luminance 
value remains the same.
The RGB bars move simultaneously. Single-click the small button next to a bar to reset it to the original 
value.

4 The effect is instantly visible in the video inlay.

5 The correction parameters are transferred to the clip properties as soon as the clip has been completely 
logged.
A blue five-point star appears on the clip Picon in the Rack indicating that Color Correction attributes 
exist for the clip.
To deactivate the modified attributes, see the sections on Attributes, “Tab: Special”  on page 8-70 or “FX 
Properties”  on page 8-71.

6 Liquid blue  continuously displays the modifications in real-time.

Subsequent color corrections in RGB mode are always possible. See also “Primary Color Correction, Playback 
Level and Scene Detection” on page 8-61.
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Audio Tab

Here you can control and adjust incoming audio signals.
For a description of the functions and elements of the faders and audio peak meter, 
see “Audio Tool”  on page 13-14. 

Audio tab (sample)

D e s t r u c t i v e  a n d  N o n - D e s t r u c t i v e

When an incoming audio signal is digitized or saved without any signal-related changes, the procedure is “non-
destructive”. Modifications such as level changes are recorded separately as parameters and are not used until 
playback. (See “Playback Level” on page 6-28.) The advantage is that the Media File remains unchanged. 
In the destructive procedure, the signal is already modified before being saved to the storage medium. The only 
way to the original is via the original itself.

Pinnacle Liquid always gives you the option of adjusting all signals in non-destructive mode using the 
Playback Level function. Depending on the product hardware and the signal type, however, the audio 
input can also be adjusted destructively.
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I n p u t

These four faders and the associated levels affect or control the incoming audio signal of active Audio Source 
Tracks (product and signal dependent; see overview below).
For a detailed description of operation and information on digital audio (level scales, clipping, headroom, etc.) 
see the “Audio Tool”  on page 13-14.

Level Is Too High
If the amplitude of the input level is clearly too high (and cannot be compensated by adjusting it downward, as 
far as possible):

� For analog signals:
Control the input resistance and attenuation at the input 
Liquid blue : Edit > Control Panel > Site > System Settings > Inputs/Outputs > Audio Inputs. 

� For digital signals:
To adjust these signals, you would have to connect a suitable mixer in series or adjust them at the output 
of the signal source. 

Liquid blue : To adjust input channels 5 to 8 (SDI and AES/EBU), select Edit > Control Panel > Site > Player 
Settings to switch to the corresponding audio input. 

P l a y b a c k  L e v e l

The Playback Level (volume) is a clip attribute and a non-destructive setting. You can already define the volume 
level at which the clip should be played back on the Timeline when logging/digitizing.

Control the Playback Level using the fader on the left side of the tab. The associated level meter (right) is always 
visible.
It displays up to four audio input signals as narrow yellow bars, as well as the current Playback Level as a slightly 
wider bar with a numeric indicator above it.

Note the following: 

� The Playback Level applies to all the Audio Source Tracks of a clip and to the complete clip (no key fra-
mes).

� For identification purposes, a small blue star appears in the upper right-hand corner of the Picon of 
clips with a modified Playback Level (see also Object Icons (Picon View) on page 8-37).

� The waveform display of audio clips in the Timeline and in the Source Viewer’s Waveform Inlay repre-
sents changes made to the clip’s Playback Level; i.e., a low volume Playback Level results in a flattened 
waveform.

� The level meter on the right remains visible regardless of which tab is in the foreground.

� The Playback Level can also be set later on via the extended dialog box in the Clip Viewer ( page 8-50).

� To deactivate the modified attributes, see the sections on Attributes, “Tab: Special”  on page 8-70 and 
“FX Properties”  on page 8-71.
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Your settings are retained from clip to clip unless a Reel change has since been performed and a restora-
tion of values is activated (see Logging Tool Properties,  page 6-31).

Master Tab

This tab shows an inlay containing the frame on which the Timeline Playline is currently positioned. It lets you 
determine the insert point for the Direct Insert function (Send clips to Timeline; see next section). 
Using the mouse, you can scrub directly in the inlay or in the Timeline/Timecode bar.
Note: You cannot play the current Sequence in this inlay.

If you scrub the Timeline during digitizing (capturing), individual frames may be omitted (not cap-
tured to the file). We recommend that you wait until digitizing has been completed before scrubbing the 
Timeline.

Media Tab 

� Quality rank -
leave this setting at its 16 (Normal) default unless you have specific reason to change it. For more infor-
mation on this feature, see the section called Quality ranks in chapter “High Definition”.

� CMS/Local -
this selection is only for systems configured for Liquid Editing for Workgroups or Vortex networks. You 
can either save captured data to a local storage or via a CMS/MDC (Content Management System/Meta 
Data Controller) to a network storage location. For local storage, check the Media Management Settings 
(Edit > Control Panel > Site...). Other network-related settings should be left to the network administra-
tor.
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Send Clips To Timeline (Direct Insert)

This function allows you to compile a rough cut directly from the Logging Tool, either with already captured 
(digitized) clips, or with logged-only clips. A non-digitized Sequence can then be digitized by means of Batch 
Digitize ( page 8-77).
This button is either activated (icon highlighted) or not.

1 Click the button repeatedly to toggle between insertion in Film Style (yellow icon), insertion in Over-
write Style (red icon) and deactivate insertion (see also Edit Styles on page 9-25).

2 To specify the Tracks on which the clip should be inserted, activate the Tracks you want using the correct 
Mapping ( page 9-22).
You can drag all Track Labels with the mouse to specify certain destination Tracks for certain clip types.

3 Open the Master tab and define an insert point 
either by means of a mark-in
or at the position of the Playline (important: a mark-in has priority over the Playline position). 
You can also set a mark-out.

4 Start logging/digitizing using any one of the methods described.

5 The clip is inserted on the Timeline as soon as it has been completely logged/digitized.
The clip is also stored in the current selected Rack.

If you exit the Logging Tool while Send Clips To Timeline is activated, it is then deactivated.
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Properties

This button (upper right-hand corner next to Rack drop-down list box) opens the Properties menu. Some of the 
options described below are also relevant for the Batch Digitize module.
(The menu also offers direct access to the System Settings dialog.)

G e n e r a l  S e t t i n g s

Open/Close/Change Reel Section

Open Select Reel dialog on entering Logging Tool

If this option is activated, the Select Reel dialog box ( page 6-12) is displayed automatically each time you open 
the Logging Tool.

Stop attached player when Logging Tool is closed

If this option is activated when you close the Logging Tool, a stop command is issued to the player.

Start Logging Tool with last selected Rack

If this option is selected, the Logging Tool is opened with the last Rack selected. This allows you to begin storing 
logged/digitized clips without making any other selections.

Keep Color Correction/Audio when changing the Reel

This option ensures that Color Correction values and the Playback Level are retained each time the Reel is 
changed.

Activate TC Shift mode

If this option is activated, the Select Reel dialog box contains a timecode field in which you can enter the desired 
shift.

DEVICE Section

Stop attached player after Open End capture

Stops the player the next time you click Digitize, effectively terminating the capture process.

Capture device to Stdby Off if not used

This option reduces wear on the tape and video heads. 
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CAPTURE Section

Ignore dropped frames for LIVE Capture
The capture process normally aborts when frames are dropped. When active, this option causes any dropped 
frames to be ignored while the live capture process continues. Bear in mind that inconsistent timecode can 
make subsequent Batch Digitize impossible.

Ignore Timecode embedded in source stream
Most analog to DV converters do not handle TC data. In Batch Digitize, this can lead to problems. TC data can, 
however, also be transmitted over a RS 422 remote connection. To use this data instead of the DV TC, enable 
this option. With this method, however, frame accurate batch capture cannot be guaranteed. We recommend 
the use of converters that embed RS 422 TC data in the DV stream.

VITC contained in the video signal is ignored.

Enable RapidCapture 
With this option enabled, the system starts digitizing (capture) the very instance when the servo of the player 
goes in its “locked” status, that is, when the video signal is stable. It makes no difference whether the player was 
started manually or controlled by the Logging Tool.

Thus, you only need to open the Logging Tool, insert a tape in the player, name or select a Reel, and click the 
Play button. Capture starts as soon as the video signal is stabilized. This function can also be used in combina-
tion with Automatic Scene Detection.
There is one additional option:

� Discard if less than... [frames]
Clips which duration would be below the specified limit will not be kept, but discarded. This duration 
refers to the interval between start of player and stop of player. If this interval is shorter than the entered 
time, the clip will not be stored.

Set Lead-In for Mark-In during logging
If this option is activated, the mark-in will be shifted ahead (toward start of tape) by the specified value. The 
player must be in PLAY mode (not fast forward, rewind or shuttle). This primarily serves to compensate for 
response time delays during “on the fly” logging ( page 6-36).

Automation Section

Auto 3pt
(Available only in conjunction with the Send Clips to Timeline (Direct Insert) function - see  page 6-30.) You do 
not need to set a mark-out when capturing in the Logging Tool but you must set a mark-in and mark-out on the 
Timeline. Send Clips to Timeline must be activated. The Logging Tool records the clip for the duration of time 
period specified by the mark-in and mark-out on the Timeline. The clip is then inserted on the Timeline (and in 
the rack).

Use Scene Detection, If Available
See “Automatic Scene Detection”  on page 6-40.
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T C  B r e a k  B e h a v i o u r  ( L o g g i n g  To o l  o n l y  a n d  R S  4 2 2 )

Discontinuous timecode on a player tape can cause problems during digitizing. If the mark-in is set too close to 
a TC break, this can interfere with the tape deck’s preroll; during Batch Digitize the correlation of clips and cor-
responding locations on the tape can be lost. 

If you use Liquid Edition  with an RS-422-controlled player, disable the “RefAlarm” function at the 
player. This is an alarm message indicating a missing reference (Genlock). Because Liquid Edition  
cannot be synchronized with a studio clock, the software error message “Reference missing or bad” is 
output.

Complete loss of sync (for example, noise between encoded/recorded sections of a tape) can cause the 
digitizing process to be cancelled. Some players can be set so that at least a stable synchronous signal is 
always output. 
These features work under the assumption of TC “breaks”, that is, skipped TC info, while the synch, or 
burst, signal remains intact.
TC delivered via LTC In (analog audio input) does not qualify for these options.

Choose one of three options (CAUTION: use only with RS 422 remote and on Open End capture, that is, when 
no mark-out is set):

� Create new clip after TC Break - 
Pinnacle Liquid detects a TC break and stops digitizing in order to continue after the interruption. The 
new mark-in is set so as to take into account a five second preroll time.
The additional clip is clearly indicated and stored in the current Rack.

� Continue digitize and set TC Break Marker -
Digitizing continues; where the timecode was interrupted, red markers are set on the position bar in the 
Clip/Source Viewer and on a Timeline clip.

In order to delete a TC break Marker, place the Playline over the Marker, hold the CTRL and SHIFT keys 
simultaneously and click the Delete Marker button.

� Stop digitize at TC Break -
Digitizing is stopped, the system prompts you to either cancel the ongoing process (media and clip will 
be discarded), or keep the so far digitized clip.
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D i s k  F u l l  S t a t e  /  C h a n g e  Vo l u m e

As soon as the current capture drive (destination volume) becomes filled to a certain limit, the system can auto-
matically change to another volume or drive although not without issuing a warning. In other words, here you 
can define when the drive is considered “full”.

� Disk considered Full if remaining disk space less than -
Enter the amount of disk space (in MB) that should still be available on the capture drive when one the 
following actions is performed:

� Full State warning lead time (remaining logging time until full state condition is reached) - 
If activated, a warning is issued in the video inlay and in the capture drive list box when the disk 
approaches the Full State. You can define when this warning should be issued in terms of the number of 
seconds remaining before the limit is reached.
This is a Logging Tool feature only.

It is generally recommended that hard disk storage not be used to the limit of its capacity, i.e. that you 
set the limit so that at least 20 percent remains. Never set Disk Full State to 0 (zero)! 

� Switch to next available free volume after Full has been reached (Batch only) -
Pinnacle Liquid checks whether the current clip can be completely digitized within the space remaining 
on the current storage medium. If not, it immediately changes to the next drive. 
This is a Batch Digitize feature which does not work in the Logging Tool.

The “next volume” meant here is the next available volume with sufficient storage capacity, not neces-
sarily the one which follows as next in the list. 
Drives and volumes are defined in the Media Management Settings.
 Important: The access rights must be set to Write (“Video Tab/Audio Tab”  on page 8-117).
Additional changes are possible if the list of drives is sufficiently long.
If Disc Full State is ultimately reached (no further volume changes possible or enabled), digitizing stops 
and the Digitize button starts flashing: see “Full Control Digitize”  on page 6-37.

Te x t u a l  C l i p  P r e s e t s

Here you can define the defaults for the text fields (see also Clip Tab: Naming and Numbering Clips on page 
6-21). These entries are then permanently defined for each newly created clip and can, for example, be supple-
mented with automatic numbering. Of course, the default presets can also be deleted from the fields on a case-
to-case basis.
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Methods

Various methods are available for logging and digitizing that can be selected on the basis of the particular appli-
cation and as a matter of personal preference. 

� Before logging/digitizing: Checklist  page 6-35

� Logging  page 6-36

� Digitizing  page 6-37

� Stop (All Stop)  page 6-40

� Automatic scene detection  page 6-40

� File ingest  page 6-42

� Background capture (Liquid blue)  page 6-45

Before Logging/Digitizing: Checklist 

Before you start logging and/or digitizing, be sure to check the following important settings and options:

� Is the correct source selected?  page 6-10

� Has a Reel been selected/named and a Rack found?  page 6-12

� Has a Media Format been selected (if available)?  page 6-18

� Have the correct capture drives (volumes) been specified?  page 6-19

� Have Source Tracks (audio/video) been specified?  page 6-17

� Has Mono/Stereo been defined?  page 6-18

� Are problems with the timecode to be expected (only with RS 422 remote)?  page 6-33

Even while the Logging Tool is active, objects in the Timeline and in the Project remain accessible and 
can be edited.
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Logging

Logging is possible only with material played via a source that can be controlled by Pinnacle Liquid. Signals that 
are played live can only be digitized (and only open end). 

L o g g i n g  w i t h  a  M a r k - I n / M a r k - O u t

The most precise method is as follows:

1 Cue up the player to the mark-in point. 
See also “Controls (Player and Edit Buttons, G)” on page 6-14.

2 Set the mark-in.

3 Cue up to the mark-out point and set the mark-out.

4 Enter any necessary text in the text fields and click the Log button. 
This serves to store the logged clip in the selected Rack and clear the timecode fields; the Logging Tool is 
then ready for you to define another clip.

All data can be modified until you click the Log button.
You can also set a mark-in and mark-out while the player is running. This is known as “on the fly” log-
ging. In order to compensate for response times, you can set a lead-in for the mark-in ( page 6-31).
If the Send Clips To Timeline function is activated, the clip is also set in the Timeline.

L o g g i n g  w i t h  t h e  L o g  B u t t o n

This variant lets you click one less time when defining clips:

1 Click the Log button once to set the mark-in.

2 Click it again to set the mark-out and transfer the clip to the Rack and, if the Send Clips To Timeline 
function is activated, to the Timeline as well.

If either a mark-in or mark-out is already set, or if either a mark-in or a mark-out is set together with a 
duration, clip definition is already completed the first time you click the log button.
You can also set a mark-in and mark-out while the player is running. This is called “on the fly” logging. 
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S o n y  C l i p L i n k ™ ( D V  i n  o n l y )

ClipLink™ is a function that transcends the conventional separation of shooting and editing. In conjunction 
with specific DVCAM players, such as the Sony DSR-60/60P, 80/80P or 85/85P, Pinnacle Liquid generates clips 
automatically. Thus non-linear editing can start almost instantly. ClipLink™ log data such as the scene number 
and time code data are recorded into the cassette memory. Index Pictures, which are compressed images taken 
from the start of each scene are recorded onto the tape. When editing, ClipLink™ log data and index pictures 
are transferred to Pinnacle Liquid, and clips are automatically created in a Rack. 

Pinnacle Liquid also takes over the OK/NG Flag of Clips, which is important for example for the batch digitiz-
ing ( page 8-77) process.

O f f l i n e  L o g g i n g

Offline logging occurs when clips are to be defined without players that can be controlled.
The timecode values of mark-in and mark-out points are entered manually. Otherwise the process is the same 
as logging with a connected player (also see “Before Logging/Digitizing: Checklist”  on page 6-35).

If Pinnacle Liquid Media Management finds a Media File that matches the clip data entered, the clip is 
considered digitized” and can be played immediately. See also “Matching Clips to Media Files” on page 
8-110.

� To clear all timecode fields (except Position), hold the SHIFT-KEY while clicking Cancel.

Digitizing (Capture)

In the Logging Tool, digitizing is started or terminated by means of the button displayed. Several variants are 
available.

If you’re working with the Live Player set on Custom TC: Enter the desired start TC value in the TC field, 
start the counter by clicking Play. Now the Digitize button can be selected.

F u l l  C o n t r o l  D i g i t i z e

“Full Control Digitize” means that the system controls digitizing from the mark-in to the mark-out (Batch Digi-
tize is always “full control”). The other mode is “open-end” ( page 6-38).
In the Logging Tool, individual clips can be “full-control digitized”.
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This happens after you click the Digitize button:

� Mark-in and mark-out set:
The player cues up to the preroll position and changes to “Play”. Digitizing starts at the mark-in. The 
message DIGITIZING appears in the status field and a progress indicator is displayed in the Duration 
timecode field.
The digitizing process stops at the mark-out and so does the player. The digitized clip is transferred to 
the Rack, and to the Timeline if selected (see  page 6-30).

The current process can only be cancelled by clicking the Cancel button ( page 6-40).

A yellow flashing Digitize button indicates changes or additions made in the clip tab during digitizing, 
or the occurrence of errors. Either click Stop to discard the current clip or the Digitize button to com-
plete the ongoing operation.

O p e n  E n d

In this mode, the system has no control over the procedure. The user starts and stops the player and the digitiz-
ing process. Digitizing from a live source is always “open-ended”:

� Mark-in set:
The player cues up to the preroll position, changes to “Play” and starts digitizing as of the mark-in.
The status field contains the message DIGITIZING.
Duration timecode field: Here timing starts as of the mark-in.
Digitizing stops as soon as you click the Digitize button again.
The digitized clip is transferred to the Rack, and to the Timeline if selected 
( page 6-30).
If you click Stop, the so far digitized clip with its corresponding Media File(s) are discarded.

� Start/stop digitizing:
Click the Digitize button once to start digitizing. Click it again to stop the process and transfer the clip 
to the Rack, and to the Timeline if selected ( page 6-30).

� If you click Cancel the so far digitized clip with its corresponding Media File(s) are discarded.

Digitizing affects the pending A/V signals as they are defined in the particular play sources ( page 6-10) and as a 
function of the Source Tracks selected ( page 6-17). Players (such as CD players) may have to be started and 
stopped manually.
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C r e a t i n g  S u b c l i p s

Subclips are components of a higher-level clip (master clip); they all reference the same Media File. However, 
subclips have their own clip-ins and clip-outs.
To a certain extent, the creation of subclips combines the digitizing and logging processes; during digitizing, 
the mark-in/mark-out points are repeatedly set and clips are repeatedly stored in the Rack (and on the Timeline 
if selected, page 6-30). A lack of material before and after the mark-in/mark-out is no problem because digitiz-
ing continues straight through. Each subclip can be expanded up to the size of the master Media File (see also 
Expand Clip (To Available Media) on page 9-64). 
Two variants are available:

Using Mark-in and Mark-out

1 Start the digitizing process using one of the methods described above ( page 6-37).

2 Set a mark-in and mark-out. 
Until you click Log (to transfer the subclip to the Rack or to the Timeline), the mark-in/mark-out can 
still be modified.

3 You can repeat the procedure described in #2 as long as the digitizing process is still running.

4 To terminate, click the Digitize button again. The master clip is also stored in the Rack (optionally on 
the Timeline as well,  page 6-30).

Using the Log Button

1 Start the digitizing process using one of the methods described above ( page 6-37).

2  Click the Log button once to set a mark-in and again to define a mark-out and insert the subclip in the 
Rack and on the Timeline.

3 You can repeat the procedure described in #2 as long as the digitizing process is still running.

4 To terminate, click the Digitize button again. The master clip is also stored in the Rack.

A flashing Subclip symbol indicates the active subclip mode. This is also to remind you that any text 
inputs are going to be stored with the next subclip defined.
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( R e - ) D i g i t i z i n g  I n d i v i d u a l  C l i p s

You can transfer a clip directly from a Rack to the video inlay in the Logging Tool using drag & drop. The clip 
data appears in the timecode fields. 

� A new clip and a new Media File are generated in a subsequent digitizing operation. The original clip 
data and media data is retained.

� If you want clip and the media data overwritten, use the Batch Digitize function ( page 8-77).

B a t c h  D i g i t i z e

Batch Digitize permits the automatic digitizing of clips that have already been logged. The system controls the 
player. For more information, see “Batch Digitize (Batch Capture)”  on page 8-77.

C a n c e l

Click this button to cancel digitizing. No Media File is created and no clip is stored in the Rack. The player is 
stopped.

� To clear all timecode fields (except Position), hold the SHIFT-KEY while clicking Cancel.

Automatic Scene Detection 

Automatic Scene Detection saves you the trouble of manually dividing up your material into individual clips. 
This function is available only when digitizing via the DV input using i.Link (IEEE 1394) (not when logging 
and not via analog inputs, if any are available).

To activate this function, select [Edit > Control Panel > User >] Logging Tool > Properties > General and then 
Use scene detection if available.

Here’s how it works:

1 Activate Scene Detection (the options are described below). Select the usual Logging Tool settings (Rack, 
AV sources, clip numbering, etc.).

2 Confirm your selection and exit Properties. Start tape playback and click Digitize. Although you cannot 
see it initially, the system marks each new scene.

3 Let the tape run until it reaches the desired exit point, click Digitize once again and stop the tape. 
Or you can edit an area between a mark-in and mark-out.

4 The scenes detected are stored as clips in the selected Rack and also, if Direct Insert ( page 6-30) was 
activated, on the Timeline.
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In the case of tapes with a large number of timecode jumps or breaks, you should play the tape live (see 
also Live Input on page 6-10). Scene detection continues to operate, although later on you will not be 
able to re-digitize the clips created using Batch Digitize because there is no tape TC information. A copy 
of the tape can help but not all device manufacturers support the transfer or recording of the timestamp 
data ( page 6-41) necessary for scene detection.

O p t i o n s  a n d  B a c k g r o u n d  I n f o r m a t i o n

� Use scene detection if available -
Automatic Scene Detection evaluates the DV data. This data can be provided with a “timestamp”: Every 
time you press the record button on your camcorder, the camera’s system time and the date are recorded 
along with the timecode, thereby identifying the beginning of the scene. However, not all cameras 
record the timestamp so check the operating instructions. If your camera does not offer this function, 
you still have the option of using scene detection based on video content ( page 8-93).
The timestamp data is transferred via the i.Link (IEEE) interface, which is why you cannot use Scene 
Detection with analog inputs.

� Create Subclips -
Selecting this option results in one master clip that is as long as the overall digitizing process plus a 
number of Subclips corresponding to the number that Scene Detection was able to identify.
You can trim a Subclip up to the length of the master clip, thus making it unnecessary to enter a Handle 
Length. If you view a series of Subclips in the Project window (in Detail View!), you will note that they all 
have the same clip-in and clip-out. (See also “Clip-In/Clip-Out and Mark-In/Mark-Out” on page 6-5.)

If you select Create Subclips, the entire media file (one full-length file) will be captured when you subse-
quently perform a Batch Digitize operation.

� Create Master with inside handle length -
This option generates master clips only, meaning clips with individual clip-in and clip-out data. You can 
enter a Handle Length (see below).
Important: You can also trim these master clips to the total available length of their shared Media File 
but only by using the Expand Clip(s) function ( page 8-61).

Use Create Master if you want to re-batch the clips later on using Batch Digitize; you will then obtain one 
Media File for each clip.

� Handle length -
The clip-in is set at the point where the scene changes (according to the timestamp) and is followed by a 
mark-in. The “distance” between clip-in and mark-in corresponds to the Handle Length entered. The 
same distance exists between the mark-out and the subsequent clip-out defined by the end of the scene.

For both Subclips and master clips: If you’re using Automatic Scene Detection, be extremely careful when 
deleting clips along with the Media File. You need to take into account that a very large number of clips 
is attached to the same Media File.
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File Ingest 

File Ingest makes it possible to capture material particularly for the use in a networked environment. While the 
capture process continues, an editor working on a separate Pinnacle Liquid editing station can already use the 
media data. Every single frame becomes available the moment it is created.

Click Pinnacle Liquid Star t menu > Tools > File Ingest to open the dialog.

File Ingest has no video inlay and no audio levels. Important: you must specify the endpoint of the ingest pro-
cess by entering a clip duration.
Media files created with File Ingest are not suitable for a subsequent Batch Digitize. They have to be imported in 
the Project. Pinnacle Liquid Media Management can only register this data after is has been imported in the 
Project.

The material used for File Ingest must carry a consistent and intact synch signal (no “noise” on tape!). If 
there are TC breaks you may consider using the Live input in combination with System TC. Otherwise 
the ingest process will be aborted.

File Ingest 
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Step by Step

Some of the File Ingest functions you may already know from the Logging Tool.

1 Open File Ingest and select a source from the list in the upper left corner. A remote controlled source 
(e.g. a video recorder) can be cued to the desired starting point on the tape.
However, note that File Ingest is basically a Live capture because the system determines neither the 
player’s starting point nor its stopping point.

2 Define all Source Tracks (video, audio, stereo or mono).

3 The Reel name defaults to the current date, which is also inserted when you click the Plus sign. You may 
enter a different name.

4 Enter any clip name you like.

5 Now enter the Capture Duration. This is mandatory, even if you want to cancel the ingest process before 
the end of the duration.

6 Destination: Select the location where the media data should be saved.

7 Now select the Media Format (Codec, capture format). Consider the compatibility of playback formats 
used in all networked edit stations. For Vortex, it must be DV(avi).

8 Create clip in active rack causes the clip to be placed in the Rack currently selected in the Project. This 
lets you skip the import procedure described below.

Every file created with File Ingest gets a path/file name which is a combination of the individually 
selected clip name, the media format suffix and the directory path to where it is being saved. Examples: 
X:\cpr\TEST1.AVI or W:\rsz\INGEST001.M2V

9 Start the ingest process by clicking the Digitize button. A progress bar keeps you up to date.
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Import and Editing

All clips created with File Ingest can only be imported to a Project (except when you are using Vortex - please see 
the Vortex manual).

Important: for immediate playback on your system the imported files must conform to one of the valid play-
back formats of the your system. Otherwise the media files need to be rendered before playback. 

1 If necessary, create a new Rack in the Project. 
Open the Rack shortcut menu and select Import > Media Clip.

2 Browse to the storage location.

3 In the case of A-V clips it suffices to click the video file(s) (CTRL+click). The corresponding audio file 
will be imported as well.

4 If the clips are already completely captured when they are imported, they are available in full length.

5 If the ingest process is still running while you import, the available length can frequently be updated.
The clip is loaded in the Clip Viewer or Source Viewer with its momentary length. You can extend the 
clip-out until the final clip length is reached.

Once an ingested clip has been imported in the Project it is recognized by Media Management (provided the 
media directory was added to the list of Media Volumes in Media Management Settings). Batch Digitize, how-
ever, is still not possible.
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Background Live Capture

This tool allows you to write a native live signal to the storage medium currently selected via the SDTI input on 
the blue.box. During this procedure you can already edit the clip created.
To open the dialog box, select Tools > Ingest Tool > Live Background capture.

Background capture

Several functions are the same as for the Logging Tool:
Select Source Tracks, Mono/Stereo, audio channels (SDTI embedded 1-4 or 5-8) and the drive to which the data 
should be written.

1 Define the timecode that should be used. Click the player button to display the settings for the Live 
player and select one of the three TC options: Custom (entry in field), Time of Day (system time) or LTC 
In (studio TC via CH-1 In).

2 Define the Tracks you want to capture.

3 Select Mono or Stereo for the audio tracks.

4 The current date is selected as the Reel name. You can edit this field.

5 Enter a Name that identifies the clip in the Project.

Liquidblue

TC Video In Audio In Minimize

Source Tracks
Stereo/Mono

Capacity/Drive Start/Stop
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6 Enter the expected length of the clip. You can stop recording before this time has elapsed; the clip can be 
used in any case. This information is required for Media Management.
When the time has elapsed, recording stops.

7 Enter the settings for the storage medium selected under Edit > Control Panel > Site > Media Manage-
ment Settings. (See “Media Management Settings” on page 8-116.)

8 Start the player or initiate signal playback.

9 Recording starts as soon as you click the Digitize button. 
A clip is created in the active Rack of the Project.

10 The clip is immediately available for editing, up to the length currently reached.

11 Click the Minimize button to reduce the dialog box to an icon on the task bar.

12 To update material already being used on the Timeline you can, for example, click the monitor button in 
the Track Header area twice in succession.

E d i t i n g  W h i l e  A n o t h e r  S y s t e m  i s  S t i l l  C a p t u r i n g

You can already edit these files while a system other than Pinnacle Liquid is still capturing. To do so, you must 
have a name specific to Pinnacle Liquid for which you use the (dummy) Timecode from the clip’s Mark-Out. For 
a media import operation, activate the checkbox next to Trust Meta Information Media Length. Positioning the 
clip at time “x” on the Timeline allows you to edit the data that has been captured up until this point in time. To 
update this data, you must update the Timeline or the Project, for example by clicking the monitor button in the 
Track Header area twice in succession. 

If the import is being performed by an ALE project, the name is irrelevant. The final length must be defined in 
the ALE file. When importing, activate the checkbox next to Trust Meta Information Media Length.
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Importing Objects

The Import function lets you integrate objects in Pinnacle Liquid Projects such as video files, audio files, graph-
ics files, titles, subtitles, crawls, test images, etc. 
Import involves either creating a shortcut (link) to the object’s storage location (diskette, hard disk, network, 
CD-ROM, etc.) or saving the file (optionally as a copy) in a Media Directory of the current Project. In either 
case, a clip is stored in a Rack.

Import - where from, where to?  page 6-47

What can be imported?  page 6-48

Import media clips  page 6-49

Image import (Global Settings)  page 6-52

Import - Where from, Where to?

The destination of an import operation is always a Rack. This is 
where the imported clip(s) are stored. Open the shortcut menu for 
the Rack that you want as your import destination and select 
Import. A submenu is displayed:

� Media Clip (stills, animations, audio, video, etc.)

� Vortex Media Clip (only in systems connected to Vortex)

The sources for the import are determined by your system; from a 
diskette or from a network drive, anything that the operating sys-
tem can find can be addressed.

Rack shortcut menu with 
Import submenu
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What Can Be Imported?

The Import Media dialog box, which contains the same basic components as a typical Windows dialog box, 
indicates the file formats that Pinnacle Liquid can use. Click the Files of type list box to display a list of compati-
ble file formats.

You may have to convert a file to a compatible format before importing it.
Pinnacle Liquid converts external formats after import and prior to first playback respectively, automat-
ically to one of or the valid internal file format (video: depending on hardware; audio: always PCM 
WAV).

Video File Formats: 
� *.dif, *.dv, *.dvsd (DV, DVC & variants)

� *.m2v (MPEG2 I-frame)

� *.yuv, *.2yuv (uncompressed)

� *.avi

�  *.mov (QuickTime)

� *.dvd (Sony specific DV)

� *.mxf (AV and metadata conforming to the MXF Exchange Format; MXF is not exclusively a video for-
mat, contains meta data as well and can even be AV multiplex)

� *.wmv (Windows Media)

� *.mpeg, *.mpg, *.ts, *.vob (MPEG2 files)

DV-AVI files created with Adobe Premiere or DV Tools may be imported in Pinnacle Liquid as well. 
Audio integrated in AVI files will be extracted and split on import.
AVI files to be used with Premiere are best created with the Fuse Sequence function ( page 16-16).

Audio File Formats: 
� *.wav (PCM uncompressed)

� *.mpa, *.mp3 (MPEG-1 Layer 2 Audio)

� *.wma (Windows Media Audio)

Valid audio sample rates for import are: 11025 Hz, 22050 Hz, 32000 Hz, 44100 Hz, 48000 Hz. Sample rates in 
between can not be imported.

Graphics (Image) File Formats: 
� *.bmp, *.png, *.tga, *.tif, *.pcd, *.psd, *.pcx, *.bsi, *.jpg, *.tdk (TitleDeko)

(Note: except TIFF lzw-compressed; GIF is no longer supported (Version 5.0 or later.)
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Importing Media Clips

From the Rack shortcut menu select Import > Media Clip to import objects to a Rack, or go via File > Import > 
Media.

 
Import Media dialog box

Instructions for Importing Images and Titles in the 16:9 or 4:3 
Format

If you work in 16:9 mode: To avoid undesirable distortions, imported Media Files that have been produced with 
graphics programs or title generators must also be generated using the 16:9 aspect ratio. 

Generally: Please use the current Sequence resolution as a guideline to determine the exact pixel by pixel resolu-
tion and aspect ratio needed for correctly dimensioned import graphics. Check Timeline Properties or the New 
Sequence dialog.
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Clip Metadata

Metadata is additional information on clips that is generated and imported during logging, including:

� Clip-in/clip-out

� Reel name

� Clip name, if any.

This applies to Pinnacle Liquid Version 2.55 and higher and to clips that were created in Pinnacle Liquid. The 
metadata is displayed in the Rack in Detail View (list). These clips can also be digitized by means of Batch Digi-
tize.
See also “Metadata” on page 8-98.

Selecting Files

Import > Media Clip can also be used for loading several objects at once. This is useful, for example, if you want 
to integrate several video clips from a removable hard disk or individual animation pictures in your Project. 
One way to do this is to select the required object(s) using a CTRL+click or SHIFT+click. Another way is to drag 
a frame around the objects or to enter a name, using a joker (?) or wildcard (*) in the File Name field. Click 
Open. A preliminary list which meets the criteria specified in the File Name field appears. From this list select 
the objects you require. Click Open again.

Images and still titles in themselves have no “length” (i.e. no true TC-in to TC-out). As clips in the 
Project, they are allocated the duration that was assigned in the global image import settings (default is 
three seconds). See also “Image Import (Global Settings)” on page 6-52.

Copying/Moving Files and Creating Shortcuts

The Media File Action list box in the Import Media dialog box defines the media import more closely. You can

� Copy the selected file(s) to a Project media directory (original stays in its position), 

� Move the selected file(s) to a Project media directory (original removed from its position),

or 

� Create a shortcut (Link) (original stays in its position).

For the Copy and Move options, the Project Media Directory in which the files are saved depends on the file type 
and the Media Management settings (see also Project Media Directories: Where Are the Files Stored? on page 
8-108).
Linked files remain in their storage location.
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Default TC System

Autodetect Framerate should be enabled here. The two other options are only needed in such cases where the 
automatic mode does not return the desired results, or when you want to force a conversion.

� Default TC System -
Select the frame rate that matches the the video object you want to import. All values here are fps, 
frames per second.

� Assume Drop Frame -
Enable this option when the selected TC System is of the drop frame type.

� Autodetect Frame Rate -
lets the system do the job of identifying the source material frame rate. Should be enabled in most cases.

See also “Timecode Systems” on page 5-11.

Options

A u t o m a t i c  D e t e c t i o n  o f  A n i m a t i o n s

The individual files of an animation are detected as such and loaded as a clip if their file names contain a 
sequence number (such as Anima001, Anima002, etc.). The system automatically converts imported anima-
tions to a playable format.
Click the file with the lowest sequence number. The associated files are loaded automatically (make sure all rel-
evant files are in one directory).

T r u s t  M e d i a  M e t a  D a t a  

This option applies to the live capture function of Liquid blue . See “Editing While Another System is Still 
Capturing”  on page 6-46.
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Image Import (Global Settings)

In the Image Import Properties dialog box, you can define parameters for importing graph-
ics files, such as the default duration of a graphics clip on the Timeline. Be be sure to check 
these settings carefully when you load a large number of files. These settings may be found 
in Edit > Control Panel > User > Image Import.

Image content is interlaced

An image is interlaced when it comprises two fields whose lines alternate in an interlaced pattern. This is the 
case with most video images. In Pinnacle Liquid, this information is important for effect rendering. If the 
imported images are some type of animations in interlace mode, activate this checkbox.

Scale to fit

Activate this option if you want to adapt the imported images to the selected TV format. Depending on their 
original size, however, this may result in varying degrees of distortion.

Image Import (global settings)
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Automatic detection of animations

Activate this option if you want Pinnacle Liquid to detect the individual frames in an animation automatically. 
The software looks for file names that are consecutively numbered in ascending order (for example, 
"Image001.tif to Image099.tif ").

Image Duration 

Use this option to preset the length of a graphics clip on the Timeline. The default is three seconds.

Pixel format

Auto means that Pinnacle Liquid automatically attempts to identify the format of the pixels that form the image; 
Square, CCIR 4:3 or CCIR 16:9 tells Pinnacle Liquid to handle the pixels in accordance with the TV format con-
figured for the system.
Note: This has no effect on the pixel format.

Alpha image playback behavior

This option is meaningful only if you run into alpha-channel problems when playing consecutive clips. These 
clips are usually played back in real time. Nevertheless, problems may result from a very large number of very 
short clips.
The closer you position the slider to the Secure end, the earlier Pinnacle Liquid starts to render these clips in 
order to permit a correct playback. If you position the slider all the way to the left (Secure end), to be on the safe 
side Pinnacle Liquid renders every clip that is longer than about a second with the alpha channel. 
At the Aggressive end (slider all the way to the right), there is no rendering; Pinnacle Liquid attempts real-time 
playback at all times. 

Photo CD

On this tab, you can define the resolution to be used for loading images in the photo CD format. (This setting 
may differ from the image format on the photo CD; in some cases, the photo CD may not support all the avail-
able formats.) 
Volume II Chapter Input 6 - 53



PINNACLE

Copying/Pasting Objects from Other Projects
Copying/Pasting Objects from Other Projects

Another method for inserting objects in a Project is to copy and paste them using the Windows method:
Open a Project, select one or more objects (for example using CTRL+click or SHIFT+click), copy the objects by 
pressing CTRL-C (or by selecting Copy from the shortcut menu), exit the Project and open the destination Pro-
ject. Go to the desired location (Rack, desktop, Timeline) and paste the object(s) by selecting the Paste option 
from the shortcut menu or pressing CTRL-V. 

Objects inserted in this way retain their links to their own Media Files. This means, for example, that you can 
continue to play a video clip. 

� It’s even easier if the Project from which you want to copy objects is opened from the Project Browser. See 
“Working With Two Projects Simultaneously” on page 8-4..

For instructions on inserting objects on the Timeline:  page 9-56

To transfer objects simultaneously from different Racks, first move/copy them to a “collective Rack”. 
Then select them all by means of CTRL-A and copy them with CTRL-C. Or else you can copy the Rack 
with all its contents.
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Media Management and Object Import

You can also integrate objects in a Project using Pinnacle Liquid Media Management functions ( page 8-97). 
Media Management primarily serves to access Media Files; if necessary, however, you can generate objects from 
these files. See also “Media Files: Functions” on page 8-114.
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Creating Objects

This section describes objects that you can create within Pinnacle Liquid (i.e. without exiting the program). It 
covers the following topics:

Create color clip

Create monochrome or color gradient backgrounds  page 6-57.

Generate signal clip (reference level tones)

Using the internal signal generator  page 6-59

Create title

Generate still, roll and crawl titles using the integrated titler  page 14-1

Produce customized effects

... using the Pinnacle Liquid effect editors  page 10-3

Voice-over

Record live comments “onto” the image  page 13-65
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Creating a Color Clip

The Create > Color Clip function (in the Rack shortcut menu) allows you to define color clips (for example, for 
a title background). In the Color Clip dialog box that is displayed when you select this option, you can set the 
parameters for monochrome clips as well as linear and circular gradients. 

Monochrome or Color Gradient

From the list box, select:

� Single color (monochrome background)

� Linear gradient (two colors, straight transition)

� Circular gradient (two colors, circular transition)

Selecting Color(s)

Click 1st Color (for a gradient, also click 2nd Color) to open the Color Picker, then select the color(s) you want to 
use. 

T h e  C o l o r  P i c k e r

The Color Picker provides five different methods for defining a color. A preview of the resulting color is dis-
played in the color boxes (1st Color or 2nd Color).

� HLS color model -
Drag the marker in the three horizontal bars (one for hue (H), one for saturation (S) and one for lumi-
nance (L)). 

� RGB color model -
The combination display/entry field below the HLS bars describes a color in the RGB (red-green-blue) 
model. Each value can be from 0 to 255. 0’0’0 is black, 255’255’255 is white and 0’255’0 is pure green.
For an exact reproduction of a color value with known coordinates, click the field and enter the num-
bers via the keyboard.

� Color hexagon -
Drag the cross-hair pointer to the desired color.

� Color scale 
- A selection of hues. Click the appropriate box.

� Pipette (Color Picker) -
The Pipette “sips” a color from any location on the desktop. Click the Pipette icon, drag it to the desired 
location and release the mouse button. The color value is taken from the exact tip of the Pipette.
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Edit Gradient

The direction and density of linear and circular gradients can be changed as follows:

� Click left in the preview window and create a line with your mouse. The gradient depends on the align-
ment and length of this line.

� For linear gradients: Use Gradient Settings to repeat the pattern you created and to mirror adjacent 
areas.

 

Color Matte Clip
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Generating a Signal Clip (Reference Level Tones)

Pinnacle Liquid has an internal audio signal generator that allows you to generate individual signal tones:

1 Open the shortcut menu in any Rack and select the Create > Signal Clip option. A clip with the audio 
(loudspeaker) icon is stored in the Rack.

2 From the shortcut menu of the signal clip generated, open the clip Properties. You can now set the fol-
lowing on the Signal tab:

3 Waveform -
Select either Sine, Sawtooth, Rectangle, Triangle or Silence as the type. Level tones are typically sinusoi-
dal.

4 Frequency -
Set the slider to the desired value (from 100 Hertz to 10 kHz).

5 Volume - 
Select 0, -9,, -12, -18 or -27 dB.

6 On the General tab, name the clip so that it will be easier to identify in the Project later on.

The preset reference tones contained in earlier versions of Pinnacle Liquid are replaced by this new, 
more flexible function.
No media data exists for a signal clip. The internal signal generator generates the signal. For the same 
reason there is no waveform display of a signal clip. 

Creating Titles

You can create still, roll and crawl titles with the titler integrated in Pinnacle Liquid. When you close the titler, 
the objects produced are automatically exported to the Rack that was last activated.

For more information on the titler, see the separate chapter.  page 14-1. 

Producing Customized Effects

Effects are also among the objects that you can create in Pinnacle Liquid. Using the Effect Editors (e.g. 2D Editor 
or Keying Editor), you can define customized effects that can be stored as objects in the Rack.

Also see “Effect Editors (Basics)”  on page 10-10.
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Voice-Over

Voice-over permits a live audio recording to be synchronized onto the image (for example, in order to record a 
comment) by inserting an audio clip on the Timeline.

For more information on this function, see “Voice-Over”  on page 13-65.
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Importing EDL/AVID MediaLog Files

For more information on this topic, see the section on “Exporting/importing EDLs”  on page 7-18.
Volume II Chapter Input 6 - 61



PINNACLE

Importing EDL/AVID MediaLog Files
Volume II Chapter Input6 - 62



Chapter

Volume
 II

7

Exchange



PINNACLE
This chapter describes features related to the exchange of data in many formats between systems and applica-
tions. You will also find information on how to set up and operate Pinnacle Liquid in a simple network.

XML/ALE/XCE export and import 

Interface to Project and media data exchange  page 7-3

Create a shot list or batch list

Using the ALE format exchange to swap data between systems  page 7-6

XSend to... 

Send clips and media files to external applications such as Commotion, or Adobe AfterEffects  page 7-9

XReceive

Import of objects and structures  page 7-14

MXF AV Data interchange

Standard interoperability between platforms  page 7-16

Export/Import EDLs/ AVID MediaLog files

Edit using an Edit Decision List  page 7-18

Import VideoMachine DBF

Project upgrade to Pinnacle Liquid  page 7-23

Networking Pinnacle Liquid

Store Projects and media on a network, retrieve data from network  page 7-24

OMFI Export

The gateway to exchanging data with postproduction systems: Open Media Framework Interchange  page 7-31

LST Import

Retrieving Vortex editing data  page 7-36
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XML/ALE/XCE Import and Export 

Pinnacle Liquid offers a standard interface to exchange Project data in the XML and ALE formats. Clip meta-
data can be exchanged using the ClipExchange (XCE) format.

You can find these functions in � Menu bar > File > Import> (or Export >) XML/ALE...

Although these files also have the extension *.ale, Avid MediaLog import is not the same procedure as 
importing ALE Projects; see “Reading in Avid Media Log Logging Lists”  on page 7-22.
ALE export or import is not possible with HD based material (clips, Sequences). 

ALE Export can be used to create shot lists or batch lists from a Project or certain Racks of a Project (see 
“Use ALE Export to Create Shotlists and Batchlists”  on page 7-6). 

Information about ALE, XML and XCE

Pinnacle Liquid has always employed a special ALE format to exchange Project data including their correspond-
ing media data. Nowadays ALE, which was developed as a simple logging data exchange format, is no longer 
sufficient to enable up-to-date and efficient data exchange. Therefore Pinnacle Liquid supports, besides legacy 
ALE, a new XML-based Project data exchange format.
Export and import of individual clips is handled by means of XCE, ClipExchange. Both file types, XML and 
XCE can be opened and viewed in a simple text editor or internet browser (append the XML suffix to an XCE 
file: like in clipexport.xce.xml). The format standard specifications are available on request from Pinnacle Sys-
tems (please contact Support).
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Import Project (XML or ALE) 

All available data from the ALE file or XML file will be transferred to the current Pinnacle Liquid Project, 
including the file paths of corresponding media files.

XML import does not copy any media files. To work with existing media files, the importing system needs to be 
set to recognize the location of these files. 

Go to Media Management Settings and add the drive or folder path where the relevant files are stored to the list 
of Media Volumes (Edit > Control Panel > Site). If the Media Volume is already on the list, the system automati-
cally establishes the links between clips and media files. All clips can be played instantly. 

Depending on what exactly you are currently importing, there may be additional options. If these options can 
not be selected, they are not available in the current operation.

Media File Action

(Not with XML import.) Here you can select how the Media Files of the ALE Project should be handled.
This function copies the Media Files referenced by the imported clips to the primary destination drive in the 
local system as defined in the Media Management Settings ( page 8-116).

As a variant, however, you can also limit yourself to creating shortcuts (links) to the Media File storage location.

Further options

� Treat audio as mono -
interprets audio files on import as being the mono type (even if they‘re not)

� Size Media File(s) to Mark-In/Mark-Out -
Only the range of associated Media Files defined by the clip is copied/moved to the destination drive.
Also, a Handle Length to be added to mark-in and mark-out may be specified.

� Import clips into active Rack of main Project window -
(not in the currently active Rack of Project Browser).

� Ignore insufficient media duration -
This only concerns the Live Capture tool of Liquid blue .
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Export Project (XML or ALE) 

Enter the name and path of the file and select the desired format, ALE (*. ale) or XML (*.xml). 

All available clip data (as can be displayed in a Rack’s Detail View mode) will exported in the ALE or XML file. 
The file paths of all media files will be included.
This function does not export media data!

Choose one of the following options:

� Export entire Project -
and that’s exactly what it does.

� Export selected Rack on Project Clips Tab -
will only export the contents of the selected Rack (only one Rack can be selected)

� Export selected Clip(s) on Project Clips Tab -
exports one or several selected clip(s) in a Rack

Import/Export Clips (ClipExchange, XCE)

These functions are designed to transfer XCE-formatted clip meta data plus their corresponding media files 
between systems. The structure of a Project (folders, Racks) is not touched by this type of export. Only clips are 
exported and, on import, put in a Folder which contains one or more Racks. All clips will be sorted by Reel 
name, meaning that all clips coming out of the same Reel will end up in the same Rack.

When you import XCE data a dialog box opens and prompts you to enter a storage location for the files. You 
can indicate a location. If you don’t, clips will be imported without their corresponding media files. You can 
later establish the links between clips and media, using the Verifyimported Media function (Rack shortcut 
menu).
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Use ALE Export to Create Shotlists and Batchlists

A shotlist (also known as logging list ot batch list) contains the most important information about the clips of a 
project. This information is also called meta data and presented in a way similar to that of an EDL (Edit Deci-
sion List). Meta data comprise clip name, Reel name, mark in and mark out, comments, and other info. 

Shot lists and logging lists can be exchanged between different editing systems. They may also serves to archive 
Project contents. 

ALE list elements

What‘s mandatory, what‘s optional  page 7-6

Working with ALE lists

How to create a logging list or batch list  page 7-8

ALE List Elements

The following image shows an ALE list which was exported from Pinnacle Liquid (see  page 7-5 for details on 
ALE export) and imported in a spreadsheet program:

ALE shotlist representing a Racks‘s content

The elements of the lists will be explained in the following paragraphs.
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Global Headings

The basic attributes of a Project are defined as “Global Headings”. The must appear at the top of the ALE list, 
and exactly the way shown in the image above, including the entry “Headings”.

� FIELD_DELIM means that all list column entries are separated by Tab stops. This is important when 
the ALE list is imported in a spreadsheet software.

� VIDEO_FORMAT can either be PAL or NTSC.

� AUDIO_FORMAT: 22, 24, 44 or 48 kHz.

� FPS means frames per second: NTSC 29.97, PAL 25.

Column Headings

Every column in the list has a certain Column Heading. The word “Column” precedes the row (line) of column 
headings. ALE specifications allow for a great number of column headings, some of which are mandatory, but 
much more are optional.

� Name (mandatory) is the name of the clip or objects (maximum 32 characters length)

� Tracks (mandatory) describes the video and audio tracks of the source.

� Start and End (both mandatory) refer to the clip-in and clip-out of the clip’s media file.

� Tape (mandatory) defines the tape or, more generally, the source (named Reel in Pinnacle Liquid).

� Duration is the clip length between Start and End.

� Mark IN and Mark OUT (not the same as Start and End, but In and Out of the actual clip).

� Scene, Take, Comments are optional fields which can be filled in the Logging Tool while logging or in a 
clip’s Properties at any time. 

� Mediapath is a Pinnacle Liquid ALE specialty. Here the exact storage loaction of a clip’s media file is 
given.
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Working With ALE Lists

An ALE list is a text file with no formatting. It can be viewed in a simple text editor, but also in a full-blown 
word processor. Because of its table-like structure it is best edited in a spreadsheet software such as Microsoft 
Excel.
Let’s use a logging list as an example to outline the procedure. You, the editor, want to provide your client with a 
list of all logged clips and other objects in the Project.

1 Since ALE Export scans all Racks of a Project from top to bottom, it may be a good idea to check the 
order of Racks and objects within the Racks before the export is started.

2 Select Pinnacle Liquid � Menu bar  > File > Export > XML/ALE...

3 The whole Project or just a the content of a single Rack? Click the approriate checkbox and select a 
directory.

4 Click Save; the export begins.
Sequences and effects are not exported.

5 Load the ALE file in your spreadsheet software. Depending on the product it may be necessary to 
change the file suffix to *.txt.

6 You can import the *.ale file directly in Excel. A conversions routine starts automatically. Make sure that 
tab stops are used as deliminators.

7 Now you have all the possibilities of the spreadsheet software. 
You can sort by Tape name to line up all clips of a certain tape, you can delete columns you don’t need, 
or you can move the Comment column next to the Name column.
This list can be printed.

U s i n g  t h e  A L E  a s  a  B a t c h  L i s t

ALE are very versatile lists. They can easily be converted. To convert an ALE to a Batch List, which can be 
loaded in FinalCut Pro, for example, it suffices to rename some of the column headings and to insert two addi-
tional. The exact required format is documented in the manuals of the applications. 

One thing you should not forget after having edited the list in a spreadsheet or wordprocessor: Save the list as 
text file with no application-specific formatting and, if required, change the file suffix to whatever the import-
ing application needs.
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XSend To...

The XSend To... function allows you to transfer clips, Containers and Sequences quickly and directly from Pin-
nacle Liquid to QuickTime-compatible applications such as Commotion 4.1 and Adobe AfterEffects for further 
processing or to an encoding application such as MediaStream for streaming.
Pinnacle Liquid currently features predefined interfaces to Adobe AfterEffects, Terran Media Cleaner, Win-
dows Media and QuickTime. You can also use XSend To... to connect “plug-in” applications and enhance the 
functionality. In the current version, this has already been implemented for Adobe AfterEffects. An SDK is 
available on request from Pinnacle Systems.

Objects permitted for the XSend To... function  page 7-9

Calling XSend To...  page 7-10

XSend To... options  page 7-12

Objects permitted for the XSend To... function

With XSend To..., you can send single clips (both from the Project and from the Timeline), multiple clips, a com-
plete Sequence, and Containers to an application. Transitions (such as Dissolves and Cross Fades) and clip effects 
are not considered to be objects. Optionally, however, you can use the Fuse function to transfer a particular 
effect (i.e., as a rendered Media File).
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Calling XSend To...

You will find this function in the shortcut menu for clips and Sequences in the Project and in the shortcut menu 
for clips on the Timeline. If you have selected multiple clips, you can call XSend To... from the shortcut menu for 
any of the clips selected. From the submenu displayed, you can then select the application to which you want to 
send the material. If you wish to transfer a Sequence, in the Project window call the function from the shortcut 
menu for this Sequence.

XSend to... Location

This function allows you to XSend (in this case, save) clips to any location on your computer or network. No 
software application will be opened.

XSend to... Location; with options

� Target location -
Select a directory.

� Use object name/original media file name -
You can either save the files under their individually assigned object name (from within Pinnacle Liq-
uid), or under the name originally assigned by the system.

� Copy meta data files -
Enable this option if you want to save corresponding meta data (e.g. XML files) to the selected target 
location.

� Convert mono tracks to stereo -
wraps mono audio clips in stereo files.
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Liquidblue

XSend To... Other Applications

1 To configure XSend To... for other applications that are not (yet) listed in the submenu, select XSend 
To...> Others. 

2 In the dialog box, click Add and find the desired file in the Windows selection box displayed. Note: 
Only executable (*.exe) files can be selected. The application is inserted in the list of applications. 

3 Click the application and then click XSend To... to send the object(s) to the application.

Which Programs are Compatible?

To test whether the “other application” is compatible with XSend, perform the following test:
On the Windows desktop, drag a file (i.e. an icon, which is a shortcut to a file) to the icon for the particular 
application and drop it. The test file must be of the same type as the file you want to send to the program by 
means of XSend. If the program now starts with this file, it is “Drag&Drop-compatible” (as it is called in Win-
dows) and can therefore be addressed by XSend. If not, you will have to use the usual method of opening the 
program and loading the file(s).

XSend to... Macromedia Flash

Pinnacle Systems offers a XSend to MacromediaFlash (*.flv) interface. It can be downloaded from the Pinnacle 
Systems web homepage if it is not already installed on your system.

XSend to... Vortex

Systems connected to Vortex offer two additional XSend commands:

� vortex: publish to single file -
initiates a Fuse process.

� vortex: publish to playlist -
calls up the Feed labeling Window.

For more information on these options please consult the Vortex documentation.

XSend to... Location (MPEG2-IPB)

This option is reserved for MPEG2-IPB clip on the Timeline. It works like XSend to... Location, but includes 
the IPB clip’s audio file(s), and a multiplexed stereo wav file.
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XSend To... Options

The options described below are offered in different combinations as a function of the source material and tar-
get application.

Single Clip

For single clips (without effects), the application selected is opened immediately.

Clip(s) with effects

� Fuse – Select this option if the clips should be transferred to the selected application as a result of the 
effect. This starts the Fuse process ( page 16-16).

� From Mark In to Mark Out – Limits the section to be transferred.

� Save Fuse File As... – Enter the directory path or select the path from the Windows dialog box (Browse).

� User-Defined Name (instead of Object Name) – If desired, enter an individual name for the Fuse file gen-
erated.

� As Source Clip(s) without Effects – Effects applied to clips are ignored.

Sequence(s)

� Fuse – Select this option if the clips of the Sequence should be transferred to the selected application as a 
single file. This starts the Fuse process ( page 16-16).

� From Mark In to Mark Out – Limits the Sequence section to be transferred.

� Save Fuse File As... – Enter the directory path or select the path from the Windows dialog box (Browse).

� User-Defined Name (instead of Object Name) – If desired, enter an individual name for the Fuse file gen-
erated.

� As Composition(s) of Source Clips – The vertical and horizontal arrangement of clips on the Timeline is 
transferred (without rendered effects or render files) to the application (for example, AfterEffects). The 
source clips are available in the destination application.

� Fuse single clips – This option transfers each individual clip to the destination application (Adobe After-
Effects) as a result of any effects applied. The Timeline structure is retained.
Volume II Chapter Exchange7 - 12



PINNACLE

XSend To...
Animation, titles with effects

� Fuse – Select this option if the clips of the Sequence should be transferred to the selected application as a 
result of the effect (also with roll/crawl titles). This starts the Fuse process ( page 16-16).

� From Mark In to Mark Out – Limits the Sequence section to be transferred.

� Save Fuse File As... – Enter the directory path or select the path from the Windows dialog box (Browse).

� User-Defined Name (instead of Object Name) – If desired, enter an individual name for the Fuse file gen-
erated.

� As Source Clip(s) – Sends the output files for animation (such as single-image graphics) to the destina-
tion application. A roll/crawl title is transferred without the motion information.

Note on Using This Function with AfterEffects:

The first time you use XSend To... with AfterEffects, the following message is displayed:

“Some of the add-on modules require that they be registered for this version of AfterEffects in order for you to 
be able use them.” From “Skip All/Serialize All”, select the “Serialize All” option.
If you already clicked “Skip All”, close AfterEffects and resend to AE. The query is then repeated. Proceed as 
described above.

If you transfer one or more clips to AfterEffects using XSend To..., a dialog box is displayed after you start the 
program (“Add[software name] Footage”) containing a list of these Media Files and the AE composition(s) in 
which these files should be integrated.
Select the Media Files and a composition and click OK.
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XReceive

XReceive is to some extent the counterpart to XSend. You can use this function to retrieve files in your system 
that can’t be accessed by means of a standard media import or that are not suitable for this type of operation.
XReceive connects your system via an IEEE 1394 interface, e.g. to the Sony DU1 Hard Disk Recorder. You can 
integrate and immediately work with media data and metadata in the Sony-specific *.dlx format in your 
Project.

Other applications can also be accessed using an XReceive plug in. 

XReceive module
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Calling XReceive

To open the XReceive module, select Pinnacle Liquid � Menu bar  > Edit > XReceive. 

Then select the application you want from the drop-down menu (if more than one application is available).

XReceive Options

� Media File Action -
These are the Copy, Move and Link options already familiar from the standard import. Note that Move 
removes the file(s) from their original storage location.

� Import Audio Files as Stereo -
This option imports audio clips with the stereo attribute.

� Import Files to current Rack -
If this option is not activated, a new Rack is created with the name XReceive. Otherwise the clips are 
imported to the Rack currently selected.

� Add string to Reel name -
enter here a name that will be appended to the existing Reel name. This is especially handy when you are 
working with more than one hard disc recorder.

Starting XReceive

After selecting your options, click OK. In the Open file dialog box, navigate to your destination and select the 
files or folders. 
The import is then performed.
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MXF File Exchange Format 

MXF stands for Material Exchange Format. It facilitates the exchange of AV media data including its corre-
sponding meta data. Typical meta data would be information like timecode data and clip names. MXF is a stan-
dardized yet open format which can be used across different platforms. Like AVI, MXF is a “wrapper” format, 
which can contain differnt essence data while the file format suffix always stays the same.

Pinnacle Liquid currently supports:

� MPEG MXF -
Contains MPEG2 I-frame only and audio WAV essence data. When you export MEPG MXF you can 
choose a compression level, or bitrate, between 5 and 50 Mbit/s bitrate (MEPG-2 ML@422, I-frame 
only). Available export options are explained in detail at the end of this section.

� MPEG IPB MXF -
As an export format there is also MPEG IPB MXF available. Its export options are set in the IPB Settings 
dialog ( page 16-36).
The difference between MPEG IPB MXF and Elementary Stream export is only the MXF file wrapper.

� In the Logging Tool and File Ingest tool it is possible to capture to several MXF formats. Click the media 
format list to get an overview of available formats.

Export MXF 

MXF Export is an option of Export Sequence as... (File > Export > Sequence...)

M P E G  M X F  ( I - F r a m e  o n l y )

1 Select MPEG MXF as the export format.

2 Then click Options. The MXF Settings dialog opens:

� Bitrate selection -
5, 10, 15, 25, 33 and 50 MBit/s are on offer. 5 is the lowest quality (visible pixel artefacts), 50 is best qua-
lity.

� extended video resolution -
initiates export in 640x512 (NTSC) or 768x608 (PAL) resolution (width x height). 

� AV multiplexed or separate -
multiplexed generates one single stream; both video and audio are wrapped in the MXF container. Or 
you can select separate files for the video and audio data.

3 Click Ok and Ok again in the Export dialog. Choose a location to save the file(s) and let the export 
begin.
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MXF File Exchange Format
M P E G  I P B  M X F

1 Select MPEG IPB MXF from the list of export formats.

2 Then click Options. Detailed information on IPB Settings on  page 16-36. 

Import MXF 

On import it can become necessary - depending on product version and possible system formats - to render the 
MXF material before it can be played on the Timeline or in the Viewers.
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Exporting/importing EDLs

An Edit Decision List (EDL) contains in chronological order all basic components of a film Sequence, including 
the mark-in and mark-out points and video and audio tracks. Pinnacle Liquid automatically generates a new 
EDL whenever you create a new Sequence and continues to update the list as you add and modify editing events. 
EDLs can be exported and imported.

Events contained in EDLs  page 7-18

Areas of application  page 7-19

Available formats  page 7-20

Exporting EDLs  page 7-20

� EDL without audio information  page 7-21

� Multi-layer EDLs  page 7-21

Importing EDLs page 7-22

� Reading in AVID Media Log logging lists  page 7-22

Events Contained in EDLs

Since EDLs can be read by different types of systems, they allow for system-independent editing of videos. This 
means you can do preliminary editing and layout work offline on one system and final online editing on 
another.

In addition to Mark-In and Mark-Out points, EDLs also list video and audio sources, the duration of Transiti-
ons (e.g. dissolves and cross fades) and a SMTPE code number, provided it is known for standardized effects 
(for example, 004 for a wipe). 
It addition, it indicates Timewarp effects. The entry DM+050 indicates 50% slow motion and DM-033 indicates 
33% reverse playback (DM stands for “dynamic motion”).
However, since EDLs have to be compatible with many different types of systems, from the most sophisticated 
to the most basic, the information they contain has to be kept very simple and by no means reflects all the edit-
ing functions available with Pinnacle Liquid. The actual media data is not stored in an EDL.
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Areas of Application

Despite certain drawbacks, EDLs can still be very useful, especially for large projects. Since most of the work 
required to produce a video does not depend on quality, to keep costs down, it is sometimes useful to do rough 
editing and experimental work on an off-line suite. Then, with the EDL and source material at hand, to perform 
final assembly work, using a higher quality on-line editing suite. 

When switching from non-linear offline editing to linear online editing, the system reads the video editing data 
and creates a logging list. Without EDLs such Projects would be nearly impossible since you would have to cre-
ate every Sequence manually, step by step. If problems arise during final cutting which require off-line editing, 
EDL files can again be used.

Since EDLs contain the basic content of a Sequence, they permit identical versions of a video to be processed on 
different systems. 

Typical examples include the following:

� The master is to be created in a special format that is not available to you.

� For on-line editing you need the technical capacities of a large studio.

� You do not have enough hard disk space to redigitize the complete project at optimum quality.

It is recommended that you do a test run in advance to check the compatibility of the EDL and the on-
line editing system to be used. For example, some systems reject edit lists whose Reel names include let-
ters (e.g. “A001” or “tape01”).
It is also recommended that you edit images only (without audio) on the on-line system, provided that 
the Sequence does not have too many special effects. The audio tracks (possibly already mixed) are 
played onto a timecode-identical tape that can then be simply mixed together later with the on-line 
tape.
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Available Formats

EDLs are alphanumeric files and do not contain any media data. This means the EDLs of even very large 
Sequences with several hundred events have convenient formats and fit easily on a floppy disk. Pinnacle Liquid 
lets you export and import EDL files in the following standard formats:

� Sony (BVE 9100)

� CMX (3600)

� GVG

You can also convert EDL files from one of these formats to another, allowing you to cut the same job on differ-
ent equipment using the same source material (tapes). 

Exporting EDLs

Step by Step

EDL Export window

To export the EDL of a Sequence created with Pinnacle Liquid:

1 In the Timeline, activate playback for the Tracks to be exported. EDLs are limited to a single video Track 
(V) and a maximum of four audio Tracks (A1 to A4). 

2 Click File > Export > EDL. 

EDL drop-down box Save Print
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Exporting/importing EDLs
3 A window with the EDL of the active Project on the Timeline appears. 
The default export format setting is Sony (BVE 9100). To select a dif-
ferent export format (CMX 3600 or GVG) use the drop-down box in 
the top left-hand corner. Pinnacle Liquid automatically converts the 
EDL to the specified format and displays it. 

4 Specify how you want to output the EDL - as a printout or file.

� Click Print to print the EDL. 

� Click Save to save the EDL on a floppy disk or other storage medium. 

Exporting EDLs without Audio Information

To export an EDL without any audio information (i.e. only the video data), be sure to deactivate the Audio Play-
back of all relevant Tracks (deselect the loudspeaker icon in the Audio Playback column) before exporting it 
from the Timeline. 

Multi-layer EDLs

You can also export multi-layer EDLs using separate export procedures. To do so, simply activate an audio or 
video Track (select/deselect the loudspeaker/monitor icon in the Audio/Video Playback column). The layers can 
be reconstructed when they are imported.
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Importing EDLs

Step by Step
To import an EDL: 

1 Click File > Import > EDL. 

2 The EDL Import dialog box appears. Select an EDL. 
(Note: Pinnacle Liquid supports the above-mentioned EDL formats.)

3 Click Open. The selected EDL is transferred as a new Sequence to the active Project. In the Project win-
dow, a new Rack Folder is created. This folder contains the Racks of the various types of media (depends 
on Sequence imported). 

After you have loaded an EDL in a Project, the Sequence appears as “empty” clips on the Timeline. 

To batch digitize clips, open the Rack Folder created when the EDL was imported. Open the Rack shortcut 
menu. Select Batch Digitize > All in Rack. For more information, 
see “Batch Digitize (Batch Capture)”  on page 8-77.

EDLs cannot be directly imported into an existing Sequence. Instead, a new Sequence has to be created.

Reading in Avid Media Log Logging Lists

Logging Lists created with Avid MediaLog can be read in in Pinnacle Liquid and used for Batch Digitize. Go to 
File > Import > EDL and specify the file type “*.ALE” under Files of type. Open the respective file on the drive 
(e.g. disk drive) and you will find a folder including a Rack with the logged clips in Project. You can then start 
digitizing with Batch Digitize.

Although these files al so have the *.ale suffix, MediaLog import does not involve the same procedure as 
importing ALE Projects (also see “XML/ALE/XCE Import and Export”  on page 7-3).
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VideoMachine DBF Import

You can import Project data from VM-Studio to a Pinnacle Liquid Project. 

Proceed as follows:

1 Export the relevant VideoMachine Project. Start by selecting the Timeline menu > Tools > General Prefe-
rences > DBF Export Structure. In the dialog box displayed, you can then define which Project data you 
want to export. The data that can be exported is activated in the screenshot below. You cannot import 
other data or media data to Pinnacle Liquid.

Only the selected data can be imported in Pinnacle Liquid.

2 After making your selection, select Project menu > File > Export Project. The file is saved under the 
name you selected and with the extension *.dbf.

3 To import to Pinnacle Liquid: Select File > Import > Video Machine DBF. Once the data has been con-
verted, a folder with the name of the export file is created in the current Project. The Racks in this folder 
correspond to the Reels of the Video Machine Project and contain the clips along with all the data and 
Picons.

You can digitize these clips using the Batch Digitize function ( page 8-77). Sequences (Video Machine Movies) 
can be exchanged by means of EDL import/export ( page 7-18).

When importing graphics files, make sure that the directory paths are the same. A graphics file that was, 
for example, located under C:\media\graphics\ in the VM system must be stored under the same direc-
tory path in Pinnacle Liquid so that it can be accessed by the software.
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Networking with Pinnacle Liquid 

It is possible to retrieve and save AV data not only to local storage media (i.e. hard discs directly attached to the 
system you are a working at) but also via a network, that is, on remote storage. Even Projects can be shared via a 
network.

To be able to work conveniently, the network needs to provide sufficient bandwidth between local and remote 
hardware. Thus it is possible to, e.g., use one system for capture and another one to edit on.

The following section does not in first line deal with Pinnacle Vortex and Liquid Editing for Workgroups 
network structures. For related information please refer to these products’ manuals.

Assign network drive or directory  page 7-24

Network settings  page 7-26

� WindowsXP network settings  page 7-27

Shared Projects  page 7-27

InterCom for editors sharing a common project  page 7-28

Proxy Generation  page 7-30

Assign network drive or directory

To connect Pinnacle Liquid to a network you have to assign network drives or directories in the Media Manage-
ment Settings:

1 Select Pinnacle Liquid Edit > Control Panel > Site > Media Management Settings.

2 Click Add and browse to the intended drive or directory. You can also create a new directory on a drive 
(if you have the required access rights).

3 Now make the newly selected or created drive/directory the primary capture drive (marked “X”), and it 
will appear as primary drive in the list of capture drives in the Logging Tool. 

As long as the selected drive/directory is on this list, its media files remain available for the local system. You 
can locate remote media files on the Project window Media tab and integrate them in your system with the 
Create clips of selected media function. This creates a Rack named Media Clips which contains the clips trans-
ferred to your current Project (the media files remain at the network location). This step is necessary because 
these media files were not created in your Project. Therefore, the Project does not (yet) “know” the clips.

However, if you create clips in the Logging Tool to be saved on a network drive (non-local), the clips will already 
be part of the Project.
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Save Network Data Locally

There are several possibilities to transfer data from the network to local or other network media drives: 

� via the Project Media tab -
The shortcut menu of the Project Media tab offers two options that you can use to transfer data from the 
network to your Primary Media Volume: Create clips and copy selected media to capture volume and Copy 
selected media to capture volume. The difference is that in the first case also clips will be added to a Rack. 
If the Primary Media Volume is a network directory, files can be copied within the network (or from 
local to network destinations). For information on Media Volumes, see  page 8-116. 

� Import -
Create, if necessary, a Rack. Open the Rack shortcut menu > Import > Media Clip and select the clip(s).
Select either the option Copy or Move (not Link) to actually transfer the data to the local storage. Care-
ful: Move removes the data from its original place. 

� using Consolidate -
this works only on the precondition that the clips already exist in the Project. For example, use Consoli-
date if you want to locally backup data originally retrieved from the network, that is, clips you used for 
your current edit. Open Rack shortcut menu > Consolidate and select the clip(s) or Sequence(s). Enable 
the Include identical files... option. For more info on Consolidate, see  page 8-85.
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Network settings

Three basic options help optimize network performance.
Systems configured for Pinnacle Vortex offer many more options. These settings, how-
ever, should be left to the Vortex specialist.

Open (via Edit > Control Panel > User > Network) the Network Settings dialog and enable 
or disable:

Network Settings Tab

� Do not generate AVI index files -
Speeds up the first file access, but may slow down a bit the overall access speed. 

� Do not generate Peak files -
No Peak files (used to display audio waveforms) will be created on import. This speeds up the import of 
large files.

� Use small block sizes for network -
In 100 Mbit or gigabit networks: network transfer block size will be limited to 64 kByte. Fibre channel 
networks can handle bigger block sizes.

� Liquid Editing for Workgroups: Use “Priority Calls” -
Use InTime to render on netwoirk drive -
These settings concern Vortex and Liquid Editing for Workgroups setups. Please refer to the respective 
product manuals.

MAS/MDC Settings Tab

These settings concern Vortex and Liquid Editing for Workgroups setups. Please refer to the respective product 
manuals.

Tab [ProductName] 

� Liquid Edition : Optimize AVI Capture for Network -
Should be enabled when you capture AVI files to a network storage medium.
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WindowsXP Network Settings 

You need Windows Administrator or Power User rights to install Pinnacle Liquid. To work with Pinnacle Liq-
uid, standard user rights are sufficient. In networks it is often useful to restrict user access. However, this may 
cause an error message to pop up when Pinnacle Liquid is launched by a user with limited rights (only on Win-
dows XP systems). To avoid this message, the “scheduling priority” for the limited user or the limited user 
group needs to be increased.

1 Go Windows startmenu > Settings > Control Panel > Administrative Tools > Local Security Policy

2 Select the folder Local Policies > User Rights Assignment

3 Doubleclick Increase Scheduling Priority

4 Add the relevant user(s) or user group(s) and click OK.

You may want to leave these settings to your system admin or IT specialist.

Shared Projects 

Two or more users can simultaneously work on the same Project. Please note that in the basic form of a network 
there is no central administration to handle such a Project-sharing (in Vortex it can be done).

So, when it comes to deleting and changing clips or media data, every user has the same rights. One exception: 
the user who first opens a Sequence gains exclusive access to that Sequence as long as it is open.
A good communication between users of a common Project is advisable. 

To stay up to date about all changes that a collaborator on the same Project makes, the software provides a 
Refresh function.

This function has to be assigned to a keyboard key.

1 Open the Keyboard Settings (Edit > Control Panel > User...).

2 Select Global Shortcuts from the end of the list in the upper left of the dialog. The Global Shortcuts box 
must be checked.

3 Open the tool box by clicking the wrench symbol, if it is not already open.

4 From the list in the upper right area, select Desktop.

5 Open the menu of the lowermost “T” (Project) and drag the Refresh Project Viewers button to a key of 
your choice.

6 Then confirm with Ok (checkmark) and all is set.
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InterCom: Messaging For Editors Sharing a Project

InterCom lets you exchange messages over the network. To use this service you need to assign the local com-
puter to a common root directory of a workgroup. This directory must be accessible for all users intending to 
be part of the InterKom exchange. You may have to ask your system administrator or IT department to set up 
such a directory. 

The InterCom address fields lists Windows computer names, not the names of the users who are logged 
in. It is a good idea to change those computer names to something more descriptive, e.g., “Edit 1” and 
“Edit 2” to designate certain editing suites.

Sign on

1 Call up the InterCom window by clicking the symbol shown here (it’s on the task bar, bottom right of 
the screen).

2 Select the Settings tab.

InterCom setttings

3 Enter the network file path of the common directory or navigate to the directory using the Browse but-
ton. If you enter the path manually, click Set to confirm.

Options:

� Open this window immediately when I receive a message -
makes the InterCom pop up in the foreground when a new message arrives.

� Automatically add senders to address list -
This puts every sender who mails a message on top of the list of recipients. You can reply immediately 
without having to select an address from the list.
Volume II Chapter Exchange7 - 28



PINNACLE

Networking with Pinnacle Liquid
Send and Receive Messages

You can use InterCom as soon as the computer is assigned to the common network directory.

1 Click the tool symbol shown here to open the InterCom window. 

InterCom window with address field, 
text field and field displaying sent and received messages

2 Click the To button (or ALT+T) to display a list of possible mail recipients. Or, if you know the address 
already, start entering the address. The system will complete the address while you are typing. 
Everyone on list sends the mail to all people listed.
To remove a name, select it in the address line and press DEL.

The names in the list consist of two parts: the prefix before the @ denotes the Pinnacle Liquid user 
name. If a user has not logged on to Pinnacle Liquid with a specific user name, or with only the default 
user name, Default is used instead. The second part denotes the computer network name. Examples: 
MOE@MUC-CPRXP or DEFAULT@MUC-CPRXP.

3 Enter your message. 

4 To send, click Send or hit ALT-S.

At the recipient’s computer the incoming message triggers a blinking, red-orange telephone to appear in the 
place of the InterCom symbol on the taskbar, or, if set to do so, the InterCom window opens automatically (see 
Settings tab). 
Click the blinking symbol to open the window. 
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Proxy Generation (Vortex)

This function is part of the Vortex news system. Proxies are bitrate-reduced representations of video clips. 
Because of their low resolution proxies claim only small amounts of network bandwidth. Proxies are generated 
using a data rate of 1.5 MB/sec and a 320x240 resolution (PAL/NTSC). Audio comes at 128 kbps. For more 
details please refer to your Vortex documentation. You should have your system administrator set up these 
options.

� Enable Proxy Generation -
makes the following options appear:

� Proxy Video and Audio Path -
specify where you want to save the audio and video proxy files.

� Proxy Device ID -
specifies the system within the network.

� Proxy Load Threshold -
When the CPU load exceeds the value entered here, proxy generation will be cut back in order to not 
interfere with editing or an ongoing capture process.
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OMFI Export

Complex audio editing is often carried out on special audio postproduction systems. The Open Media Frame-
work Interchange (OMFI) format has established itself as the exchange standard for this type of work. OMFI 
makes it possible not only to export the pure editing data (EDL is limited to this type of data) but also allows 
audio and video Media Files to be exported. Furthermore, it is possible to generate a precise map of a Timeline 
Sequence with all clips and layers. 

HD Sequences can not be exported by means of OMFI.

What is exported?  page 7-31

Calling OMFI Export  page 7-32

Composition

Defining OMFI components  page 7-33

Media

Export formats and media types  page 7-34

Options

Additional functions of OMFI Export  page 7-35

What is Exported?

The Sequence currently located on the Timeline forms the basis for the export.

The export includes:

� Clips on Tracks with Audio Playback or Video Playback active (or both).

� An area between the mark-in and mark-out points, or the entire Sequence.
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Calling OMFI Export

The OMFI Export Tool is located in File > Export > OMF. The dialog box below is displayed. It is divided into 
two areas: Composition and Media.

OMFI Export
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Composition

In this area, you can define the components of the Composition (the OMFI term for a Sequence).

OMFI Version

Select the desired version from the menu. OMFI 2.0 is the default setting; however, you can also select 
OMFI 1.0.

Note on importing in AVID Express: If OMFI 1.0 is selected, you should export AIFF audio data. Volume and 
panning settings are not retained.

Include

You can use this area to define the components of the Composition. This does not have anything to do with the 
Media Files that are actually exported (see below), but rather refers to the pure edit data (mark-in/mark-out 
points, etc.). You can choose from the following menu options:

� Video - only video clips are exported

� Audio - only audio clips are exported

� Video and Audio - video and audio clips are exported (default setting) 

Mix video down to one Track

In situations where a detailed imaging of the Sequence is not essential as far as the video clips are concerned, 
multiple Tracks containing video clips can be reduced to a single video Track (mix down). Audio clips are not 
affected by this setting.
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Media

The Media area of the dialog box contains settings that affect the form and format of the media data that is to be 
included in the composition:

Export with Media Files

This option is usually activated. You can use the drop-down menu to specify the file type to be exported (video, 
audio, audio and video (default setting)). During an actual export, the affected files are converted to an OMF 
file.

Consolidate media

This option is activated by default and ensures that the clips in a Sequence are transferred to the OMF format 
precisely in terms of their length. With a Handle Length of 0 (default setting), the resulting OMF clips cannot be 
trimmed beyond the mark-in or mark-out point. If a little trim leeway should remain, enter a specific handle 
length; if full access to the original Media Files is required, deactivate the function. This can, however, result in 
very extensive OMF files.

Video Format

This setting is important when you export video files. Select the desired compression rate. The approximate 
storage required is displayed next to the box.

Audio Format

This area defines the audio file format and sample rate within the OMF format. The Audio Format menu offers 
the following options:

� WAV - generates WAV files (default setting)

� AIFF - generates AIFF files

The Sample Rate menu offers the following options:

� 44.1 kHz (default setting)

� 48 kHz.
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From Mark In to Mark Out only

Activate this checkbox if only a section in a Sequence needs to be converted to OMF. If only a mark-in point is 
set, the end of the Sequence is assumed to be the mark-out point. If only a mark-out point is set, the beginning 
of the Sequence is assumed to be the mark-in point. 

Start Export

Once all the options have been set, click on the checkmark. In the dialog box that opens, specify the name and 
storage location for the OMF file. The file extension.omf is assigned automatically. During the rest of the export 
process, a window opens in which you can view the progress of the export and interrupt it if necessary.

Options

This area offers composition-related options that do not usually have to be changed:

OMFI Export options

Deactivate the effects that are not supposed to be contained in the composition. Volume means that clip-spe-
cific volume levels are transferred. 
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LST Import

This function imports editing data from Vortex, Pinnacle System’s Networked News Editing Solution. Please 
refer to your Vortex documentation for more details.
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As a preliminary step to the actual editing, this chapter deals with the sorting, finding, viewing, deleting, nam-
ing and copying of video and audio clips, i.e. the administration of a Project and all its components. 
It is divided into three parts:

Project 

Everything you need to know about the organizational systems in Pinnacle Liquid  page 8-4

� Opening and creating Projects  page 8-4

� Project templates  page 8-5

� Copying and deleting Projects  page 8-6

� Project structure (tabs, racks and folders)  page 8-7

� The Project Browser  page 8-14

� Project properties  page 8-16

� Diagnose project  page 8-18 

� Backing up and restoring projects  page 8-18

Object

The material from which the films are made  page 8-26

� Basics  page 8-27

� Objects in the Project (views, sorting, finding, re-importing objects)  page 8-31

� Searching for and finding objects (quick search; complex search)  page 8-40

� Clip Viewer: viewing objects  page 8-50 

� Object properties (object information)  page 8-66

� Storyboarding: Outlining a film  page 8-72

� Batch Digitize/Capture: Automatically digitizing (capturing) clips  page 8-77

� Consolidate: Reducing clips and Media Files  page 8-85

� Condense: Combining all the clips of a Sequence  page 8-88

� ClipSync: Synchronizing selected objects  page 8-90

� Automatic scene detection  page 8-93
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Media Management

Working with Media Files  page 8-97

� System formats in Pinnacle Liquid  page 8-102

� The media tab in the Project window  page 8-111

� Media Management Settings  page 8-116

� Search and import media files  page 8-126

� Deleting clips, objects and Media Files  page 8-128
Volume II Chapter Administration 8 - 3



PINNACLE

The Project
The Project

The Project is a key Pinnacle Liquid module, used for gathering, organizing and managing objects for produc-
tions. These objects include audio clips, video clips, Sequences, graphics, titles, subtitles, opening credits, clos-
ing credits, effects, animations, etc.
See also “The Object” on page 8-26.

Opening and Creating Projects

In Pinnacle Liquid, at least one Project must be open at any one time. 

To create a new Project...

� ...click � Menu bar  > File > New > Project.
In the dialog, enter a Project name and select a Template, if desired (see “Project Template”  on page 8-5), 
then click Ok.

To open a Project...

� ...click � Menu bar  > File > Open Project.
Select the appropriate Project in the list that appears and click Open. 

If more than one Project  have recently been worked on, you can select one of these Projects from the list 
displayed when you select � Menu bar  > File > Recent Projects...

Working With Two Projects Simultaneously

It is possible to edit two Projects at the same time; however, you have full access rights only to the “primary”, 
current Project, i.e. the one that was loaded in the Project window. A second Project can be open in the Project 
Browser, from which you can copy objects such as clips to the current Project.
More detailed information here: “The Project Browser”  on page 8-14.
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Project Template

In Pinnacle Liquid a Template refers to a predesigned standard Project with user-defined objects. For example, 
if you plan to produce a series of several parts, with a template you could define the standard elements for all 
parts, instead of having to load the same color bars, titles, subtitles, etc. in several Projects. 

Save Project as Template

Templates can be generated in these ways:

1 You can either add the required standard elements to a new, empty Project and save it as a Template, or 
you can delete all unnecessary objects (clips, etc.) from a completed Project and 

2 Save this as a Template (File > Manage Projects > Save as Template...).

Templates can only be used for new Projects. You cannot “superimpose” a Template on an existing Pro-
ject.

Delete Template

Select the Templates to be deleted from the list of Templates. Caution: the system does not prompt you again 
after you clicked Delete. 

Keep the Project from which you have generated one or more templates because updating a Templates 
requires that you have access to the original Project. Make your changes in the original Project and then 
save the new Templates under a new name or save it under the same name to replace the old Templates 
(in this case, you must first delete the old Templates).
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Copy/Delete a Project

Changes in a current Project are constantly saved. If you want to freeze the actual state of a Project, you can cre-
ate a copy of it.

Do not use the Windows Explorer for copying or moving Projects! Doing so may cause you to lose data!
Do not use the standard Windows dialogs “Save (as)” or “Open” to copy, delete or rename Projects!

Save A Copy

1 Select File > Manage Projects > Save a Copy. 

2 Type a name for the copy in the name field in the dialog box that appears. 
If you want a different folder to the pre-selected folder that Pinnacle Liquid opens first, you have to 
select the new location using the Open/Create a Project dialog box.

3 Click OK.

Finally, the original Project with the original name stays opened in Pinnacle Liquid.

If you change the file extension the copy will not be recognized as a Project any more and Pinnacle Liq-
uid will not open it.

Delete Project (with Media and Render Files)

It sometimes becomes necessary to delete Projects that are no longer needed. In this case, proceed as follows:

1 Select File > Manage Projects > Delete Project

2 In the dialog box that appears, select the Project you want to delete.

Click Delete Media Files to not only erase object data, such as clips and Sequences, but also all Media 
Files of a particular Project. This option should be used with care, since it is not possible to reverse the 
command once it has been carried out.
The same is true for the deletion of media files, which is also possible here.

3 Click Delete to erase the Project from the hard disk. The system will not prompt you for confirmation.

Clean Up Project

This function (located in the shortcut menu for the desktop Trash icon) deletes some of the peripheral Project 
data, which can become quite extensive especially for large and long, edited Projects. 
This function does not delete any objects, Sequences or Media Files.
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Project Structure

This section provides information on the basic elements of a Project and on how to work with them.

What Comprises a Project?
Look at the figure below or at any Pinnacle Liquid Project on your computer’s monitor. The name of the Project 
appears at the top left in the title bar.

Project window (Sample)
� Tree area 

The tree area on the left is used for creating and selecting Rack Folders and Racks.

� Content area
The content area on the right is used for organizing and viewing objects.

� Tabs
The five tabs provide you with an overview of your Project’s entire contents (All), specific Racks (Clips: 
without effects Racks), the individual effects Racks (FX; without clip Racks), the system effects Racks 
(Library) and media data (see also Media Management on page 8-97).

� Quick Finder
This button lets you locate specific objects in Racks ( page 8-40).

� Toolbar
The tool buttons are used for switching viewing modes and cutting, copying, pasting and deleting 
objects ( page 8-30). 

� Rack shortcut menu
Clicking the shortcut menu button (or right-clicking the content area) opens the Rack shortcut menu.

ToolsTabs

Tree area

Rack menu iconQuick Finder

Content area
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Working with the Project Window

The Project window behaves like any other Windows window with one exception: You can never close it 
because at least one Project must always be open. You can, however:

� Minimize it. It then becomes an icon in the taskbar, allowing you to clear a space on your desktop;

� Maximize it. The window then fills all the space available on the desktop (depending on the desktop lay-
out selected; see “Desktop Views”  on page 3-14);

� Resize it by dragging the window border.

� Drag the vertical bar between the content and Rack/folder areas. If more contents exist than can be dis-
played at one time, a vertical and/or horizontal scrollbar appears.

What Are Rack Folders and Racks?

Rack Folders and Racks provide you with a clearer overview, particularly in the case of extensive Projects.
Take another look at the Project window shown at the beginning of this section. 

� Racks are combined in Rack Folders, which cannot themselves contain individual objects. 

� Objects are combined in Racks.

The sample Project (“Project window (Sample)”  on page 8-7) contains the “Audio” Folder in which the “Audio1” 
and “Audio2” Racks have been stored. 

With some features, the “active” (or current, selected, clicked...) Rack is of importance. Newly created 
clips, for instance, may be placed in the active Rack. It is, however, possible to have more than one active 
Rack.
In such a case, the active Rack is the one selected and visible (tab in front) in the Project window. If you 
use the Project Browser, the selected and visible Rack in the Browser is “active”. If both Project window 
and Project Browser are visible with selected Racks, the Rack in the Project window has priority.
If the system can not access an active Rack, a new one will be created under the name Imported Media 
Files.
See also “The Project Browser” on page 8-14.
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Creating New Folders/Racks 

There must be at least one Rack in your Project in order to structure, organize, 
load, log and digitize the material you need for editing. In the default configura-
tion, a Rack with the name Sequences is created for each newly generated Project. 
Rack Folders are optional.

1 To create a new Rack Folder or Rack, right-click the tree area. 

2 In the shortcut menu that appears, click either New Rack or New Rack 
Folder.

3 The new Rack Folder or Rack is initially created under the placeholder 
name “New Folder (number)” or “New Rack (number)” and high-
lighted, meaning that you can immediately edit this name. Enter a name 
via the keyboard and press ENTER.

M u l t i p l e  F o l d e r  L e v e l s

You can nest Rack Folders to virtually any level, thus generating “sub-Rack-folders”, “sub-sub-Rack-folders”, etc. 
To do so, right-click a Rack Folder to display its shortcut menu and create another folder as described above.

Rack/Folder area menu
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Copying and Moving Racks and Folders

If your Project contains one or more Rack Folders or Racks, additional functions appear in the Rack Folder/Rack 
shortcut menu for working with Racks and Rack Folders. Right-click a Rack Folder or Rack to access the shortcut 
menu.

C u t / C o p y / P a s t e

� Use Cut to delete a selected Rack or Rack Folder from its current position. 

� Use Copy to create a copy of a Rack or Rack Folder; then use Paste to re-insert it somewhere else.

� Use Paste to insert a “cut” or copied Rack or Rack Folder somewhere else (for example, you may want to 
insert a Rack in a different Rack Folder). 

Rack Folder/Rack shortcut menu

Copying, cutting and pasting can also be done with the drag&drop function. To move Racks and Rack 
Folder, even several at once, simply drag them from Rack Folder to Rack Folder. To copy Racks, 
CTRL+drag them (a small plus symbol appears next to the mouse pointer). 
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Creating a Shortcut to a Rack

A Shortcut is a link to a Rack or Rack Folder. Any changes you make to a Shortcut (such as deleting an object it 
contains) are also made directly to the Rack, and vice versa. The only exception is deleting: if you delete a Short-
cut, the original Rack is not deleted.

1 Right-click a Rack to display its shortcut menu and select Create Shortcut.

2 The system generates the shortcut under the original Rack and assigns it the same name; however, the 
Rack icon now has a small arrow.

You can also create a Shortcut to a Rack using the drag&drop function: Drag the Rack to the desktop. A 
Shortcut is identified by the small arrow in the bottom left-hand corner of the Picon (the arrow appears 
on the icon in the Detail View).

W h y  U s e  R a c k  S h o r t c u t s ?

Rack shortcuts are especially useful on the desktop (see note above). They allow you to keep several Racks open 
at once, thus providing you with a broader, simultaneous overview of the materials available.
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Open Several Racks Simultaneously 

To view more than one Rack at once, drag a Rack icon from the Project window’s tree area as a shortcut to the 
desktop. Double-click the icon to open its Rack window, which is now a Shortcut of the original Rack within the 
Project window.

Desktop with Project window, shortcut icons and Rack windows

Rack windowsRack icons
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Deleting Racks and Folders

1 To delete a Rack or Rack Folder, right-click the Rack or Rack Folder. 

2 In the shortcut menu that appears, click Delete. The object is transferred to the desktop Trash. If neces-
sary, you can still retrieve it from there.

If you want to use a single object contained in a Rack Folder or Rack in Trash, you have to copy the whole 
Rack or Rack Folder back to the Project window. It is not possible to access individual objects contained 
in Racks or Rack Folder in Trash.

Renaming Racks and Folders

Use Rename to rename a Rack or Rack Folder. 

1 To do so, right-click the object. In the shortcut menu that appears, click Rename. 

2 The object’s name field can now be edited. Enter a new name and confirm with ENTER. 

You can also edit an object name by delayed double-clicking the name and then entering a new name, 
which is the same way as used in MS Windows.

Tools

You can also call the Cut, Copy, Paste and Delete functions from the Project toolbar by clicking the particular 
button.

Project toolbar

 

PasteCut

Copy Trash/Delete
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The Project Browser 

The Project Browser proves especially useful when working on a single monitor system. When active, the Project 
Browser takes up some space of the Timeline.

Project Browser 

The Project Browser is a miniature Project window. Use the this tool button to call up the browser. If you do not 
find the button on the Timeline tool bar, retrieve it from the corresponding tool box (see “Customizing Toolbars”  
on page 17-8). To close the Project Browser, click the tool button again.

Project window and Project Browser differ in one important issue: A selected (sometimes also called 
active) Rack or Rack Folder in the Project window is not automatically selected or active in the Project 
Browser. Please keep this in mind when using functions which refer to active, or selected, Racks 
( page 8-8).

� Change size and position of browser - 
The boundaries between Timeline and Project Browser as well as between content area and Rack/Folder 
area can be moved. Place the mouse on the separating line and drag it to the desired position (see 
arrows in screen shot above).
You may also change the positions of content area and Rack/Folder area. Right-click on the separating 
line between the areas and select a combination. Relative preserves the relative size of both areas when 
dragging bigger or smaller.

Views Rack shortcut menuToggle Rack/Folder 
tree visible/invisible 

Rack/Folder 
area

Content area
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To move the Project Browser to, say, top of the Timeline, right-click the separating line between browser 
and Timeline Headers and select an option from the shortcut menu.

� Show/hide rack tree -
Click to toggle between showing and hiding the Rack/folder tree.

The Rack Desktop shows clips and effects that were placed on the Pinnacle Liquid desktop, but no Racks.

� Switch Project - 
In case you need material from a Project other than the current, you can switch Projects. The current 
Sequence remains on the Timeline.
To do so, right-click the Toggle Rack Tree symbol. You get a list of the most recent Projects you worked 
on. Click the Project’s name to select it.
If you need a different Project, you will first have to open and close it the conventional way in order to 
get it on the most recent list. 

Using this function, it is possible to have two different Projects in Project window and Project Browser. 
The Project in the Project window (Working Project) stays the primary, current Project for which the user 
owns complete access rights. You can copy objects from the secondary Project (the one in the browser) 
to the current (the one in the window), but not vice versa.

Depending on context, a left mouse button double-click on an object results in different actions:
Project Browser: object is sent to the Source Viewer.
Project window (Rack): object is loaded in Clip Viewer.
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Project Properties

The Project Properties are a combination of several basic settings that users can modify to fit a particular use or 
preference. 

To open the Project Properties, right-click the content area or tree area, or click the shortcut menu button on the 
right-hand side of the toolbar and select Project Properties. 

All properties and settings that you can open and modify in the separate modules correspond exactly to 
the Properties and Settings in Edit > Control Panel >... You can thus make your settings in both places.

� Click In Picon View Show Clip’s Scene and Take Number Instead of Name -
to display scene and take numbers in Picon view. 
If you haven’t already specified these during logging/digitizing, then you can do this at any time in the 
Clip Properties ( page 8-66).

� Auto update project Picons -
updates all Picons in a Project (according to current mark-ins and mark-outs as well as index picons).
See also “Grab Picons” on page 8-29.

� Mark clips used in current Sequence -
Tells you which clips are being used (completely or partially) on the current Timeline Sequence. In Picon 
View a checkmark in the upper left corner of the Picon indicates such a clip, in Detail View it says Yes in 
the Used column position. You may have to edit the view to make this column visible: see “Edit View”  
on page 8-32.
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To define what action is carried out when you double-click an object, select one of the options available in the 
Double-Click On Clip area:

� Load Clip into Source Viewer - loads clip/object into the Sequence Editor’s Source Viewer for processing 
(“Source Viewer”  on page 9-39).

� Load Clip into Clip Viewer - loads clip/object into the Clip Viewer ( page 8-50). 

� Start Picon Play - starts playback of a clip in Picon view ( page 8-74).

� Open Object Properties - opens the object’s Properties box in order to view or modify clip data, such as a 
name or comment ( page 8-66).
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Diagnose Project

You can find this function the desktop Trash shortcut menu. It is used to recover Projects and objects that were 
damaged or lost because of a computer malfunction, or a manipulation of files.

If a problem was detected and if the recovery was successful, you will find a new Rack-Folder in the Project, 
named Diagnose Project.

Backing Up and Restoring Projects

You can back up all Project data, including Media and render data, on storage media such as hard disks, CDs or 
DVDs and import it from these media back to Pinnacle Liquid. 
This function is suitable for archiving entire Projects. It’s worthwhile backing up the Project media data, espe-
cially when it would be very difficult to recreate it (e.g. tapes without timecodes, live recordings, no access to 
sources). Depending on the scope of the Project, however, this can be a very lengthy process and may require a 
great deal of storage space.

It is possible to back up and restore Project, Media or render data separately.

Note that all data is copied and nothing is automatically deleted. Make sure you have performed the 
Backup/Restore correctly before you delete your data.

You can access the backup and Restore functions under Pinnacle Liquid � Menu bar > File > Manage Projects
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Backing Up a Project

You can back up all or specific parts of the data for a Project. 
You can access this function under File > Manage Projects >...

Backing Up a Project

The Backup project dialog box contains the following options:
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S a v e  t o . . . :

Here you have another chance to change the Project name, if appropriate. The Pro-
ject ID assigned by the system is appended in any case. The two combined form the 
name of the main backup directory. All other directories and files are stored on sub-
ordinate levels, depending on what you chose to back up. 

You can also define a specific backup directory. Click the icon to the right of the field 
and look for the path you want, or create a new directory.
If you do not specify a different directory, the Project is backed up in a directory 
named Backup. This directory is created on the same drive that contains the current 
render directory (e.g. R:\_Backup).

Important: Do not change the directory and subdirectory structure (for example, using the Windows 
Explorer) if you want to be able to use the Restore function.

I n c l u d e  d a t a  f r o m  c u r r e n t  p r o j e c t :

Project files

Activate this checkbox if you want to back up the Project currently loaded. This option saves all essential Project 
data (such as the clips with their Picons, Sequences, etc. - i.e. the actual editing work). The path of the current 
Project is specified on this line and cannot be changed. 
Saved Project data is protected and cannot be changed.

Media files

This option differentiates between imported and captured media data.

� Imported media (including linked files) -
This includes all data added to the Project by means of the Import or Copy/Paste commands. It also 
includes title graphics generated with TitleDeko and Media Files that were integrated in the Project 
using the Copy commands on the Project’s Media Tab. Media files generated by means of Consolidate are 
also affected as well as files that were imported via a link.

� Captured media -
This refers to the Media Files that were logged and captured either with the Logging Tool or the File 
Ingest tool. It makes no difference whether the files were saved locally or in the network (including 
CMS/MDC).

Media files from Version 2.55 or earlier are not compatible with the current Media Management 
(among other things, because of the incompatible file names) and are stored in a separate directory. 

Directory Structure for 
Project Backup
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Even if you activate Media files only (without Imported/Captured), the system includes a number of 
other files in the backup. These are Media Management link files that are used for restoring media paths 
in a networked environment. Leave the Media files checkbox activated if you need to reestablish access 
to a fixed stock of media data from the backed up and restored Project.

Render files

You can also back up render files generated by effects. Note, however, that you can restore render files at any 
time if you have the Media Files and the actual Project data. If storage space is limited, it is better to do without 
the render files.

O p t i o n s

The second tab in the dialog box contains three options:

� Overwrite without warning -
If a full or partial backup already exists, select this option to accelerate the process. The system will then 
refrain from prompting you to confirm.

� Compress project files -
This option reduces storage requirements by compressing the project data. When restored, the data is 
automatically decompressed.

� Burn to CD/DVD -
Select this option if your backup medium is a CD/DVD.
When you initiate backup, the Export to (S)VCD/DVD dialog box appears.
Insert the CD or DVD and start the burning procedure. (If necessary, you can specify the burner speed 
and enter a disc volume name on the Burning tab.)
For more information on this module, refer to page 16-18.

B a c k u p  I n f o

The number of files selected and the resulting storage requirements are displayed at the bottom of the dialog 
box. Compare this information with the available capacity, especially if you wish to back up the data to DVD or 
CD.
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R e f e r e n c e  s e t s

Reference Sets serve to save backup configurations and options. 

1 First select the configuration, such as Project data only, burn to DVD.

2 Click the Plus sign.

3 Enter a name for the reference set, such as “Project/DVD”.

4 Press ENTER.

As soon as you modify a Reference Set, the Double-Plus icon is activated. You must click this icon to acknowl-
edge your change(s). Use the Trash icon to delete Reference Sets from the list.

T i p s

Backup is always a trade-off between security issues and convenience. It can consume a large amount of storage 
space and time.

� Always back up (or archive) Project data.

� Back up Media Data if you no longer have access to the original material. This also includes graphics 
and animations that you have developed but of which there may not be any copies.
However: In the case of capture material, it is often faster and more practical to re-batch a Sequence. 

� Render files are the easiest to restore. If the media data is available, the system will do it automatically. 
Backing up render files is certainly the lowest priority, except in the case of productions with a large 
number of effects.
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Restoring a Project

A Project Restore is basically the reverse of Backup. Consequently, only Projects that have been backed up by 
means of the Backup function can be restored. You specify whether you want Project, Media and/or Render files 
to be copied back to your system.
You can access this function under Pinnacle Liquid � Menu bar  > File > Manage Projects

Moreover, the Project you are currently working on in Pinnacle Liquid is not automatically replaced. 
After the restore operation, you must open the Project and register the actual media and render paths in 
the system (Media Management Settings > Media Volumes > Add and System Settings > General > Ren-
dering).
Projects do not have to be restored on the same system from which they were backed up. Backup and 
Restore are possible from the network.

Restoring a Project
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R e s t o r e  f r o m . . .

The system first looks in the Backup folder that was created by the backup opera-
tion. If this folder contains one or more Projects, they appear on a list from which 
you can select one of them. 
If your backup files are located elsewhere, click the folder icon to the right to navi-
gate to the storage location.

In any case, when you call Restore project the system creates three directories. It is 
your choice whether or not you use them:

I n c l u d e  d a t a  f r o m  b a c k u p  p r o j e c t :

Select the components that you want restored on your system. If you want to store the data in a specific direc-
tory, select this directory. Otherwise, the data will be copied to the directories automatically created by the sys-
tem.

Project files

Select this option to restore the actual Project data (without media).

Media files

This option differentiates between imported and captured media data.

� Imported media (including linked files) -
This includes all data inserted in the Project by means of the Import or Copy/Paste commands. It also 
includes title graphics generated with TitleDeko and Media Files that were integrated in the Project 
using the Copy commands on the Project’s Media Tab. Media files generated by means of Consolidate are 
also affected.
In addition, files that were imported only by means of a link are backed up in separate copies.

� Captured media -
This refers to the Media Files that were logged and captured either with the Logging Tool or the File 
Ingest tool. It makes no difference whether the files were saved locally or in the network (including 
CMS/MDC).

Media files from Version 2.55 or earlier are not compatible with the current Media Management 
(among other things, because of the incompatible file names) and are stored in a separate directory. 

Render files

Retrieves the render files saved during Backup.

Directories Automati-
cally Created for 

Restored Project Data
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R e s t o r e  I n f o

The number of files selected and the resulting memory requirements are displayed at the bottom of the dialog 
box.

O p t i o n s

� Overwrite without warning -
Because existing files can also be overwritten, this option allows you to suppress the standard warning 
message.

� Add media path to Media Management dialog volumes list -
Relates to the Media Management Settings: This option automatically configures the path to the restored 
Media Files (captured and/or imported) in the list of Media Directories.
It saves you the trouble of assigning it manually.
Also see “Media Management Settings”  on page 8-116.

R e f e r e n c e  s e t s

This option serves the same function here as for Project Backup (see page 8-22).

Opening and Editing a Restored Project

Note that a restored Project will not necessarily be located in the usual directory. Its 
location depends on the restore path. To open the Project, always look for the entry 
with the small symbol in front of its name as shown here:

If you performed a standard backup/restore, your Project will be located in the..\_Restore folder.
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The Object

This section tells you everything you need to know about objects in Pinnacle Liquid:

Basics

Objects defined, basic methods for working with objects, etc.  page 8-27

Objects in the Project

Views; sorting; re-linking  page 8-31

Search for and find objects  page 8-40

View objects: Clip Viewer  page 8-50

Object properties

Find and edit object information  page 8-66

Storyboarding

Outline a film Sequence  page 8-72

Batch Digitize

Digitize clips automatically  page 8-77

Consolidate

Reduce clips and Media Files  page 8-85

Condense

Combine all the clips of a Sequence  page 8-88

ClipSync

Synchronizing selected objects  page 8-90

Automatic Scene Detection

Turn one into many  page 8-93

Media Management

Working with media files  page 8-97.
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Basics

What Are Objects?

In a Project, you will primarily be working with objects. “Object” is the most general word for items contained 
in a Project such as audio clips, video clips, Sequences, graphics, titles, subtitles, opening credits, closing cred-
its, effects, animations, etc. Racks and Rack Folders are also objects, as are Shortcuts and copies.

O b j e c t s ,  S h o r t c u t s ,  C o p i e s  a n d  M e d i a  F i l e s

“Objects” generally refer to items contained in a Project, such as video clips, audio clips, etc. Objects comprise 
one or more files on the hard disk. These files are called “Media Files.”

If you have digitized, for example, a clip with a Video Source Track and two synchronous Audio Source Tracks, 
this is considered as one object made up of three Media Files on the hard disk (one video file and two audio 
files). However, if you ungroup (disband) the Video and Audio Source Tracks on the Timeline, you end up with 
three objects.

In contrast to an object, a Media File cannot be modified - only created or deleted. If you want to trim a video 
clip, the Media File remains unchanged since trimming a clip only involves changing the mark-in and mark-out 
points to that part of the object you want to work with. 

In the Project module you can also create copies of objects and define object shortcuts:

� Copy
A “copy” is completely separate from the original object. If you edit a copy, the original object is not 
affected. Every object you place on the Timeline is a copy. If you trim the clip, the object in the Project 
remains unchanged.
Copies in the Project are used to create different clips from the same Media File or to create own effects 
starting with the copy of a default effect.
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� Shortcut
A “shortcut” is linked to the original object. If you edit an original object, the Shortcut is also changed 
and vice versa.
Shortcuts are mostly used to get quicker access to the clip. For example, shortcuts on the desktop give 
you instant access to several clips which are stored in different Racks.

Hierarchy of Project, folder, Racks and objects 
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Object Shortcut Menus

Each object in Pinnacle Liquid has its own shortcut menu containing functions that 
relate to the particular object type. Some functions, however, are available for all 
objects.

G r a b  P i c o n s

Use Grab Picons to update a clip’s Picons at the mark-in and mark-out.
For automatic update of all Picons in a Project, see “Project Properties”  on page 8-16.

C u t / C o p y / P a s t e

� Use Cut to delete a selected object or folder from its current position. 

� Use Copy to create a copy of an object; then use Paste to re-insert it somewhere 
else.

� Use Paste to insert a “cut” or copied object somewhere else (for example, in a dif-
ferent Rack). 

Copying, cutting and pasting can also be done with the drag&drop function. 
To move objects, even several at once, simply drag them from Rack to Rack. 
To copy objects, CTRL+drag them (a small plus symbol appears next to the 
mouse pointer).

C r e a t i n g  a  S h o r t c u t

1 Right-click the object. In the shortcut menu that appears, select Create Shortcut.

2 The system generates the shortcut below the original object and assigns it the same name; however, the 
object icon now has a small arrow.

You can also create a shortcut to an object using the drag&drop function: Drag the object to the desktop.

D e l e t i n g  O b j e c t s

For a detailed description of how to delete objects, refer to the section on media management (“Deleting Clips/
Objects and Media Files”  on page 8-128).

Object shortcut menu 
(Clip)
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R e n a m i n g  O b j e c t s

Use Rename to rename an object. 

1 To do so, right-click the object. In the shortcut menu that appears, click Rename. The object’s name 
field can now be edited.

2 Enter a new name and confirm with ENTER. 

You can also edit an object name by delayed double-clicking the name and then entering a new name, 
which is the same way as used in MS Windows.

U n d o / R e d o

Click Undo to reverse the last action performed. Click Redo to reverse the last Undo action performed. Undo 
and Redo apply to changes made directly to the object (for example, renaming), but not if you have moved it 
from Rack to Rack, deleted it, etc.

P r e v i e w

Click one or several clips in the Rack and select the function Preview > Selected from the Rack shortcut menu. If 
you wish to view all clips in the Rack, click Preview > All In Rack. The clips are now loaded in the Clip Viewer in 
the indicated given order and played back seamlessly as soon as you click Play ( page 8-50). 

S c e n e  D e t e c t i o n

“Automatic Scene Detection (Clip Viewer)”  on page 8-93.

Tools

You can also call the Cut, Copy, Paste and Delete functions from the Project toolbar by clicking the particular 
button.

Project toolbar

 

PasteCut

Copy Trash/Delete
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Objects in the Project

This section provides information on the interplay between Projects and objects:

Object views  page 8-31

Selecting objects  page 8-38

Sorting and arranging objects  page 8-38

Verify imported media  page 8-39

Views

Pinnacle Liquid makes a distinction between the Detail View (list) and the Picon View (images). This results in 
a number of variations and editing options:

D e t a i l  V i e w

The screenshot below shows the Project window with a few Racks and Rack Folders. One Rack in the list is 
selected. It contains several clips, displayed in alphanumeric form in the content area on the right, along with 
their mark-ins, mark-outs, duration, Tracks, etc.

Project window with Rack in Detail View 

Detail View
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Standard Detail View

To activate Detail View, right-click the Project window’s content 
area or click the shortcut menu button on the right side of the tool-
bar. In the shortcut menu that appears, click Detail View > Stan-
dard. “Detail” means that information is displayed in 
alphanumeric form with clip names, mark-ins, mark-outs, etc.; 
“Standard” means the information is displayed with the default 
column settings.

You can also activate Detail View by clicking its icon on the toolbar.

Edit View

To adjust the Detail View display, right-click the content area to 
open the Rack shortcut menu. Click Detail View > Edit View to 
open the Detail View Properties dialog box.

Properties box in Detail View

Rack shortcut menu (Detail View)
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� In the list, click the check boxes of those items you want to display in detail view. The area at the top of 
the dialog box shows how the Detail View display looks. You can also use this area to change column 
width. To do so, drag the column divisions to the required position.
You can also adjust column width directly in the Rack, however, these changes will not be saved.

� Slow double-click any column heading name in the Customized Name column to edit it. 

� To change the order of the columns, click the column heading name of the column you want to move. 

� Repeatedly click the arrow buttons to the right of the scroll bar to move the column heading up or down 
in the list.

Save Sets
To save a certain configuration as a set, click the Save Set As button and enter a set name. To load a previously 
saved set, click the Arrow icon on the right of the Set field and click a set in the drop-down list that appears. 
Click Delete to delete sets.

Object icons must always appear at the beginning of a line, i.e. they cannot be moved. For a list of icons, 
see “Object Icons (Detail View)”  on page 8-36.

Standard and Individual Settings

Individual sets can also be activated with the shortcut menu. The 
default (Standard) settings are always available.

Detail View settings in 
Rack shortcut menu 
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P i c o n  V i e w

Use Picon View to display objects as miniature images (Picons). In the case of a video clip, the first frame (mark-
in) generally appears. If you define a specific index image (during Logging or in the Clip Viewer), this image will 
appear. Graphics and titles are also displayed en miniature.
The Grab Picons function in the Rack shortcut menu updates Picons at the current positions of mark-in or clip-
in and clip-out or mark-out, respectively.

Project window with Rack in Picon view

The contents of only one Rack at a time can be displayed in the contents area of the Project window. 
Click the tabs or the Racks in the tree area for a quick overview of the Racks in your Project.

Picon View
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Click Small, Medium or Large to specify Picon size. How 
many objects will be visible, depends on the size of the 
window.

Clip names also appear in Picon View. If you prefer 
to display take and scene numbers (for example, if 
you are working with a screenplay), click the 
appropriate option under Shortcut Menu > Project 
Properties
(see also Project Properties on page 8-16).

Picon View: Mark-In/-Out

To display both the mark-in Picon and mark-out Picon, 
under Picon View, click the appropriate option, depending 
on what size you want to display Picons.

In this mode, you will see fewer clips within the same win-
dow size.
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O b j e c t  I c o n s  ( D e t a i l  V i e w )

In detail view, each line is preceded by an icon, representing object type and status.

Object icons in Pinnacle Liquid

Digitized video clip

Undigitized video/audio clip

Digitized video/audio clip

Undigitized audio clip

Digitized audio clip

Sequence

Graphics (title, image)

Audio effects

Animation

Video effects

Undigitized video clip

Subclip

Graphics (roll title)

Graphics (crawl) title)
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O b j e c t  I c o n s  ( P i c o n  V i e w )

Icons indicating the object status are also used in the Picon View:

Effects Applied to Clips Symbol

If you applied one or more effects to a clip, a grey star appears in the Picon:

Picon with effect and Attributes symbols (left); Media File unavailable (right)

Media File Not Available 

The exclamation mark in the upper left-hand corner indicates that a clip’s Media File is not available. This sym-
bol corresponds to the exclamation mark in Detail View for undigitized video/ audio clips.
In Detail View you can display the Media Online column. Yes or No indicates the media status of an object. See 
also “Edit View” on page 8-32.

Modified Clip Attributes

A small blue star in the top right-hand corner identifies clips whose

� Playback Level ( page 8-70) and/or

� Color Correction Attributes (Primary Color Correction) 

have/ has been changed. You can access these modifications via the extended dialog box in the Clip Viewer. 

To deactivate the modified attributes, see the section on Attributes, “FX Properties”  on page 8-71.

Clip Being Used in the Current Sequence

If so, the Picon will display a checkmark in its upper left corner. This option can be 
enabled in the Project Properties dialog ( page 8-16).

In Detail View it says Yes in the Used column position. You may have to edit the view 
to make this column visible: see “Edit View”  on page 8-32.
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Select All/Invert Selection

Click Select All in the Rack shortcut menu to select all objects in a Rack. In Picon View, selected Picons appear 
with a yellow frame around them; in detail view, selected items are highlighted. 

CTRL+click to select individual objects.

Click Invert Selection to select the items not selected and vice versa. This is useful if you want to select nearly all 
objects in a Rack, except for a few. In this case, first click the objects you do not want and then click Invert Selec-
tion. 

Sorting Objects

Objects in a Rack can be displayed in certain orders, regardless of whether Picon or Detail View is active. How-
ever, to actually sort items, you have to switch to Detail View:

Sorting clips according to ascending alphanumeric order

S o r t i n g  U s i n g  t h e  S h o r t c u t  M e n u

1 Right-click the heading of the column you want to sort.

2 In the shortcut menu that appears, click the required sorting method:
Ascending (0 to 9, A to Z),
Descending (Z to A, 9 to 0), or
Unsorted (leave in present order). 
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S o r t i n g  U s i n g  t h e  A r r o w  I c o n

Alternatively, you can also simply repeatedly click the heading of the column you want to sort, thereby toggling 
between the three sorting options, represented by the different arrow icons that appear (or don’t appear) in the 
heading.

� An arrow pointing downwards represents ascending order,

� upwards, descending order, and

� no arrow, unsorted.

Every column can be sorted, but you can only display the information sorted based on one column at a time. In 
other words, you can either sort by clip name or by the mark-in point or by the mark-out point, etc. Once you 
have specified the sorting method for one column, the other columns are automatically rearranged accordingly.

When sorting in ascending order, Pinnacle Liquid places numbers before letters; in descending order, 
letters before numbers. Although sorting functions are only available in Detail View, any order specified 
in detail view is maintained in Picon View. When Batch Digitizing ( page 8-77), Pinnacle Liquid auto-
matically sorts in ascending order.

Verify Imported Media 

The Verify Imported Media function 

�  checks the connection between imported clips or objects in a Rack and matching Media Files,

and

� tries to restore this connection (if missing) through re-import or re-linking.

Verify Imported Media is by default performed on clips whose media is not available (exclamation mark on 
Picon). But even if your clips are Media online, you may copy the Media Files of formerly linked clips to your 
local directory to achieve better performance, for example.
In the Rack shortcut menu, click Verify Imported Media > All in Rack or Selected. 
Volume II Chapter Administration 8 - 39



PINNACLE

The Object
In the dialog choose from the list a method of restoring the connection:

� Copy the located Media File to a Project media directory

� Move the located Media File to a Project media directory

� establish a Link between object and Media File (which stays at its location).

With the option Process only missing media unchecked, the operation includes all clips selected or in Rack. 

If Verify Imported Media cannot find a matching Media File, another dialog comes up. Here you can search for 
and select a specific file. 

See also “Media Management” on page 8-97.

Searching for and Finding Objects

Finding specific objects can be difficult, especially in extensive Projects. Pinnacle Liquid provides you with two 
tools: a Quick Finder and a complex Find Tool.

Quick Finder

Use this function (located in the upper left-hand corner of the Project window) to quickly find names and terms 
in your Project. Enter the term you are looking for in the field (you can also type in just part of the term). Click 
the Binoculars (Quick Finder) button.

If Pinnacle Liquid finds partial or full matches, the objects are highlighted in their Rack. Click the Binoculars 
button again to continue the search. 

Click the arrow icon to the right of the input field to open a drop-down list from which you can select and reac-
tivate a term you searched for previously. 

The Quick Finder function only finds objects based on the match principle and one after the other. Fur-
thermore, the search results cannot be grouped together in one Rack, so this function is best used to 
find a specific object quickly in an extensive Project.

In order to find objects in a Project based on more complex search criteria, use the Find Tool ( page 8-41).
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Find Tool

The Find Tool is a powerful tool for finding practically any object in a Project. It offers a complex series of oper-
ators for customized searching and lets you conveniently organize results. 

Opening the Find Tool  page 8-41 

Search criteria  page 8-42

Options  page 8-46

Displaying search results  page 8-47

Command bar  page 8-48

Creating a Rack  page 8-48

Move to Rack  page 8-49

Copy to Rack  page 8-49

O p e n  F i n d  To o l

To use the Find Tool, click Edit > Find.

Find window
The Find Tool includes three tabs which are used for specifying search parameters and displaying results. On 
the right-hand side of the window are additional search commands and options for transferring results.
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S e a r c h  C r i t e r i a

The following pages show how to set tab parameters for effective searching. 

Item + Location Tab 

Item + Location tab with search string 

Use the options in the Item + Location list boxes to specify the attributes of the object you want to find. To per-
form a search, the Item + Location window must contain at least one search string. A search string is made up of 
entries in the following boxes: 

� Column list box

� Operator list box

� Variable field

� More list box

Column List Box

To begin defining the attributes for a search, first select an attribute from the drop-
down Column list box. The box provides 18 different criteria for narrowing down a file 
search.

The option you choose in the Column list box has a direct effect on the options 
available in the remaining three boxes. 

Column list box
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Operator List Box

Use the Operator list box to specify criteria for further narrowing down your search. 

Various search routines are available in this box, for example:

� begins with
Use to search for items that begin with the search term.

� ends with 
Use to search for items that end with search term.

� contains
Use to search for items that contain the search term.

� doesn’t contain 
Use to search for items that do not contain the search term.

� exact match
Use to search for items that are completely identical to the search term. 

� doesn’t match
Use to search for all items except those that are completely identical to the search term.

Which options appear in one box depends on what you selected in other boxes. Pinnacle Liquid offers 
you logical operators to choose from.

Variable Field

What appears in this area depends on what you selected in the Column list box. The following boxes can appear, 
for example:

� Text box 
This box appears, for example, when you specify Name in the Column box and is used to search for a 
text string (maximum of 29 characters). Right-click the text box to open a shortcut menu with the func-
tions Undo, Mark and Copy.

Operator List Box
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� Tracks box
This box appears, for example, when you specify Tracks in the Column box and is used to define which 
Tracks to search. 
This is useful, for example, if you are searching for a clip, but only for video clips, not audio clips. To do 
so, select Tracks under Column, contains under Operator and click V (for video) in this box. You can also 
enter whether you are looking for mono (M) or stereo (S) audio clips in the select menu. 

More List Box
Use the More list box to specify the basic search operators AND and OR. Up to four search 
strings can be linked with these logical operators. Every line represents a search string. The 
default setting is “inactive” (---), in which case the system only searches for the first string. Use 
the AND and OR operators to search for and link additional strings.

Whether you use AND or OR depends on to what degree you want to narrow down the results. 
For example, a search for a certain clip name AND a certain Reel will result in one item, that is, if 
a clip of the specified name is located in a Reel of the specified name. A search for a certain clip 
name OR a certain Reel will result in a list of all elements in which both terms were found inde-
pendent of another. 

A maximum of four strings can be linked 

More list 
box
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Select

Use the Select tab to specify in which areas and for what types of media you want to search. The search proce-
dure always applies to the active Project. The following two options are available: 

� Racks to search in

� Media types to search for

Select tab

Racks to search in 

Use this function to specify which Racks to search through. This is especially useful if your Project involves 
many clips stored in a lot of different Racks. Click a check box to activate/deactivate it. Double-click a folder to 
open its substructure. If an item in a folder is selected, the check box next to the folder appears grey. 

To facilitate using the Find Tool, it is important to name text Racks meaningfully and effectively organize audio 
and video clips and transitions (for example, sorted according to media and events).

Media types to search for

Use the Media Types to Search For box to specify what type of media the Find 
Tool should look for. 

Media types
Volume II Chapter Administration 8 - 45



PINNACLE

The Object
Click the required check boxes. The logical operator between the various 
boxes is understood to be “OR”. 

Use this function to prevent types of media from being displayed that you are 
not looking for - even if they fulfill the criteria specified under Item + Loca-
tion. 

This function can be useful, for example, if you are looking for a certain 
video clip. If you specified V (for video) in the Location field, all filters and 
graphics in your Project will also appear. To avoid this, use this box to specify 
exactly what types of video data you want to find.

The options selected in this box have priority over those specified on 
the Item+Location tab.

O p t i o n s

Use the Options tab to set the following two basic search parameters:

Case sensitive 

Activate this option if you want the system to consider capitalization of information in the Text box when 
searching (if box is checked, system matches capitalization; if box is not checked, system ignores capitaliza-
tion).

No shortcuts

Activate this option if you want the system to ignore shortcuts. If the box is deactivated, the system will search 
for both original clips and crosslinks to such clips. 

If you click Audio, only 
audio data will appear. 
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S e a r c h  R e s u l t  D i s p l a y

This box displays the results of a given search.

Search Result area

The Search Result area offers two shortcut menus.

� To open the objects shortcut menu, right-click an object in the Search Result 
area. The options provided in this menu let you open an object, transfer it to the 
Timeline, copy it etc. 

� To open the Rack shortcut menu, right-click a free area in the Search Result area. The functions in this 
menu can apply either to all search objects or only selected objects. The options provided in this menu 
let you perform a preview of all selected clips, switch between object display modes, select objects etc.
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C o m m a n d  B a r

Use the three buttons at the top of the right-hand side of the Find window to 
control the actual operation of the Find function. 

Find Now

Once you have set all find parameters on the various tabs, click this button to 
begin the search. 

Stop

Click this button to halt a search at any time. This is useful if you realize that 
you have not narrowed down the possible results enough and the system is 
taking too long to process the command or if you already see the file you 
need in the Search Result area. 

New Search

Click this button to delete all previously set search parameters and begin set-
ting the parameters for a new search. 

Use the three functions at the bottom right-hand side of the Find window to 
control Rack assignments of files found. You can copy either all or only 
selected files to an existing or new Rack.

C r e a t e  R a c k

Use this option to create a new Rack into which you want to copy selected or 
all files. The dialog box that appears lets you specify a Rack name and loca-
tion. 

Search

Destinatio
Volume II Chapter Administration8 - 48



PINNACLE

The Object
M o v e  T o  R a c k  

Use this function to move objects from their present Rack to another, 
already-existing Rack (“moved” objects are deleted from their previous 
Rack). 

Use the Move To Rack function only if you are absolutely sure 
that you don’t need the objects any more at their original loca-
tion.

C o p y  t o  R a c k

Use this function to copy objects to another Rack (“copied” objects 
remain in their previous Rack).

Use this function for temporary operations with a specific 
selection of objects.
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Viewing and Editing Objects: the Clip Viewer

Using the Clip Viewer, you can view (or listen to) and edit audiovisual objects. Such objects are generally 
referred to as “clips”, and not just in Pinnacle Liquid. This section covers the following topics:

Opening the Clip Viewer  page 8-51

Basic Clip Viewer functions

� Navigation using the position bar  page 8-53

� Setting the mark-in/mark-out  page 8-54

� Mark-in/mark-out and clip-in/clip-out icons  page 8-54

� Brief overview: Scrubbing  page 8-54

� Timecode fields  page 8-55

� Timecode formats  page 8-55

Additional Clip Viewer functions  page 8-56

� Underscan/overscan  page 8-56

� Audio scrubbing and monitoring  page 8-56

� Setting Markers and adding comments  page 8-57

� Waveform inlayD  page 8-59

� Shuttle Playback  page 8-60

� Making a subclip  page 8-61

� Expand Clip  page 8-61

� Primary Color Correction  page 8-61

� Playback Level (audio)  page 8-65

� Auto Scene Detection  page 8-93 
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Opening Clip Viewer

The Clip Viewer can be opened in one of two ways:

� Right-click an object in a Rack or on the desktop. Click Open in the shortcut menu that appears.
or:

� Double-click the object you want to view. Provided you have selected the appropriate option in Project 
Properties ( page 8-16), the Clip Viewer will open along with the desired object.

The image appears in the window. It can be in the form of a video inlay (when the object is a video clip) or a 
graphic (e.g. a test pattern). Once the Clip Viewer is opened, you can load further objects by double-clicking 
them.

The usual play control and edit buttons are located below the position bar (for a description of these buttons, 
refer to chapter “Input”  on page 6-1).

Please note that there is no OK button - all changes to an object are constantly saved.

Double-clicking a Timeline clip opens the Clip Viewer with this clip. However, you cannot edit the 
mark-in and mark-out points because you are actually viewing a copy of the clip.
The Color Correction tab (for a video clip) or Playback Level tab (for an audio clip) is automatically dis-
played.

You can also configure the Clip Viewer’s toolbars. Right-click the toolbar to open the toolbox. Here you 
can arrange your toolbar with drag and drop. See also “Customizing Toolbars” on page 17-8.
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Basic Clip Viewer Functions

Clip Viewer

Current position 
of Playline

Length of clip from
mark-in to mark-out

Mark-in and mark-
out icons

Playline

Position bar

Extend
 dialog 
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N a v i g a t i o n  U s i n g  t h e  P o s i t i o n  B a r

The position bar is identical in the Clip, Source and Master Viewers and (in a miniaturized form) in Picon Play. 
Although the width of the bar is fixed, it is possible to view specific sections of a clip in the desired resolution. 
This makes navigation and thus finding scenes much easier, especially in long clips.

Position bar

Zoom Scale

The zoom scale allows you to change the scale of the position bar.
Use the mouse to drag the small mark triangle to the left or right. The mouse pointer then becomes a magnify-
ing glass icon with a plus or minus sign:

� All the way to the left - greatest resolution (about seven frames along the entire width of the position 
bar, one frame for each line in the scale).

� All the way to the right - smallest resolution (each line on the scale represents 120 seconds). 

Navigation Bar

The navigation bar represents the length of the clip with relation to the scale of the position bar.
You can use the mouse to drag the navigation bar; the results depend on the scale selected. When you drag the 
bar all the way to the left (right), the first (last) timecode position on the position bar is the first (last) image of 
the clip. The entire clip does not fit on the bar; you can view only a section. If you are unable to move the bar, it 
means that the entire clip appears on the position bar.
The small line below the navigation bar represents the Playline position within the clip. The mark-in and mark-
out points (if set) are also displayed. 
Functions:

� Double-click the navigation bar to toggle between two states: A full zoom-out to the mark-in/mark-out 
or the last zoom scale that was manually set.

� Double-click the navigation bar while pressing SHIFT to toggle between the zoom-out and clip-in/clip-
out or the last zoom scale that was manually set.

Playline and Navigation Bar

When you move the navigation bar, the Playline retains its absolute position in the clip.

When you press SHIFT while moving the clip, the Playline moves with the navigation bar.

Mark-in/mark-out points and other Markers remain in their defined positions.

Zoom scale Navigation bar Playline position
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S e t  M a r k - I n / M a r k - O u t

To insert a mark-in or mark-out point or to change their position, move the Playline to the required position 
and click the Mark-In or Mark-Out button. 

� To change the position of a mark-in or mark-out point, you can also move the mark-in and 
mark-out icons on the position bar while pressing ALT+drag. The mouse pointer turns into a 
cross. While the mark-in and mark-out points are being moved, the image in the inlay repre-
sents current position. You can also move Markers in the same way. 

� Press the SPACE bar to alternately stop and start playback. Press the ARROW-RIGHT and 
ARROW-LEFT keys to jog forward or back frame-by-frame. 

� If you use a mouse with a mouse wheel: simply turn the wheel to move the Playline frame by 
frame, press the wheel to move 10 frames at a time.

M a r k - I n / M a r k - O u t  a n d  C l i p - I n / C l i p - O u t

The icons in the corner of the inlay indicate that the Playline is at the mark-in or mark-
out (filled triangle) of a clip or at the beginning or end of the corresponding Media File 
of a clip (outlined triangle). See “Clip-In/Clip-Out and Mark-In/Mark-Out”  on page 
6-5 and “Media Management”  on page 8-97.

B r i e f  O v e r v i e w :  S c r u b b i n g  V i d e o

Below the image display window is a position bar which represents the length of the 
clip. With the Playline (press the left mouse button) you can move back and forth on 
the position bar. The process of dragging the Playline back and forth on the position 
bar is referred to as “scrubbing.” During scrubbing a bracket appears next to the mouse 
pointer. Scrubbing also works when the mouse pointer is in the inlay so you do not 
always have to be right on the position bar.

Mark-In Clip-In
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T i m e c o d e  F i e l d s

The two timecode fields indicate the position of the Playline and the length of the clip, respectively.

Position

You can also enter a timecode value manually to move to a certain position in a clip. This can be done in one of 
two ways:

� Click the Position field. In the box that opens, enter a timecode value using the numeric keypad. Alter-
natively, you can also click a single digit and enter a number to replace it. When you have finished input-
ting a timecode, confirm with ENTER. If the timecode turns red, you have entered an impermissible 
value (such as 00:61:00.34). On ENTER the Playline jumps to the indicated position.

� Begin typing the value on the numeric keypad. The editing field automatically opens.

Duration

The Duration field can also be edited. The mark-out value can be set based on the mark-in value and duration. 
So the length of the clip can be defined by the mark-in value and the specified duration. Once you have entered 
a duration value, the system instantly sets the mark-out point. Once you have entered a value in the Duration 
field, confirm with ENTER.

� To cancel an entry, press the ESC key. The display will return to the original value.

T i m e c o d e  F o r m a t s

The PAL and NTSC-DF/NTSC-NDF timecode formats use different separator characters between seconds and 
frames. Examples:

� NTSC Non Drop Frame: 01:00:00.00 (dot)

� NTSC Drop Frame: 01:00:00,00 (comma)

� PAL: 01:00:00:00 (colon)
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Additional Clip Viewer Functions

U n d e r s c a n / O v e r s c a n

This toggle switch lets you choose between Underscan and Overscan inlay view. 

� Activate Underscan to show the whole frame with all pixel information displayed. 

� Activate Overscan (deactivate Underscan) to display a cut-off view, typical of a television picture. 

The default setting is Underscan.

If you don’t find this button in the standard toolbar of the Clip Viewer, open the Customize window (right-click 
in toolbar) and drag the button to the toolbar. (See also “Customizing Toolbars” on page 17-8.)

A u d i o  S c r u b b i n g  a n d  M o n i t o r i n g

“Audio Scrubbing” in non-linear editing can be compared to what professional tape recorders are capable of, 
i.e. to slowly (or faster) play and rewind the tape to find a certain audio position while you‘re actually listening 
to the sound. In Pinnacle Liquid move the Playline within the position bar or in the Video Inlay of the Clip 
Viewer. Pinnacle Liquid features two types of audio scrub:

� Analog scrub -
To activate audio scrubbing, you must first press the SCROLL key. 
Then right-click the Audio Tool icon on the task bar (bottom right). A shortcut menu is displayed from 
which you can toggle between analog and digital.

� Digital scrub -
Press the CAPS LOCK key on your keyboard to activate digital audio scrubbing. Press it again to deacti-
vate this mode.

If you use a mouse with a mouse wheel: simply turn the wheel to move the Playline frame by frame, press the 
wheel to move 10 frames at a time.

Select Audio Tracks
If you are working with clips including three or four Source Tracks (A1 to A4), you have to select the Source 
Track(s) you wish to monitor when scrubbing. Please note: This has no effect on the Audio Editor Routing.
To do so, drag the function Select Audio Tracks from the toolbox of the Clip or Source Viewer to the function bar.

You can match Source Tracks to certain physical audio outputs. To do so, select a combination in the function 
menu.

� If the scrubbing mode was activated, you can scrub frame by frame by using the RIGHT 
ARROW/LEFT ARROW keys. Press the ARROW keys and the SHIFT key simultaneously to move 
the Playline by 10 frames each.

If Liquid Control  is connected: Activate/deactivate the Scrubbing mode with the SCROLL key and 
move the jog button or the shuttle ring. This option is supported in all modules.
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S e t t i n g  M a r k e r s  a n d  A d d i n g  C o m m e n t s  

You can set as many Markers as you like on the position bar and attach a comment to each one.

Setting and Deleting Markers
� Setting - Move the Playline to the Marker position and click the Set Marker function. The Marker icon is 

inserted in the position bar.

� Deleting - Position the Playline directly on a Marker in order to delete it using the Delete Marker func-
tion. You can select the Marker more easily using the Goto next/previous Marker and Goto next/previous 
event functions. (See also “Button Navigation” on page 9-29.)

Attach comment

1 Set a Marker.

2 Double-click a Marker to open its comment box. 

3 Enter a text.

4 Confirm with OK or press the ENTER key.

Set Markers and add comments

 

Comment boxDelete MarkerSet Marker
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Display attached comments

To display the entered information, including the timecode data of the given position, rest the mouse pointer 
on a Marker for about a second (comment appears automatically) or double-click the Marker to open the com-
ment box. 

Marker comments in clips are transferred to the Timeline and can be accessed there in the same way. 

GoTo Marker List

Click this button to open a window with a list of all Markers and comments for a clip. Click a given entry to 
move the Playline to this position in the clip and display the corresponding image in the inlay. 

If you don’t find this button in the standard toolbar of the Clip Viewer, open the Customize window (right-click 
in toolbar) and drag the button to the toolbar ( page 17-8).

List of clip Markers 

� Marker Comment - contains a Marker comment created by the user. To enter a comment, double-click 
the Marker and type in information in the field that appears.

� Clip - shows the timecode position of a Marker on a clip. 

Right click in the Marker window to display a shortcut menu containing the following entries:

� GoTo Marker - Moves the Playline to the selected Marker, without closing the window in the process (as 
it does when you click the Marker entry).

� Clear Selected Marker - Deletes selected Marker. 

� Clear All Markers - Deletes all Markers.
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Wa v e f o r m  I n l a y

If you are editing an audio-only clip in the Clip Viewer, the waveform of the clip is displayed in the inlay win-
dow:

Waveform Inlay

The illustration shows a stereo clip. Both Source Tracks are arranged in the upper area. The two lines of the Play-
line encircle an image frame. The lower area shows the same Track in larger scale. The section above is indicated 
by a rectangular frame. You can mouse-scrub in the lower and upper waveform.

� To change the dimension of the rectangular frame, use CTRL-ARROW-UP or DOWN.

The Waveform Inlay cannot display more than two Source Tracks at once. Use the option Audio Source Tracks to 
select the Source Tracks to be displayed.

If you want to edit the Audio Source Tracks for a video clip in the Waveform Inlay, first deactivate Video in the 
object Properties dialog box for the relevant clip ( page 8-66).

The Waveform Inlay of audio clips reflects their individual Playback Level settings. A very low volume 
audio clip, for example, appears in the Waveform Inlay with an accordingly “flattened” waveform.
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S h u t t l e  P l a y b a c k  ( J K L )

The Shuttle Playback function is available for fast or slow reverse and forward playback of video and audio. This 
function is available in the Clip Viewer (as well as in the Source Viewer) in two different speeds:

� 7 and 15 frames per second (slow Shuttle Playback; forward/reverse for NTSC; for PAL: 6 and 12)

� 30, 60, 90, and 150 frames per second (fast Shuttle Playback; forward/reverse for NTSC; for PAL: 
25,50,75,125)

The tool icons of the Shuttle Playback can be found in the Toolbox. You can include them in your customized 
software interface ( page 17-8). 

Enable Shuttle Playback

To enable Shuttle Playback, click one of the icons indicated below. Click again (or press a key) to activate the 
next higher or lower level. Clicking the opposite icon results in stepwise acceleration or deceleration. It is 
moved to the opposite direction at 30 or 7 frames (NTSC). 

Shuttle Playback (fast)

Allows you to switch through a playing speed of 30, 60, 90 and 150 frames per second (NTSC, forward/reverse). 
PAL: 25, 50, 75, and 125.

Shuttle Playback (slow)

Allows you to switch through a playing speed of 7 and 15 frames per second (NTSC, forward/reverse). 
PAL: 6, 12.

� The Shuttle tools are assigned to the following keys in the standard keyboard layout:

� J - Fast reverse playback

� K - Stop

� L - Fast forward playback

� SHIFT-J - slow reverse

� SHIFT-L - slow forward
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M a k e  S u b c l i p

Click this button to create a Subclip from a given clip, defined by the position of the mark-in and mark-out. 

� This function is particularly useful when you want to isolate several different scenes and takes from a 
long clip. 

� Every new Subclip is saved in the Rack. 

� The term “sub” only defines the relationship of these clips to the original clip and its Media Files. In the 
Project window and on the Timeline, they are handled in the same way as any other clip. Subclips appear 
in Racks with the same name as their original clip, but have a Subclip icon. ( page 8-36.)

� Sub Clips will be automatically scaled to their duration in the viewers, so you don’t have to deal with the 
length of the Media File.

If you don’t find this button in the standard toolbar of the Clip Viewer, open the Customize window (right-click 
in toolbar) and drag the button to the toolbar. (See also “Customizing Toolbars” on page 17-8.)

E x p a n d  C l i p  ( T o  A v a i l a b l e  M e d i a )

Expand Clip makes the media file of the clip completely available for trimming the clip in the Clip Viewer.

A clip can be trimmed to its clip-in and clip-out points, but not beyond. However, with a subclip, by definition, 
there is digitized material beyond these points available. Expand Clip lifts the initial limitation of the clip by 
expanding the clip’s boundaries to the media file’s clip-in and clip-out.

P r i m a r y  C o l o r  C o r r e c t i o n ,  P l a y b a c k  L e v e l  a n d  S c e n e  
D e t e c t i o n  

Liquid blue  offers realtime, hardware-based color correction (the same function as in the Logging 
Tool, minus the option for setting parameters directly by dragging the mouse pointer in the inlay).
Liquid Edition’s color correction in the Clip Viewer is a variant of the software-based realtime 
effects.

Primary color correction in the Clip Viewer is identical to primary color correction in the Color Correction Edi-
tor only with regard to its mode of operation. The corrections are separate applications that have no effect on 
one another.

Color Correction settings and the (audio) Playback Level are object Attributes. To work with these Attributes, 
load a clip in the Clip Viewer and open the extended dialog box using the small arrow to the right of the Dura-
tion timecode field.

The Active checkbox lets you temporarily deactivate or reactivate Attributes. Also see “Tab: Special”  on page 
8-70 and “FX Properties”  on page 8-71.

You can also double-click a Timeline clip to open the Clip Viewer with an extended dialog box.
Volume II Chapter Administration 8 - 61



PINNACLE

The Object
Video tab  page 8-62

Audio tab (Playback level)  page 8-65

Scene tab  page 8-93

Video Tab (Primary Real Time Color Correction)

This tab contains the functions for primary color correction. The correction works 
non-destructive, meaning that its attributes are saved with the clip metadata and 
used in real time for playing back the digitized material.

Shadows, Midtones, Highlights Black, Gamma, Gain 

Color Correction can be applied in measured doses in three graduated luminance areas:

� Shadows (black, pedestal)

� Midtones (gamma)

� Highlights (gain, lift, white value)

By selecting an area, you can perform selective color corrections. In each of these areas, you can control the red, 
green and blue color channels and the brightness (luminance - gray bar).

Color Correction
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Hue and Saturation 

These two functions affect the entire image. 

� Hue -
With this function you travel once around the entire color wheel either clockwise or counter-clockwise 
(“Color wheel and color vectors (vectorscope view)”  on page 8-65).
To view the effect, try applying this function to the color bars test image. Each color gradually changes 
to the color adjacent to it in the color wheel.
This function is especially important in the NTSC standard because it can be used to balance the color 
shifts typical of NTSC.
Value range: +/- 255.

� Saturation - 
This function adjusts the colorfulness of the image from achromatic (black-and-white, completely de-
saturated) to very, very colorful (over-saturated). 
Value range: +/- 255.

Using Color Correction 

Color Correction is a primary color correction (as opposed to secondary or selective color correction). It is clip-
based, meaning that modifications apply from a mark-in to a mark-out (no key frames).

The Restore to Default button shown here resets all the parameters to zero.

Red, green, blue and brightness (luminance) can be controlled separately. Nevertheless, a change in a color 
channel also causes a change in luminance. Proceed as follows:

1 Select Black, Gamma or Gain (shadows, midtones or highlights). 

2 Drag one of the color bars or the luminance bar to the desired position or enter a value from -255 to 
255. Single-click the small button next to a bar to reset it to the original value.

3 The effect is instantly visible in the video inlay. 

4 A blue five-point star appears on the clip Picon in the Rack indicating that Color Correction attributes 
exist for the clip.

5 To deactivate the modified attributes, uncheck the box below; for more info see the sections on Attribu-
tes, “Tab: Special”  on page 8-70 or “FX Properties”  on page 8-71.

6 Pinnacle Liquid displays the modifications in real-time.
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CCIR 601

Limits the image output signal to the values permitted by the CCIR-601 Standard by clipping any exceeding 
components. 

Work only in CCIR

This option confines values within the limits of CCIR 601, meaning that illegal colors cannot even be created 
during correction (rather than only be clipped at the output). 

75% Color

Limits the CbCr color components to 75 percent of the maximum permissible value.

Reference Sets

With this function, you can save up to 16 different groups of settings and restore them if necessary. The param-
eters of all three correctors plus tools are saved. 

Click the Plus symbol to add a set. A modified set can be saved using the double-Plus symbol. Trash deletes the 
current set, which you can choose form the list.

Color Correction: Basics 

Color correction is a science in itself; for this reason, only an outline can be presented here.

The Color Wheel 

The color wheel - a physiologically inspired reflection of the phenomenon of color vision - is based on the 
assumption that four basic colors form two opposite pairs: red and cyan, blue and yellow.

Add to this the brightness, which ranges between white and black. These three pairs can be spread over a three-
dimensional coordinate grid (color space) in which each color that can possibly be displayed is defined by its 
blue or yellow component, red or green component and a brightness. In color television technology, the oppo-
site color pairs are replaced by the color difference signals R-Y (Cr,U) and B-Y (Cb, V). The luminance signal Y 
forms the third coordinate. 
The basic colors red, green and blue and the mixed colors magenta (violet), cyan and yellow that lie in between 
are points (color signal locuses) within this wheel. Thus the color phenomenon is also displayed in the vector-
scope (the use of this measuring device for color manipulation is highly recommended). 

When examining a color bar in the vectorscope, each of the colors named above is represented by a glowing dot 
at a specific location of the screen (like the tip of an arrow; see figure). The arrows are called vectors. With the 
aid of these vectors, all the possible points (= colors or hues) within the wheel can be precisely defined mathe-
matically.
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The position of a point relative to the center of the wheel affects the colorfulness (saturation) of a color; a pale 
blue is close to the center and a vibrant, fire-engine red is located near the wheel’s periphery. A hue (red, green, 
blue, etc.) is an angle in the color wheel. Pure red is located at approx. 104 degrees and red-violet (magenta) at 
approx. 92°. Note that in the degree scale of the vectorscope, 0° is located at “3 o’clock”. 
Thus a color is adequately defined by the length of the vector and the angle. On this basis, color corrections are 
performed in the “YUV” color space. 

Color wheel and color vectors (vectorscope view)

RGB Color Model 

It is also possible, however, to use three bars for quantitatively displaying a hue. These bars (one red, one green, 
one blue) can be seen in Pinnacle Liquid Color Correction. A color appears to be composed of different percent-
ages (bar lengths) of the three basic colors RGB, apart from the pure basic colors themselves. RGB is generally 
specified in values from 0 to 255. Example: (0,255,0) is pure green; (0,0,0) is black; (255, 255,255) is white. 
Computer monitors and TV screens generate colors from “packages” of red, green and blue dots illuminated at 
different intensities. 

Playback Level

Here you can set the volume level for an audio clip for playback (Timeline and/or Source/Clip Viewer). For more 
information on this function, see: “Audio Tab”  on page 6-27.

Scenes Tab

See “Automatic Scene Detection (Clip Viewer)” on page 8-93.

Red 104°

Yellow 
167°

Green 241°

Magenta 61°

Blue 347°

Cyan 284°

90°

270°

180° 0°
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Object Information: Properties

This dialog box contains detailed, object-specific information on, for example, the name of the Media File, file 
size, length, date last changed and where it is located. 

The FX Properties provide additional information on objects to which video or audio effects have been applied.

Opening the object Properties box  page 8-67

Customizing the object Properties box  page 8-68

General elements of the object Properties box  page 8-68

� Edit properties of multiple clips simultaneously  page 8-70

FX Properties  page 8-71

Properties of a signal clip  page 6-59

Setting the volume, waveform and level
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Opening the Object Properties Box

Right-click an object to open its shortcut menu and click Properties to display the following or a similar dialog 
box:

 

Full view of Properties window with customize dialog box on right

� The Properties differ slightly depending on the object type.

� The General tab is available for all objects. See also “General Elements of the Object Properties Box” on 
page 8-68.

� The V tab is available for video clips and image objects.
Also see “Media Management and Object Properties”  on page 8-122.

� Tabs A1 and A2 (and in some cases, A3 and A4) contain information on the audio format.
Also see “Media Management and Object Properties”  on page 8-122.

You can also customize this dialog box to meet your particular needs. This procedure is described in the follow-
ing section..

Customize
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Customizing the Object Properties Box

1 Click the wrench icon to open a field containing three tabs: General, Timecodes and Special. 

2 Drag the elements you want to include in the dialog box from the appropriate tab to the required posi-
tion. The position of existing buttons is shifted to make way for the added tools. Remove any elements 
by dragging them to a tab or the desktop. The mouse pointer turns into a trashcan symbol when an ele-
ment is in an area in which it can be removed. 
The Customize dialog box has to be open to move elements within the Properties dialog box.

3 When you have finished, click the Customize button again. The new settings are now used for all Racks 
in the Project and saved in the user profile ( page 17-3).

General Elements of the Object Properties Box

The customize elements are distributed among three tabs:

Ta b :  G e n e r a l

� Name - 
Name of object appears initially. This can be the name automatically assigned by the system, for 
instance, during logging (see also Clip Tab: Naming and Numbering Clips on page 6-21) or a name you 
created. You can use this name or enter any name of your choice.

� Comment -
Use to enter comments regarding the object.

� Reel -
For a video or audio clip: Name or number of the object’s source tape/medium. You cannot edit this 
field (see also Media Management on page 8-97).

� Audio Reel -
The name of the Reel where the clip’s audio originated. Video and audio clips from different sources can 
be synchronized using the ClipSync Function ( page 8-90).

� Tracks -
Used to specify the object’s video and/or audio Source Tracks. 
You can regroup disbanded clips (following a Disband Clip(s) operation) by reactivating the original 
Source Tracks (see page 9-67).

In the Track field, you can deselect audio/video tracks that were previously digitized and add tracks that 
have not yet been digitized. Naturally, clips with source tracks added must be redigitized (if Media 
Management cannot match suitable Media Files).
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� Audio Mode -
Used to switch audio clips to mono or stereo. (See also “Stereo and Mono, Panorama and Balance” on 
page 13-8.)

� Scene/Take/Attributes -
Use this option, for example, if you are creating your video based on a screenplay. You can adjust the 
Project Properties so that objects in Picon View are displayed either with their name or scene and take 
numbers ( page 8-16).

� Camera -
This option assigns the clip to a specific camera (see chapter Edit, MultiCam editing).

T a b :  T i m e c o d e s

� Duration -
Indicates the length of a clip between the mark-in and mark-out points. (Do not confuse with clip-in 
and clip-out points.) 

� Mark In / Mark Out Picture -
Displays the mark-in and mark-out points as Picons.

� Clip Length -
Indicates the length of clip between the clip-in and clip-out points. This number reflects actual or max-
imum Media File duration, respectively. Mark-in and mark-out points can be different to clip-in and 
clip-out points.
This field can be edited.

� Clip In/Out -
Indicates the actual beginning and end of a Media File.
You can edit these fields. Together with an appropriate Reel name, it is now possible to define clips in the 
Object Properties dialog box, since Media Managements matches Media Files with suitable clips.
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Ta b :  S p e c i a l

� Created -
Indicates the date and time the object was created. The system clock serves as a reference.

� Modified -
Indicates the date/time when the object was last changed. The system clock serves as a reference.

� Index Picture -
If applicable, displays the selected index picture. 

� Parent Project -
For a clip that was inserted in the current Project by means of CTRL-C/CTRL-V or Create Clip (Media 
Management,  page 8-114): The original Project in which this clip was created.

� Basic Clip Attributes -
You can activate (check mark visible) or deactivate (no check mark) Color Correction and Playback 
Level settings (known as clip Attributes). A blue five-point star appears on or disappears from the clip 
Picon.
See also “FX Properties” on page 8-71.
If this checkbox is deactivated, these Attributes are just not applied.

� Status OK/NG -
Clips marked with “No Good” can be excluded from the Batch Digitize process by activating the Clips 
Marked OK option.

� Original Name -
Name of the Media File that the clip referenced when it was imported. The reference can change during 
the course of your work; this allows you to clarify sources.

E d i t  t h e  p r o p e r t i e s  o f  m u l t i p l e  c l i p s  s i m u l t a n e o u s l y  

1 Select all clips that you want to edit in a Rack, on the Timeline or on the Desktop.

2 Open Object Properties by right-clicking one of the selected clips.

3 Edit all relevant items, e.g. Clip Name or Audio Tracks.

4 Confirm the modifications: click the checkmark or the Plus(+) sign.

Properties which cannot be edited are grayed out.
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FX Properties

FX Properties provide information on and access to the effects applied to 
an object. You can activate or deactivate the effect parameters and clip 
attributes. 
The effect editors are listed below the horizontal line and the attributes 
are listed above it.

� Activating and deactivating parameters and attributes: Click the 
appropriate checkboxes.
Double-click an entry to open the Effect Editor or Clip Viewer. 
The effects are not deleted; they are simply not applied. This 
allows you, for example, to prevent rendering.

The colored line on the upper edge of the Timeline clip (indicating the effects and attributes applied) 
appears interrupted if effects or parameters are deactivated.
For Project clips, a black and/or blue star is displayed. See also “Object Icons (Picon View)” on page 8-37.

� You can change the order in which effects are rendered. To do so, click the effect and then click the 
arrow buttons to move it to the required position.

� To delete an effect from the list, click it and then click the Trash button.

� Right-click an effect to open a shortcut menu and click Edit to access its Effect Editor. 

In the case of a Timeline clip, you can open the FX Properties dialog box from the clip’s shortcut menu. 
For more information, see “FX Properties”  on page 9-68.
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Preparing for Editing: Storyboarding

A storyboard is used to roughly outline the course of an editing job. Using Picons, you can quickly put together 
a Sequence to get a rough idea of what a film will look like. With the Picon Play function and Clip Viewer, you 
can view and edit clips. Afterwards you can transfer your storyboard Sequence for fine editing to the Timeline 
or Source Viewer with the Send To Timeline function or with drag&drop.

Storyboarding on the desktop  page 8-73

Picon Play  page 8-74

Shortcut menu for objects on the desktop  page 8-75

Transferring storyboards (Send To)  page 8-76

Storyboarding in a Rack  page 8-76
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Storyboarding on the Desktop

You can arrange Picons on the desktop in any way you like. Drag clips from a Rack (or Racks) to the desktop to 
begin arranging them.

The Picons that appear are Shortcuts (represented by the arrow icon in their bottom left-hand corner). This 
means that any changes you make to the clips also affect the clips in the Rack (for example, if you define new 
mark-in and mark-out points they will also appear changed in the original clip).

To transfer your storyboard Sequence to the Timeline, make sure all Picons are selected (yellow border), 
the Picons slightly overlap, with each succeeding Picon on top of the previous one. Pinnacle Liquid can 
then recognize the order of the clips. The bottom clip is used as the first clip in the Sequence on the 
Timeline; the top clip, as the last. Do not click a clip somewhere in the middle of the stack, because that 
would change the order. 

Simple storyboard
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Picon Play

Picon Play is possible both in Picon View and in Detail View. 

A c t i v a t e  P i c o n  P l a y

� ALT+double-click the Picon or clip name.

� Double-click a clip’s Picon (Picon View) or a name (Detail View). For this to 
work, you have to have selected the option Start Picon Play in the Project Proper-
ties dialog box ( page 8-16). 

Pinnacle Liquid starts playing the clip in a window in Picon format (its size depends on the size you specified in 
Picon View). The clips plays until you click another object or on another area of the Project window. 

A d d i t i o n a l  P i c o n  P l a y  F u n c t i o n s :

� The Playline shows the position in the clip being played at any given time during playback.

� To scrub, position the mouse pointer on the inlay and drag it to the left or right.

� To set mark-in and mark-out points, use the A and S keys on the keyboard (default).

� To redefine the clip, ALT+drag any existing mark-in/mark-out points. The mouse pointer turns into a 
cross.

� Markers and comments also appear, if set. To view a Marker comment, simply position the mouse 
pointer on the Marker.

� Press the SPACEBAR to either start or stop playback, ESC closes the image window.
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Shortcut Menu for Objects on the Desktop

Picon View can be controlled just like in a Rack ( page 8-31) with an object’s 
shortcut menu. Use the Mark-In/Mark-Out mode to see the actual images at the 
in and out points.

Moreover, three special functions are additionally available for desktop story-
boarding:

S e l e c t  A l l  O v e r l a p p i n g

Click an object in a series, then right-click and select this option to select all 
overlapping objects in the given series. If you created two or more series of over-
lapping clips, you have to repeat this procedure for all other series. Selected 
objects appear with a narrow yellow border.

You can also select objects with the mouse by dragging a frame around 
them or with SHIFT+click.

C a s c a d e  S e l e c t e d  O b j e c t s

Click this option to arrange all selected objects in a 
cascaded stack to create more room on the desktop. 

S h u f f l e  S e l e c t i o n

Click this option to view the individual objects in a cascaded stack in their defined 
order. Each object is displayed for about two seconds. This is useful for viewing 
entire clip series. Once the last object is reached, the system starts over from the 
beginning. To stop this procedure, click the desktop.

Shortcut menu
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Transferring Storyboards (Send to)

You can also transfer a Storyboard (i.e. a connected series of clips) to the Timeline or Source Viewer.
Simply select all the clips and click Send to > Timeline. The clips are then grouped (video and audio combined 
in one clip) and inserted (at the location of the Playline).

If you want to have more control over the process, proceed as follows:

1 Empty the Timeline (“New Sequence”  on page 9-47).

2 Load one of the clips you selected to the Source Viewer.

3 Check the Source Track Mapping and drag the V, A1 or S labels, etc., to the correct positions, i.e. to the 
places where you would like to position the video and audio clips.

4 Select Grouped or Ungrouped (= no checkmark), as appropriate, as well as Stereo Mapping from the 
shortcut menu for the first column (to the far left) before the start of the Timeline.

5 On the desktop, select all the storyboard clips, either by clicking Select All Overlapping (shortcut menu), 
or by dragging a lasso around them, or by clicking them while holding down the SHIFT or CTRL KEY.

6 The Playline should be located at the start of the Timeline. Now click Send to > Timeline (from the 
shortcut menu for any of the clips).

7 Load all of the clips to the Timeline. 

Remember that the source mapping settings also affect the assignment of Source Tracks to Timeline 
Tracks (since with Send to > Timeline the selected clips are transferred to the Timeline via the Source 
Viewer, even if this is not apparent to the user; see “Source Track Mapping”  on page 9-22).

Objects on the Timeline are initially linked by a hard cut, since you cannot add Transition effects to a storyboard 
Sequence on the desktop.

Storyboarding in a Rack

The procedure for creating a storyboard Sequence in a Rack is similar to that of using the desktop. 

Use the mouse to move objects. Objects must be arranged in a certain way so that the system knows how to 
organize them on the Timeline. In Detail View, arrange objects from top to bottom; in Picon View, from left to 
right and from top to bottom. Click Send To > Timeline to move selected objects to the Timeline (same proce-
dure as when working on the desktop).

Sorted mode must be disabled. Change briefly to the Detail (list) view and check whether any of the col-
umn headings contain a small triangle (pointed up or down). If yes, click this triangle until it disap-
pears. This activates the unsorted mode. You can now rearrange the objects however you want.
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Batch Digitize (Batch Capture)

Batch Digitize is the automatic digitizing of what is usually a large number of clips and is, therefore, usually the 
next step after logging ( page 6-36). However, this function is also recommended for the transition from offline 
to online editing or for “cleaning up” Projects.

Call Batch Digitize  page 8-77

The Batch Digitize module  page 8-78

Start/Cancel Batch Digitize  page 8-82

Batch Properties  page 6-31

Batch Digitize and render effects  page 8-84

Calling Batch Digitize

You can call Batch Digitize from the Project or from one or more clips on the Timeline. You must have a remote 
controlled player connected to your system. 

Batch Digitize can be applied to one or more clips, to entire Sequences. and to clips that have been edited with 
the Timewarp Editor.

To call Batch Digitize, go to the Rack or Sequence containing the clips to be digitized or the Sequence and open 
either

� The clip shortcut menu ( page 8-29) and then Batch Digitize (this clip only will be batched)

or

� The Rack shortcut menu (using the button on the top right in the Project toolbar or clicking in a free 
area of the Rack window).

Select Batch Digitize and then one of four options:

� All In Rack - Starts Batch Digitize for all the clips in a Rack.

� Selected - Starts Batch Digitize for all selected clips.

� Not Digitized - Analyzes which clips are not digitized and starts Batch Digitize with these clips.

� Clips Marked OK - Starts Batch Digitize with the clips whose status is set to OK ( page 8-66). Clips that 
have been logged in Pinnacle Liquid always have the OK status.
This option is especially useful when using Sony ClipLink where it is already possible to assign a status 
of OK or NG (No Good) while recording.
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The Batch Digitize Module

After the clips have been selected, the Batch Digitize module is displayed above the Timeline instead of the 
Sequence Editor.
When you call this module, the Clip tab is displayed in the foreground with the following segments:

 

The Batch Digitize Module

B a t c h  S e t t i n g s

These options affect the size and number of Media Files generated.

Condense to Mark-In/Out

Use this option to digitize clips from mark-in to mark-out. Otherwise clips will be digitized from clip-in to 
clip-out.
On first-time digitize, mark-in/mark-out and clip-in/clip-out are most probably identical. When Use Mark-In/
Out is activated while batching a Sequence, only the required media data will be created. Otherwise you could 
end up with a lot more digitized material on your disk drives.

See also “Condense”  on page 8-88.

Remember: If you plan to batch the media data of a certain Sequence, call up Batch Digitize from the 
Sequence clip’s shortcut menu (you find the Sequence as a clip in the Sequence Rack of the Project) and 
check the Use Mark-In/Out option. Batching all original clips from the Rack(s) is not going to do the 
trick since they may have totally different mark-ins and mark-outs.
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Handle Length

In the default configuration (Handle Length = 0), digitizing is performed exactly from the clip’s mark-in point 
to its mark-out point. If you enter a value (in frames) under Handle Length, this will be added to both the mark-
in and mark-out, i.e. the Media File created will be a bit longer. 

Example (for NTSC): From a clip with mark-in = 00:01:00.00, mark-out = 00:02:00.00, handle length = 30 
frames, a Media File is created with a length of 1:02 minutes (clip-in = 00:00:59.00, clip-out = 00:02:01.00).

Mark-in and mark-out points cannot assume values that exceed those of clip-in and clip-out points. 
Rule of thumb: Mark-in <= clip-in. If the media file’s mark-in and clip-in points are identical, you can-
not add a handle length.

Tip: If you “batched” the clips of a Sequence with a Handle Length in order to leave yourself room to 
trim these clips later on, you must expand the relevant clips before you can lengthen them (you can 
always shorten them). This is done by selecting Expand Clip(s) from the Timeline clip shortcut menu 
(also see “Expand Clip (To Available Media)”  on page 9-64).

Merge Gaps below...

Clips that follow in very close succession on a tape can be merged into one Media File. This means that the 
player does not stop at the clip’s mark-out (clip-out) and restart at the next mark-in (clip-in) but instead keeps 
running, thus avoiding any unnecessary shuttling back and forth on the part of the player. Plus, it’s faster.

In the field, enter a Distance in frames:
If a mark-out or clip-out (first clip) and mark-in or clip-in (next clip) are within this distance (taking into 
account any Handle Lengths), a single Media File is created that is referenced by two or more clips.

When clips overlap (mark-in/clip-in of the later clip comes before the mark-out/clip-out of the earlier 
clip), the system automatically tries to merge the clips in one Media File.
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Merge works only with clips of the same type; for example, if a clip with the Source Tracks VA1A2 follows 
a clip with the Source Tracks VA3A4, separate Media Files are generated. See also example illustration 
below.

Schematic diagram: Merge if less than... with “Distance” set to 10 Frames

Just Clips without Media

This option limits digitizing to clips that are not associated to any Media Files. 
This options corresponds to the option found in the Rack shortcut menu > Batch Digitize > Clips Not Yet Digi-
tized.

A u d i o  T a b

On this tab, you can monitor the input level but you cannot change it.

M e d i a  T a b

On this tab, you can select the capture Quality Rank for the batch operation. For example, if you now want to 
change a Sequence that was edited with “offline” clips to a master-capable format by batching, select another 
rank here. For more information, see the Quality Rank section in chapter “High Definition”. 
Most users, however, should leave the default as it is.
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B a t c h  I n f o

This section contains information on the current batch job.

Total Duration

This field initially contains the accumulated duration of all the clips, as they were sent from the Project to be 
batched, that is, before the options Handle Length, Use Mark-In/Out or Merge if less than... are applied. 

The actual duration of all resulting Media Files is calculated, and displayed, when you launch the Batch. That 
duration can be longer or shorter, depending on material and options selected.

Batch List

Here you find not a list of all the clips you selected for batching but rather a list of resulting Media Files after 
batching. Please note:

� Initially, all clips/resulting Media Files are marked Queued in the Status column, meaning they weren’t 
yet processed.

� In case of merged files, the list entry carries the name of the first of the merged clips.

� Any Handle Length or Merge Distance that you may have selected ( page 8-79) can change the list, which 
is immediately updated once you start the batch process.

� The clips/resulting Media Files are sorted (in an ascending order) by Reel and by mark-in, in order to 
reduce Reel changes and player action.

B a t c h  S t a t u s

� The progress indicator below this field provides you with information on the overall progress of the 
batch operation.

� A progress indicator below the video inlay refers to the current clip being digitized/Media File being 
created.

The audio peak meters display the level being applied during digitizing. Any Playback Levels that were 
logged are not taken into account (see also Playback Level on page 6-28).
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Starting/Stopping Batch Digitize

 Before you begin, be sure to check the following settings:

� The Media Format/Codec (depending on product) selected 

� Destination volumes for digitizing -
If more than one destination volume is registered, select one from the list box.
When necessary, Batch Digitize employs all volumes (disk drives) available through Media Manage-
ment to complete the current batch job. See also “Media Management Settings” on page 8-116.

� Settings for the player -
Click the player button next to the player name to open the settings dialog box 
( page 6-10)

The batch operation starts when you click the Digitize button and runs automatically following these steps:

1 First, Batch List and the Duration are updated, if applicable.

2 The system prompts you to insert a specific tape. If you haven’t yet done so, insert the correct source in 
the player and click OK.

3 If all runs smoothly, one batch list entry after the other is removed from the list as Batch Digitize com-
pletes the job.

4 In case of successful termination the Batch Digitize dialog closes.
Otherwise, see “Error Messages”  on page 8-82 below.

Pinnacle Liquid processes the clips in ascending order by mark-in points in order to avoid any unneces-
sary shuttling back and forth on the part of the player.

E r r o r  M e s s a g e s  

Clips that could not be digitized remain in the batch list, marked with one of the following error messages 
(Status column). 
Please note that the systems proceeds to digitize all other clips on the list. There is no need to stop the batch 
before the batch is done. Problematic clips can be digitized after successful troubleshooting.

� Diskspace -
The file(s) could not be fitted on any one of the available volumes. (See also “Disk Full State / Change 
Volume” on page 6-34.)
At the end of the batch, the system goes into troubleshooting mode,  page 8-83.

� Failed -
The data could not be digitized correctly, or the digitize process could not be completed.
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� Player -
A general player device error occurred.
Check the device setup, cabling, existence of reference signal etc. 

� Preroll -
The preroll position could not be located on the tape (Reel).
Most probably a wrong tape was inserted, or there is TC problem.

� Routing -
The Source Track selection and the actual device parameters don’t match (Example: the clip calls for 
VA1A2A3A4 but the device delivers only VA1A2).

� TC break -
A TC break was detected and the clip(s) could therefore not be digitized.
Please note: The TC Break Behaviour Settings in the Logging Tool Properties have no influence on TC 
breaks detected during Batch Digitize.
At the end of the batch, the system goes into troubleshooting mode.

T r o u b l e s h o o t i n g  M o d e

The system goes into troubleshooting mode once the batch list has been completed and at least one of the fol-
lowing errors has occurred:

� TC break -
Assuming that clips were carefully logged, TC breaks should not occur when digitizing a batch. Due to 
activated Merge if less than... and generous Handle Lengths, however, TC breaks may inadvertently fall 
in the range of resulting Media Files.

� Diskspace -
Due to the excess capacity digitized as a result of Merge if less than... and generous Handle Lengths, the 
system may run out of available diskspace. 

In both cases the system comes up with a new batch list, now without paying heed to the Distance value of the 
Merge... function. Beneath the Merge... function a message appears, saying Press Digitize to retry without mer-
ged media.
Do so, and the system attempts to digitize these now un-merged clips. On successful completion the Picons of 
the clips are updated.

S t o p  B a t c h  D i g i t i z e

To stop a batch operation, click the Cancel button. Since this does not exit the Batch Digitize module, you can 
restart the batch.
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Batch Properties

The Batch Digitize Properties dialog box is in part identical to the Logging Tool Properties dialog box:
 page 6-31.

Batch Digitize and Render Effects

If you use Batch Digitize to digitize the clips of a Sequence that has already been edited in order, for example, to 
achieve a higher image quality, note the following:

� All the rendered components of this Sequence (clip effects, Transitions, slow-motion clips, accelerated 
clips, etc.) initially retain the quality in which they were originally rendered. 

� When played, the Sequence accesses the existing Media Files of the rendered passages unless you deleted 
these files.

� If you deleted the render Media Files, Pinnacle Liquid re-renders the appropriate passages using the cur-
rent render quality ( page 10-37).

� You can initiate a re-render operation manually by deleting the render files for the Project ( page 8-131).

B a t c h  D i g i t i z i n g  C l i p s  w i t h  a  M o d i f i e d  S p e e d  
( S l o w - M o t i o n ,  E t c . )

Media Management starts rendering these clips using the saved parameters as soon as the associated Media 
Files are available.
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Consolidate

The Consolidate function copies the media data required by clips (individually or 
in a Sequence), thus permitting those that are no longer needed to be deleted. 
Once a Sequence has been completed you can, for example, discard the surplus 
raw materials in order to create more space on the storage media. Consolidate can 
also be applied to individual clips.
You also have the option of storing the consolidated clips in a Rack (see also Con-
dense on page 8-88). 

Consolidate is for logged clips only. It does not work with imported clips.

After successful Consolidate the “old” Media Files are no longer instantly 
accessible. That is because all consolidated clips are now referenced to 
consolidated (i.e. copied) Media Files. 
As long as the “old” data has not been deleted, however, you can use 
Create clip(s) from Media File(s) to re-establish access ( page 8-114).

Consolidate copies sections of selected media data, meaning you should 
not wait to execute this function until your storage media are almost full.
For safety’s sake, the old Media Files are not deleted automatically unless 
you have expressly set this option (checkbox activated).
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Calling Consolidate 

The Consolidate function is located in the clip and Sequence shortcut 
menus (in the Project), and in the Rack shortcut menu.

1 Select one or more clips, or a Sequence. 
If you use the Rack shortcut menu, you can also select Consoli-
date for all the objects in the Rack.

2 Select Consolidate from the shortcut menu. When a Sequence is 
selected, all the clips in the Sequence are consolidated.

3 A dialog box is now displayed containing several options:

� Handle Length -
This value (in frames) is added to the clip’s mark-in and mark-
out points in order to leave room for subsequent trimming.

Handle Length needs sufficient data on the part of the original 
Media File.

� Create new MASTER clip(s) in new Rack -
If this option is activated, Pinnacle Liquid creates a Rack in the Project containing all the clips of the 
Sequence. You can assign a name to this Rack in the text field provided.
(That is basically the function of Condense ( page 8-88)).

� Include identical files (move to new location) -
In the default configuration, the consolidated media data is saved to the directory from which the origi-
nal data was taken. However, with this option you can divert the consolidated data to a directory of your 
choice, which is especially useful if the original media volume is near capacity limit.
You must either select this directory in the Media Management Settings or create it, and identify it as the 
Primary Volume ( page 8-117).
This means that you can, for example, assemble a number of files gathered together in the network on 
one (local) volume.

4 If there is not enough space available in the current volume ( page 8-117), an error message is displayed. 
In this case, determine which Media Files are not needed and delete them.

The Sequence or clip(s) can be played exactly as before. They are, however, now referenced to the newly created, 
consolidated Media Files. You can either retain or delete the “old” Media Files (see the next section).

Consolidate dialog box
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D e l e t e  O r i g i n a l  M e d i a ( s )

You can also simply activate the Delete Original Media(s) checkbox so that media files will be automatically 
deleted following a Consolidate operation. But consider the warning in the dialog box carefully because you will 
have no more opportunities to intervene or delete files selectively.

Consolidate and the Consequences

After Consolidate has been successfully applied, the number of new Media Files contained in the Project Media 
Directory can be no more than the number of clips contained in the consolidated Sequence (a single consoli-
dated clip results in up to five Media Files, one video file and up to four audio files).

Pinnacle Liquid Media Management then ensures that the clips reference these new Media Files, i.e. you can 
play them immediately in the Clip Viewer and on the Timeline. See also “Media Management” on page 8-97.

Consequently, you can now delete any “old” Media Files that are no longer needed. In order to avoid undesired 
consequences, we strongly recommend the following method to delete Media Files: 

1 In the shortcut menu for the consolidated Sequence/clip(s), click Tag used media. 
Media Management now determines how many clips access the same Media File.

2 Open the Media tab in the Project window and under Streamed media, select the Project in which the 
Consolidate operation was executed.
All the Streamed Media Files are now displayed.

3 The result of the Tag used media command appear in the Tags column as a number from 0 to..., depend-
ing on how many clips reference the same Media File. 

4 Sort the Tags column by clicking the column heading (or using the shortcut menu) so that all zero (0) 
Tags are together.
“Zero” means that the Media File is not used by any clip.

5 Select the 0 Tags and then click Delete in the shortcut menu.

When you delete Media Files from the Media tab, the files are deleted immediately and permanently 
without your being asked to confirm the deletion.
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Condense

The Condense function generates copies of clips. Associated Media Files are not copied (see also Consolidate on 
page 8-85).

This function is used, for example, to generate the inventory of a Sequence. It allows you to view exactly what 
material and what length of material was used - a useful function if you need to create a music list or archive 
footage list.

Schematic diagrams comparing Consolidate (left) and Condense (right)
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Calling Condense

The Condense function is located in the clip or Sequence shortcut menu in the Project.

1 Select one or more clips, or a Sequence. 
If you use the Rack shortcut menu, you can also select Condense 
for all the objects in the Rack.

2 Select Condense from the shortcut menu.

3 A dialog is now displayed containing two options:

� Handle Length 
This value (in frames) is added to the clip’s mark-in and mark-out 
points, thus creating a new clip-in or clip-out.

� Create new MASTER clip(s) in new Rack -
If this option is activated, Pinnacle Liquid creates a Rack in the 
Project in which all the clips created by the Condense operation are 
stored. Condense dialog box
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ClipSync

The Rack shortcut menu contains the ClipSync option that allows you to synchronize clips according to several 
criteria, such as a mark-in or Markers individually set as synchronous points.

Which objects can be synchronized?  page 8-90

How to synchronize clips  page 8-91

Which Objects Can Be Synchronized?

You can synchronize

� a video clip with one or more audio clips,

� an audio clip with one or more video clips or

� audio clips with one or more audio clips,

(depending on the synchronous point selected). The result is a new clip: VA1..A4 or A1..A4

In all cases, note the following:

� A video clip cannot be synchronized with audio clips from different Reels, i.e.:
Vreel#1 + A1reel#2 + A2reel#3 cannot be synchronized.

� Nor can a video clip be synchronized with audio clips from the same Source Track, i.e.:
V + A1 + A1 cannot be synchronized. Generally, same Source Track clips (V + V, A2 + A2) cannot be 
synched.

� ClipSync attempts to perform all technically feasible synchronizations. If, for example, you select one 
video clip and three audio clips that can be synchronized, the almost inevitable result will be three syn-
chronized clips.

� The names of synchronized clips have the suffix “.Sync”.

When you synchronize clips of different lengths, the clip produced is as long as the longest overlapping area of 
all the participating clips:

ClipSync combines clips by aligning synchronous points and by clipping parts that exceed 
their joint overlapping range

� The timecode format must be identical for all participating clips. PAL and NTSC TCs cannot be mixed.
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How to Synchronize Clips

1 :  S e l e c t  o b j e c t s

Open the shortcut menu for a Rack containing clips to be synchronized and select ClipSync (either for all the 
clips in the Rack or for selected clips).

The ClipSync dialog box is displayed containing a list of the selected or marked, valid clips from the rack. For 
example, if you have selected only video clips, there is nothing for ClipSync to do and so the list is empty.

You can then select specific clips from this list or synch them all (select no or all clips).

ClipSync functions on the basis of synchronous points, i.e. points in clips that are positioned frame by 
frame exactly above one another on the Timeline (see diagram above). For example, you can locate, 
mark and align sound of the slate in the image and the associated peak in the audio clip waveform (in 
other words, synchronize the two clips). Naturally, you must already have inserted your individualized 
marking in the form of a mark-in/mark-out or Marker before starting ClipSync. If you’re synchronizing 
with a timecode or clip-in/clip-out, you can start ClipSync immediately.

2 :  S e l e c t  s y n c h r o n o u s  p o i n t s

Use the two list boxes in the middle of the ClipSync dialog box to select synchronous points.

Synchronize to timecode

If video and audio clips have identical timecodes, synchronizing to timecode can be very useful. Clips of differ-
ent lengths are aligned to the first common TC value. Assuming that clips share common timecode values, the 
following rules apply:

� Several audio clips from the same Reel are assigned to the same synchronized clip if permitted by the 
Source Tracks:
Vreel#1 + A1reel#2 + A2reel#2 + A3reel#2 = VA1A2A3.sync 

� Audio clips from different Reels are combined separately with the video clip:

� Vreel#1 + A1reel#2 + A2reel#3 + A3reel#4 � VA1.sync + VA2.sync + VA3.sync 

� One audio clip and several video clips with matching timecodes can be synchronized:
V1, V2, V3 + A1 � V1A1.sync + V2A1.sync + V3A1.sync

Synchronize to mark-in or mark-out/clip-in or clip-out

You can use existing mark-ins or mark-outs as synchronous points. Clip-ins and clip-outs are always present 
but can’t really be set individually.
Otherwise the rules described under “Synchronizing to timecode” apply.
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Synchronize to marker

You can synchronize to

� the first Markers in the clips (in earlier TC counts).

Otherwise the rules described under “Synchronizing to timecode” apply.

3 :  S p e c i f y  c r i t e r i o n

If necessary, you can define the selected synchronous point more precisely by means of a second criterion. The 
second list box (on the right) contains:

� any name (default)

� identical clip name (exact match)

� fitting clip name (partial match)

� identical Reel name (exact match)

� fitting Reel name (partial match)

For example, if you select Identical clip name, only the clips with the exact same name are synchronized.

A partial match extends to matching characters in the clip or Reel name. Example: A video clip with the name 
“Clip” and an audio clip with the name “ClipABC” can be synchronized because the first four characters are the 
same. If – for example, in the Logging Tool – you insert a dot (.) in the clip name, the search for matches is 
applied only as far as this dot.

4 :  S y n c h r o n i z e

Once you have selected synchronous points and conditions, start ClipSync for all the clips in the list or for the 
selected clips.

� The lower box then contains a list of the synchronized clips in a display similar to that of the Media tab: 
The synchronized clips are shown first and their components are listed below them and indented. If it 
can be determined, the timecode shift is specified.

� Double-click the synchronized clips to open the Clip Viewer and quickly look over the results.

� If you finish by clicking OK, the clips produced are stored in the Rack in which you called ClipSync. 
Clicking Cancel discards the results of ClipSync.

Synchronized clips are linked in the sense of the Item Link function ( page 9-80) and can be unlinked (or 
ungrouped) with the Disband Clip function ( page 9-66).
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Automatic Scene Detection (Clip Viewer)

Automatic Scene Detection (found in the extended dialog box of the Clip Viewer) divides a longer clip with diffe-
rent takes (scenes) into a number of shorter clips. 

Automatic Scene Detection operates on the basis of 

� video content  page 8-94

or

� metadata  page 8-96

“Foreign” media data (such as imported clips that were created with a different Codec) is automatically ren-
dered before scene detection. This applies to all source material that cannot be played directly in the Clip 
Viewer.

Automatic Scene Detection in the Clip Viewer
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Scene Detection Based on Video Content

The system analyzes differences in the video content frame by frame. For example, if a shot of an evening can-
dlelight dinner is followed by a daytime market scene under a blue sky, it’s easy to deduce that this is a new 
scene and create a new clip. Other motifs, such as a fast pan, can prove more problematic for the system since 
the content varies wildly from frame to frame. 
For this reason, you are provided with a slider for setting the Sensitivity of the video analysis. Depending on the 
material, you’ll need to experiment a little. It is recommended that you roughly sort through your material 
before starting scene detection based on video content because the same Sensitivity setting may not bring good 
results for all types of material.

S t e p  b y  S t e p :

1 Presort the material: Images of peaceful landscapes and of autoracing require different Sensitivity set-
tings.

2 Open the (first) clip in the Clip Viewer, click the arrow button in the upper right-hand corner of the Clip 
Viewer to open the extended dialog box and select the Scenes tab.
Mark-in and/or mark-out, if set, limit the Scene Detection range.

3 Click the based on video content radio button.

4 For the first run leave Intraframe Sensitivity at default. 

5 Depending on your personal preference, activate Show detection progress (slower). 
Activated: The video continues playing. This however slows down the detection progress a little bit.
Deactivated: Each new scene is indicated by freezing the first frame of the scene in the Clip Viewer until 
the next scene is detected, and so forth. This method works a little faster than the other.

6 Multiframe Scan should be enabled in most cases ( page 8-95).

7 Click Start.

8 The clip in the Clip Viewer is played back. Each time a scene is detected, a green Marker is set on the 
Position Bar. If you notice that scenes are not being detected or non-scenes are being detected, exit and 
correct the Sensitivity for the next run.

To jump from Marker to Marker use the buttons shown here or the C and V keys of the keyboard 
(default assignment). With the ARROW KEYS (LEFT/RIGHT) it is easy to check whether a Marker really 
indicates a scene change. If not, just delete the Marker.
 See also “Clear All Scene Markers” on page 8-95.
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9 Once you’re satisfied with the scene analysis, select one of the Create clips options:
- Consider all clip markers: This option considers even the “normal”, gray Markers as scene starts. Thus 
you can mark a clip manually, and have it sliced in Subclips or Masterclips automatically.
- Subclips (with identical clip-in and clip-out for all created clips)
- Masterclips (each clip has its own clip-in and clip-out)
See also “Subclip or Masterclip?” on page 8-95.

10 Click Create Clips.
Now the new clips are being transferred to the Rack.

If you delete unnecessary Subclips or Masterclips, make sure you do not delete them together with the 
Media File. All the clips created in a single scene detection run refer to the same media file.

I n t r a f r a m e  S e n s i t i v i t y

A high value means a high sensitivity to scene changes, and vice versa. Intraframe detection takes pixel shifts as 
well as changes in the overall color balance of the images into account. 

M u l t i f r a m e  S c a n

This is a filter which suppresses extremely short image events in order to not create unnecessary scenes. The 
best example would be photo flashes that last only one frame. Should be active in most of the cases. 

S u b c l i p  o r  M a s t e r c l i p ?

� All subclips created by the Automatic Scene Detection have identical clip-ins and clip-outs.
Therefore, a subclip can easily be trimmed to the full extension of its media file.

� All master clips created by the Automatic Scene Detection have individual clip-ins and clip-outs.
 Any Handle Length will be added before and after, respectively, the detected scene, thus defining the 
clip-in and the clip-out. The mark-in sits on the green scene marker.
If you want to trim the master clip beyond the limits of its initial clip-in and clip-out, you need to 
expand the clip (see also Expand Clip (To Available Media) on page 8-61).

C l e a r  A l l  S c e n e  M a r k e r s

This deletes all Scene Markers.

In order to delete several scene markers at once, it is useful to call up the Marker List, and the fastest way to do 
so is to click this symbol. On the list, right-click and select from the menu one of the delete options.
If you don’t find the symbol on the tool bar, right-click the tool bar and select Customize. Then drag the symbol 
from the library to the tool bar.
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Scene Detection Based on Metadata

With this variation, the system analyzes the start/stop data (datestamp/timestamp) that DV camcorders write 
to the tape each time recording begins. Important: Not all manufacturers equip their devices with this function. 

If the material does not contain timestamp data, the system automatically falls back on video content 
based detection.

Select the option, click Start and once the scenes have been created by means of Markers in the Position Bar, 
select Create Subclips.

For more information on this type of scene detection, see the Input chapter ( page 6-40).
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Media Management

Media Management in Pinnacle Liquid provides greater clarity and more transparency in the handling of 
Media Files, especially for users working in a networked environment. It facilitates and organizes the exchange 
and shared usage of Media Files and the selection of Media Formats and digitizing drives. Media Files, you may 
remember, contain the digital image and audio information necessary for editing. Clips in a Project and 
Sequence establish the visible and editable relationships to Media Files.

Pinnacle Liquid Media Management monitors all the relevant Media Files in the background and tells you, for 
example, whether and how often the clips connected to a Media File are used in a Sequence and Project. Or if 
you define a new clip in the Logging Tool by means of a Reel name, mark-in point and mark-out point, Media 
Management can immediately establish a relationship to a suitable Media File (if any exists). It also allows you 
to track down Media Files in networked directories, view them and, if necessary, copy or move them to your 
local A/V storage medium.

Basics  page 8-98

The most important information on Media Files

Media Management tab  page 8-111

Managing Media Files in the Project 

Media Management settings  page 8-116

Defining drives and directories

Media Management and object properties  page 8-122

Information and functions

Media Management and the Windows Explorer  page 8-126

Finding and managing Media Files

Search and import Media Files  page 8-126

Deletion of clips/objects and Media Files  page 8-128
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Basics

Certainly it is also possible to work in Pinnacle Liquid without giving much thought to Media Files. To a large 
extent, the software organizes the interactions between clips and Media Files in the background. When Projects 
become more complex and the exchange of data becomes more important, however, you should familiarize 
your self with some of the basics of Media Management. 

Compatibility

Projects and Media Files that were created in Pinnacle Liquid up to and including Version 2.55 are automatically 
adapted for Media Management (Version 4.0 and later).

Metadata

Simply put, a clip is made up of metadata.
Metadata such as a mark-in, clip-out or Reel name serves as references to specific A/V material (Media Files) 
that should be played, for example, when a clip is loaded in the Clip Viewer. Media Management needs some of 
this metadata in order to find the correct Media File. (See also “Matching Clips to Media Files” on page 8-110.)

Media Types

Pinnacle Liquid Media Management distinguishes between two types of Media File:

� Streamed media - 
Media Files with “real” (i.e. timecode-based) clip-ins and clip-outs, such as video and audio data 
streams and animations.

� Still media - 
Media Files without a “real” timecode clip-in/clip-out, such as graphics inserts and title clips, which can 
be changed to any length by repeating the same single image.
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Identifying a Media File

What makes a file a Media File from the point of view of Media Management?

� Still Media File
This type of Media File is sufficiently defined by a Reel name and the name assigned when the file was 
created.

The following metadata identifies a Streamed Media File: 

� Reel name -
The name of the Reel must be specified for logging and digitizing ( page 6-12). An unmistakable and 
unique Reel name is especially important in a network environment.

If you are wondering what a “unique” Reel name is and how to come up with one as easily as possible, 
here is a suggestion: Use the day’s date in the Reel name:
For example, Reel01 12-09-02 (or a four-digit year to avoid the next millennium bug).
If you digitize live, you are certain to have a unique name if you combine a realtime TC (24-hour for-
mat!) and the day’s date. In a network, you can achieve further clarity by appending the editor’s initials. 
For example, Reel07 12-09-02 CPR. 

� Clip-in -
Timecode of the first frame in a clip. 
Unlike the mark-in, which can be moved around within the clip, the clip-in cannot be changed. A 
Media File with a different clip-in (where all the other metadata is the same) is a different Media File.

� Clip-out - 
Timecode of the last frame in a clip. 
Unlike the mark-out, which can be moved around within the clip, the clip-out cannot be changed. A 
Media File with a different clip-out (where all the other metadata is the same) is a different Media File.

� Stream type (video, audio, still) and a stream ID (see the section on naming Media Files,  page 8-100).

With this information, Media Management can assign clips and Media Files to one another. The “matchback” 
functionality searches all the specified directories. If a Media File is found that matches a clip, the clip can be 
played (see also Matching Clips to Media Files on page 8-110).
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Naming of Media Files by Pinnacle Liquid (Streamed media)

Up to and including Version 5.6x

Media Management names new and imported Streamed Media Files ( page 8-98) as well as imported anima-
tions on the basis of the timecode data. For example:

15030512N 15040613N V0.yuv

� The first number is the timecode of the clip-in (hhmmssff).

� Timecode system: N stands for Non Drop NTSC and D for Drop Frame NTSC, P for PAL.

� The second number is the timecode of the clip-out.

� Stream type: V stands for video and A for audio.

� Stream ID: 0 to 3; differentiates among streams of the same type; for example: A0 = 1st Audio Source 
Track, A2 = 3rd Audio Source Track of the clip. 

� The file name extension indicates the File Format (in this case: YUV, i.e. Media Format Uncompressed).

From and including Version 6.0

The integration of HDTV also affects Media Management. There are many more timecode variants, quality 
ranks, resolutions and frame rates than in the straightforward PAL/NTSC world. If you’re interested in the spe-
cifics, here is a list of all the designators.
A media file generated in Pinnacle Liquid can, for example, look like this:

../Reels/MyTestReel.@c3.P CF450037 / 01231412P 01301702P V0. @rP4. @iDIF. MXF 

� MyTestReel -
This is the Reel name that was entered in the Logging Tool.

� @c3 (camera) -
This designates the camera setting (required for multi-camera editing). Default is @c0.

� P (Reel timecode system) - 
- P, N, D (PAL, NTSC, NTSC Drop Frame)
- F (24p)
- HF (23.98 Non-Drop Frame)
- HG (23.98 Drop Frame)
- HP (HD-PAL 50 Hz)
- HN (HD-NTSC 59.94 Hz)
- HD (HD-NTSC DF 59.94 Hz)
- LP (Proxy PAL 12.5 Hz)
- LN (Proxy NTSC 15 Hz)
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- LF (Proxy Film 12 Hz)
- H3 (HD 30 Hz)
- H6 (HD 60 Hz)

� CF450037 (project ID) -
The system assigns this number for the purpose of assigning Reels and Projects.

All entries up to this point are part of the directory path name. All clips in the same directory have the same 
path because they come from the same Reel. The clip names are formed from the following elements:

� 01231412 P 01301702 P (clip’s timecode area) -
This example means: Clip-in = 01:23:14:12, clip-out = 01:30:17:02; PAL timecode
- P, N, D (PAL, NTSC, NTSC Drop Frame)
- F (24p)
- HF (23.98 Non-Drop Frame)
- HG (23.98 Drop Frame) 
- HP (HD-PAL 50 Hz)
- HN (HD-NTSC 59.94 Hz)
- HD (HD-NTSC Drop Frame 59.94)
- LP (Proxy PAL 12.5 Hz)
- LN (Proxy NTSC 15 Hz)
- LF (Proxy Film 12 Hz) 
- H3 (HD 30 Hz)
- H6 (HD 60 Hz)

� V (media type) -
Either V for video or A for audio.

� 0 (media stream) -
Video stream = 0; audio streams from 0 (channel A1) to 3 (channel A4).

� @rP4 (quality and resolution) -
Information on quality and resolution; not specified for all formats.

� @iDIF (internal media format) -
For AVI and MXF, indicates what is “inside”: In the example, DV-DIF in an MXF wrapper.

� MXF (file format) -
One of the file formats supported by Pinnacle Liquid; however, depends on the particular product. For 
example, *.avi, *.2yuv, *.dif, *m2v, etc. 
See “System Formats and Codecs in Pinnacle Liquid”  on page 8-102.
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System Formats and Codecs in Pinnacle Liquid

This section provides information about the system formats and codecs availbale in Pinnacle Liquid.

S y s t e m  F o r m a t s

Analog and digital video and audio material can be recorded, stored, edited and transmitted in many “for-
mats”. The term “format” has no very precise definition and is confusing because of the many ways in which it 
is used. The “formats” that you work with as a Pinnacle Liquid user primarily depend on your editing system. 

File Formats

File Formats can be identified by the file name extension on the Media Files. But the extension not always gives 
away the actual content of the file. If, for example, the file extension is *.avi, the file actually may contain DV or 
MPEG essence data - two different video media formats. In contrast, “examplefile.2vuy” is a pure video media 
file, and the extension clearly indicates that fact.
Some file formats, such as AVI and MXF are so called “wrapper formats”. You can put video and audio files 
inside an AVI wrapped filed when you, e.g., fuse a Sequence.
Pinnacle Liquid uses the following video File Formats

� 2vuy, yuv (uncompressed YUV video) 

� m2v (compressed MPEG-2 video) 

� mxf (standard video and audio file exchange format plus metadata; can handle a variety of essence data 
including MPEG video; see  page 7-16)

� avi (popular particular in DV video; “wrapper format” for various essence data types including MPEG-
2 and audio formats)

� dif (used mainly for DV video)

For all the products, wav is used as the audio File Format.

Media Formats and Codecs 

Pinnacle Liquid knows three “families” of video Media Formats: the uncompressed (YUV), the DV variants, 
and the MPEG-2 variants (availability depending on product version).

Media Formats are subsets of File Formats, i.e. two Media Files can have the same extensions (e.g. *.mxf or *.avi) 
but still be different because their Media Format is not the same. Not the same, because the codecs are different. 
More about codecs on  page 8-106

Pinnacle Liquid uses the following Media Formats:
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Uncompressed (YUV) 

� File formats *.2vuy, *.yuv: 
 full YUV resolution, no transcoding, difference only in file extension.
HD formats available.

MPEG-2 variants 

� MPEG2 I 422P@ML -
MPEG I-Frame only, variable compression at 5, 10, 25, 33 or 50 MBit/sec
File formats *.m2v, *.mxf; *.avi
Vertical resolution Normal (480/576) or Extended (512/608) (PAL/NTSC)
HD formats available

� MPEG2 422P@ML IMX -
direct compatible to Sony IMX; with Extended Resolution (512/608) and 50 MBit/sec fixed
File formats *.m2v, *.mxf, *.avi

� MPEG2 MP@HL -
IPB-MPEG, used in HD formats and in export to DVD
several options, see IPB Settings
File formats *.m2v, *.mxf

� MSS -
direct compatible to Pinnacle MediaStreamServer
File format *.mxf (MPEG essence data as IPB, IMX or 
Standard-422P@ML at 50 MBit/sec)

DV variants

�  DV -
File formats *.avi, *.dif; 25 Mbit/sec 

�  DVCPro 25 -
File formats *.avi, *.dif; 25 Mbit/sec 

�  DVCPro 50 -
File formats *.dif,.avi; 50 Mbit/sec 

Audio

� PCM 16 bit, 48 kHz (all products)
file format *.wav
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Render formats

When rendering effects, Pinnacle Liquid generates files of a specific format. This format is defined in the Time-
line Properties dialog or when you create a new Sequence. The selected Render/Fuse format is then valid for all 
render files generated from that Sequence. It is also the format of choice when you use the Fuse function to cre-
ate video files from a Sequence.

A list of available Render/Fuse formats can be found on page 8-106.

C o d e c s

The term codec is a combination of the words coder and decoder. A codec is used to convert data (analog or 
digital) to a specific format, or, when decoding, to extract the original data from the encoded status.

Pinnacle Liquid employs codecs to create media data (files):

� when capturing (Digitize),

� during the Fuse process,

� when rendering, 

� and of course to read out all these files and display their content as visible images and audible sounds.

A codec is a mathematical algorithm. In some cases one has to pay license fees to use a codec, e.g. for certain 
surround sound applications. Where no codec is necessary, we talk about Native Transfer: Capture from DV 
tape via the IEEE 1394 interface is a straight file copy operation without any coding or decoding involved. How-
ever, when you input an analog signal, you can choose from several different codecs, because the analog signal 
needs to be converted to a digital file that you can keep on your hard disk.

In digital editing, the codec (DV, MPEG, etc.) is commonly associated with a file format. This has led to certain 
conventions: a DV codec usually writes and reads AVI files (audio-video interleaved). The MPEG I 422P@ML 
codec in Pinnacle Liquid is traditionally linked to the file format *.m2v. However, these associations an be 
modified.

Define codec presets  page 8-104

Overview: All available codecs within the Pinnacle Liquid family of products  page 8-106

Define Codec Presets 

You can create your own Codec Presets, that is, combinations of codecs and file formats. With some codecs there 
are further parameters to determine, e.g. compression rates (MPEG2 I-frame only). 

(If you plan to stick with native DV input and output you can just skip the next pages.)

CAUTION: When you create and use individually defined Codec Presets you’re always risking to operate 
outside commonly accepted conventions and standards. File exchange could become difficult or even 
impossible because of incompatible formats.
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Open the Codec Presets dialog: Edit > Control Panel > Site.

Codec Presets

The list on top contains all presets currently known to Pinnacle Liquid (to find out which presets you can use 
with your product, see page 8-106).

To define your own Codec Presets please follow these steps:

1 Select one preset that is similar to what you are planning to create, e.g. MPEG2 MP@HL (M2V). 

2 Then click the double plus sign to the right of the list. 

3 You may change the default name “New Preset (1)”. Then click the small checkmark.

4 Now you specify the Codec and the File Format. (This depends on the selected base Preset. In our exam-
ple you would be taken to the IPB Settings dialog. If it were a DV codec you’d have nothing to edit here.)

5 Click the checkmark (OK) to save the new Preset.

The newly created Codec Preset now appears in the list of Media Formats in the Logging Tool, in Timeline Proper-
ties and in the New Sequence dialog.

Presets marked with an asterisk (*) cannot be deleted from the list; only those created by a user can be deleted. 
Select one and click the Trashcan symbol. The other symbol lets you rename the Codec Preset.

Add new Preset

Rename Preset

Delete Preset
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MPEG I-Frame Codec Options 

Here you define the Bitrate (compression) and vertical resolution (Height; when Profile Constraints is set to 
None). When IMX is selected as a profile, Bitrate and Height cannot be modified. 
The Extended 512/608 Height setting is needed only in some special cases.

Special options (MPEG-I 422P@ML)

Available Codecs Within the Pinnacle Liquid Family of Products

Liquid Edition  (incl. Pro)

� Capture (native) -
DV [avi], DV [dif], DVCPro 25 [avi/dif],  MPEG2 IPB, HD MPEG (HDV)

� Capture (via Encoder) -
DV [avi], DV [dif], DVCPro 25 [avi/dif],  MPEG2 IPB, Uncompressed

� Realtime playback (Timeline) -
DV [avi], DV [dif], DVCPro 25/50, MPEG 2 IPB, MPEG 2 I-Frame, MPEG 2 IMX, HD MPEG I-Frame, 
HD MPEG IPB, Uncompressed, HD Uncompressed

� Render - 
DV [avi], DV [dif],DVCPro 25/50, MPEG 2 I-Frame, MPEG 2 IMX (opt.), Uncompressed, HD 
Uncompressed

� Fuse -
DV [avi], DV [dif], DVCPro 25/50, MPEG 2 IPB, MPEG 2 IMX (opt.), HD MPEG I-Frame, HD MPEG 
IPB, Uncompressed, HD Uncompressed
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Liquid blue

� Capture (native) -
DV [avi], DV [dif],  DVCPro 25 [avi/dif], MPEG2 I-Frame, MPEG 2 IMX, DVC Pro 50

� Capture (via encoder) -
DV [avi], DV [dif], DVCPro 25 [avi/dif], MPEG 2 IPB, MPEG 2 I-Frame, MPEG 2 IMX, DVC Pro 50, 
Uncompressed

� Realtime playback (Timeline) -
DV [avi], DV [dif], DVCPro 25/50, MPEG 2 IPB, MPEG 2 I-Frame, MPEG 2 IMX, DVC Pro 50, 
Uncompressed

� Render - 
DV [avi], DV [dif], DVCPro 25/50, MPEG 2 I-Frame, MPEG 2 IMX (opt.), Uncompressed, DVC Pro 50

� Fuse -
DV [avi], DV [dif], DVCPro 25/50, MPEG 2 IPB, MPEG 2 IMX (opt.), MPEG I-Frame, Uncompressed, 
DVC Pro 50

Identical Media Files

Initially, Media Management handles Media Files in different Media Formats (I-MPEG, DV, Uncompressed, 
PCM, etc.) that are otherwise identical (same Reel, same clip-in/clip-out) as one clip that exists in two or three 
Media Formats (Clip-based View). Probably the most common example of this involves video Media Files with 
synchronous audio Media Files (e.g. VA1A2)
Another criterion is the creation time: When two or more identical files exist, Media Management focuses on 
the most recent. See also “Matching Clips to Media Files” on page 8-110.
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Project Media Directories: Where Are the Files Stored?

The current Pinnacle Liquid Project works with three different types of Media Directories that are created as a 
function of the Media File type and the system requirements (in the example below, written in italics; also see 
“Media Types”  on page 8-98).
A typical path, i.e. the “road” Pinnacle Liquid follows from the clip to a corresponding Media File, might be as 
follows:

R:/.../Reels/Tape01.NA50500B2/01200505N 01210012N V2.m2v

� “R:/” refers to the volume, such as a local RAID or a storage medium connected via the network.

� “/.../” stands for additional directory levels. You can define these levels in the Media Management Set-
tings ( page 8-116).

� For Media Management, “Reels” means: This is where Project Reels containing Media Files can be 
found.

� “Tape01” is the name of a Reel that was assigned (in this example) during logging.
Appended to this entry is the ID of the Project in which logging was performed. The ID is generated 
automatically. N stands for NDF NTSC and must match the clip ID.

� “01200505N 01210012N V2.m2v” is the name assigned to the Media File by Media Management: For an 
explanation of how this is done, see “Naming of Media Files by Pinnacle Liquid (Streamed media)”  on 
page 8-100.

To view the path information, select File-Based View (see the Media tab in the Project window, 
 page 8-112).

Each Media Directory also contains information on the Project in which the Media Files were created. 
Media Management uses this information to indicate the origin of media data on the Media tab (where 
Reels are arranged by Project;  page 8-111).

S t r e a m e d  m e d i a

Streamed Media Files are stored as described below; the words in the directory path written in italics are gener-
ated by Pinnacle Liquid:

� For digitized media (Logging Tool, Batch Digitize):
“DriveLetter:/DirectoryName/Reels/ReelName.ProjectID/MediaFileName”, where the “MediaFile-
Name” conforms to the convention described above ( page 8-100).
Media Management assigns these files to the Reel name allocated for logging/digitizing (“Selecting/
Creating a Reel (E)”  on page 6-12).
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� For imported Media Files: 
“DriveLetter:/DirectoryName/Reels/@ImportProjectID.PProjectID/MediaFileName”, where the “Medi-
aFileName” conforms to the convention described above ( page 8-100).
This applies to files imported by means of a Copy/Move operation. See also “Importing Media Clips” on 
page 6-49. 
Media Management assigns these files to a Reel with the name Imported Files. 

� For linked files: 
“DriveLetter:/DirectoryName/MediaFileName”.
These files are identified in Media Management as linked objects; the file icon has a small arrow (see 
also Object Icons (Detail View) on page 8-36).
These files retain their name (such as Example.tif).

S t i l l  M e d i a

� Stills (i.e. images, titles, backgrounds, etc.):
“DriveLetter:/DirectoryName/@ImportedStills.ProjectID/FileName”.
Media Management assigns these files to a Reel with the name Image.

Here the Project ID ensures that identical names can be used in different Projects.

W h e r e  D o e s  M e d i a  M a n a g e m e n t  L o o k  f o r  M e d i a  F i l e s ?

The “magic word” is “Reels”. In any directory tree, Media Management ignores everything above the “Reels” 
directory and searches for Media Files below it (i.e. in the subordinate directory levels). Such files must be con-
tained in these directories and comply with the naming conventions described above, for example 
Reel02.P91CE0342.

Media Management does not detect Media Files outside this directory structure or files that do not follow Pin-
nacle Liquid naming conventions.
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Matching Clips to Media Files

In order to be able to play a clip, at least one Media File, or part of, must be found that matches the clip’s meta-
data. This matching operation works as follows:

1 On the basis of the clip’s metadata, Media Management first searches the associated Reel directory to 
find a Media File range that matches the clip’s mark-in/mark-out range.

2 The first range found is preselected. 

3 Next Media Management searches the other files in the directory. If the Quality Rank criteria and/or the 
creation date (most recent file) result in a better match, the Media File thus identified is played; other-
wise the preselected file is played.

In other words, there is no fixed assignment of clip to Media File in the sense that exactly one Media File is asso-
ciated with the clip.
For A/V grouped clips, matching is also extended to the associated audio files.
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Media Tab in the Project Window

The Media tab in the Project window provides access to the Media Files of the current Project and to all Media 
Files that can be accessed by Media Management (see also Media Volumes (Directories) on page 8-117).

� The left-hand area of the window contains a hierarchical tree (arranged by Streamed media and Still 
media on a Project- and Reel-specific basis); the area on the right contains the Media Files. 

� The current Pinnacle Liquid Project is in the top position. Any other Projects that Media Management 
was able to find when scanning the registered Media Directories are initially displayed as closed folders.

� When the Projects are opened (by double-clicking), the next sorting level, the Reel level, is displayed. 
When you click a Reel name, only the Media Files for this particular Reel are displayed in the right-hand 
area of the window. 

� Double-click the Media Files in the right-hand field to load them in the Clip Viewer and (if necessary 
and depending on network capacity) play them back - and even to send them directly to your Timeline.

Media Management scans all available media directories whenever you click the Media tab (refresh 
function). To induce a refresh while working in the Media tab, click one of the other tabs and come back 
to the Media tab. If you want to refresh while working on the Media tab, select Refresh View or Rescan 
Directories from the Media tab shortcut menu ( page 8-114)

 

Media tab
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Media Files: Views and List Headings

The Media Files can be displayed as Picons and in the form of a list. You can sort each column (in the Detail 
(List) View) and generally edit the list. (See also “Objects in the Project” on page 8-31.)

Right-click a free space in the right-hand area of the window or click the button at the top of the Project window 
to display the shortcut menu for the Media tab. Select Detail View followed by one of the following options:

� File based - 
This view displays all the file-specific information such as the directory path, video bitrates (compres-
sion), audio bit rates, etc.
Each individual Media File gets one entry (one line). The object icon is displayed on the left.
This view is recommended for identical files or for video with synchronous audio because it allows you 
to access the individual Media Files directly (see also Identical Media Files on page 8-107). 

� Clip based -
This view combines several identical Media Files in a single clip. 
Example: A video clip with two Audio Source Tracks (VA1A2) gets only one list entry.

� Mixed - 
This option combines the two views mentioned above. The first line contains the clip information with 
the associated file-based information listed below it.

For a description of additional menu functions, see “Edit View”  on page 8-32.

List Headings

The list headings (the individual columns) are basically identical to those offered on the Clips tab. 
However, note the following differences:

� Name -
An optional name for the Media File corresponding to the name with which the file was digitized (not to 
be confused with the system name, which is specified in the File column).

� Tags -
The number specified in this column indicates the number of clips in the current Project or in the 
Sequence on the Timeline that are referenced to this Media File. 
0 means: This file is not used by any clip(s) ( page 8-114).

Tags are not updated automatically. Reset and start a new count for fresh results. For a correct count of 
used media be sure to choose the Clip Based viewing mode 
( page 8-112).
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� Project - 
Name or ID of the Project in which the Media File was created.

� Audio Rate - 
Sampling rate for audio Media Files. 

� Audio Bits - 
Bit rate for audio Media Files.

� Video Aspect - 
Aspect ratio (4:3, 16:9).

� Path -
Directory path for the Media File ( page 8-108).

� File -
Name of the Media File (system name,  page 8-100).

� Location - 
Freely assignable name for the volume (storage medium/location) where the file is stored, such as an 
abbreviation (see also Editing Media Directories on page 8-118).

� Link - 
If this column contains an “x”, the Media File was not stored in a Project Media Directory but a link to 
this file does exist. (See also “Copying/Moving Files and Creating Shortcuts” on page 6-50.)

� Local -
An “x” in this column means that the media file is located on a local drive (not in the network).

� Quality -
This column indicates the quality rank of the media file that the user assigned for the capture. Normally 
(i.e. if nothing was changed), it is set to “16 (Normal)”; otherwise, it contains a number from 1 to 31. 
See also “Quality Ranks” on page 5-16.

In each column, the entries can be sorted.  page 8-38
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Media Files: Functions

Open the shortcut menu by right-clicking on the Media tab in the Project window or clicking the tool button. 

� Open -
This function loads the Media File in the Clip Viewer. If the data rate is sufficiently high, Media Files can 
easily be played via a network connection as well. 
Direct editing is not possible; if you wish to do so, create a clip from the Media File (see below).

� Properties -
This function opens the Object Properties dialog box ( page 8-66).

� Create clip(s) from Media File(s) -
This function generates one clip for each Media File selected. The clips are stored in an automatically 
generated Rack with the name Media Clips and can be edited for use in the Project and Sequence.

� Create Clips and copy selected media to capture volume -
This is the method used for saving clips to a local disk from the network (or for copying them from one 
local directory to another local directory, or from one network directory to another network directory). 
The associated clips are also added to the current Project.
Important: “Capture volume” refers to the primary, current directory (see “Media Volumes (Directo-
ries)”  on page 8-117).

� Copy selected media to capture volume -
Same as above, but does not generate a clip in the Project.

� Delete selected Media Files -
This function deletes the selected Media File(s) without asking you to confirm the deletion. 

This deletion if final! Before deleting the file, make sure it is not being used by any other user.

� Tag used media - 
of current Sequence
of current Project
This function counts the number of times a Media File is used by clips in a Project and/or on the Time-
line, regardless of whether all or only part of the file is used.
Activate this option to begin counting.
Media Management counts the clips: 0 (zero) means: The Media File is not used by any clip. This option 
also helps you identify superfluous data and delete it if desired.
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Tags are not updated automatically. Reset and start a new count for fresh results.
Also, for a correct count of used media be sure to choose the Clip based viewing mode ( page 8-112).

� Reset -
This function resets the values under Tag used media to zero (for example, to restart counting).

� Check Links -
This function checks whether the link(s) to the Media File(s) are correct and indicates any lost links.

� Refresh View - 
This function updates the list displayed. However, files that were not created by Pinnacle Liquid in the 
network are not included.

� Rescan Directories - 
This function also applies to files that were created by other systems or were moved to the media direc-
tories by means of the Windows Explorer.
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Media Management Settings

To view the options and default settings for Media Management, select Edit > Control 
Panel > Site > Media Management Settings. Among other things, these settings are impor-
tant for the Logging Tool because they allow you to define the directories for digitize and 
save operations. 
The Media Management settings are not user-specific; they apply to the particular sys-
tem.

Media Management Settings
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Video Tab/Audio Tab

� Separate volumes for video and audio -
Activate this option if you wish to save video and audio media files in separate directories. If only one 
tab is displayed (Video/Audio combined) a separate destination volume for audio has not been specified 
in the Logging Tool ( page 6-19). 
It is normally recommended that video be saved with its audio data.

� Show clip names on media tab (takes longer) -
Activate this option to display the individual clip names (as opposed to the names that were assigned by 
Media Management) when you open the Media tab. It then takes slightly longer to generate the list.
To reduce network traffic you can set up a local drive cache for all clip name files. Clip names stay in this 
cache for 20 days beore they are deleted.

M e d i a  Vo l u m e s  ( D i r e c t o r i e s )

This list applies to several modules and functions in Pinnacle Liquid:

� For Media Management:
Media Management searches the drives and directories listed here for Media Files that can be used by 
Pinnacle Liquid.

� For the Logging Tool and Batch Digitize: 
Any data resulting from digitizing is saved to the volumes (drives and directories) specified here.
If more than one volume is specified, the Primary Volume can be marked with an asterisk (*). 
If Switch to next available volume... is activated for the digitizing drives (“Disk Full State / Change 
Volume”  on page 6-34), digitizing continues on the next available volume(s) following the Primary 
Drive in the list or, if the end of the list has been reached, on the first drive at the top of the list (Batch 
Digitize feature only). 

� For media-clip import/ALE import/Consolidate:
The Media Files of imported objects are saved to the specified volume (and possibly in specific subdi-
rectories, depending on their type,  page 8-108). The same applies to ALE media files. 

For capturing (digitizing) purposes, please use NTFS partitioned hard disk drives exclusively. FAT32 
may cause problems with longer clips.
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E d i t i n g  M e d i a  D i r e c t o r i e s

You can add to and modify the list of volumes, remove any entries not needed and change their order. You can 
also assign the volumes individual names.

� Add - 
This function opens a Windows dialog box in which you can find and select the relevant volume. Click 
OK to add it to the list.
You can also create a new directory (folder). Click the button and enter a location and name for the new 
folder.

� Edit -
This function allows you to edit an existing list entry. Click the entry and then click Edit and follow the 
procedure described under Add.
Or you can right-click the Path column to call the Edit and Add functions from the shortcut menu.

� Remove -
This function deletes an entry from the list (and only from there). Click the entry and then click 
Remove.

� Naming/Alias column - 
Right-click the Alias column to open an editing field. Type in a name and press ENTER to close the field.
This name will be used in the Logging Tool and in the Media window in the Location column (see “List 
Headings”  on page 8-112). 
You can use aliases to replace technical path specifications with names that are easy to remember.

� Primary Volume column -
Right-click the column to define a volume as the current (primary) digitizing volume. The selected 
entry is marked with an X. (See also “Disk Full State / Change Volume” on page 6-34.)

The volume or directory identified by “X” is “primary” in many ways, not only for digitizing but also in 
the case of media import and the Consolidate function. The primary volume can also be a network 
directory.

� Import Drive column -
(Right next to the Primary Volume column) Important in networked systems where the Media Manage-
ment is centrally administered. Add the network file path and put the X in front of that list entry (right-
click). Thus the centralized Media Management can keep track of locally import objects.
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� Access Rights column -
You can assign the Write or Read attribute (right-click to open the shortcut menu) in order to protect 
specific directories.
Important: This does not apply on the operating system level, i.e. it does not prevent accesses by 
another users.
Volumes to which the Read attribute has been assigned are not included in a volume change. Write 
access includes Read access.

� Rearrange - 
You can move the entries using the two arrows to the right of the list box. Click an entry and then click 
one of the arrows until the entry is in the desired position. 

If you wish to create a new directory, select File > New > Folder in the Windows Explorer (refer to the 
Windows manual).

W h a t  H a p p e n s  W h e n  Yo u  C r e a t e  a  N e w  M e d i a  
D i r e c t o r y ?

When you click Add to create a new media directory, the following occurs (based on an example):

1 You want to create the directory “NewVolume” on drive Q: Click Add, go to Q: and enter the name.

2 Q:\NewVolume now appears in the list of directories. A directory of the same name is created on the 
hard disk and:

3 Media Management automatically creates two subdirectories: Reels and a directory that identifies your 
computer in the network.
Media files are stored in subdirectories of the Reels directory ( page 8-108).
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Format Ranking Tab

You need this list if you have identical clips (video or audio) in different file formats. In earlier versions of Pin-
nacle Liquid, you were able to specify a preferred file format for playback - but no more than one. The variety of 
formats is now greater, however, and it could happen that Media Management will need information on how 
you wish to rank the different media types. This is of particular importance in a networked environment where, 
for example, “online” and “offline” files are handled, or where many users share common files. For a single seat 
setup this function has practically no relevance.

Select the pertinent formats and use the arrow keys to arrange them in the proper order.

 

Format Ranking
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Importing Media Clips

When importing media clips to a Project, you can create copies of the relevant Media Files in the relevant Project 
Media Directory or move files to this directory (see “Media Volumes (Directories)”  on page 8-117 and “Project 
Media Directories: Where Are the Files Stored?”  on page 8-108).
For more information, see “Importing Media Clips”  on page 6-49.

You can also bypass the import operation as described. If you have found a Media File in a specific 
directory, you can generate a clip for this file in your Project using the Create clip(s) from Media File(s) 
function ( page 8-114). In this case, however, the Media File is not copied or moved to one of your Pro-
ject Media Directories.
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Media Management and Object Properties

The Object Properties window provides information on the object and to a lesser extent, on functions, depend-
ing on the object type.
You can call the Properties dialog box from the shortcut menu of any object. The elements on the dialog box’s 
General tab are the same for all objects (see also General Elements of the Object Properties Box on page 8-68). 
The V and A1...A4 tabs are described below.

Tab: V

The upper area of this box lists the information that Media Management was able to find for this object; the 
lower area contains options that the user can set (depending on the object type).

V-Tab with video relevant information
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� Quality rank -
Indicates the “quality level” assigned for capture, which is normally the default value 16 (normal). Can 
be used to associate another set of media files with the current clip. See the appropriate section in chap-
ter “High Definition”.

� Media File Name -
Name under which the system saved a Media File on the hard disk (see also Naming of Media Files by 
Pinnacle Liquid (Streamed media) on page 8-100). In the case of images, the file name is displayed that 
was assigned when they were created.

� Media Location -
Path and directory where the Media File is located. See also “Project Media Directories: Where Are the 
Files Stored?” on page 8-108.

� Media Size -
Size of the Media File in kilobytes, megabytes or gigabytes.

� File Format -
The Media File Format, such as YUV or 2VUY for Uncompressed, M2V for I-MPEG or TGA for a Targa 
graphics file. Also see “System Formats and Codecs in Pinnacle Liquid”  on page 8-102.

� (Codec) Media Format -
Specifies the Media Format that was used for digitizing or when a graphics file was created. Also see 
“System Formats and Codecs in Pinnacle Liquid”  on page 8-102.

� NDQ Level (Bit rate) -
Specifies the data throughput rate (with I-MPEG2, also indicates the compression level).

� Aspect Ratio -
The original aspect ratio of the video image (4:3 or 16:9).

� Original Image Size -
For graphics: dimension (height x width in pixels) and bit depth of the source file.

� PixelFormat -
Specifies the aspect ratio of the video pixels. 

� Content is interlaced -
Specifies whether the clip was created by means of interlacing. Graphics files are not generally inter-
laced, nor are some HD formats.

� Alpha -
Yes means the clip has its own alpha channel.

� Quality rank -
Indicates the quality level assigned when the clip was created (see  page 5-16).
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O p t i o n s :
Depending on the object type, these options and list boxes are either available for selection or not (grayed). 
� Interlacing

In this list box, you can define the sequence of fields. It applies to images produced by means of interlac-
ing, i.e. that comprise a sequence of even and odd lines.
Some graphics programs convert the default sequence, which can cause the images to flicker.
You may be able to prevent this effect by changing the field sequence.

The playback field order of an animations can be changed via the Interlacing selection. Choose either 
Top Field First or Bottom Field First. Please access the properties from the Project, not from the object’s 
Timeline shortcut menu.

The question of whether or not to use interlaced mode generally applies to graphics grabbed from a 
television picture, which consists of two interlaced frames. In some cases, the still may flicker if the two 
frames are significantly different. This is particularly true if there is a great deal of movement in the pic-
ture. In this case, it is useful to grab only the even or odd lines of a picture and fill in the missing lines 
through interpolation.

� Use image alpha -
Deactivate this option if you do not want to use a graphic’s alpha channel (in, for example TGA files the 
alpha channel contains information on the graphic’s transparency). Pinnacle Liquid recognizes whether 
a graphic contains an alpha channel or not. If not, this option is inactive.

� Scaling -
Using the scaling options, you can change and adapt clips that were generated with a format other than 
the one currently set for the Timeline. However, you can also leave them as they are.
In order to give you as much freedom as possible for adapting the clips, you can select from among 
seven options. X indicates the image width and Y the image height.

� Pixel Aspect
Square, PAL/NTSC CCIR 4:3 or CCIR 16:9 instruct Pinnacle Liquid to handle the pixels according to the 
TV format selected for the system.
Note: This does not affect the pixel format.
If you selected the Auto option under Control Panel > User > Image Import > Defaults, Pinnacle Liquid 
attempts to recognize the existing pixel format automatically.
If the import operation results in unwanted distortions/aspect ratios, you can define the correct pixel 
format here. CCIR PAL/NTSC refer to the 4:3 aspect ratio.

PAL format can vary (768x576 or 720x576) depending on pixel shape. As mentioned above, most 
graphics programs generate square pixels. Positioned side by side, 768 of them make up the full width of 
the video format. For television images, only 720 pixels are necessary since the pixels are somewhat 
wider than they are high (i.e. rectangular). As a result, 768 square pixels = 720 PAL pixels. This means a 
picture with 768x576 pixels created with a graphics program completely fills out the PAL television for-
mat (assuming the pixels are square). The values for NTSC are: CCIR NTSC = 720x486; NTSC (square 
pixels) = 640x486.
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Tab: A1 (A2, A3, A4)

Similar to Tab V, plus audio specifics:

� Samples/s
Specify the sampling rate here. Internally Pinnacle Liquid works with 48 kHz.

� Bits/Samples
The bit rate of the audio file. 
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Media Management and the Windows Explorer

You can also find the file names generated by Media Management in the Windows Explorer. Media Files are 
easy to identify by the timecode information and the directory containing the Reel name.
For most Media Files a file exists with the same name containing metadata for this Media File. 

Search and Import Media Files (Search Media) 

This tool locates and imports Media Files to your Project. You can specify several search criteria and import 
options. For each media file imported, be it video, audio, graphic or a title, a clip will be added to the Project.

Search Media can be found in � Menu bar > File > Import. 

Search (and import) Media
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1: Define Search Criteria

What are you looking for? Video, audio, images? Certain file names or parts of file names? Select the options. 
The list displays all selected file extensions. 
Where do you want the tool to search? Select a drive or folder. To speed up the search, you may also exclude cer-
tain folders.

Using the Ignore paths function, you can select specific directories and exclude them from the search. 
To do so, click Edit and either enter a path name (e.g. C:\Programs) or use the navigation function. Click Add to 
add the selected path to the list of exclusions.

2: Start/Stop the Search

Click the Search button. The Result of Search area lists all files found. You can stop the operation as soon as the 
wanted file(s) show(s) up.

3: Select Files for Import

You may now move all located files to the Import list or select individual files (use CTRL-click or SHIFT-click). 
Click the Arrow Down symbol to transfer all selected items. The Arrow Up symbol shifts selected files back to 
the Results list.
The Results area is cleared every time a new search is started, the Import list area is cleared only after all files 
have been imported.

4: Select Import Method

Copy, Move files or create a Link? Copy and Move transfer the files to the current Primary Media Volume. 
Caution: Moved files are no longer at their original locations. A linked file stays where it is.

5: Import

Finally, click Import. In your Project a Rack Folder named Search Media Import and containing the Racks 
“Video”, “Audio” and “Images” will be created. There you can find the clips that correspond to all imported 
Media Files.
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Deleting Clips/Objects and Media Files

Delete clips/objects  page 8-128

Delete Media Files  page 8-130

Delete render files  page 8-131

Restore deleted objects, Media Files and render files  page 8-132

Clean up Project  page 8-133

Deleting Clips/Objects

To remove one or more objects (clips, Sequences, effects, etc.) from your Project, you can select from among 
four different options:

� Delete (shortcut menu option):
Select one or more objects, open the shortcut menu and select Delete.

� Trash button (Project tool bar):
Select one or more objects and click the button located in the Project toolbar.

� DEL key (keyboard): 
Select one or more objects and press DEL.

� Drag & drop to desktop Trash icon:
Select one or more objects and drag them to the Pinnacle Liquid desktop Trash icon (not the Windows 
Recycle Bin and not the Project Trash button!).
See also “The Trash” on page 3-20.

In all four cases, the Delete dialog box is displayed and in all four cases the objects are placed in the desktop 
Trash from which they can also be retrieved.
Objects that are deleted from the Timeline are not placed in the Trash.
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The Delete dialog box contains several options for deleting objects or Media Files. Pinnacle Liquid always asks 
you exactly what you want to delete in order to keep you from accidentally deleting an object you still need. 
When you delete Media Files, a second dialog box may be displayed depending on the circumstances 
( page 8-130).

Delete dialog box

The delete options refer to the objects you selected in the Rack. The number of objects selected is specified.

Single-click the appropriate option(s) to activate them:

S e q u e n c e ( s )

This option deletes Sequences from the Rack and removes the Sequence name from the drop-down list box 
above the Master Viewer. It does not affect the Media Files.

C l i p ( s )

This option is applied to clips and, if appropriate, the associated Media Files. You can delete the clip(s), the 
Media File(s) or both:

� Media File(s) of logged clip(s)

� Media File(s) of live captured clip(s)

� Imported Media File(s)

When you delete specific Media Files, you are asked to confirm the deletion ( page 8-130).
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G r a p h i c s  a n d  T i t l e  C l i p ( s )

This option deletes graphics and title clips with/without Media Files. When you delete specific Media Files, you 
are asked to confirm the deletion ( page 8-130).

E f f e c t ( s )

This option deletes clip effects, transitions, audio effects, etc., but not the original effects in the Pinnacle Liquid 
FX Rack.

S h o r t c u t ( s )

This option deletes shortcuts, including those on the desktop.

Deleting Media Files

If you attempt to delete Media Files that are used by other clips, you are asked to confirm the deletion in a sec-
ond dialog box.

Conform Media Delete
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Deleting Render Files

Render files, i.e. files created when effects or Timewarp Editor clips are rendered, can also be deleted selectively.
It may become necessary to delete render files when, for example after a Batch Digitize operation, you want to 
perform a manual re-rendering of effects on the basis of the newly digitized material (also see “Batch Digitize 
and Render Effects”  on page 8-84) or when you delete files you no longer need in order to make room on the 
storage media. The following options are available:

D e l e t i n g  R e n d e r  F i l e s  ( P r o j e c t )

The shortcut menu for the Trash icon on the desktop contains a number of options for deleting render files that 
apply to the current Project. Select 
Delete Render Files Of Project:...

� All -
This option deletes all existing render files in the Project.

� Not used by any Sequence -
This option deletes render files that do not reference any existing Sequences in the Project.

� Not used by current Sequence -
This option deletes all render files except those used in the Sequence currently located on the Timeline.

� Not used by Sequence(s) selected in Project window -
This option deletes all render files except those belonging to the Sequences selected in the Project win-
dow.

D e l e t i n g  R e n d e r  F i l e s  ( T i m e l i n e )

These delete functions are applied to render files belonging to the Sequence currently located on the Timeline. 
In the Timeline shortcut menu, select 

Delete Render Files...

� between Mark-In/Out -
to delete selectively or

� of current Sequence (all) -
to delete all the render files of the Sequence.
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Restoring Deleted Objects, Media Files and Render Files

A number of options are available for retrieving “deleted” objects, files and statuses. Sometimes, however, cer-
tain manipulations are required and sometimes it simply cannot be done. The following is an overview of 
emergency and preventive measures:

O b j e c t  ( C l i p )  D e l e t e d  -  M e d i a  F i l e  F o u n d

A clip can easily be created from a Media File:

1 Identify the Media File on the Media tab in the Project window, for example based on the Reel name, or 
switch to Picon View.

2 Then call the Create clip(s) from Media File(s) function from the Media File shortcut menu.  page 8-114

M e d i a  F i l e  D e l e t e d  -  O b j e c t  ( C l i p )  F o u n d

If the object is a logged object, you can quickly re-digitize it by means of a Batch Digitize operation (provided 
that the original material is still present). See “Batch Digitize (Batch Capture)” on page 8-77.
In the case of imported Media Files, a copy may still exist (for example, in the network). If the file is still located 
in the original storage location, Media Management will find it automatically.

M e d i a  F i l e  a n d  O b j e c t  ( C l i p )  D e l e t e d

In such a case there is little hope. Perhaps you can access the object via a working version you saved at an earlier 
point in time (see also Earlier Versions on page 8-133).

R e n d e r  F i l e  D e l e t e d  -  E f f e c t  F o u n d

This is simple. Pinnacle Liquid re-renders the effect when, for example, the relevant Sequence must be played.

R e n d e r  F i l e  a n d  E f f e c t  D e l e t e d

Standard effects can simply be applied once again at the appropriate positions. Pinnacle Liquid re-renders the 
effect when, for example, the relevant Sequence must be played.
Customized effects must be recreated. It is recommended that you save labor-intensive effects in a Rack. See 
also “Saving Individually Created Effects” on page 10-38.

T r a s h  ( D e s k t o p )

The Trash icon on the Pinnacle Liquid desktop keeps deleted objects. If you have not emptied the Trash in the 
meantime, you can regenerate all the objects it contains. 
Drag or copy the relevant objects to the desired location.
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U n d o  L i s t

Many modules have Undo/Redo functions. By repeatedly clicking this function, it is possible to restore an ear-
lier status. However, you may also lose other work steps.

E a r l i e r  Ve r s i o n s

You can also protect yourself from loss by periodically saving intermediate stages of your work. This is possible 
for Projects ( page 8-6) and Sequences ( page 9-49).

Cleaning up a Project

This function (located in the shortcut menu for the Pinnacle Liquid desktop Trash) deletes some of the periph-
eral Project data which can become quite extensive especially for large and long, edited Projects.
This function does not delete any objects, Sequences or Media Files.

Particularly when working with large Projects, be sure to empty the Pinnacle Liquid desktop Trash icon 
from time to time. This keeps the Project files small.
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This section describes the Pinnacle Liquid function that deals more specifically with the editing of Sequences on 
the Timeline, such as how to insert, trim, delete and move clips on the Timeline. The basics of audio editing are 
also presented. 

Video Editing

� Basics (Timeline layout and customization; priorities; Edit Styles; FX basics)  page 9-3

� Sequence Editor (working with the Source/Master Viewer and the Insert Arrow; Sequence manage-
ment)  page 9-38

� Timeline editing (configuring and trimming a Sequence using drag&drop)  page 9-54

� Objects on the Timeline (marking clips; disbanding clips; Match Frame; clip properties, etc.)  page 9-63

� Trim Editor - provides all the functions for precision trimming  page 9-70

� Special functions (synchronizing Tracks; linking objects)  page 9-78

� Editing - examples and illustrations (Insert Arrow, Timeline, Trim Editor)  page 9-83

Audio in the Timeline

Basic information related to audio and the Timeline  page 9-104

Special functions and Tools

� Consolidate (copying the Media Files used in a Sequence)  page 8-85

� Condense (collecting all clips of a Sequence in a Rack)  page 8-88

� Matte Track and Track Matte  page 9-108

� Nesting Sequences (building a Container)  page 9-112

� Master Viewer: Full-Size Monitor  page 9-117

� Inlay Quality menu  page 9-119

� Snapshot (freeze and save Timeline frame) page 9-120

� Multi-Camera Editing  page 9-121
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Video Editing

Basics

This section provides you with information on the Timeline. The Timeline is the area in which the Sequence is 
compiled.

Timeline layout  page 9-4

Configuring Tracks

Dimensions and information  page 9-13

Track priority 

Higher and lower on the Timeline page 9-21

Source Track Mapping

What belongs where? Important for working with the Sequence Editor  page 9-22

Edit Styles

Overwrite or move objects?  page 9-25

Navigating on the Timeline

Using the mouse, keyboard and tool buttons  page 9-28

Timeline markers and cue markers

Setting markers for and adding comments at important points  page 9-32

Undo/redo

Risk experimenting while editing with undo/redo  page 9-33

ABCs of effects

Most important information on effects  page 9-34
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Timeline Layout

As the basic tool for non-linear editing, the Timeline not only allows you to gain an overview of your editing 
work, it also provides flexible and powerful functions. 

There is no set assignment of clips to Tracks - all video and audio clips, graphics, title clips and transition effects 
can be positioned anywhere on any Timeline Track.

Any changes made to the Timeline have a direct effect on the Sequence, can be played immediately and are con-
tinuously saved (except for effects that have to be rendered). 

Timeline window

T i m e l i n e  D i s p l a y

Click the View Switcher on the taskbar to toggle between different Timeline views 

(see “Desktop Views”  on page 3-14).

SlicesTrack header area Tracks

PlaylineZoom controller Timecode barTimecode display Scroll bars

ClipsToolbar
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T i m e l i n e  E l e m e n t s

This section describes the most important components of the Timeline:

“Empty” Timeline

An “empty” Timeline or positions on the Timeline at which no object (video clip, audio clip, title, etc.) is located 
on a Track, indicate the following:

� @ System’s video output: black (Video Black)

� @ System’s audio output: mute

In other words: You do not have to insert a particular object to generate a result of “black” or “mute” at the par-
ticular output. For example, a fade-out is generated by a dissolve in an “empty” Timeline position.

Timecode Bar

The Timecode Bar displays timecode in various scales ( page 9-6), from single frames to several minutes. 
Mark-in points, mark-out points and markers defined on the Timeline or in the Master Viewer appear on the 
timecode bar. The space between mark-in and mark-out points appear shadowed. 

Changes to Timecode Bar scaling have no effect on the position bar in the Master Viewer and vice versa. 

Playline

The Playline displays the current position on the Timeline (= current position in the Sequence). The Playline 
also defines how certain actions on the Timeline should be carried out. For example, inserts made with the 
Insert Arrow are positioned at the Playline if no mark-in or mark-out points are set on the Timeline. 

The Playline on the Timeline and the Playline on the position bar in the Master Viewer correspond to the same 
position in the Sequence and move simultaneously. 

If the Timecode bar in the Timeline is zoomed in (1 second scale or less), a second line appears. This line speci-
fies which frame is being shown in the Master Viewer (or output). 

When inserting clips with the Source Viewer, this frame will be overwritten by the source’s first frame. If, 
for example, a mark-in is set at this position on the Timeline, this frame will be overwritten with the 
mark-in of the source. 

Scroll Bars

As you zoom in on the Timeline, less of it becomes visible. To see the hidden areas, use the horizontal scroll bar 
at the bottom of the Timeline window to scroll the Timeline display.

When the combined height of all the Tracks exceeds the available display area, a vertical scroll bar appears to the 
right of the Tracks. 
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Zoom Control 

The zoom controller below the Track headers lets you zoom in and out on the Timeline. Move the triangular 
zoom slider to the left to zoom “into the Timeline” and to the right to zoom out. The smallest unit is a frame and 
the largest is a minute (distance between the scale markings.)
Important: This setting does not affect the Zoom Controller in the Master Viewer, nor does that controller affect 
this setting.

Zoom and Timecode Indicator; Setting the Zoom

� You can also change Timeline resolution via the keyboard. Press the ARROW UP key (same as 
Zoom Out, dragging slider to the right) to see an overview of your Sequence. Press the ARROW 
DOWN key to display up to the highest resolution (individual frames).

Timecode/Zoom Display

The display below the Zoom tool indicates the Zoom factor and the current position of the Playline on the Time-
line (Master Timecode). The separator (, ;:.) between the values indicates the TC system used. For more infor-
mation refer to “Timecode Systems”  on page 5-11.

Timeline Shortcut Menu

Right-click the Timeline to open its shortcut menu:

� Show Every Frame - most magnified view of the Timeline 

� Show Entire Sequence - adjusts Timeline display to show the entire 
length of a Sequence 

� Zoom In - magnifies Timeline display by one increment 

� Zoom Out - reduces Timeline display by one increment

� Insert - inserts the contents of the clipboard at the current position

� Update Head/Tail Picons - updates the clip Picons at the beginning 
and end of the clip

� Delete Render Files - deletes render files selectively.  page 8-131

� Cut/Copy/Paste/Delete - see “Timeline Editing”  on page 9-54

� Timeline Properties - see the following section. 
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Timeline Properties

Click the right-hand mouse button on the Timeline to access the shortcut menu. Under Timeline Properties 
you’ll find several options that allow you to personalize Timeline editing.
The dialog box has two tabs: General relates to every new Sequence that you create, open or edit. The settings on 
the Current Sequence tab relate only to the Sequence that is currently on the Timeline. These options are 
described in the section entitled “New Sequence”  on page 9-47.

You can access the Timeline Properties dialog also via Edit > Control Panel > User > Time-
line.

General

� Clear mark-in/out on Timeline after insert -
...immediately after the clip was inserted (only when using the Insert Arrow). See also “The Insert 
Arrow” on page 9-42.

� Clear mark-in/out on Timeline after delete marked range -
in analogy to the above function.

� Automatically update Timeline Picons -
... does so even while trimming the clips.

� Keep stereo Audio Mode when disbanding stereo audio clips in Timeline -
if this option is not selected, stereo clips will be disbanded and converted to mono Audio Mode. 
See also “Stereo and Mono, Panorama and Balance” on page 13-8.

� Restrict dragged Transitions to available handles -
This means that a Transition will not be applied at all, or that its original length will be automatically 
modified to match the available handle (leeway, or available media data). Caution: this option affects 
only the initial application of the Transition. Subsequent trimming is not restricted.
See also “Leeway (Overlap)” on page 9-36. 

� Show dupes during trim -
This is an extension of the Detect recurrent use option which has to be enabled beforehand in the Track 
Header > View menu (Name, see  page 9-14).
A jagged line at the upper edge of the clip indicates the range of frames that is already being used on 
another part of the Timeline. With this option active, this display is active even while you trim the clip.

� Show sync breaks during trim -
This works the way the dupes display works. You first have to enable the Sync Break indicator for all or 
one particular Track before you can use this option ( page 9-14).
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� Extended sync break display -
This extends the standard Sync Break functionality:
Normally, a sync break (that’s when the original relation between audio and video clips is disrupted) is 
displayed only as long as the original clips still retain some overlap. When the clips get totally displaced, 
the display disappears because the system assumes that this happened intentionally.
Now, if you enable this option, the sync break will be displayed even in the case of no overlap at all.

� Default magnet for scrubbing and editing -
These options make it easier to position the Playline (scrubbing), and to insert clips and Transitions 
(editing). 
Select the points of magnetic attraction from the lists. Below a certain distance, the Playline and the 
object will snap to the selected magnetic point.
See also “Snap Mode” on page 9-59.

Current Sequence

These options are described under “New Sequence”  on page 9-47.

Tracks

Tracks are the basic elements of the Timeline. They are used for positioning clips, transitions and all other 
objects contained in a Sequence. Every object on a Timeline Track occupies a certain area of the Timeline. The 
length of this area depends on the object’s duration and on the Timeline display size. The mark-in point is rep-
resented by the left edge of the clip, the mark-out point, by the right edge.

Right-click a free area of the Track to open a shortcut menu for controlling Timeline display size (“Zoom Con-
trol”  on page 9-6).

In Pinnacle Liquid, all Tracks are the same. There are no preset video, title or audio Tracks. 
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Slice Numbers

The Slice Number bar, located on top of the Tracks, displays a number for every edit event in ascending order.

Slice numbers

The following slices are shown on the Timeline: 

� Video clips (slice spans the mark-in and mark-out points)

� Transitions other than hard cuts (slice spans the entire Transition duration)

� Empty areas between clips on the Timeline 

� Areas where video clips overlap, if their mark-in and mark-out points do not match 

Right-click the Slice Number bar to open the following shortcut menu:

� To select more than one slice number, hold down the SHIFT button when clicking.

� Set Mark-In/Out for Edits # -> #
Click this option to set a mark-in at the slice first selected and a mark-out at the slice last selected. 

Slice Colors

In addition to the standard gray, Slices can appear with one of the following colors, thus indicating how (i.e. in 
terms of frame rate, frames per second, fps) corresponding Timeline areas will be played back:

� Green -
Green slices identify segments that are ready for immediate realtime playback. They contain either real-
time hardware effects or effects that have already been rendered. The system falls back on existing ren-
der files.

� Yellow - 
Yellow slices identify segments that can basically be played back without waiting for rendering. 
Depending on processor performance and FX constellation, however, frames may be dropped during 
the preview. The system cannot determine whether this will occur until the Playline actually enters the 
Slice because processor usage (for example, for realtime software effects) is not evident beforehand. 
Audio-video synchronicity, however, remains intact, and the visual impression of the effects can usually 
be judged quite reliably.

� Red - 
Red slices identify segments that must be rendered prior to playback. During the rendering process, the 
Slices gradually turn green. This is the case for all Pinnacle Liquid Classic effects.
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� Dark Red -
When the Slice above certain Timeline ranges turns dark red, this indicates:
- There is no media data for the clip(s) available (also indicated by “!” in the inlay)
- The file format of the clip(s) does not match the Quality Ranks currently set for the Timeline/Sequence 
(see “Desired Media Quality and Min Media Quality”  on page 9-49).

� Gray -
Everything that is not green, yellow or red, i.e. “normal” video and graphics, is gray and is always played 
back at the full frame rate.

Toolbar 

The toolbar is located at the top of the Timeline and contains buttons for navigating on the Timeline and play-
ing, marking and processing clips and Sequences. This toolbar can be customized like any other Pinnacle Liq-
uid toolbar. (See “Customizing Toolbars” on page 17-8.) 

The default toolbar contains buttons for basic functions. 

If you wish to call a certain function only once (without permanently storing the button on your task-
bar), use the toolbar shortcut menu (right mouse-click) and select the respective function from the list. 
This is only carried out once, no icon is placed on the toolbar (see also Calling Tools Once on page 
17-10).

Mouse Pointer Shapes

When the Edit Mode is deactivated (i.e. when in Scrub Mode), the mouse pointer always appears as an arrow 
accompanied by a line which represents the Playline.This means you can scrub at any position on the Timeline. 
See also “Mouse Navigation” on page 9-28.

When the Edit Mode is activated, the mouse pointer changes depending on where the mouse is located on the 
Timeline:

� When the mouse pointer is on an empty part of the Track it appears as crosshairs. 

� When the mouse pointer is on top of a clip, it turns into an arrow accompanied by a film strip symbol. 
This means you can select the clip and move it in its entirety.

� When the mouse pointer is near the mark-in or mark-out of a clip or transition, the arrow is accompa-
nied by a mark-in or mark-out symbol. This means that you can trim the object by pressing the left 
mouse button. 

� When the mouse pointer is on a clip or a transition, the mark-in and mark-out symbols appear as 
empty mark-in and mark-out symbols if the function is not available.
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T r a c k  H e a d e r s

The Track Headers are in the area to the left of the actual Tracks. This area is used for organizing the Tracks in a 
Sequence, defining Source Track Mapping, specifying Track display, naming Tracks, etc. Whether a Track is 
active or not active for editing also appears here.

The Track Headers are divided into six columns:

The top row of the Track Headers contains the column headers. Right-click a particular column Header 
to customize Tracks. The settings in the column Headers affect all Tracks. Every Track can also be config-
ured individually.

Track Header (Subtrack column present only if subtracks are present)

Subtracks and Matte Tracks Display

If Subtracks and/or Matte Tracks are configured, an additional column appears on the far left. The more subor-
dinate Subtracks or Matte Tracks that are used, the wider this column becomes. See “Add Matte Track”  on page 
9-18 and “Add Sub Track”  on page 9-19.

Source Track Mapping 

The Source Track Mapping column shows the Source Tracks (video, audio 1 to 4) of the clip currently in the 
Source Viewer. You can define which Source Tracks are mapped to which Timeline Tracks in the column and you 
can define mapping type and completely deactivate mapping in the column header. More  page 9-22

Sync Lock

The Sync Lock column is used for linking Tracks to avoid that e.g. sound and image become asynchronous dur-
ing trimming of objects.  page 9-78

Track Names

Audio Playback

Track Header

Video-
Playback

Source Track
Mapping

Source Track
Labels

Track Name

SyncLock

Subtracks
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Track Name 

The Track Name column shows the name of every Track. Here you can modify the Tracks and adjust what 
appears on them.  page 9-13
This column is also used for defining Tracks as active or not active for editing. See also “Activate all / Deactivate 
all” on page 9-17.

In this column the Source Timecode will be displayed, if the option has been enabled. See  page 9-14.

Video Playback

The Video Playback column is used for activating and deactivating video playback of Tracks. If Video Playback 
is activated, the monitor icon appears.

Right-click the column header to open the shortcut menu, where you can activate or deactivate Playback.

If Video Playback is activated, all video clips on respective Tracks are played during playback. This status 
is represented by a white monitor icon in front of a Track.

If Video Playback is deactivated, no video is played from this Track and the white monitor icon disap-
pears. 

To activate/deactivate video playback of a single Track, simply click the monitor icon in the appropriate 
field.

Audio Playback

The Audio Playback column is used for activating and deactivating audio playback of 
Tracks. If Audio Playback is activated, the loudspeaker icon appears. In this column 
you can also adjust how audio clips are displayed.

Right-click the Audio Playback column header to open a shortcut menu for controlling audio playback 
settings. See also “Special Characteristics of Audio Clips” on page 13-5.

If the speaker icon appears as a contour, audio scrubbing mode is activated for the Track: “Audio Scrub-
bing - Digital or Analog”  on page 13-11. 

Audio Playback menu
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Configuring Tracks

You can “configure” Tracks both individually and for the entire Timeline. In other words, you can 
name, delete, add, copy, zoom in, zoom out, etc., either all the Tracks as a group or a single Track.

A d j u s t i n g  A l l  T r a c k s  ( T r a c k  N a m e  H e a d e r )

To adjust all Timeline Tracks as a group, right-click the header of the Track Name col-
umn. In the shortcut menu that appears, use the options provided to control the 
appearance and functionality of the Tracks. 

Add Track

Click Add Track to add an additional Track to the Timeline. New Tracks are added 
under the existing Tracks. You can always drag a Track to a different position.

Track Name header 
shortcut menu
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View

Click View to open a submenu with various options for controlling how clips are displayed on the Tracks. 
Changes made to these settings automatically affect how clips are displayed on the Tracks. 

� Head - displays the first frame of the clip as a Picon at the beginning of the 
clip. 

� Tail - displays the last frame of the clip as a Picon at the end of the clip.

� Index - displays the index frame in the middle of the clip (see“Set Index Pic-
ture”  on page 6-17).

� Marker - displays clip markers (if set). See also “Setting Markers and Adding 
Comments” on page 8-57.

� Sync Break - A red line at the bottom of a clip indicates that the audio and video portions of a clip are no 
longer synchronous. 
The number at the end of the clip indicates by how many frames you have to move the clip(s) so that 
they are synchronous again. 
However, this function only works if the video and audio were digitized synchronously and inserted 
ungrouped on the Timeline. See “Source Track Mapping”  on page 9-22 and “Synchronicity”  on page 
9-104.

� Recurrent Use - indicates (based on the timecode information) whether a clip or parts of it are already 
contained in the Sequence. A red jagged line at the top edge of a clip shows what part of the clip has 
already been used.

If you are using two different clips with identical timecode in a Sequence, these clips (or parts of them) 
are registered as already being used (recurrent use), even though they may be of totally different con-
tent.

� Speed - indicates the speed factor (as a percentage) by which the clip was modified. A broken black line 
appears at the lower edge of the clip. An alternating red and black broken line indicates a timewarp 
effect.

� FX - displays the icons of the effects assigned to a clip. Activate this function to access an effect icon’s 
shortcut menu. See also “Effect Icon on a Timeline Clip” on page 10-8.

 View submenu
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� Source Timecode - when active, the timecode data of a Timeline clip will appear below the Track name.
This refers to the position of the Timeline Playline covering a clip on the Timeline. Thus you know the 
clip’s TC data, not only the master TC of the Timeline.
The Track height must not be below 38 pixel (see “Track Height”  on page 9-16).

Source Timecode refers to the clip TC

Text

Click Text to open a submenu with various options for controlling the display of clip information. You can dis-
play all clip properties necessary for your work. 
Click an item to select it (a checkmark appears next to it). Selected information is automatically displayed with 
the clip. 

All Text options and some of the View options are included in a clip’s Properties window. Click Proper-
ties in a clip’s shortcut menu to modify the information. See also “Object Information: Properties” on 
page 8-66.
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� Name - displays name of current clip.

� Scene/Take - displays the entry made when naming a clip, for example, in the 
Logging Tool or in Clip Properties.

� Duration - indicates the length of a clip in seconds between its mark-in and 
mark-out.

� Clip Duration - indicates the length of a clip in seconds before the mark-in, 
between the mark-in and mark-out, and after the mark-out.

� Reel - displays source Reel names. 

� Comment - displays clip comments.

� Mark-In/Out - displays the timecode of the mark-in and mark-out.

� AV Media - displays the clip path, i.e. the name and location of the corresponding Media File.

Sample: clip with all text information available

These options only appear if clip display is large enough. The Text data also appears in the tooltip (acti-
vated by resting the mouse pointer on a clip for about one second).

Track Height

If you want all the Tracks to have the same height, click Track Height. From the pop-up that appears, specify a 
height of 14 to 122 pixels. To directly control the height of individual Tracks using the mouse, drag the line 
between two Track Headers up or down.

Control Track height using the mouse

Submenu text
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Activate all / Deactivate all

Select Activate all in the Name Track Header to toggle Track status between 
active and inactive. Inactive Tracks have a Track name with a dark back-
ground. To change the status of individual Tracks, simply click their Track 
name.

When a Track is not active, you can delete and move clips, but not add new 
clips using the Insert Arrow or Send To function. However, you can still drag 
clips to the Timeline. See also “Adding Objects” on page 9-56.

Protect All

Click Protect all to protect all Tracks and hence all elements on the Timeline from being modified. When this 
function is activated, you cannot directly access the clips or other elements on the Tracks. Protected Tracks are 
played back normally during Timeline playback (when playback is activated). 

The Picons of protected Tracks appear with a darker background. 

Protected and unprotected Tracks

You can delete protected Tracks (system prompts you for confirmation).

Active Track

Inactive Track

Track active/
inactive

Protected Track
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A d j u s t i n g  I n d i v i d u a l  T r a c k s

To adjust an individual Track, right-click a Track name to open a 
shortcut menu.

Some of the options in this menu are the same as in the Track Name 
Header shortcut menu. See also “Adjusting All Tracks (Track Name 
Header)” on page 9-13.
These options operate the same as those in the other menu, except 
they only apply to one selected Track. The differences are discussed 
in more detail below. 

Duplicate Track

Click Duplicate Track to make a copy of the current Track, including 
all the objects it contains, and insert it below the current Track. The 
copy is assigned the same name and has the same settings as the 
original. 

Duplicate Track Empty

Click Duplicate Track Empty to make a copy of the current Track, 
without its contents (i.e. just the settings). The copy is inserted 
below the current Track and assigned the same name as the origi-
nal. 

Delete Track

Click Delete Track to delete the current Track from the Timeline. The system prompts you for confirmation.

Add Matte Track

Click Add Matte Track to add a Matte Track as a subordinate track to an existing track (a special type of Sub-
track). This function is used for Track Matte (alpha channel) effects. For a more detailed explanation, refer to: 
“Matte Track and Track Matte”  on page 9-108.

When Matte Tracks are used, another column is added to the Track Header area on the far left. The Matte Track 
itself is green. Click the Plus sign in the new column to display the track or the Minus sign to hide it.

Matte Track for V_1 Expanded; New Column on the Left

Single Track shortcut menu
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Add Sub Track

Subtracks are useful for setting up complex Timelines such as those used, for example, in multilayer composit-
ing. They basically serve as Containers - although only on a Track-specific basis - and not as freely moveable 
objects. Subtracks have no other purpose than to achieve order and clarity, and thus differ from Matte Tracks. 
You can configure as many Subtracks as you wish.

Subtracks and Hierarchical Tree (on the Left)

Note the following:

� As soon as the first Subtrack is added, a new column is added on to the left of the Mapping column. As in 
the Windows Explorer, a system of Plus and Minus boxes and connecting lines allows you to show and 
hide the different hierarchical levels.

� Each new Subtrack is initially positioned on a subordinate level in the tree hierarchy, indicated by the 
arrow to the right of the minus box. In the screenshot above, for example, this is illustrated by “sub 1” 
and “sub 2”.
This means that when you click the minus sign, Subtrack “sub 2” will disappear. The same thing hap-
pens when you select Collapse Tracks from the shortcut menu.
If you then click the plus sign, the subtrack will reappear. 
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� The shortcut menu for a Subtrack also contains the Expand/Collapse Level functions. When you collapse 
(raise) the Subtrack level, the Subtrack is shifted onto the same hierarchical level as the Subtrack imme-
diately above it. In the screenshot above, this is illustrated by Subtracks 6 to 9.

� Objects on different Subtracks are independent of one another. For example, if you move an object to 
the “master” track while its Subtracks are collapsed, it will no longer be synchronous with the objects on 
the Subtracks.

To avoid undesirable consequences when objects are unintentionally moved, work with linked objects. 
See also “Item Link” on page 9-80.
You can also activate the SyncLock function (for FilmStyle). See also “Sync Lock” on page 9-78.

� Treat Subtracks and the objects they contain just as you would normal Tracks and objects.
But also note: When you delete a (sub)track to which other Subtracks are attached, these subordinate 
Subtracks are also deleted.

Collapse / Expand Level and Tracks

See previous section.

Rename

Click Rename to rename a Track. In the edit dialog box that appears, enter a name of up to 31 characters. The 
default names given to Tracks are Name 1, Name 2, etc. 

Track names help you maintain an overview of the various Tracks on the Timeline, but have no effect on 
a Track’s functions - every Track on the Timeline has the same functions. Only activating video or audio 
playback influences a Track’s functions.
“Video Playback”  on page 9-12 and “Audio Playback”  on page 9-12.
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Activate and deactivate all others

This function lets you save a few steps when you just want to activate a single Track. All other tracks are deacti-
vated.

View 

 See “View” on page 9-14.

Text Info 

See “Text” on page 9-15.

Track Height 

See “Track Height” on page 9-16.

Protected 

See “Protect All” on page 9-17.

Active 

See “Activate all / Deactivate all” on page 9-17.

Track Priority

Track Priority is defined vertically (higher Tracks have higher priority). In other words, the higher tracks 
encompass everything below them. This lets you apply effects at several levels (multi-layering). 

You can insert any number of Tracks in order to create effects like keys, 2D/3D effects, etc.

To change a Track’s Priority, drag its Track name in the Track Header to a different position. As you drag, the 
pointer changes to show where the Track will be inserted when you release the mouse (either above or below 
another Track).

Track priority changes with Track order

Track Priority plays an important role for example with keying. In a keyed clip, the clip underneath becomes 
visible. 

Track Priority does not apply to audio. All audio signals have equal priority, regardless of their Track 
position. 
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Source Track Mapping

If you are working with the Sequence Editor ( page 9-38), Source Track Mapping is important for inserting clips 
on the Timeline; it serves as a sort of “signpost” for the Source Tracks.
When you use the appropriate function to insert a clip from the Source Viewer on the Timeline or when you use 
the Send To > Timeline function in the Project window, the Source Tracks (i.e. video and/or audio Tracks) for the 
click are distributed over the Timeline Tracks in accordance with the Source Track Mapping. 

S o u r c e  T r a c k  M a p p i n g  M e n u

In the shortcut menu for the Source Track Mapping column, you can begin by defining whether clips should be 
grouped or ungrouped on the Timeline or should be inserted “as a gap”: 

� Click Grouped (with/without checkmark) to define how Source Tracks should be positioned on the 
Timeline Tracks: completely grouped (VA), separately (V;A#) or video and stereo (V,S#).

� Click Mappings Enabled to deactivate (no checkmark) or activate (with checkmark) the mapping func-
tion. If mapping is disabled, any clips you insert on edit-active Timeline Tracks are represented by a gap 
with the length of the clip.

� Click Stereo mappings separate to insert stereo audio clips on the Timeline as two separate objects and at 
label positions A1 and A2 (instead of S1 or S2).

When you drag clips to the Timeline, the defined mapping is 
ignored, clips are always inserted as “grouped” wherever you drop 
them. 
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S o u r c e  T r a c k  L a b e l s

Source Track Labels in the Source Track Mapping column identify the Timeline Tracks on which the Source Tracks 
should be inserted. The following Labels are possible:

� “VA” means that a clip is positioned on a Track with video and audio grouped. Tracks labeled with “A” 
only contain audio (no video signal in clip).

� “V” means that only a video signal is positioned on the Track.

� Tracks marked with “A#” (for audio A1-A4) are assigned audio clips from the corresponding Source 
Track (input channel). 

� “S#” means that stereo audio is positioned on the Track (for example, A1/A2 for S1 and A3/A4 for S2).

M a p p i n g s  D i s a b l e d

Deactivate Mappings Enabled so that when you press the Insert Arrow instead of the clip itself a gap the duration 
of the clip appears on the Timeline Tracks (if they are edit-active) based on Source Track Mapping. This applies 
to both grouped and ungrouped clips.

 
 

Grouped video and 
audio

Ungrouped video 
and audio

Ungrouped/grouped 
video and stereo audio
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M a p p i n g  I n d i v i d u a l  T r a c k s  

You can define mapping for each Track. To enable/disable mapping simply click 
the Source Track Label (toggle switch). 

M o v i n g  S o u r c e  T r a c k  L a b e l s

To move the individual Source Tracks, drag the V, VA, A# or S# to the required 
Timeline Track. The edit status of the Timeline Track is also transferred with this action, meaning that the origi-
nal Track is left edit inactive.

Moving source Track labels 

You can also control mapping of the individual Source Tracks with the individual shortcut menus. 
To activate mapping for a Track, simply click it (a checkmark appears next to it
To completely deactivate mapping for a Track, click the Track again so that the checkmark disappears. 
Please note: That does not activate or deactivate the edit status of the Track. 

Which shortcut menu appears depends on mapping type

Enabled

Disabled

Mapping status

Grouped video and 
audio

Ungrouped video 
and audio

Ungrouped/grouped 
video and stereo audio
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Edit Styles

Pinnacle Liquid’s two Edit Styles determine how objects are inserted on the Timeline, regardless of whether you 
use a mouse (drag&drop) or the Insert Arrow and Source Viewer:

Overwrite Style

Objects that are inserted overwrite any objects or gaps on the particular Track.  page 9-25

Film Style

As at the film cutting table, here the material at the insertion point is “cut” and the clip is inserted between the 
“two parts”. Subsequent objects and gaps are shifted accordingly.  page 9-26

When insertion is by drag&drop ( page 9-56), the Source Track Mappings are not used. See “Source Track 
Mapping” on page 9-22.

O v e r w r i t e  S t y l e

When working in Overwrite Style, the inserted clip replaces an area on the Timeline Track equal in size to the 
clip’s duration. 

To activate Overwrite Style, click the tool button (between Source and Master Viewer). When Overwrite Style is 
active, a red square appears at the top center of the button.

Which Timeline Tracks are overwritten depends on which Source Tracks a clip contains and on Source Track 
Mapping. (See “Source Track Mapping”  on page 9-22 for details.)

To insert an object with the Insert Arrow a Track has to be active and not protected.  page 9-17 

In the case of active Tracks that have no assigned Source Tracks, a gap which corresponds in length to the dura-
tion of the inserted clip is created and existing clips are overwritten when you insert objects with the Insert 
Arrow. See also “The Insert Arrow” on page 9-42.
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E x a m p l e

The following example illustrates an insert using the Insert Arrow with a clip that has one video Source Track 
and one audio Source Track mapped to a Track set inactive. 

A transition in the area of the inserted clip is deleted. 

F i l m  S t y l e

If you insert a clip with the Insert Arrow in Film Style, a cut is created at the insert point. 

To activate Film Style, click the tool button (between Source and Master Viewer). When Film Style is active, a 
yellow square appears at the top center of the button.

Based on Source Track Mapping (see also Source Track Mapping on page 9-22), the Timeline Tracks are rippled 
by the duration of the clip.

In order to insert an object with the Insert Arrow a Track has to be active and not protected.  page 9-17 

In the case of active Tracks that have no assigned Source Tracks, a cut is also created. Objects previously on the 
Track are shifted (rippled) to make room for the inserted clip and a gap is created.  page 9-42

Name 1

Name 2

Name 3

Name 1

Name 2
Name 3

V

V

Before insertion

After insertion

inactive

inactive

A1

A1
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E x a m p l e

The following example illustrates an insert using the Insert Arrow with a clip that has one video Source Track 
and one audio Source Track mapped to a Track set inactive.

A transition in the area of the inserted clip is deleted. 

Name 1

Name 1

Name 2

Name 2

Name 3

Name 3

V

V

A1

A1

Before insertion

After insertion

inactive

inactive
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Navigating on the Timeline

This section describes how you can find your way on the Timeline, set the Playline to specific points on the 
Timeline, and view/listen to video/audio.
The information below also applies to the Playlines in the Clip, Source, Master and all other Viewers.

The timecode display to the lower left of the Timeline refers to the current position of the Playline.

Z o o m  C o n t r o l  a n d  S c r o l l  B a r s

The amount of a Sequence that you can view at one time on the Timeline depends on three factors:

� Timeline scale/zoom: Zooming the Timeline scale in and out.  page 9-6

� Scroll bars: Scrolling the Sequence to the left/right or up/down.  page 9-5

� Desktop view (View Switcher): Here you can select various Timeline views, such as horizontal over both 
monitors (if you work with two monitors).  page 3-14

M o u s e  N a v i g a t i o n

“Mouse navigation” in Pinnacle Liquid means moving the Playline ( page 9-5). In linear editing, it means cue-
ing a VCR to a tape position. 

Scrub Mode

In this case, the mouse pointer must be switched to Scrub Mode. Above the Timeline, the mouse pointer again 
appears as shown (white arrow accompanied by a line representing the Playline).

If the mouse pointer does not look like this, you are in Edit Mode ( page 9-55). Click the Edit Mode button in the 
Timeline toolbar to switch to Scrub Mode.

� Or to change modes temporarily, hold down the ALT key. When you release the key, the mouse 
pointer will return to the previous mode.

Moving the Playline

� In Scrub Mode: Click the point on the Timeline where you want to position the Playline. 

� In Edit Mode: Click the desired position within the Timecode Bar ( page 9-5).
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Scrubbing

� Drag the Playline over the Timeline. Video is played back simultaneously. (Audio scrubbing:  page 8-56).
If you reach the end/beginning of the Timeline, the system automatically scrolls the Timeline farther.

� If you use a mouse with a mouse wheel: simply turn the wheel to move the Playline frame by 
frame, press the wheel to move 10 frames at a time.

You can also scrub with the mouse pointer in the video inlay of the Master Viewer. The Playline auto-
matically follows.

K e y b o a r d  N a v i g a t i o n

You can also move the Playline using the keyboard:

Arrow Keys

� Use the LEFT ARROW/RIGHT ARROW keys to move the Playline one frame at a time.

� Simultaneously hold down the SHIFT key to move the Playline 10 frames at a time.

Default/Custom Key Assignment

You can also assign the function to another key. See also “Assign Functions to Keyboard” on page 17-11.

Shuttle Playback (JKL)

Shuttle Playback is a convenient way to play back Sequences.  page 8-60

B u t t o n  N a v i g a t i o n

The toolbar is located at the top of the Timeline and contains buttons for navigating on the Timeline. This tool-
bar can be customized like any other Pinnacle Liquid toolbar. (See “Customizing Toolbars” on page 17-8.) 

GoTo Start

Jumps to the beginning of the Sequence/clip.

GoTo End 

Jumps to the end of the Sequence/clip.
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Step Back 1 Frame 

Jogs backward one frame at a time. 

Step Forward 1 Frame

Jogs forward one frame at a time.

Step Back 10 Frames

Jogs backward ten frames at a time.

Step Forward 10 Frames

Jogs forward ten frames at a time.

GoTo Mark-In

Jumps to the mark-in point, if set; otherwise to the start of the Sequence/clip.

GoTo Mark-Out

Jumps to the mark-out point, if set; otherwise to the end of the Sequence/clip.

GoTo Previous Marker

Jumps backward to the next Marker in that direction, if one is set.

GoTo Next Marker

Jumps forward to the next Marker in that direction, if one is set.
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GoTo Previous Edit

Jumps backward to the previous Edit, if it exists.

GoTo Next Edit

Jumps forward to the next Edit, if it exists.

The system registers each point on the Timeline where a clip, transition, title, etc., ends or begins as an 
“Edit” and displays it as a Slice. These Slices are numbered and are displayed above the Timeline Tracks.

GoTo Previous Event

Jumps backward to an event before the current position, if one is set. 

GoTo Next Event

Jumps forward to an event following the current position, if one is set.

Events include Markers, mark-ins, mark-outs and Edits.

GoTo Previous Gap

Click the GoTo Previous Gap button to position the Playline at the beginning of the closest previous Gap on any 
Track. 

GoTo Next Gap

Click the GoTo Next Gap button to position the Playline at the beginning of the next Gap on any Track.

A Gap is defined as the space between two adjacent clips on a Track.
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Timeline Markers /Cue Marker

Timeline Markers can be set anywhere on the Timeline and can be provided with a comment as needed. A Mar-
ker List allows you to jump directly to a specific Marker.

There is also a clip Marker. See also “Setting Markers and Adding Comments” on page 8-57.

S e t t i n g  a n d  D e l e t i n g  M a r k e r s

Move the Playline to the Marker position and click the Set Marker function. The Marker symbol is inserted in 
the Timecode Bar and in the position bar of the Master Viewer. At the same time, it appears in the Master Viewer 
video inlay.

Position the Playline directly on a Marker in order to delete it using the Delete Marker function. You can select 
the Marker using the Goto next/previous Marker and Goto next/previous Event functions. (See also “Button 
Navigation” on page 9-29.)

A t t a c h i n g  a  C o m m e n t

Double-click a Marker to attach a brief comment (maximum 25 characters). Then click OK or press ENTER to 
close the editing field.
The comment is displayed when you rest the mouse pointer on the Marker for about a second.

M a r k e r  L i s t

Click this button to open the Marker List. This window contains a list in chronological order of all the Marker 
set in the current Sequence. 

Double-click a marker entry to make the Playline move to the cor-
responding Marker position.

� Marker Comment - contains a Marker comment created by the 
user. To enter a comment, double-click the Marker and type in 
information in the field that appears. 

� Sequence - shows the timecode position of a Marker on the 
Timeline.

� Clip - shows the timecode position of a Marker on a clip. 

Right click in the Marker window to display a shortcut menu containing the following entries:

� GoTo Marker - Moves the Playline to the selected Marker, without closing the window in the process (as 
it does when you click the Marker entry).

Marker list
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� Clear Selected Marker - Deletes selected Marker. 

� Clear All Markers - Deletes all Markers in the current Sequence.

� Clear All Sequence Markers - Deletes all Sequence Markers of the current Sequence.

� Clear All Clip Markers - Deletes all clip Markers in the current Sequence.

Undo/Redo

In the default configuration, these two functions are available on the Timeline and Master Viewer toolbars. 

U n d o

Cancels the last edit action and returns the software to the state it was in before you performed that action. Pin-
nacle Liquid saves the last 64 changes you made in any given module, permitting you to revert to practically any 
previous state. 

The Undo History summarizes all available Undo steps in a list of edit actions. By clicking on a list entry 
you can reinstate the Timeline state prior to that specific action.
Call the Undo History by CTRL-SHIFT-clicking the Undo button. Hit ESC to close Undo History. A simi-
lar list of Redo steps can be displayed via CTRL-SHIFT-Redo.
Undo/Redo History is available in the Source Viewer and the Clip Viewer as well.

R e d o

Cancels an Undo and returns the module to the edit state it was in before you used the Undo button. 

LiquidEdition Liquidchrome

C u e  M a r k e r s

Cue-Markers trigger GPI impulses, for example to indicate the start or end of a Sequence playing on the Time-
line. A GPI breakout box is available; please consult your Pinnacle Systems GmbH dealer.

Cue-Markers look like ordinary Markers on the position bar, but have the color yellow. Set and delete Cue 
Markers in the same way you set and delete ordinary Markers. The tool buttons Set Cue-Marker and Delete 
Cue-Marker show a lightning next to the Marker triangle:

If you don’t find these tools on your default toolbar, check out the tool box of Timeline/Master Viewer.
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ABCs of Effects

The simplest effects in Pinnacle Liquid are video Dissolves and Audio Cross Fades. This section provides a brief 
description of these Transitions. For more information on video and audio effects, see “Effects in Pinnacle 
Liquid: The Basics”  on page 10-3.

A d d  t r a n s i t i o n s

On the Library  tab in the Project window, Transitions can be found in the Rack Folders named Classic Transi-
tion FX and Realtime Transition FX, in the Racks Editors, Presets and Audio, respectively. There the dissolve is 
stored as Dissolve, and the cross fade as Audio Crossfade. 

Drag the Transition you want to the clip interface or to the beginning or end of the clip to generate a fade-in/
fade-out.

When a Transition or effect is being rendered, a pulsating sigma sign appears on the bottom right-hand side of 
the taskbar.
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T r a n s i t i o n  S h o r t c u t  M e n u

Like all the objects in Pinnacle Liquid, a Transition has a shortcut menu. Here you can, for example, define the 
Transition duration or alignment:

Edit 

To create or edit a Transition, click Edit to open the appropriate Transition Effect Editor.

Duration

To change the default duration of a Transition, click Duration and enter the required 
duration in hh:mm:ss:ff.

To change the duration value, you can also subtract or add a certain duration. To do 
so, enter a “+” or “-” before a number. Confirm with ENTER. 

Transition effect 
shortcut menu
Volume II Chapter Edit 9 - 35



PINNACLE

Video Editing
Align

Use Align to define the point (mark-in, middle, mark-out) to position a Transition on the Timeline (generally at 
the cut between two clips).

� Click Start At Cut to position the beginning of a Transition (mark-in) at the 
cut.

� Click End At Cut to position the end of a Transition (mark-out) at the cut. 

� Click Centered On Cut to center a Transition on the cut.

� You can also activate the Align function by repeatedly pressing the ALT button, while dragging 
the Transition. This allows you to toggle between the three positioning points.

Cut/Copy/Replace

� Click Cut to delete a Transition from the Timeline and transfer it to the clipboard. You can then insert 
the Transition elsewhere on the Timeline. 

� Click Copy to create a copy of a Transition on the clipboard. You can then insert the Transition elsewhere 
on the Timeline, while keeping the Transition at its original position.

� Click Replace to change Transition type without changing basic parameters like duration, alignment, 
etc. You can use this function, for example, to replace a dissolve with a slide. To use Replace, you have to 
first copy the new Transition to the clipboard. 

Delete

Click Delete to eliminate a Transition from the Timeline. 

Rename

Click Rename to assign a different name to a Transition effect.

Transition Undo/Redo

These options allow you to cancel changes you made to Transitions or to cancel the undo(s) that you per-
formed.

L e e w a y  ( O v e r l a p )

A valid Transition appears as a grey bar. If the bar is red, this means that the clip does not cover the entire Tran-
sition area. This occurs if the end of the outgoing clip or beginning of the incoming clip has too little leeway (or 
“overlap” when you think in terms of A/B editing). 
To remedy this situation, trim the clips or the Transition. See also “Trimming Objects” on page 9-60.
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Va l i d  a n d  I n v a l i d  T r a n s i t i o n s

If a Transition is not possible, you will not be allowed to set it. The examples below illustrate why this might 
happen:

Invalid Transitions
The pictures below illustrate how Transitions can be set.

Dissolve (top); fade-in/fade-out with leeway (middle); fade-in/
fade-out without leeway (bottom)

If you insert, delete or move a clip in the area of a Transition, the entire Transition is deleted. 

A d d  ( A u t o )  D i s s o l v e

This function automates the insertion of Dissolves and Cross Fades: With a single click, the Dissolve or Cross 
Fade is in place. See also “Add Dissolve” on page 13-60.
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Sequence Editor

The Sequence Editor combines the Source Viewer (“player”), Master Viewer (“recorder”) and Timeline (permits 
non-linear editing and the creation of Sequences). Clips are inserted on the Timeline by means of the Insert 
Arrow.

Source Viewer

Lets you view and define the clips that you will insert in the Sequence  page 9-39

The Insert Arrow

For inserting clips on the Timeline  page 9-42

Master Viewer

For controlling the Timeline and checking the master  page 9-43

Sequence

� Create, save as template, copy, start Timecode  page 9-47

� The ABCs of editing with the Sequence Editor  page 9-52

Use the Sequence Editor as an alternative or supplement to Timeline editing ( page 9-54).

Sequence Editor and Timeline

Source viewer Master Viewer
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Source Viewer 

The Source Viewer is used to prepare clips for editing and insert them on the Timeline. It is equipped with the 
same functions as the Clip Viewer ( page 8-50), but also offers the Insert Arrow and the two Edit Styles 
( page 9-25). 

Source Viewer 

Position barToolbars

Clip name pull-down Playline position Duration indicator
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L o a d i n g  C l i p s  t o  t h e  S o u r c e  V i e w e r  

There are various ways to load clips (and clip shortcuts) to the Source Viewer. Regardless of the method you use, 
a shortcut of the clip is created in the Source Viewer. Therefore, any changes you make to a clip always affect the 
original in the Project window. 

When you insert a clip on the Timeline, a copy of the clip is created. Thus, the original clip is not 
affected. This copy can be transferred to the Project (with Cut/Copy, Paste). 

The last 20 clips you loaded in the Source Viewer appear in the clip name list.  page 9-41

Drag&Drop

You can drag clips from the Project window to the video inlay of the Source Viewer. When you drag several clips 
at once to the Source Viewer, they appear in the order they were in the Project window. 

Send to...

You can transfer clips from the Project window to the Source Viewer by clicking Clip shortcut menu > Send To... 
> Source Viewer. (See also “Transferring Storyboards (Send to)” on page 8-76.)

Double-Click (Project)

Double-click a clip in the Project window to directly load it in the Source Viewer. For this to work, the appropri-
ate settings must be made in Project Properties.  page 8-16

Double-Click (Timeline Clip)

Double-click a Timeline clip to load the clip in the Clip Viewer.  page 8-50.

D r a g g i n g  C l i p s  f r o m  t h e  S o u r c e  V i e w e r

Of course, you can also drag clips from the Source Viewer to other areas.

To do so, CTRL+drag a clip to: 

� the desktop (a shortcut is created).

� in a Rack of the Project window (a copy of the clip is created).

� the Master Viewer (a copy of the clip is created and inserted at the Playline). 

� on the Timeline. 
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C l i p  N a m e  L i s t

The last 20 clips you loaded in the Source Viewer appear in the Clip Name List. The last loaded or selected clip 
appears at the top of the list. If you dragged several clips at once to the Source Viewer, they appear in the order 
they were in the Project window. 

Clip Name List
Right-click Clip Name List shortcut menu > Clear List to delete all entries or individual entries. Other functions 
available in the shortcut menu:

� Most recent always top/bottom -
Ensures that the last clip you edited will appear at the top or bottom of the list.

� Sort by name/Unsorted -
Sorts the list alphabetically or leaves it just as it is (e.g. in the order in which the clips were loaded in the 
Source Viewer).

S e t t i n g  M a r k - I n s  a n d  M a r k - O u t s

To load a certain portion of a clip in the Source Viewer on the Timeline, first set a mark-in and a mark-out point. 
To do so, position the Playline where you want the mark-in (or mark-out) to be and click the Mark In/Mark Out 
button. Do the same for the mark-out (or mark-in). It does not matter whether you position the mark-in or 
mark-out first. If a mark-in or mark-out already exists, it is replaced. 

Moving Mark-Ins and Mark-Outs

You can also move an existing mark-in or mark-out instead of setting new ones.
To do this, ALT+drag the mark-in or mark-out to the required position. The mouse cursor turns into a cross. 
The new position is reflected both in the video inlay and on the timecode indicator.

Mark-In/Mark-Out Frames are “Inclusive”

Frames with mark-ins or mark-outs are inclusive. This means they are used for insertions and Timeline 
playback. 

Mark-In and Mark-Out Priorities

� The mark-in has priority over the mark-out, i.e. to match a clip to the Timeline mark-out, only set the 
mark-out in the Source Viewer.

� The Timeline mark-in and mark-out have priority over the clip mark-in and mark-out. For example, if a 
clip has a longer duration (between the mark-in and mark-out) than the duration between the mark-in 
and mark-out on the Timeline, the Timeline mark-out prevails, the clips is inserted in exactly the length 
of the Timeline mark-in and mark-out. 
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Additional Functions

The Source Viewer also provides the functions of the Clip Viewer, such as Waveform Inlay, Shuttle Playback 
(JKL), etc. (see also Viewing and Editing Objects: the Clip Viewer on page 8-50).

The Insert Arrow

Single-click the Insert Arrow to transfer a clip defined in the Source Viewer to the Timeline. The button is located 
between the Source and Master Viewers.
If you use the Insert Arrow, make sure you have checked or set the following items before clicking it:

� Is (are) the Timeline Track(s) activated?  page 9-17

� Are the Source Tracks correctly assigned (mapped)?  page 9-22

� Is the Edit Style correct?  page 9-25

� Are the mark-in and mark-out points set on the Timeline or is the Playline positioned correctly? 

If everything is correct...

... click the Insert Arrow to insert the clip. Afterwards, the Playline moves exactly one frame after the mark-out 
of the inserted clip so that you can insert the next clip.

As of version 4.01, mark in and mark out on the Timeline are cleared automatically and immediately 
after a clip was inserted using the Insert Arrow. 
If you want to retain mark in and mark out at their respective positions,
- click Undo, or
- right-click right after the insertion on the Slice above the inserted clip, and set new markers. This rem-
edy works only under the condition that Slice and inserted clip are of the same length.

An edit operation is actually complete after you set three mark-in/mark-out points. The fourth mark-in 
or mark-out is set automatically. For more information, read about “three-point editing”.  page 9-52
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Master Viewer

The Master Viewer is used for displaying output of the Timeline. All actions performed in the Master Viewer 
have a direct effect on the Timeline and vice versa. All buttons are available for both areas and are used to acti-
vate the same functions.

The Master Viewer is similar in design to the Source Viewer and Clip Viewer. However, it is not used for process-
ing and playing clips, but rather Sequences.

Master Viewer

Playline position Duration
Sequence name drop-down Sequence menu

New Sequence button

Video inlayPosition bar Toolbar
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L o a d i n g  S e q u e n c e s  t o  t h e  M a s t e r  V i e w e r / T i m e l i n e

There are three ways to load Sequences to the Master Viewer (and thus onto the Timeline): 

� You can double-click them in the Project window,

� use the Send To... option in the shortcut menu 

� or drag them to the Master Viewer’s inlay. 

When you transfer several Sequences to the Master Viewer (from the desktop or a Rack), they appear in 
the Sequence List in their original order. The Sequence List is used for selecting Sequences.

S e q u e n c e  L i s t

The last 20 Sequences you loaded into the Master Viewer or created (see also 
New Sequence on page 9-47) appear in the Sequence List. The Sequence last 
loaded appears at the top of the list. By selecting a Sequence in the Sequence 
List, you can load Sequences onto the Timeline and into the Master Viewer. 
Other functions available in the shortcut menu:

� Most recent always top/bottom -
Ensures that the last Sequence you edited will appear at the top or bottom 
of the list.

� Sort by name/Unsorted -
Sorts the list alphabetically or leaves it just as it is (e.g. in the order in which the Sequences were loaded 
in the Master Viewer).

Remember there is a difference between loading a Sequence in the Master Viewer and dragging one 
from the Project window to the Timeline or into the Source Viewer. For more information, see “Nesting 
Sequences (Building a Container)”  on page 9-112.

D r a g g i n g  S e q u e n c e s  f r o m  t h e  M a s t e r  V i e w e r

You can also drag Sequences from the Master Viewer to the desktop, Racks or Source Viewer. To do so, 
CTRL+drag the Sequence. Dragging a Sequence to the Timeline results in the creation of a Container 
( page 9-112).

Sequence List
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S e t t i n g  M a r k - I n s  a n d  M a r k - O u t s

To define a specific insertion point or exit point on the Timeline, first set a mark-in or mark-out. To do so, posi-
tion the Playline at the corresponding position on the Timeline and click the Mark-In/Mark-Out button. It 
makes no difference whether you position the mark-in or mark-out first. If mark-ins or mark-outs already 
exist, they are replaced. 

Fit Sequence to Mark In and Mark Out

This button lets you toggle between displaying the entire Sequence for the entire available length of the Timeline 
and the area between the mark-in and mark-out. The Timeline’s zoom function always toggles between these 
two views.

Inserting at the Playline

If no mark-in or mark-out is set, the clip is inserted at the Playline.

Moving mark-ins and mark-outs

 page 9-41

Mark-in and mark-out frames are “inclusive”

 page 9-41

Mark-in and mark-out priorities

 page 9-41
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A d d i t i o n a l  F u n c t i o n s  a n d  E l e m e n t s

The Master Viewer has many functions in common with the Clip Viewer and Source Viewer. The functions not 
listed here are described there ( page 8-50).

Position Bar

To view a Sequence, scrub the position bar (you can also scrub in the Master Viewer’s inlay like with all viewers). 
For general hints on how to use the position bar, see “Navigation Using the Position Bar”  on page 8-53.
During scrubbing, the Playline moves and the Timecode Bar is adjusted to reflect the current timecode position. 
See also “Mouse Navigation” on page 9-28.

You can use the arrow buttons on the keyboard or the mouse wheel to jog the inlay frame-by-frame. Roll the 
wheel away from you to jog forward, roll it toward you to jog backward.

The position bar shows markers and the mark-in and mark-out points set on the Timeline.

Timecode Displays

The two timecode indicators at the top of the Master Viewer display information on current Playline position 
and duration between mark-in and mark-out. The display is in standard timecode format.

Video Inlay

The video inlay displays Timeline output at the current Playline position. 

A clip’s mark-in/mark-out points are graphically displayed in the video inlay. Special icons mark frames that 
contain such points or markers: 

� Frames with mark-in/mark-out points have an opaque triangle in the corner.

� Markers not only appear on the position bar, but are also represented in the video inlay through a 
marker icon at the top of the inlay.

Shuttle Playback (JKL)

You can also operate the Master Viewer using Shuttle Playback.  page 8-60

Effect Editor Buttons

In the default configuration, the two toolbars to the right of the Master Viewer contain the buttons for the Pin-
nacle Liquid Effect Editors.  page 10-39

Playline position Duration
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Sequence

The Sequence is the film that is edited on the Pinnacle Liquid Timeline. This section tells you how to work with 
Sequences:

New Sequence  page 9-47

Sequence menu  page 9-49

� New Sequence from template  page 9-50

� Saving a copy of a Sequence  page 9-50

� Saving Timeline as template  page 9-50

� Saving Timeline as default template  page 9-50 

� Setting start timecode  page 9-50

Playback Sequence  page 9-51

Sequence as a clip  page 9-52

N e w  S e q u e n c e

The New Sequence button lets you create a new Sequence on the Timeline (also via File > New > Sequence). 
The first step in the process is to empty the Timeline. The previous Sequence continues to be stored in the 
Sequence Rack of the Project Window. You can also reload a Sequence from the list of Sequence names to the 
Timeline ( page 9-44).

 
New Sequence
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When you reboot your computer after a system crash (e.g. due to a power failure), a new Sequence is 
automatically created. Pinnacle Liquid’s Instant Save ensures that you will not lose your data. The 
Sequence you were editing before the crash can be found in both the Sequence List and Sequence Rack.

Name and Template

Enter a name for the new Sequence here. The Autoincrement option adds a number to the file name (which is 
retained unchanged), always incremented by +1.

If a Template exists, you can select it from the list. For information on creating Timeline templates, refer to
 page 9-50.

Sequence Parameters

(You can access the parameters below from Timeline Properties or in the New Sequence dialog.)

� Preset -
Here you will find a long list of SD (standard definition, PAL/NTSC), high definition and multimedia 
formats. For more information on the latter two formats, see the chapter entitled “High Definition”  on 
page 5-1. 

When you select a specific format, the associated frame rate, resolution and field sequence are immediately dis-
played. As soon as you change one of these parameters, the preset changes (for example, from NTSC 4:3 to 
Custom Format).

� Frame rate -
The frame rate indicates the number of frames or fields played back per second (“fps” stands for frames 
per second).
With some formats you have the choice to activate the Use DropFrame timecode option. This sets the 
Timeline Master to a dropframe TC system.

� Resolution -
Indicates the active resolution as horizontal pixels times vertical pixels; the image’s aspect ratio and the 
pixel shape (square or rectangular).

� Interlacing -
The SD formats PAL and NTSC use interlacing (see Glossary), as do some HD formats. This parameter 
indicates which of the two fields is displayed first.

Create non-standard Sequences only at your own risk! Before doing so, check with your client or the 
recipient of the final data or product.

The following options relate to the playback of Timeline clips. 
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FX Quality

All effects will always be rendered in the best possible quality, without compromise. When you’re editing and 
testing, however, sometimes speed takes priority over quality. For the purpose of a preview, this option lets you 
lower the quality a little. 

Desired Media Quality and Min Media Quality

Normally, these are both set to 16 (Normal) and should not be changed. 
This means that only clips identified as 16 Normal are played. For other clips, the screen remains black and their 
Slices turn dark red, indicating that no media files are available.

These two options act as a filter. You can use them to specify exactly which clip media files should be 
played back. Naturally, this is useful only if you assigned the clips specific quality levels, such as “Level 
7” or “Level 26”, when they were captured in the Logging Tool. Desired Media Quality defines the top 
end of the scale and Min Media Quality defines the bottom. 
Example: You set three quality levels during capture: Level 12, 16 (Normal) and Level 20. In order to be 
able to play all these variants on the Timeline, set Desired Media Quality = 20 and Min Media Quality = 
12. If you want to exclude clips of type “12”, set the Minimum Quality to 16 (Normal).
For more information, refer to “Quality Ranks”  on page 5-16.

Render/Fuse Codec Preset

This setting defines - for the current Sequence - the Render and Codec Preset to be used for rendering and fus-
ing of files. The default selection matches the selected Timeline format and should not be changed, unless there 
is specific reason to do so.
See also “Fuse Sequence” on page 16-16.

S e q u e n c e  M e n u

Click the Sequence Menu button in the top right-hand corner of the 
Sequence Editor to open the Sequence menu. Use this menu to adjust set-
tings for handling and displaying Sequences on the Timeline.

Sequence menu
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New Sequence from Template
Click this option to create a new Sequence in a Project that is not based on the Default Tem-
plate, but rather a Template selected from the submenu that appears.

Save A Copy Of Sequence...
Use this option to save a copy of a current Sequence on the Timeline. Enter a name for the 
copy so that it can be saved under this name in the Project’s Sequence Rack. The original 
Sequence on the Timeline maintains its original name and can continue to be edited.

Use this function to note “milestones” in your editing work, for example, to try out 
different versions of your Project.

Save Timeline As Template... 
Use this option to save the current Timeline Tracks as a new Template. In the box that appears, enter a Template 
name. If you do not save the template in the Template folder or if you use a different file extension, Pinnacle Liq-
uid does not recognize it as a Template and does not display it in the Template list.

This function is useful for saving different templates for different tasks.

In contrast to Project Templates, Timeline Templates do not contain any clips or other objects. They only 
contain settings regarding how the Timeline and the objects it contains are displayed.

Save Timeline As Default Template
The Default Template is used for Sequences created with the New Sequence button or with Template > Default > 
New Sequence ( page 9-47). Click Save Timeline As Default Template to define the current Timeline as the Default 
Template. 

Set Start Timecode
Use this function to enter an initial timecode for a Sequence on the Timeline. In the field that appears enter a 
timecode value.

Consider how much leader you plan to leave before the Sequence. Set Start-Timecode = “Sequence start” minus 
“leader duration”. Example: Sequence start (10:00:00.00) minus leader (00:01:30.00) = Start Timecode 
(09:58:30.00).

The timecode of the current Timeline is the master TC, because in non-linear editing the Timeline is the 
master.
Therefore, the recording tape (or master tape) needs a compatible timecode. For example: Your 
sequence starts at 10:00:00.00 hours, but the tape has been striped (coded) starting at 02:00:00.00 hours 
- record to tape in insert mode will inevitably fail.
Solution: adapt the Timeline TC or stripe the tape accordingly ( page 16-6).
Also, when you use a precoded tape to perform an insert edit, Timeline TC and tape TC need to be com-
patible, and the corresponding clip(s) have to be placed at correct position(s) on the Timeline.

New Sequence 
from Template 

menu
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P l a y i n g  B a c k  a  S e q u e n c e

You can play back a Sequence in the Master Viewer/Timeline, in the Source Viewer and using Picon Play. In the 
default configuration, the following buttons are available on the corresponding toolbars:

Start/Stop Playback

Plays back the Sequence from the current position to the end. To stop playback, click this button once again or 
click Stop.

� Press the SPACEBAR (default assignment). For customized assignments, see: “Assign Functions to 
Keyboard”  on page 17-11. 

Play Around Position (Loop)

This button activates a 4-second playback loop around the actual Playline position, i.e. two seconds before and 
two seconds after. This gives you the opportunity to review an edit or a certain passage. Clicking on this button 
again or pressing the SPACEBAR stops the loop. 

� Press ALT+SPACEBAR (default assignment). For customized assignments, see “Assign Functions 
to Keyboard”  on page 17-11. 

Play In to Out

Plays in a continuous loop from the mark-in to the mark-out, if both are set. If no mark-out is set, plays from 
mark-in to end. If no mark-in is set, plays from the beginning to the mark-out, if one is set, or to the end, if not.

� Press SHIFT+SPACEBAR (default assignment). For customized assignments, see “Assign 
Functions to Keyboard”  on page 17-11. 

To stop “in to out loop play,” press the SPACEBAR on the keyboard, or click the Play or Stop button.

Play to Out 

Plays in a continuous loop from the current position of the Playline to the mark-out, if one is set. If there is no 
mark-out, plays to the end.

� Press CTRL+SPACEBAR (default assignment). For customized assignments, see “Assign 
Functions to Keyboard”  on page 17-11. 

Shuttle Playback (JKL)

 page 8-60
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S e q u e n c e  a s  a  C l i p

On the Timeline, a Sequence appears as a more or less complex collection of clips. In a Rack in the Project win-
dow, however, a Sequence is represented as a single object. This is why, like a clip, a complete Sequence can also 
be inserted in another Sequence or viewed, marked and inserted on the Timeline in the Source Viewer. You can 
also nest Sequences inside one another. See also “Nesting Sequences (Building a Container)” on page 9-112. 

The length of a Sequence as a clip is determined by the mark-in and/or mark-out. In other words, if a 
one-minute Sequence contains a 30-second area bordered by a mark-in and mark-out, the Sequence as a 
clip then appears in the Project window with a length of 30 seconds. However, the Sequence may still be 
trimmed.

Three-Point Editing

Three-point editing is useful for subsequently inserting clips in Sequences and replacing clips. After you have 
defined three editing points, Pinnacle Liquid sets the fourth. See also “Mark-In and Mark-Out Priorities” on 
page 9-41.

Replace an edit in an existing Sequence as follows (see example below ; the video clip is to be replaced, while the 
audio Track is to remain intact):

1 Select Overwrite Style since you want to overwrite the clip on the Timeline.  page 9-25

2 Set the audio Tracks inactive (using the shortcut menu or by clicking the Track name).  page 9-17

3 Define a mark-in and mark-out of the clip to be replaced with the mark-in and mark-out points on the 
Timeline. 

4 Load the clip to be inserted in the Source Viewer and define the incoming point with mark-in or the 
outgoing point with mark-out. 

5 Click the Insert Arrow button.  page 9-42

6 After you have set three edit points, the fourth is automatically defined, i.e. the clip is inserted based on 
the mark-in and mark-out of the Timeline.
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If you define all four editing points, the mark-out in the Source Viewer is overwritten by the correspond-
ing Timeline mark-out.

Name 1

Name 2

Name 3

Name 1

Name 2

Name 3

Before insertion

After insertion

inactive

inactive
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Timeline Editing

Whether you choose to edit with the Sequence Editor or work directly on the Timeline depends on the particular 
application and your personal preference. Both are possible in Pinnacle Liquid. You can even use a combination 
of the two methods.
This section tells you how you can edit and trim directly on the Timeline. It describes the following areas in 
detail: 

Timeline edit functions  page 9-55

Adding objects

Drag&drop; Send To...; Transitions  page 9-56

Selecting objects

With the mouse; keyboard; selecting objects after the Playline  page 9-57

Repositioning objects

Positioning; moving and copying a range  page 9-58

Trimming objects

With the mouse; keyboard; Extend and Slide tools  page 9-60

Deleting objects

Deleting objects or ranges  page 9-62
Volume II Chapter Edit9 - 54



PINNACLE

Video Editing
Timeline Edit Functions

The toolbar is located at the top of the Timeline and contains buttons for navigating on the Timeline and play-
ing, marking and processing clips and Sequences. This toolbar can be customized like any other Pinnacle Liq-
uid toolbar. (See also “Customizing Toolbars” on page 17-8.) 

E d i t  B u t t o n

Click this button to activate the Edit Mode of the mouse cursor. This mode permits you to access elements on 
the Timeline so that you can, for example, select, trim and delete objects.

� Press the ALT key to temporarily switch between cursor Edit Mode and scrub mode.

When the Edit Mode is deactivated, you can scrub the Playline with the cursor.
To scrub on the Timeline when the Edit Mode is activated, drag the mouse pointer on the Timecode Bar.

A d d  E d i t  ( R a z o r  C u t )

Adds a cut to all active Tracks at the current position of the Playline. Adding a cut splits the affected clips into 
two separate clips with new mark-in and mark-out points.

The Picons at the new mark-in and mark-out points are updated automatically

T r a s h

Deletes a range between the mark-in and mark-out points.  page 9-62

T o g g l e  E d i t  S t y l e

Click this button to toggle between Overwrite Style and Film Style. Film Style is indicated by a yellow icon, Over-
write Style by a red icon.  page 9-25

D o u b l e - C l i c k  a  C l i p

Double-click a clip on the Timeline to open the Clip Viewer with the extended dialog.
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Adding Objects 

There are various ways to position objects on the Timeline in order to edit a Sequence (other objects already on 
the Timeline are overwritten or shifted depending on the Edit Style specified - see “Edit Styles”  on page 9-25).

D r a g & D r o p

By dragging: you can drag objects directly to the Timeline from the Project window, Clip Viewer, Source Viewer 
(hold down the CTRL key) and desktop. They are positioned where you drop them.
With this method, Source Track Mapping is ignored ( page 9-22).

Objects that you drag and drop on the Timeline remain grouped, i.e. a video clip that has two audio 
Tracks is inserted on the Timeline as one object. You can, however, disband the object, i.e. dismantle it 
into single clips  page 9-66

S e n d  To . . .

Using the Send To... option in the Object shortcut menu: objects are positioned on the Timeline at the Playline 
position. 
With this method, Source Track Mapping is adhered to (see also Source Track Mapping on page 9-22).

I n s e r t i n g  T r a n s i t i o n s

 page 9-34
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Selecting Objects

To process objects on the Timeline, for example, to copy, move or delete them, they first have to be selected.
Selected objects appear “recessed” on the Timeline.

C l i c k i n g  O b j e c t s
Click the Edit Mode button on the Timeline toolbar to put the mouse cursor in the necessary mode for selecting 
objects (= Edit Mode).

� To temporarily switch to Scrub Mode, hold down the ALT key.

The type of mouse pointer reveals what mode the system is in.  page 9-10:

When the Edit Mode is activated, you can access objects on the Timeline and select them with a click of the 
mouse. 

� To select more than one object at once, SHIFT+click the required objects. To select a number of 
objects (e.g. such located next to each other on the Timeline), SHIFT+click the first and last one 
of this row. The ones in between are automatically selected. 
This function works with all Tracks.

D r a g g i n g  a  L a s s o
You can also select several objects by dragging a Lasso around them with the mouse. To do this, begin dragging 
in an area of the Timeline Tracks that is not occupied by any objects and release the mouse button once the Lasso 
contains parts of all objects you require. It is sufficient that the Lasso line only touches objects to be selected.

S e l e c t i n g  O b j e c t s  a f t e r  P l a y l i n e
Use this function to select clips of an active Track or of several active Tracks located after (= to the right of) the 
current Playline position. 

If you want this selection to be valid for all objects (on all Tracks), activate all Tracks via Activate All in the Track 
Header of the name column. This selects also those objects over which the Playline is located.

M a r k  a n d  S e l e c t  C l i p  U n d e r  P l a y l i n e
Clips which intersect with the Playline and are placed on active Tracks can be highlighted in two ways, using 
two functions:

� Mark clip(s) under Playline -
Sets a mark-in and a mark-out at the first possible and the last possible range of the clip(s) involved. 
This can be, e.g. in the case of long sound clip, quite a big range. The clip(s) itself are not selected.

� Select clip(s) under Playline -
Works the same way a single click on a clip works. No mark-in and mark-out are set.
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These two functions can only be executed via the keyboard and are not part of the standard keyboard 
layout. If you want them, you have to set up the keyboard shortcuts: Go Edit > Control Panel > User > 
Keyboard. From the list in the upper left area select the Timeline/Master Viewer section, and then on the 
right of the tool box the All others tab. The “T special” down below in the list hides the two desired func-
tions. Drag the Ts to a key of your choice (works also in combination with ALT or SHIFT or CTRL).

Repositioning Objects

To reposition objects on the Timeline they must first be selected (see also Selecting Objects on page 9-57). Once 
selected, objects can be repositioned in a variety of ways. 

P o s i t i o n i n g

Activate the Edit Mode to drag selected objects to a different Track or a different position on the same Track. 
Two functions help you position the objects, Align and Snap Mode.

Nothing in the Timeline changes while you are dragging the object; only after you release the mouse 
button and the object can be inserted does the Timeline rearrange itself.
In other words, in Film Style, subsequent objects move to close the gap created by the movement. In 
Overwrite Style, the gap remains open. Clips are also rearranged behind the insertion point (in Film 
Style), while it is simply overwritten in Overwrite Style.
Please also note this Film Style peculiarity: If, for instance, you want to move a clip one frame to the 
right, the clip has to be dragged over its full length plus one frame to the right. Otherwise the clip will 
revert to its original position when you release the mouse button.

If the area of the Timeline where you want to move an object does not currently appear on the screen, 
drag the object in the direction of this area until the Timeline has scrolled to it.

Align

Use the Align function to align clips: the default insert point for clips is at the left edge; for Transitions, the mid-
dle. 

� Press the ALT key repeatedly while dragging an object to toggle between the three available 
insert points: beginning (mark-in), middle and end (mark-out) of the clip/Transition. 

Insert point at mark-in Insert point at center Insert point at mark-out
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Snap Mode

Another tool available for precision positioning is the Snap Mode. Use this function for frame-accurate align-
ment of objects. 

� Hold the SHIFT key while dragging a clip. A magnet symbol appears at the mouse pointer. On 
getting close to a possible Edit point, the clip will be positioned precisely at the Edit. 
Snap and Align can be used in combination: Hold the SHIFT key and, hitting ALT, toggle align-
ment modes.

The Snap Mode can be permanently enabled: see “Timeline Properties”  on page 9-7.

Moving Objects with your Keyboard

� Vertically -- to be able to move an object vertically, for example Track by Track, select it and press CTRL 
+ ARROW UP/DOWN. 

� Horizontally -- the object keeps its exact horizontal position, an audio clip, for example, remains syn-
chronous. Use CTRL + ARROW LEFT/RIGHT to move an object frame by frame to the left or right or 
SHIFT + CTRL + ARROW LEFT/RIGHT to move it ten frames at a time.

� For additional and customized key assignments, 
see “Assign Functions to Keyboard”  on page 17-11.

Copy/Cut and Paste

Use the Paste function to reposition clips from the clipboard (after Copy or Cut;  page 9-59). 
This information applies to actions within the same Sequence; otherwise, refer to the note below.

1 Position the Playline where you wish to insert the clip.

2 From a suitable Track, call the Timeline shortcut menu (right-click an empty area on the Timeline).

3 Click Paste. 

While performing this operation, keep in mind the following:

� Edit Styles (Overwrite or Film)

� Available and free Timeline Tracks. If you insert several vertically arranged clips, the highest clip will be 
inserted in the Track from which you called the shortcut menu and the others will be inserted in the 
Tracks below it. If there are not enough Tracks, nothing is inserted.

When a clip is inserted in a different Sequence, the procedure is as follows: The clip (or clips) is (are) 
inserted in active Tracks. If nothing happens when you select the Paste command, check to be sure the 
destination Tracks are also activated for editing.
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M o v e / C o p y  R a n g e

You can use these two functions to quickly and easily rearrange sections on the Timeline. Simply use the follow-
ing procedure:

� Activate the Tracks containing the affected objects.

� Use mark-in and mark-out points to mark the section.

� Position the Playline where you wish to insert the marked section.

� Copy Range inserts a copy of the section; Move Range transports the section from its original position to 
the new one.

The results vary according to the edit style:

� Copy Range overwrites (Overwrite Style) or moves the subsequent objects (Film Style).

� Move Range overwrites information (Overwrite Style), or moves the subsequent objects (Film Style). In 
Overwrite Style, a gap remains at the original position. In Film Style, the subsequent objects move and 
fill the gap.

Trimming Objects

Trimming involves shortening and lengthening Timeline objects. There are various ways to do this:

How trimming affects other objects on the Timeline depends on the Edit Style you have selected (see 
also Edit Styles on page 9-25)
If you are working in Overwrite Style, trimmed objects delete whatever was previously at a given posi-
tion on the Timeline or create gaps. 
If you are working with Film Style, trimmed objects shift other objects on the Timeline (objects are rip-
pled or moved).

Tip: When trimming audio clips, press the SCROLLLOCK key to activate audio scrubbing and locate edit 
points more easily  page 13-11.

T r i m m i n g  U s i n g  t h e  m o u s e
You can use the mouse to trim objects on the Timeline if Edit Mode is activated for the mouse pointer 
( page 9-55). 

When the mouse pointer is near the mark-in or mark-out of a clip or Transition, the arrow is accompanied by a 
mark-in or mark-out symbol. This means that you can trim the object by pressing the left mouse button. 
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T r i m m i n g  w i t h  t h e  K e y b o a r d
First select clip-in or clip-out, then:
CTRL + ARROW RIGHT/LEFT allows trimming by one frame each; SHIFT-CTRL + ARROW RIGHT/LEFT by ten 
frames each. As described above, several edits can also be selected and trimmed.  page 9-57

� For additional and customized key assignments, 
see “Assign Functions to Keyboard”  on page 17-11.

E x t e n d  T o o l
The Extend function allows you to quickly trim (lengthen/shorten) one or more clips to a specific point:

1 Activate the Track(s) where the clip or clips are located.

2 If you specify the trim point using a mark-out, you can lengthen the previous edit by clicking on the 
Extend function.
If you specify the trim point using a mark-in, the following edit will be given preference.

3 Mark-in and mark-out points of the affected edits are moved equally, thus ensuring that the Extend 
function does not affect synchronicity (as is the case with Trim Both in the Trim Editor). 

If there is insufficient material to work with, Extend is only carried out to the extent allowed by the existing clip 
data. If mark in and mark out points are set, the last point to be set is taken into account.

S l i d e  To o l

The Slide function allows you to move one or more clips on a Track without resulting in gaps to the left or right 
of the clip or clips. In other words, this function trims the mark out point of the clip located before the selection 
and the mark in point of clips located after the selection. You can activate the Slide function as follows:

1 Mark the clip or clips using the Lasso function or using CTRL+click or SHIFT+click.

2 Activate the Slide function by clicking on the icon, or call the function from the Customize list (right 
mouse-click on the toolbar of the Timeline or Master Viewer). If the function is not located on the tool-
bar, you can retrieve it from the function library using the Customize command.

3 Use the mouse to drag the clip or clips to the desired position. You can also use the keyboard to trim the 
clip (CTRL + LEFT ARROW/RIGHT ARROW).
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Deleting Objects

When deleting objects, note the Edit Style:

- Overwrite Style: deleting an object does not affect the other objects on that Track. The deleted object just leaves 
a gap in the Track equal in size to its duration.  page 9-25

- Film Style: elements later on the Track ripple forward to fill in the gap left by the deleted object(s).  page 9-26

Transitions are deleted from the Timeline without affecting any other objects or leaving gaps.
Timeline objects are removed from the Timeline only; deleting them does not affect Media Files or 
objects in the Project.

D e l e t e  S i n g l e  O b j e c t

To delete an object from the Timeline, first mark it and then press the DEL key or select Delete from the shortcut 
menu.

D e l e t e  S e v e r a l  O b j e c t s

To select more than one object, CTRL+click or SHIFT+click the objects or drag a Lasso around them. Once 
selected, you can use the DELETE key to delete the selected objects. All Transitions connected with these clips 
are also deleted.

D e l e t e  T i m e l i n e  R a n g e

With mark-in and mark-out points set, click the Trash button to delete everything between the mark-in and 
mark-out, except elements on Tracks not active or protected. Elements that overlap the mark-in and mark-out 
points are trimmed and/or split into pieces.
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Objects on the Timeline

The objects on the Timeline are video clips, audio clips, Containers and Transiti-
ons. Like all other objects, they each have their own shortcut menu. (See also 
“Object Information: Properties” on page 8-66.) This section provides you with 
information on Timeline-specific functions, i.e. functions that are important for 
working with objects on the Timeline.

Right-click a clip to open its shortcut menu.

C l i p  I n f o

“Clips” refers to all objects that contain image and/or audio data. 

When you rest the cursor on a clip for a second a pop-up with clip information 
appears. To control what information this pop-up contains, use the Track Name 
and Column Headers shortcut menus (see also Adjusting All Tracks (Track Name 
Header) on page 9-13). 

Clip with clip information

O p e n  ( D o u b l e - c l i c k )

Calls the Clip Viewer with extended dialog (Attributes).

S e t  C l i p  M a r k e r

Set Clip Marker inserts a clip marker at the Playline.

D e l e t e  C l i p  M a r k e r

Delete Clip Marker deletes the clip marker at the Playline.

Timeline clip Shortcut 
menu
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Z o o m  To  C l i p

Zoom To Clip zooms Timeline display to approximate clip length. 

C u t

Cut deletes a clip from the Timeline and moves it to the clipboard.

As long as a clip is not inserted at another position, it appears on the Timeline with a grid over it.

C o p y

Click Copy to open a submenu:

� Copy the selected clip(s) to the clipboard.

� Copy the volume/panning settings, if any.

� If you hold down the CTRL key while dragging an object, a copy is created and a plus symbol 
appears next to the mouse pointer.

P a s t e

Click Paste to open a submenu:

� Clip FX - Click to insert a previously copied clip effect (from Clip FX shortcut menu > Copy)

� Volume/Panning - Select to insert the corresponding audio settings.

D e l e t e

Delete eliminates a clip from the Timeline.

R e n a m e

Use Rename to assign a different name to a clip. 

E x p a n d  C l i p  ( T o  A v a i l a b l e  M e d i a )

Expand Clip is available only for subclips with individual clip-ins and clip-outs. Subclips are clips that have 
already been defined as such in the Logging Tool or have been digitized with a Handle Length in a Batch Digitize 
operation ( page 6-39).

Select one or more clips and call the function from the shortcut menu.

Expand Clip makes the media file of the clip completely available for trimming the clip on the Timeline.

Each clip can be trimmed to its clip-in and clip-out points, but not beyond. However, with a subclip, by defini-
tion, there is digitized material beyond these points available. Expand Clip lifts the initial limitation of the sub-
clip by expanding the clip’s boundaries to the media file’s clip-in and clip-out.
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B a t c h  D i g i t i z e  C l i p ( s )
Batch Digitize Clip(s) calls the Batch Digitize module ( page 8-77) for the clip(s) selected and allows you to digi-
tize one or more clips directly from the Timeline (capture). 

Tip: What do you do if...
... you are editing and you notice that a clip you digitized is too short? Easily solved! Supply the source 
tape (Reel), select Batch Digitize from the clip shortcut menu to display the Batch Digitize dialog box 
and enter a generous Handle Length.
After digitizing is complete, return to the Timeline and select Expand Clip(s) from the clip shortcut 
menu. You can now extend the clip you just digitized at the mark-in and mark-out.

C l i p  U n d o
Clip Undo cancels the last action(s) you performed on a clip on the Timeline. You can cancel up to 64 steps.

C l i p  R e d o
Clip Redo cancels the last undo(s) you performed. You can cancel up to 64 undos.

M a t c h  F r a m e  ( To  T a p e ,  P r o j e c t  o r  C l i p )

Match Frame To Clip

Loads the corresponding original of a Timeline clip into the Source Viewer.

1 Position the Playline on the desired image. 

2 Right-click the clip to open the shortcut menu.

3 Select Match Frame.

 The Playline position in the Source Viewer corresponds to the position of the Playline in the clip on the Time-
line. 
Optionally, a mark-in can also be set. See “Timeline Properties” on page 9-7.

You can use Match Frame e.g. to load a clip and to re-insert its audio source Track in case a clip audio Source 
Track was not inserted on the Timeline or if it is not in sync.

Match Frame to Project

Same procedure as Match Frame to Clip, but selects the original clip in its original Project Rack. Note: Does not 
select a clip in the Timeline Project Browser. Look in the Project window for the located clip.

Match Frame is not available for clips that have been copied from other Projects into the current Project.
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Match Frame To Tape

Rolls a tape in the player to the same position that the Playline occupies on the corresponding Timeline clip.

1 Position the Playline on the desired image. 

2 Insert the correct tape in the player, open the Logging Tool.

3 Right-click the clip to open the shortcut menu.

4 Select Match Frame.

The player now cues up to the defined position.

Match Frame to tape works on the assumption that clips were digitized (captured) with a tape-related 
timecode source. It works not with: imported or captured clips without a valid TC; clips captured from 
a non tape-based Live source; and Containers generally.

E a s y  F r e e z e  F r a m e

Creates a freeze frame (still image) at the Playline position.

1 Move the Playline to the frame you want to freeze.

2 Right-click the clip to open the shortcut menu, select Freeze Frame.

3 The still now overwrites the remaining length of the clip. You can extend or shorten the freeze to any 
length.

At the end of a clip (last frame position), the resulting freeze will have exactly one frame of length. You can 
extend or shorten the freeze to any length.

C o n t a i n e r

You can use the Container functions to nest Sequences.  page 9-112

I t e m  L i n k

You can group clips on different Timeline Tracks. See also “Item Link” on page 9-80.

D i s b a n d  C l i p

Clips that were inserted on the Timeline as a grouped or linked clip, including video and audio Source Tracks, 
are disbanded on the Timeline via a shortcut menu command. The underlying free Tracks are used for this. If 
there are objects on the underlying Tracks, additional Tracks are automatically created. One clip each can be 
disbanded in one process.

Disbanding a stereo-audio clip creates two mono clips whose panning is centered. The volume level 
increases by 6 dB.
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Disband Several Selected Clips

If several clips are selected, they are disbanded in parallel. You can activate this function in the shortcut menu of 
any selected clip.

The objects created by disbanding are linked (or grouped) in the sense of the Item Link function. If you 
would like to unlink the items altogether (for example, in order to delete a clip), you must use the Item 
Link > Unlink Items function ( page 9-80).

Regrouping Clips / Reactivating Source Tracks

As with any other action, you can undo the clip disbanding operation immediately afterwards. But you may 
also want to undo it at a much later point in time, after performing various editing steps. This is done by restor-
ing the original clip unit. For example:

1 You have disbanded a clip originally grouped as VA1A2, thus creating three objects on the Timeline: 
One video clip and two audio clips.

2 Right-click, for example, the audio clip A2 to open Properties. Under Tracks, only A2 is activated.

3 Click V and A1 and exit Properties.

4 Instead of the audio clip, the Timeline now contains the original VA1A2 clip, which functions as a “full-
fledged”, grouped clip.
You can delete the other components of the reanimated clip as appropriate.

Actually, a clip always retains the “memory” of its original, complete state. This characteristic also explains why 
disbanded audio clips carry the effect lines of video effects. Although you might at first wonder what an audio 
clip has to do with a video effect, it only takes a single click to turn it back into an effect video clip.

A d j u s t  A u d i o

This menu option is visible only if the Audio Editor is open and the clip is an audio clip or contains audio. For a 
detailed description, see “Global Modification of Volume and Panning (Adjust Audio Function)”  on page 13-59. 

X S e n d  t o . . .

See “XSend To...” on page 7-9.

A d d  L i n e a r  T i m e w a r p

This functions calls the Add Linear Timewarp dialog. Use it, for instance, to quickly create a slomo or a freeze. 
See “Linear Timewarp” on page 12-45.
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F X  P r o p e r t i e s

The FX Properties provide information on and access to the effects applied to an object. You can activate and 
deactivate effect parameters and clip Attributes. 
The effect editors are listed below the horizontal line, the attributes above the line.

FX Properties dialog box

� Activating and deactivating parameters and Attributes:
Click the appropriate checkboxes. Double-click an entry to open the Effect Editor or Clip Viewer.
The effects are not deleted; they are simply not applied. This allows you, for example, to prevent render-
ing.
The colored line on the upper edge of the Timeline clip (indicating the effects and Attributes applied to a 
clip) appears interrupted if effects are deactivated.

� The clip effect list contains all effects applied on a clip. You can control the order in which effects are 
applied to a clip by rearranging the order of the effects in this list. To move an effect, click it and then 
click Move up or Move down.

Order is important, for example, in the case of GPU and CPU realtime effects. Maximum system per-
formance (maximum number of realtime effects) is achieved when CPU effects are applied before GPU 
effects (CPU at the top of the list; see  page 11-26).

You can also change an effect’s settings using the FX Properties shortcut menu:

Trash

Move up

Move down

Clip effect list

Undo Redo

List of Attributes
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Edit 

Select Edit or double click the Editor’s name to open a particular Effect Editor and edit an 
effect ( page 10-13.)

Undo

Click Undo to cancel a change you made in the FX Properties (you can also do this by clicking the Undo button).

Redo

Click Redo to cancel an Undo action (you can also do this by clicking the Redo button).

Remove Effect

Click Remove Effect to delete an effect from a clip (you can also do this by clicking the Trash button).

P r o p e r t i e s

Click Properties to open the Clip Properties box with information on the current clip. Most items (such as Name, 
Source Tacks, Comments, etc.) can be edited, even for multiple clips. (See “Object Information: Properties” on 
page 8-66.)

T r a n s i t i o n s

Transitions (Transition effects such as dissolves) are also objects.  page 9-34.

FX Proper-
ties menu
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Trim Editor

Of course, if you want to more precisely trim cuts once you have finished raw editing a Sequence on the Timeline 
or while you are inserting clips in a Sequence, you can do this with the Timeline or Source Viewer. However, if 
you want to see the mark-out frame of the outgoing clip and mark-in frame of the incoming clip side-by-side so 
that you can, for example, coordinate movement in the pictures for a perfect Transition, then you should use the 
Trim Editor.

Opening the Trim Editor/Basics  page 9-71

Selecting a trim mode  page 9-72

Customizing digital audio scrub  page 9-73

Selecting multiple trimming points  page 9-74

Trimming (examples)  page 9-74

Selecting previous or next edit  page 9-76

Trim Editor tool buttons  page 9-76

 Liquid Control  is an excellent addition to the Trim Editor. It will allow you to perform all your 
trimming functions with the fingers of one hand while giving your undivided attention to the image 
( page 17-18).

Trim Editor

Duration of incoming clipEdit point on the TimelineDuration of outgoing clip Shortcut menu

TC +/- of trimmed frames Incoming frameOutgoing frame Toolbar

Choose trim point 
Volume II Chapter Edit9 - 70



PINNACLE

Video Editing
Opening the Trim Editor/Basics

To open the Trim Editor, click the Open Trim Editor button on the Timeline’s toolbar (or F5). 
The Playline automatically moves to the closest edit on an active Track. This edit and also edits on other active 
Tracks at the exact same timecode position are activated for trimming. Furthermore, yellow handles appear in 
the mark-in and mark-out areas to be trimmed on the Timeline.
Please note that the waveform display of audio clips slightly impairs the performance.

Trim operations in the Trim Editor are always in Film Style. 
When displaying clips, the Trim Editor ignores realtime effects that were applied to the clips to be 
trimmed. The inlays show the original video. We recommend that you first trim the clips precisely and 
then apply the effects.

E l e m e n t s  o f  t h e  T r i m  E d i t o r

The following are the most important functions and elements of the Trim Editor:

Previewing the Edit

In Preview mode, the video inlay plays an Edit in a continuous loop. You can use Preview Range in the shortcut 
menu to enter a duration.  page 9-77

Inlays

The Trim Editor consists of the left and right video inlay. The left inlay shows the mark-out of the outgoing clip; 
the right inlay, the mark-in of the incoming clip. 

Timecode Displays below Inlay

The two timecode indicators below the video inlays show the current shift in the mark-in/mark-out since the 
edit point was selected. This indicator is reset to 00:00:00:00 with every new edit. For example, if you shortened 
the outgoing clip by 15 frames, - 00:00:00:15 appears in the timecode indicator. 

Timecode Displays above Inlay

The three timecode indicators above the video inlays provide the following information (from left to right):

� current duration of outgoing clip 

� timecode of editing point on the Timeline (master TC)

� current duration of the incoming clip
Volume II Chapter Edit 9 - 71



PINNACLE

Video Editing
P r o t e c t e d  a n d  I n a c t i v e  T r a c k s

Protected Tracks and inactive Tracks are handled differently during trimming (see also Trimming with the Trim 
Editor on page 9-94):

� If all Tracks are protected or edit-inactive, no edit is available. The Playline remains at its current posi-
tion when you open the Trim Editor. 

� If more than one Track is edit-active, when you open the Trim Editor the Playline moves to the next edit 
and deactivates all other Tracks for the current trim.

� If you open the Trim Editor, then switch an edit-inactive Track to edit-active, the closest edit on that 
Track is selected for trimming. The other Tracks are set edit-inactive.

Selecting a Trim Mode

When the Trim Editor is opened it is initially in Trim Both mode. Two other modes are also available: Trim Out-
going Clip and Trim Incoming Clip.

In the Trim Editor window, a bar below the inlays shows which of the clips is activated for trimming. In the 
default setting (Trim Both) a bar appears under both inlays.

� Trim Both means that both the mark-out of the outgoing clip and the mark-in of the incoming clip are 
trimmed. This is also indicated by the yellow handles in the mark-in and mark-out areas of the clips. 

To select one of the three trim modes:

� Trim Outgoing Clip: Click the outgoing clip in the left video inlay.

� Trim Incoming Clip: Click the incoming clip in the right video inlay.

� Trim Both: Click the area between the video inlays to select both the outgoing and incoming clips.

You can also activate the trimming points on the Timeline by clicking a mark-in or mark-out point.

Handle
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Customizing Digital Audio Scrub

To the left and right of the timecode fields, you will find editing fields in which you can enter the range (in 
frames) for digital audio scrubbing ( page 13-11). These fields allow you to edit audio frame by frame in the 
Trim Editor.
Note the following:

1 You can activate or deactivate digital audio scrub by pressing the SCROLLLOCK key.

2 Scrubbing is then applied to the Tracks activated for audio scrubbing. To activate these tracks, hold 
down the SHIFT key and click the Speaker icon for the Track(s) containing the audio clips you want to 
scrub. 
You can activate up to two Tracks for scrubbing. These Tracks are identified by the fact that their Speaker 
icon appears as a contour (not filled in).

3 Please note: digital scrub is per default activated. 
(Use the shortcut menu (right-click next to the Audio Tool icon on the Taskbar) to toggle scrub modes 
when editing in the Timeline. The Trim Editor features digital scrub only.) 

D = Digital Scrub enabled

� The value entered defines the length of the playback loop. A value of 0 means that no frames are played 
back and a value of 4, for example, means that the audio for 4 frames is played back.

� The left-hand field applies to audio of the Outgoing Clip and the right-hand field to the Incoming Clip.

For more information, refer to“Audio Scrubbing - Digital or Analog”  on page 13-11 and “Audio Settings”  on 
page 13-67.
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Selecting Multiple Trimming Points
You can simultaneously trim several edits on different Timeline Tracks. This is useful, for example, to trim 
audio on several Tracks at the same time. 

Select several edits as follows:

� If the edit points are on different Tracks, but at exactly the same Timeline position, the Trim Editor will 
automatically select all edits at exactly this position on all active Tracks. 
The same thing happens when you use the GoTo Next/Previous buttons for moving to a certain edit.

� If the edits points are at different Timeline positions, SHIFT+click the mark-in and mark-outs on the 
Timeline. You can also select mark-ins and mark-outs on different Tracks.
Tracks that are not active for editing are temporarily activated for this trim operation. Afterwards, they 
are deactivated again.

When you select multiple edits for trimming, the edit with the highest Track priority on the Timeline appears in 
the Trim Editor video inlays. 

Trimming (Examples)
With single or multiple edits selected for trimming, you can trim the mark-in and mark-out point(s) with the 
tool buttons or by scrubbing the Timeline or video inlays. As you trim, the video inlays in the Trim Editor win-
dow are updated to display the current mark-in and mark-out points. 
Scrub the mouse in the left inlay to trim the outgoing frame(s). Scrub in the right inlay to trim the incoming 
frame(s). 

S i n g l e  T r i m
If you are only trimming the outgoing clips or incoming clips, the duration of the clips and the position of the 
subsequent clips change. For example, if you lengthen a clip by 15 frames, the subsequent clip is rippled by 15 
frames and Sequence duration is increased by 15 frames.

Single trim 
Moving the Playline when the Trim Editor is open trims the selected clips. 

Before

After
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T r i m  B o t h

When trimming both the outgoing and incoming clip, their duration change since the edit moves on the Time-
line. However, the subsequent clips stay in the same position and Sequence duration remains unchanged. 

Trimming both 

S l i p  C l i p

Click the Slip Clip button to choose both the mark-in and mark-out of a selected clip.

When Slip Clip is activated, both the mark-in and mark-out of one clip are trimmed and shifted by the same 
number of frames in the same direction. This means that the positions of the mark-in and mark-out of the clip 
are maintained on the Timeline, the positions of the mark-in and mark-out on the clip are shifted without 
changing the duration.

Since duration does not change, the Slip Clip mode has no effect on subsequent clips on the Timeline. 

Slip clip moves the content of Clip B, 
but not the mark-in and mark-out on the Timeline

Before
After

� � � � � � � � 	 
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� � � � � � 	 
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Clip A

Clip A

Clip A

Clip B

Clip B

Clip B

Clip C

Clip C

Clip C
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Selecting Previous or Next Edit

To change edits, click GoTo Next or GoTo Previous. This causes the Playline to jump to the closest edit after or 
before the current edit, and the selected handles appear on the newly selected edit. The Trim Editor video inlays 
change to display the new outgoing and incoming frames. 

� When you select a different edit, the system automatically deactivates the Slip Clip mode and returns to 
Trim Both mode.

� Edits on protected or inactive Tracks are ignored. 

Trim Editor Tool Buttons

The Trim Editor has the following tool buttons:

T r i m m i n g  B u t t o n s

These tools move the currently selected mark-in/mark-out(s) back or forward on the Timeline. You can select 
the mark-out of the outgoing clip, the mark-in of the incoming clip, or both, for trimming.

Trim 1 Frame Back - moves the selected edit one frame back.

Trim 1 Frame Forward - moves the selected edit one frame forward.

Trim 10 Frames Back - moves the selected edit ten frames back. 

Trim 10 Frames Forward - moves the selected edit ten frames forward.

R e s t o r i n g  a n  E d i t

You can use the Undo/Redo buttons in the Trim Editor to undo/redo the steps you performed since opening the 
Trim Editor. To restore an edit to the state it was in before you opened the Trim Editor, click the Restore Edit but-
ton.
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O p t i o n s

Show only full result 

With this option enabled both Trim Editor viewers will always show the complete, composited image, that is, 
including all effects and layered images from above and beneath the current edit point.
If disabled, initially and for about one second, only the source video from the left and the right of the edit will 
be displayed, and then the full composition. In the case of very complex compositions around a trim point, it 
can make good sense to disable this option. Trimming will then be a bit smoother.

Preview Range

Enter a value for the length of the preview loop.
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Special Functions

This section describes the functions that are not generally needed every day but can be very useful for specific 
tasks.

Sync Lock

Sync Lock combines objects on different Tracks (and that’s all objects on these Tracks) to prevent them 
from being moved relative to each other to avoid unwanted asynchronous audio. This, however, only 
makes sense in Film Style and has corresponding effects. A white dot in the column indicates if a Sync Lock 
is activated for a Track.

A c t i v a t i n g  S y n c  L o c k

Click the Sync Lock column (to be found in the Track Header area at the beginning of the Timeline) to acti-
vate Sync Lock for the respective Track. Click Sync Lock again to deactivate it: the white dot disappears. 
Sync Lock can also be activated/deactivated in the respective shortcut menu. You can activate/deactivate 
Sync Lock for all Tracks in the Sync Lock column head via the shortcut menu.

Sync Lock has a direct influence on your work on the Timeline and in the Trim Editor. 

S y n c  L o c k  i n  F i l m  S t y l e

In Film Style it is not possible to move an object on a synchronized Track. A Quick Info box appears: This Object 
Cannot Be Moved. 
You can now check the intended operation, deactivate Sync Lock, if necessary, or change to Overwrite Style and 
perform the move.

Please note that, when trimming in Film Style, object parts may be deleted or gaps be entered if Sync 
Lock is active. This is to guarantee the synchronicity of the following objects. 

S y n c  L o c k  i n  O v e r w r i t e  S t y l e

Sync Lock is not active in Overwrite Style, since in that case trimming of objects does not cause the moving of 
other objects, and thus no asynchronicities. 
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S y n c  L o c k  /  E x a m p l e s

All displayed Tracks are Sync Lock-active in the following examples:

Trim Mark In to the Left (Lengthening)

Trim Mark In to the Right (Shortening)

Trim Mark Out to the Left (Shortening)

Trim Mark Out to the Right (Lengthening)
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Item Link

This function can be accessed via the shortcut menu of an object. It allows you to link several objects (clips to 
clips, Transitions to Transitions) to form one group. They remain linked until Item Link is deactivated. 

As long as they are linked, their multiple components react just like a single object: clicking on one selects all 
items belonging to the group as well. If you move one, the other ones move as well. The same applies to the dele-
tion of items. 

Trim functions can be carried out with linked items as well.

The ClipSync function lets you synchronize objects based on various synchronous points such as time-
code, mark-in or Marker ( page 8-90).

I t e m  L i n k  F u n c t i o n s  Ve r t i c a l l y

Item Link functions vertically: you can link an object on one Track to any number of objects on other Tracks. 
These objects, however, need to be positioned on Tracks with a lower priority, that is, have to be on Tracks below 
the single object. 

It is not possible to permanently link objects only to those on the same Track.

L i n k  I t e m s

1 Keep the CTRL key pressed and click on the objects you wish to link.

2 Open the shortcut menu of one of the objects involved and select the option Item Link > Link Item to 
link the objects. If the option is grayed out in the menu (meaning it cannot be selected), the objects are 
probably already grouped (at least in part), or you are attempting to link objects on the same Track.

U n l i n k  I t e m s

1 Click any object of the linked group 

2 Select Item Link > Unlink Item from the shortcut menu to unlink the group; all objects are now inde-
pendent again.

A u t o s e l e c t  L i n k e d  I t e m s

The effect of Item Link can be activated/deactivated for the entire Timeline. You can, for example, edit an indi-
vidual object without having to unlink and relink again the items. This function is mainly used to temporarily 
unlink objects.
Simply click the icon which also indicates whether the Item Link status is active (icon is highlighted) or not 
(icon is grey). 
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D e s e l e c t  I n d i v i d u a l  I t e m s

To temporarily remove an object from a group, select the entire group and then the respective object while 
keeping the CTRL key depressed. 

This option is not a substitute for Autoselect Linked Items: the group itself with all the links remains.

A d d  I t e m  t o  L i n k e d  I t e m s

Click the object of the group and then (while keeping the SHIFT key depressed) on the following object(s). 
Select the function Item Link > Link Item from the shortcut menu of one of the respective objects. Note that 
additional objects from Tracks must have lower priority.

E d i t  o f  L i n k e d  I t e m s

Below, you will find some examples showing the effect certain operations have on linked objects:

Cut linked objects with the razor blade (Add Edit)

Cut linked objects with the razor blade (protected Track)

BEFORE: AFTER:
Cut with the 
razor blade at 

this point

After the cut you will have two 
linked groups

(the dark and the bright one)

BEFORE: AFTER:
Cut with the razor 
blade through the 
two upper objects 

at this point.

These three 
objects are 
still linked

The two objects 
are form a new 

group
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Select a handle of a linked object

Consequences of Cut/Copy/Paste

Copy/Paste of deselected objects

Cut/Paste of deselected objects

BEFORE: AFTER:

If in this group the Mark Out of one object is selected, all Mark Outs of the 
objects of this group are selected automatically as well.

BEFORE: AFTER:Copy of these linked 
objects

After pasting these objects 
remain linked

BEFORE: AFTER:The lowest object is dese-
lected by mouse click + Ctrl

The two copied objects are 
forming a new linked group

BEFORE: AFTER:The lowest object is dese-
lected by mouse click + Ctrl

The two pasted objects are 
forming one group with the 

deselected object
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Editing - Examples and Illustrations

This section again summarizes the various editing options available in Pinnacle Liquid. Certain editing proce-
dures are illustrated with examples.

Creating a Sequence  page 9-83

Overwrite and film styles illustrated  page 9-84

Timeline trimming  page 9-89

Trimming with the Trim Editor  page 9-94

Creating a Sequence 

In order to create a Sequence, you should already have a rough idea of the course of the editing job. A proven 
procedure for non-linear editing is to begin by roughly putting together the Sequence based on contents and 
appearance, for example using a Storyboard, or by arranging the clips in a Rack. 

You can then choose one of three methods for inserting clips on the Timeline:

� via the Insert Arrow using the Sequence Editor  page 9-38

� via drag&drop (Timeline editing)  page 9-54

� via Send To (Storyboarding)  page 8-76
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Overwrite and Film Styles illustrated

The two Edit Styles ( page 9-25) define how the insertion or deletion of a clip or gap will affect the other objects 
on the Timeline:

I n s e r t i n g  a  C l i p  i n  O v e r w r i t e  S t y l e  

When working in Overwrite Style, the inserted clip replaces all objects in the insert area on the Source Tracks 
specified in Source Track Mapping.

Editing with the Insert Arrow

When inserting with the Insert Arrow, the clip in the Source Viewer is inserted on the mapped Source Tracks. See 
“Source Track Mapping”  on page 9-22 for details. 

Example of inserting a video clip (V and A1 Source Tracks).

Name 1

inactive

After insertion

Name 1

inactive

Before insertion

Name 2

Name 3

Name 2
Name 3

V

A1

V

A1
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Editing with Drag&Drop

When inserting a clip with drag&drop, you can insert objects on the Timeline from, for example, the Project 
window or desktop. 

Before insertion

After insertion

Name 1

Name 2

Name 1

Name 2
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I n s e r t i n g  a  C l i p  i n  F i l m  S t y l e

When you insert a clip in Film Style, existing parts of a Sequence are not deleted by the inserted clip. Instead, a 
cut is made at the insert point and the second “piece of film” is attached to the mark-out of the inserted clip. 

Editing with the Insert Arrow

When inserting with the Insert Arrow, the clip in the Source Viewer is inserted on the mapped Source Tracks. See 
“Source Track Mapping”  on page 9-22 for details. 

inactive

Name 1

Name 2
Name 3

Name 3
Name 2

Name 1

inactive

Before insertion

After insertion

V

A1

V

A1
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Editing with Drag&Drop

When inserting a clip with drag&drop, you can insert objects on the Timeline from the Project window or desk-
top. 

D e l e t i n g  C l i p s

Deleting a Clip in Overwrite Style 

When deleting a clip in Overwrite Style, the objects which followed the deleted clip are not rippled and a gap 
which corresponds in length to the duration of the deleted clip results.

Name 1

Name 1

Name 2

Name 2

Before insertion

After insertion

Before deletion

After deletion

Name 1

Name 1

Name 2

Name 2
Volume II Chapter Edit 9 - 87



PINNACLE

Video Editing
Deleting a Clip in Film Style 

When deleting a clip in Film Style, the objects which followed the deleted clip are rippled to fill the space (no 
gap results).

D e l e t i n g  G a p s

There are two ways to delete a gap: 

� Trim the gap on the Timeline until it disappears

� Set a mark-in and mark-out on the Timeline at the beginning and end of the gap. Click the Trash button 
to delete the gap. Make sure you are in Film Style so that the subsequent objects are rippled to fill the 
gap.

After deletion

Before deletion

Name 1

Name 1

Name 2

Name 2
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Timeline Trimming

You can perform the following trimming operations via the mouse or keyboard.

Trimming clips  page 9-89

Trimming Transitions  page 9-93

Simultaneously trimming several objects  page 9-93

T r i m m i n g  C l i p s  

The effect of trimming on other objects on the Timeline depends on which edit style you specified.

The simplest type of trim is the single trim. To perform a single trim, simply click the trim area at the beginning 
or end of a clip and drag the clip in the desired direction. This can also be done in the Trim Editor.

� CTRL + ARROW RIGHT/LEFT allows trimming by one frame each; SHIFT + CTRL + ARROW 
RIGHT/LEFT by ten frames each. 

Single trim in film style  page 9-90

Single trim in overwrite style  page 9-91

Trim both  page 9-92

Slip clip  page 9-92
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Single Trim in Film Style:

Trim mark-out

Clip A

Clip A

Clip A

Clip B

Clip B

Clip B

Clip C

Clip C

Clip C

Trim mark-in

Clip A

Clip A

Clip A

Clip B

Clip B

Clip B

Clip C

Clip C

Clip C
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Single Trim in Overwrite Style:

Trim mark-out

Clip A

Clip A

Clip A

Clip B

Clip B

Clip B

Clip C

Clip C

Clip C

Trim mark-in

Clip A

Clip A

Clip A

Clip B

Clip B

Clip B

Clip C

Clip C

Clip C
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Trim Both

The Trim Both option trims two clips - the mark-out point of the outgoing clip and the mark-in point of the 
incoming clip. The total duration of both clips remains unchanged.

When using Trim Both, it makes no difference which edit style is activated.

Slip Clip

The Slip Clip option modifies the content of a clip on the Timeline by moving the mark-in and mark-out the 
same distance in the same direction. Both duration and position on the Timeline remain unchanged. 

Clip A Clip B

Clip A Clip B

� � � � � � � � 	 
 ��������

� � � � � � 	 
 ��

� � � � � � � � 	

Clip A

Clip A

Clip A

Clip B

Clip B

Clip B

Clip C

Clip C

Clip C
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T r i m m i n g  T r a n s i t i o n s  

Drag the beginning or end of a Transition to move its mark-in or mark-out point. 

S i m u l t a n e o u s l y  T r i m m i n g  S e v e r a l  O b j e c t s

To trim several clips on the Timeline at once, mark the different trim points by holding down the CTRL KEY and 
clicking them. (The selected clips can be at different positions on the Timeline.) Drag one of the handles to trim 
the clips. 

Overwrite style

Film style

Name 1

Name 2

Name 3

Name 1

Name 2

Name 3

Before trimming

After trimming

Name 1

Name 2

Name 3

Name 1

Name 2

Name 3

Before trimming

After trimming
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Trimming with the Trim Editor

Basics  page 9-94

Opening the Trim Editor in different Timeline situations  page 9-95

Going to next/previous edit  page 9-97

Simple trim with the Trim Editor  page 9-98

Adding trims by activating additional Tracks  page 9-100

Manually changing selected trims  page 9-101

Slip clip mode  page 9-102

A trim with Transition  page 9-103

B a s i c s

� The default trim mode is Trim Both. To select a different mode, click either the outgoing or incoming 
clip in the Trim Editor. To reactivate Trim Both, click the area between the two viewers. The trim mode is 
applied to all the edits involved.

� Trimming is always done in film style.

� Click the outgoing viewer to trim the mark-out of the outgoing clip.

� Click the incoming viewer to trim the mark-in of the incoming clip.

Mark-out

Transition

Playline Active Tracks appear 
light grey

Gap on Track

Inactive Tracks 
appear dark grey

Mark-in
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O p e n i n g  t h e  T r i m  E d i t o r  i n  D i f f e r e n t  T i m e l i n e  
S i t u a t i o n s

This section describes the effects of activated/deactivated Tracks and overlapping Edits.

No Tracks Active

� The Playline automatically moves to the closest previous/next edit.

� The Track with the edit is set active.

� Trim Both is activated.

One Active Track 

� The Playline jumps to the closest previous/next edit on the active Track.

� Trim Both is activated.

Edit closest
to Playline

Playline moves 
to the closest 

edit

Mark-in and 
mark-out of 
the edit are 

selected

Track is
now active

BEFORE AFTER

BEFORE AFTER

Active Track Edit closest 
to Playline

Playline moves to the closest 
edit on the active Track
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Two or More Active Tracks 

� The Playline jumps to the closest previous/next edit on an active Track(s).

� All active Tracks which do not have an edit at this position become inactive.

� All edits at same position are selected and Trim Both mode activated.

� All Tracks involved are active.

Two or More Edits at the Same Position

� All edits are selected; Trim Both activated.

� All Tracks involved are set edit-active.

� Tracks that were previously edit-active but do not have an edit at this position are set inactive.

BEFORE AFTER

Edit closest to 
Playline on an 
active Track

Edit closest 
to Playline

Playline moves to the 
closest edit(s) on 
an active Track(s)

These Tracks 
become/remain 

inactive

BEFORE AFTER

Edits closest to Playline 
at the same position

Both edits are selected; 
Trim Both activated

Both Tracks 
are set active
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G o To  P r e v i o u s / N e x t  E d i t  i n  D i f f e r e n t  E d i t  S i t u a t i o n s

These situations occur if the Trim Editor is already opened and you are using the GoTo Previous/Next Edit func-
tion.

One Track Active

� The Playline jumps to the closest edit on an active Track.

� If there is another edit on a different Track at this position it is also selected and the given Track is set to 
active.

Two or More Tracks Active

� The Playline moves to the closest edit on an active Track.

� All active Tracks which do not have an edit at this position are set inactive.

� All Tracks that have an edit at this position are set active; Trim Both mode is activated.

BEFORE AFTER
Closest edit on an 

active Track
Playline moves to

the closest edit on an 
active Track

This Track switches
to active

BEFORE AFTER

Closest edit on an active 
Track

Playline moves to the 
closest edit on one of 

the active Tracks

This Track switches 
to active
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Manually Selecting Trims

� The active Track(s) with the Playline exactly at the edit we call “leading Track(s)” for that trim. The 
active Tracks with manually selected edits we call “secondary Tracks.”

� Click Goto Next/Previous Edit to move the Playline to the closest edit on one of the leading Tracks.

� All active Tracks which do not have an edit at this position are set inactive.

� All Tracks that have an edit at this position are set active and the Trim Both mode is activated.

S i m p l e  T r i m  w i t h  T r i m  E d i t o r

Cases that frequently occur:

Trim Both

� Trim Both is the Trim Editor’s default mode.

� Trimming the edit to the left shortens the outgoing clip and lengthens the incoming clip by an equal 
number of frames. This means the length of the trimmed Track does not change, only the edit point is 
moved. If you move the edit point to the right, the opposite happens.

BEFORE AFTER

Edit at 
Playline

Playline moves to 
closest edit on 
leading Track

This Track switches 
to inactive

Secondary 
Tracks

Leading Track

Trim edit to the 
left or right
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Trim Outgoing

� Trimming to the left or right, shortens or lengthens the outgoing clip.

� Every object to the right of the trimmed edit(s) on the trimmed Track(s) is rippled. As a result, the 
Track(s) gets shorter or longer.

Trim Incoming

� Trimming to the left or right, shortens or lengthens the incoming clip.

� Every object to the right of the trimmed edit(s) on the trimmed Track(s) is rippled. As a result, the 
Track(s) gets shorter or longer.

Trim outgoing clip 
to the left or right

Trim incoming clip 
to the left or right
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A d d i n g  T r i m s  b y  A c t i v a t i n g  A d d i t i o n a l  T r a c k s

By manually setting a Track active (by clicking on the Track name in the Track header area), the edit on the 
Track closest to the Playline of the leading Track is selected for trimming.

Trim State

The edit on the additionally selected Track is assigned the activated trim mode.

BEFORE AFTER

Track is set active. 
Edit automatically

selected for trimming

Track is inactive

BEFORE AFTER

Same trim mode is
activated for this
edit as the edit on 
the leading Track

Trim mode defined for the trim on 
the leading Track is Trim Outgoing

Edit on the 
leading Track
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M a n u a l l y  C h a n g i n g  S e l e c t e d  T r i m s

Click a mark-in or mark-out directly to change selected trims. The type of mouse pointer indicates whether 
Trim Outgoing or Trim Incoming is activated.

Selecting a Mark-In on an Inactive Track

� The Track becomes active.

� Tracks that do not have an edit at this position become inactive.

� The Playline moves to the selected edit.
Depending on which part of the edit you have clicked (left side - center - right side) Trim Outgoing, Trim 
Both or Trim Incoming is activated. You can change the trim mode of an already selected edit the same 
way.

Selecting Additional Edits

SHIFT+click a mark-in and/or mark-out to add an edit to the already selected edits. In this case the Playline 
stays at its actual position. You cannot select more than one edit on the same Track. 

Trimming Mark-In and Mark-Out Simultaneously

It is possible to activate different trim modes for the same group of selected edits (for example, Trim Outgoing 
and Trim Incoming at the same time).

In the example above, when the outgoing clip is trimmed to the left it becomes shorter and when the incoming 
clip is trimmed to the right it also becomes shorter.

BEFORE AFTER

The Playline moves to 
the edit and Trim

Incoming is activated

Click here

BEFORE AFTER
This edit is added to the trim selectionSHIFT+click here
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S l i p  C l i p  M o d e

Activate the Slip Clip mode in the Trim Editor to slip clips. Click the outgoing viewer to slip the outgoing clip; 
click the incoming viewer to slip the incoming clip.

Activating Additional Tracks

It is possible to work with slip clips on different Tracks by activating another Track or by selecting additional 
edit points directly on the Timeline.

The clip which overlaps most of the leading clip (the one which is already loaded in the Trim Editor) and which 
is closest to the Playline will be selected for slip clipping. 

If the leading clip gets slipped, all other clips involved are also slipped. Slipping and trimming at the same time 
is not possible.

Incoming clipOutgoing clip

BEFORE AFTER

Slip Clip mode is activated for this clipThis Track is to be set active

BEFORE AFTER

This mark-in is also selected and Slip Clip 
mode is activated for this clip

Select this mark-out by clicking it
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A  T r i m  w i t h  T r a n s i t i o n

The Transition moves with the edit and remains at the same position in relation to the edit itself.

You can only trim until the Transition of the trimmed edit reaches the next/previous edit or another Transition. 
Otherwise you have to shorten the duration of the Transition.

BEFORE AFTER

Transition moves with the editTrim edit to the left
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Audio in the Timeline

This section contains information on audio editing on the Pinnacle Liquid Timeline. Audio clips basically 
behave the same as any other object, whether in the Clip Viewer, Source Viewer, Master Viewer or on the Time-
line. Nevertheless, there are a few special points that you should note. (For more information on the subject of 
audio, see the section on “Audio Postproduction and Audio Effects”  on page 13-2). 

“Audio” Tracks

Because in Pinnacle Liquid there is no such thing as an “Audio Timeline Track”, it is important to think about 
how you will position the audio before you begin editing. A correctly configured Timeline containing clear 
assignments will help you maintain an overview. By the time you reach postproduction, you will be glad you 
took the time get organized. See “Configuring Tracks”  on page 9-13 and “Audio Playback”  on page 9-12.

Synchronicity

In Pinnacle Liquid, two or more clips are “synchronous” if they have been digitized together. If they are then 
moved with relation to one another, the clips become asynchronous. This can happen, for example, if you 
insert a clip on the Timeline in Film Style when not all of the Tracks are active. In order to avoid this, check the 
following when inserting clips:

� Edit Style - Film Style (objects are moved) or Overwrite Style?  page 9-25

� Active Tracks - When inserting in Film Style, only objects on active Tracks are moved.  page 9-17

Grouped video and audio clips (i.e. video and audio Source Tracks integrated in one clip) are less likely to 
become asynchronous because the audio and video are linked, being embedded in one single object. Two 
methods are available:

� Drag&drop: If you insert clips on the Timeline using the mouse, the audio and video remain linked 
within these clips, meaning that they remain synchronous. For details, see the section on “Timeline 
Editing”  on page 9-54.

� Switch Source Track Mapping to Grouped: Then audio and video clips will also be grouped when you 
insert them on the Timeline using the Insert Arrow. See “The Insert Arrow”  on page 9-42 and “Source 
Track Mapping”  on page 9-22.

You will always have the option of disbanding linked clips later on, for example for audio postproduc-
tion.  page 9-66
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Other functions in Pinnacle Liquid related to synchronicity:

� Sync Break - Indicates a loss of synchronicity both visually and numerically.  page 9-14

� Item Link - Individual objects on different Tracks can be combined in groups to prevent them from 
being moved relative to one another.  page 9-80

� Sync Lock - All the objects on all or specific Timeline Tracks can be linked together.  page 9-78

� ClipSync - This function lets you synchronize objects based on various synchronous points such as 
timecode, mark-in or Marker ( page 8-90).

In the case of complex Sequences, a loss of synchronicity may at first go unnoticed. It is then difficult 
later on to reconstruct the cause. Naturally, you can repeatedly apply the Undo function on the Timeline 
but this will also undo any work that you have done since synchronicity was lost. Often the fastest rem-
edy is to recreate the audio or video clips. Then use the Match Frame function to quickly find the syn-
chronous point.  page 9-65

Volume and Panning

Audio clips have a specific volume (level) and a specific left/right alignment, called panning or balance, 
depending on stereo or mono properties. This information is defined when the clips are digitized or imported, 
along with their stereo or mono characteristics (“Stereo and Mono, Panorama and Balance”  on page 13-8). 
Nevertheless, you can also change these parameters later on.

Note that the volume and panning are not set globally for a Timeline Track; these properties belong to 
the clip rather than the Track. For this reason it makes sense, for example, to position all loud ambient 
sound clips on the same Track. The Tracks can then be deactivated all at once (See also “Audio Playback” 
on page 9-12.) You can also quickly select these clips (“Selecting Objects after Playline”  on page 9-57) 
and adjust the levels en bloc (“Global Modification of Volume and Panning (Adjust Audio Function)”  on 
page 13-59).
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Fade-In and Fade-Out

In order to achieve somewhat smoother audio Transitions before the final mixing, you can use temporary audio 
fades that can then be edited later on. The following options are available: 

� Cross Fade - You can insert a Cross Fade either manually (“ABCs of Effects”  on page 9-34) or automati-
cally (“Add Dissolve”  on page 13-60).

� 1-Click FadeIn/Out - To use this option, the Audio Editor must be open. 
( page 13-17)

Output and Monitor

What you hear when you play the audio on the Timeline depends on a number of factors. 

� The panning or balance (left/right/center) is primarily a clip property ( page 13-5) but can also be influ-
enced in the Audio Editor. It can even be affected by subsequent mixers and switch panels.

� The volume can be influenced by the Audio Tool (output;  page 13-14) and by clips that have been 
adjusted individually. Audio clip effects can also affect the volume level. 

� Liquid blue : A separate, adjustable audio monitor output is featured.
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Special Functions

Matte Track and Track Matte

Matte effects created on a special Timeline Track page 9-108

Consolidate and Condense (Building a Rack from a Sequence)

The Condense function combines all the clips of a Sequence to form a new Rack ( page 8-88); Consolidate creates 
copies of required Media Files ( page 8-85). 

Nesting Sequences (building a Container)

Sequences can be nested on up to ten levels.  page 9-112

Master Viewer: Full-size monitor

Changing to maximum/quarter resolution  page 9-117

Inlay Quality Menu

Setting up the display  page 9-119

Snapshot 

Freeze a Sequence image and save it as BMP file  page 9-120

Multi-Camera Editing

Conveniently cutting between two different synchronous sources  page 9-121
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Matte Track and Track Matte

The Matte Track lets you very easily set up a track matte effect. These effects are key or mask effects, which can 
also be animated.

Step 1: Set up Matte Track  page 9-110

Step 2: Create a track matte (mask)  page 9-110

Step 3: Set up Track Matte effect  page 9-111

A Matte Track is a special Timeline Track that acts like subtrack. See the example:

Foreground / Fill
(Master Track)

Matte Track (mask)

Background (Key)
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And this is the image created by this composition:

Resulting image created by the Matte Track effect
How can this result be explained?
The white X is filled in with the color bar pattern - that’s why the clip above the Matte Track is called “Fill” or 
“Foreground”. The black area around the X is replaced by the background, provided by the clip beneath the 
Matte Track. This is a standard-issue key effect.The X itself is a title clip created in TitleDeko. It’s just the letter 
X, color white, horizontally stretched, on a black = transparent background. This clip provides the alpha plane. 
The Matte Track detects the alpha plane automatically. 
Here is another way of explaining the Matte Track effect:

Matte Track: how it works

Alpha channal =
Matte Track 

(mask)

Background clip

Effect over background

X

Matte Track effect

Foreground/Fill
(Master Track) X

Output result
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Step 1: Set up Matte Track

A Matte Track can be created on any Timeline Track. 

1 Right-click the Name area of a Timeline Track and select Add Matte Track.

2 The Matte Track, in a greenish tint, is added just below the Track. A new column appears. By clicking 
the Minus sign inside the little box you can collapse the Matte Track. 
To delete a Matte Track click the Name area and select Delete Track.
Please note:

� The system automatically detects the presence of an alpha plane in clip placed on the Matte Track. If yes, 
you do not need to add another Track Matte effect. Key and fill will be assigned automatically as well.
If no alpha plane is present, the Track Matte CPU effect in its default state is applied. This, however, 
becomes not visible for the user, no effect line or effect icon appears. If you want to edit the effect, you‘ll 
have to drag the editor from the Rack and drop it on the clip.

� Matte Tracks follow their Master Tracks - if moved vertically as well as when the Master Track is deleted.

� Clips on Master Track, Matte Track and background Track are not automatically linked or grouped. We 
recommend that you link relevant clips together to avoid accidental derangements of your carefully 
constructed effects (see “Item Link”  on page 9-80).

� The Matte Track cannot be named, but otherwise it is a Track like all other Timeline Tracks. 

� You can set up as much Matte Tracks as you like.

� Clips on Matte Tracks cannot be integrated in Containers.

Step 2: Create a Track Matte (Mask)

For a first tryout we recommend the creation of a simple geometric pattern or just even a letter, like in our 
example. You can use TitleDeko to produce that clip, but any other image or video, with or without an alpha 
plan, will do.
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Step 3: Set up the Track Matte Effect

The order of events is not really important. We’ll proceed top-down. Make sure that Video Playback (monitor 
symbol) is active on all three Tracks.

1 Place the fill clip above the Matte Track which you have created in Step 1. This is the image that is going 
to fill in the area defined by the mask.

2 Place the Track Matte clip (mask) from Step 2 on the Matte Track, just below the fill clip.

3 Place the background clip on the Track below the Matte Track.

In many cases that should be sufficient. But - if your Track Matte clip has no alpha, or if you plan to animate the 
mask, the process continues:

4 Drag the Track Matte CPU effect from its Rack Realtime Clip FX > Editors to the clip on the Matte Track.

5 Open the effect editor, select a Keyer Type. 
Linear Luma is suitable for clips without alpha plane but with a distinct contrast between the dark and 
the lighter parts of the image.
Linear Alpha creates the key effect based on the alpha plane information already contained in the clip (if 
that is the case).
Invert swaps what is considered background and foreground. All other parameters are described on  
page 11-35.

6 On to the animation of the mask (we‘ll make it move):
Apply, e.g., the 2D Editor GPU to the matte clip. Taking our example, we could move the X from the left 
side to the right side across the image.

7 If you want the fill (foreground) image to move with the mask, you have to apply the identical motion 
effect to this clip as well (first copy the effect, then use clip shortcut menu > Paste > Clip FX).

8 Add more effects.

Instead of Track Matte CPU you can use other key effects, a Blue Screen Key, for example.
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Nesting Sequences (Building a Container)

If you want to include Sequences as objects on the Timeline, drag them from the Project window to the Timeline 
or the Source Viewer (or use Send To command from the shortcut menu). You can now edit the Sequence just 
like a clip, e.g. include it in another Sequence (building Containers), apply effects or trim it. 

When inserting Sequences, pay attention to possibly set mark-ins and mark-outs since this defines the 
length of the resulting Container clip.

What are Containers?  page 9-112

Building a Container  page 9-113

Stepping into a Container  page 9-114

� Inserting further containers  page 9-115

Editing Containers  page 9-115

Dismantling Container  page 9-116

� Dismantle or step into containers?  page 9-116

Containers are copies of Sequences  page 9-116

What Are Containers?

In Pinnacle Liquid, Containers are Sequences that were integrated in another Sequence. Complete Sequences 
containing an unlimited number of clips and edits can be embedded like objects (i.e. clips) in another 
Sequence. Pinnacle Liquid allows you to edit these Sequences on the Timeline within the main Sequences and to 
move back and forth from the container(s) to the main Sequence with just one mouse-click. This main 
Sequences are the main level; up to ten levels (layers) can be created with this Container method.

The Audio Routing on the highest level applies ( page 13-38). 
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Build Container

You can use the Build Container function to combine a specific segment of a Sequence (or a complete Sequence) 
into a container from within the Timeline. This function can be activated via the toolbar shortcut menu or the 
function icon shown here; it may be necessary to copy the latter from the function library to the Toolbar.
 Define the area to be included in the Container:

� horizontally through the use of mark-in and mark-out points

� vertically by activating or deactivating Timeline Tracks. Only objects on activated Tracks are included in 
the Container.

Make sure that there are no inactive Tracks located between the active Tracks. If there are, no Container 
will be built.
Reason: Container building can change the priority of the Timeline Tracks. This is because the Container 
is always stored above the Tracks it serves to combine. If you exclude one or more Tracks (because they 
are deactivated), the Container that was built can now contain clips that are located above the Track that 
was excluded. This means that those clips that were previously located below the clips of the excluded 
Track (i.e. that had a lower priority) would be located above them and could result in unexpected effects 
for multilayering. (See also “Track Priority” on page 9-21.)

Afterwards, click on Build Container. This function inserts a clip of the corresponding length into the next-
higher Timeline Track that is available.
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Step Into Container

First insert a Sequence (Container) within the Sequence (Top Sequence) currently being edited. Then open the 
Container’s shortcut menu and select Container > Step Into Container.

Opening the container

The opened Container is now located on the Timeline including all individual objects. A tab indicating that the 
current Container is “stepped into” (opened) appears left of the Track Headers. By clicking this tab, you reach 
the higher Sequence, i.e. you close the Container.

Layer 1 container opened

An area is highlighted in color on the Timecode bar and is limited by mark-in and mark-out points. This area 
corresponds to the length of the Container in the higher Sequence (in this case the main Sequence). The indi-
cated timecode refers to the Container currently open. Also the Timeline layout corresponds to the current Con-
tainer.

See “Dismantle Container” on page 9-116.
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I n s e r t  F u r t h e r  C o n t a i n e r s

Insertion of further Containers leads to an increase in tab pages. 

Multiple nested containers

You reach the lower levels within a main Sequence by repeated Step Into Container (which adds a tab each time 
you do so). This corresponds to the option “Step Out Of Container”. The Sequence Editor always displays the 
name of the main Sequence.

Edit Containers

You can edit an opened Container just like any other Sequence. When changing the length of clips within the 
Container, thus changing the entire length as well, please note: lengthening/shortening the Container does not 
automatically affect the next higher level(s). This means that the actual length of the Container placed as a clip 
on the Timeline remains unchanged, so:

� if you shorten an opened Container, the shortened area shows as “black” at the video output in the next 
higher level during playback. You therefore have to trim or delete this area of the Container clip. 

� if you lengthen an opened Container, you have to lengthen the Container clip by trimming it in the next 
higher level after closing the Container to make sure the clip is played back in its new length.
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Dismantle Container

Similar to Disband Clip(s), this function in a Container’s shortcut menu breaks down a Container into its com-
ponents. 
Unlike Step Into Container, a separate subsequence is not opened on the Timeline and the Layer tabs do not 
appear on the left side of the Timeline. If they do not already exist, the necessary Tracks are created below the 
Container. Clips that are located directly below the Container to be dismantled are moved downwards accord-
ingly.

A Container with one or more Clip FX applied to it cannot be dismantled. Use the Step into Container 
function instead.

D i s m a n t l i n g  o r  O p e n i n g  a  C o n t a i n e r ?

� You can click on an Opened Container to close it again. In the case of nested containers, you will obtain 
a better overview if you strictly separate the levels.

� A Dismantled Container can change the Timeline layout if Tracks are added. If may also be necessary to 
regenerate a dismantled file using the function Build Container. 

Containers are Copies of Sequences

Containers are copies of Sequences and function on the Timeline just like all other clips. This means that changes 
made in Container do not affect the original Sequences in the Rack and vice versa.

You should take this into consideration when repeatedly using the same Sequence in case a change becomes 
necessary. Instead of changing ten individual Container, it is far more useful to edit the original Sequence and to 
exchange the Container afterwards.
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Full-Size Monitor

This toggle button lets you switch the Master Viewer to full resolution and display it at its maximum size, i.e. 
640*480 pixels for NTSC and 768*576 pixels for PAL (square pixels). However, this may simultaneously reduce 
the size of the Source Viewer.
This function is available only with a desktop (computer monitor) resolution of at least 1280*X because if the 
desktop resolution were too low, the enlarged Viewer would not leave enough space for the Timeline.

HD formats such as 1920x1080 or 1280x720 cannot (yet) be displayed in fullscreen mode. Fullscreen 
display is limited to NTSC, PAL and smaller HD formats.

When this mode is deactivated, the Master inlay is displayed at one-quarter resolution (half height, half width). 
However, it is scaled (i.e. adapted to the space available) depending on the desktop resolution used, as demon-
strated by the following figure:

Full-size mode: How resolution relates to inlay size...

1/4

10
24

1280
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In this example, the desktop is set to 1280 * 1024 (width * height) and the videos inlays are displayed in PAL 
format.

� The Clip Viewer displays its image at the default size and resolution, which is one quarter of the PAL or 
NTSC resolution. 
The Full-size button has no effect on the Clip Viewer.

� The Master Viewer is set to its full resolution and size:
PAL = 768 * 576 (square pixels)
NTSC = 640 * 480 (square pixels)
As you can see, the Clip Viewer inlay fits into the full screen four times.

� The Source Viewer (also at one-quarter resolution) is scaled to fit the remaining width with its height 
adjusted to the corresponding aspect ratio.

The following table describes the variants (NTSC/PAL):

The Clip Viewer and Render Viewer are not currently full-size-capable.

If you change the desktop resolution for your operating system (for example, to a higher resolution such 
as 1280 x 1024), you may have to reinstall Pinnacle Liquid to adapt the interface.

Resolution 
(horizontal)

Full-size mode Possible for

1024 No - 

1280 Yes Master Viewer, some Effect Editors (esp. realtime editors)

1600 Yes (automat.) All Viewers (except for some Effect Editors)
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Inlay Quality Menu / Inlay Size

This function lets you change the size of the video inlays in Pinnacle Liquid.
Important: These options apply only to the inlay display (preview), not to rendering or output to tape.
Click the button to open the selection menu.

Full Screen: CCIR Pixels/Square Pixels 
- Only in Fullscreen Mode and only for PAL/NTSC - 
Computer monitors, whether LCD or CRT, can only display square pixels. The same is not true of video. The 
CCIR (ITU) Standard stipulates rectangular pixels for NTSC and PAL. Normally, all the inlays in Pinnacle Liq-
uid run based on square pixels. The signal for the monitor display is interpolated for this purpose.
When you switch to CCIR, the image narrows slightly and its contents are somewhat squashed in the horizontal 
direction, as shown in the example below. (In NTSC, the exact opposite occurs. PAL pixels are wider than 
square computer pixels whereas NTSC pixels are taller.)

Left: Square pixels (round section); center: CCIR PAL (vertical oval);
 right: CCIR NTSC (horizontal oval)

The TV resolution is converted for display on a computer monitor (see table below). The advantage is that play-
back is laterally correct and undistorted; the disadvantage is that the pixels are no longer identical, which is par-
ticularly important in the case of exact, pixel-by-pixel effect editing. For example:

Same section from same video frame, different pixel patterns

Square pixels CCIR pixels
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Identical areas were cut from the bottom left-hand corner of the same video frame, once with the square setting 
and once with CCIR pixels. As you can see in the enlargement, the pixels at the same locations are not identical.
Why is this? Because in the one case the lines (i.e. the horizontal rows of pixels) in the frame are 720 (CCIR) 
pixels wide and in the other case are 768 (square) pixels wide (according to PAL specification). The image con-
tents in the square-pixel display are distributed over different pixels than in the CCIR recording:

As the figure shows, the pixels themselves are always square, including the CCIR pixels. The CCIR pixels should 
actually be rectangular but because they cannot be rectangular on a computer monitor, the image appears nar-
rower in PAL and flatter in NTSC.

Quarter/Maximum/Default Inlay Size

This option scales the inlay to the largest (default/quarter) size currently possible. As a result, toolbars may be 
suppressed or rearranged.

Snapshot

It’s called snapshot and that’s exactly how it works. Point and shoot: place Playline on image, click the button 
shown here.

The image is then placed in the active Rack and carries the temporary name “Snapshot”. The corresponding 
media file (*.bmp) is saved to the directory ImportedStills.[ProjectID] in the current media directory. If you 
want to know the exact path, open the snapshot clip’s Properties.

Snapshot is ideal to quickly create a freeze.

If the tool symbol is not on the Timeline tool bar: right-click the tool bar, Customize > Special, and drag the 
symbol to a tool bar position.

TV standard CCIR (TV monitor) Square (computer) 

NTSC 720 * 486 (DV: 480) 640 * 480

PAL 720 * 576 768 * 576
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Multicamera Editing 

When recording events using multiple cameras simultaneously (often with linked identical timecodes), you 
also want to view the images simultaneously and cut directly from one source to another. The multicamera 
function from Pinnacle Liquid makes this possible. The procedure normally involves three stations:

1 Synchronize up to 16 video clips based on individually defined sync points (such as Markers) or identi-
cal timecodes ( page 9-122), using the MulticamSync command in the Project Rack

or:

1 Logging Tool: Capture the sources, i.e. the tapes (preferably already equipped with identical timecodes). 
( page 9-129)

2 Source Viewer: Load multicam clips (up to 16) for a simultaneous display of the synchronous video, 
ganged playback of all clips, selection of cameras (rough cut); insertion on the Timeline. ( page 9-125)

3 Timeline: Right-click to cut from CameraX to CameraY. Only one Track is used. ( page 9-128)

Contents of this section:

Determining sync points in clips  page 9-122

Synchronizing using MulticamSync  page 9-123

Multicamera clips in the Source Viewer  page 9-125

Multicamera editing on the timeline  page 9-128

� Synchronizing the Source Viewer and Timeline  page 9-128

Multicamera capture in the Logging Tool  page 9-129
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Determining Sync Points in the Clips

If you don’t have any synchronous tapes, two methods are available for synchronizing clips or setting them to 
identical timecodes:

� Synchronize captured clips using MulticamSync (recommended method);

� Synchronize using the TC Shift command (in the Logging Tool); for more information, see  page 9-130.

If you have clips that have already been captured, you first need to determine the sync points in the relevant 
clips, meaning the point in time at which all the clips (should) match. For example, you may have filmed with a 
clapper, or oriented yourself by a flash or significant audio event that is visible or audible in all the clips.

1 Combine all the clips you want to synchronize in one Rack.

2 Mark the sync point you’ve decided on in the same way in all the clips using:

� The clips’ mark-in or mark-out, or

� The clips’ clip-in or clip-out, or

� The first marker in the clips.

It’s easiest to do this in the Clip Viewer. We recommend that you set the mark-in at the sync point in each clip so 
they all start at the defined moment.

If your clips have identical timecodes (i.e. they were already recorded synchronously), synchronize 
them by the Timecode (as described below) using the MulticamSync command.

3 Arrange the clips in the Rack in the desired order. The first clip in the list becomes Camera1, the next 
becomes Camera2, etc.
Select the clips you want to synchronize.

The Multicam clip adopts its audio from the Camera1 clip. Keep this in mind when making your selec-
tion. In other words, Camera1 should contain the “master audio”.
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Synchronizing Clips Using MulticamSync

4 Call the MulticamSync command from the Rack’s shortcut menu or by selecting Menu Bar > Project > 
MulticamSync.

5 The top section displays the list of clips (max. 16) that will form the Multicam clip.
In the middle section, select the previously defined sync point (you can ignore the second list box).

MulticamSync: Five video clips formone five-camera multicam clip.

6 Click Sync selected clips for Multicam.

7 The bottom section now contains a list.
The top entry is the Multicam clip that was generated, followed by its components. Make sure it meets 
your expectations and then click OK (checkmark).
If one or more clips are not included in the Multicam clip, something is wrong with the sync points.

8 The Rack now contains the Multicam clip, identified by the extension *.Sync.
You can, of course, rename this clip.

9 Load this clip in the Source Viewer or drag it directly to the Timeline (or do both).

10 Continue reading as of “Multicamera Clips in the Source Viewer”  on page 9-125 or “Multicamera Editing 
on the Timeline”  on page 9-128.
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If You Have Questions about the Length of the Multicam Clip ....

.. Look at the following figure:

Multicam clip (top) formed from five clips

The five clips were synchronized by a Marker and positioned on the Timeline with all the Markers lined up 
exactly, one above the other. The Multicam clip, which is located on the top Track, is only as long as the area in 
which all the other clips overlap (indicated by a Mark-In and Mark-Out).

Thus, you also need to define the sync point in such a way that the clips form the longest possible Multicam clip. 
Ideally, all the clips used should be of about equal length and the sync points should be set at the start of each 
clip.
See also “ClipSync” on page 8-107.

Properties of the Multicam Clip

A Multicam clip is actually many clips. The Properties dialog box for a clip contains a General tab with a Camera 
list box where you can switch the Multicam clip to any of its Camera clips.

You can also create copies of the Multicam clip and assign each copy to a specific camera, resulting in 
one clip per camera.

“Camera” and “Camera Count” Columns in the Rack

In the Detail (list) view, the Rack has columns listing the number of active Cameras for Multicam clips and the 
number of Cameras belonging to the Multicam clip.
(These columns are not displayed in the standard layout. To display them, open the Rack shortcut menu and 
select Detail View. In the dialog box displayed, select Edit View. At the bottom you will find the two entries that 
you must activate and which you can move higher up in the column if desired (select and use the up-arrow)).
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Multicamera Clips in the Source Viewer

In the Source Viewer, a Multicam clip is displayed with all its camera images. All the clips remain synchronous. 
If you scrub one clip, all the others follow.

1 In preparation: Drag the two tool buttons pictured from the Source Viewer’s function library to the tool-
bar. Activate the Multicam display. We’ll discuss the other command later on.

2 Transfer the Multicam clip to the Source Viewer (for example, using drag & drop). It might then appear 
as follows:

A five-clip multicam clip in the Source Viewer, 3 x 3 view; 
the toolbar contains camera buttons for changing from one camera to another

3 The numbers of the camera clips are highlighted in yellow. The active camera has a yellow border 
(Camera3 in the figure). 

4 Click an image to activate the clip or camera.
Volume II Chapter Edit 9 - 125



PINNACLE

Special Functions
5 Each time you click an image, a Multicam Marker is set on the position bar. The number in the Marker 
refers to the camera that is being cut to. (You can disable this option: Right-click in the image area and 
disable the Markers as desired.)
You can also use the camera buttons from the library.

Multicam Markers indicate cuts from one camera to another

6 Start playback and click the images or camera icons to cut back and forth between available images. 
You can also scrub in the inlay or on the position bar.
All the images play simultaneously (more or less fluently, depending on the number of cameras  and 
your system’s capacity).

� You can also assign the Camera icons to the keyboard (Edit > Control Panel > User > Keyboard 
Properties). Select the Source Viewer as a module).

7 When you’re done with the clip, click the Insert Arrow to insert it on the Timeline. Pay attention to 
Source Track Mapping and active/inactive Timeline Tracks.
At the points identified by the Multicam Markers, the image cuts to the specified camera.
Audio is always inserted from Camera1 (continuously, without edits - see figure below):

Edits in the video clip where Multicam Markers are located.
In the audio clip, only the markers are set.

You can, of course, work with mark-ins and mark-outs as usual. In this case, however, you should gang 
the Source and Master Viewers so the cuts will remain synchronous. It is also a good idea to disable the 
Multicam markers.

For more information, see “Multicamera Editing on the Timeline”  on page 9-128.
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Tips and additional functions

� Get the tool buttons pictured on the left from the function library and place them on the Source Viewer 
tool bar:
The Marker List provides an overview of the Multicam Markers. Right-click the marker list to open a 
shortcut menu, which also contains an option for deleting the Markers.
The Goto previous/next marker option can be used for easy and precise navigation.

� To move the Multicam Markers on the Position Bar, drag them with the mouse while holding down the 
ALT key.

� To overwrite Multicam Markers, position the mouse pointer on a specific camera (i.e. over the image) 
while playing and hold down the left mouse button.

� A Multicam clip is automatically recognized in the Source Viewer. Click the Multicam icon to toggle 
between a full and split screen.

� If one or more images in the Source Viewer unexpectedly run into the black, it might be because syn-
chronization has been compromised. 
See “Synchronizing the Timeline and Source Viewer”  on page 9-128.

� Right-click in the Source Viewer’s inlay to open the shortcut menu and select the Multicam view grid 
(1x1, 2x2, 3x3 or 4x4). The grid is more or less filled, depending on the number of cameras. 1x1 means 
full screen.
From this menu, you can also determine the camera locations. Click an image and select the camera 
you would like to see at this point.
You can also deactivate (uncheck) a camera to eliminate it altogether.
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Multicamera Editing on the Timeline 

The method described here is recommended especially for Multicam clips that have not already been  edited in 
the Source Viewer by means of Multicam markers (“Multicamera Clips in the Source Viewer”  on page 9-125).

1 Position the Multicam clip (*.Sync) or Camera1 clip generated in the Logging Tool on the Timeline.

2 Transfer the Multicam clip (*.Sync) or Camera1 clip generated in the Logging Tool to the Source Viewer. 
Select the appropriate Multicam View (such as 3x3; see page 9-127), if necessary.

3 Disband the Timeline clip so that the audio clips are positioned on separate tracks (Shortcut menu > 
Disband Clip(s)). This will prevent the audio from being edited with subsequent edits.

Synchronizing the Timeline and Source Viewer

4 Position the Playline anywhere in the Multicam clip on the Timeline, right-click to open the shortcut 
menu and select Match Frame.
You should now see the same image in the Master Viewer and Source Viewer (Camera X).

5 Click the Multicam ganging of Source and Master Viewer button (must be highlighted in yellow).
(If you don’t see this button on the Source Viewer toolbar, right-click the toolbar and drag the tool but-
ton from the Special tab to the toolbar.)
This links the Timeline’s Playline to the Source Viewer’s Playline.

6 Play the Timeline clip. Stop at the point where you want to cut to another camera.

7 The camera images in the Source Viewer jump to the sync point at the Playline position on the Timeline 
clip. 
When you scrub, the camera images follow. The frame rate depends on the number of cameras and 
your system’s capacity.

8 Right-click the Timeline clip to open the shortcut menu and select Cut to camera: > Camera X (which-
ever is appropriate).
An edit is inserted at the Playline position. The audio clips are not affected.

9 Find the position for the next cut to another camera ... and so on.

Tips and Variations

� Whenever you move the Multicam clip on the Timeline or insert another clip, you must resynchronize 
the Source Viewer and Timeline.
First select Match Frame and then reactivate ganging. The button must be highlighted in yellow.
A good way to check synchronization is to compare the Source timecode and the Source Viewer time-
code: If synchronization is correct, they will be identical (see Source Timecode,  page 9-15).
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� When the Timeline and Source Viewer are linked,
- Playing the Timeline serves to play Timeline audio (Source Viewer mute);
- Playing the Source Viewer serves to play both Source Viewer and Timeline audio. Naturally, you can 
also disable Source Viewer audio if you find the combined playing irritating.

� The Trim Editor is ideal for precisely trimming a Multicam Sequence. With it you can easily jump from 
edit to edit and optimize the transitions.
Pay attention to synchronicity with the audio: The relationship between image and sound changes in 
the Slip Clip, Trim Outgoing and Trim Incoming trim modes. Trim both has no effect on synchronicity.

� If you want to completely replace a camera clip on the Timeline, right-click the clip to open the shortcut 
menu and select Switch to camera: Camera X .

Multicamera Capture in the Logging Tool

You need at least two tapes with an identical timecode.

1 Load the first tape, open the Logging Tool, assign a Reel name, and select a Rack for the clips as well as 
the media format (Codec). So far, this is the standard procedure in the Logging Tool.

Audio must be taken from one of the synchronous tapes. This tape will become the Camera1 tape and the Mul-
ticam clips will be formed from it. The other tapes, from Camera 2 to Camera 16, are recorded without audio 
tracks. If in doubt, use the tape containing the best original sound as Camera1. In the example, we assume that 
tape 1 will also be Camera1.

 

Multicam: Cameras 1 to 16
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2 Camera1 is the default. V, A1 and A2 should already be activated. Define and capture the clip(s) from 
this tape.

3 As soon as you’ve finished the tape, load the next tape in the player. Drag the first clip from the Rack to 
the Logging Tool inlay or reenter a mark-in and mark-out. Do not change the Reel name transferred 
from the previous tape (the system automatically appends a camera ID).

4 Now select Camera2. The Audio Source Tracks can no longer be activated.

5 Capture this clip with the same TC values for the mark-in and mark-out (if possible; at the very least, 
make sure you have a long TC area that overlaps, i.e. is synchronous).
This creates a video-only clip with the same TC data as the Camera1 clip.

6 Repeat steps 3 to 5 until you’ve processed all the tapes and clips.

Continue as of “Multicamera Clips in the Source Viewer”  on page 9-125.

Tips:

� Carefully rename Reels and clips so you can keep track of them.

� You can also simply log the clips and then transfer them to the system by means of Batch Digitize.

� All the tapes used must have a continuous timecode (no interruptions or breaks). It is  not possible to 
synchronize clips across TC breaks.

S y n c h r o n i z i n g  w i t h  t h e  T C  S h i f t  C o m m a n d  ( i n  t h e  
L o g g i n g  To o l )

The TC Shift command lets you add or subtract a value from a tape’s actual TC so that you can record clips with 
the desired timecode.
If activated ([Edit > Control Panel  > User >] Logging Tool > Properties > General > Activate TC Shift mode), TC 
Shift appears as a TC input field in the Change Reel dialog box.
The Change Reel dialog box opens every time you change a tape.

1 Select one tape as a reference tape; the other tapes will be adapted to its timecode.

2 Based on a sync point (clapper, flash, sound, etc.), determine the extent to which the other tapes deviate 
from the reference tape. Note the values to the exact frame (such as 00:00:06:12) and note whether they 
run ahead or behind.

3 Capture the reference tape without a timecode shift as Camera1 as described above (“Multicamera Cap-
ture in the Logging Tool”  on page 9-129).
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4 Capture the remaining tapes using the TC shift calculated for each and as Camera 2, Camera 3, etc. 
Enter the shift with a plus or minus sign, as appropriate.

Synchronizing by entering a TC shift

5 All your clips should now have a synchronous timecode. You can easily verify this at the sync point.
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This chapter contains basic information on video effects. Note that these descriptions apply to Classic editors 
and effects (Clip FX and Transitions).

If you’re working with Pinnacle Liquid effects for the first time, read the following sections of this chapter.

Effects: The basics  page 10-3

Overview of the effect families in Pinnacle Liquid

Detailed description of the Classic Effect Editors  page 10-39

Direct links to chapters covering the following topics:

� Software-based realtime effects (CPU/GPU)  page 11-1

� Special FX (Color Correction Editor, Timewarp Editor, Linear Timewarp)  page 12-1

� Audio effects  page 13-69

For more information, refer to your product manual.
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Effects in Pinnacle Liquid: The Basics

In their broadest sense, effects are used to modify, distort, and optimize digitized video and audio. Pinnacle 
Liquid provides effects for both video and audio clips.
Among them you will find ready-made effects and effect editors that can be used immediately, some of which 
can also be played back in real time (depending on the hardware combined with Pinnacle Liquid or the product 
version). Effect editors allow you to create your own complex, customized effects.

Guide to Effects: What is Available?
This is a short overview of all available types of effects in Pinnacle Liquid.

� Classic Effects -
Editors for Clip and Transition Effects;
Render effects;
Rack Folder: Classic Clip FX and Classic Transition FX;
Special features: suitable for oversized graphics (pan&scan effects); zoomable Canvas; excellent quality;
Reference manual: in this chapter (“Finish”).

� Realtime Effects software-based (CPU and GPU) -
Clip and Transition effects, performed by software utilizing CPU or GPU of graphic card, in realtime; 
Rack Folder: Realtime Clip FX and Realtime Transition FX;
Special feature: Keyframe curve (parameter based editing);
Reference manual: chapter “Realtime FX”.

� Hollywood FX (realtime) -
Clip and Transition Effects; Hollywood-FX-Editor; 
Realtime (GPU);
Rack Folder: PlugIn Clip FX and PlugIn Transition FX (> Editors); preset HFX under Realtime Transition 
FX > Specials;
many spectacular and imaginative effects;
Manual: see Hollywood FX online help. 

� Alpha Magic Wipes -
Collection of alpha wipe patterns; feature of Gradient Wipe and Gradient Wipe with Border ;
Realtime (GPU);
Rack Folder: Realtime Transition FX > Editors.
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Effect Basics

This section provides basic information on the effects available from Pinnacle Liquid. Be sure to read this sec-
tion if you have not yet worked with Pinnacle Liquid effects.

What are clip effects?  page 10-4

Priority for multilayering  page 10-4

What are Transitions?  page 10-5

Where are the Pinnacle Liquid effects?  page 10-5

Register FX for effects you create yourself  page 10-6

Applying effects to clips  page 10-7

Activating/deactivating effect parameters  page 10-8

Deleting and removing effects  page 10-8

Effect icon on a Timeline clip  page 10-8

Effect symbol in a Picon view  page 10-9

FX Properties  page 10-9

What Are Clip Effects (Filter)?

Clip effects only involve a single clip. Another commonly used expression for Clip 
effect is “filter”. By applying one or more clip effects to clips, you can manipulate 
them in a variety of ways.

Certain clip effects, such as color or keying effects, only influence the appearance of 
a video - they do not alter a clip’s position. In contrast, effects like 2D effects alter 
size, position, rotation, etc. (See also “Classic Clip Effect Editors (Filters)” on page 
10-10.)

Priority for Multilayering

Many clip effects (for example, key effects) are based on an overlapping of images on two or more effect layers 
(mulitlayering). The following general rule applies: a clip on a higher Timeline Track (higher = closer to the top) 
normally overlaps all the clips below it, meaning that it has a higher priority.
Priority also plays a role in transition effects (see also Background/Foreground on page 10-41).

Example of a 
clip effect
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What Are Transitions?

Transition effects are used for defining transitions between clips, or transitions 
between “black” and a clip (like in fade-out). They appear as separate objects on the 
Timeline and always involve two consecutive clips (or a clip and “black”) on one 
Track. Examples of transition effects are dissolves, wipes, zooms, slides, etc. 

Just like clip effects, you can also trim and move transition effects to control their 
duration and position (see also ABCs of Effects on page 9-34). 

Where are the Pinnacle Liquid Effects?

The Library  tab in the Project Window contains the following Pinnacle Liquid effects (note that the basic 
structure has changed since Version 5.0; the actual selection and display depend on your Pinnacle editing sys-
tem):

Realtime Clip FX Rack in Pinnacle Liquid (sample illustration)

Example of a 
transition effect
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� DVD Menus - Templates for DVD menus.

� Realtime Clip FX - This folder contains realtime clip (filter) effects with separate editors.
The Presets Rack contains ready-to-use effects.
The audio effects are also located here.

� Realtime Transition FX - Realtime-capable Transition effects with separate editors. 
The Presets Rack contains ready-to-use effects. 

� Classic Clip FX - This Folder contains clip effects and effect editors from Pinnacle Liquid that you can 
use to create and edit your own clip effects (basics and  page 10-56).
The Presets Rack contains ready-to-use effects.
All Classic FX are rendered.

� Classic Transition FX - This Folder contains Transition effects and effect editors from Pinnacle Liquid 
that you can use to create and edit your own transition effects. 
The Presets Rack contains ready-to-use Transitions.

� Plug In Clip FX - These Folders and Racks contain effects from third-party vendors included in the Pin-
nacle Liquid scope of supply, e.g. Hollywood FX.
To add more plug-in effects, select Control Panel > Site > PlugIn Settings.

� Plug In Transition FX - Same as above.

FX Tab

Available in addition to the Library  tab is the FX tab which is used for saving effects you created yourself (and 
all other objects). 

� The function Import > Media or Title Clip is not available on this tab. To save something in FX, use 
Copy/Paste or Drag & Drop.

� If you want to create or modify an effect and then save it for later use in other applications, make a copy 
of the effect (or Effect Editor) in a Rack, assign it a name, edit it and use it like any other effect. 

To o  M a n y  E f f e c t s  t o  K e e p  T r a c k ?  A  F e w  T i p s :
Because Pinnacle Liquid offers so many effects, it isn’t easy to keep track of them all. One option is to work with 
a reduced selection of your favorite effects and always have your own effects available in your projects. 

� You can copy any effect from the Library tab to a Rack on the FX tab and keep it in a customized struc-
ture of Rack Folders and Racks - simply press CTRL-C and CTRL-V as many times as necessary. 

� There you can rename the effects any way you want.

� You can save this structure with a Project Template and reload it for each new Project (see “Project Tem-
plate”  on page 8-5).
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Applying Effects to Clips

When using effects, remember that clip effects can be used for individual clips, while Transitions involve two 
clips (or, more generally, two video signals) and are independent objects.

T r a n s i t i o n  e f f e c t s
To apply Transition effects, drag them from the Project window to the edit point between two clips on the Time-
line, or in the case of a fade-in or fade-out to the beginning or end.

That’s how to apply a transition correctly: across the edit, 
with no gap between the two clips

 For a description of how to proceed further:  page 10-13.

� Use the Align function to select the insert point of a Transition. While moving the Transition 
closer to an edit, repeatedly press the ALT key to toggle between the beginning (mark-in), mid-
dle and end (mark-out).

C l i p  e f f e c t s

To apply ready-made clip effects, drag them from the Project window to clips on the Timeline. Once one or 
more effects have been applied to a clip, the clip appears with a purple line at the top and with one (or more) 
effect icon(s). For a description of how to proceed further:  page 10-13.

The Timeline Track of the clip to which an effect is applied must be activated for video playback. (See 
also “Video Playback” on page 9-12.)

A Timeline Slice above a segment that contains non-rendered render effects is displayed in red. From left 
to right, this area gradually disappears from the Slice as rendering progresses. 
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Activating/Deactivating Effect Parameters

You can activate or deactivate the effect parameters and clip attributes. 
The FX Properties dialog box provides information on and access to the 
effects applied to an object. Open the FX Properties dialog box from the 
clip’s shortcut menu.
The Effect Editors are listed below the horizontal line and the Attributes 
are listed above it. Right-click an effect to open its shortcut menu and 
select Edit to access the Effect Editor.

� To activate or deactivate effect parameters and Attributes, click 
the appropriate checkboxes. The effects are not deleted; they are 
simply not applied. This allows you, for example, to prevent ren-
dering.
Double-click an entry to open the Effect Editor or Clip Viewer. 

� You can change the order in which the effects are rendered. To do so, select an effect and click the Arrow 
buttons to move it to the required position.

� To remove an effect from the list, select it and then click the Trash.

Deleting and Removing Effects
� Transitions - Click the Transition and press DEL or right-click the Transition and select the Delete func-

tion from the shortcut menu. 

� Clip effects - If you want to remove an effect from a clip, open the shortcut menu by right-clicking either 
the colored line or the effect icon (see also Effect Icon on a Timeline Clip on page 10-8) or via the clip’s 
FX properties. (See also “FX Properties” on page 9-68.)

Effect Icon on a Timeline Clip
If one or more effects have been applied to a clip, the clip appears with a colored line at the top and with one or 
more effect icons. The Timewarp Editor, however, is indicated as a broken line along the bottom edge of the clip.

If the line at the top loses its intense color and appears more pale, this means that the effect(s) or Attributes are 
deactivated. See also “FX Properties” on page 8-71.

Clip with several effect icons and colored line (top)

FX Properties: Activating and 
deactivating

Keying EditorWipe Editor

2D Editor

Color Editor

Filter Editor

Colored line
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Depending on the Track height and Timeline scale selected, the effect icon might not appear. However, 
the colored lines are always visible.

If you disband a grouped VA clip that has video effects (Disband Clip(s) function), the audio clips also 
carry the effect line. Basically, they are still full-fledged clips with video, since all you have to do is reac-
tivate the Video Source Track in the Clip Properties to restore the original clip (see  page 9-67).

A c c e s s i n g  E f f e c t s  v i a  a  L i n e  o r  I c o n

Right-click either a line or an icon to display a shortcut menu with two levels. The top lists the effects applied to 
the clip and the bottom lists the options relating to the particular effect.

� Edit - this option opens the editor for the effect ( page 10-10).

� Copy/Delete - See also “Saving Individually Created Effects” on page 10-38.

� FX Undo/Redo - these options relate to changes made to the effect.

� Active - this option is activated in the default configuration; click the check mark to remove it and pre-
vent the effect from being applied (also see “Activating/Deactivating Effect Parameters”  on page 10-8).

� Move up/down - in the case of multiple effects, these options let you change the order of application. 
They move the effect up or down one position.

� Rename - this options lets you identify specially configured effects by name.

Effect Symbol in Picon View

If you apply one or more effects to a clip, a white five-point star appears in 
the upper right-hand corner of the Picon displayed in the Picon View in the 
Project window or on the desktop. The blue star represents active clip Attri-
butes.

FX Properties

FX properties provide information on and access to the effects that have 
been applied to an object. See also “FX Properties” on page 9-68.

Picon with effect symbol and 
attributes symbol in the upper 

right-hand corner
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Effect Editors (Basics)

In addition to the ready-made effects supplied, Effect Editors are provided that allow you to individually create 
and adapt clip effects and Transitions. This section provides you with basic information and an overview of the 
Effect Editors in Pinnacle Liquid:

What is an Effect Editor?

An Effect Editor is a workshop for creating effects whose parameters you yourself modify. An effect created in 
this way is an object similar to many other objects in Pinnacle Liquid; it is applied like a ready-made effect, can 
be copied, deleted, moved, shortened, lengthened, etc. -- and even edited.
There are several types of Effect Editor:

Classic Clip Effect Editors (Filters)

A number of Effect Editors is available for generating clip effects (video). Some of these are software or hard-
ware realtime effects. This type of Effect Editor is also commonly referred to as a “filter”. Below is a brief 
description of the standard editors provided in Pinnacle Liquid. The figures show the tool buttons you can use 
to call the editors or the icons under which you will find the editors in the Project window.

Information on software-based realtime effects can be found in a separate chapter starting on  page 11-1.

K e y i n g  E d i t o r

You can use this editor to remove areas of an image which are a certain color or brightness and replace them 
with a different image. 

For details, see “Keying Editor”  on page 10-73.

F i l t e r  E d i t o r

Use this editor to create alienation effects with clips without altering their size, position, etc. For details, see 
“Filter Editor”  on page 10-84.

C o l o r  E d i t o r

Use this editor to adjust the color, contrast, brightness, gamma etc. settings of clips. In this way you can correct 
color and create color alienation effects. Example: white balance correction, color matching. For details, see 
“Color Editor”  on page 10-70.
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W i p e  E d i t o r

Use this editor to create wipes. The Wipe Editor is equipped with an alpha channel, making it possible to define 
transparent parts of a clip so that another clip can show through. The appearance of this mask can be controlled 
with many different parameters, including Pattern, Position and Size. For details, see “Clip FX Wipe Editor”  on 
page 10-69.

2 D  E d i t o r

Use this editor to control, for example, size, position, rotation and border to create effects such as picture-in-
picture. For details, see “Clip FX 2D Editor”  on page 10-56.

3 D  E d i t o r  

This Effect Editor allows you to create three-dimensional effects. It also contains a complex Pageturn function.

C o l o r  C o r r e c t i o n  E d i t o r

Primary, Six Vector and Selective Color Correction plus a wide variety of additional functions (such as Tone 
Balance, Histo Match and subsequent White-Balancing) and diagnostic displays (vector, waveform, histogram, 
etc.) make this editor a powerful tool ( page 12-3).

T i m e w a r p  E d i t o r  

The Timewarp Editor lets you create dynamic motion effects (DME), ranging from a simple linear slow motion 
to complex effects involving Key Frame controlled changes in speed and playback direction of video 
( page 12-50).
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Classic Transition Effect Editors

Use these editors to create transitions between clips. Since these effects always involve two clips (an incoming 
and an outgoing clip), they can be rather complex. The functionality is basically the same as for the corre-
sponding Clip FX Editors.

� 2D Editor for transitions  page 10-42

� 3D Editor for transitions  page 10-51

� Wipe Editor for transitions  page 10-52

Example of an Effect Editor (normal view): 2D Editor for Transitions

 ToolbarPosition barVideo inlayToolbar

Acceleration curveTabs Playline position Duration
Toggle incoming/

outgoing
Close 
editor
Volume II Chapter Finish10 - 12



PINNACLE

Effects in Pinnacle Liquid: The Basics
Opening Effect Editors and Editing Clips 
(= Applying FX Editors)

In the default configuration, an open Effect Editor takes the place of the Sequence Editor. You can open an Effect 
Editor in many ways:

E f f e c t  E d i t o r  B u t t o n s  ( M a s t e r  V i e w e r )

(applicable to Clip FX:)

1 Click one of the Effect Editor buttons listed previously that are located to the right of the Master Viewer 
in the default desktop layout.

2 Then click the clip that you want to edit.

This works the other way round as well: Mark the clip, click the editor’s symbol. The marked clip is 
instantly loaded in the editor.

S e l e c t i n g  a n  E d i t o r  f r o m  a  L i s t

(applicable to Clip FX:)

1 Click the button shown and select the Effect Editor you want from the menu displayed.

2 Then click the clip that you want to edit.

R e t r i e v i n g  a n  E f f e c t  E d i t o r  f r o m  t h e  R a c k

1 In the Project window, click the Library  tab and drag the Effect Editor you want from one of the Fol-
ders/Racks to a clip in the Timeline.

2 Continue with “Opening via an Effect Icon or Line”: 

O p e n i n g  v i a  a n  E f f e c t  I c o n  o r  L i n e

� Effect Icon - right-click the effect icon to open the shortcut menu, select the Editor and then Edit.

� Colored line - right-click the colored line to open the shortcut menu, select the Editor and then Edit.

O p e n i n g  a n  E f f e c t  E d i t o r  v i a  F X  P r o p e r t i e s

1 Open the shortcut menu for the clip on which the effect(s) is/are located.

2 Select FX Properties.

3 Right-click or double-click the effect name to open the shortcut menu and select Edit to open the editor 
with the clip
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O p e n i n g  a n  E f f e c t  E d i t o r  i n  t h e  R a c k

(applicable only to Effect Editors that were copied to the FX tab:)

1 Double-click the relevant Effect Editor icon.

2 Then click the clip that you want to edit.

O p e n i n g  T r a n s i t i o n  E f f e c t  E d i t o r s

Transition Effect Editors appear as separate objects on the Timeline because they are positioned on the edit 
between two clips or at the beginning or end of a clip.

1 Drag the desired Effect Editor from the Rack to the interface between two Timeline clips or the begin-
ning or end of a clip.

1 Right-click the Transition to open its shortcut menu and select Edit,

or

1 Simply double-click the Transition.

A p p l y i n g  a n  E f f e c t  E d i t o r  t o  a  C l i p  i n  t h e  P r o j e c t

A clip does not have to be located on the Timeline in order for a (clip) effect to be applied to it:

1 Open the desired clip Effect Editor using one of the methods described.

1 Click the clip located in a Rack in the Project window or on the desktop.

The clip is loaded in the editor and the clip Picon appears with a five-point star. 

The rendering process does not begin until the clip has been placed on the Timeline.

Wo r k i n g  w i t h  t h e  P r e v i e w  I m a g e
Instead of loading a clip in the Effect Editor, you can work with the preview images (the gray and blue panels 
that appear in the Editor Inlay when no clip is currently loaded). This can be helpful for preparing and trying 
out effects because the volume of data to be calculated is much smaller, thus speeding up the preview. (See also 
“Effect Viewer” on page 10-17.)
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Effect Editor Full Screen Mode

Especially if you work with a dual monitor setup, it makes sense to set the Effect Editors to Full Screen Mode. The 
left monitor now displays the video inlay in almost complete full page size; the tool buttons are arranged in 
freely movable windows on the right screen. 
To switch to Full Screen Mode, click the indicated tool symbol in the toolbar of the active Effect Editor. To leave 
the Full Screen Mode, click the symbol again.

Full screen mode is not usually available for realtime effect editors.
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Elements and Functions of the Effect Editors

Example of an Effect Editor (normal view): 2D Editor for Transitions

This section describes the various elements of the Effect Editors and explains how they are used. All Effect Edi-
tors are organized in the same way and even have some of the same parameters. For a more detailed description 
of the effect parameters, see the sections on the particular Effect Editors. This section covers the following top-
ics:

Effect Viewer  page 10-17

Position bar  page 10-18

Timecode displays  page 10-18

View RGB Channels and Alpha Channel  page 10-19

Key Frames  page 10-20

Additional Key Frame functions  page 10-22

Acceleration curve (Key Frame interpolation)  page 10-23

Effect parameters and options  page 10-29

Effect Editor shortcut menu  page 10-32

Deactivating modified settings  page 10-34

Copying settings to Key Frames  page 10-34

Closing Effect Editors  page 10-34

 ToolbarPosition barVideo inlay
(Effect viewer)

Toolbar

Acceleration curveTabs Playline position Duration
Toggle incoming/

outgoing
Close 
editor

Effect parameters
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Effect Viewer

The editor’s Effect Viewer lets you preview effects. When you open an Effect Editor, the default graphics appear. 

Effect Viewer with default image 

Click the Zoom button to zoom in and out on the Effect Viewer’s video inlay. Also, with any effect tool selected 
you can temporarily enable the Zoom tool by pressing the right mouse button. 
Drag up to zoom in on the inlay, drag down to zoom out. Zooming out of the inlay lets you see the area around 
the standard screen area, and a grid pattern appears. 

This is the “canvas” view. Each rectangle on the canvas corresponds to a full screen. To toggle between full-
screen view and the standard grid-pattern view of 325%, double-right-click the video inlay. 

Effect Viewer with canvas and grid pattern

The Canvas is useful for maintaining an overview of moving effects such as 2D and 3D effects. It lets you view 
clips and parts of an image that are outside the actual screen area, for example, in the case of zoom and other 
2D/3D effects.

The Canvas View is merely a viewing mode - it has no influence on the effect itself. 
This is an exclusive feature of the Classic Effect Editors.
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Position Bar

The position bar, located below the video inlay, can be used for scrubbing. As you drag the Playline, the time-
code value also changes to reflect current position and duration. For more information on how the position bar 
works: “Navigation Using the Position Bar”  on page 8-53.

� Press the LEFT or RIGHT ARROW key to move the Playline one frame.

Key Frames and clip Markers also appear on the position bar. 

Position bar with Key Frames, markers and Playline

When opening an Effect Editor, the Playline can be on different locations on the position bar depending 
on the Playline’s position on the Timeline at the moment of opening. If it is located in the clip/Transition, 
it keeps its position. If it is located before or after the clip/Transition, it jumps to the beginning or the 
end of the position bar in the Editor, that is, the first or last frame of the clip or Transition. 

Timecode Displays

Two timecode fields are located above the video inlay.

Playline Position

The left field displays the timecode of the current Playline position on the timecode bar.

C l i p  D u r a t i o n

The right field displays effect duration. In the case of transition effects, the duration of the Transition appears; in 
the case of clip effects, the duration between mark-in and mark-out of clip appears.

Key Frames

MarkersPlayline
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View RGB Channels and Alpha Channel

In some cases it is very useful to view a clip’s color channels (red, green, blue), its luminance channel, or its 
alpha channel - if available. 
Click the button shown here and select from the menu:

� Normal - all channels are displayed, including an existing alpha channel.

� Alpha Overlay - visualizes the alpha channel by a red overlay, where solid red indicates full transparency 
which blocks out the RGB channel background. Useful, for instance, to check a key effect especially 
around the edges of the foreground image.

� Color only -red, green and blue together, without alpha.

� Red-green-blue - either-or-or. Useful for Color Gain or Gamma modifications (functions in the Color 
Editor).

� Luminance - Brightness (gray scale; Y) only.

� Alpha - displays an alpha channel as black & white pattern. White indicates opaque (non transparent), 
black indicates completely transparent areas, levels of gray varying degrees of transparency.

� Inverted Alpha - same as above, only inverted.

Not all Effect Editors feature these options. Please note also: They are not settings, but rather view 
modes.
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Key Frames

Pinnacle Liquid uses Key Frames to precisely define the chronological stages of an effect. Key Frames mark spe-
cific frames within an effect where effect parameter settings are changed. Key Frames are used in all Effect Edi-
tors for defining effects. 

W h y  U s e  K e y  F r a m e s ?

Every Key Frame contains information on the settings of all effect parameters that are manipulated at the given 
position (such as image size, rotation, key settings, wipe pattern, etc.). 
When you run a key-framed effect, Pinnacle Liquid interpolates between the different settings in successive Key 
Frames. You can think of Key Frames as “steps” in an effect and use them to define image movement, new wipe 
settings, etc. Any time you change a setting in an Effect Editor, Pinnacle Liquid automatically inserts a new Key 
Frame (if the use of this feature has not been turned off).

� For example, a picture which passes over another picture can be defined with just two Key Frames. The 
first Key Frame positions the image in the top, left corner of the screen; size is set to 0. The second Key 
Frame increases the size of the image to 100% and centers it. When you run the effect, Pinnacle Liquid 
interpolates between the different settings in the two Key Frames.

Appearance of a 2D effect with two Key Frames

� By using the Curve function, you can set an acceleration spline for each Key Frame.  page 10-23 

� By default, Pinnacle Liquid effects have two Key Frames: one at the beginning and one at the end. Both 
Key Frames have the default settings: no image manipulation. You can modify default Key Frames and 
insert new Key Frames wherever needed on the position bar.

You can also deactivate the use of Key Frames by clicking Options tab > Do not use Key Frames (default 
in Color Editor and in Keying Editor). In this case, the effect has only one parameter setting, in other 
words, the effect does not change over time.  page 10-30
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S e t t i n g  K e y  F r a m e s

Any time you change a setting in an Effect Editor, Pinnacle Liquid automatically inserts a new Key Frame at the 
given point on the position bar (located below the Effect Viewer’s video inlay). Click this button to manually 
add a Key Frame, with the current settings, at the current point in the effect.

C o p y i n g  K e y  F r a m e s

Use this button to copy a Key Frame to the clipboard, without deleting it from the effect.

� CTRL + C to copy Key Frames.

P a s t e  K e y  F r a m e

Use this button to paste a copied Key Frame elsewhere in an effect.

� CTRL + V to paste Key Frames.

The tabs to the left of the Effect Viewer offer drop-down menus with controls grouped by type. To apply settings 
to a particular Key Frame, drag the diamond in the tab item bars to the Key Frame in the position bar. This is 
useful, for example, if you want to apply the same border settings to certain Key Frames in an effect and do not 
want to move the Playline to each one. 

You can also apply settings to a whole effect by dragging the diamond to the video inlay.

D e l e t i n g  K e y  F r a m e s

To delete a Key Frame, click the Goto Next/Previous button to move the Playline to the Key Frame you want to 
delete. Click the Delete Key Frame button to eliminate the Key Frame.

� DELETE

� CTRL + X to delete and copy to clipboard.

M o v i n g  K e y  F r a m e s

Hold the ALT key and drag the Key Frame with the mouse (left button pressed) to the desired position.

C o m m e n t i n g  o n  K e y  F r a m e s

Key Frames, just like Markers, can be commented on. Double-click a Key Frame to open an entry field. You can 
enter comments of up to 25 characters. Confirm your entry with OK. The Key Frame comment becomes visible 
if the mouse pointer remains on the Key Frame for more than one second.
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Additional Key Frame Tools

You can use the toolbar below the video inlay to control the sequence of an effect. In addition to the default 
functions, the function library tab in the Effect Viewer contains special functions for editing effects. For more 
information, see: “Customizing Toolbars”  on page 17-8.

P r e v i o u s  K e y  F r a m e

Moves the Playline back to the previous Key Frame.

N e x t  K e y  F r a m e

Moves the Playline forward to the next Key Frame.

G o t o  P r e v i o u s  M a r k e r

Moves the Playline back to the previous Marker.

G o t o  N e x t  M a r k e r

Moves the Playline forward to the next Marker.

M o v e  C a n v a s

Click this button to move an image on the Canvas. This function only works if you have zoomed in 
( page 10-17) on the Canvas. You can now drag the image within the video inlay. Right-double-click the video 
inlay to restore the default Canvas size.

S a f e  A c t i o n  A r e a / T i t l e  M a r k s

Click this button to superimpose Safe Action and Title Marks on the image visible in the Effect Viewer. (This has 
no influence on image output.)
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Acceleration Curve

The acceleration curve, located to the left of the Effect Viewer, is used for defining the rate of change between 
two Key Frames. Clip images are interpolated based on the set curve. The x-axis of the grid represents time; the 
y-axis, change. 

For example...  page 10-23

Linear acceleration  page 10-24

Splined acceleration  page 10-24

Default acceleration curve  page 10-25

Accelerate - decelerate  page 10-27

Acceleration range  page 10-28

F o r  E x a m p l e . . .

For example, you have an effect with two Key Frames. The first Key Frame is called KF1; the second, KF2. To 
keep things simple, the only difference between KF1 and KF2 is the color of the clips’ borders: With KF1, the 
image has a red border, while with KF2 it has a blue border.

The beginning of the effect is represented by KF1 (red border). KF1’s values are positioned at the bottom left-
hand corner of the grid. KF2’s values are in the top right-hand corner (blue border). The horizontal axis 
between KF1 and KF2 is the time axis; the vertical axis represents the change in the effect, in this case, the color 
of the border.

Default acceleration 
curve
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L i n e a r  A c c e l e r a t i o n

The diagonal line through the grid shows that there is a steady rate of change over the duration of KF1: border 
color changes steadily from red to magenta to purple to blue as you run the effect. This is linear acceleration, the 
rate of change is constant from beginning to end.

Linear acceleration 

S p l i n e d  A c c e l e r a t i o n

You can also set a splined acceleration so that the rate of change varies over time. Splined acceleration is dis-
played as a curve. There are two types of acceleration splines you can use on an effect: Default Acceleration 
Curve or Accelerate - Decelerate. These options are available in the shortcut menu.

You can set an acceleration curve three ways:

� Drag the acceleration line with the mouse.

� Drag the slider under the Acceleration field at the bottom of the box.

� Enter a value in the field next to the slider.
All three displays reflect the defined acceleration curve.
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You can define a different acceleration curve for each Key Frame in an effect, but you can only assign 
one curve to each Key Frame. This means that the same acceleration curve applies to all the changes 
which occur between two given Key Frames. In other words, if the Key Frames change both image size 
and border color, the same acceleration curve applies to both size and color interpolation.

D e f a u l t  A c c e l e r a t i o n  C u r v e

The figure below shows a positive acceleration setting in default mode. In the case of positive function curves, 
the rate of change is high directly after the first Key Frame at the beginning of the effect (KF1) and lower 
towards the end of the effect (KF2). With an acceleration setting of 85, for example, border color may change 
from red to magenta to purple all in the first half of the effect. The change from purple to blue would then be 
much slower and occur in the second half of the effect.

Positive acceleration
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The figure below is an example of a negative function curve in default mode. In the case of negative function 
curves, the rate of change is low directly after the first Key Frame at the beginning of the effect (KF1) and 
increases towards the end of the effect (KF2). With an acceleration setting of -85, for example, border color may 
take the first half of the effect to change from red to magenta. The change from magenta to purple to blue is 
much quicker, and occurs in the second half of the effect.

Negative acceleration
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A c c e l e r a t e  -  D e c e l e r a t e

The other mode for splined acceleration is Accelerate-Decelerate. In this mode, the rate of change varies twice. 
The figure below illustrates an example of a positive setting in this mode. 

Positive accelerate-decelerate curve

Rate of change is higher at the beginning and end of the effect, and lower in the middle.
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With negative accelerate-decelerate settings, the rate of change is lower at the beginning and end of the effect, 
and higher in the middle of the effect, as shown in the figure below.

Negative accelerate-decelerate curve

A c c e l e r a t i o n  R a n g e

In both splined modes, the acceleration range is +/- 100; 0 is the default setting and corresponds to linear accel-
eration. At 100, the acceleration path is a right angle: all changes between Key Frames occur at KF1. In our 
example, the border color would change from red to blue immediately, then stay blue for the rest of the effect. 
With a -100 setting, no change would occur until KF2: the border stays red for all of KF1, then instantly changes 
to blue at KF2. In both cases, there are no intermediary steps; the color changes instantly without the magenta 
and purple transition stages. This is similar to a cut, as opposed to a dissolve: the Key Frame settings “jump” 
without interpolation.
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Effect Parameters and Options

Using the two tabs to the left in the Effect Editor, you can customize the effect parameters and other options.

E f f e c t  P a r a m e t e r s  T a b

The left-hand tab contains in its drop-down menus all parameters for the given effect. 

Effect parameter tab and Border Inside drop-down menu (2D Editor)

When generating effects, there are several ways of adjusting the Effect Editor parameters: 

� by selecting an item from a drop-down menu,

� using a slider or knob, 

� entering a numeric value, 

� activating a tool button and moving the mouse within the video inlay, 

� selecting colors in a color selector.

Certain related functions that are set using a slider (such as width and height) can be linked together by clicking 
the Lock button (Lock icon closes). In this case, any changes made to one parameter directly affect the other. If 
the Lock icon is open, parameters can be set separately.

� To fine-tune effect parameters, it is recommended that you use the mouse wheel on your wheel 
mouse.

Lock button

Activated

Deactivated

Diamond button
(Key Frame)

Drop-down
arrows

Drop-down menu

Reset button
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O p t i o n s

The Options tab contains three drop-down menus:

� Alpha - lets you deactivate an existing alpha channel and create a new one, e.g. for title graphics.

� Key Frames - lets you define whether Key Frames are to be used in the effect. 
It is advisable not to use Key Frames if the effect maintains constant parameters throughout the time 
sequence.

� Render Options - lets you define whether the effect should be computed in fields or frames.

Normally, the Render Fields option should be selected. The Render Frames option is useful only for cer-
tain effects (for example, for some key effects it helps obtain better key results). However, if the end 
product is “film” -- which also includes AVI and Quicktime movies -- the frame setting is helpful 
because the editors then render in frame mode.

Options tab
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Toolbar

The toolbar located below the tabs and acceleration curve contains special effect editing buttons. To customize 
the buttons on this toolbar, drag them from the General tab in the Customize window. (See also “Customizing 
Toolbars” on page 17-8.)

R e s t o r e  I n i t i a l  S t a t e

Restores initial state (to when editor was first opened).

R e s t o r e  t o  D e f a u l t

Resets all parameters to the default factory settings.

S w a p  S o u r c e s

Use this button to toggle between the incoming and outgoing clips of a Transition effect in order to apply the 
given effect to the other clip.

R e v e r t  D i r e c t i o n  o f  E f f e c t

Click this button to reverse the direction of the effect.
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Effect Editor Shortcut Menu

An Effect Editor’s shortcut menu contains options for adjusting effect settings.

U n d o

Click Undo to cancel the last action you performed and return the effect to 
the state it was in before you performed that action. Pinnacle Liquid notes the 
last 64 changes you made during any given effect editing session, permitting 
you to revert to practically any previous state.

�CTRL + Z

R e d o

Click Redo to cancel the last undo action you performed and return the effect 
to the state it was in before you used the Undo function (up to 64 steps).

�CTRL + Y

The Undo and Redo buttons are available on the toolbar under the tabs and pop-ups.

C u t

Click Cut to delete the Key Frame at the Playline from the effect and copy it to the clipboard. You can then use 
Paste to insert the cut Key Frame elsewhere in the effect.

� CTRL + X

C o p y

Click Copy to copy the Key Frame at the Playline to the clipboard, without deleting it from the effect. You can 
then use Paste to insert the copied Key Frame elsewhere in the effect.

� CTRL + C

P a s t e

Click Paste to insert a cut or copied Key Frame from the clipboard into the effect at the position of the Playline.

� CTRL + V

Effect Editors shortcut menu
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C u t  >  ( w i t h  s u b m e n u )

Click Cut > to open a submenu for specifying which properties you want to remove from a given Key Frame. 
For example, you can clear the rotation values of the Key Frame while maintaining its current size. The cut 
properties are placed on the clipboard in case you want to paste them into other Key Frames.

C o p y  >  ( w i t h  s u b m e n u )
Click Copy > to open a submenu for specifying which properties you want to copy to the clipboard from a given 
point in an effect. This lets you, for example, copy a setting that can then be pasted into several Key Frames.

P a s t e  >  ( w i t h  s u b m e n u )
Click Paste > to open a submenu for specifying which properties in the clipboard you want to apply to a given 
point in an effect. For example, if you cut or copied an entire Key Frame to the clipboard, you can apply only its 
size settings to one Key Frame and its rotation settings to another.

If you paste a property that you have not previously copied or cut, Pinnacle Liquid uses the property’s 
default settings. For example, if you paste size without an existing size setting in the clipboard, Pinnacle 
Liquid sets Key Frame to size 100%.

P a s t e  t o  a l l  K e y  F r a m e s
Click Paste to all Key Frames to apply the contents of the clipboard to all Key Frames in the effect.

You can also use the diamond icons on the tab item bars to copy and paste Key Frames. To do so, drag 
the diamond icon of the particular parameter to a Key Frame on the position bar to copy these settings 
or drag it to the inlay to copy the settings to all Key Frames.

S h o w
Click Show to open a menu for controlling the display of the preview in the Effect Viewer. These settings do not 
affect the effect itself; they are merely display options for customizing the appearance of the clip in the preview. 
You can enable and disable the following functions (a check mark next to an item means that it is enabled):

� Background
- when enabled, the lower-priority video on the Timeline (background image) is visible when you move, 
key, or resize the foreground image. When disabled, or if there are no lower priority layers on the Time-
line, the background is black.

� Foreground 100% 
- makes the foreground image completely opaque. No background is visible in areas in which fore-
ground and background overlap.

� Foreground 75% 
- makes the foreground image partially transparent. The background shows through the foreground 
image.
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� Foreground 50% 
- makes the foreground image semi-transparent. 

� Foreground 25% 
- makes the foreground image very transparent. Use this setting when the 75% or 50% settings are not 
transparent enough to let you see details in the background.

If you are creating a transition effect in which you are modifying the background as well, use this func-
tion to be able to edit the background image if it is fully covered by the foreground image.

P r o p e r t i e s

Click Properties to open the Properties dialog box which contains three tabs for adjusting effect and preview 
quality. For more information on this subject, see “Rendering and Preview Quality (relevant only for Classic 
Effects)”  on page 10-37. 

Deactivating Modified Settings

A concave (pushed in) square on the tab item bar indicates that the settings in that 
drop-down have been modified (i.e. are no more the default settings) and are acti-
vated.

To deactivate all the values in a drop-down menu, click the square so that it appears 
normal (not pushed in). Note that this does not reactivate the default settings - it merely prevents the settings 
from being applied to the effect.

Copying Settings to Key Frames

Drag the diamond in the tab item bar to a Key Frame on the position bar to apply the drop-down menu settings 
to that Key Frame. You can also apply settings to a whole effect by dragging the diamond to the video inlay.

Closing Effect Editors (Start Rendering)

Click this button to close the Effect Editor. 

If necessary, Pinnacle Liquid begins rendering the changes made without asking for further confirmation. 
If no changes were made, nothing is rendered.

You can define how long it will be from the time you close the editor until rendering begins. (See also 
“Rendering and Preview Quality (relevant only for Classic Effects)” on page 10-37.)

activated

deactivated
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Effect Rendering

Resident programs (meaning programs that run in the background, such as antivirus programs) may 
block or interfere with rendering. Internet firewalls can also cause problems. Be sure to deactivate these 
programs while working with Pinnacle Liquid.

Render Viewer

Rendering occurs automatically in the background. During rendering a pulsating Sigma symbol appears on the 
taskbar. To monitor the rendering process, click the Sigma button to open the Render Viewer. 

Pinnacle Liquid also plays partially rendered transitions or clip effects on the Timeline. Where no ren-
dered data is available, a gray exclamation mark on a black surface becomes visible in the inlay while the 
Playline is over a section not yet rendered. 

Render Viewer

The Render Viewer displays the video image being rendered. Underneath the video inlay is a rendering status 
display:

� Click Stop Rendering to stop the rendering process.

� Click Start Rendering to start or resume rendering.

� Click the box to activate or deactivate rendering of the yellow slices (this enables/disables the back-
ground rendering of realtime effects). For more information, see “Render Management of Realtime 
Software Effects”  on page 11-7. 
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Any rendering process that has been stopped manually must also be restarted, otherwise no further 
rendering will take place.

� Click Close to exit the Render Viewer (the pulsating Sigma signal indicates that rendering is continuing 
in the background).

� “Idle” indicates that there is nothing to render.

� During rendering, a display appears with information on the rendering status (remaining time, number 
of frames rendered, etc.).

A Timeline Slice above a segment that contains non-rendered effects is displayed in red. From left to 
right, this area gradually disappears from the Slice as rendering progresses.

Deleting Render Files
Render files, i.e. files created when effects or timewarp clips are rendered, can be deleted selectively.
It may become necessary to delete render files; for example, after a Batch Digitize operation you may want to 
perform a manual re-rendering of effects on the basis of the newly digitized material. Or you may want to delete 
files you no longer need in order to make room on the storage media. The following options are available:

D e l e t e  F u n c t i o n s  i n  t h e  D e s k t o p  T r a s h  I c o n
The shortcut menu for the Trash icon on the desktop contains a number of options for deleting render files that 
apply to the current Project. Select: 
Delete Render Files Of Project:...

� Not used by any Sequence -
This option deletes render files that do not reference any existing Sequences in the Project.

� Not used by current Sequence -
This option deletes all render files except those used in the Sequence currently located on the Timeline.

� Not used by Sequence(s) selected in Project window -
This option deletes all render files except those belonging to the Sequences selected in the Project win-
dow.

D e l e t e  F u n c t i o n s  i n  t h e  T i m e l i n e  S h o r t c u t  M e n u
These delete functions are applied to render files belonging to the Sequence currently located on the Timeline. 
Select:

Delete Render Files...

� between Mark-In/Out -
to delete files selectively or

� of current Sequence (all) -
to delete all the render files of the Sequence.
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Rendering and Preview Quality (relevant only for 
Classic Effects)

Use an effect’s Properties window to control rendering and preview quality. There are two ways to open this 
window:

� On the Effect Editor’s toolbar, click the Effect Editor’s Shortcut Menu Button > Properties.

� Click Edit > Control Panel > Site > FX Editor Properties.

R e n d e r  Q u a l i t y

Use the Render Quality tab to adjust rendering quality settings. You can choose between Best Quality, High 
Quality and Preview Quality. Use the Best Quality option for creating masters. 

Pinnacle Liquid renders effects in the YUV color space, in uncompressed YUV quality and on a sub-
pixel basis. 

P r e v i e w  Q u a l i t y  

Use the Preview Quality tab to control preview quality. You can choose between Best Quality, High Quality and 
Fast Preview. So that results appear more quickly during previewing, use the Best Quality Last and Fast Preview 
First functions. For example, use both Best Quality and Fast Preview First so that when you are editing a fast 
preview is shown and afterwards the best quality appears. Use High Quality with Best Quality Last and Fast Pre-
view First for an additional quality step. 

S y s t e m

The System tab lets you optimize your computer system for Pinnacle Liquid effects. See your product manual 
for details.
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Saving Individually Created Effects 

An effect which was created using one of the Effect Editors may be saved and renamed for later use. That’s how 
to proceed:

1 Create the effect, insert it on the Timeline either as clip effect or Transition.

2 Open the shortcut menu of the effect by clicking the colored line or the effect icon (Clip FX only), or in 
case of a Transition open the shortcut menu of the Transition.

3 Select Copy.

4 In the Project choose any Rack other than Library  and add the effect selecting Rack shortcut menu > 
Paste.
The same menu also features the Rename option.
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Detailed Description of Classic Effect Editors

This section provides detailed descriptions of the Effect Editors available in Pinnacle Liquid as well as step-by-
step examples for creating transitions and clip effects. It covers the following topics:

Transition Effect Editors: Basics  page 10-40

2D Editor for Transitions  page 10-42

3D Editor for Transitions page 10-51

Step-by-step: Creating a Transition 2D effect  page 10-47

Wipe Editor for Transitions  page 10-52

Step-by-step: Creating a Transition wipe effect  page 10-54

Clip FX 2D Editor  page 10-56

3D Editor for clip effects  page 10-57

Clip FX Wipe Editor  page 10-69

Color Editor  page 10-70

Keying Editor  page 10-73

Filter Editor  page 10-84
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Transition Effect Editors: Basics

Transitions always require two video signals. The simplest type of transition effect is a Dissolve in which the clip 
to the left of the Transition on the Timeline (outgoing clip) is mixed with the second clip (incoming clip). This 
involves two video signals. The parameters of these signals can be controlled in the Effect Editors.

Transition Wipe Editor

One of the participating signals can also be “black”. This is the case if the Transition is positioned at the 
beginning or end of a clip and thus touches an empty position (= “black”) on the Timeline. Examples: 
fade-in, fade-out. See also ““Empty” Timeline” on page 9-5.

Outgoing/Incoming Clip

Transition effects are often much more complex than clip effects since they involve two clips in one editor. At 
some point in the Transition the clips are either in the foreground or background, as in the case of a wipe or 
slide. 

Incoming clip in the foreground

Outgoing Clip Incoming Clip
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When you open the 2D Editor for Transitions, on the right-hand side above the inlay the following button 
appears. Represented on the button are the two clips involved in the Transition effect: 

When editing a Transition effect you have to distinguish between the outgoing and incoming clip. Click the left 
or right area of this button to define which clip is active for modifying. In the screenshot above, the incoming 
clip can be modified. Regardless of which tool you now use, any changes you make are applied to the incoming 
clip. To make changes to the outgoing clip, the other side of the button has to be clicked.

The button also shows which clip is in the foreground and which is in the background. 

Background/Foreground

Whether a clip is in the foreground or background determines when and how this clip partially or fully covers 
the other clip during the transition. Foreground/background defines “priority”. 

There are two ways of defining background and foreground for the selected clip:

� click the Send Clip to Foreground/Background button on the right-hand side of the toolbar in the Effect 
Editor 

� click the Priority drop-down menu, Background or Foreground:

Click Background if you want the clip to remain in the background and be fully or partially covered by the fore-
ground clip, depending on the effect. 

Outgoing clip

Background

Incoming clip

Foreground
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Transfer Mode (Compositing Operation)

In the case of a foreground clip, various functions (Transfer Modes, formerly compositing operations) are 
available for defining how it covers the background clip. 

The options available are more or less the same as those available in advanced graphics software.

Use the Send Clip to Foreground/Background button to toggle between the background and the fore-
ground option specified in the Priority dialog box. Remember that this function has an influence on the 
effect. To process a background clip that is not visible, either decrease Canvas size (using the Zoom but-
ton or right-dragging the area) or adjust the transparency of foreground clip display (Effect’s shortcut 
menu > Show > Foreground #%). 

2D Editor for Transitions

The 2D Editor for Transitions is used for generating 2-D effects. Since these effects consist of two clips they can 
be rather complex. Key Frames are used to define the dynamics of such effects.

Opening the Effect Editor

There are several ways to open the 2D Editor for transitions:

� In the Project window, click Library  > Folder Classic Transition FX > Editors. Drag 
the 2D Editor from the content area to a cut on the Timeline. Right-click the effect, 
then click Edit in the shortcut menu to open the editor with the corresponding clips.

If you have already created a copy of the editor in a Rack other than Library: Click Open 
in the shortcut menu or simply double-click the effect.
In the Effect Viewer, the default graphics appear. In general, an effect preview runs more quickly and smoothly 
with these test graphics than with video clips, so it is advisable to use this method to open the 2D Editor if you 
only want to test effects.

� The 2D Editor button in the Master Viewer’s toolbar is used for opening the 2D Editor. If you now click 
on an already existing transition in the Timeline, this Transition will be loaded into the Editor, which 
now also assumes the functionalities of the 2D Editor for transitions.

Most of the functions in the 2D Editor can be controlled both by mouse, button, slider and/or edit field. Work-
ing with the drop-down menus often permits you to be more precise, since you can enter exact numerical val-
ues and fields can be controlled manually (see also Effect Parameters and Options on page 10-29).
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Double-click the video inlay to restore the default settings of the activated button.

2D Editor for Transitions

Position
Use this function to control the horizontal and vertical positioning of the incoming and/or outgoing clip. 

� Adjusting settings in menu: 
Move the sliders to a particular position/value between +/- 400 % (four times the image width or image 
height). Click Center Image to position a clip in the middle of the video inlay.

� Adjusting settings directly in video inlay: 
Click the Position button. Drag clips directly in the Effect Viewer for rough positioning.

� If you hold down the CTRL key and drag the mouse, the vertical axis will change with respect to 
a fixed horizontal axis. If you hold down the SHIFT key, the horizontal axis will change while the 
vertical axis remains fixed.

Size
Use this function to control image size. 

� Adjusting settings in menu: 
Move the Width and Height sliders to a particular position/value between 0 and 400 %. If you want 
width and height to be controlled simultaneously (aspect ratio), click the Lock button. Click Original 
Size to restore the object in the Effect Viewer to its original size. Click Fit to full Size to adjust a smaller or 
larger image to the size of the Effect Viewer.

� Adjusting settings directly in video inlay:
Click the Size button. Drag clips directly in the Effect Viewer for rough sizing.

� SHIFT+click to disable the Lock function and modify width and height by dragging the mouse 
up/down or left/right.
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Rotation

Use this function to control rotation. 

� Adjusting settings in menu:
Move the Angle knob to a value between 0° and 360° to set the spin angle. With Spins specify the 
required number of rotations within the course of the effect (0-100). Activate either Clockwise or Coun-
ter Clockwise rotation.

� Adjusting settings directly in video inlay:
Click the Rotation button. Drag clips directly in the Effect Viewer to define rotation. 

� Hold CTRL or SHIFT keys while dragging to rotate the image in 90 or 45 degrees increments.

With a Spin of 0, a clip rotates until it reaches the position specified under Angle. To spin a clip more 
than one full rotation, but less than an additional full rotation, set the required additional amount 
under Angle. For example, if you start with an angle of 0° and set Angle to 180° and Spins to 3, the clip 
will rotate three and a half times (3 x 360° and 1 x 180°). 

Border Inside

Use this function create a border within a clip’s area and control its dimensions. An inside border reduces the 
dimensions of a clip. 

� Adjusting settings in menu: 
Move the Height and Width sliders to values between 0 and 100% (in relationship to the clip’s dimen-
sions). 
Click Softness to create a soft edge along the inside edge of the border.
Set Transparency to 0 to 100 to define border transparency.
Under Color, specify a border color; specify a second color under 2nd Color to create a color gradient 
within the border. 
If you selected a gradient under Blend, move the Direction slider to specify the angle of a gradient (0-
180°).

� Adjusting settings directly in video inlay: 
Click the Adjust Inside Border button. Drag the mouse pointer on the video inlay to define border size.
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Border Outside

Use this function to create a border along the outside edge of a clip. Adding a border increases the dimensions 
of a clip. 

� Adjusting settings in menu:
All functions operate the same as those described under Border Inside. The only difference is the small 
square in front of the Softness slider, which can be used to specify rounded or right-angled border 
edges.

� Adjusting settings directly in video inlay: 
Click the Adjust Border Outside button. Drag the mouse pointer on the video inlay to define border size.

When you change the size of a clip, border width is automatically scaled up or down to maintain the 
original ratio of border width to clip size.

Shadow

Use this function to create a shadow. 

� Adjusting settings in menu:
Set X and Y Offset to specify a clip-to-shadow distance (= offset) of +/- 50% (in relationship to clip 
width and height). 
Specify a value under Softness to define shadow edge softness; 
specify a value under Transparency to define shadow transparency. To create a colored shadow, specify a 
color under Color. 

� Adjusting settings directly in video inlay: 
Click the Shadow button. Drag the mouse pointer on the video inlay to define a shadow.

Cropping

Use this function to crop a clip. 

� Adjusting settings in menu:
Move the Top, Bottom, Left and/or Right sliders to crop the different sides of a clip between 0 and 100% 
(in relationship to clip dimensions). 

� Adjusting settings directly in video inlay:
Click the Cropping button. Drag the mouse pointer on the video inlay to crop the picture.
At the edges of the picture the mouse pointer changes its form to indicate the cropping direction (from 
top, bottom, left, right).
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Mirror

Use this menu to mirror clips horizontally and/or vertically.

Trailing

Use this function to create a trail. A “trail” is an effect in which a clip is followed by a series of several copies of 
itself.
 To create a trail, click this button. In the dialog box that appears, move the Frame slider to specify the number 
of frames that should follow (maximum of 20). Move the Offset slider to define the distance between the indi-
vidual copies. With the maximum setting of 100, only one trail frame appears in the Effect Viewer. The smaller 
the value, the tighter/denser the trail. Under Transparency specify trail transparency - the last frame has the 
specified transparency. Click Foreground or Background to instruct the system to display the trail in front (on 
top) of the clip or behind (underneath) it.

Transparency

Use this function to define the transparency of a clip in front of a background.

You can enter a value between 0 and 100 (completely transparent). With Edge Softness you can create a trans-
parency gradient, in which transparency increases towards the edge of the clip. With an edge softness of 100 
(maximum setting), clip contours practically disappear. Edge Softness also alters a clip’s outside border.

Transparency values in overlapping areas of a clip are handled cumulatively. For example if you specified 
a transparent inside border, this transparency is added to the transparency of the overall clip or to that 
of Edge Softness.
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Step-by-Step: Creating a Transition 2D Effect

1 Position the two clips between which you plan to create a Transition on the Timeline. In this example, 
the outgoing clip contains paint spots, while the incoming clip contains a rose dipped in paint. In the 
Transition effect, the rose clip starts out as a small picture in the top right-hand corner and, after a few 
rotations around its own axis, expands to fill the entire video inlay. The clip with the paint spots should 
also have a transparent border.

Outgoing clip (left) and incoming clip (right) still without transition

2 In the Project window, click Library  Tab > Folder Classic Transition FX > Editors in 
the tree area. Drag the Classic Transition FX 2D Editor to the cut between the two 
clips.
If the transition is not completely gray (i.e. fully or partially red), insufficient leeway 
was provided on either the start, end or both sides of the Transition. In this case, trim 
the mark-in and/or mark-out of the clip(s) until the red disappears (See also “Leeway 
(Overlap)” on page 9-36.)
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3 Right-click the Transition to open the Effect Editor’s shortcut menu. Click Edit to open the 2D Editor.

4 The 2D Editor appears above the Timeline (that is, if the specific view is acti-
vated). The incoming clip appears in the Effect Viewer. The Edit Outgoing/
Incoming Clip button above the Effect Viewer on the right shows that the 
incoming clip is defined as the foreground clip (hence, as the “priority” clip 
it can be edited) and the outgoing clip (paint spots) as the background clip. 
This is the default setting: incoming clip = foreground. 
The effect is one second long as can be seen in the timecode display on the 
right (the duration can also be changed here). Two Key Frames at the begin-
ning and end of the effect appear on the position bar. The Playline is located 
at the beginning of the position bar at the first Key Frame.

Incoming clip (foreground) in Effect Viewer

5 Now you can edit the effect. First define its initial state at first Key Frame. To do so, click the Size button 
to reduce the size of the rose-being-dipped clip (you can make the clip as small as you like, even so 
small that you cannot recognize the image it contains). 
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Click the Position button to move the clip to the top right-hand corner (see below).
Make sure the Playline is located at the first Key Frame.

6 Now define the final state of the effect. To do so click the Goto Next Key Frame button to move the Play-
line to the Key Frame at the end of the position bar. Set Size and Position to default to adjust the clip so 
that it fills the entire inlay as the foreground image.

Jump to second Key Frame 

7 In the drop-down menu on the left of the editor, click Rotation. Set the Spins slider to 3 full rotations. 
Activate Counter Clockwise.

Set Spins to 3 
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8 To define a narrow, transparent blue outside border for the incom-
ing clip, open the Border Outside drop-down menu.

Specify an appropriate border width for the small picture under 
Width; adjust Softness and Transparency. To define a color either click 
the Color box to open the color selector and select a color or click any-
where on the desktop. All changes you make to settings are automati-
cally reflected in the object. 

9 Start a “preview” of the effect by shifting the Playline from left to 
right. As the small picture moves away from the corner, it rotates 
three times and at the same time the blue border and the other attributes appear, until it fills out the 
entire Effect Viewer. An intermediate stage appears in the screenshot below.

10 Close the editor by clicking the Close Editor button in its top right-hand corner. Background rendering 
of the effect begins immediately. You can monitor this process in the Render Viewer. To do so click the 
Sigma button. See also “Render Viewer” on page 10-35.
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3D Editor for Transitions

The 3D-Editor for transitions is used for generating 3D effects between two clips.

The 3D Editor has four drop-down controls in addition to those of the 2D Editor. They are: 

� Rotation - Defines rotations of the image in space (“Rotation”  on page 10-59).

� Camera - Defines the position of the virtual camera in space (“Camera”  on page 10-63).

� Shear - Distorts the image along the edges ( page 10-65).

� Pageturn - Contains the parameters for the Pageturn effect (“Pageturn”  on page 10-66).

For a comprehensive description of all 3D features please turn to “Clip FX 3D-Editor”  on page 10-57 pp.
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Wipe Editor for Transitions

The Wipe Editor creates an alpha channel. This channel operates like a mask placed on top of a clip which 
causes only parts of the clip to appear. In the case of a transition wipe effect, the image data of the other clip 
(incoming or outgoing clip) can be adjusted at the same time. 

Opening the Wipe Editor for Transitions:

There are three ways to open the Wipe Editor for Transitions:

� In the Project window, click Library  Tab > Folder Classic Transition FX > Edi-
tors. Drag the Wipe Editor from the content area to a cut on the Timeline. Right-
click the effect, then click Edit in the shortcut menu to open the Editor with the 
existing clips.

� If you have already created a copy of the editor in a Rack other than Library : Click Open in the short-
cut menu or simply double-click the effect.
In the Effect Viewer, the default graphics appear. In general, an effect preview runs more quickly and 
smoothly with these test graphics than with video clips, so it is advisable to use this method to open the 
Wipe Editor if you only want to test effects and view them in the editor or if you would like to create your 
own standard effects that are not meant for any particular clips.

� The Wipe Editor button in the Master Viewer’s toolbar is used for opening the Wipe Editor. If you now 
click an already existing transition in the Timeline, this transition will be loaded into the Editor, which 
now also assumes the functionalities of the Transition FX Wipe Editor.

The Wipe Editor’s functions are essentially identical to those of the 2D Editor, the only difference being the addi-
tion of the Pattern and Gaussian Blur menus ( page 10-87).

For a description of all other Wipe Editor functions, see “2D Editor for Transitions”  on page 10-42.
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Wipe Editor for transitions

Pattern

� First select the shape of the Wipe areas: Rectangle or Circle.
You can select a gradient (see Transparency > Softness).

� Use the Repeat X and Repeat Y sliders to define how many wipe areas you want to create (“wipe areas” 
refer to the individual elements of a pattern). 

� Repeat X divides a picture up into a number of areas along the horizontal axis; Repeat Y does the same 
along the vertical axis. In the above screenshot, Both Repeat X and Repeat Y are set to 3, thereby result-
ing in 9 wipe areas. These areas were then rotated with the Rotate button. 

� Use the Mirror X Repetition and Mirror Y Repetition functions to mirror wipe area rows or columns 
along the center axis. See examples below:

No mirroring (left), mirrored Y repetition (center) 
and mirrored X repetition (right)

It is not possible to make changes to the individual areas of a wipe - they can only be changed collec-
tively. In other words, any change you make to a border, rotation, transparency, etc. is applied to all 
wipe areas in the same ma1nner.
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Step-by-Step: Creating a Transition Wipe Effect

1 Position the two clips between which you plan to insert a wipe transition on the 
Timeline. In the Project window, click Library  Tab > Folder Classic Transition 
FX > Editors in the tree area. Drag the Transition FX Wipe Editor to the cut 
between the two clips.

If the transition is not completely gray (i.e. fully or partially red), insufficient leeway was provided on 
either the start, end or both sides of the transition. In this case, trim the mark-in and/or mark-out of the 
clip(s) until the red disappears (See “Trimming Objects” on page 9-60.) 

2 Right-click the transition to open the Effect Editor’s shortcut menu. Click Edit to 
open the Transition FX Wipe Editor.

In this example, the incoming clip of a water glass is in the foreground. Hidden under-
neath it is the outgoing clip, a picture of a paint can. The effect is as follows: the water 
glass is located in a grid of nine rotating fields (wipe areas) that slowly become larger and 
gradually cover the paint can.

3 Make sure the incoming clip is in the foreground and that the Playline is on the first (left) Key Frame. 
First you have to define the initial state of the incoming clip.

4 To do so, open the Pattern drop-down menu and set both Repeat X and Repeat Y to 4.

5 Open the Size drop-down menu and set both Width and Height to 0% to reduce the size of the clip to 
nothing. This can also be done with the Size button.

Effect Editor’s 
shortcut menu
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6 Open the Rotation menu and set Rotation to 90 degrees. This can also be done with the Rotation button. 

Example of a transition wipe

7 Close the editor by clicking the Close Editor button in its top right-hand corner. Background rendering 
of the effect begins automatically. You can monitor this process in the Render Viewer. To do so click the 
Render Viewer button (Sigma).
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Clip FX 2D Editor

In contrast to the Transition FX 2D Editor, the Clip FX 2D Editor exclusively works with individual clips. 

Opening the Clip Effect 2D Editor

There are several ways to open the clip effect 2D Editor and load a clip for editing (see also Opening Effect Edi-
tors and Editing Clips (= Applying FX Editors) on page 10-13):

� Click the Open 2D Editor button on the toolbar to the right of the Master Viewer.
Click a clip to load it into the editor.

� If you have already created a copy of the Editor in a Rack other than Library : Click 
Open in the shortcut menu or simply double-click the effect.
Click a clip to load it into the Editor.

� In the Project window, click Library  Tab > Folder Classic Clip FX > Editors in the tree area. Drag the 
clip effect 2D Editor from the content area to a clip on the Timeline. Right-click the effect. In the short-
cut menu that appears, click Edit.

Clip effect 2D Editor

Unlike the Transition FX 2D Editor, this editor does not have Foreground/Background and Incoming/Outgoing 
functions since clip effects always only involve one clip. The background is always filled with a clip on a Track 
underneath it on the Timeline (if applicable). 

Otherwise the functions of the 2D Editor for clips are identical to those of the 2D Editor for transitions and are 
described there: “2D Editor for Transitions”  on page 10-42).

If you want the Key Frame effect to have a color background, simply position a color clip underneath the 
effect clip on the Timeline. (See “Track Priority” on page 9-21.).
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Clip FX 3D-Editor

The 3D Editor provides you with a further effect dimension; in addition to the x (horizontal) and y (vertical) 
axes, you can now work with the z axis. This axis creates the impression of space that adds “depth” to the direc-
tion of effect.

This section describes the 3D functions for both clips and Transition effects.
For information on the general operation of the Effect Editors (Key Frames, Key Frame interpolation, 
frame mode, etc.), please refer to“Effect Editors (Basics)”  on page 10-10 and “Clip FX 2D Editor”  on 
page 10-56. 

Opening the 3D Editor/Overview

There are several ways to open the 3D Editor and load a clip for editing (see also Opening 
Effect Editors and Editing Clips (= Applying FX Editors) on page 10-13):

� In the standard view of the Pinnacle Liquid user interface, click the 3D Editor button 
located beside the other Effect Editor buttons, to the right of the Master Viewer. Then 
single-click the clip you want to edit in the Editor.

� Drag the 3D Editor from the Library  tab to a clip or a Transition between two clips. The Transition 3D 
Editor in the default configuration it is located in the Folder Classic Transition FX > Editors. 
Then open the Editor shortcut menu by right-clicking either the effect button for the clip or the colored 
line that appears at the upper edge of the clip. Select Edit to open the 3D Editor. 

If you use the 3D Editor for a transition effect, open the Transition shortcut menu and click Edit.

Special Feature of the 3D Editor: The Z Axis

In the default configuration, the Z axis is perpendicular to the monitor surface and extends into the depth of an 
imaginary space. The three axes x, y, z are at right angles to one another. 

3 Axes: x, y, z

x

z

y
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For better orientation and handling, the three axes are superimposed on the image in the viewer. The axes 
become visible when you start editing parameters. 

You can continue to apply effect parameters such as Size, Borders, Transparency and Trailing with the 3D Editor 
because it also contains the standard functions of the 2D Editor for both clips and transitions.

Differences from 2D Editor

The 3D Editor has four drop-down controls in addition to those of the 2D Editor. 

� Rotation - Defines rotations of the image in space.

� Camera - Defines the position of the virtual camera in space.

� Shear - Distorts the object in two dimensions.

� Pageturn - Contains the parameters for the pageturn effect.

You can move the slider with the mouse, enter values in the text boxes, or use the function buttons.

Position

This option lets you define the movement of the image along the two spatial axes:

� Position X - Horizontal movement (left/right; range of slider +/- 400 percent).

� Position Y - Vertical movement (up/down; range of slider +/- 400 percent).

� Position Z - Movement into the depth of the space (“backward”/“forward”, range of slider +/-  400 per-
cent).

A shift of 100 percent corresponds to one full image width or frame height (NTSC: 720/486 pixels; PAL: 720/
576 pixels).

Setting parameters in the video inlay:

Click the Position button and drag the image to the desired position. Hold down the

� CTRL key while dragging to move the image exactly vertically.

� SHIFT key while dragging to move the image exactly horizontally.

� ALT key while dragging to move the image exactly along the z axis.
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Rotation

This option lets you set image rotation around the central horizontal axis (x), the central vertical axis (y) and 
the axis perpendicular to the center point of the image section (z). You can also move the pivot point.

Axes of rotation  page 10-64

Pivot point  page 10-65

Setting parameters in the inlay  page 10-64

Backside image  page 10-68

“Center point” and “central axis” refer to the geometric center of an existing image object (actual pixel 
size of the clip) whose pivot point (see below) has not been moved.
When a clip is cropped, the geometric center changes accordingly.

A x e s  o f  r o t a t i o n

A Spin control with two edit boxes is provided for each axis of rotation. The following general rule applies: If 
you change only one value, the image is rotated around an axis. If you change two or three parameters, it is 
rotated around a point.

Rotation Menu

3 5 9 °  s p i n  c o n t r o l

Hold down the mouse button and turn the knob by dragging the indicator. One full rotation corresponds to 
360°. With each complete rotation, the value in the Spins editable box (see below) is raised or lowered, i.e. the 
rotation counter changes each time you pass the 359° mark. 
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S p i n s  a n d  A n g l e  e d i t  b o x e s

If you wish to program several full spins over the effect duration, enter a value in the top box. Use the bottom 
Angle box to define a starting angle and/or to define an exact end position. For example:

To execute three three-quarter rotations from an upside-down starting position:

1 Start of effect (Key Frame 1)- Enter: “0” Spins, Angle “180” (or use the spin control)

2 End of effect (Key Frame 2) - Enter: “3” Spins, Angle “90”.

Pivot point

The Pivot Point is the point at which the rotations begin. In the default configuration, the Pivot Point is located 
at the geometric center of the image or nodal point of the camera (see below). In other words, the rotational 
axes intersect at this point. 

You can move this Pivot Point along the individual axes and thus move the center of rotation, as illustrated by 
the following example:

Move x pivot point to the left

If you wish to rotate the image around the left-hand vertical edge, set the x Pivot point to -50 percent (half the 
image width). The Pivot Point moves from the center to the left-hand edge. Now set the y Spin control: The 
image opens up like a window shutter.

x

z

y

x: - 50

Rotate y
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Now shift the y Pivot point to +50 percent: the point is shifted upward by half the image height to the upper left-
hand corner of the image.

Pivot point at top left-hand corner of image

Turning the y Spin control further has no effect other than what was described above because the Pivot Point is 
simply moved upward on the y axis. If you change the x Spin control, however, you will see a difference. When x 
and y are both changed, the image visibly rotates around a point - the upper left-hand corner. In actual fact, 
however, the intersection of the x-y-z axes is only diagonal in space. 

The gridlines on the Canvas (the 3D Editor work space) are excellent orientation aids for programming 
effects in three-dimensional space, especially when the Pivot Point is not located at the center of the 
image. 

The Zoom function allows you to view a larger work space. The plane spanned by the gridlines describes the 
default location of the z Pivot Point. If it was moved, its location is behind or in front of the plane, if not, it is 
exactly on that plane. 

S e t t i n g  p a r a m e t e r s  i n  t h e  v i d e o  i n l a y

Activate the Rotation or Pivot Point function and, inside the video inlay, drag the mouse pointer while holding 
down the:

� SHIFT key to rotate the image on the x axis/to move the pivot point to the left/right;

� CTRL key to rotate the image on the y axis/to move the pivot point up/down;

� ALT key to rotate the image on the z axis/to move the pivot point forward/backward;
CTRL and ALT simultaneously serve to rotate the image in 45-degree increments;

� No key to edit the x and y axes simultaneously.

x

z

y

x: - 50

Rotate x

y:
 +

 5
0
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Backside Image

If you rotate an image so that the back is visible, the same image appears but reversed left to right (default set-
ting). The area below the Spin control contains several functions for editing the appearance of the back.

F l i p  h o r i z o n t a l / v e r t i c a l

Activate the appropriate checkboxes to flip the back of the image horizontally and/or vertically.

C o l o r

To create a single-color backside, activate Color, click on the highlighted square, select a hue and, if desired, 
define a degree of opacity. If you set the color opacity to “100”, the color completely covers the back of the 
image. To adjust this setting, you can either use the slider or enter a value in the box. 

You can also use the Eyedropper (Pipette) function in the Color Picker dialog box to select a hue from any posi-
tion on the desktop and apply it to the back.
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Camera

The sliders in the Camera drop-down menu apply to a virtual camera whose “viewfinder” is represented by the 
fixed dimensions of the Effect Viewer. As with images, you can rotate the camera on three axes and change its 
Pivot Point. In addition, you can move the camera in space, and it is equipped with a function that allows you to 
change its field of view. Thus, you can change the examiner perspective.

Rotation  page 10-64

Pivot point  page 10-65

The menu has the same layout as the Rotation menu.

Drop-down Camera
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R o t a t i o n

As long as the Pivot Point is not moved in any of the three directions, the virtual camera’s pivot point is located 
exactly at its nodal point.

� X and Y correspond to the tilt and swivel movements possible for a camera mounted on a tripod. 

� Z permits a rotation on the image axis, i.e. it basically has the same effect as rotating the image itself on 
the z axis. 

3 5 9 °  s p i n  c o n t r o l

Hold down the mouse button and turn the knob by dragging the indicator. One full rotation corresponds to 
360°. With each complete rotation, the value in the Spins editable box (see below) is raised or lowered, i.e. the 
rotation counter changes each time you pass the 359° mark. 

S p i n s  a n d  A n g l e  t e x t  b o x e s

If you wish to program several full spins over the effect duration, enter a value in the top box. Use the bottom 
Angle box to define a starting angle and/or to define an exact end position.

S e t t i n g  p a r a m e t e r s  i n  t h e  v i d e o  i n l a y :

Activate the Rotation function for the camera (indicated by the four “viewfinder edges”) and, inside the video 
inlay, drag the mouse pointer while holding down the:

� SHIFT key to rotate the camera on the x axis;

� CTRL key to rotate the camera on the y axis;

� ALT key to rotate the camera on the z axis;
CTRL and ALT serve to rotate the image in 45-degree increments.

� No key to edit the x and y axes simultaneously.
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Pivot Point

The Pivot Point is the point around which the camera rotates. In the default configuration, the Pivot Point is 
located at the camera’s nodal point. In other words, the rotational axes intersect at this point. If you move the 
Pivot Point off center, the camera describes a circular movement around the actual center with each rotation, 
making it possible, for example, to circle the image with the camera. In the real world, this shift in the Pivot 
Point represents a revolution around a center point, which can also be located inside the object.

X ,  Y ,  Z  P o s i t i o n
These sliders allow you to change the position of the camera relative to the image plane. 

� X - moves camera horizontally (range of slider +/-400 percent).

� Y - moves camera vertically (range of slider +/- 400 percent).

� Z (distance) - moves camera forward or backward along an axis. This procedure is roughly the same as 
enlarging or shrinking the image; at the same time, however, the image position remains fixed on the 
image plane. Values below 100 move the camera closer to the image (0 is “inside the image”) and values 
above 100 move the camera further away (max. 1000).

F i e l d  o f  V i e w
This parameter allows you to enlarge or shrink the image section (range: 1.0 to 135.0°)

The default value is 50.4°. This is almost exactly the field angle achieved in still photography using a lens with a 
50 mm focal length. This lens creates a perspective corresponding to the field angle of the human eye.

S e t t i n g  p a r a m e t e r s  i n  t h e  v i d e o  i n l a y :
Activate the Pivot Point function for the camera (indicated by the four “viewfinder edges”) and, inside the video 
inlay, drag the mouse pointer while holding down the:

� SHIFT key to move the pivot point to the left/right;

� CTRL key to move the pivot point up/down;

� ALT key to move the camera pivot point forward/backward;

� No key to edit the x and y axes simultaneously;

� CTRL and ALT serve to rotate the image in 45-degree increments.

S h e a r  F u n c t i o n
Shear distorts the image along the x, y and z axes.

� X and Y - Distorts the image around the x or y axis on the z plane, i.e. in two dimensions. A rectangular 
image becomes a parallelogram.

� Zx and Zy - Combines Shear X or Shear Y with rotation around the Z axis.

Operation is the same as for the other 3D functions.
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3D Transition Effects and Multilayer 3D Clip Effects

As with the 2D Editor, the 3D Editor makes a distinction between Incoming/Outgoing clip and Foreground/Back-
ground when you apply the effect to two clips, i.e. use the effect as a Transition. The corresponding function 
button for switching between clips for editing can be found in the same location as in the 2D Editor, above the 
inlay. 

Z  P o s i t i o n

The Z position must be applied separately to the two clips belonging to a Transition. Because both clips exist in 
the same “z environment”, however, an overlapping is possible if the clip planes are modified accordingly.
When several clips are layered on top of one another (multilayer composite), the Track priority continues to 
apply, i.e. a clip on a higher Track superimposes images on lower Tracks regardless of the particular z positions. 
There are no intersections, nor are there gradual changes in the layering.

C a m e r a  P e r s p e c t i v e

A 3D transition involves two Cameras, one for each of the two clips. Multilayer composites retain their Camera 
settings when the 3D Editor is used.

Pageturn

Pageturn generates an effect that is similar to the turning of a page in a book. You can set the page-turn direc-
tion, back-of-image display, light accents and other parameters presented individually below:

Pageturn (some parameters not visible)
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R a d i u s

Defines the bend radius with which the image is uncurled. The higher the value, the further the bend.

C u r l  

Defines how far the image should be curled or the status at the start of the effect. For example, an image can 
already be partially curled at the start of the effect.

D i r e c t i o n

Defines the direction of the page turn, for example from the bottom left-hand corner toward the upper right-
hand corner. With the default setting 0°, the left-hand edge of the image is turned exactly horizontally toward 
the right, meaning that the Curl axis around which the image winds is parallel to the left-hand edge of the 
image.

When you change the angle during the effect or enter several spins (via the keyboard or by rotating the Spin 
control several times), the image uncurls several times over the four corners, i.e. the Curl axis rotates around the 
image center.

R o l l

When Roll is activated, the image is rolled up into a spiral, tighter or looser depending on the radius selected. 
When Roll is not activated, the image corner always remains visible when curled.

F r o n t  L i g h t

Sets a light accent on the inside of the bend (i.e. the front of the image). To define a color, click the Color box 
and select a color. Use the slider to set the intensity of the accent. You can also enter a value in the text box or use 
the Eyedropper (Pipette) in the Color Picker dialog box to select a color from anywhere on the desktop, including 
from the inlay.

S e t t i n g  p a r a m e t e r s  i n  t h e  v i d e o  i n l a y

You can apply the Curl, Radius and Direction functions directly to the Video Inlay. To do so, click the tool but-
ton and drag the mouse pointer inside the inlay while holding down one of the following keys: 

� No key: Curl (drag downward to lower the value and upward to raise it).

� CTRL key: Radius (drag downward to lower the value and upward to raise it).

� ALT key: Changes the Direction when you drag the mouse pointer in a circle around the center of the 
inlay. Drag counter-clockwise to lower the value and clockwise to raise it (0 to 360°). 
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B a c k s i d e  I m a g e  p a r a m e t e r s

The parameters in this group define the how the back of the turned page will be displayed. In the default config-
uration, the back of the image is the same as the front but reversed left to right.

F l i p  h o r i z o n t a l / v e r t i c a l

Activate these functions to flip the back of the image vertically and/or horizontally.

C o l o r

You can also apply a color to the image back. Click the highlighted square next to the slider to open the Color 
Picker dialog box. The slider alters the opacity of the color layer: 0% is transparent, 100% is opaque. Here, too, 
you can select a color using an Eyedropper (see description under Front Light).

H i g h l i g h t

Select this option to activate a light accent on the outside (back) of the bend and use the slider to adjust the 
intensity of the accent. Again, you can determine the color of the light (see description under Front Light).

H i g h l i g h t  d i r e c t i o n

Changes the position of the highlight on the outside of the bend. Move the slider to shift the highlight closer to 
or away from the corner of the image (default = 50).

H i g h l i g h t  f a l l o f f

Changes the softness of the highlight´s edges. A value of 0 creates a very broad and soft transition (default = 
50).

T r a n s p a r e n c y

Activate the checkbox and then either use the slider or enter a value to define the transparency of the turned 
page corner with relation to the image beneath it (front side of image).
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Clip FX Wipe Editor

When you create a wipe, an alpha channel is added to the clip. This channel operates like a mask placed on top 
of a clip which causes only parts of the clip to appear. The mask can take on many forms, and it can be ani-
mated. 

Opening the Clip FX Wipe Editor:
There are several ways to open the Wipe Editor for clip effects and load a clip for editing (see also Opening Effect 
Editors and Editing Clips (= Applying FX Editors) on page 10-13):

� Click the Open Wipe Editor button on the toolbar to the right of the Master Viewer.
Click a clip to load it into the editor.

� If you have already created a copy of the editor in a Rack other than Library : Click 
Open in the shortcut menu or simply double-click the effect.
Click a clip to load it into the editor.

� In the Project window, clickLibrary  Tab > Folder Classic Clip FX > Editors. Drag the clip effect Wipe 
Editor from the content area to a clip on the Timeline. Right-click the effect. In the shortcut menu that 
appears, click Edit.

Clip effect Wipe Editor

Unlike the Transition FX Wipe Editor, this editor does not have Foreground/Background and Incoming/Outgoing 
functions since clip effects always only involve one clip. In this case the priority is important because the wipe 
effect uncovers the image contents that are underneath the clip with the wipe effect.

Otherwise the functions of the Wipe Editor for clip effects are identical to those of the Wipe Editor for transitions 
and are described there: “Wipe Editor for Transitions”  on page 10-52).
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Color Editor

The Color Editor is used for controlling a clip’s coloring. Key Frames permit dynamic effects to be created. 

Opening the Color Editor

There are several ways to open the Color Editor for clip effects and load a clip for editing (see also Opening Effect 
Editors and Editing Clips (= Applying FX Editors) on page 10-13):

� Click the Open Color Editor button on the toolbar to the right of the Master Viewer. 
Click a clip to load it into the editor.

� If you have already created a copy of the editor in a Rack other than Library : Click 
Open in the shortcut menu or simply double-click the effect.
Click a clip to load it into the Editor.

� In the Project window, click Library  Tab > Folder Classic Clip FX > Editors. Drag the clip effect Color 
Editor from the content area to a clip on the Timeline. Right-click the effect. In the shortcut menu that 
appears, click Edit.

Color Editor

When you first open the Color Editor, the Pinnacle Liquid default graphic appears in the Effect Viewer. Once you 
select a clip this graphic is replaced by the clip. As with the other Editors, functions can be activated either by 
clicking the appropriate button or by selecting an option from the drop-down menus.
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Brightness & Contrast

Use this function to control brightness, contrast and chroma.

� Adjusting settings in menu:
Adjust the Brightness, Contrast and Chroma sliders to the required position. 

� Adjusting settings directly in video inlay: 
Click either the Brightness or Contrast button and drag the mouse pointer up and down in the inlay. 

Hue & Saturation

Use this function to control hue, saturation and lightness.

� With the menu: 
Move the sliders to set each parameter. 
Hue modifies color in the range of -180 to 180 ° in the spectrum from red to green and blue to magenta.
Saturation is used for controlling the intensity of a particular color (maximum value = 100%).
Brightness is used to control gray scale values. Black has a brightness of -100, while white has a bright-
ness of +100. 

� Working with the buttons: 
Click the appropriate button. When controlling the settings directly in the video inlay, the mouse 
pointer is accompanied by an H, S or L, depending on which function is activated.

Color Gain

Use this function to control the color gain of each of the three basic colors red, green and blue.

� Working with the menu:
Move the appropriate slider to control color gain.

� Working with the buttons: 
Click the Color Gain button. Now when you move the mouse pointer on the Effect Viewer, the color 
mouse pointer appears. Drag the mouse pointer up and down in the left-hand third of the inlay to con-
trol the red channel, in the middle of the inlay to control green and on the right-hand side to control 
blue. CTRL+drag the mouse pointer to adjust all three channels simultaneously.
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Equalize

Use this function to equalize the color channels and luminance channel. 

� Adjusting settings in menu: 
Select the channel you wish to control in the Channel list box. You can control red, green and blue either 
individually or simultaneously for all three. Move the Amount slider to choose a value between 0 and 
100. With 100, the particular color or luminance is distributed equally throughout the entire image. 
With 0, the original image appears. With settings between 0 and 100, an intermediary value between 
these two extremes is interpolated. In the case of dynamic effects, this function can be used to create a 
wipe or dissolve between the original image and the image manipulated with the Equalize function.

Gamma

Use this function to control an image’s gamma curve. Differences in brightness are most noticeable in the mid-
dle brightness range. Bright areas in an image can be made to appear flatter or have more depth. 

� Adjusting settings in menu:
Slide the Red Gamma, Green Gamma and Blue Gamma sliders to control gamma. Use Black Stretch to 
adjust the gamma curve for black, independent of the color channels. With this function you can specif-
ically stretch (or compress) the bottom range of the gamma curve in order to increase (or decrease) 
details in shadowed areas, without effecting the actual black value.

� Adjusting settings directly in video inlay: 
Click the Gamma button. Now when you move the mouse pointer on the video inlay, the color of the 
mouse pointer changes. Drag the mouse pointer up and down in the left-hand third of the inlay to con-
trol the red channel, in the middle of the inlay to control green and on the right-hand side to control 
blue. CTRL+drag the mouse pointer to adjust all three channels simultaneously.

Transparency

Use this function to control transparency. 

To do so, move the Transparency slider to control clip transparency (fully transparent = 100, maximum value). 
Click/slide the Edge Softness button/slider to control the transparency of a clip’s outer edges. The higher the 
value, the larger the transparent area.
Volume II Chapter Finish10 - 72



PINNACLE

Detailed Description of Classic Effect Editors
Keying Editor

A key effect is used to make a certain area of an image transparent (for example, areas with the same brightness 
or color) in order to then replace this area with another image.

Opening the editor  page 10-74

Key types (overview)  page 10-75

Key Mask  page 10-75

� Invert  page 10-75

� Softness  page 10-75

� Show mask  page 10-76

Transparency  page 10-76

Luminance Key/parameters  page 10-76

Chroma Key/parameters  page 10-79

Blue screen Key/parameters  page 10-81

Green screen Key parameters  page 10-81

RGB difference Key/parameters  page 10-83
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Opening the Keying Editor

There are several ways to open the Keying Editor for clip effects and load a clip for editing (see also Opening 
Effect Editors and Editing Clips (= Applying FX Editors) on page 10-13):

� Click the Open Keying Editor button on the toolbar to the right of the Master Viewer. 
Click a clip to load it into the editor.

� If you have already created a copy of the editor in a Rack other than Library  Click 
Open in the shortcut menu or simply double-click the effect.
Click a clip to load it into the editor.

� In the Project window, click Library  Tab > Folder Classic Clip FX > Editors. Drag the clip effect Keying 
Editor from the content area to a clip on the Timeline. Right-click the effect. In the shortcut menu that 
appears, click Edit.

Keying Editor

When you first open the Keying Editor, the Pinnacle Liquid default graphic appears in the Effect Viewer. Once 
you select a clip this graphic is replaced by the clip. As with the other editors, functions can be activated either 
by clicking the appropriate button or by selecting an option from one of the drop-down menus.
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Key Types

Pinnacle Liquid offers five different types of keys.

� Luminance Key - Used for keying areas with a certain bright-
ness (i.e. affects the luminance signal). 

� Chroma Key - Allows certain colors or color ranges to be 
keyed.

� Blue Screen Key - Used for keying a defined blue for creating 
the blue-screen effect.

� Green Screen Key - Used for keying a defined green. page 10-81

� RGB Difference Key - Used for keying specifically defined monochrome color areas. This is primarily 
used for graphics.

� None - Deactivates all keys. However, with this function clip transparency or a mask can be defined.

Key Mask

For all the key types, the Key Mask lets you select image areas that should be keyed or excluded from the key 
function. If no Mask is defined, the key function is applied to the entire image. Options:

� Mask shape - 
Lasso (Free Form).

� If you want to define several areas, press and hold the SHIFT key. A plus (+) sign appears next to the 
mouse pointer.

� If you press and hold the ALT key, a minus (-) sign appears next to the mouse pointer. In this case you 
can cut out one or more additional areas within an area. 

� If you press and hold the ALT and SHIFT keys, you can select the overlap area of intersecting Mask areas.

I n v e r t

Activate this to reverse the Key Mask function. Now the selected area is excluded from the key function and 
everything else around it is added to the key.

S o f t n e s s  

Here you set a soft transition at the edges of the Key Mask.
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S h o w  M a s k

This function makes the Key Mask(s) in the image more visible by providing a uniform gray area.

T r a n s p a r e n c y

Here you set the transparency of the key area.

Luminance Key

The Luminance Key operates with an image’s luminance signal, i.e. the various gray scales of a picture. Lumi-
nance keying is not only useful for gray-scale and b/w graphics and pictures, but also for images with high 
brightness contrasts.

Luminance Key

The Threshold, Cutoff, Key Transparency and Foreground sliders described below are only active if Linear 
is selected under Graph Mode (see Graph Mode below). 

The following controllers are used for defining both points of the curve in linear graph mode. When you move 
one of the sliders, the curve is automatically adjusted.

Linear 
Graph Mode

Point BPoint A
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T h r e s h o l d

Threshold and Key Transparency are functions of one another. The value set under Threshold defines the lumi-
nance range for Key Transparency and vice versa. Key Transparency defines the level of transparency for the 
luminance levels specified under Threshold. To set threshold, either enter a numerical value in the Threshold 
field or drag Point B to the right or left in the graph. Threshold range is 0 (black) to 100 (white).

C u t o f f

Cutoff and Foreground are functions of one another. The value set under Cutoff defines the luminance range for 
Foreground and vice versa. Foreground defines the level of transparency for the luminance levels specified under 
Cutoff. To set cutoff, either enter a numerical value in the Cutoff field or drag Point A to the right or left in the 
graph. Cutoff range is 0 (black) to 100 (white).

K e y  T r a n s p a r e n c y

Key Transparency and Threshold are functions of one another. The value set under Key Transparency defines the 
luminance range for Threshold. To set Key Transparency, either enter a numerical value in the Key Transparency 
field or drag Point A up or down in the graph. Key Transparency range is 0 (opaque) to 100 (transparent).

F o r e g r o u n d

Foreground and Cutoff are functions of one another. The value set under Foreground defines the transparency 
for the luminance range defined under Cutoff. To set Foreground, either enter a numerical value in the Fore-
ground field or drag Point A up or down in the graph. The Foreground range is 0 (opaque) to 100 (transparent). 

C r e a t i n g  a  L u m a  K e y

The luminance axis represents an image’s luminance values from black to white. The transparency axis repre-
sents transparency from opaque to totally transparent.

Initially an image is totally opaque (i.e. the curve is completely flat). In order to key, specify which part of the 
image should be transparent (i.e. define a luminance value). Specify how soft the transition between opaque 
and transparent should be (i.e. the steepness of the curve between Point A and Point B).Two points define the 
curve: Point B is defined by cutoff and foreground, Point A by threshold and key transparency.

The settings for a simple luma key could be: 

� Threshold = 80 (everything “lighter” than the value 80 is keyed)

� Cutoff = 78 (everything “darker” than 78 remains opaque).

Key Transparency defines how transparent the keyed area should be. Foreground defines the transparency of 
the “unkeyed” area.
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The luminance difference between the two points in the curve defines the hardness or softness of the transition 
in between. 
A value of 2 would create, for example, a hard transition. To soften it, either raise Threshold (move Point A to the 
right) or reduce Cutoff (move Point B to the left).

To increase or decrease keying with both points simultaneously, drag the line between the points. This main-
tains the transition softness and makes it easy to specify which part of the frame to key.

Luminance Key: a different image signal is superimposed over areas with 
the same luminance

Other Graph Modes

Luma keys can be created by specially adapting the luminance graph.

In the graph above, the horizontal axis is for luminance, with black being 
on the left and white on the right. The vertical axis represents transpar-
ency, with opaque being at the bottom and full transparency at the top. 
Drag the points on the graph to set clip luminance to any level of transpar-
ency. Four modes are available for drawing graphs:

� Linear - in the linear luma key graph (default) you can set two points (see above).

� Multi Line - in this graph, you can add as many points as needed to assign different transparency set-
tings to the various luminance values. The lines between points are straight. To add a point, click or 
drag a line.

� Curve - same as Multi Line, except that the line curves through each point. Curve shape depends on the 
relative location and distance of the current point to those on either side of it.

� Freestyle - lets you draw lines “by hand” by dragging the mouse in the graph.
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Chroma Key

Using Chroma Key you can key a color or color range in a specified luminance range. The color to be keyed in a 
picture can thus be defined precisely.

Chroma Key

S e l e c t i n g  a  C o l o r  A r e a  w i t h  t h e  P i p e t t e

The most direct way of defining a color range is to use the pipette pointer. To do so, click the Pipette (Eyedrop-
per) button and then the area of the picture you want to key. The selected color is indicated by a small point in 
the color wheel.

Use multiple clicks or dragging to select several areas.

Press and hold down the SHIFT key to select a larger color area. Then larger circular ranges of the selected color 
range appear in the color wheel. 
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S e l e c t i n g  a  C o l o r  A r e a  i n  t h e  C o l o r  W h e e l

The mouse pointer turns into a cross when it is in the color wheel. Drag the mouse pointer in the color wheel to 
create a frame of any shape in it. After you release the mouse button, the area enclosed by the line is then the 
selected color area. The following options are also available:

� Increase/add area:
SHIFT+drag the cursor to define more than one area or increase the size of an existing area. A plus sign 
appears next to the mouse pointer. Simply encircle the area to be included keeping the mouse button 
pressed.

� Reduce area:
If you press ALT, a minus sign appears next to the mouse pointer. To cut out one or several areas within 
a color selection, simply encircle the area to be deleted keeping the mouse button pressed. 

� Select subset:
With the ALT and SHIFT keys pressed, you can specify the overlap of two intersecting areas.

� Delete selection:
Double-click the color wheel to delete a color selection, or simply define a new area.

The current color (at the mouse pointer) appears in numeric format as an RGB (red-green-blue) and 
HLS (Hue-Lightness-Saturation) value below the color wheel. 

L u m i n a n c e  R a n g e  

The vertical line on the left of the spectrum is used for setting the luminance key. Values in the range of the 
white sliders are in the key range; those outside the range of the black sliders are outside of the key range. The 
areas between the white and black sliders represent transitional areas. The closer the sliders are together, the 
narrower the luminance area that will be keyed.
A double-click on or close to the vertical line resets the sliders to their initial positions.

S o f t n e s s

Use Softness to create a soft transition between key and foreground.

S p i l l  S u p p r e s s i o n

Use Spill Suppression to desaturate and thus make less visible any existing color values of the key color, espe-
cially at the edges of the foreground.
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Blue Screen Key/Green Screen Key

Blue-screen keying is used for recordings in front of a blue background. For best results the background should 
be in the standard blue-screen color (approximately corresponds to Pantone 2735) and have even lighting.
The parameters described here operate in the same way for the Green Screen Key Editor. 

When working with material originally created in DV, you should use a green background and the 
Green Screen Key Editor. Due to the chroma sampling of 4:2:2, or of 4:2:0 or 4:1:1 (depending on the for-
mat), the green channel for DV has a much greater luminance than the other colors. For this reason, 
keying to green works best for DV.

Blue Screen Key

Blue/Green Screen Key Editor
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T h r e s h o l d

The value you set here determines the size of the key range on the UV level (i.e. the two color difference signals 
R-Y and B-Y). The key center point is calculated from all the UV values for the image. The slider allows you to 
set the environment to be keyed to the calculated average value.

L u m a  T h r e s h o l d  a n d  L u m a  C u t o f f
These parameters affect the range of luminance (brightness) to which the key should apply. The key center 
point in the image is again the point of reference, except that it is on the y level (luminance signal). Luma Thres-
hold defines the point (y value) the start key range and Luma Cutoff determines the other end of the range to be 
keyed. 

The value is specified as a percentage of the possible dynamic range. If a pixel’s luminance distance from the 
luminance center point is less than the threshold value, the luminance has no effect on the key. If it is greater 
than the cutoff value, the pixel becomes opaque. The area in between is the range defined by these two parame-
ters.

T r a n s i t i o n
Normally the transition from keyed to non-keyed ranges in the image is linear. Transition presents the transi-
tion in the form of an acceleration/deceleration curve as used for Key Frame interpolation by the Pinnacle Liq-
uid Effect Editors, although in this case it has a chronological dimension. Here you can use the function, for 
example, to optimize the key to the edges of foreground objects.

Y U V  S p i l l  S u p p r e s s i o n
This function suppresses smaller impurities in the image foreground by de-saturating the interfering color val-
ues. This type of spill suppression works in the YUV color space. It precedes RGB spill suppression in the calcula-
tion Sequence.

R G B  S p i l l  S u p p r e s s i o n
This function suppresses smaller impurities in the image foreground by de-saturating the interfering color val-
ues. This type of spill suppression works in the RGB color space. It follows YUV spill suppression in the calcula-
tion Sequence.

Blue Screen Key 

Foreground frame with blue 
screen background

Background Keying result
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RGB Difference Key

Use the RGB Difference Key to specify which color you want to make transparent in the clip. 
The difference between a chroma key and an RGB difference key is that a chroma key lets you adjust the chroma 
and the gray values independently, while the RGB difference key adjusts these components together.

RGB Difference Key

C o l o r

Click this field to open the color palette. To specify the color you want to use, click a color in this color spec-
trum.

P i c k  a  c o l o r

You can also use the Pipette (Eyedropper) to specify the key color. Simply click the Pipette button and continue 
to hold down the mouse button, then release the mouse button anywhere in the software interface or desktop. 
This action selects the color value at precisely the location where the mouse button was released. The color is 
automatically displayed in the color field.

S i m i l a r i t y

Use Similarity to specify a range of similar colors to be transparent. To select a range, drag the Similarity slider 
between values 0 and 100. The higher the setting, the broader the range of similar colors selected. 

S o f t n e s s

Use Softness to soften the edges of the superimposed (foreground) clip.
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Filter Editor

The Filter Editor contains a wide range of effects used for alienating video material. 

Opening the Filter Editor

There are several ways to open the Filter Editor for clip effects and load a clip for editing (see also Opening Effect 
Editors and Editing Clips (= Applying FX Editors) on page 10-13):

� Click the Open Filter Editor button on the toolbar to the right of the Master Viewer. 
Click a clip to load it into the editor.

� If you have already created a copy of the editor in a Rack other than Library : Click 
Open in the shortcut menu or simply double-click the effect.
Click a clip to load it into the Editor.

� In the Project window, click Library Tab > Folder Classic Clip FX > Editors. Drag the Filter Editor from 
the content area to a clip on the Timeline. Right-click the effect. In the shortcut menu that appears, click 
Edit.

Filter Editor 

When you first open the Filter Editor, the Pinnacle Liquid default graphic appears in the Effect Viewer. Once you 
select a clip this graphic is replaced by the clip. As with the other editors, functions can be activated either by 
clicking the appropriate button or by selecting options from the drop-down menus.
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Invert

Use the Invert function to use the color or lightness which is complementary to the one you originally specified.

� Channel - Use the Channel list box to select a color, luminance or alpha channel to which you want to 
apply a function. The following channels are available: None, RGB, Red, Green, Blue, Luminance, Alpha.

� Blend with Original - Use this transparency slider to create a transition between the inverse of an origi-
nal image and the original image itself. Move the slider to 0 for a opaque inverted image; move it to 100 
for a opaque original image. 

Original clip and negative effect 

Mosaic

Use the Mosaic function to create a mosaic effect.

� Move the two sliders to define the number of horizontal and vertical divisions in an image (to create 
blocks). 

� Click the Sharp colors check box if you want the system to base color on the color in the middle of each 
block. Leave this check box deactivated if you want the system to base color on the average value of the 
colors.

Original clip and clip with mosaic effect
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Posterize

Use the Posterize function to limit the number of colors in a picture. The system maps the image’s pixels based 
on the colors that are the closest match. Use this filter to create large, flat areas in an image.

� Channel- Use the Channel list box to select a color, luminance or alpha channel to which you want to 
apply a function. The following channels are available: RGB, Red, Blue, Green.

� Amount - Use the Amount option to limit the number of colors used for posterizing. 

Solarize

Solarize acts as a filter between a positive and negative image. 

Use the Threshold slider to specify the brightness value at which inversion should begin. A value of 0 corre-
sponds to the original image; with a value of 100 all brightness levels are inverted.

� Click Negative to subtract color and brightness values. 

� Click Positive to add color and brightness values. 

Original clip and clip with solarize effect
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Gaussian Blur

This filter lets you add a controllable blur to the image. 

Radius defines the degree of the blur. Both Directions, Vertical or Horizontal determines the visual impression of 
the filter.

Gaussian blur

Cropping

See also “Cropping” on page 10-45.

Transparency

See also “Transparency” on page 10-46.
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This chapter provides information on the realtime effects in Pinnacle Liquid. With realtime effects, you can 
preview effects immediately, without having to wait for them to be rendered. For basic information on effects, 
see the “Finish” chapter in the section on “Effect Editors (Basics)”  on page 10-10.
This chapter describes the Effect Editors that have been modified as of Version 6 (as opposed to the Classic edi-
tors).

Realtime effects: always maximum performance  page 11-3

Rendering and realtime  page 11-4

Realtime and preview  page 11-5

Functions and parameters of the Effect Editors  page 11-10

... for CPU and GPU effects (non-Classic FX)

Effects and Effect Editors  page 11-25

Overview of all the CPU/GPU effects

Additional realtime capabilities  page 11-40

� Realtime color correction (primary) 

� Titles and graphics with alpha

� Audio effects 
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Always Maximum Performance

Pinnacle Liquid realtime effects need no special hardware. The effects use all your computer’s existing capabili-
ties. That‘s the reason they‘re called “host-based” effects, the host being your computer with the combined 
power of all its components, most prominently the microprocessor and the graphics card. If you upgrade your 
system to, say, a faster CPU, the performance gain directly results in more realtime: more video layers, more 
effects simultaneously, more creativity for you. When you exceed the limits of your system, performance will 
degrade smoothly, in a way that lets you still preview and experiment with a high degree of interactivity. It is not 
a question of “either render or realtime”. 

Some of the Pinnacle Liquid realtime effects were optimized for the computer’s main processor(s) (central pro-
cessing unit, CPU), and others for the graphic card’s graphics processor (graphics processing unit, GPU). Each 
one is a specialist for certain tasks. Therefore, all realtime effects are assigned to either the CPU(s) or the GPU 
and accordingly marked, such as Magnify GPU. Pinnacle Liquid is the first editing solution to offer consequent 
use of modern, off-the-shelf high-performance graphics cards. The realtime capabilities combined with Pinna-
cle Liquid’s exclusive background rendering give you unmatched creativity and efficiency: instant preview, and, 
when you‘re done editing, everything‘s ready for playout.

Your computer system’s performance capability depends on many factors, which means it’s almost impossible 
to predict which effects will play back in preview smoothly (at full frame rate) and in what combinations. The 
CPU, main memory, graphics card, hard disk(s), the disk(s)’ degree of fragmentation, the software running in 
the background, the BIOS settings and the drivers used all play a part. Anyway, Pinnacle Liquid always attempts 
to provide optimal playback. Plus, Pinnacle Liquid is a safe investment, because its effects and video stream 
performance scale perfectly with the power of its computer system, perfectly using the performance growth 
curves the high-tech industry has to offer.
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Rendering and Realtime

This section provides you with information on when effects are realtime-capable and when they have to be ren-
dered, as well as what this means for the Timeline playback (preview).

When to render, when to use realtime?  page 11-4

Realtime and the effect preview  page 11-5

Render management of software effects  page 11-7

Optimizing realtime preview  page 11-8

The Render Viewer  page 11-9

Working with render files  page 11-9

When Render, When Realtime?

Pinnacle Liquid distinguishes among three types of effect:

� Realtime effects (hardware-based) - 
These effects require special hardware. For example the DV500 card from Pinnacle. A limited number 
of effects can thus be made realtime-capable.

� Realtime effects (“host-based” or software-based) -
These effects require no special hardware. All the effects are computed by the host PC CPU or the 
graphics processor. 
For detailed information on these effects, see: “Effects and Effect Editors”  on page 11-25.

� Render effects -
These are effects that are always rendered.
This type includes Classic Effect Editors of Pinnacle Liquid and third party plug-in effects.
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Realtime and the Effect Preview

On the Timeline, the above-mentioned effect types are indicated in the Slices (the numbered segments above 
the Timeline) by means of defined colors. In this way, the system provides information on the effect preview or 
playback behavior:

Slices above the Timeline

� Green -
These segments will certainly be played back at the full frame rate (for example, PAL: 25 fps/NTSC: 30 
fps) because either hardware effects are applied or the Slices have already been rendered (fps means 
frames per second).
A green Slice indicates that a render file was created for this segment. The file is used to play the Slice.

� Yellow -
These segments may jitter when played back (i.e. played back at less than the standard fps rate), mean-
ing that frames are dropped. Realtime software effects are always “yellow” because the system cannot 
supply exact information before the actual playback.
A yellow Slice always indicates that the system will attempt to play the segment in realtime, even it has to 
reduce the frame rate (drop frames). Audio remains synchronous.
Preview is possible in the Master Viewer video inlay and via an analog monitor output (optional); but 
not via IEEE/DV out.

� Red -
These segments must always be rendered.
Where no rendered data yet exists, a gray exclamation point on a black surface becomes visible in the 
inlay as soon as the Playline touches the section not yet rendered.
A deep, intense red indicates a render problem. Remove the effect(s) that caused the problem.

� Gray -
Everything that is not green, yellow or red, i.e. normal video and graphics, is played back at the full 
frame rate.
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Sometimes, however, even realtime effects have to be rendered before a usable “preview” or view of the effects 
becomes possible. Such scenarios include, for example:

� A hardware-based realtime effect combined with render effects or combined with other hardware-
based realtime effects - although it is also a matter of vertical positioning. A realtime effect positioned 
above a render effect can be played back in realtime but not the other way around.

� A software-based realtime effect combined with render effects.

� A software-based realtime effect combined with other software-based realtime effects. In this case, host 
PC performance plays a decisive role.

Pinnacle Liquid already starts playing the rendered passages of a clip before the entire clip has been ren-
dered. The exclamation point, which always indicates a lack of media data, does not become visible in 
the inlay until the Playline enters the red section of the Slice. 

General Preview: Familiarizing Yourself with Effects 

You can test any effect (editor) on a clip before actually applying it.

In a Rack, you can open any editor by double-clicking it. A standard graphic is then displayed in the inlay on 
which you can test the effect. You can copy some or all of the Effect Editors to various racks on the FX tab and 
start them from there.

� Classic effects -
Preview by scrubbing the Playline.

� CPU/GPU realtime effects -
Preview by scrubbing or using the Playback function.

� Hollywood FX -
Preview (and select additional effects) in the Hollywood FX Editor.

� Other PlugIns -
Preview options depend on the type of PlugIn.
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Render Management of Realtime Software Effects

The yellow Slice marking above a realtime Transition or a clip that was edited using a realtime filter indicates 
that:

� This segment can be played back immediately without waiting for rendering. 
However: When the segment is played back, individual frames may be dropped, depending on the com-
plexity of the effect(s) and on computer performance. If frames must be dropped, an error message will 
appear to the bottom right in the taskbar ( page 3-11).

Also see “Optimizing Realtime Preview”  on page 11-8

Enable Background Rendering / Render Yellow Slices

The rendering of yellow Slices can be enabled and disabled; which basically means to switch on or off the back-
ground rendering. To select this option, right-click the render button (Sigma) in the taskbar to display the 
shortcut menu or un-check the box in the Render Viewer. In other words, the system uses available resources to 
render realtime passages. This has certain advantages:

� You don‘t lose time since you do not have to wait for the rendering to finish.

� Rendered Slices can be output via i.Link DV; the preview is possible only in the video inlay of the Master 
Viewer or via analog outputs (optional).

� Additional effects can be applied without having to perform a complete rendering of the segments. This 
is especially advantageous in the case of complex multilayer effects.

As long as the Slice(s) above the rendered section is (are) yellow, the system attempts realtime playback. 
Only after the Slice(s) have turned green, the render file is played.
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Optimizing Realtime Preview

Some tips on enhancing your system‘s realtime performance.

First CPU, then GPU (in effect editing)

You can apply all realtime effects in all combinations imaginable to a clip. But: The best performance is 
achieved when CPU effects are applied first, and GPU effects last.
The processing order of effects applied to a clip can be viewed and changed in the clip’s FX Properties: The list 
reflects the order in which effects were initially applied. The first effect in the list is processed first, the last effect 
is the final. (Right-click a clip and select FX Properties from the shortcut menu.)

The explanation lies in the way CPU and GPU cooperate. The CPU mainly does basic video processing, 
e.g., it decodes a frame, and works on certain effects. It then passes on the data to the GPU, which takes 
care of additional effects and displaying the image, among other things. But if the GPU has to pass data 
back to the CPU, there‘s a bottleneck because bandwidth in the direction from GPU to CPU is much 
smaller than vice versa.Therefore it is recommended to process all CPU effects before data is passed to 
the GPU. And, as a rule of thumb if maximum performance is called for, use GPU effects - the CPU is 
busy with a host of other tasks.

Turn Off Audio Playback Temporarily

In certain borderline cases, deactivating timeline audio (Playback Off) can help prevent “dropped frames”, 
i.e. frames omitted during playback. This is always the case when your system is operating near or beyond 
the limits of its performance capability. Deactivating audio takes off a little of the strain.
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The Render Viewer

The Render Viewer is an inlay in which you can monitor the current render process. In the taskbar, click the 
symbol shown to open this view.

Although the sequence of frames in the Render Viewer may appear to be mixed up (especially if you combined 
realtime and render effects), it isn’t; Render Management, which is working in the background, distributes spe-
cific resources to the different effects.

The Render Viewer contains a checkbox that lets you enable or disable the rendering of “yellow slices”. 

Render Viewer

Working with Render Files

As a user of realtime effects, you will not normally have to deal with render files, but sometimes they do come 
up. If this happens, read the appropriate sections in the “Finish” chapter on “Deleting Render Files”  on page 
10-36 and “Rendering and Preview Quality (relevant only for Classic Effects)”  on page 10-37.
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Functions and Parameters of the Effect Editors (Non-Classic)

The new Effect Editors in Pinnacle Liquid (as of Version 6) have a different interface from that of the classic edi-
tors, as well as expanded functions, such as Key Frames for each parameter. All GPU effects, CPU effects use the 
expanded Effect Editor. 

This section describes the parameters and functions of these Effect Editors.

Brief overview  page 11-10

Setting parameters  page 11-14

Key Frame curves  page 11-16

Additional options  page 11-24

Brief Overview

Drag any Effect Editor from the Realtime Clip FX Rack and drop it on a Timeline video clip, or double-click the 
name of the Effect Editor in the Rack. The editor is then opened in place of the Source and Master Viewers:

 

Effect Editor - full-screen view

Below is a description of the functional areas, from left to right.
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A: Parameter Menus

These menus list the parameters of the Effect Editors. Most parameters are combined in groups, such as Posi-
tion, Size, etc., as seen here:

Parameter groups of the Effect Editors

Parameters are the variables of an effect that can be modified (e.g. Position, Transparency, Border, etc.). Many of 
these parameters are subdivided into further categories. For example, Size is divided into Horizontal and Verti-
cal. 
For detailed instructions on setting and modifying parameters, see the section on “Setting Effect Parameters”  
on page 11-14.

B: Options - with or without Key Frames?

This is an important option. It determines whether or not you will work with Key Frames. 
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You have two choices:

� Without Key Frames, you cannot make dynamic changes to clips. For example: If all you want to do is to 
reduce the size of the clip and move it, and you want to do this for the entire length of the clip, you will 
find it faster and easier to deactivate Key Frames here. In other words, static effects do not require Key 
Frames.

� With Key Frames, all types of change are possible. If you want an image to start out in color and end up 
in black and white, you must use Key Frames. You will need at least two of them, one at the beginning of 
the clip and one at the end, but you are free to use as many as you want. Key Frames are said to “animate” 
an effect, meaning that they “bring it to life”.

This option is applied to all the parameters of an Effect Editor. For more information on Key Frames, see the 
section on “Parameter Curves”  on page 11-16.

C: Parameter Curves

You can provide each parameter with its own Key Frames, thereby assigning Size independently of Rotation 
independently of Cropping, etc. This is illustrated in the Parameter Curves area:

Each parameter has its own curve

For more information, see the section on “Parameter Curves”  on page 11-16.

D: Effect Viewer and Its Surroundings

The Effect Viewer contains either the image of the clip that is currently being edited or a preview graphic (if you 
loaded the editor without a clip). 

The Position Bar, playback buttons and Key Frame buttons are located below the video inlay.

The timecode fields above the video inlay indicate the current position of the Playline and the duration of the 
effect (transition or clip).

To the right of the inlay, tool buttons are arranged in vertical rows for directly editing the image. With these but-
tons you can, for example, precisely position a miniaturized clip “on sight”.
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E: Effect Management - Undo, etc.

To the left in the toolbar below the video inlay, you will find the same functions in all the editors - for example, 
an Undo button for canceling the last step performed and a Redo button for restoring the original state. (See 
also “Key Frames” on page 10-20.)

F: Exiting an Effect Editor

Click the running man to follow him to the exit. If a clip was loaded in the Effect Editor, it is now available for 
playback on the Timeline. If rendering is required, this is initiated now.

If you opened the editor directly from its root directory by double-clicking it, a query will appear when you exit 
asking whether you want to save a copy of the effect you edited. If you click Yes, a copy is created on the FX tab 
in a Rack named New FX. It is placed here because the effects on the Library tab cannot be modified further. 
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Setting Effect Parameters

There are four ways to modify parameters:

� Using a slider or knob.

� Entering a value on the keyboard.

� Directly in the inlay using tool buttons.

� Using the Parameter Curve of the particular parameter.

First select a specific parameter, such as Position:

Then click the triangle or title bar to open the drop-down menu:

M o d i f y i n g  P a r a m e t e r s  U s i n g  S l i d e r s  a n d  K n o b s

Using the mouse, drag one of the sliders to the desired position, including outside the field and drop it when 
you reach your destination. You can also use the mouse for fine-tuning. The numeric value changes as you 
move the slider, in some cases only up to a maximum value.

Click in the field and drag to the left or right

Modified Parameters

As soon as you modify a parameter, a yellow box appears to the far right in its title bar. This lets you know that 
at least one parameter was modified, even when the menu is collapsed.

Disabling Parameters

Click the yellow box. It then changes to blue, indicating that parameters were modified but are currently dis-
abled. Click the box again to enable the parameters. This is a convenient way to enable and disable parameters, 
which often makes it easier to assess the course of an effect.

Parameter was 
modified

Key Frame icon
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Key Frame Icons

The parameter settings from the menus are stored in the key frame icons. For the Size menu, for example, the 
key frame contains the values for Horizontal and Vertical. When you drag the Key Frame icon and drop it on a 
Key Frame on the Position Bar below the Effect Viewer, this Key Frame takes on the stored values (in addition to 
its own values declared up until this point).

To Reset:

Right-click in the parameter field to reset the value to zero.
When the last parameter has been reset to zero, the yellow box disappears.

E n t e r i n g  P a r a m e t e r  Va l u e s  f r o m  t h e  K e y b o a r d

1 Double-click in the particular field.

2 Enter a value.

3 Confirm your entry by pressing ENTER or TAB (jumps to the next field). If you entered a value that 
exceeded the maximum value permitted for the parameter, your entry changes to the maximum value 
allowed.

Some values should be entered in any case, including all integer values, such as the number of rotations 
for the Rotation parameter or the number of Replications for the replicating effect (Replicate GPU). In 
such cases, it’s faster and easier to enter the value.

To Reset:

Right-click in the parameter field.

M o d i f y i n g  P a r a m e t e r s  i n  t h e  I n l a y  U s i n g  To o l  
B u t t o n s

Some parameters are assigned a tool button. For example, you can change the Position of a clip directly in the 
inlay using the mouse. (If you don’t recognize a button, rest the mouse pointer on it for just a moment to display 
the tool tip stating its function.)
The tool buttons are located to the right of the inlay. 

1 For example, click the Position button (shown here). 

2 Move the mouse pointer across the image, holding down the left mouse button.

3 Drop the image at the desired position.

The values and sliders in the associated parameter menu follow your movements, which means you can also use 
this method to change numerical values.

To Reset:

Double-click in the video inlay to reset it to its original state.
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Parameter Curves

You can use as many Key Frames as you want for editing each parameter of an Effect Editor. All these Key Fra-
mes are then linked by means of a Parameter Curve. This curve demonstrates how the value of a particular 
parameter changes over the course of the effect (for example, how an image becomes larger or smaller). You can 
edit the Key Frames directly in the curve, as well as modify the curvature itself. However, the term “curve” isn’t 
meant to be taken too literally: In the case of a linear change, the “curve” can also be a straight line.

Overview  page 11-16

Working with curves

� Linear and constant  page 11-20

� Bezier curves  page 11-21 

Additional key frame functions page 11-23

Overview
The first time you open an Effect Editor, the curve field is empty. The first curve(s) don’t appear until you open 
a parameter menu. The screenshot below contains two curves, one representing Size Horizontal (= width) and 
one representing Size Vertical (= height). If these parameters were linked, you would see only one curve.

Key frame curve for the Size parameter
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Also note: If Key Frames are globally disabled for an effect (Options > Keyframes > Do not use Keyframes), you 
will see only straight horizontal lines instead of curves. You can only move these lines up and down. 
Here are the most important points regarding Parameter Curves:

� Color coding -
The lines are the same color as their parameter fields, thus making it easier to assign multiple curves.

� Position Bar -
A Position Bar runs horizontally along the bottom of the curve view that is the same as the Position Bar 
below the video inlay and represents the duration of the effect. The effect starts on the left and ends on 
the right.

� Value scale -
This vertical scale is purely a quantitative measure. It has nothing to do with the units of size, it only 
indicates “more” or “less”. This scale must retain its relevance even when different parameters, such as 
Size and Rotation, are displayed simultaneously. Because Size is specified as a percentage (+/-400) and 
Rotation is specified as a degree (0-360), the two cannot be measured against the same ruler. For exam-
ple, the Rotation Key Frame might be located at position 300 (for 300°), Size at 25 (for the percentage) 
and some other parameter at 231 (for example, pixels). (See also “Functions of the Parameter Scale and 
Position Bar” on page 11-22.)

� Playline position -
The Playline position is indicated by a red vertical line. When you modify a parameter, the Key Frame is 
set at the point where the Playline intersects this parameter’s Parameter Curve. A Key Frame is also 
inserted on the Position Bar below the video inlay.
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Here is another example. You are working with a ten-second color clip with unlinked Horizontal and Vertical 
parameters. The clip is transformed from a narrow, vertical line to a narrow, horizontal line (it has completely 
disappeared by the last frame, which is why this frame is not shown below).

Unlinked parameters: The height decreases to zero percent and the width increases to 100 percent (the 
last image at 10 seconds not shown)

Height
(Vertical)

Width
(Horizontal)

0 seconds 2 seconds 4 seconds 6 seconds 8 seconds
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Working with Curves

In its original state (parameters not yet modified, Key Frames enabled), the curve appears as a straight horizon-
tal line at the zero level. A Key Frame (small box) is visible at each end point. The handles for the Bezier func-
tion are parallel and horizontal (see “Bending Bezier Curves”  on page 11-21).

� When you bring the mouse pointer near the curve, the pointer changes shape (pointing index finger) 
and the curve is highlighted to indicate that it is now selected.

� When two lines initially overlap (for example, the Horizontal and Vertical lines for the Size parameter), 
you can select one of the two lines by clicking in the parameter field and then edit it with the mouse.

� Setting and moving a Key Frame on the curve -
Wherever you click, a Key Frame is set on the curve. You can then move the Key Frame wherever you 
want (not entirely: some parameters have maximum values). An info box indicates the TC value and 
parameter value.

� no key: Key Frame can be moved vertically (changes value);
hold ALT key: Key Frame can be moved horizontally (changes position);
hold CTRL key: Key Frame can be moved vertically and horizontally.

� Moving multiple Key Frames simultaneously -
Drag a lasso around the Key Frames that you want to move simultaneously and then drag one of the Key 
Frames selected. You know which Key Frames are selected because the small boxes are filled in.

� Moving the curve segment between two Key Frames -
This causes the curve (line) to move, including the two Key Frames. Clicking one Key Frame affects the 
curve segment to its right, up to the next Key Frame.

� hold SHIFT key: segment can be moved vertically (changes values);
hold ALT key: segment can be moved horizontally (changes positions);
hold CTRL key: segment can be moved vertically and horizontally.

The shortcut menu for Key Frames on a curve contains the following options:

� Copy key frame(s) -
Copies the Key Frame(s) (use a lasso to select multiple Key Frames).

� Cut key frame(s) -
Deletes Key Frame(s) from their original locations.

� Paste key frame(s) -
Inserts previously cut or copied Key Frame(s) at the Playline position or, in the case of multiple Key Fra-
mes, at the Playline position and to the right of it.

� Delete Key Frame from the curve -
Right-click Key Frame > Shortcut Menu > Delete key frame(s).
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I n t e r p o l a t i o n

Each Key Frame on a curve has an Interpolation option in its shortcut menu. Interpolation describes the way in 
which parameters change between two Key Frames. Right-click a Key Frame on a curve to display a shortcut 
menu containing the Hold, Linear and Bezier options.

Hold 

This option sets the parameter value to the right of the Key Frame to the Key Frame’s constant value. In other 
words, there are no more changes.

Hold maintains the parameter value up to the next Key Frame

In the figure above, for example, the Size is initially reduced but then remains constant: After a sharp bend, the 
curve becomes a straight, horizontal line.

Linear

This option causes a steady change from one Key Frame to the next. Linear transforms a curve into a straight 
line that rises or falls at a steady rate. The steeper the angle, the more drastic the change; the flatter the angle, the 
less drastic the change.
Linear Interpolation permits sudden transitions, such as a movement that instantly shifts to the opposite move-
ment.

Left: Parameter drops steadily (bottom line with Bezier above it)
Right: Sharp bends indicating sudden changes

Bezier

These are the actual curves. A Bezier curve is initially set for every Key Frame by default and permits dynamic 
changes, such as soft transitions between states or accelerated and decelerated changes. The same rule applies 
as above: the Bezier curve starts to the right of the Key Frame. You will find more information in the next sec-
tion.
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B e n d i n g  B e z i e r  C u r v e s

You may already be familiar with this type of curve from vector graphics programs. Each Bezier curve has small 
handles attached to each of its Key Frames, with Control Points at the ends of the handles. When you drag these 
points, it changes the bend of the curve. Basically, however, the same applies as for straight, linear lines: The 
steeper the angle of the curve, either up or down, the faster the parameter value rises or falls; the tighter the 
radius of the curve, the more drastic the change.
The Control Points are always linked by a line. The gradient of this line indicates the angle at which the curve 
passes through the Key Frame between the Control Points. In the figure below, the line is relatively horizontal:

Bezier curve with “handles” and control points

In the next figure, the curve passes through the Key Frame at a fairly steep angle, so that the line linking the 
Control Points is also very steep:

A sharp bend in the curve indicates a rapid change

The Control Points also act like magnets: They attract the zeniths of the curves, but the further they are from a 
curve, the greater their magnetic effect.
It takes only a moment to acquaint yourself with the basics of Bezier curves. You’ll soon find that you intuitively 
achieve the desired results.
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F u n c t i o n s  o f  t h e  P a r a m e t e r  S c a l e  a n d  P o s i t i o n  B a r

For greater clarity, the parameter scale and position bar (time scale) can be:

� Moved vertically or horizontally - 
Drag theparameter scale up or down, or to the left or right. The Position Bar beneath the curve view is 
linked to the Zoom control of the Effect Viewer.

� Zoomed in/out -
Drag the scale while holding down the CTRL key.

You can undo these changes by opening the shortcut menu for the curve view and selecting the appropriate 
options. The display will be set so that Key Frames are again visible. Click anywhere (except on a curve or Key 
Frame) and select one of the following options:

� Reset scales -
Resets the parameter scale and the position bar.

� Reset parameter scale -
Resets the scale only.

� Reset time scale -
Resets the position bar only.

S h o w / H i d e  P a r a m e t e r  C u r v e s

This option also serves to improve clarity. You can hide specific Parameter Curves, or even all Parameter Curves. 
You will find these functions in the shortcut menu for the curve view.
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Additional Key Frame Functions

S e l e c t  A l l  K e y  F r a m e s  o n  a  C u r v e

Right-click anywhere on the curve line to open the shortcut menu and select Select all Key Frames of parame-
ter).

A s s i g n  I d e n t i c a l  V a l u e s  t o  M u l t i p l e  K e y  F r a m e s

It is often necessary that all or part of the Key Frames share identical parameter values. To avoid the tedious task 
of setting the values for each individual Key Frame, follow the procedure below: 

1 Set one of the Key Frames to the desired value and position the Playline exactly on this Key Frame (for 
example, use the Q and Z keys to jump from Key Frame to Key Frame).

Set one Key Frame to the desired value

2 Drag the Key Frame Icon (�) from the parameter’s title bar and drop it in the effect inlay. All Key Frames 
for this parameter will automatically be assigned the selected value and the curve will be flattened out to 
a horizontal line.

C u r v e  K e y  F r a m e s  a n d  P o s i t i o n  B a r  K e y  F r a m e s

Whenever you insert a Key Frame on a Parameter Curve, a corresponding Key Frame also appears on the Posi-
tion Bar (although this is not visible when curve Key Frames overlap). The two Key Frames thus created are 
linked; when you delete one, the other is also deleted.
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Additional Options

Channel Processing

In Effect Editors for which it is relevant, the Options tab contains an area entitled Channels. Here you can select 
the channels to which the effect modification should be applied (Red, Green, Blue and/or Alpha). In the default 
configuration, the effect is applied to all channels (even if none are activated here). 
Effect Editors offering this option include, for example, Posterize and Base Color Correction.
Volume II Chapter Realtime FX11 - 24



PINNACLE

Effects and Effect Editors
Effects and Effect Editors

This section contains a complete listing of all the software-based realtime Effect Editors in Pinnacle Liquid. We 
have not attempted to list all the standard effect parameters, such as Size and Position, or other parameters that 
are self-explanatory.

� All CPU/GPU realtime effects can be found on the Library tab, in the Realtime Clip FX and Realtime 
Transition FX folders.
These folders contain the Racks Editors (all effect editors), Presets (editor fx with certain predefined set-
tings) and Audio (realtime audio fx).

� Realtime-capable Pinnacle Hollywood FX Editors are stored in the PlugIn folders; HFX presets can be 
found in the Realtime Transition FX> Specials folder.

For a detailed description of the basics of applying effects and setting parameters, see the preceding section and 
the “Finish” chapter on  page 10-4. This section provides a quick introduction.

Preliminary remarks  page 11-26

Realtime Clip FX  page 11-31

�Editors  page 11-31

�Presets  page 11-37

�Audio  page 11-37

Realtime Transition FX  page 11-37

�Editors  page 11-37

�Presets  page 11-39

�Audio  page 11-39

PlugIn FX  page 11-40
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Preliminary Remarks

This section contains information on realtime effects and a quick introduction to the correct application of 
these effects.

GPU and CPU
Pinnacle Liquid’s software based (or host-based) realtime effects have been optimized for either the graphics 
card processor (GPU) or the computers’s central processing unit(s) (CPU). To facilitate identification of these 
effects, all realtime effect editors are marked either “GPU” or “CPU”, such as “2D GPU”. Realtime effects can 
be found in the Library tab, in the Racks named Realtime Clip FX and Realtime Transition FX.

Always apply CPU effects before the GPU effects. Check the FX Properties of a clip: CPU effects should 
lead the list, and GPU effects should be down the list. (Right-click a clip to call FX Properties.) See also 
“Optimizing Realtime Preview”  on page 11-8.

Effect Icon
The small icon visible in a clip on the Timeline indicating that a clip effect has been applied is green when it des-
ignates a realtime effect. This allows you to distinguish it from render effects.

Effect Preview in the Editor

You can already test realtime effects in the corresponding Effect Editor. Click the button shown for Play In to 
Out to play the effect from start to finish. In the case of long clip effects (filters), it’s best to set the Playline man-
ually whenever possible and view subsections of the effect.

“Progress” Effect Parameter

Some realtime Effect Editors include the Progress parameter, which allows you to determine how fully devel-
oped the effect should be at a specific point in time. For example, you can define that a Clock Wipe should 
already be 25 percent completed when the Transition begins.
In the default configuration, Progress is 0% at the start of a transition and 100% at the end.
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Discrete Parameters

Some effect parameters (for example, the number of sides for MultiShape Crop) can be set only in whole-num-
ber increments (thus making them “discrete”). If you want to change discrete parameters between the begin-
ning and end of an effect, the change occurs in abrupt steps. For example, every few frames an additional side 
suddenly appears in the effect image. Intermediate steps are not possible.

Quick Introduction to Effects

If you can or prefer to skip over all the details of effect processing at this time, read the following quick intro-
duction. For more details, see the section on effects under “Effect Basics”  on page 10-4 ff.

1  W h e r e  a r e  t h e  e f f e c t s ?

All effects and Effect Editors are located in the Project window or Project Browser on the Library tab. The real-
time effects can be found in the folders called Realtime...; the Pinnacle Hollywood FX are also realtime-capable 
and can be found under Plug In Transition FX, Plug In Clip FX.

2  W h a t  i s  a n  E f f e c t  E d i t o r ?

Actually, an Effect Editor is also an effect, but one that you can fine-tune. Some effects are immediately visible 
when you apply them to a clip; the Black-and-White Effect, for example, instantly removes all color from the 
image (this effect can not be edited, however). A 2D Editor, on the other hand, requires a few settings before the 
effect is applied (for example, a change of Position). Each Editor has a certain number of parameters, e.g. Size or 
Rotation to affect the image’s appearance.

3  W h a t  i s  t h e  d i f f e r e n c e  b e t w e e n  a  c l i p  e f f e c t  
( f i l t e r )  a n d  a  t r a n s i t i o n ?

A Transition requires two consecutive clips on the Timeline:
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Position the Transition across the edit between clips. A Transition always requires two images (even if one of 
them is “black”, or blank Timeline) and, therefore, always requires “leeway”, i.e. material extending beyond the 
displayed clip length. With A/B editing, the same clip would look like this:

The two red arrows indicate the extra “leeway”.
If there isn’t enough leeway, the Transition turns completely or partially red.

A clip effect (often called a “filter”) is generally applied for the entire length of a clip. The effect can change dur-
ing the course of the clip but doesn’t have to. In the one case, the effect would be static (e.g. a consistent and uni-
form saturation) and, in the other, dynamic (e.g. a 2D motion effect). 
A clip effect is indicated by an effect icon and a colored line along the top of the clip:

Clip effect with icon and colored line

You can apply a clip effect to the entire Timeline Track (i.e. to all the clips on the Track). To do so, drag the effect 
to the Track’s title bar. This will cause a colored line to be displayed there. Using this procedure you can, for 
example, change all the video clips on a Track to monochrome or reduce their size - or both, since you can also 
apply multiple effects. 
Pay attention to the sequence of CPU and GPU effects.

Fade in

Fade out
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4  H o w  d o  I  a p p l y  a  c l i p  e f f e c t ?

The easiest way is to drag the effect you want from the Rack and drop it on a clip.

Please note: for maximum performance apply CPU effects before you apply GPU effects.
(But there are also other options: see“Opening Effect Editors and Editing Clips (= Applying FX Editors)”  on page 
10-13.)

5  H o w  d o  I  a p p l y  a  t r a n s i t i o n ?

Drag the desired Transition to the edit between two clips. Important: Even if there is only one frame between 
the clips, you won’t be able to drop the Transition. Make sure you have enough “leeway” ( page 11-27).

6  H o w  d o  I  e d i t  e f f e c t  p a r a m e t e r s ?

First you have to open the Effect Editor. In the case of Clip FX, right-click the colored effect line along the top of 
the clip or the effect icon to display the shortcut menu. Then select the editor (if more than one effect has been 
applied), followed by Edit.
For Transitions, just double-click the Transition.
Now change the parameters using the sliders on the left-hand side (e.g. for Size and Position in the 2D Editor). 
Or you can use the tool buttons on the right-hand side, which will allow you to change parameters directly in 
the inlay (click and drag). 

7  W h a t  a r e  K e y  F r a m e s  a n d  w h a t  d o  I  n e e d  t h e m  f o r ?

You do not always need Key Frames. Static Clip FX don’t require Key Frames. If you don’t want to continuous or 
dynamic change during the clip’s duration, open the editor, go directly to the Options tab and click Do not use 
Keyframes. Any modification is then applied equally to each individual frame of the clip.

Motion, change and dynamic effects, however, require at least two Key Frames. The first Key Frame contains the 
initial state and the second contains the end state. The change takes place between the two, all intermittent 
states are interpolated.
Do not deactivate the Key Frames in a Transition.
Also see “Key Frames”  on page 10-20 or the section in this chapter on “Parameter Curves”  on page 11-16.

8  C a n  I  s a v e  e f f e c t s  I  c r e a t e d  m y s e l f ?

Yes, on the FX tab in the Project window. The Library is reserved for the effects supplied with the product.
Right-click the effect (either a Transition or Clip FX on the Timeline) to display the shortcut menu and select 
Copy. In the Project, go to the FX tab, create a new Rack and insert your effect there. You should also name the 
effect to make it easier to identify for later use.
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When you call an effect by double-clicking it and you then edit and close it, a query is displayed asking whether 
you want to save this effect permanently. If you click Yes, the effect is stored on the FX tab in a Rack named New 
FX, where you should then assign it a unique name.

You can copy effects, Racks and Rack Folders from the Library tab to the FX tab, thereby creating your 
own selection of favorite effects, individually named and edited.

9  H o w  d o  I  d e l e t e  e f f e c t s ?

Transitions: Click to select and press DEL.
Clip FX: Right-click the effect icon or the effect line to open the shortcut menu and select Delete.
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Realtime Clip FX

Editors

L e n s  F l a r e  

This effect generates an optical reflection that radiates outward in all spectral colors just as it would appear if 
light hit a camera lens from the side.

M a g n i f y  

This effect generates a magnifying glass that can be moved across the image.

2 D  ( C P U  a n d  G P U )

Editor for two-dimensional effects (XY) including parameters for borders and shadow. For individual slide 
effects, enlarging/reducing image size.

3 D  ( C P U  a n d  G P U )

Editor for three-dimensional effects (XYZ); for example, individual tumble effects.
You can also open the 2D and 3D Editors using the Effect Editor icons next to the Master Viewer.

M u l t i S h a p e  C r o p  

This editor lets you crop an image from multiple sides and at all possible angles.
In the initial configuration, the image is displayed as an octagon. Using the parameters for Radius and number 
of Sides you can, for example, create a many-pointed star.
Note: Naturally, when discrete parameters such as the number of sides are used with dynamic effects (with Key 
Frames), it is only possible to jump from one state to the next - two sides to three sides to four sides, etc. This 
applies to all editors with discrete parameters.

M u l t i S h a p e  P I P  

This effect is used for overlapping (multilayering) individually shaped images.

M u l t i S h a p e  S p o t L i g h t  

This effect generates an area on the image that resembles the lighted field of a spotlight; you can define its size, 
position, color and shape.
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R e p l i c a t e  

This effect multiplies the image by replicating and miniaturizing it, and also by scaling if you entered different 
values for horizontal and vertical replication.

Wa t e r  D r o p  

This effect simulates the impact of a droplet falling onto the surface of water, producing expanding, concentric 
waves.

Wa t e r  Wa v e  

This effect is similar to Water Drop except that a straight wave approaches from different directions and rolls 
over the image.

B r i g h t n e s s  a n d  C o n t r a s t  

This effect provides a simple brightness and contrast slider. In the default configuration, the RGB color chan-
nels are linked together but they can also be adjusted individually.

F u l l  C r o p  

This effect is used for cropping the image on four sides - top, bottom, right and left.

P a g e  C u r l  

This effect causes the image to roll up like a sheet of paper in a tighter or looser roll. The back of the page shows 
either the mirror image or a user-definable color.

P a g e  P e e l  

Same as Page Curl except that the image is not rolled, i.e. the edge is always visible.

A c c o r d i o n  

This effect folds up the image in a series of parallel folds like an accordion.

B e v e l  C r y s t a l  

This effect generates the impression that you are viewing the image through a polished crystal. You can modify 
the pattern, the number and alignment of edges, and the refraction.
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C r a c k e d  S l a b  

This effect produces a jagged crack through the image and divides it into two halves. You can edit the color, 
direction and shape of the crack.

F a l l i n g  C r y s t a l s  

This effect shatters the image into many pieces that slowly fall downward.

C u r t a i n  

This effect projects the image onto a curtain that can be pulled open to the left or right. The Wind parameter 
causes the curtain to wave in the wind more or less gently.

C y l i n d e r  

This effect projects the image onto a cylindrical surface.

E x p l o s i o n  

This effect breaks the image into many pieces so as to resemble an explosion.

R e f l e c t i o n  

This effect is like viewing a motif across a pond and seeing it reflected in the water, with waves if desired.

S t a i n e d  G l a s s  

This effect is like viewing the image through glass with an irregular surface, causing distortion and magnifica-
tion effects.

B a s e  C o l o r  C o r r e c t i o n  

This effect lets you set the luminance (Y correction in the Black, Gain and Gamma brightness ranges), the indi-
vidual color channels (red, green, blue), Saturation (Chroma) and Hue. Brightness and Contrast sliders are also 
available.
The Colorspace Settings help you avoid unreliable colors or stay within the CCIR standard. For more informa-
tion, see  page 8-61.

B l u r

Blur is an adjustable defocusing. The blurred area can be enclosed.
This Blur is much closer to what a real-world camera lens would achieve and in that respect better than the 
Gaussian Blur (Classic Filter Effect Editor). On a dual CPU system, both processors will be utilized. You can 
switch of this option in the High performance menu. In single CPU systems, this option is inactive.
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C h r o m a K e y e r  Y U V  

The Chroma Key lets you make specific areas of an image transparent to reveal the image underneath. The 
transparent image areas are defined by their color, which is why this is called a Chroma Key.

Defining a color 

You can select the Hue angle (as designated by the center of the “pie piece”, which you can also rotate by means 
of the mouse), a certain area around the selected hue center (modify Discrimination to make the slice bigger or 
smaller), and you can limit your selection by defining the Saturation (regions most saturated are at the edges of 
the color field).

Key Gain and Key Offset 

Key Offset specifies the amount that is to be added or subtracted from the key image. Gain specifies the value by 
which the key image is multiplied. Higher gain provides higher contrasting keys with sharper edges.

Invert Key 

reverses the region that is keyed out.

Spill Suppression 

Spill Suppression is the mechanism for removing a color cast from the foreground image. Spill is usually caused 
by light bouncing off a monochrome background (such as a blue screen). The Spill Suppression Angle is nor-
mally set to the same or nearly the same value as the Hue angle. Therefore this value is set as an offset. Example: 
Hue angle = 340, Angle Offset = 10, the resulting Spill Suppression Angle is 350. Gain specifies how much of the 
spill hue to suppress. When set to 1, then full strength Spill Suppression is performed.

Helpers 

Split Screen controls how much of the resulting image will show the key image. You can show the key in the 
lower or upper half of the image.

Invert 

This effect maps the signal components on their opposite values - either all three simultaneously or one at a 
time: Y (brightness/luminance signal) and the Cb and Cr color difference signals.
It’s best to view the results in a color bar. Invert Y exchanges black and white bars. Inverting Cb and Cr compo-
nents maps a color on the color that is more or less directly across from it on the color wheel (for example, yel-
low on blue).
If there is an alpha channel, it can also be inverted.
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L u m a  K e y e r  

With a luminance key, only those areas of an image that have a specific brightness (Y) are made transparent. 
The brightness range around a middle value can also be provided with a soft transition to an unkeyed area. 
Parameters:

� Center -
sets the center luma value that will generate a full key.

� Radius -
sets the radius around the center value that will generate a full key.

� Softness -
softens the transitions from key to non-keyed regions.

� Gain -
multiplies the key value by the Gain constant

� Offset -
adds or subtracts a constant value of an offset from the key.

� Invert Key -
the pixels that were keyed out will become not keyed out, and vice versa.

R o l l  /  C r a w l  

This editor has only two parameters: horizontal position and vertical position. It has been specially optimized 
for animating roll and crawl titles and is automatically applied when you create an animated title in TitleDeko.

P o s t e r i z e  

Posterize reduces the number of different colors in an image to produce a flatter effect resembling a poster.

B l a c k - a n d - W h i t e  

Removes all color information from the clip. Not editable.

T r a c k  M a t t e  C P U  

With Track Matte CPU it is possible to create a tailor-made, even animated alpha plane. An example of a track 
matte (also known as a travelling matte) is the view seen through the gun barrel in the opening credits of James 
Bond movies: You‘re looking out through the muzzle and following the movements of the actors in the back-
ground - until the shot rings out and blood runs down the screen.
You can now do this at home.

Set this effect using the Timeline’s Matte Track function (see the detailed description starting on  page 9-108).
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Parameter

� Keyer Type -
Here you can define the source of the key information: Luma means that the key information (or alpha 
channel) will be generated from the luminance signal of the key clip; Linear means that the existing 
alpha channel of the key clip will be used. Title generators usually create clips with an alpha channel. 

� Center Value -
Defines the exact luminance value beyond which the foreground clip will become visible.

� Radius -
Defines a range of values around the value defined as Center value.

� Softness -
Creates a soft transition between the Center Value and the zero value.

� Gain -
Multiplies the alpha channel created by the Track Matte effect by this value.

� Invert key -
Inverts the alpha channel that Track Matte generates.

� Transparency -
Controls the transparency of either the foreground image or the background image (depending on 
Invert key setting).

S w i r l  

Superimposes a whirlpool (as you see in your bathtub) over the image. Can be edited in several categories (Size, 
Position, Angle, etc.)

S p h e r e  S e c t i o n

Projects the image on a cone- or rhombus-shaped three-dimensional body, whose appearance can be altered 
with several controls.

S h a r d s

The image disintegrates into many triangular pieces (roughly resembling shards). The shards can, among other 
things, be rotated and, similarly to the explosion effect, disappear beyond the image frame.

T i l e s

The image disintegrates into a definable number of rectangles. You can influence the distribution as well as 
some other parameters.
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Presets

In these Racks you find predefined effects, arranged by GPU and CPU. It‘s a good idea to turn to Picon view to 
get an idea of what these effects do. 

Audio FX

See “Audio Effects”  on page 13-69 and “Pinnacle Liquid Plugin Audio Effects (VST)”  on page 13-76.

Realtime Transition FX

Editors

D i s s o l v e  C P U  

Standard transition 

C r o s s  D i s s o l v e  G P U  

Standard transition

D i s s o l v e  T h r o u g h  C o l o r  

Dissolves from an image to a selectable color and from there to the next image: Or the dissolve can be set so that 
it becomes increasingly transparent (alpha) to reveal the clip underneath.

G r a d i e n t  W i p e  

This transition provides over 400 gradient patterns for designing the transition.
Note: Alpha Magic Wipes are part of the Classic Transition FX Gradient Wipe Editor.

G r a d i e n t  W i p e  w i t h  B o r d e r  

This transition provides additional parameters for designing a border.

P a g e  C u r l  a n d  P a g e  P e e l  

As described under filters, but for transitions.
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B a n d  W i p e  

The new image advances across the old image from both sides and in a definable number of bands, like the 
teeth of a comb.

B a r n  D o o r s  

The new image advances across the old image from both sides like the two wings of a barn door. Parameters 
such as direction and colored border permit variations on this theme.

C l o c k  W i p e  

The new image covers the old image in a growing, round segment like the sweep of a hand of a clock.

G r a d i e n t  W i p e

This is a wipe effect with 400 wipe patterns.

I n s e t  

This is a wipe effect in which the new image starts in one of the four corners and gradually covers over the old 
image until it is completely hidden.

I r i s  C r o s s  

This is a wipe effect in which the image is divided horizontally and vertically into four square segments; 
depending on the effect direction, these segments gradually become smaller to reveal or hide the new image.

I r i s  D i a m o n d  

This wipe effect forms an overlap in the shape of a diamond (square standing on a corner).

I r i s  R o u n d  

This wipe effect forms a round overlap.

I r i s  S q u a r e  

This wipe effect forms a square overlap (edges parallel to image).

P u s h  

One image pushes the other either to the side or upward or downward.
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R a d i a l  W i p e  

The previous image is tipped out of the visible area via one of the four corners, revealing the new image.

S l i d e  

Slides the new image over the previous one.

We d g e  W i p e  

Same as the Clock Wipe except that the segment grows in both directions (with the Clock Wipe, one of the two 
“hands of the clock” remains fixed).

W i p e  

Same as Slide but with two additional parameters (Edge Softness and Border).

Presets

In these Racks you find predefined effects, arranged by GPU and CPU. It‘s a good idea to turn to Picon view to 
get an idea of what these effects do. 

Audio FX

� CrossFade -
Standard audio cross fade
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PlugIn FX / Hollywood FX

The Pinnacle Hollywood FX included with Pinnacle Liquid are also realtime-capable. Hollywood FX count 
among the GPU effects.
The Hollywood FX Editors are located on the Library tab in the PlugIn Transition FX and PlugIn Clip FX Racks. 
In the Specials folders you will also find a selection of Hollywood presets.

Additional Realtime Capabilities

In addition to effects, the realtime capabilities of Pinnacle Liquid come into play in other areas as well.

Realtime Color Correction in the Clip Viewer

The Clip Viewer’s extended dialog box contains functions for primary color correction. These include lumi-
nance, red-green-blue in the black, gamma and gain ranges, and control by means of hue and saturation.

For more information, see the section entitled “Primary Color Correction, Playback Level and Scene Detection”  
on page 8-61.

Titles and Graphics with Alpha

Still, roll and crawl titles are played across a video in realtime. The number of layers possible (i.e. the number of 
titles you can place on top of one another) depends on your system’s performance capability.

Audio Effects

Pinnacle Liquid’s standard audio effects as well as all VST plugins continue to be realtime-capable. See“Audio 
Effects”  on page 13-69.
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Timewarps and Color Correction

Color Correction Editor  page 12-3

Linear Timewarp  page 12-45

Timewarp Editor  page 12-50
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Color Correction Editor 

The Pinnacle Liquid Color Correction Editor provides primary and secondary color correction functions, 
including the necessary diagnostic tools (such as the Waveform Monitor and Vectorscope). 

The first part of this section will provide you with an overview of the editor’s elements and functions. The sec-
ond part contains a brief discussion of color theory, which you can skip if you’re already familiar with color cor-
rection. The third part provides you with a detailed description of all the parameters of the primary and 
secondary correction modules along with several examples.

Color Correction Editor (Overview)  page 12-4

What is color?  page 12-8

Practical tips for using color correction  page 12-11

Working with the Vector, Cube and Waveform Displays  page 12-13

Introduction to the interpretation of the most important diagnostic displays 

Diagnostic displays  page 12-19

Tools  page 12-26

Legalizer, channel selection and saved settings 

Primary Color Correction  page 12-27

Six Vector Color Correction  page 12-38

Selective Color Correction  page 12-39

Real Time Color FX (Liquid blue) page 12-44
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Color Correction Editor (Overview)

Opening and Operation

Color Correction Editor operation is the same as clip Effect Editor operation (general instructions for use can be 
found under “Classic Clip Effect Editors (Filters)”  on page 10-10). Open the Color Correction Editor as follows:

� Click the button displayed (in the standard view, located to the right of the Master 
Viewer) followed by the clip that you want to edit or

� Drag the editor icon from the Library  tab in the Project window to the relevant clip. 
Then open the editor either by right-clicking the effect button for the clip or right-
clicking the colored line along the top of the clip. 

The Color Correction Editor takes the place of the Sequence Editor. Click the triangular arrow at the bottom 
between the inlays to open the bottom half of the editor. 
The Color Correction Editor is divided into five areas:

� (1) Diagnostic displays, inlay reference sources and buttons;

� (2) Compact Display of correctors and magnifier;

� (3) Inlay for the image material to be corrected, Primary Color Correction buttons;

� (4) Buttons for Primary Color Correction and the two types of secondary correction;

� (5) Tools for editing, such as the Legalizer.

Color Correction Editor

1
2

4 5

3
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Diagnostic Area (1)

Diagnostic area of the Color Correction Editor

This area contains functions for analyzing and assessing the image material to be edited.

� A - This knob lets you adjust Display intensity.

� B - List box for selecting the Display (Vector, Waveform, Histogram, Lightning, Cube, Vectorlight) or Refe-
rence Source. 
For descriptions of the individual Displays, see:  page 12-19.

� C - List box for quickly toggling between different Reference Sources ( page 12-28).

� D - Inlay (here, the Vector display)

� E and F - Position bar and buttons for navigating in a Reference Source.

� G - Click this symbol to change to the Vectorlight Display.

� H - Correction tools, Display selectors.

A B C

D

E

F

G

H
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Compact Display and Magnifier (2)

�A - Compact Display of the three correctors (Primary, Six Vector, Selective); you can edit the 
tool buttons and sliders. 

�B - Zoom and scale
When the Zoom is activated, an enlarged view appears wherever the mouse pointer is positioned 
in the inlay. Moving the slider changes the zoom scale in four different stages.

�C - Opens/closes the expanded Color Correction Editor. 

Correction Area (3)

Correction area

A

B

C

C

A B
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The original material is edited in this area. Changes are immediately visible in the inlay and at the monitor out-
put.

� A - A Reference Source (in an orange frame) is displayed. Select the reference source from the shortcut 
menu for the relevant Timeline clip. See also “Reference Source” on page 12-28.

� B - Buttons (Color and Gray Balance, HistoMatch, HueMatch, etc.)

� C - Buttons for navigating in the correction clip; Undo/Redo, return to original state, etc.

Comparing the Master Viewer inlay and the Color Correction Editor viewer, a slight change in contrast 
and/or brightness can be observed. This is, however, not a defect, but the consequence of different color 
spaces used for representation of the same clip in the inlays on the one hand and the Color Correction 
viewer on the other hand. While the other inlays display the CCIR color space (RGB 16 to 235), the 
Color Correction Editor works with the full range available because it uses a rendered frame for preview. 
Therefore it is possible to modify the video level even beyond the 100 and 0 % limits.
We would like to stress the fact that serious color correction is not possible by judging the image on a 
computer monitor. RGB does not display the full range of colors, which becomes particularly obvious 
with very bright and very dark colors. Connect a calibrated video monitor for optimum, YUV-based 
performance and quality control. 

Primary and Secondary Correctors (4) 

You can apply the three correctors individually or combine and apply them consecutively (from left to right). 

� Primary Color Correction (left) - Permits basic color editing; for example, you can quickly correct a 
color cast or change the contrast ( page 12-27).

� Six Vector Color Correction (center) - Permits the selective adjustment of six defined color areas (red, 
magenta, blue, cyan, green, yellow;  page 12-38).

� Selective Color Correction - Permits the selection of up to 15 specific color areas for a precise color cor-
rection including ColorWash and “Garbage” ( page 12-39).

Tools (5) 

The area to the right of the correctors contains:

� A Legalizer that can be activated or deactivated. If activated, it will show you when the permissible sig-
nal-related threshold has been exceeded in the diagnostic displays (Vector, Wave, etc.) ( page 12-26).

� A Channel Selector that permits the individual selection and display of Y/RGB channels ( page 12-26).

� A selection list containing color correction Settings that can be applied repeatedly ( page 12-26).
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What is Color? 

Depending on who you’re talking to, this question can have many different answers. 
A physicist might say that color is an electromagnetic radiation of a certain wavelength. A doctor might tell you 
that it’s the stimulation of light-sensitive receptors on the retina. An artist might say, it’s a subjective impression. 
And a philosopher would perhaps answer, it’s nothing but an idea. 
In any case, color has something to do with light. When Sir Isaac Newton illuminated a prism with a ray of sun-
light, three rays emerged from the other side - red, green and blue - which were then changed back into color-
less “white” sunlight when they passed through the next prism. 

Another observation that you can verify with any paint box is that when you combine certain colors, it pro-
duces a hybrid color that is not “contained in” the original colors. Blue and yellow make green. Does this mean 
that blue or yellow already contain green? Brightness also plays a part. In the dark, even the most vibrant red 
turns black and if you mix any color with increasing amounts of white, it will eventually turn white. 

When thinking about colors, it’s helpful to develop models that include a few basic assumptions and that will, in 
actual practice, result in reasonable outcomes and satisfactory explanations, even if they’re not the final word 
on “Color”.

Possible Models 

The models used in Pinnacle Liquid Color Correction came from computer and television technology. Both are 
primarily based on the assumption that there are three basic colors (red, green and blue) and a brightness 
(“gray zone”) between the extremes of white and black. Three dimensions are enough to establish a space, 
which is why we talk about a “color space”. Thus we can imagine colors (or, more precisely, hues) as precisely 
defined points within a precisely defined space.

The Color Wheel 

The color wheel - a physiologically inspired reflection of the phenomenon of color vision - is based on the 
assumption that four basic colors form two opposite pairs: red and cyan, blue and yellow.

Add to this the brightness, which ranges between white and black. These three pairs can be spread over a three-
dimensional coordinate grid (color space) in which each color that can possibly be displayed is defined by its 
blue or yellow component, red or green component and a brightness. In color television technology, the oppo-
site color pairs are replaced by the color difference signals R-Y (Cr,U) and B-Y (Cb, V). The luminance signal Y 
forms the third coordinate. 
The basic colors red, green and blue and the mixed colors magenta (violet), cyan and yellow that lie in between 
are points (color signal locuses) within this wheel. Thus the color phenomenon is also displayed in the vector-
scope (the use of this measuring device for color manipulation is highly recommended).
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When examining a color bar in the vectorscope, each of the colors named above is represented by a glowing dot 
at a specific location of the screen (located at the tip of an arrow; see figure). The arrows are called vectors. With 
the aid of these vectors, all the possible points (= colors or hues) within the wheel can be precisely defined 
mathematically.

The position of a point relative to the center of the wheel affects the colorfulness (saturation) of a color; a pale 
blue is close to the center and a vibrant, fire-engine red is located near the wheel’s periphery. A hue (red, green, 
blue, etc.) is an angle in the color wheel. Pure red is located at approx. 104 degrees and red-violet (magenta) at 
approx. 92°. Note that in the degree scale of the vectorscope, 0° is located at “3 o’clock”. 
Thus a color is adequately defined by the length of the vector and the angle. On this basis, color corrections are 
performed in the “YUV” color space.

Color wheel and color vectors (vectorscope view)

RGB Color Space 

On a computer monitor, colors are generated by means of red, green and blue dots illuminated at different 
intensities. If you look closely enough at the monitor, you can see these dots. The red, green and blue (RGB) 
variables can be stored digitally as bytes with values from 0 to 255. The notation (255,255,255) means “white”, 
(0,0,0) means “black” and (0,255,0) means a fully saturated “green”. The brightness not only of the resulting 
colors is also described by the RGB value sets: (25,25,25) would be a dark gray, (200,200,200) a light gray.
Many graphics programs use the RGB model to define colors.

Red 104°

Yellow 
167°

Green 241°

Magenta 61°

Blue 347°

Cyan 284°

90°

270°

180° 0°
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YUV Color Space (YCbCr Space) 

Television was originally black and white. All the information was transmitted in one signal, the luminance sig-
nal (Y), which permitted the display of the necessary shades of gray. When color television was developed, it 
still had to operate on the many existing black-and-white TV sets. For this reason, two “color difference signals” 
were added to the Y signal: Cb (analog: B-Y; U) and Cr (analog: R-Y; V). 
These three components form what is often called the “YUV” signal. From this signal, red, blue and green val-
ues can be computed that guarantee the correct reproduction of color on the color monitor.
Stored digitally as bytes, the value of each component can in theory range from 0 to 255. The actual ranges of 
values, however, are limited by CCIR Standard 601: 
Y (16 to 235)
Cb, Cr (16 to 240)

Mathematically speaking, the two color spaces (YUV and RGB) describe the same space. However, the differ-
ent range of values results in a very different spatial resolution. Moreover, specific colors are “not possible” in 
the RGB space but can be produced in the YUV space. See also “Legalizer” on page 12-26.
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Practical Tips for Using Color Correction 

Color correction is one of the most complex and difficult areas of postproduction. For non-professional users, 
we’d like to offer the following tips:

No Color Correction on the Computer Monitor

You should always evaluate any color correction on a calibrated video monitor or television. Because of the dif-
ferent technologies, the colors on the video monitor and computer monitor cannot match exactly.

Calibrating the TV Monitor

If possible, purchase a dark-blue filter (e.g. Wratten 47B), which will allow you to simulate the Blue Only (Blue 
Check) feature available on professional video monitors. You’ll find this filter in any of the better photo stores.

1 To calibrate a typical TV monitor, use the SMPTE color bar test pattern from Pinnacle Liquid (located 
under..\Media\Testpattern\NTSC). Load SMPTE Color Bars (NTSC) to a Project and then to the Time-
line or Clip Viewer so that it will appear on the TV monitor:

SMPTE color bars 
(Top row, left to right: White, Yellow, Cyan, Green, Magenta, Red, Blue
Middle, narrow row: Blue, Black, Magenta, Black, Cyan, Black, White)

2 View the screen through the blue filter (or turn on the Blue Check feature on the monitor).

3 The colors now disappear and you see only alternating lighter and darker bars - three darker and four 
lighter - as shown below:

SMPTE color bars: Blue Only

Hue and chroma 
adjustment area

Brightness 
adjustment area

Contrast adjust-
ment area
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4 Use the Hue control (if any) and Chroma control (“Color”) of the TV/monitor to adjust the picture 
until each of the four lighter, upper bars matches the small rectangle directly beneath it.
Hue mainly adjusts the two inside bars and Chroma adjusts the two outside bars. (You can ignore the 
bottom row. PAL televisions do not have a Hue control.)

5 Take away the blue filter (turn off Blue Check).

6 Now adjust the brightness. Look at the black area in the bottom row directly below the red bar. In the 
center is a vertical bar that is barely lighter than its surroundings (depending on the test pattern, this bar 
may also comprise three individual bars of different shades of gray).
Turn up the brightness until the center bar stands out clearly.
Then turn down the brightness, just until the center bar disappears.

7 And now for the contrast: Adjust the white rectangle between the two blue rectangles until it turns a 
pure, gleaming white but doesn’t intrude into the adjacent rectangles.

8 Contrast and brightness affect one another, so repeat steps 6 and 7 until you obtain the optimal results.

If you have a professional video monitor, set all the controls to the precalibrated positions.

Adapting the Environment

A professional colorist studio is gray and drab. Surrounding colors must not be allowed to distract from the 
motif.
Try to design your editing room to be as neutral as possible:

� Dim the lights as much as possible. Use lighting that is neither too “warm” (light bulbs) nor too “cold” 
(neon tubes). The ideal setup is a color temperature of 6500 K and indirect lighting.

� Remove all bright colors from your field of vision (flowers, pictures, etc.).

� Place the monitor in front of a neutral background. Make sure no direct light falls on the monitor, 
including from the sides.

� Avoid color curtains, which can affect room lighting, as well as color carpets and colorful wall cover-
ings.
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Working with the Vector and Waveform Diagnostic Displays  

This section describes how to work with a vectorscope, waveform, etc. Reading this section will help clarify 
much of the information on color and color models from the previous section and give it a concrete basis in 
reality. If you’re already familiar with this topic, skip to the description of the individual color correctors (“Pri-
mary Color Correction”  on page 12-27 ff.).

1 Begin by importing the RGBspace test image from the directory (Pinnacle Liquid > Media > Stills > 
PAL or NTSC) to a Project Rack. Then open the Color Correction Editor and click the test image to load 
it in the editor in place of the default image. From the drop-down list box above the Diagnostic Display, 
select Vector. If everything is functioning correctly, a colorful pattern of bands should appear on the 
right-hand side and the Vector Display should contain the following image:

RGBspace.bmp test image in the Vector Display

How to interpret this image:
RGBspace contains the six hues red (R), magenta (Mg), blue (B), cyan (Cy), green (G) and yellow (Yl), each 
ranging from non-saturated to saturated. These are the six lines radiating from the center point. (See also “The 
Color Wheel” on page 12-8.)
The edges represent the different gradual transitions from adjacent hues, such as the color gradient from red 
(255,0,0) to magenta (255,0,255). 
About the scale: The horizontal axis is Cb, the vertical axis is Cr, the six markings indicate the corresponding 
color locuses at a saturation of 75 %. 
The maximum saturation of the test image colors is 100 %; this is why the corners of the hexagon are located 
outside the circle.
The square contains the 75% color range.
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Unlike an analog vectorscope, the digital Vector Display of Pinnacle Liquid Color Correction displays 
disconnected points. This means, for example, that the typical line patterns are omitted from standard 
color bars interpretation. Another remark about color bars: The additional points visible in the digital 
display are the results of minimal “stray colors” in the transition to adjacent colors that are produced 
through anti-aliasing.

2 Go to the Primary Color Correction area (bottom left) and drag the Saturation slider (S). The hexagon 
expands or contracts and the colors in the test image intensify, fade or disappear altogether. In the Vec-
tor Display, a black-and-white image exists as a tiny dot at the point where the coordinates intersect.

Note: Clicking the button displayed quickly resets the original values.

3 Now try the Hue slider (H). The hexagon rotates like the vanes of a windmill. All the hues in the test 
image change to the adjacent hue. 

Primary color correction of the hue is especially useful in an NTSC system where often the entire spec-
trum is shifted during transmission; Hue can get it back on track.

4 Drag one of the three gray Primary Color Correction bars. These are the Luminance (Brightness) sliders. 
You will notice that while the brightness of the test image varies, the Vector Display remains the same. 
Why?

5 Because Luminance operates on a different plane. 
You will see this when you select the Cube display from the list box or when you click the Rotate button 
(which may have to be retrieved from the tool box).

6 Initially an image appears that is similar to the hexagon in the Vector Display but without the circular 
scale. The axes are identified as Cb and Cr. 
You are looking up at a cube whose uppermost corner is positioned exactly above its lowest corner. 
Left-click in the display above the Cr axis and drag it downward in an arc. The cube is rotated to a posi-
tion similar to the one in the image below:

The RGBspace.bmp test image in the Cube Display
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The third axis (Luminance axis Y) now appears. 
What appears to be a cube is the RGB color space. Within this space, imagine the possible RGB colors. As was 
stated earlier, we’re dealing with models and models always require a little imagination.
Once this RGB space appears within the coordinates of the YUV space, notice three things:

� The RGB value for black (0,0,0) is not positioned at Y = 0 but at Y = 16. This is evident from the corner 
of the cube located just above the axis intersection. Likewise, the RGB value for white (255,255,255) is 
positioned at Y = 235. This is due to the CCIR Standard mentioned above ( page 12-10).

� The cube is smaller than the space created by the YCbCr axes. This is also due to the CCIR Standard 
which specifies values from 16 to 240 for Cb and Cr.

� The RGB cube stands on one of its corners. Its space diagonal from black to white corresponds to the Y 
axis of the YUV space.

� Press SHIFT and drag to rotate the cube around the Y axis.

Experiment with the Saturation slider to see how the cube expands and contracts.
Once it expands beyond a certain point, clipping occurs; this means you’ve reached the edge of the permissible 
YUV space. See also “Legalizer” on page 12-26. 

7 Close the Color Correction Editor and reopen it immediately to call the standard test image (Note: Make 
sure there is no clip selected on the Timeline!). The Vector Display contains the following image:

The standard test image in the Vector Display

How can this be explained?
The six radiating lines that characterize the RGB color space are created by the six color bands at the top of the 
test image.
The gray-scale wedge at the bottom of the test image describes the range of possible luminance (0 to 255) and, 
as was explained above, is not visible in this display because luminance is plotted along the Y axis. 
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The most important feature here is the square plane representing the possible colors of the YUV color space. 
Switch back to the Cube Display:

The standard test image in the Cube Display

With a luminance of Y = 128, you see the plane of possible colors for the YUV space (here only every fourth 
color value is displayed as a pixel dot). These values come from the color square in the center of the test image.
Color gradients (Cb,Cr) are arranged on the left and right (half resolution). These two lines form the axis inter-
section at Y = 128. 
The gray-scale wedge (luminance from 0 to 255) appears as a green Y axis in conformity with YUV.

Experiment with the sliders again to get a feel for Vector and Cube Display interpretation.

Now switch to the Waveform Display:

The standard test image in the Waveform Display (not clipped)
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The Waveform Display lets you measure the luminance (a.k.a. brightness or video level) of an image signal.
In contrast to the Vector Display, the Waveform has a spatial relationship to the image, as is clearly indicated by 
the line running diagonally from the bottom left to the top right; this line indicates the increasing luminance of 
the gray-scale wedge which runs from left to right in the test image.
The other six diagonal lines represent the six color bands in the luminance gradient.
The line of the YUV color fields with two gaps is located at 50% (Y = 128); the short lines below the gaps repre-
sent the gray bars between the color fields.

The red scale mark at 0 (percent) stands for CCIR black (Y = 16) and the mark at 100 stands for CCIR white (Y 
= 235). If you activate the Legalizer ( page 12-26), the lines/values extending outside this range are clipped. 
Another common name for the range from 0 to 100% is the “image amplitude”. 

8 Naturally, test images always provide very tidy Vector and Waveform Displays. The interpretation of 
“real” video signals can appear confusing but only at first glance. Here are three examples:

Video image and the associated Vector Display

In this image, a green apple (the Granny Smith variety, to give you an idea) is being dipped in a can of yellow 
paint. To the right is a can of blue paint and in the background a few splashes of red, yellow, blue and turquoise 
paint. 
Every luminous green dot in the Vector Display stands for a precisely defined hue with a specific saturation. 
Intensely glowing clumps appear wherever a large number of very similar hues are grouped together.
The Vector Display clearly reflects the yellow and red color components as well as the turquoise splashes. What 
is at first surprising is the lack of a distinct “green” display for the apple. Where the human eye makes a clear 
distinction, the Vector analysis sees only nuances of yellow. 
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The same motif as it appears in the Waveform Display:

Video image and the associated Waveform Display

This display shows a relatively uniform distribution of brightness, a wide band that mainly falls between 20 and 
80 percent. The short black band at the lower left-hand edge of the image is mapped on the zero line at the bot-
tom left. At points the highlights on the apple and paint cans extend above the 100 percent line.

This motif illustrates even more clearly the spatial relationship between the Waveform Display and the associ-
ated video image:

Image and the associated Waveform Display

The even blue background extends in a band across the entire display; the darker squares on the right stand out 
as three spikes. The lighter reflection on the light bulb is the horizontal mark on the 100 percent line; the uni-
form gray of the bulb is represented by the slightly longer mark on the 80 percent line. The different luminance 
values of the face are responsible for the spectrum at the center of the waveform.
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Diagnostic Displays (Overview)  

Pinnacle Liquid Color Correction provides various diagnostic displays for assessing and analyzing video signals. 
You can select them from the top left-hand list box (above the Diagnostic Display area), or by clicking their 
respective buttons.

Vector Display 

The Vector Display allows you to analyze, control and adjust the color components in a video signal.

It is called automatically when you activate the Hue-Saturation button (see figure).

Vector Display with mouse pointer

� The abbreviations R (red), Mg (magenta), B (blue), Cy (cyan), G (green) and Yl (yellow) stand for the 
color signal locuses. The circular degree scale (0 to 359° with 0° at “three o’clock”) indicates the color 
angle. 

� The Cb axis runs horizontally and the Cr axis runs vertically.

� The square formed by the dotted line encloses the range of 75 % color range 
(see also Legalizer on page 12-26).

� The permissible range as defined by CCIR Standard 601 is specified by the dimensions of the axes (see 
also Legalizer on page 12-26).

� Single-clicking the segmented rectangle in the bottom right-hand corner instantly takes you to the Vec-
torlight Display.
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You can set the Saturation (S) and Hue (H) directly in the Vector Display. 

� Saturation -
Drag the mouse pointer across the display, either toward or away from the axis intersection.
A double-click resets the value to initial state.

� Hue -
Drag the mouse pointer in a circle around the axis intersection.

Waveform Display 

The Pinnacle Liquid Waveform Display represents the luminance component of a video signal (video level). It 
analyzes the signal’s field lines from left to right, meaning that the waveform image has a spatial correlation to 
the video image. 
This is illustrated by the standard color bar (100/100) with its graduated brightness gradient from white 
(100 %) to black (0 %):

Waveform Display of the 100/100 color bar

The scale from 0 to 100 (percent) refers to the image amplitude. Beyond 100 percent, bright spots in the image 
appear plain white without any detailing. Using the Legalizer, you can clip the signal ( page 12-26).

� Single-clicking the segmented rectangle in the bottom right-hand corner instantly takes you to the Vec-
torlight Display.
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Cube Display 

The Cube Display is a three-dimensional display of the video signal along the Y, Cb and Cr axes.

Cube Display rotated to an individual perspective

Clicking the Rotate button automatically takes you to the Cube Display. You can then drag the mouse pointer 
over the display to create the desired perspective.

� Simultaneously hold down the SHIFT key to rotate the display around the Y axis.

This display is especially useful when you’re working with Selective Color Correction. You can then see 
how the user-definable Hue, Lightness and Saturation ranges gradually come to encompass the color 
locuses along the luminance axis as well.
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Lightning Display 

This display shows the color values of all three signal components (YCbCr). All the other displays can indicate 
either the color component or the luma component. The Lightning Display is used especially in video analyzing 
technology.

Lightning Display

Basically, you are shown two sides of the Cube Display, one of which is upsidedown (in the bottom section). The 
Y component is plotted along the center vertical axis. The Cb component is displayed on the left-hand side of 
the top section and the Cr on the left-hand side of the bottom section, each in the positive coordinate range.
To clarify this further, load the RGBspace graphic. Then experiment a little with the Hue slider and compare the 
results with the Cube Display ( page 12-13).

� Single-clicking the segmented rectangle in the bottom right-hand corner instantly takes you to the Vec-
torlight Display.
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Vectorlight Display 

The Vectorlight Display combines several different displays:

� Vector Display (bottom left)

� Waveform Display (top right)

� The other two are variations of the Cube Display (similar to the Lightning Display). The Y axis is the cen-
ter vertical axis in the top left display and the center horizontal axis in the bottom right display. 
Changing the Hue value rotates the image around the Y axis and will help you gain a clearer under-
standing of the displays.

Vectorlight Display

Click one of the Displays to maximize it on the screen.
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Histogram 

The Histogram shows the distribution and frequency of the RGB values contained in an image. It has no spatial 
relationship to the associated image.
Color correction using the Histogram (HistoMatch) is described elsewhere:  page 12-36.

Histogram Display

� A field is displayed for each channel (red, green, blue).

� The values are plotted from left to right on the X axis (0 to 255), the scale is divided by 10 scale marks 
along the upper horizontal lines. 

� The two inner dotted red lines indicate the edges of the permissible range (approximately as per CCIR 
601) and the outer dotted lines represent 0 and 255. See “Legalizer” on page 12-26.

� The Y axis (from bottom to top) represents the number of pixels for each point along the X axis. The Y 
axis is scaled so that the full height of the scale always represents the maximum value detected, the oth-
ers adapt accordingly. 

� The histogram for a reference source is dark blue; wherever values overlap, the green histogram of the 
current image is somewhat brighter. 

For example, the histogram of a fully saturated red color clip (255,0,0) comprises a green vertical line at posi-
tion 255 in the R field and two lines at position 0 in the G and B fields. Clearly stated, all the pixels contained in 
the image are red=255 and it contains no values for the other two components. The histogram for a dark-green 
color clip (25,25,25) displays the three lines (full height) at the same X positions. 
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One more example:

Image and histogram

The motif is a circular gradient from blue to red. A large number of blue pixels are present resulting in a distinct 
display of R, G and B: three lines to the full height. Red is also present in the requisite specification; theoreti-
cally, however, it is only a single pixel (determined by the gradient definition) and therefore it does not show in 
the histogram display. 
The gradient appears as a ramp in the R and B fields.
If saturation is removed from the image, the display in the three fields will be identical; it then represents only 
the gray-scale values of the gradient. 
Experiment a little with the sliders to familiarize yourself with the histogram.

Basically, the following applies: The chances for a differentiated color correction are better if the values are dis-
tributed fairly evenly over the individual color channels. 
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Tools 

Legalizer 

Four options will help you stay within certain signal-related limits. 

C C I R  6 0 1  
Limits the image output signal to the values permitted by the CCIR-601 Standard by clipping any exceeding 
components. Use the SoftClipping function to configure signal clipping ( page 12-26).

Wo r k  o n l y  i n  C C I R  
This option confines values within the limits of CCIR 601, meaning that illegal colors cannot even be created 
during correction (rather than only be clipped at the output). 

7 5 %  C o l o r  
Limits the CbCr color components to 75 percent of the maximum permissible value.

S o f t C l i p p i n g  
Normally, signal peaks that extend beyond the permissible signal range are simply clipped, resulting in a loss of 
image information.

These two functions (one for Luminance and one for Chrominance) permit a gradual clipping, i.e. the signal is 
not simply truncated at the clipping limit but is compressed well below this limit. You can determine the degree 
to which it is compressed using the sliders.

SoftClipping permits a somewhat better delineation in image areas that are too bright and too dark.

Channel Display 

With this function, you can activate the individual color channels R, G and B or the luminance channel Y or all 
three color channels at the same time. It helps you detect image signal noise in the channels.

Reference Sets 

With this function, you can save up to 16 different groups of settings and restore them if necessary. The param-
eters of all three correctors plus tools are saved. 

Click the Plus symbol to add a set. A modified set can be saved using the double-Plus symbol. Trash deletes the 
current set, which you can choose form the list.
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Primary Color Correction 

A basic feature of Primary Color Correction is the fact that it affects the entire color balance of an image. In other 
words: If, for example, the red component in Gamma is increased, the whole image takes on a more or less dis-
tinct reddish “cast”. Or it’s a cast that is removed by increasing this component.

The sliders for Primary Color Correction are located in the lower left-hand section of the Color Correction Editor 
and between the inlays (Compact Display).
The Primary Color Correction functions are generally adequate for your “everyday” color correction needs.

Primary Color Correction can either be used alone or in combination with the other types of correction.

You can activate or deactivate the parameters by means of the square on the right in the Primary Color Correc-
tion title bar.

Operating variants  page 12-28

� Separately using sliders and editing fields  page 12-28

� Linked using the mouse in the inlay  page 12-28

� Working with the Reference Source  page 12-28

Parameters

� Gain  page 12-29

� Gamma  page 12-30

� Black  page 12-30

� Hue  page 12-30

� Saturation  page 12-30

Set contrast

� Black-Gamma-Gain contrast  page 12-31

� Contrast Adaptation  page 12-31

Cast correction (using the mouse)  page 12-32

Gray Balance (subsequent white-balancing)  page 12-32

Tone Balance  page 12-35

Color Balance  page 12-35

HistoMatch  page 12-36

HueMatch  page 12-37
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Operating Variants 

When working with Primary Color Correction, you can choose between several operating variants. For pur-
poses of comparison and matching, you can also display a Reference Source.

S e p a r a t e  C h a n n e l  C o n t r o l  
Using the mouse, you can adjust the bars for the color channels (red, green, blue) and luminance 
(gray) individually.
You can also edit the display fields: Click a field and enter a value or use the UP ARROW or DOWN 
ARROW keys to increase or decrease values. 
Press the TAB key twice to confirm your entry; the cursor then jumps to the next field.

L i n k e d  C o n t r o l  
When you drag the mouse pointer over the inlay, the R, G and B channels are modified simultaneously while 
luminance remains the same. This makes it easy, for example, to correct a color cast.
Imagine the color wheel( page 6-23) superimposed on the image. As you drag the mouse pointer toward “3:30 
o’clock” the blue component increases while the green and red components are simultaneously reduced. The 
RGB bars indicate the quantitative change.

Drag the mouse pointer (up or down) while holding down the right mouse button to change the Luminance.

Activate linked control by means of the gain, gamma or black button ( page 12-29).

R e f e r e n c e  S o u r c e  
A Reference Source makes it easier to correct or adapt the color of image motifs. Some Primary Color Correction 
functions (such as Tone Balance) require that you select a Reference Source.
This is how it is done:

1 Open the shortcut menu for a Timeline clip (this may require that you temporarily close the bottom sec-
tion of the Color Correction Editor) and click Set As Reference Source (this function appears in the menu 
only if the Color Correction Editor is open).
This clip continues to be defined as a Reference Source until you define another.

2 From the center list box above the diagnostics inlay, select Reference Source.
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3 Activate the Set Split Size function to change the size of the Reference Source displayed within the correc-
tion inlay. The orange frame indicates its dimensions.
Drag the mouse pointer from the corner or side from which it should be displayed.

4 You can display other Reference Sources as described under step 1. Or you can select the Last Source or 
Next To Last Source from the center list box above the diagnostics inlay. These options refer to the edited 
clips.

In order to display the Reference Source as a frame beside the correction image, select Reference from the 
left-hand list box above the diagnostics inlay instead of a diagnostic display.
The position bar below the diagnostics inlay refers to the currently active Reference Source, thus allow-
ing you to navigate within this clip.

Parameters 

This section describes the individual standard ranges and parameters of Primary 
Color Correction. 
You can modify RGB and luminance in three overlapping areas (Gain, Gamma, 
Black) either separately or with R, G and B linked (see also Linked Control on page 
12-28).
Hue and Saturation can also be configured either separately or in combination.

The effects of these sliders are best illustrated in the Waveform and Cube Displays 
(preferably with the RGBspace test image; see “Working with the Vector and Waveform 
Diagnostic Displays”  on page 12-13).

You can activate or deactivate the parameters by means of the square on the right in 
the Primary Color Correction title bar.

Be sure to keep an eye on the permissible maximum and minimum levels 
(verify in the Waveform or Vector Display) if, for example, you work for a TV 
station.

G a i n  ( H i g h i g h t s )  
Gain primarily affects the bright spots in an image such as highlights and reflections. 
You can raise or lower Gain to correct point-sized overexposures/underexposures.

Gain is the variable usually affected with the conventional contrast control on TV or Video Monitors. However, 
a much more effective contrast adaptation is achieved through the combination Gain and Black (see “Contrast”  
on page 12-31). 

The Waveform Display (with the standard test image) illustrates how the value is raised or lowered when 
Y=255. The slope of the lines changes.

Primary Color Correc-
tion (from top to bot-
tom: Gain, gamma, 
black, saturation, 

hue)
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G a m m a  ( M i d t o n e s )  

Gamma primarily affects medium-bright areas of an image.

Gamma is the variable you can set by adjusting the conventional brightness control on your TV set.

The Waveform Display (with the standard test image) illustrates how the lines from Y=0 to Y=255 are distorted 
into curves.

B l a c k  ( B l a c k  Va l u e ,  P e d e s t a l )  
Black primarily affects the dark ranges in an image. But be sure not exceed the permissible black value!

The Waveform Display (with the standard test image) illustrates how the value is raised or lowered when Y=0. 
The slope of the line changes.

H u e  
This slider causes a gradual transition of colors to the colors adjacent to them.(See also “The Color Wheel” on 
page 6-23.) 
In the Vector Display, a change in Hue appears as a rotation of the color locuses around the Y axis (which is why 
it is also called the “color angle”). It has no effect on the Waveform Display.

S a t u r a t i o n  
Saturation determines the colorfulness of a hue. “Saturation equals zero” is the absence of color components; 
only the Y (black-and-white) signal remains.
In the Vector Display, saturation is defined by the distance from the axis intersection Cb/Cr. Changes in Satura-
tion have no visible effect in the Waveform Display.

This slider corresponds to the standard color control on a TV set.

L i n k i n g  o f  H u e  a n d  S a t u r a t i o n  
This function allows you to modify Hue and Saturation simultaneously but only in the Vector Display 
( page 12-19). The Vector Display is automatically called when you click this button.

The mouse pointer changes on the Vector Display. If you drag the mouse pointer:

� In a circular motion, the color locuses rotate around the axis intersection, i.e. the Hues change;

� Up and down, the Saturation rises/falls.

� Simultaneously hold down the SHIFT key to change only the Saturation; hold down CTRL to 
change only the Hue.
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Contrast 

“Contrast” is the difference between the brightest and darkest spots in an image. When the difference is mini-
mal, the image is “flat”; when it’s extreme, the contrast is “hard”. A black silhouette against a bright white back-
drop is about the hardest contrast imaginable. Once contrast is used as a means for designing images, however, 
the subjective perception of differences between bright and dark is what matters most.

Contrast can be modified in two ways: Black-Gamma-Gain control and Contrast Adaptation.

B l a c k - G a m m a - G a i n  C o n t r o l  
Contrast can best be increased by making the brightest spots in an image a little brighter and the darkest spots a 
little darker (and vice versa to reduce contrast).

This is achieved with a slight increase or reduction in Gain and a concurrent slight reduction or increase in 
Black. Basically, this applies both to the luminance component and the RGB components. 

Saturation also contributes to the subjective perception of contrast.

C o n t r a s t  A d a p t a t i o n  
This function automatically adapts the contrast based on the brightest and darkest spots in an image:

Activate the function and drag a line from the “black point” to the “white point” (i.e. from the darkest to the 
brightest point in the image). Because this can be a matter of individual pixels, it may be helpful to activate the 
Zoom ( page 12-6). 

Y Gain and Y Black are modified so that the luminance value of the “black point” is set to true black 
(Y=0 or Y=16) and the luminance value of the “white point” is set to true white (Y=255 or Y=235). 
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Correcting Color Cast (with the Mouse) 

You can correct a subjectively perceived predominance/lack of a particular hue quickly and easily using linked 
Primary Color Correction:

1 Open the Color Correction Editor.

2 Click the clip you want to edit. It can be located in a Rack or on the Timeline. 
If necessary, move to a specific spot in the clip using the position bar or the navigation buttons.

3 Assess the distribution of brightness and then click the Gain (highlights), Gamma (midtones) or Black 
(dark range) button.

4 Take even greater control: Select the Vector Display ( page 12-19) and, if necessary, activate the Legalizer 
( page 12-26).

5 Drag the mouse pointer across the inlay in the direction of the hue that you wish to intensify and away 
from the hue you want to soften. See also “The Color Wheel” on page 6-23. 
The luminance remains the same. You can see how the linked values are changing by watching the RGB 
bars.

Gray Balance (Subsequent White-Balancing) 
To a large extent, the human eye is able to adjust to the predominant color temperatures of light. This is why the 
same white object under different lighting conditions is still perceived as “white”.
A video camera must be set to the current definition of “white” before recording and when the light color (color 
temperature) changes. If white-balancing was not done or was done incorrectly, it can still be corrected subse-
quently - within certain limits, that is.
What is actually being done is Gray-Balancing because true white (255,255,255) seldom occurs. Instead it’s a 
matter of taking an undesirable color cast in an area that is presumed “white” and changing it to “achromatic”, 
i.e. a specific level of gray.
In the RGB model, “gray” is always produced when the RGB values are the same - for example (25,25,25) or 
(111,111,111). In the YUV model, “gray” is when Cb, Cr = 0.
Consequently, Pinnacle Liquid Gray Balance requires that gray be contained in the image motif. If it isn’t, you 
might be better off using Tone Balance ( page 12-35).

1-point gray balance

� How gray balance works (example)  page 12-33

� Options  page 12-34

2-point gray balance  page 12-34

3-point gray balance  page 12-34
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1 - P o i n t  G r a y  B a l a n c e  ( E x a m p l e )  
The basic functioning of Gray Balance will quickly become clear with an example.
The first figure shows a spectrum clearly shifted toward red. The light bulb should actually be CCIR white 
(Y=235, Cb, Cr = 0). This would be the spot (if this were a camera image) on which you would white-balance.

Gray balance: The motif has a reddish cast.

In actuality, however, this spot has the coordinates Y = 234, Cb = -7, Cr = 7, in other words, an undesirable cast. 
In the Cube Display the narrow, finely curved line of green dots is especially obvious, indicating the cast. 

In order to correct this, you would click the 1-Point Gray Balance button (and also the Zoom) and look for a 
point in the image that is as achromatic as possible. In this case, it’s simple: Either the body of the light bulb or 
the black outline.
Clicking the achromatic point means moving this point precisely to the Y axis (CB, CR = 0). In other words, this 
point is defined as “gray”.

The next figure again shows the colors correctly while the narrow green line in the Cube Display is on the Y axis:

Gray is again gray and blue is again blue.

Clicking the blue background would produce a garish, yellowish-red cast. This and similar effects are 
easily understood when you look at the Vector Display and consider shifting the color locuses toward or 
away from the Y axis (achromatic).
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Options 
1-Point Gray Balance without additional modifications affects the RGB gamma values.

� Press the SHIFT key and click to adapt the RGB Gain values.
Press the CTRL key and click to adapt the RGB Black values.

2 - P o i n t  G r a y  B a l a n c e  
Drag a line between a light-gray point and a dark-gray point within the image to adapt the RGB Black values 
and RGB Gain values.
This option can be applied if a color cast caused by an incorrect white-balancing does not run linearly across 
the brightness areas.

3 - P o i n t  G r a y  B a l a n c e  
3-point Gray Balance affects Black, Gamma and Gain. When you click the button, three control squares con-
nected by a line appear in the image. 

The black square represents Black, the gray one Gamma, the white, Gain. 

1 Drag the control squares to spots in the image which correspond to their respective luminance ranges. 
The black square goes on the darkest spot, the white one to the brightest, the gray square somewhere in 
between.

2 Click the right mouse button to apply Gray Balance. 

3 If necessary, repeat steps 1 and 2 to optimize results.

The control squares check luminance values at the spots where you have moved them and change roles 
accordingly. For example: If you move the gray square representing Gamma to a spot which is even 
darker (in terms of luminance) than the current black square’s location, the squares adapt: The gray 
square changes to black, the black to gray.
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Tone Balance 

An image motif does not always contain gray for a subsequent white-balancing ( page 12-32). In this case, you 
can use Tone Balance to balance color on the basis of a reference hue.
Correction is possible in Black, Gamma and Gain; the default setting when you click the button is gamma.
Luminance remains the same, a fact that sets Tone Balance apart from Color Balance. 

1 You need a Reference Source ( page 12-28) containing similar, “correct” hues as far as the mood of the 
color is concerned. This is clearly a subjective assessment that requires a good eye and a little experi-
ence.
Call the Reference in the Diagnostic Display.

2 Click the Tone Balance button and drag a line from a point in the Reference Source to a similar point in 
the clip with the incorrect color balance (in other words, not from green to red - that certainly wouldn’t 
work).

� Press the SHIFT key and drag to adjust the RGB Gain values.
Press the CTRL key and drag to adjust the RGB Black values.

If this function is activated, the diagnostic display automatically changes to the current Reference 
Source. See also “Reference Source” on page 12-28.

Color Balance 

1-Point and 3-Point Color Balance match a Reference Source and the clip that you want to modify. In contrast to 
the otherwise similar Tone Balance function, luminance is affected by the Color Balance function.

1-point Color Balance  page 12-35

3-point Color Balance  page 12-36

1 - p o i n t  C o l o r  B a l a n c e  

1-Point Color Balance affects Black, Gamma and Gain simultaneously. 

1 You need a Reference Source ( page 12-28) containing similar, “correct” hues as far as the mood of the 
color is concerned. This is clearly a subjective assessment that requires a good eye and a little experi-
ence.
Call the Reference in the diagnostic display.

2 Click the Color Balance button and drag a line from a point in the Reference Source to a similar point in 
the clip with the incorrect color balance.

If this function is activated, the diagnostic display automatically changes to the current Reference 
Source. See also “Reference Source” on page 12-28.
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3 - p o i n t  C o l o r  B a l a n c e  
3-Point Color Balance lets you match the Black, Gamma and Gain ranges separately 

When you click the button, three control squares connected by a line appear in the Reference Source as well as in 
the image that you want to modify. 

The black square represents Black, the gray one Gamma, the white one Gain. 

1 In the Reference Source image, drag the control squares to spots in the image which correspond to their 
respective luminance ranges. The black square goes on the darkest spot, the white one to the brightest, 
the gray square somewhere in between.

2 Arrange the control squares in the image that has to be modified with respect to similarity in luminance 
and hue.

3 Click the right mouse button to apply Color Balance. 

4 If necessary, repeat steps 1, 2 and 3 to optimize results.

The control squares check luminance values at the spots where you have moved them and may adapt 
accordingly. For example: If you move the gray square representing Gamma to a spot which is even 
darker (in terms of luminance) than the current black square’s location, the squares adapt: The gray 
square changes to black, the black to gray,

HistoMatch 

The color balance of two images can also be matched on the basis of the associated histograms. This can be 
done either manually or automatically. You must have a reference source.
The two histograms should be somewhat similar from the start in order to achieve a satisfactory result. See also 
“Histogram” on page 12-24.

H i s t o M a t c h  ( A u t o m a t i c )  
1 Load the clip you want to correct in the Color Correction Editor.

2 Define a Reference Source ( page 12-28) and call it from the diagnostic display.

3 Define a working rectangle in both the Reference Source and the working image using the button pro-
vided.
Matching is performed on the basis of the working rectangles selected.
If you do not define separate rectangles, the entire image is used.

4 Click the HistoMatch button. The change instantly becomes visible in the inlay.
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H i s t o M a t c h  ( M a n u a l )  
When you perform a manual HistoMatch, you work with the Histogram diagnostic display ( page 12-24). 

1 Load the clip you want to correct in the Color Correction Editor.

2 Define a Reference Source ( page 12-28).

3 Select the Histogram diagnostic display. The histograms for the two clips are both visible and superim-
posed on one another (green for the correction clip and blue for the reference source).

4 Activate the Histogram Adjust function and drag the mouse over the display to match the histograms as 
much as possible:
- Drag the left end to adjust Black,
- drag the center to adjust Gamma,
- drag the right end to adjust Gain.
You can do this in all three of the components (R,G and B).
The changes are simultaneously visible in the correction clip.

HueMatch 

This function is used to match the correction clip as closely as possible to the Reference Source and affects satu-
ration and hue. 

1 Define a Reference Source ( page 12-28) and call it from the diagnostic display.

2 Define a working rectangle in both the Reference Source and the working image using the button pro-
vided.
Matching is performed on the basis of the working rectangles selected.
If you do not define separate rectangles, the entire image is used.

3 Click the HueMatch button. The change instantly becomes visible in the inlay.
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Six Vector Color Correction  

Six Vector Color Correction is already considered to be secondary correction because the hues R, Mg, B, Cy, G 
and Yl can be edited independently of one another. For example, you can easily use this function to “repaint” a 
red car blue.

Six Vector Color Correction appears in the Compact Display between the inlays and 
in the bottom half of the Color Correction Editor when it is opened all the way.
Six Vector Color Correction can be used separately or in combination with the other 
correction functions.

You can activate or deactivate the parameters by means of the square on the right in 
the Six Vector Color Correction title bar.

Selecting and Editing a Color Vector 

1 First select the Color Vector you want to edit by clicking the color or the associ-
ated radio button. 
The transitions between the six sectors are fluid; if you wish to define the hue 
exactly, you may have to switch to Selective Color Correction.

2 Edit the Color Vector:

� Either by means of the known parameters (Gain, Gamma, Black, Hue, Saturation; see “Parameters”  on 
page 12-29),

� Or by going directly to the Vector Display where you can drag the selected Color Vector to the desired 
location.
Saturation can also be set by means of the mouse. See also “Vector Display” on page 12-19.

3 If appropriate, select additional Vectors. You can edit all six Vectors. If you go back and edit a specific 
Vector again, the previous values of this Vector are overwritten.

Six Vector Color 
Correction
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Selective Color Correction  

Selective Color Correction permits a very precise definition of the hues you wish to edit. You can pick up to 15 
individual hues or color ranges. You can even edit the range for which no selection has been made (the “Gar-
bage”).

Selective Color Correction appears as a Compact Display between the inlays and in the bottom half of the Color 
Correction Editor when it is opened all the way.
Selective Color Correction can be used separately or in combination with the other correction functions.

You can activate or deactivate the parameters by means of the square on the right in the Selective Color Correc-
tion title bar.

Editing is generally performed in the following sequence:

Define vectors (A)  page 12-40

Color isolation (B)  page 12-41

Edit colors (C)  page 12-43

� ColorWash  page 12-43

� Non-selected area (garbage)  page 12-43

Operating variants  page 12-43

Selective Color Correction

A B

C
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Defining Vectors - Selective Color (A) 

Initially no Vectors are defined.

1 Load the clip you want to edit in the Color Correction Editor.

2 Click the Add Selective Color button in the Selective Color area to activate the Pipette (Eyedropper).

3 Determine the color area in the correction clip as precisely as possible by also using the Zoom 
( page 12-6).

� - Single-click to define a 3x3 pixel area around the Pipette position.

� - Drag the mouse pointer to define an area of a selected size (rectangular).

� - Hold down the CTRL key during either of the two procedures above to add other areas.

4 The selected color (i.e., the Vector) appears in the two color fields to the right of the color wheel. The 
lower field will later display the modified color.
In the color wheel itself, a small circle indicates the center of the color currently selected.

5 If necessary, repeat steps 2 and 3.
You can define up to 15 Vectors.

6 To toggle between selected Vectors, click either the arrow buttons above the color wheel or the small cir-
cles within the color wheel.

7 To delete selected Vectors, select them as described in step 6 and click the Trash icon.

You can also use the Pipette to determine the target color (target Vector). To do so, use a Reference Source 
( page 12-28).
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Color Isolation (B) 

In order to edit a color as precisely as possible, the color must be isolated from the spectrum of colors in the 
image. Otherwise you might have unwanted color corrections in similar areas. 
Pinnacle Liquid specifies each selected color Vector as a numeric “center” in YCbCr values:

 
This center is determined mathematically on the basis of various values using the Pipette.
A dynamic selection range exists around the center that is described by a luminance (L), saturation (S) and hue 
(H) range. The less uniform the colors selected with the Pipette, the greater the range:

 
1 Switch to the Vector Display. The Vector selected is indicated by a blue marking in the display:

Selection range (light blue) and transition range (dark blue)

� The hue (H) is represented by the size of the segment angle (the “width of the wedge of pie”).

� The saturation (S) is represented by the radial extension of the segment.

� The third dimension, luminance (L), is visible only in the Cube Display 
( page 12-21).

� The transition range (Softness, dark blue marking) defines the transition from the selected range (light 
blue) to the non-selected surroundings. The larger the transition range, the softer the transition.
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2 In the next few steps, you will try to optimize the selection.
For example, if you wish to isolate and then modify a specific red hue, the associated color locuses (the 
green points in the Vector Display) should be as completely covered by the selection range as possible in 
all three components (H, S, and L).

3 If several Vectors exist, select one (see above, step 6).

4 To fine-trim the selection, optimize the luminance (L), saturation (S) and hue (H). 
(Depending on the image motif, you will not necessarily have to optimize all three components and not 
necessarily in this order.)

� Luminance (L) -
Switch to the Cube Display and click the L icon. 
Working image: Only the ranges that meet the Y center plus/minus Y range criterion are displayed. The 
rest of the image is displayed as standard gray (Y=128).
Cube Display: The currently valid luminance range (along the Y axis) is displayed as blue.
Move the Range slider so that the standard gray disappears from the areas you want to edit or until the 
luminance range outlined in blue in the Vector Display includes the relevant color locuses.
Finally, click the L icon once again.

� Saturation (S)-
Switch to the Vector Display and click the S icon. 
Working image: Only the ranges that meet the Cb center, Cr center plus/minus Saturation range criterion 
are displayed. The rest of the image is displayed as standard gray (Y=128).
Vector Display: The currently valid saturation area is displayed as a rotating ring.
Move the Range slider so that the standard gray disappears from the areas you want to edit or until the 
blue saturation area includes the relevant color locuses.
Finally, click the S icon once again.

� Hue (H)-
Switch to the Vector Display and click the H icon.
Working image: Only the ranges that meet the Cb center, Cr center plus/minus Hue range criterion are 
displayed. The rest of the image is displayed as standard gray (Y=128).
Vector Display: The currently valid hue range is displayed as a segment of a circle.
Move the Range slider so that the standard gray disappears from the areas you want to edit or until the 
blue segment includes the relevant color locuses.
Finally, click the H icon once again.

5 If the Vector is sufficiently isolated, you can edit the color as desired.
If you want to define the selection ranges even more precisely (for example, by defining the upper and 
lower limits of the ranges), see “Color Isolation Using the Mouse”  on page 12-43.
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Editing Colors 

Once your selection(s) have been made and optimally configured, you can perform the desired corrections. 

To do this, use the standard tools (Black, Gamma, Gain, Hue, Saturation; see “Primary Color Correction”  on 
page 12-27) and drag the Cb and Cr sliders (ColorWash;  page 12-43).

The lower of the two rectangular color fields next to the color wheel displays the modified color and the top 
field shows the original color.

C o l o r Wa s h  
Shifting selections horizontally and/or vertically is known as ColorWash. To do this, use the Cr and Cb sliders. 
The effect is very noticeable in the Vector Display.

N o n - S e l e c t e d  R a n g e  ( G a r b a g e )  
“Garbage” refers to the range not selected in any Vector. This option allows you, for example, to isolate three col-
ors and, via “garbage”, de-saturate all the others or set them to black and white.

You can edit the non-selected range by not selecting a Vector (click next to the circles in the color wheel or click 
on the gray area around the color wheel). Naturally, the color isolation parameters are then irrelevant; other-
wise apply the correction as described.

Operating Variants 

C o l o r  I s o l a t i o n  U s i n g  t h e  M o u s e  

You can also isolate colors directly in the inlay or in the Vector Display using the mouse. First you must have 
selected at least one Vector (see “Defining Vectors - Selective Color (A)”  on page 12-40).

Then activate Color Isolation by clicking the button displayed and position the mouse pointer on the inlay or 
Vector Display. The display contains the selection range, which appears as a larger or smaller blue spot. You can 
change the shape, position and size of this range:

Drag the mouse pointer over the inlay or display while holding down the left, right or center (wheel) mouse 
button and the following keys:

� Luminance range -
Hold down the CTRL key and
left mouse button to move the lower limit;
right mouse button to move the upper limit; 
center mouse button (or mouse wheel) to move the center of the luminance range.
Suitable diagnostic display: Cube.
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� Saturation range -
Hold down the SHIFT key and
left mouse button to move the lower limit;
right mouse button to move the upper limit; 
center mouse button (or mouse wheel) to move the center of the saturation range along the radius.
Suitable diagnostic display: Vector.

� Hue range -
Hold down the ALT key and
left or right mouse button to enlarge/reduce the hue range (segment);
center mouse button (or mouse wheel) to rotate the color angle.
Suitable diagnostic display: Vector.

� Move the center -
You can move the center of the selected color along the Cr and Cb axes. The selection range in the Vector 
Display moves accordingly.

S e l e c t i n g  a  T a r g e t  Ve c t o r  
Using the Pipette, you can select a color from a Reference Source ( page 12-28). Note: This selects the target Vec-
tor, i.e. the color to be achieved as a result of the correction. The lower of the two color fields then changes to the 
color defined in the Reference Source.

Follow the procedure described in “Defining Vectors - Selective Color (A)”  on page 12-40. 

LiquidEdition Liquidchrome

RealTime ColorFX

The Rack RealTime ColorFX contains a selection of pre-made color clip effects such as Sepia Tint or an Invert 
Luma filter, which can be played back in real time. 

The Clip FX Rack contains a selection of pre-made color clip effects. 

Simply drag & drop effects to desired clips. All Realtime Color FX can be further edited using the Color Cor-
rection Editor.
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Linear Timewarp

Use Linear Timewarp to quickly and simply generate linear speed effects in video clips and animations, such as 
slow motion, fast motion, fit to fill, reverse playback, freezes, strobe effects, etc. Add Linear Timewarp is a func-
tion in a clip’s Timeline shortcut menu.
“Linear” means: the playback speed does not change during playback, i.e., remains constant.

Dynamic modifications of speed and direction using Key Frames are best achieved with the Timewarp Editor 
( page 12-50). However, for a quick fit to fill operation, for instance, the Linear Timewarp function is highly rec-
ommended - even though it could perfectly be done with the Timewarp Editor.

All Timewarp video effects will be rendered. 
Audio is affected as well, though the pitch stays the same (time stretching feature), and plays in realtime. 

Add Linear Timewarp  page 12-45

Parameters  page 12-46

Video and audio computation  page 12-47

Generating a freeze (still)  page 12-49

Add Linear Timewarp /Edit Linear Timewarp

Add Linear Timewarp can be found in the shortcut menu of any video or animation clip on the Timeline.

If a clip has already been edited with Linear Timewarp, open the shortcut menu by right-clicking the colored 
broken line at the bottom of the clip, and call the function (Linear Timewarp or dynamic Timewarp Editor).

TIP: Apply the Timewarp effect first, then all other effects. That is, the Timewarp clip needs to be com-
pletely rendered before you apply additional effects.
Plus, a Timewarp discards a clip’s alpha plane so that already applied key effects, for example, would be 
lost. 
If a Timewarp effect, be it dynamic or linear, is applied to a clip to which already one or more effects 
have been applied, the following happens:
The effect line at the clip’s top as well as the effect icon disappear from the clip. Instead the black and red 
Timewarp line appear at the bottom of the clip.
This behaviour is mandated by technical reasons. However, it does not mean that the previously applied 
effect(s) has (have) been cleared or deleted from the clip. They become visible once again when the 
Timewarp effect is taken from the clip. 
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Parameters (Overview)

Add Linear Timewarp

Clip Length

Displayed is the length (or duration) of the original clip just as it sits on the Timeline, prior to any Timewarp 
treatment.

Speed 

Here’s where you set playback speed and direction.

� Reverse
Check the box to select reverse playback. 

� Percentage or factor
Click the % checkbox if you prefer to enter values as a percentage of standard playback speed (which is 
100 %). Otherwise a factor will be used (1.0 = 100 %). 

� Speed
Enter a value, confirm with ENTER to exit the dialog, or hit TAB to confirm and jump to the next selec-
tion.
Examples:
100 % = factor 1.0 = realtime (standard) playback
50 % = factor 0.5 = half the realtime (slomo)
0 % = factor 0.0 = freeze image
- 100 % = factor -1.0 = realtime reverse playback
Maximum values: fastmotion factor 100 (10 000 %); slow motion factor 0.0000001 (0.00001 %).

Freeze: The resulting clip has a default duration of 5 seconds if Apply clip length is checked (see below), 
otherwise its original duration. The image frozen is the one at the clip’s mark-in point. 
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� Fit to Fill (dynamic speed)
When checked, a manually entered Speed becomes redundant. Use Fit to fill to close the gap between 
mark-out of the Timewarp clip and the mark-in of the next clip on the same Track. 
Subsequent trimming of the Timewarp clip causes the Speed value to be adapted according to the trim 
action.

Resulting Clip Length

Here you find the resulting length of the timewarped clip, assuming you have entered a Speed value or selected 
Fit to fill, 
or, other way round, 
you enter the desired duration in the TC field, which changes the value in the Speed field accordingly.

� Apply clip length
If checked, the clip will automatically be brought to its actual warped length. Caution: a lengthened clip 
will overwrite the following clip(s) on the same Track. 
If this option remains unchecked, you will have to trim the clip manually.

Video Computation

For play speeds below a factor of 1.0 (regardless of whether the value is positive or negative), you have four 
options for rendering the decelerated material. If the source material was recorded on:

� Video (60/50 fields/second with NTSC/PAL), use Cut Fields or Mix Fields. 

� Film (24/25 frames/second), use Mix Frames or Cut Frames.

For the best results, we recommend that you render short test clips using the different options. The following 
generally applies:

� Mix Fields (for video):
Motion is played back more smoothly but is not as sharply focused. In most cases, this is the best 
choice.

� Cut Fields (for video):
Provides a sharper focus but motion can be slightly jerky.

� Mix Frames (for film):
Provides smooth motion but is less focused.

� Cut Frames (film):
Provides sharp focus but motion is often jerky.
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Motion Detection

In the default configuration, this function is activated. For motifs with a lot of motion or very unsteady cam-
eras, it may be better to deactivate Motion Detection.

Strobe Effect

The Strobe effect is best used for motifs with a great deal of motion. Strobe plays a configurable number of iden-
tical frames in succession before repeating the same number of the next frame (omitting those in between). For 
example: Instead of the standard frame sequence 1-2-3-4-5-6-7 etc., 2-frame-Strobe plays back the sequence: 1-
1-3-3-5-5-7-7 etc.
Click the button to the left of the list box to enter the strobe number.

Trailing

The Trailing effect makes movements and changes of motif visible by means of “trails” in the frame. 
Click the button to the left of the list box to define a trail length, type and appearance.

Progressive

The Progressive option serves to convert interlaced material to non-interlaced material.

Audio Computation

Select Dialog or Music, based on the type of audio clip. The pitch is not modified (time stretching feature). 
Audio-only Timewarps are played back in realtime.

Maximum Speed values permitted for audio Timewarp are 50 % and 200%.

Negative speed values are not accepted for audio (i.e. no reverse play). In the case of combined A-V 
clips, the video is played backward while the audio is played at the desired speed but in the forward 
direction.
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Generating a Freeze (Still) 

When you apply a Linear Timewarp (or the Timewarp Editor) to a 1-frame clip, Pinnacle Liquid assumes that 
you want to freeze exactly this frame, i.e. that you want to turn it into a still. The procedure is as follows (based 
on the example of a clip frozen at the end):

1 Using the Add Edit button (see figure), trim the last frame from the clip. It helps to select a Timeline 
scale of the same size.

2 Open the shortcut menu for the 1-frame clip and select Add linear Timewarp. 

3 Enter the length desired for the still. Important: If Apply clip length is activated, the resulting clip over-
writes the next clip on the Timeline. In any case, you can trim the still clip on the Timeline to any length.

4 Click OK to exit Linear Timewarp.

A quicker way to achieve the same result is to use the Easy Freeze Frame function (Timeline clip shortcut 
menu); see  page 9-66.

Variation: Drag the Timewarp Editor to the clip, open the effect menu, select Edit linear TimeWarp and follow 
the procedure described above.
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Timewarp Editor 

The Timewarp Editor allows you to modify the play speed and direction of video clips.

You can control speed and direction changes dynamically with Key Frames.

The Timewarp Editor is a clip effect. Timewarp video effects are rendered, audio timewarps are realtime. Linear 
audio timewarp effects are possible, though no dynamic.
For basic information on video effects, see “Effect Editors (Basics)”  on page 10-10 and 
“Key Frames”  on page 10-20.

Even though we may sometimes refer to “slower” and “faster” playback in order to clarify a concept, the 
play speed of digital video is constant, depending on the system (NTSC: 30 or 29.97 frames/s, PAL: 25 
frames/s). The illusion of “slower” or “faster” playback is created when additional frames are interpo-
lated (computed) or frames are omitted.

Opening and Using the Timewarp Editor  page 12-51

Functions of the Timewarp Editor (Overview)  page 12-52

Interpreting Diagrams  page 12-55

Standard Applications  page 12-62

Individual Timewarp Effects  page 12-66

D y n a m i c  E f f e c t s  a n d  A u d i o

As with Linear Timewarp, the audio is also affected in the Timewarp Editor. The following applies:

� For a linear effect, audio is adapted accordingly (slower/faster at a constant pitch).

� For dynamic effects with multiple Key Frames, an average speed is determined and applied to the clip’s 
audio component.

� Audio cannot be played backward.

The maximum values permitted for audio Timewarp are 50% and 200%.
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Opening and Using the Timewarp Editor

The Timewarp Editor is used like a clip Effect Editor (for general information see “Classic 
Clip Effect Editors (Filters)”  on page 10-10). To open the Timewarp Editor:

� Drag the Editor Picon from the Library  tab of the Project window to the appro-
priate clip.
Open the Editor by right-clicking the continuous colored line on the bottom edge 
of the clip or from the clip’s FX Properties dialog box ( page 8-71).

� The Timewarp Editor initially takes the place of the Sequence Editor. Click the triangular arrow at the top 
between the timecode displays to open the bottom half of the editor.

If you use the Fit to Fill function, you do not have to open the Timewarp Editor 
( page 12-64).

TIP: apply the Timewarp effect first, then all other effects. That is, the Timewarp clip needs to be com-
pletely rendered before you apply additional effects.
Plus, a Timewarp discards a clip’s alpha plane so that already applied key effects, for example, would be 
lost.
If a Timewarp effect, be it dynamic or linear, is applied to a clip to which already one or more effects 
have been applied, the following happens:
The effect line at the clip’s top as well as the effect icon disappear from the clip. Instead the black and red 
Timewarp line appear at the bottom of the clip.
This behaviour is mandated by technical reasons. However, it does not mean that the previously applied 
effect(s) has (have) been cleared or deleted from the clip. They become visible once again when the 
Timewarp effect is taken from the clip.

Sometimes you will open the Timewarp Editor and discover that a Speed has already been selected (usu-
ally comprising an odd number with many decimal places). But this is only the case for clips whose clip-
in and clip-out are identical to the mark-in and mark-out. The Timewarp Editor requires one extra clip 
before the mark-in and one clip after the mark-out, i.e. in the section to which the Timewarp effect is 
being applied. If the clip-in/mark-in or clip-out/mark-out coincide in the original clip, the mark-in for 
starting the effect is automatically shifted one frame (and the same happens to the mark-out), thus 
changing the speed information.
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Functions of the Timewarp Editor (Overview)

The Timewarp Editor generates a (rendered) destination clip from a source clip.
In the simplest case, it is only a matter of reversing the play direction or decreasing/increasing the play speed. 
Using multiple Key Frames, you can combine the two parameters in one clip as often as you like.

Timewarp Editor (overview, default assignment)

A - Editing and control functions (source clip)

B - Rendering options (e.g. Strobe effect);  page 12-64

C - Indication of speed at Playline position (negative values mean reverse play)

D - Source/destination range: Displays playback behaviour of the resulting destination clip;  page 12-55

E - Speed diagram displaying changes in speed and play direction of the destination clip

F - Editing and control functions (destination clip)

G - Position bar (destination clip,  page 12-54)

H - Position bars (source clip)

I - Key Frame functions ( page 12-53)

A

B

D

E

C

F

G

H

H

I
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Setting and Editing Key Frames

The Timewarp Editor contains the usual range of buttons for setting, deleting and copying Key Frames (for basic 
information, see “Key Frames”  on page 10-20).
However, it also allows you to do the following:

� Set a Key Frame -
Press the CTRL key and click the desired position in the grid. The mouse pointer changes to a hand with 
an extended index finger and a plus sign. This applies to the upper and lower diagrams. The curve 
changes accordingly.

� Move a Key Frame -
The mouse pointer with the extended finger appears next to the Key Frames and can be used to move 
Key Frames to new positions.

Key Frames in the Timewarp Editor are absolute, i.e. when the Timewarp clip is subsequently trimmed, 
the distribution of Key Frames over the length of the clip does not change, instead the currently applica-
ble parameters are extrapolated before the first and after the last Key Frame.

Linearize/Delinearize Segment

Firstly, this function serves to create direct transitions, such as a sudden shift from “forward” (speed of 1.0) to 
“reverse” (speed of -1.0).
Secondly, linearizing results in a steady progression of motion between two Key Frames, i.e. without accelera-
tion or delay. For more information, see the example under “Linear and Nonlinear (Curve)”  on page 12-60.

This function always is always applied to the left-hand Key Frame and the next Key Frame to the right: Select a 
Key Frame (color changes to orange), click the button (click while holding down the SHIFT key to delinearize). 
The Key Frames appear as vertical bars of differing heights, depending on their original position:

Linearized segment with Key Frames

The results of the function are visible in the upper diagram where the transition between two Key Fra-
mes is linearized or delinearized. Curves become straight lines, and vice versa.

 Speed A ---->

 Speed B ---->

Transition
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E d i t  K e y  F r a m e s  ( L i n e a r i z e )

You can extend/shorten Key Frames upward/downward to modify shifts in speed and/or direction.
When the mouse pointer is positioned near a Key Frame, it becomes an arrow. An arrow pointing to the left 
means that you are editing the segment to the left of the Key Frame and an arrow pointing to the right indicates 
the Key Frame to the right. Left-click and drag the upper or lower end of the Key Frame to the desired location.

Navigating Diagrams, Keeping Overview

Five functions that make handling and understanding of the diagrams easier:

M o v e  a  S e g m e n t

Depending on the scale currently set, a smaller or larger portion of the diagram area is outside the range of the 
display.
Hold down the SHIFT key (the mouse pointer changes to a hand) and drag the pointer across the diagram until 
the appropriate section is visible.

L o c a t e  S e l e c t e d  K e y  F r a m e

Click this button to move the Key Frame currently selected to the center of the diagram. This is helpful if you 
previously moved the segment and then lost track of it.

L a r g e  D i s p l a y

Single-click the triangle at the top between the timecode fields to open and close an enlarged view of the dia-
gram.

P o s i t i o n  B a r s

The position bars in the Timewarp Editor function the same way as all the other position bars (see “Navigation 
Using the Position Bar”  on page 8-53). The only difference is that the Playline in the lower diagram is used to 
select speed factors between +/- 100.
The horizontal position bar applies to both diagrams.

A d j u s t  S c a l e

Click this button to link the scales of the position bars for the source and destination clips.
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Interpretation of the Diagrams and Examples

The upper diagram maps the chronology of the source clip (vertical axis and position bar to the left) against the 
chronology of the destination clip (horizontal axis and position bar). In its initial state when you call a clip that 
has not yet been edited, the following applies:
Source clip chronology = destination clip chronology.
The straight red line in the display represents this state: The mark-in and mark-out points of the source and 
destination clips are identical with regard to timecodes. Each individual frame in the source clip is mapped on 
the corresponding destination clip. 

In order to understand all the Timewarp functions, it is important to know that “position” in the spatial sense 
(as applied to a video tape) has nothing to do with the position bars. These bars deal with time. 

The lower diagram indicates the speed (vertical) throughout the destination clip time axis (horizontal). In the 
initial state, the straight red line runs horizontally at a height of 1.0 (100 percent), i.e. in a constant positive play 
direction. 

Some examples:

Linear Slow Motion at Half the Standard Speed
For linear slow motion at 50%, the destination clip becomes twice as long as the source clip. The speed remains 
constant, which is why it is called “linear slow motion”.

Linear slow motion at 50% play speed (factor of 0.5)

A Key Frame is set at the first frame of the source clip that is assigned a speed parameter of 0.5. The resulting 
straight blue line ascends less steeply than the standard red line.

< Duration source clip >

< Duration of dest. clip (2 x source clip) >
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When Does a Timewarp Clip End?

By strict definition, the destination clip ends where the straight blue line exits the diagram grid.
This means that logically it can be played only to the point at which the last frame (interpolated from the source 
clip) was played back. Beyond this point, the last source clip frame is played back as a still and continues this 
way for as long as you wish.

However, basically, the destination clip ends whenever you want it to. You simply have to trim the clip at the 
appropriate position on the Timeline (also see “Standard Applications”  on page 12-62).

The vertical extension of the grid in the upper diagram indicates the actual length of the source clip Media File. 
You cannot set Key Frames outside this grid.
There is no limit to the horizontal extension to the right and left. In theory at least, the destination clip can be 
endless.

Dynamic Acceleration/Deceleration 

When multiple Key Frames are used, you can generate dynamic Timewarp effects.

Example:

Accelerate-Decelerate-Stop-Reverse-Accelerate-Decelerate

This Timewarp clip has three Key Frames linked by curves. The parameters of the first and last Key Frame are 
the same: A factor of 1.0 (100% play speed), i.e. standard playback.

The center Key Frame is defined in the speed diagram as -100% (-1.0), i.e. at this point, the destination clip 
should play at a normal speed but in reverse.

 Speed

-100%

100%
0%

So
ur

ce
 

cl
ip

 Faster

< Stop

 Reverse
< >

 Slower
< >

 Slower
< >

Stop >

 Faster
< > < >
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The figure shows the resulting phases:

� First the clip accelerates until it reaches about 160% of the initial speed.

� In the second phase, it decelerates to 0% (Stop).

� In the third phase, it runs backward, initially accelerating (to 
-100%) and then decelerating until it stops again.

� In the next phase, the clip plays in the forward direction and accelerates.

� In the final phase, it decelerates back to the standard speed.

Altogether the destination clip is no longer than the source clip. The accelerated and decelerated segments bal-
ance each other out.

W h y  A  C u r v e ?

Let’s say you wanted to slow down a clip from standard speed to zero, e.g., decelerate a movement to its com-
plete stop. Therefore, you set Speed = 1.0 at the first Keyframe (or mark-in) and at the end of the clip, at the sec-
ond Keyframe (or mark-out), to zero.

Now the speed line becomes an initially slightly ascending, and then descending curve that ultimately hits the 
zero position, from where it goes on again as a straight horizontal line. But somehow you had assumed that the 
line should have smoothly fallen from the outset. Strange logic? Not at all.

Faster, slower, then stop - same duration
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Imagine you wanted to cross a room from one wall to the opposite wall; the walls in this example representing 
mark-in and first, mark-out and last Keyframe. You set out and walk slower and slower until you stop right in 
front of the wall. If you constantly slow down, don‘t you need more time to cross the room, more than when 
you walk your constant normal speed? Yes, you do.

But you have not given the destination clip more time to complete the task, the walls stand where they‘ve stood 
before. That‘s why you make up for the extra time, and therefore the initial acceleration you see in the curve. 
This is to make sure that the effect finishes in the source clip’s time frame (source clip and destination clip have 
the same lenght = duration). 

Of course it is possible to achieve a more or less linear deceleration - but that takes time. More time means to 
move the mark-out (and the second Keyframe) to the right:

Near constant deceleration, but longer duration
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Playback Loop

It is also possible to form a “loop”, i.e. a clip that is played to the end, jumps back to the beginning and is 
replayed. This can be repeated any number of times:

In the segments where the speed remains constant at 1.0, the straight ascending lines in the upper diagram run 
parallel to the standard line. Each of the almost vertical descents designates the position at which the clip 
returns to the starting position (by means of an extremely fast “rewind”). At the return point, the Key Frames 
are spaced one frame apart; the transition has been linearized (see enlarged view in the figure and “Linear and 
Nonlinear (Curve)”  on page 12-60).

Linear, forward playback loop

Normal Playback

Return

...
Volume II Chapter Special FX 12 - 59



PINNACLE

Timewarp Editor
Linear and Nonlinear (Curve)

The transitions between the play directions (forward and reverse) and speeds can be configured in several dif-
ferent ways, as illustrated by the next example. The diagram below describes a clip that is played repeatedly 
from beginning to end and from end to beginning:

Clip played alternately forward and backward

The lower speed diagram recognizes only two states of constant speed: In this example, these are approx. +4 
and -4. The transitions have been linearized. This means that the play direction changes directly (the straight 
lines are bent) and that the defined speed is adopted immediately. There is no gradual transition. The change 
takes place “within” the Key Frame which, for this reason, is displayed extended at the corresponding height.

Fo
rw

ar
d

Backward

0.0

Start

End

Key Frame
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The figure below shows the same Key Frame distribution as the figure above except that the transitions have not 
been linearized:

Non-linearized variant of previous example

This destination clip demonstrates soft transitions between the forward and backward passages.

S o m e  B a s i c  R u l e s

Once you know a few basic rules, diagram interpretation becomes much easier:

� A curve/straight line ascending from left to right means:
In the upper diagram: Play direction = forward;
In the lower diagram: Acceleration

� A curve/straight line descending from left to right means:
In the upper diagram: Play direction = backward
In the lower diagram: Deceleration

� A straight horizontal line means:
In the upper diagram: Still playback
In the lower diagram: Constant speed

� A steep curve/straight line:
In the upper diagram: High speed
In the lower diagram: Rapid acceleration/deceleration

� A shallow curve/straight line:
In the upper diagram: Low speed
In the lower diagram: Gradual acceleration/deceleration
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d
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End
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Standard Applications

This section provides you with step-by-step instructions for frequently used applications such as slow motion 
and stills (Freeze). 
For the task of creating these standard applications we recommend you use the Add Linear Timewarp function 
( page 12-45). 

When you exit the Timewarp Editor, the rendering of effects begins. If the effect has changed the length of the 
source clip, you must manually trim the clip to the new length on the Timeline:. Otherwise the rendering stops 
only at the end of the original clip, that is, even more than necessary is rendered, if the destination clip comes 
out shorter.

� Use this method for exact trimming of a Timewarp clip:
After editing the effects, set a Marker at the last significant frame of your Timewarp destination clip, at 
its last Key Frame, for instance. When you then trim the clip on the Timeline, drag the clip until the Mar-
ker symbol appears in the upper right-hand corner. This tells you that you have found the correct mark-
out and the actual length.

Slow Motion/ Fast Motion (Linear)

The speed of a slow motion clip is somewhere between 1.0 (standard) and 0.0 (freeze). Values greater than 1 
serve to multiply the standard speed.

1 Set a mark-in and mark-out on the Timeline clip that you want to edit. 
Make sure you don’t set a mark-in and mark-out on the first or last frame of the clip (i.e. the clip-in and 
clip-out of the Media File).

2 Drag the Timewarp Editor to the clip and open the Editor as described ( page 12-51).

3 Position the Playline on the mark-in of the source and destination clips.

4 Enter the appropriate speed factor in the field with the blue flag.
See also “Render Options” on page 12-64.

5 Set a Key Frame. A straight blue line with the corresponding gradient appears in the diagram.

6 Exit the Timewarp Editor and trim the clip to the new length on the Timeline.
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Reverse Playback (Linear)

Clips played in reverse have speed factors with a minus sign: -1.0 means the source clip is played at the standard 
speed but from the mark-out to the mark-in. Reverse slow motion is also possible (e.g. “- 0.45”).

1 Set a mark-in and mark-out on the Timeline clip that you want to edit. 
Make sure you don’t set a mark-in and mark-out on the first or last frame of the clip (i.e. the clip-in and 
clip-out of the Media File).

2 Drag the Timewarp Editor to the clip and open the Editor as described ( page 12-51).

3 Position the Playline on the mark-in of the source and destination clips.

4 Enter the appropriate speed factor with a minus sign in the field with the blue flag.
See also “Render Options” on page 12-64.

Alternate variant: Set the mark-in after the mark-out on the source clip position bar. This also causes a 
reversal of the source clip.

5 Set a Key Frame. A straight blue line with the corresponding gradient appears in the diagram.

6 Exit the Timewarp Editor and trim the clip to the new length on the Timeline.

Freeze (Still)

Create a still (freeze) as follows:

1 Drag the Timewarp Editor to the clip and open the Editor as described ( page 12-51).

2 In the source clip, scrub to the frame you want to freeze.

3 Enter a speed factor of 0.0 in the field with the blue flag.
See also “Render Options” on page 12-64.

4 Set a Key Frame. A straight, horizontal blue line appears in the diagram.

5 Exit the Timewarp Editor and trim the clip to the new length on the Timeline.

You can also generate a Freeze (faster and more easily) using a Linear Timewarp ( page 12-49).
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Adjust to Length (Fit to Fill)

Instead of specifying a speed factor in the editor, you can define a length for the destination clip, e.g. if you want 
to fill a gap of a specific duration on the Timeline.

1 Drag the Timewarp Editor to the appropriate clip.

2 Trim the clip to the appropriate length. Shortening it means accelerating the clip and lengthening it 
means slow motion. Doubling the length = half speed (0.5).

3 If you wish to edit this clip further, open the Timewarp Editor.

Render Options

You can activate a number of options when rendering Timewarp effects. You will find these options in the list 
box above the source clip inlay.

R e n d e r  O p t i o n s  f o r  S l o w  M o t i o n

For play speeds below a factor of 1.0 (regardless of whether the value is positive or negative), you have four 
options for rendering the decelerated material. If the source material was recorded on:

� Video (60/50 fields/second with NTSC/PAL), use Cut Fields or Mix Fields. 

� Film (24/25 frames/second), use Mix Frames or Cut Frames.

For the best results, we recommend that you render short test clips using the different options. The following 
generally applies:

� Mix Fields (for video):
Motion is played back more smoothly but is not as sharply focused. In most cases, this is the best 
choice.

� Cut Fields (for video):
Provides a sharper focus but motion can be slightly jerky.

� Mix Frames (for film):
Provides smooth motion but is less focused.

� Cut Frames (film):
Provides sharp focus but motion is often jerky.
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M o t i o n  D e t e c t i o n

In the default configuration, this function is activated. For motifs with a lot of motion or very unsteady cam-
eras, it may be better to deactivate Motion Detection.

S t r o b e  E f f e c t

The Strobe effect is best used for motifs with a great deal of motion. Strobe plays a configurable number of iden-
tical frames in succession before repeating the same number of the next frame (omitting those in between). For 
example: Instead of the standard frame sequence 1-2-3-4-5-6-7 etc., 2-frame-Strobe plays back the sequence: 1-
1-3-3-5-5-7-7 etc.
Click the button to the left of the list box to enter the strobe number.

T r a i l i n g

The Trailing effect makes movements and changes of motif visible by means of “trails” in the frame. 
Click the button to the left of the list box to define a trail length, type and appearance.

P r o g r e s s i v e

The Progressive option serves to convert interlaced material to non-interlaced material.
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Individual Applications

You can create complex Timewarp Effects quickly and easily using the tools of the Timewarp Editor. 
The basic principle is presented here step by step. 
For your first attempt, select a clip with a lot of motion in the motif (or in the camera work) and load it in the 
Timewarp Editor.
Initially the source and destination clips are identical.

1 Set the Playlines in the source and destination clip position bars to the mark-in if they’re not already 
there.
(At this point you can immediately set your first Key Frame, for instance if the clip should play at a spe-
cific speed from the very beginning).

2 Scrub the destination clip position bar at the position where you are defining the first modification.

3 Which frame from the source clip do you wish to see in this position in the destination clip? Scrub the 
source clip position bar at the desired position.

4 Set a Key Frame.

5 If necessary, enter a speed factor. You can also select a render option, such as a Strobe effect.
Click Set Key Frame once again to apply the values to the Key Frame.

6 Repeat steps 2 to 5 until you have defined the sequence of motion for the destination clip. If necessary, 
linearize individual or all segments.
Scrubbing the destination clip will provide you with a preview.

7 To fine-tune your work, enlarge the diagrams to a comfortable size (or switch to large display,
 page 12-54) and drag the Key Frames with the mouse

8 Exit the Timewarp Editor, render the effects and trim the clip to the actual length on the Timeline.

After editing the effects, set a Marker at the last significant frame of your Timewarp destination clip, at 
the last Key Frame, for instance. When you then trim the clip on the Timeline, drag the clip until the 
marker symbol appears in the upper right-hand corner. This tells you that you have found the correct 
mark-out and the actual length. 
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Audio Postproduction and Audio Effects

This chapter describes the audio functions of Pinnacle Liquid 

Basics

Facts you should know about audio editing in Pinnacle Liquid  page 13-3

Audio Tool

Control output levels  page 13-14

Liquidblue

Audio Editor

� Multichannel mixer  page 13-19

� Rubberbanding, adjust level, pan and balance directly on the Timeline  page 13-27

� Output mapping: Assigning signals  page 13-32

� Audio Routing (Classic) to assign audio signals to specific outputs  page 13-38

� Insert effects and send effects  page 13-42

� Surround 5.1  page 13-47

Special functions

Fast insertion of fades; live mix; voice-over and more  page 13-56

Audio Effects 

� Standard audio effects and basics  page 13-70

� Plugin audio effects (VST interface)  page 13-76

Audio Monitor

Liquid blue : Listen to audio separately  page 13-16
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Basics

This section provides a basic description of audio editing in Pinnacle Liquid:

ASIO driver standard  page 13-4

Special characteristics of audio clips  page 13-5

Inserting audio clips on the Timeline  page 13-7

Assigning Tracks  page 13-8

Stereo and mono, panorama and balance  page 13-8

Muting Timeline Tracks  page 13-11

Audio scrubbing and monitoring  page 13-11

Working with more than 16 audio Source Tracks (real-time playback)  page 13-13
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ASIO Driver Standard 

As of Version 6.x, Pinnacle Liquid uses the professional ASIO (Audio Stream In/Out) driver standard to inte-
grate computer audio hardware, such as sound cards.
This does not necessarily mean that you now need an ASIO-compatible sound card, since Pinnacle Liquid pro-
vides the ASIO Direct X Full Duplex Driver - a two-channel (stereo) converter - as standard. However, you must 
have a suitable ASIO driver to use multichannel sound cards (for example, to produce 5.1 surround sound).

The current ASIO driver and current audio hardware are specified in the Audio Editor’s Output Mapping 
( page 13-32).

M u l t i p l e  S o u n d  C a r d s

Although you may have several sound cards installed in your system, you cannot operate them simultaneously 
with Pinnacle Liquid. It makes no difference whether these devices are installed internally (PCI) or externally 
(USB).

1 Select Edit > Control Panel > Site > System > Inputs / Outputs > Audio Outputs. From the submenu dis-
played, select ASIO.

2 The default setting for Selected Device is ASIO Direct X Full Duplex Driver. If you want to know which 
sound card or audio hardware is currently using the driver, double-click Edit on the line below it to 
open the following dialog box:

ASIO Direct X Full Duplex Control Panel

Audio devices cur-
rently in the system

OUTPUT

Audio devices cur-
rently in the system

INPUT
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3 In this example, there are two audio devices: The sound chip integrated on the mainboard (Intel) and 
an external USB audio box.
Activate the checkbox next to a device to select it for input or output. 
(This dialog box is available in English and German only.)

The ASIO/Direct X driver is limited to two channels. This means that even if the connected hardware 
has more than two physical outputs, only two can be addressed.

M u l t i p l e  A S I O  D r i v e r s

If several ASIO drivers are installed in the system, one of these must be selected to operate with Pinnacle Liquid.

1 Select Edit > Control Panel > Site > System > Inputs / Outputs > Audio Outputs. From the submenu dis-
played, select ASIO.

2 Double-click Selected Device and select the driver compatible with the audio hardware to be used.

3 To enter specific settings for the ASIO driver selected, click Edit Selected Device on the line below it.

4 Refer to the documentation supplied by the manufacturer with the driver.

Special Characteristics of Audio Clips

As objects, audio clips are very similar to video clips (moveable, trimmable, etc.) but they do have a few special 
characteristics.
You can access these functions via the shortcut menu for the Audio Playback column, which is located at the 
beginning of the Timeline and is identified by the loudspeaker icon. See also “Audio Playback” on page 9-12.
The options in this shortcut menu are applied either to all Timeline Tracks (if you called the menu from the 
Audio Playback column header) or to individual Timeline Tracks (if you called the menu from the level of the 
respective Track). 

Audio clips with volume lines, pan lines, waveform indicator
and Key Frames

Pan line

Waveform Volume line Key Frame
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S h o w  Vo l u m e  

Activate this option to graphically display the level of an entire clip 
(appears as a blue line). This line shows audio fade-ins and fade-outs 
and, if the Audio Editor is open, can be moved to any position to edit 
audio (procedure referred to as “rubberbanding”).

Volume lines do not necessarily need to be displayed to adjust vol-
ume, but it makes mixing easier. You can either activate Pan Lines or 
Volume Lines, but not both.

Clips whose Playback Level ( page 6-28) was modified during 
logging/digitizing are displayed with the Volume Lines set to 
the 0 dB position. Nevertheless, audio is played at the modi-
fied level.
The waveform display reflects the Playback Level setting. For example, a very low volume clip shows a 
“flattened” waveform.

S h o w  P a n n i n g / B a l a n c e  

Clip-Specific Panning/Balance

Panorama (pan) lines (yellow) show the right and left orientation of the output signal of an audio clip: 

� Pan line at the top of the clip means left, 

� at the bottom, right. 

You can activate either Pan Lines or Volume Lines, but not both. 
See also “Clip Panning” on page 13-23.

Track-Specific Panning/Balance

You can also define the surround and left/right orientation for an entire Timeline Track. To display these pan 
lines, open the shortcut menu for the Audio Playback Column and select Show Track Output Panning.
(See also “Pan, Balance and Surround Panner (Track)” on page 13-25.)

LFE Panning relates to the LFE (subwoofer) channel of a surround mix ( page 13-47).

Column Audio-Playback
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Wa v e f o r m

Choose this option to graphically display a clip’s audio signal. This is useful, for example, when the editing work 
you are doing revolves around a certain audio event (such as a continuous drum beat), in which case you can 
use the wave peaks as reference points. 

It is only possible to display a waveform for individual audio Source Tracks. V-A-grouped clips cannot 
be displayed in waveform mode.

Stereo Waveform Indicator

In the case of stereo-audio clips, the two waveforms are displayed overlapping each other: 
A1/3 on top, A2/4 below.

D i s b a n d  C l i p  

An audio clip can contain up to four audio Source Tracks. Four individual clips 
can be generated from this type of grouped clip. Open the shortcut menu for the 
clip.

Use this function to distribute the Source Tracks of a grouped clip among the 
Timeline Tracks below the original clip (if free). If there is no free Track directly 
below, an additional Track (or more, if necessary) is automatically added. 

Stereo clips are separated into two mono clips. Please note that the vol-
ume level of the mono clip increases by approx. 6 dB; as a standard, the 
clips are panned centrically.

Inserting Audio Clips on the Timeline

Audio clips can be inserted on the Timeline in three different ways. Each of the 
methods is described in detail on the page indicated:

� Drag&drop - Inserts (grouped) clips on Timeline Track ( page 9-56).

� Send To... - Inserts clips at the Playline position in accordance with the Source 
Track Mapping ( page 9-22).

� Source Viewer and Insert Arrow - Inserts clips at the mark-in point or at the 
Playline position in accordance with the Source Track Mapping. See also 
“Source Track Mapping” on page 9-22.

Clip Shortcut Menu
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Assigning Tracks

Depending on the size of your Project, it can be very useful to carefully work out a clear audio editing concept, 
especially how you plan to distribute the different audio clips. In terms of mixing, consider which audio clips 
should be grouped and which ones you want to keep separate. 

You can name Timeline Tracks separately so that it is easy to recognize what type of audio is on what 
Track. For example, you could position all ambient recordings (mono) on a Timeline Track called 
“Ambient,” direct sound (mono) on “Direct” and soundtracks (stereo) on “Music”.  page 9-13

Stereo and Mono, Panorama and Balance

The conventional “audio world” (not including surround sound etc.) is two-dimensional: an imaginative 
acoustic space is created between “left” and “right” determined by actually existing audio outputs of a system. 
They should not be confused with the Audio Source Tracks. These are already digitized audio signals labeled A1, 
A2, A3 and A4 in Pinnacle Liquid.

D e n o m i n a t i o n s

With respect to common work steps, the following convention was determined as output standard:

� Audio output (channel) CH-1 (A1), CH-3 (A3) or Source Track A1, A3 = odd numbers = “left”

� Audio output (channel) CH-2 (A2), CH-4 (A4) or Source Track A2, A4 = even numbers= “right”

Other assignments are always possible with the aid of the appropriate Mapping or Panning.

S t e r e o  a n d  M o n o

A stereo signal in its original meaning reflects a spatial sound source. To create a spatial impression between 
“left” and “right”, two signals have to be used. For this reason, the term “stereo” refers to a pair of audio signals. 
A stereo signal understood in this sense consists of two signals that subjectively sound the same, but create an 
acoustic space centrically between “left” and “right”.

A mono signal is never accompanied by another signal and does not create a spatial acoustic impression. The 
final format decides at which audio output the signal applies, for example whether your customer wants to have 
room noise and live sounds on track1 or 2 of his master tape. If the mono signal is part of a stereo output, it can 
be assigned to a left or right output by means of panning.
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W h a t  B e l o n g s  W h e r e ?

� In Pinnacle Liquid, “stereo” usually means the following: even Source Tracks=right output, odd Source 
Track=left output.

� “Mono” usually means the following: the signal is output centrically between left and right. In the case 
of mono, it does not make any difference whether the Source Track number is even or odd. 

When working on the Timeline, Pinnacle Liquid initially proceeds on the assumption that a stereo signal (e.g. a 
piece of music digitized from a CD) keeps its left-right assignment and is to be assigned to the respective “left” 
and “right” output to create a spatial acoustic impression. In other words: what is played-in in stereo is also 
played-back in stereo without you having to make any settings. The same is true for mono signals. Mono is 
mono without modifying panning. Both channels create the same volume.

The primary left/right orientation of stereo clips and the central orientation of mono clips are default 
settings.They may, of course, be changed. 

S t e r e o / M o n o  I s  a  C l i p  P r o p e r t y

In Pinnacle Liquid, an audio clip can be either “stereo” or “mono”. This feature is assigned to it and can also be 
changed. There are three possibilities of changing this feature:

� preferably during digitizing or logging ( page 6-3)

� or in the Audio Mode function in the clip Properties dialog box (“Tab: General”  on page 8-68)

� or on the Timeline by means of Adjust Audio (“Global Modification of Volume and Panning (Adjust 
Audio Function)”  on page 13-59).

The stereo or mono setting can also be seen from the Detail (List) View in the Rack in the Tracks column and is 
characterized by an attached -S or -M (e.g. “VA1A2-S”).

In the case of imported audio files, Pinnacle Liquid automatically recognizes stereo or mono files and 
labels them accordingly.
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S t e r e o  o r  M o n o  o r  P s e u d o - S t e r e o ?

If you ask yourself which kind of clips to work with, stereo or mono, make a decision on the basis of your end 
product:

� Stereo-Master: if all sources are stereo (in the above-mentioned meaning), work with stereo audio clips 
down the line without having to deal with the left/right assignment.

� Mono-Master: identical signals are applied at two or more audio Tracks of a master tape.

� Stereo-Mono: ambient sound and live sound are mono clips, the underlying music of CD stereo. This 
keeps a spatial music effect, the sounds are correctly located in the middle. In addition, panning of 
mono clips can cause a spatial effect.

� Multitrack/Direct Out: Digitize the audio clips as “stereo” even if the signals are completely different to 
create a “clean” separation of Tracks. You may, however, also digitize individual monochannel Tracks as 
left or right stereo clips. Direct Out means that the signals are passed on unaltered through the system.

P a n o r a m a  a n d  B a l a n c e

Panorama (Pan) and Balance are two possibilities to influence signal orientation within the left/right spectrum:

� The balance is controlled in stereo clips just like in your stereo system: one signal amplitude is lowered, 
the other one remains unchanged. The left/right signal distribution is upheld.

� The panorama is controlled for mono clips: the signal of a channel “migrates” e.g. from left to right. The 
signal amplitude is not changed, only its left/right distribution.
This procedure is called “panning”.

Clip Viewer and Source Viewer output mono clips centrically, stereo clips left/right. If you wish to moni-
tor certain Source Tracks, use the function Audio Mode in the clip Properties. You may, however, also call 
the Select Audio Output function.

P a n o r a m a / B a l a n c e  a n d  A u d i o  R o u t i n g

"Right", "Center" and "Left" are the result of the clip properties "Stereo" and "Mono". Keep this in mind when 
working with the Audio Editor. 
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Muting Timeline Tracks (Audio Playback)

Select this function from the Audio Playback column shortcut menu to 
switch the playback of one or all Timeline Tracks off or on. It is the same as 
activating or deactivating playback directly in the Audio Playback column of a 
Timeline Track (by clicking the Loudspeaker icon). 

Audio Scrubbing - Digital or Analog

“Audio Scrubbing” in non-linear editing systems corresponds to what you can do with any professional tape 
recorder: playback or rewind the tape slowly or quickly to find a certain audio location. In Pinnacle Liquid you 
move the Playline via the clips to be played back (in the Timeline) or you move the mouse pointer of the Video 
Inlay of the Clip Viewer, Source Viewer or Master Viewer. 

Press the SCROLL key on your keyboard once to activate analog audio scrubbing. Next to the Audio Tool icon in 
the taskbar an A or D indicates the scrubbing mode. Press SCROLL again to deactivate this mode. 

Pinnacle Liquid offers you two types of audio scrubbing that depend on the audio material and your personal 
preference: 

� Analog Scrubbing -
Analog scrubbing sounds similar to what you do on a tape recorder.

� Digital Scrubbing -
In the case of digital scrubbing, individual frames are played back in a loop.
Go to Audio Settings to change the digital scrub parameters ( page 13-67).

To toggle between scrubbing modes use the shortcut menu of the Audio Tool icon on the taskbar (right-click). 
Select your preference, and don’t forget to choose the Tracks you need to monitor (see the following section).

Toggle analog/digital scrubbing; “D” indicates enabled digital scrubbing

Audio Playback on/off

Shortcut menu for the Audio 
Playback column
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The three steps of successful scrubbing:

1 Enable scrubbing (hit SCROLLLOCK key)

2 Select scrub type (analog or digital, shortcut menu of taskbar Audio Tool icon)

3 Select Timeline Tracks for scrub (two max, SHIFT-click Loudspeaker icon in column)

� To scrub frame by frame use the ARROW RIGHT/LEFT keys. Press the ARROW keys and the 
SHIFT key simultaneously to move the Playline by 10 frames each.

If Liquid Control  is connected: Activate/deactivate Scrubbing mode with the SCROLL key and move 
the jog button or the shuttle ring as usual. This works in all modules.

S e l e c t i n g  A u d i o  T r a c k s  f o r  S c r u b b i n g  ( T i m e l i n e )

Loudspeaker as contour: The Track “V/O” is activated for Audio Scrubbing.

A maximum of two audio Tracks (Source Tracks) can be scrubbed at the same time. To select your Tracks, click 
the speaker icon in the Audio Playback column of the respective Track while keeping the SHIFT key depressed. 
The icon appears as a contour. A Track for which playback is generally deactivated (no speaker icon) cannot be 
played back via scrubbing.

See also “Audio Monitor” on page 13-16.

S e l e c t i n g  A u d i o  T r a c k s  f o r  S c r u b b i n g  a n d  M o n i t o r i n g  
( C l i p / S o u r c e  V i e w e r )

If you are working with clips including three or four Source Tracks (A1 to A4), you have to select the Source 
Track(s) you wish to listen to when scrubbing. Please note: This has no effect on the Audio Editor’s Output Map-
ping.
To do so, drag the function Select Audio Tracks from the toolbox of the Clip or Source Viewer to the tool bar. 
Select a Track combination from the shortcut menu. The selected Source Tracks will be routed to the available 
physical audio outputs.

The following option is also available:

Drag buttons A1 to A4 from the function library (right-click > Customize > Special) and drop them on the 
Source Viewer Toolbar. These buttons let you select the Source Tracks of the clip currently loaded that you want 
to monitor.
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Working with more than 16 Audio Source Tracks 
(Real-Time Playback)

Pinnacle Liquid can simultaneously play back a maximum of 16 Audio Source Tracks (48kHz, 16-bit). Because 
this is guaranteed by the system CPU, compute-intensive audio effects can reduce the level of performance.

If the number of maximum live Source Tracks is exceeded, Pinnacle Liquid automatically begins background 
rendering (this is indicated by the pulsating � symbol in the Pinnacle Liquid taskbar). During rendering, 
“excess” Tracks are merged to create one Media File. Audio effects may trigger rendering.
The results of this processing are not visible on the Timeline. Pinnacle Liquid creates a temporary file exclu-
sively used for playback. Click the � symbol in the taskbar to open the Render View window to find out how 
long rendering will take and/or to halt rendering.
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Audio Tool

The Audio Tool influences and monitors the audio output signals. In the signal path sequence, it follows the log-
ical output busses, which makes it the ultimate audio levels control before the physical outputs.

This section covers the following topics:

Opening the Audio Tool/Functions

The Audio Tool is used for controlling output levels. To open the Audio Tool window, click its icon in the taskbar. 
You can also access the module via Tools > Audio Tool. 

Output Level Meter

� The Audio Tool displays the level of the outgoing audio signals in the form of 
up to four vertical bars that change from yellow to red when the level 
exceeds -9 dB (default), thus indicating that the level is nearing the overload 
threshold.
Liquid blue  and Liquid Edition : The overload threshold can be set 
in steps of 1 dB (-9 to -20 dB) (Edit > Control Panel > Site > System Settings 
> General > General > Audio Reference Level).

� Use the arrow icon to display or hide the controller section. To lock a pair of 
Faders so that they move in unison when you drag them up or down, click 
their Lock buttons. 
Double-click the Fader or the scale to reset it to 0 dB.

� If you use a mouse with a mouse wheel, simply turn the wheel to move 
the Fader in increments of 0.3 dB.

� The bar indicators continue to show signal peaks for a few moments after 
the level has dropped. A given maximum value continues to be displayed in 
the max dB field until the level is exceeded, or until you delete it by clicking 
the icon (small round button) button. 

Reset max dB
max dB

Fader

Lock Faders

Clipping LEDs

Audio Tool
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Clipping

The red “LED” indicator above each of the scales shows whether the overload threshold has been exceeded, in 
which case the system clips the signal. Also, in the max dB Field, the value 0.0 is displayed in red and a red cross 
appears and stays to indicate that the system has clipped the signal. Reset using the Reset button.

A second, yellow LED indicator flashes at the output if the signal was already clipped with one of the audio 
effects. In this case, we advise you to slightly attenuate the signal in the respective audio Effect Editor. (See also 
“Audio Effects” on page 13-69.)

Auxiliary Level in the Taskbar

An auxiliary level is located next to the Audio Tool icon in the taskbar. The two topmost segments in the four 
part scale change to red if the outgoing level reaches overload.

Digital Scale and Digital Audio

Digital audio requires different level indicators than analog audio. Pinnacle Liquid works with a digital scale, 
designed for a range between 0 dB and minus infinite dB. When working with analog peak level meters, which 
are usually designed for a range between +5 dB and -40 dB, you often end up pushing the 0 dB limit. This is not 
permitted with digital audio; the -9 dB limit should not be exceeded. 

H e a d r o o m

With digital audio, overload reserve is called “headroom”. Headroom is not standardized; a headroom of 9 to 
12 dB is generally used. The “red” range of Pinnacle Liquid’s peak level meters begins by default at -9 dB. 

Digital audio exhibits less tolerance to overloading than analog audio. If you exceed a certain level, 
noticeable distortions can be heard or signal information is lost due to clipping. This is particularly 
important to keep in mind when converting audio signals, for example, from analog to digital or 
between different digital formats. 

P e a k  L e v e l  M e t e r  R e s p o n s e  T i m e

Pinnacle Liquid’s peak-monitoring devices are designed with extremely fast response times and register signal 
peaks even in the 1 millisecond range. Make sure you do not overload even these brief peaks, otherwise you 
may end up with distortions or loss of audio information due to clipping. 
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LiquidEdition Liquidchrome

Audio Monitor 

To open the Audio Monitor, click the Loudspeaker icon in the taskbar. You can then adjust the sig-
nal applied to the Audio Monitor.

� Select the outputs (Source Tracks) for left and right speakers from the drop-down menus.

� Use the Fader to adjust the volume.

� Activate Mute to mute the monitor.

The Audio Monitor Fader monitors the signals of the analog monitor output and has no 
effect on master audio output at the Liquid blue.Box .
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Audio Editor

In the Audio Editor, the audio signals are mixed and distributed to the available outputs of the system hardware.

The Audio Editor must always be open during audio editing on the Timeline. 

This section covers the following topics:

Opening the Audio Editor  page 13-18

The Audio Mixer  page 13-19

� Rubberbanding  page 13-27

� Key frame toolbar  page 13-29

Output mapping: Assigning signals  page 13-32

Audio routing A1 to A4 (Classic)  page 13-38

Audio Editor settings  page 13-42

Working with insert effects and the send bus  page 13-42

Surround sound 5.1  page 13-47

Pinnacle Liquid uses Key Frames for audio editing.
When the Audio Editor is open, audio clips can be completely edited, i.e. trimmed, moved and deleted.
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Opening the Audio Editor

To open the Audio Editor click its button in the Master Viewer’s toolbar (or press F4 in the standard keyboard 
assignment). In the standard view, the Audio Editor replaces the Source Viewer above the Timeline. 

You can launch the editor from the user interface as a moveable window and then position it anywhere on the 
desktop.

Audio Editor with mixer in the foreground, 
shown here with five fader units, one logical output bus (Stereo) and one send bus
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The Audio Mixer

As a virtual mixing console, the Mixer is the core of the Audio Editor. You can use it to operate any number of 
fader units, each of which is responsible for one Timeline Track. You can also use it as an eight- or twelve-chan-
nel mixer, as appropriate: In this case, each fader unit and its associated Timeline Track represents one “audio 
channel”.
Plugin audio effects (up to 16 per fader unit) are integrated here. The Mixer lets you precisely define volume 
and panning/balance for entire Tracks or individual clips. Send Busses (in the figure above, Send FX1) for con-
trolling seperate audio effects are located to the right of the standard fader units, which are highlighted in the 
software with different colors.

Each standard fader unit has the following functions described below.

In the default configuration (e.g. following initial installation of the software), only the most important 
fader sections are visible. You can activate all the other sections described below on the Settings tab of 
the Audio Editor.

Standard fader functions  page 13-21

Send bus faders  page 13-27

Special faders for effect editing

Faders for logical output busses  page 13-27

As of Version 6.0, the Audio Editor is no longer subject to clip limitations. Previously, for example, you 
could raise or lower the volume of clips, but not of entire Timeline Tracks. An individual setting is now 
available for this purpose.

O v e r v i e w  o f  t h e  S i g n a l  P a t h

The figure below presents an example of the audio signal path of a Timeline stereo audio clip through the Audio 
Editor to the output. One Send Bus is displayed in addition to the Fader Unit. The peak meters in the Audio 
Mixer follow their respective faders in the signal path.
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The path of the audio signal through the Audio Editor

Insert FX

Send FX
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TL

Stereo Audio Clip

Stereo Audio Clip

Clip Fader

Input Level

Output Level
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Insert FX

Output Level
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Bus Fader Bus Fader

OUTPUT BUS
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OUTPUT BUS
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S e l e c t i n g  T i m e l i n e  T r a c k s  a n d  F a d e r  U n i t s

When you open the Audio Editor, the number of fader units visible in the Mixer is always the same as the num-
ber activated for Audio Playback on the Timeline Tracks. In the default configuration, five fader units are dis-
played (Name 5 to Name 1). The fader units have the same names as their associated active Tracks.

You can add (or remove) any number of fader units by single-clicking the appropriate Audio Playback column. 
The Track’s loudspeaker icon must be visible for the fader to appear in the Mixer (see figure above).

Each Track can be assigned only once. Note that one Timeline Track can contain up to four Audio Source Tracks 
(A1 to A4) that are mixed down together.
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S t a n d a r d  F a d e r  F u n c t i o n s

This section describes the most important functions of the Fader Units. You can show or hide the individual 
function groups by clicking the Plus and Minus signs in the left-hand column. 
If you don’t see all the sections displayed below in your software, activate all the options on the Audio Editor’s 
Settings tab.
The signal path traverses the fader unit from bottom to top; therefore, we’ll start with the Track Type.

� Wherever you see an editing field, you can also enter a value directly via the keyboard; then 
press TAB or ENTER to confirm your entry.

� Right-click the plus/minus field to the left of the relevant section to toggle between knobs and 
sliders.
Note, however, that peak meters are visible only when a slider is selected.

One fader unit

 

Name and assigned timeline track

Clip level

Mute and solo function

Fader lock

Pan/balance slider (track)

Activate Mix Automation

Routing to a logical output bus (bus type)

Output level (track)

Effect insert and send bus insert

Input level (track)

Au
di

o 
si

gn
al

 p
at

h

Clip panning

Track type
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Track Type 

Click this field to select the track type appropriate for the audio clips on the associated Timeline Track. Pinnacle 
Liquid recognizes three types of audio clip:

� Mono -
One audio channel (Source Track) per clip

� Stereo -
Two audio channels (stereo) per clip
(default).

� Classic -
Up to four mono audio channels or 2x2 stereo channels per clip

The figure shows you how this affects the fader peak meters.

(Also see “Bus Types and Track Types”  on page 13-34.)

Clip Panning 

This section is visible only if you activated Classic Routing (Settings tab) and permits panning for individual 
clips.

You should also enable the Pan/Balance Lines. Open the shortcut menu for the Audio Playback column (the one 
with the loudspeaker icon) and select the appropriate option. The yellow lines (rubberbands) are then visible in 
the clip and can be adjusted by means of faders or the mouse (also see “Show Panning/Balance”  on page 13-6).

Also see track-specific panning further up in the signal path.
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Clip Faders (for the Current Clip)

These faders let you control the volume level of the current clip right where the Playline is currently located. An 
Audio Key Frame is set that moves when the fader is moved.

In the main operating range of +12 dB to -20 dB, the control range is linear and has a wide-spaced scale; below 
-20 dB it has a narrow-spaced scale. Double-click the Fader or the scale to reset to the 0 dB position.

� The UP ARROW/DOWN ARROW keys change the level in increments of 0.3 dB.

� If you use a wheel mouse, turn the wheel to change the level in increments of 0,3 dB.

Levels are relative. Projects often contain audio clips of different volume levels. Pinnacle Liquid assumes 
that every audio clip on the Timeline is at “0 dB” when placed there. This value is the default setting of 
the Volume Line and Fader (see also Show Volume on page 13-6). Every volume change you make is rel-
ative to this 0 dB. 
Clips whose Playback Level was modified during logging/digitizing or in the Clip Viewer are shown with 
the volume line set to the 0 dB position. Nevertheless, audio is played at the modified level.
The waveform display reflects the Playback Level setting. For example, a very low volume clip shows a 
“flattened” waveform.

Input Volume (Track) 

This fader affects the level at which the signal is fed to the Insert/Send Effect section and applies to all the audio 
clips on the assigned Track.

This setting is static for the entire Track (no Key Frames).
Right-click in the field with the plus/minus sign to the left of the fader to toggle between a knob and slider (with 
peak meter).

Insert Effects and Send Effects 

In this section, you can select effect plugins or send busses for send effects. Once again, the “bottom to top” rule 
applies (signal path), meaning that the bottom insert effect or send bus is edited first.
When you select (remove) a send effect here, the Fader Unit for the Send Bus is automatically inserted 
(removed).

For more information on this topic, see the section on “Working with Insert Effects, Send Effects and Busses”  on 
page 13-42.
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Output Volume (Track)

This section lets you raise or lower the volume equally for all the clips on the assigned Track.
Because this fader is located after the effect section, you can use it, for example, to re-attenuate effect-related 
increases in volume.

This setting is static for the entire Track (no Key Frames).

Routing to a Logical Output Bus (Bus Type)

In this section, you can select the Logical Output Bus or the “sum” to which the fader unit signal should be 
routed. Click the name of the bus to open a menu. These “logical” outputs are assigned to the actual, physical 
outputs on the Output Mapping tab.
Three busses are available: Stereo, Classic and Surround 5.1. It is possible to configure several busses of the same 
type (for example, Stereo (2), Stereo (3), etc.).
(See “Output Mapping: Assigning Signals” on page 13-32.)

Pan, Balance and Surround Panner (Track)

For stereo tracks, this section controls the Balance; for mono tracks, it controls Panning. This information 
always applies to left (-50) or right (50). 
In the case of a surround mix, this section serves to position the virtual sound source within the listening room. 
The slider then affects the LFE (Low Frequency Emitter), i.e. the subwoofer. The field with the moveable dot is 
called the Surround Panner (see  page 13-47).
This track-specific Surround Panning can be represented by two lines. Open the shortcut menu for the Audio 
Playback column (the one with the loudspeaker icon) and select the Show Track Output Panning option.
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Mute and Solo (Track)

� Mute -
Click this option if you want to mute this Track only. The loudspeaker icon no longer shows “sound-
waves”. The signal is not routed to the output bus.

� Solo -
Select this option if you’re playing the Sequence and want to activate audio playback for one specific 
Timeline Track only. Only this signal is forwarded to the output bus.

Additional Functions

Lock Function for Synchronizing Faders

To lock Faders so that they move in unison when you drag up or down, click their Lock buttons. A selection box 
including eight different color fields opens. You can now form subgroups of locked Faders: Faders having the 
same color (indicated by a padlock) move in unison. 

This applies to all faders, regardless of whether they use a slider or knob.

To unlock Faders, click the gray box in the selection box.

Activating/Deactivating Audio Mix Automation 

Audio Mix Automation permits the live mixing of one or several audio clips ( page 13-61).
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S e n d  B u s  F a d e r s

Send Busses are a special type of standard fader specifically used for effect editing.
In the software user interface, Send Bus Faders can be identified by their greenish color 
and their (non-editable) name (Send FX1, Send FX2, etc.).

Send Bus Faders are not assigned to Timeline Tracks but instead get their signals from 
one or more fader unit(s) or mixer channel(s).
The effect signal is then routed to an output bus and thus inserted in the master signal.
For a full description, see the section on “Working with Insert Effects, Send Effects and 
Busses”  on page 13-42.

F a d e r s  f o r  L o g i c a l  O u t p u t  B u s s e s

A fader is inserted for every Logical Output Bus you define. These faders serve to deter-
mine the level at which the audio signals are routed to the particular output bus. The 
bus fader’s peak meter indicates the number and level of the audio signals: Two for Ste-
reo, four for Classic and six for Surround. Output bus faders are red.

See also “Output Mapping: Assigning Signals” on page 13-32.

Rubberbanding

The term “rubberbanding” is used to describe the action of moving and adjusting Volume Lines, Pan Lines and 
setting Key Frames on volume and pan lines directly on the clip. 

You can do this using the mouse or the fader units. 

S e t t i n g  K e y  F r a m e s  

In Audio Timeline editing Key Frames refer to the small blue diamonds on the Volume/Pan Lines used for 
adjusting an audio clip’s volume level or the pan orientation. In order to “bend” an otherwise straight volume 
line, it is necessary to set Key Frames. 

1 Activate either Volume or Pan Lines for the relevant Timeline Track.  page 13-5.

2 Open the Audio Editor.  page 13-18

3 Position the Playline at a certain location in the clip and adjust the volume at this location in one of the 
following ways:

� Using the mixer - by moving the Fader of the appropriate fader. (If you locked Faders, you can adjust 
several clips on several Tracks at once).
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� Using the mouse - by going into Edit Mode (the mouse pointer turns into a hand with pointing index 
finger if placed near the Volume or Pan Line, a plus symbol appears next to it). Set the mouse pointer to 
the appropriate position on the volume line and click to insert a Key Frame on the line.
Once a Key Frame is set, drag the Key Frame horizontally or vertically to change its position. The corre-
sponding Fader moves as you move the Key Frame vertically and you can read the change on the dB 
scale.

Clips whose Playback Level was modified during logging/digitizing or in the Clip Viewer are shown with 
the volume line set to the 0 dB position. Nevertheless, audio is played at the modified level.
The waveform display reflects the Playback Level setting. For example, a very low volume clip shows a 
“flattened” waveform.

 

Position of fader corresponds to position of volume lines and key frames

Volume lines

Fader set to -36.4 dB

Key Frame at -36,4

Fader assigned to
Track A 1
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M o v i n g  K e y  F r a m e s

When moving the mouse pointer (make sure that you are in Edit Mode;  page 9-55) near the Volume or Pan Line, 
it turns into a hand with a pointing index finger. Click Key Frame and drag it to the required position.

A u d i o  K e y  F r a m e  T o o l t i p

When moving Key Frames, a small box appears next to the mouse pointer. It indicates:

� the horizontal displacement of the Key Frame position (in +/- mm:ss:ff)

� the quantitative change (in the case of volume lines +/- dB, in the case of pan +/- 50%, i.e. left/right).

You can move horizontally (only to the neighboring Key Frame) and vertically (within the maximum values).

M o v i n g  S e c t i o n s  b e t w e e n  T w o  K e y  F r a m e s

Using the Mouse

To move a section between two Key Frames, position the mouse pointer on the Volume Line between the two 
Key Frames and press the SHIFT key. The mouse pointer turns into a short horizontal line. Now you can move 
the area between the Key Frames. This is useful, for example, if you have faded audio in and out in a clip and 
want to adjust the entire segment between two Key Frames.

Using the Fader

This can be done in a similar way by using the respective Fader: set the Playline between the Key Frames that are 
to be increased by the same value, hold down the SHIFT key and move the Fader up and down. As soon as the 
Playline is located on a Key Frame, the line located to the right of it is edited. 

D e l e t i n g  K e y  F r a m e s

Key Frames can also be deleted in the clip by means of the mouse. Click the respective Key Frame and drag it out 
of the clip. The mouse pointer turns into a Trash icon. You can release the mouse button, the Key Frame is now 
deleted.

Key Frame Toolbar

Located below the Mixer is a toolbar with various buttons for controlling Key Frame functions. 

Key Frame toolbar 
Volume II Chapter Audio 13 - 29



PINNACLE

Audio Postproduction and Audio Effects
These buttons can be used for setting, copying and deleting Key Frames. The following information applies to 
working with both Volume and Pan Lines.

Each audio clip always has two Key Frames, one at the beginning and one at the end. 
A new Key Frame is set wherever the volume or pan is changed.

S e t t i n g  K e y  F r a m e s  

To set a Key Frame, position the Playline to the position where you want to insert a Key Frame and click the Set 
Key Frame button.

J u m p  f r o m  K e y  F r a m e  t o  K e y  F r a m e  

Click this button to move the Playline to the previous Key Frame.

Click this button to move the Playline to the next Key Frame.

D e l e t i n g  K e y  F r a m e s

Move the Playline to the Key Frame you want to delete and click the Delete Key Frame button.

D e l e t i n g  S e v e r a l  K e y  F r a m e s

The Delete Audio Key Frames button can be found in the toolbar of the Audio Editor. This button can be used 
for Key Frames on the volume line and on the pan line. Activate either Show Volume or Show Panorama and 
select a section on the Timeline by setting mark-in and mark-out. All Key Frames of the active Tracks in this sec-
tion (including those located directly on mark-in and mark-out) are deleted with this function. All Tracks that 
are neither active nor protected remain unaffected.

The line run is determined by the Key Frame located before or after the set section between mark-in and mark-
out. If there is no clip outside mark-in and mark-out, the lines correspond to the initial values. 

In order to delete all Audio Key Frames and reset the volume line to its original state, you can also select 
FX Properties in the clip’s shortcut menu. Click Audio Fader and the Trash button.

U n d o / R e d o  K e y  F r a m e

Set Key Frames in Volume and Pan Lines can be individually deleted via Undo Key Frame. This can be done on 
one or several audio clips at the same time. These audio clips have to be highlighted (selected). Redo Key Frame 
sets a Key Frame removed by Undo. 
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C o p y / P a s t e  K e y  F r a m e

Click this button to copy Key Frames with their audio or pan settings. 

Click this button to insert copied Key Frames elsewhere on the Volume or Pan Lines (or even to other clips).

Key Frames can only be copied to audio clips in the same Track.

C o p y  V a l u e  t o  N e x t / P r e v i o u s  K e y  F r a m e

Click this button to transfer settings to the next Key Frame.

Click this button to transfer settings to the previous Key Frame.

A u d i o  K e y  F r a m e s  o n  t h e  T i m e l i n e  T o o l b a r

You can also add the Audio Key Frames function and other Audio Editor functions to the Master Viewer/Time-
line toolbars but they will be active only while the Audio Editor is open.
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Output Mapping: Assigning Signals 

The signals from the individual Mixer channels and Send Busses are reunited in the output busses before being 
distributed to the physical hardware outputs. We call these output busses “logical” busses, as opposed to the 
actual physical busses to which you connect your speakers or VCR.

Why busses?  page 13-32

Bus types and track types  page 13-34

The system’s physical outputs  page 13-35

Fuse/export routing  page 13-36

Overview of output mapping  page 13-37

Output Mapping: Logical busses appear on the left, existing system outputs across the top 
(only partially visible) and the selected mapping at the points where the two intersect.

W h y  B u s s e s ?

The logical output busses and the actual connection options form a grid on the Output Mapping tab. Small dots 
serve to define and display the relationships between logical busses and physical outputs.

The audio signals intended for the different busses are combined in these busses according to their properties:

� A Stereo Bus receives all audio signals with the “left” property at its left channel and all “right” signals at 
its right channel.

� The Surround 5.1 Bus routes all signals it receives with the “left rear” property to its RearLeft channel, all 
signals labeled “left” to its Left channel, etc.

� The Classic Bus sorts all the Audio Source Tracks (A1 to A4) it receives. It is used with Classic Routing, 
which you must first activate on the Settings tab, if appropriate.
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These properties such as “Left” or “Center” were defined by means of panning (mono clips), balance (stereo 
clips) or surround panning. Each Fader Unit has a separate section for this setting:

Panning meters for the surround bus (left) and 
stereo/classic busses (right)

The pan and balance faders determine how the signal is distributed to the output bus channels. This is not an 
“either/or” situation: Using the pan fader you can, for example, apply 25 percent of a mono signal to the left 
channel of the stereo bus and apply the remaining 75 percent to the right channel. The peak meters then indi-
cate the distribution.
This is especially obvious when you route a signal to the surround bus. When the dot representing the signal 
location is positioned near the center point, various percentages are distributed to five bus channels 
(see page 13-50).

But even without any adjustment by means of these faders, each audio clip still retains the mono or stereo prop-
erty that was previously defined (for example, at the time of capture). A stereo audio clip retains its left-right 
distribution to create a spatial sound impression, whereas a mono clip (in the stereo bus) is equally routed to 
the left and right.

Within a bus, all signals of the same type (for example, all “left” signals) are combined in accordance with their 
percentages. In Mapping, dots are set that serve to route this mix (also sometimes called a “suml”) to an output, 
whether it be an audio connection on the box or an embedded audio signal as in the case of DV or SDI.
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B u s  T y p e s  a n d  T r a c k  T y p e s

In the default configuration, the logical output busses available are Classic (A1 - A4), Stereo and Surround. Each 
individual channel (fader unit) of the Audio Mixer must be assigned to one of these busses, unless you want it to 
retain the default setting (Stereo). Base your assignment on the audio clips currently located on the assigned 
Timeline Track (A1 - A4 grouped, stereo or mono clips). The figure below provides an overview of the Bus Types 
and the Track Types suitable for each:

Select the bus type suitable for the track type

As far as possible, position only audio clips of the same type on the same Timeline Track. For example, 
place all stereo music clips on a Track called “Music” and all mono, natural sound clips, etc., on a series 
of Tracks named “Nat 1, Nat 2, Nat 3”, etc. This will make the assignment in Output Mapping clearer and 
less ambiguous.

Stereo 

This bus is a two-channel output bus with a left-right distribution used for typical stereo mixes. It is generally 
used with stereo audio clips (default).
The peak meter for the stereo bus has two vertical bars representing the left and right channels.

Surround 5.1 

This bus is used for 5.1 surround sound and has six channels: Three for frontal sound, two for rear sound and 
one for the subwoofer (low frequencies).
Recommended Track Type: Mono (stereo audio is mixed to mono).
The peak meter has six vertical bars representing (from left to right) the left, right, center, LFE, left rear and 
right rear channels.

Bus type

Track type
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Classic (A1 - A4) 
Up to four Audio Source Tracks (channels) can be grouped in a single audio clip: Four mono channels or two 
sets of two stereo channels. The Classic output bus is intended for this type of audio clip. When used with mono 
Source Tracks, this setting is also suitable for the 1:1 output of a four-track recording.
Set the Track Type to Classic. The peak meter is displayed with room for four vertical bars.

The Classic bus is visible only if you activated the corresponding option in the Audio Editor Settings. 
The Clip Panning section is not visible until you activate classic routing.

In Classic Routing, make sure the lines are drawn from the subsums to the four logical outputs A1 to A4. Only 
then will you see four level bars in the clip fader and classic bus fader.

Multiple Busses of the Same Type
You can configure several busses of the same type as well as combine different busses and route them to the 
same outputs by means of mapping. This is a quick way, for example, to activate or deactivate alternative mixes.

Automatic Bus Display

Which output busses are available on this tab depends on the configuration of the Audio Mixer.

In the default configuration (with each new Sequence), only one Stereo output bus is available.
If you need more stereo busses or other busses, click the Settings tab, activate the Logical Output Bus option 
and, if necessary, activate Classic Routing (A1 to A4). In the Mixer section for Logical Output Busses 
( page 13-25), you can then configure new busses and route Tracks to existing busses.

T h e  S y s t e m ’ s  P h y s i c a l  O u t p u t s

The physical outputs available and activated in the computer system are displayed in Output Mapping to the 
right above the logical output busses. In physical terms, this means these outputs have actual connectors for 
plugging in cables.

� Sound card -
This is the primary device for monitoring the audio signal. If multiple sound cards are installed in your 
system, you must select one card or its ASIO driver (see the section on the “ASIO Driver Standard”  on 
page 13-4). Pinnacle Liquid does not allow you to operate multiple sound cards in parallel.

� Outputs on the connection box -
(Analog) Edition Pro, for example, might be listed here. All analog outputs (if more than one exists) are 
sent the same signal.

� DV (IEEE 1394) embedded output -
Only one DV recording device can be activated at any one time. If several such devices are connected to 
your system, you must select one as follows: Edit > Control Panel > Site > System > Inputs/Outputs > 
Video Outputs > 1394. 
The current Output Mapping applies to the device selected, regardless of the physical computer port to 
which the device is connected.
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F u s e / E x p o r t  R o u t i n g

Output Mapping plays a role in the Fuse process and in the export of Sequences.
The individual audio files created by the Fuse process can also be regarded as an “output”: The Fuse/Export out-
put of a logical output bus has up to eight channels, resulting in up to eight individual mono audio files when 
the dots are set in the mapping matrix.

Make sure the Create separate audio streams option is activated in the Fuse dialog box.

Multiple busses are possible (for example, Stereo, Stereo (2), Stereo (3), etc.), which also increases the number of 
possible Fuse outputs - for example, if you route stereo to Left and Right, Stereo (2) to FrontL and FrontR, etc.

This configuration results in four audio files for a fuse

Using the 5.1 Bus, you can generate up to five separate mono audio files, even if you do not intend to produce a 
surround mix or surround effects. However, you must provide the Tracks with a unique assignment so that the 
signals are not mixed in the bus. This means that Surround Panning does not change throughout output and 
that the Surround Panner is set to a different position for each Track (for example, the top left corner for the Left 
channel). Otherwise it is not possible to achieve a clear separation of channels.
The LFE (subwoofer) is not generally taken into account.

The one exception is when you export via the 5.1 encoder: This encoder mixes five surround channels 
in a special stereo signal. The surround effect will not work unless surround 5.1.mapping is correctly 
assigned. For more on this topic, see the section on “Output”  on page 13-55.

The resulting files are numbered from left to right: Left and Right are assigned the extensions [filename]_1.wav 
and [filename] 2.wav, up to RearR with [filename]_8.wav.
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O v e r v i e w  o f  O u t p u t  M a p p i n g
The table below summarizes the most important information on mapping and mono/stereo. This information 
does not apply to classic routing (for Classic Routing, see next section).

* Signals are routed individually to Effect Editors (Insert) and Send FX.
Mixing two or more mono channels can result in an increased level.

# Clip Property
Track 
Type
Mono

Track 
Type
Stereo

Logical Output Bus
Stereo

Logical Output Bus
Surround 5.1

1 Mono (A1 only) x

Panning to center.
Original signal level to
L/R outputs.
For mono output (one channel), use 
track panning

Mono signal to default sur-
round panning (center)

2 Same as above x
Conversion to stereo; identical signal 
to L/R outputs

Both signals to default sur-
round panning (center)

3
Mono (A1 - A4)
Separate effect edit-
ing*

x Same as #1
Mono signal to default sur-
round panning (center)

4 Same as above x Same as #2
Both signals to default sur-
round panning (center)

5 Stereo (A1 only) x Same as #1; signal to L/R outputs
Mono signal to default sur-
round panning (center)

6 Same as above x
Output to L (left) only
Balance adjustment

Both signals to default sur-
round panning (center)

7 Stereo (A1/2) x L/R output Same as above

8

Stereo
(A1/2, A3/4)

Separate effect edit-
ing*

x
Separate editing; 1/3 to left and 2/4 to 
right at output

Same as above

9

Stereo (A1/2) or 
(A1/2, A3/4)
Tracks processed 
separately in mixer

x
A1 and A2 mixed to mono, resulting 
in an increased level; panning to cen-
ter (same procedure with A1/2 A3/4)

Mono signal to default sur-
round panning (center)
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Audio Routing A1 to A4 (Classic Routing)

NOTE: Audio Routing in the form described here was retained in Version 6.0 (and later) mainly in order 
to maintain compatibility with older Sequences (created using Version 5.6x or earlier). When editing 
new Sequences, use Output Mapping ( page 13-32; see previous section).

Use the Audio Editor’s Audio Routing when assigning Source Tracks on Timeline Tracks to the available Logical 
Audio Outputs by means of submixes (subsums). You can then make the assignments to physical or virtual 
(Fuse) outputs in Output Mapping.
Click the Classic Routing tab in the Audio Editor. If the tab does not appear, activate it by means of the appropri-
ate option on the Settings tab.

W h y  U s e  A u d i o  R o u t i n g ?

As described earlier, Pinnacle Liquid assigns odd numbered stereo Source Tracks (A1/A3) to the left output 
(A1/A3 in Audio Routing) and even ones to A2/A4. Mono Tracks are panned centrically, i.e. evenly assigned to 
A1/A3 and A2/A4 (see also “Stereo and Mono, Panorama and Balance”  on page 13-8).

This cannot be changed in Audio Routing: a mono clip panned on the Timeline to the right cannot be applied at 
the left output by means of Audio Routing. The actual panning of mono clips happens in the output “box” (A1/
2 and/or A3/4). The left/right distribution can not be changed for mono clips in the routing. This is not true for 
stereo clips: you can switch them in routing (i.e. switching left and right), since they do not include any pan-
ning information, providing balance has not been applied to them.

Outputs A1 to A4 are logical outputs. They are not assigned to the actual physical outputs until this is 
performed in Output Mapping (see previous section).
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I n t e r p r e t i n g  t h e  A u d i o  R o u t e r  ( C l a s s i c )

Audio Editor Classic audio routing

� Timeline Tracks are arranged vertically next to each other (as in the Mixer). They represent the Timeline 
rotated by 90 degrees. 

� Four Tracks appear at a time. 

� Use the scroll bar to see additional Tracks.

� Every Timeline Track has four Source Track columns (A1 to A4). 

The screenshot above shows the Audio Routing window of a typical stereo routing. The A2 Source Track (right) 
of the clips on the “A2” Timeline Track is assigned to submix �2 which, in turn, is assigned to Output A2 (right). 
Source Track A1 (left) is routed via submix �1 to Output A1 (left). 

Remember routing applies to all clips on a Track. That is why it is advisable to reserve certain Tracks for 
different types of audio clips (ambient sound, music, etc.).

SubmixTimeline Tracks Source Tracks Prefab output sets

Track matrixScroll bar
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P r e d e f i n e d  R o u t i n g  S e t s

You can either use one of the predefined routing sets or create a customized one. The predefined routings are 
suitable for most applications.

� Standard - 
The example below shows all uneven Source Tracks routed via Submix 1 to A1. The even Source Tracks 
are routed correspondingly (application for stereo left/right; non-panned mono clips remain centered):

Audio Routing: Standard Set

Direct Out: Digitize the audio clips as “stereo” even if the signals are completely different to create a “clean” sep-
aration of Tracks. You may, however, also digitize individual monochannel Tracks as left or right stereo clips. 
Direct Out means that the signals are passed on unaltered through the system.

� Single Out - 
The following Single Out unifies all Source Tracks on A1, thus changing stereo to monochannel mono. 

This setting causes a level increase at the output of up to 6 dB.

Audio Routing: Single Out

� Set Stereo-Mono - 
Set Stereo-Mono results in both stereo Tracks being assigned to both outputs, thus sounding like mono.
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This setting causes a level increase at the output of up to 6 dB.

Audio Routing: Stereo-Mono

� Multi Channel - This setting permits a “Direct Out” with four channels. Audio Source Tracks 1 to 4 are 
routed to logical outputs A-1 to A-4, i.e. input = output.

C u s t o m i z e d  R o u t i n g  S e t s

To create a customized routing set, in the drop-down menu click Custom Set. The difference between this win-
dow and those of defined sets is that the dots in the matrix can now be edited (and appear darker).

Each of these dots represents a Source Track. To assign a Source Track to one of the eight Submixes, move its dot 
to another position in the column. To do so, click in the matrix at the desired place (the point of intersection 
between the Submixes row and the Source Track column). 

To completely eliminate a Source Track from the Audio Routing, click the dot directly and it disappears. 

S u b m i x e s

Submixes are used for grouping audio Tracks before actual output and help the user maintain a clear overview. 
Submixes can be named individually. 

� To do so, double-click below the � symbol in the box. In the field that appears, enter a name and con-
firm with ENTER. 

Routing Submixes to Outputs

You can assign Submixes to one or more outputs. 

� To do so, click one of the small boxes on the right side of the Submix box and drag the mouse pointer to 
the required output. The color of the line that appears corresponds to the output selected. 

� To delete a connection, click the corresponding line. 
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Audio Editor Settings

On this tab, you can determine the functionality of the Audio Mixer. Basically, this is done by activating or 
deactivating Mixer sections, such as Logical Output Busses or faders. In its default state, the mixer has only the 
Mute/Solo, Track Panner and Clip Fader sections. For purposes of clarity, activate the other sections only as you 
need them.

Working with Insert Effects, Send Effects and Busses

You can also edit audio effects using the Audio Editor.

The concept  page 13-43

Insert effects  page 13-44

Send effects  page 13-45
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T h e  C o n c e p t

You’re probably familiar with the concept from hardware audio mixers: All have at least one three-band equal-
izer with send-effect and effect-return connections plus the associated faders, whereas high-end models have 
many more options. The Pinnacle Liquid Audio Mixer can also do more than just adjust the volume level and 
pan/balance; it also integrates audio effects. In this context, we make a distinction between Insert Effects and 
Send Effects. The only difference is in their application; they are actually the same VST-compatible audio plugin 
effects (“Pinnacle Liquid Plugin Audio Effects (VST)”  on page 13-76).

Each fader (you can also call them “channels”) represents a percentage of the total Timeline audio for your 
Sequence. All the audio clips on a specific Timeline Track are routed through the assigned faders, as illustrated 
here in a very simplified form:

One fader per track: All stereo audio clips on A2 are edited with fader A2

In this simplified configuration, the Audio Mixer is configured only to adjust the volume. Insert effects will be 
added in the next section.
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I n s e r t  E f f e c t s

Insert effects are inserted directly into the signal path of a fader or channel. All the signals of this 
channel traverse the effect editor(s), but each is processed separately within the effect.

Insertion of these effects requires that the fader’s Insert/Send FX section be expanded (see left). 
Two effect slots are provided in the default configuration. The number of slots increases automati-
cally when you insert additional effects.

If no Insert/Send FX section is yet visible, open the Audio Editor’s Settings tab and select the appro-
priate option.

1 Click the dotted line to open the menu and select one of the available audio effects. Effects 
supplied with Pinnacle Liquid are described starting on page 13-76.

2 Edit -
Click the “e” icon to open and edit the Effect Editor.

3 Bypass -
Click the box to temporarily remove the effect from the signal path. This is useful for com-
paring the edited and unedited state.

4 The colored effect line appears above the name of the Timeline Track assigned to the fader. 
Right-click to launch the Effect Editors from there.

5 If appropriate, insert additional effects.

Note the following:

� The order in which effects are processed is from bottom to top.

� From the insert slot menu, you can change the order of the effects, rename and copy individual effects, 
and insert them at another location (clip, rack).

� Stereo effects such as StereoSpread require a stereo input. In other words, the audio signal edited in the 
particular Fader Unit must come from a stereo clip (Track Type Stereo). Or, looking at it another way, 
stereo channels require stereo effect plugins. On the other hand, you can insert stereo effects in mono 
channels, but the output will be mono.

� The maximum number of effects per channel is 16.
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S e n d  E f f e c t s

You can use send effects to bundle multiple channels and route them to the same effects. The edited signal is 
forwarded from the send bus to an output bus where it is mixed with the output signal.

A1 to A4 are routed to the Send FX1 send bus, edited there with effects and mixed with the output signal 
via an output bus (not shown).

The advantage of this procedure is that the same effect (or combination of effects) does not have to be config-
ured individually for each channel. In addition - and unlike insert effects - the edited (in audio terminology, 
“wet”) signal is mixed with the original (“dry”) signal. Here’s how it works:
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1 The send bus is automatically inserted in the Mixer as soon as at least one Send Effect is activated in one 
of the standard Fader Units (new Send Bus option on  page 13-24).

2 Click in the insert/send effect section. From the list of available effects, select those that are appropriate 
(such as the popular combination Equalizer and Reverb shown in the figure here).
In the send bus, as well, the insert effects are processed from bottom to top.
If you need more than the two insert slots provided in the default configuration, you can configure 
them on the Audio Editor’s Settings tab.

3 Now reroute the signals from the relevant channels to the Send FX1 send bus that you just configured. 
In the insert/send effect section, select the branch to Send FX1 instead of an insert effect.
This bus then appears as shown here.
The Bypass switch for the signal branch is activated but the “e” icon for editing is not. This is because the 
effects are addressed in the send bus fader.

4 The small slider determines the percentage of the signal that is diverted to the send bus. Move the slider 
to the far right for 100 percent or to the far left for 0 percent. The remaining, more or less quieter signal 
can be routed to additional send busses or edited with other insert effects.

5 If necessary, adjust the Output Level of the send bus using the fader above the effect section.

6 Like any other channel, the send bus must be assigned to a logical output bus (see “Output Mapping: 
Assigning Signals”  on page 13-32).

Additional Options

� Multiple send busses per channel -
The mixer channels are not limited to one send bus.

� Combination of send effects and insert effects -
It is not necessary to observe any particular order here.
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Surround 5.1 Sound 

A surround sound system puts you right in the center of the action because, unlike a stereo system with two 
speakers, you experience sound from six speakers: Three in front, two in the rear and one for low frequencies 
that can even be placed under the couch, since the human ear is unable to localize low tones. The term “Sur-
round 5.1” stands for five speakers plus one subwoofer.

Pinnacle Liquid lets you produce your own 5.1 surround sound mixes. The next section tells you how.

Technical requirements  page 13-47

The 5.1 surround concept  page 13-48

Stereo or mono clips?  page 13-49

Preparing the timeline  page 13-49

Configuring the mixer  page 13-50

Surround lines on the timeline  page 13-52

Output  page 13-55

� Surround 5.1 encoder  page 13-55 

T e c h n i c a l  R e q u i r e m e n t s

In order to experience the full listening pleasure of surround 5.1, you must have the following 

� A surround-capable sound card with at least two, but preferably six or more audio outputs.

� Suitable speakers and, if appropriate, an amplifier that can process the signals.

This will let you hear surround sound on your computer workstation.

� A DVD player and/or surround amplifier (suitable for ProLogic2) and speakers if you produce DVDs or 
other media with 5.1 surround sound.

Your computer’s audio hardware must be compatible with the ASIO driver standard! If you purchase a 
new sound card for surround sound projects, regardless of whether it is internal or external (USB), 
make sure it is compatible with ASIO 2.0. ASIO is a professional driver standard. See also “ASIO Driver 
Standard” on page 13-4.

And, of course, you need adequate sound material. If you’re already toying with the idea of creating a surround 
mix while filming, you need to make sure you record lots of additional sound. It is also helpful to have a library 
of background noises, like those available from many commercial suppliers.
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T h e  S u r r o u n d  5 . 1  C o n c e p t  

Of the existing surround systems, 5.1 is the most widespread. It is known under different brand names, includ-
ing AC-3, Dolby Digital, DTS and MPEG2 Multichannel.

The six 5.1 channels are normally set up as follows:

� Center -
This channel is mainly used for dialog spoken by visibly active people or for sounds that define or 
explain the image.

� Stereo and surround channels:
Left (L), Right (R), RearLeft or Left Surround (LS) and Rear Right or Right Surround (RS) -
For sounds, sound effects and music.

� LFE (subwoofer) -
LFE (Low Frequency Emitter or Enhancement or Effects) is responsible for bass tones. Because the 
human ear is unable to localize low frequencies, the associated speaker is easy to position.

Ideally, the listener sits at the center of this configuration:

Speaker setup for surround sound

The surround effect is created by cleverly distributing sound events to the five surround channels. Example: 
Your video image is from the point of view of a person driving a convertible down the highway. Suddenly the 
driver is overtaken by a Hell’s Angel-type biker on a Harley Davidson without a muffler. The thundering engine 
must first be heard completely from the rear channels and then gradually shift to the left and right front chan-
nels in unison with the events pictured. While the motorcycle is even with the convertible, the focus of the 
sound should be clearly perceived on the left (provided the biker does actually pass on the left).
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M o n o  o r  S t e r e o  C l i p s ?

In the default configuration, Pinnacle Liquid’s Surround Panner is set up for mono signals, which is why you 
should always use mono audio clips for a surround mix. Stereo clips are reduced to a mono signal before being 
routed to the Surround Panner.
For this reason, make sure you already digitize (capture) mono clips in the Logging Tool. Otherwise, open the 
clip shortcut menu (Timeline) and select Disband Clip(s) to split the stereo clips onto mono clips. Another 
option is to open the clip Properties, where you can then switch the Audio Mode from stereo to mono and back 
again (you can also apply this to several clips simultaneously).

P r e p a r i n g  t h e  T i m e l i n e  

For the best possible surround mix, reserve Tracks on the Timeline for your audio clips:

� Reserve one each for L, R, RS, LS and Center, i.e. a total of five Tracks.

� LFE -
You do not necessarily have to configure a separate Track for LFE. Generally, the bass portion of the 
other signals is routed to the LFE channel, which does not have to be assigned an actual position in 
space.

Assign appropriate names to the Tracks, preferably in accordance with the 5.1 convention (Left, Right, etc.). 
This will facilitate assignment in the Audio Mixer. Activate Audio Playback (loudspeaker icon in the Track 
Header) for each of these Tracks; otherwise, they will not have a Fader Unit in the Mixer.

Surround panning is Track-specific, meaning that it is not set for each individual clip. Therefore, note 
that when you move a clip, surround panning does not move with it! That is why we urge you once 
again to perform audio postproduction last of all.

The Timeline setup described is only a basic configuration. Naturally, you can also reserve many more 
Tracks for the mix and incorporate send busses in the surround mix.
You might also organize Tracks by sound characteristics: Music, voice, natural and ambient sounds, 
special sound effects, etc.
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C o n f i g u r i n g  t h e  M i x e r  f o r  a  S u r r o u n d  M i x

Open the Audio Editor. If you already configured the Timeline Tracks as described above and activated Audio 
Playback for each, you should see at least five Fader Units.

Open the Track Routing section. For each fader, select Surround 5.1on the top line as the bus type and select 
Mono on the bottom line as the track type. The Mixer should now look something like this:

Audio Mixer prepared for a surround mix

The surround 5.1 bus fader with its level meter for the six surround channels appears on the right 
Let’s take a closer look at the Surround Panner:

Bus type

Track type

Surround panner

LFE fader

Signal loca-
tion

Listener
position

Front/rear slider

Left/right slider

Surround 
space
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� The listener sits at the center of the surround space.

� The gray dot indicates the spot in the room at which the sound seems to meet. In the default configura-
tion, this is the center position located exactly in front of the listener - obviously, because that’s where 
the center speaker is positioned.
You can position this dot within the surround space using the mouse.

� The two triangular sliders serve to move the signal location in a straight line from left to right and up 
and down.

The figures below show the gray dot in the left, right, center, left rear and right rear positions, respectively:

Left, right, center, left rear, right rear

This means:

The surround bus routes the entire audio signal on the particular mixer channel to the specific surround bus 
channel. For the listener, all the sound seems to be coming from one speaker (provided the other channels are 
set to mute).

When the gray dot is not located at one of these extreme positions, the signal is distrib-
uted to two or more surround channels. In the figure below, the signal location is cen-
tered directly behind the listener. In other words, equal percentages of the signal are 
coming from the left rear and right rear channels and from the two corresponding sur-
round speakers.

The principle so far: For each channel, you determine which speakers the signal will be 
output to, either totally or at a certain percentage. The surround impression is pro-
duced by the mix of all the channels in the listener’s ear.

LFE Fader

The LFE channel operates the subwoofer, which is the surround system’s bass speaker. In the default configura-
tion, this fader is centered at 50 percent. The far left position represents 0 percent and the far right represents 
100 percent. The fader lets you determine what percentage of the signal will be sent to the LFE channel.

Sound is directly 
behind the listener
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S u r r o u n d  L i n e s  o n  t h e  T i m e l i n e

When you change the surround position of a channel or signal, something also changes on the Timeline. Three 
surround rubberbands are visible on the Track - note that this is on the entire Track, because surround panning 
is track-specific and not clip-specific.

Surround rubberbands

The surround position is determined by two lines:

� One line represents movement along the X-axis (left/right) and the other along the Y-axis (front/rear).

� The third line does not appear until you open the shortcut menu for the Audio Playback Column (in the 
figure above, the column with the Speaker icon) and activate the LFE line display. This line represents 
the signal’s bass enhancement, i.e. the component routed to the subwoofer.

When you change the surround position or LFE Fader, Key Frames are inserted at the Playline position.
Exception: There are as yet no Key Frames and the Playline is located at the very beginning of the Timeline. In 
this case, the lines are simply moved up and down horizontally.
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T i p s  f o r  S u r r o u n d  M i x i n g

Static Surround Sound

If you want to maintain a specific surround composition for the entire duration of a Sequence, start by creating 
it at the beginning of the Timeline. Then repeat the settings at the end of the Sequence Track by Track. The sur-
round rubberbands must run horizontally over the entire length of the sequence.

Dynamic Surround Sound

Of course, the real fascination of surround sound is in the dynamic change in sound events. However, this is 
also where it becomes most difficult, especially if you want to synchronize sound and image. Here’s a simple 
example to explain how it works:

1 Select a clip of about ten seconds with a distinct sound event and place it on a Track configured for sur-
round panning.

2 We want the signal to revolve around the listener. Set the Playline to the beginning of the clip.

3 Start by moving the gray dot (the surround position) in the Track’s Surround Panner to the Left (L) cor-
ner.

4 Each time, move the Playline the same distance on the clip and move the dot to each corner in turn, as 
shown below:

The effect of these actions on the Timeline is shown at the bottom.

5 Play back the clip. You will see the dot move in the Surround Panner and should also be able to hear the 
effect.
Volume II Chapter Audio 13 - 53



PINNACLE

Audio Postproduction and Audio Effects
Distribution of Sounds to Channels

� Commentary and dialog - 
Words spoken by actors in front of the camera as well as off-camera commentary (voiceover) should be 
routed to the center channel. This will ensure that even listeners who are not sitting at the optimal center 
point will be able to localize these sound events accurately. Distributing the sound to the left and right 
would move this impression to the right or left, depending on the listener’s position.

� Stereo sound and music -
The center speaker, which assumes a large part of the center component of a normal stereo mix, can 
make the stereo impression seem somewhat “narrow”. You can expand the stereo signal slightly by 
applying effects such as the StereoSpreader.

� Natural and ambient noise -
These sounds should generally reach the listener from all sides and are therefore output in stereo from 
the left and left rear, and from the right and right rear. Outputting a larger percentage of the signal to the 
rear speakers increases the listener’s “perceived distance” from the sound events of the front channels.

� Sound effects -
Mono sound effects are distributed equally to the center channel and rear channels so that the listener 
hears them from all sides. The exception to this rule is image-specific and dynamic effects that must be 
specially localized.

Timeline and Mixer Configurations for Surround Sound

Other methods are available besides the methods described above in which one Timeline Track is reserved for 
each 5.1 channel:

� Tracks for sound events -
With this method, you design a Timeline layout based on sound categories such as voice, on-screen dia-
log, music 1, music 2, noise, effects, etc. These categories are then “panned” (i.e. distributed to 5.1 chan-
nels) according to a more or less defined schema.

� Using 5.1 send busses -
With this method, you set up five or six send busses, one per 5.1 channel. In the case of complex mixes, 
this saves you from having to make extensive assignments of surround channels and, possibly, sound 
effects.
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O u t p u t

The logical 5.1 output bus with its six channels can be found on the Output Mapping tab. Assuming you have 
the necessary hardware, each of these channels is assigned to a physical hardware output. Check here to deter-
mine whether the default assignment corresponds to the port characteristics of your hardware, i.e. whether the 
logical channels are also output to the correct speakers.

You can delete and set dots in the matrix simply by clicking in the particular fields.

Surround 5.1 Encoder (Matrix Surround)

Pinnacle Liquid supports the 5.1 encoding of surround sound. This is a system that integrates surround sound 
in a two-channel stereo signal. It also lets you reproduce the sound on a conventional stereo system (or stereo 
TV) with only two speakers.

You must have a suitable decoder to extract the impression of spatial sound from the stereo signal. Most newer 
DVD players and surround amplifiers are able to do this.

There are two methods for generating 5.1-encoded stereo files:

� Export Sequence dialog box -
Select PCM 16 Bit 48.000 Hz 5.1 Encoder as the audio export format.

� DVD/SVCD Export -
TheDestination tab has a Matrix Surround option that activates the 5-to-2 downmix. You should prefer-
ably combine this option with AC3 audio.

Nevertheless, optimal surround sound requires a mix that uses the Surround 5.1 Bus. This is because, 
technically speaking, the 5.1 encoder follows the 5.1 bus in the audio signal path but has a fixed channel 
assignment.
A simple stereo mix can also be encoded as a 5.1 signal. Although the decoder then distributes the sig-
nal to five speakers (plus subwoofer), this produces only a kind of “pseudo surround”.
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Special Functions

This section describes a number of special audio functions:

Cross Fade  page 13-57

1-click Fade In/Out  page 13-58

Global modification of volume and panning  page 13-59

Add Dissolve  page 13-60

Audio Mix Automation (live audio mix)  page 13-61

External (hardware) audio fader  page 13-63

Voice-Over  page 13-65

Audio Settings  page 13-67

Reference Level (Create Signal Clip) page 6-59
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Cross Fade

The Cross Fade blends out the outgoing clip, while simultaneously fading in the incoming 
clip. Fade-ins and fade-outs are always linear.

� Cross Fade can be found in the Project window on the Library  tab in the Folder 
Classic Transition FX > Audio. Insert the fade at a transition or at the beginning 
or end of an audio clip.

The screenshot below shows how the mark-out and mark-in of two audio clips linked with a Cross Fade are 
somewhat shifted to the beginning and end of the cross fade. Remember to leave a bit of leeway ( page 9-36) for 
audio cross fades as for video fades.
A Cross Fade can also be inserted at the beginning or end of a clip (i.e. not as a transition) and as a fade-in/out.

Cross fade with effect and volume lines

The audio level at the beginning and end of the Cross Fade corresponds to the level of the clip con-
cerned.

Outgoing Clip Incoming Clip
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1-click Fade In/Out

This function facilitates the creation of audio fade-ins/outs. The Audio Editor has to be open and the Volume 
Lines have to be visible. Make sure you are in Edit Mode ( page 9-55).

1-click Fade In/Out

� Create fade-in: move the mouse pointer to the beginning of an audio clip near the volume line and keep 
the CTRL key pressed. The symbol of an ascending volume line appears next to the mouse pointer. The 
fade-in stretches from the beginning of the clip to where you click.

� Create fade-out: the mouse pointer is located at the end of a clip. If not, create it in the same way as the 
fade-in.
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Global Modification of Volume and Panning 
(Adjust Audio Function)
The Adjust Audio option allows you to increase or decrease the volume level of one or several audio clips. Each 
individual Key Frame is modified by the indicated value. Also Panning can be globally modified.

1 Open the Audio Editor.

2 Select one or several clips.

3 Click right in one of the selected clips and select Adjust Audio from the shortcut menu. (This entry is 
only visible with the Audio Editor open).

4 A dialog box appears:

Adjust Audio

G l o b a l  Vo l u m e
The example illustration (in the dialog box) to the right shows the scope of level increase or decrease without 
jolting the Volume or Pan Line. “15 dB Top Buffer” e.g. means that you can enter 15 dB into the left entry field. If 
you enter a higher value, the peaks of the volume/pan lines are nevertheless only increased (or decreased) by 
the technically admissible maximum value; the curves are jolted at these places.

To decrease the value, enter a minus in front of the value.

Please note the following:

� The maximum/minimum value is defined by the Key Frames with the highest/lowest value in a selected 
clip.

� Levels of minus infinite remain unchanged even if the value is decreased beyond the maximum value 
(otherwise all fade-ins/outs would get lost).

� The maximum/minimum values of volume lines can, in case of global changes, reach the indicated 
extreme values sooner than values of other Key Frames. This may cause volume curves to become flatter 
(steeper) as a result of global increase/decrease.
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G l o b a l  P a n n i n g

Again indicate a maximum level for either completely right panning (50%), or left (-50%), or somewhere in 
between. 0% indicates center position.

S e t  A u d i o  M o d e

Here you have the chance once again to label the selected clip as “mono” or “stereo”. Caution: This is not status 
indication, i.e. it is not indicated whether the clip actually is stereo or mono. If you are not sure call the Clip Pro-
perties from the shortcut menu. 

Add Dissolve

This function automates the insertion of Cross Fades and Dissolves. Proceed as follows:

1 Set the Playline near the editing point. Make sure the respective Timeline Track is enabled. If there are 
several overlapping editing points at this point, you can insert several Dissolves at the same time (if the 
Tracks are active).

2 Now you have two options: Add Dissolve with or without option 
( page 13-61). Click the icon in the Timeline toolbar, select Add Dissolve 
with option, i.e. position and length of the dissolve can be set in a dialog. 
The following box opens:

3 If necessary, change the indicated duration of the dissolve. One second is 
preset. Continue by selecting the dissolve position at the editing point:

� Starting from the editing point (fade-in)

� Centered on the editing point (dissolve)

� Ending at the editing point (fade-out)

4 You can also enable a function automatically adapting the dissolve to the 
available dissolve leeway.

� Add to all active Tracks in marked range -
This helps to distribute Dissolves and Crossfades over a wide area, even the whole Sequence. You only 
need to set a mark-in and a mark-out to define the horizontal range, and to activate or deactivate the 
Tracks for the vertical selection. Note: Dissolves and Crossfades can only be placed on active Tracks. 
Mark-in and mark-out must be placed one frame before and after the first and last clip of the range if 
you want Fade-In and Fade-Out.

5 Click OK (checkmark) to insert the dissolve at the editing point.

Add Dissolve
 Automatic dissolve
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Without Option

If you wish to continue working with the settings made, clicking on Add Dissolve without option inserts a dis-
solve with the parameters last set at the editing point without further prompt.

If a video edit is located at the editing point on an active Track, a video Dissolve is included; if an audio 
edit is located at the editing point on an active Track, a cross fade is included. Combinations are possi-
ble.

Audio Mix Automation
In the Audio Editor, Pinnacle Liquid lets you mix down one or more channels live - and not just the volume, but 
also panning, including surround panning. By linking faders, you can edit multiple Tracks or channels simulta-
neously.

Start by activating the Audio Mix Automation function of the Tracks to be mixed by clicking on the box under-
neath the Fader. See also “The Audio Mixer” on page 13-19.

The box at the bottom of each Fader glows red to indicate that the Track has been activated. This selection has 
priority over the activation or deactivation of Tracks in the Timeline. Protected Tracks cannot be activated for 
audio mix recording.

The following instructions may also be applied to panorama settings. In this case activate the appropriate rub-
berband view on the Track (see also Rubberbanding on page 13-27).

You can use a MIDI port to connect fader consoles; this is described in more detail at the end of the 
audio chapter.  page 13-63).

S t a r t i n g  A u d i o  M i x  A u t o m a t i o n

Set a mark-in on the Timeline at the point where the live mix is to start. You can limit the area 
with a mark-out, otherwise you can stop Audio Mix Automation at any time.

Now, if you start playback (with a short preroll) by clicking the Audio Mix Automation button, you will see a red 
line appear in the selected Tracks. Move the Fader of a Track to raise and lower the volume level. The red line 
changes shape accordingly. If you have several Faders locked together, you can control several channels simulta-
neously. 

The red line only appears in the Tracks whose Audio Playback is switched on.  page 9-12.

Audio Mix 
Automa-

tion active
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S t o p p i n g  A u d i o  M i x  A u t o m a t i o n

You have three options for stopping Audio Mix Automation:

� Click the function again

� Click Stop or Play,

� Run to mark-out.

S p e c i f y i n g  K e y  F r a m e  R e s o l u t i o n

After Audio Mix Automation is stopped, a dialog box is displayed that relates to converting the (temporary) red 
line to a Volume, Panorama or LFE line equipped with Key Frames:

In the top section, you have the option of setting the Key Frames:

� - Either for the specific Tracks (surround panning, LFE),

� - Or for the individual clips (volume, clip panning).

Open the shortcut menu for the Audio Playback column and activate the relevant line.

Use the Audio Key Frame Resolution drop-down menu to specify the resolution of the Volume or Panorama 
Line, i.e. how many Key Frames will be set. 

� Minimum - only the absolutely necessary Key Frames are set

� Low - slightly lower resolution than Normal

� Normal - good resolution for most applications

� High - greatest possible resolution

The rubberbands created during Mix Automation (in the clip view with Volume or Pan Lines) can then also be 
edited using the Key Frame functions.

R e p e a t e d  P r o c e d u r e s

You may repeat this procedure until the section selected is mixed perfectly. Earlier settings are overwritten with 
each confirming of the Audio Mix Automation. You can fine tune your mixes by switching Tracks on and off 
(Playback on/off, or by activating/deactivating Audio Mix Automation for these Tracks).
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External Audio Fader

If an external audio fader is connected via a MIDI interface, the Audio Mixer Faders (for Audio Mix Automation, 
for example) can also be controlled by hardware. The operation remains essentially the same; the only step you 
need to carry out before mixing is to balance the hardware faders with the software faders in the Audio Editor to 
ensure smooth fades in and out.

Faders supported  page 13-63

Installation  page 13-63

Balance faders  page 13-64

The Audio Tool can also be operated with an external fader. 

F a d e r s  S u p p o r t e d

At this time, Pinnacle Liquid supports the “Fader Master Pro” from JLCooper Electronics. For the latest infor-
mation on other devices supported, contact your specialized dealer.

I n s t a l l a t i o n

To connect the external fader, your system must be equipped with a midi interface (gameport) with a D-sub 15-
pin connector. 

This interface may already be mounted on your motherboard or may be available via an installed sound card. 
You may also use Danka Data Device’s midiLink adaptor which connects to your computer’s COM port 
(www.dankadata.com). In any case, the required (midi) driver must be correctly installed in the Windows Con-
trol Panel > Multimedia (see also the installation instructions for the sound card).

Fader Master Pro is connected to the system via an additional adapter from D-sub 15-pin (with photocoupler) 
to a 2x 5-pin DIN connector.

To externally control the faders, you have to set the mode for volume control (F01) or panning (F03) on the 
Fader Master (all other modes are ignored).
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Midi Properties

In the User settings dialog you will find an item called Midi Properties. Use these options to configure Midi 
devices and Midi ports.

Open Edit > Control Panel > User > Midi Properties (a mixer icon) and select the appropriate options.

� Midi Ports-
Assign ports for inputs and outputs

� Midi Fader Device - 
select the connected device from the list.

B a l a n c i n g  F a d e r s

Position the Playline at the position where you would like to start mixing. 

If you open the Audio Editor when an external fader is connected and turned on, two arrows, one pointing up 
and one pointing down, appear to the left of the activation button for Audio Mix Automation. These arrows 
indicate the direction in which you must move the hardware fader to ensure coverage with the software fader. 
Once both faders match, both arrows are highlighted and you can start mixing.
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Voice-Over

In combination with suitable hardware, the Voice-Over function turns Pinnacle Liquid into a live audio 
recorder, e.g. for comments that can be spoken directly “onto the image”. The clips are then inserted on the 
Timeline synchronized with the image. 

The clip generated using the Voice-Over function is saved in the Capture directory of the destination 
volume for this Project (for example, "R:\Start-PAL..."). This directory is generated only when clips are 
digitized (Batch Digitize or Logging Tool), meaning that material must already have been digitized pre-
viously in this Project.

Regardless of whether you generated mono or stereo files for the Voice-Over, only one clip is inserted in 
the Timeline (naturally, for stereo a stereo clip is saved). The Edit Style is not taken into account for 
Voice-Over; the clip is always inserted in Overwrite Style.

R e q u i r e m e n t s
This function requires that your PC have an operational sound card. The microphone is connected to the 
sound card and the input level (volume) is controlled by means of the sound card settings. You can set the file 
format (48 or 44.1 kHz, Stereo or Mono) in Pinnacle Liquid under Control Panel > User > Audio Settings
 ( page 13-67). However, these settings are dependent on the options available for your sound card. 

NOTE: See also “Voice Over Using the blue.Box” on page 13-66.

Because the Voice-Over button is not a standard part of the toolbar, you must transfer it from the function 
library to the toolbar ( page 17-8). You will find the icon (a microphone) on the Mixer tab.

P r o c e d u r e  f o r  a  Vo i c e - O v e r  S e s s i o n
1 Open the Audio Editor and set a mark-in as the starting point for recording. You can also set a mark-

out. If you do not set a mark-out, the Voice-Over function continues running until you stop it. 
The Voice Over clip will be inserted in the first (from left to right) Track marked active for Audio Mix 
Automation. That‘s the small red rectangle at the bottom of the Fader. Fader units and Timeline Tracks 
correspond to each other. 

2 To start recording, click the Voice-Over button. Record the narration or whatever audio input you 
choose.

3 To stop recording, click the Voice-Over button once again or click the Play/Stop button.

4 The Voice-Over dialog box is then displayed. Option:
- Clip Name lets you define the name under which the clip will be saved in the Rack. The Voice-Over clip 
is always saved in the currently active Rack and the extension is automatically incremented based on the 
number of Voice-Over clips already present in the active Rack.
Note: The clip is always inserted in the Overwrite Style, i.e. it overwrites any other clips.

5 If you now confirm your settings by clicking OK, the clip generated from mark-in to mark-out or from 
mark-in until recording stops is inserted synchronously in the Timeline.
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C o n t r o l l i n g  Vo i c e - O v e r  I n p u t

To access a fader for controlling the Voice-Over signal, select Edit > Control Panel > User > Audio Settings. Use 
the arrow button at the bottom right to add a level and fader. Important: Level meters and faders are activated 
and usable only if they are supported by the sound card selected.
You can also define a preroll and postroll for the Voice-Over operation in the Audio Settings dialog box. 
Preferred device allows you to select a specific sound card (if more than one is installed) and Preferred quality 
lets you configure a specific quality level (sampling rate, bit depth, etc.) supported by the sound card.

Liquidblue

Vo i c e  O v e r  U s i n g  t h e  b l u e . B o x

The analog and AES/EBU inputs of theLiquid blue.Box  can now be used together with the VoiceOver 
function. Professional type audio equipment can now easily be connected to the blue.Box. Therefore, in Con-
trol Panel > User > Audio Settings you find several new options.

First, select the blue.Box as the Preferred Device. Now a second tab, Voice Over, appears in the extended dialog 
section.

� Mute VO Track at MarkIn – this option determines playback of the Timeline Track selected for VoiceO-
ver. If activated (default), the Track will be muted when the mark-in is reached.

On the second tab the following options appear:

� Input selection – choose the input to which the signal to be recorded is connected.

� Looped through output – here you select the output to which the incoming signal is to be routed 
(looped). None means no loop-through selected. Output is always mapped to two channels; a mono 
recording will loop-through as two channel mono; stereo, however, will be mapped as stereo.

� Active monitor switch – if activated, audio on the Timeline will be muted during the V/O recording, 
beginning at the mark-in. You will only be able to monitor the signal input via the selected output. 
When deactivated, the V/O sound will be mixed into the Timeline audio. 
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Audio Settings

Select Edit > Control Panel > User > Audio Settings to configure specific Audio Mix Auto-
mation and Voice-Over parameters. 

P a r a m e t e r s  f o r  A u d i o  M i x  A u t o m a t i o n
Enter the desired values for Preroll and Postroll in the two fields. 

See also “Audio Mix Automation” on page 13-61.

P a r a m e t e r s  f o r  Vo i c e - O v e r
Here you can set the parameters that will guarantee a successful Voice-Over recording. Important: These 
parameters depend in part on the sound card installed.

See also “Voice-Over” on page 13-65.

Audio Settings

� Preroll/Postroll -
These entries define the preroll and postroll settings for the Voice-Over session.

� Preferred device -
This option lets you select different sound cards (if installed).

� Preferred quality -
This option selects the audio quality (Stereo, Mono, Sampling, etc.).

� Input level -
Single-click the small triangle on the bottom right to add an audio meter and a fader to the dialog box, 
with which you can then control the incoming signal.
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P a r a m e t e r s  f o r  D i g i t a l  A u d i o  S c r u b

Digital audio scrub (also see “Audio Scrubbing - Digital or Analog”  on page 13-11) operates as a very short play-
back loop centered around the Playline position: Each time you move the Playline, the playback loop is also 
shifted. You can modify the playback characteristics of this loop by means of three parameters:

Range -
Specifies the number of frames that should be played back before and after the Playline.

Repeat -
Specifies the number of repetitions per loop.

Gap - 
Specifies the gap (in frames) between loops, i.e. the pause before the loop restarts.

Reference Level (Create Signal Clip)

The Create Signal Clip function lets you create reference level tones. See also “Generating a Signal Clip (Refe-
rence Level Tones)” on page 6-59.
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Audio Effects

This section provides you with information on working with audio effects:

Basics

� Where can I find audio effects?  page 13-70

� Applying effects and opening Effect Editors  page 13-70

� Audio effects are real-time effects  page 13-70

� Changing effect parameters in real time  page 13-71

� FX Properties  page 8-71

� Saving effect settings  page 13-71

� Effects and output level  page 13-72

Pinnacle Liquid audio effects (standard)

� Equalizer  page 13-72

� Maximizer  page 13-74

� Echo  page 13-75

� Cross fade  page 13-57

� Add Dissolve  page 13-60

Pinnacle Liquid plugin audio effects (VST-compatible)  page 13-76
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Where Can I Find Audio Effects?

In the Project window, click Library  tab > Classic Clip FX > Audio. Here you will find the Equalizer, Echo and 
Maximizer effects.

Applying Effects and Opening Effect Editors

1 Drag the desired effect onto the relevant clip. 

2 Right-click the effect icon (or the colored line) on the clip to open the shortcut menu. 

Effect icon in the clip, colored line and Clip FX shortcut menu

Depending on the Track height and Timeline scale selected, the effect icon might not appear. However, 
the colored line is always visible.

3 Select the effect, click Edit to open the Effect Editor.

You can also open Effect Editors by selecting FX Properties from the clip’s shortcut menu. (See also “FX 
Properties” on page 13-71.)

A u d i o  E f f e c t s  A r e  R e a l - T i m e  E f f e c t s

Audio effects are real-time effects. This means you can make changes to a clip while it is playing using the audio 
effect edit boxes. However, if you apply, for example, the Equalizer effect several times to one clip, you may 
exceed your system’s processing capacity (of course, also due to other required operations). In this case, the sys-
tem renders the effects. Click the � symbol on the taskbar to open the Render Viewer window to find out how 
long rendering will take and/or to halt rendering. See also “Render Viewer” on page 10-35.
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Changing Effect Parameters in Real Time
You can evaluate the effect of the Equalizer, Maximizer and Echo directly at the audio material. Follow the steps 
indicated below:

1 Select the range of the respective audio clip on the Timeline by means of mark-in and mark-out (or 
highlight a range with the shortcut menu of the Slice Track).

2 Drag the desired audio effect onto the clip.

3 Start a playback loop by clicking the button Play In to Out.

4 Open the Effect Editor either by right-clicking the effect icon in the clip or from the shortcut menu of 
the clip at Properties FX (see next heading).

5 If you now change the parameter of the effect (e.g. add echo), you hear the immediate result in real-
time.

FX Properties
See “FX Properties” on page 8-71.

Saving Effect Settings 
To save effects, e.g. an equalizer effect with specific settings which you plan to use again on other clips, proceed 
as follows:

� Right-click the FX icon on the clip to open the shortcut menu and select Copy to create a copy of the 
given effect. 

� Go to a Rack and use the Paste option from the Rack shortcut menu. The effect will be placed in the 
Rack and can be renamed using the Rename option.

� You can also use the CTRL+C (Copy) and CTRL+V (Paste) keyboard keys for this operation.

You have to paste the copy in a Rack other than the Library  Rack since this Rack is reserved for effects 
that come with the software. 
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Effects and Output Level

Changes to Equalizer, Maximizer and Echo settings have an influence on the level of the output signal. If level 
increases significantly, clipping may be activated already within the effect. In Audio Tool (output), the LED 
indicator on top (yellow) blinks while clipping. In this case, reduce Gain (see also Clipping on page 13-15).

Equalizer

The Pinnacle Liquid Equalizer is a parametric triple-band equalizer which gives you the 
choice of three overlapping frequency bands: 

� Low: 20 Hz to 1000 Hz

� Mid: 20 Hz to 20 kHz (with adjustable slope) 

� High: 1000 Hz to 20 kHz

“Parametric” means you can precisely define a center frequency for each band. Move the Gain slider to amplify 
and attenuate (increase and decrease) the level of specific frequency bands (+/- 15 dB). Click Dry to tempo-
rarily eliminate the equalizing from the signal (for example, to compare the manipulated and original signals).

To directly edit these parameters click their respective field and enter a value.

Equalizer
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B e l l  E q u a l i z e r  a n d  S l o p e

In the Mid range, use the Slope (Q) slider to define the frequency range (bandwidth) used for amplification or 
attenuation. Depending on the settings, amplification or attenuation falls to the right or left of the center Fre-
quency by a defined factor. Together with the specified center Frequency, Q determines the bandwidth for 
amplification or attenuation. Equalizer bandwidth can be controlled with the Q slider, using the following for-
mula:

The maximum slope factor is 100; the minimum, 4. The higher the slope, the smaller the bandwidth. 

Bell equalizer bandwidth

The diagram shows that as the value for slope increases, the bell curve’s slope becomes steeper. 

Use a high slope value for a small bandwidth. Together with high attenuation, you can create a “notch filter” 
effect to filter out disturbances such as AC hum.

Bandwidth is defined as the resulting value (see graph) at +/- 3 dB from center frequency.

The Equalizer can be used several times on the same clip, each time adding three more frequency bands 
(3, 6, 9...).

Bandwidth = Center Frequency

Slope (Q)

�

��

��

�


LEVEL Center Frequency

Bandwidth

Slope

Frequency
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Maximizer

The Maximizer is an effect for optimizing loudness. With this function, “normalized” 
audio material with level peaks in the headroom range (see also Digital Scale and Digital 
Audio on page 13-15) sounds even louder and denser without exceeding the maximum 
modulation limit. Tone quality is only minimally affected.

Maximizer

Like the Equalizer, the Maximizer is also a real-time effect. The Maximizer continuously analyzes possible gains 
and displays calculated values in the Gain Headroom field. If you increase level with the slider, available Gain 
Headroom becomes smaller (indicated also by Easy and Critical next to the scale). This lets you play with the 
maximum loudness level. However, be sure to allow enough room for signal peaks.

Click Dry to temporarily deactivate maximizing (for example, to compare the manipulated and original sig-
nals).

Audio material that was previously recorded with “emphasis” contains amplified, high-frequency signal 
components. Because this may distort the Maximizer’s audio analysis, it is recommended that you not 
use emphasis if the Maximizer must be used.

The Pinnacle Liquid Maximizer is a combination of a dynamic compressor and a limiter - two compo-
nents used in professional audio processing. 
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Echo

Three parameters are available for influencing the outcome of an echo effect: Delay, Feed-
back and Mixup. Click Dry to temporarily eliminate the echo from the signal (for exam-
ple, to compare the manipulated and original signals).

Echo effect

D e l a y
Use this field to specify how long the output signal should be held in the buffer before it is sent back to the sig-
nal. To create a reverberation effect, use a relatively small delay value. 

F e e d b a c k
Use this field to define echo frequency (i.e. how often the delayed signal is returned to the signal). 

M i x u p
Use this field to define echo level in relationship to the output signal. 100 percent corresponds to a ratio of 1:1, 
in other words, equally loud.

Cross Fade
The cross fade blends out the outgoing clip, while simultaneously fading in the incoming clip.  page 13-57

Add Dissolve
With its Add Dissolve function, Pinnacle Liquid provides a convenient means of inserting cross fades. See also 
“Add Dissolve” on page 13-60.
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Pinnacle Liquid Plugin Audio Effects (VST)

The audio effects described below were developed by Steinberg, the audio group of Pinnacle Systems. These 
plugins are compatible with VST, which has become the de facto standard for plugins in the audio field. Basi-
cally, this means that all VST plugins can be integrated in Pinnacle Liquid (see “Integrating VST Effects”  on page 
13-77).
Some of these plugins come with their own graphical user interfaces, while others retain the look and feel of the 
Pinnacle Liquid Effect Editors.
To find these effects, select the Library tab Realtime Clip FX > Audio.

VST plugins do not allow you to set Key Frames.
The parameter fields are editable with the mouse only, not with the keyboard.

Integrating VST effects

� VST banks and programs  page 13-77

Applying VST effects

� As clip and “Track” effects  page 13-78

� As insert/send effects in the audio mixer  page 13-42 

Bypass function  page 13-78

Leveler  page 13-78

Grungelizer  page 13-79

Karaoke  page 13-79

Reverb  page 13-80

Liquid EQ (Equalizer)  page 13-80

StereoEcho  page 13-81

Chorus page 13-81

StereoSpread  page 13-82
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Integrating VST Effects

If you have additional VST plugins, copy them to the following directory:...\[Pinnacle Liquid program direc-
tory]\PlugIns\VST. You can also create a subdirectory here.
To locate the added effects within Pinnacle Liquid, select the Library tab > Realtime Clip FX > Audio. (You 
must, however, restart the application. After plugins are removed from the directory, a restart will take much 
longer than usual.)

V S T  B a n k s  a n d  P r o g r a m s

A VST Bank is a collection of VST Programs. A VST Program is an effect whose parameters are set in a particu-
lar way. With most of the effects supplied, you can select these programs from a list of presets. For the Equalizer, 
for example, you can select “Telephone” or “Vocal”. The drop-down list is itself a VST Bank.

You can replace VST Programs and Banks with other Steinberg audio products.

Creating and Saving a VST Program

1 Set all the parameters according to your preferences.

2 Click the program selection text box (list of presets) and enter the name of the new program.

3 Open the shortcut menu for VST commands.

4 Select Save VST Program.

5 Enter a name for the program file (the name should be the same as for the program you named above). 
The resulting file has the extension *.fxp.

Loading a VST Program

1 Open the shortcut menu for VST commands.

2 Select Load VST Program and select the program’s storage location.

3 The Program now appears in the list.

If you want to keep this program in the list permanently (=VST Bank), save it as part of a VST bank (see the 
next section).

Changing, Saving and Loading a VST Bank

This procedure is the same as for VST programs except that, in this case, entire banks (lists) are involved. These 
files are assigned the extension *.fxb.
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Applying VST Effects

VST effects are applied just like any other clip effect. Simply drag the effect from the Rack and drop it on one or 
more clips of your choice. Then click either the red line or the effect icon on the clip to open the effect editor.
You can also apply one or more audio VST effects to an entire Timeline Track. In this case, drop the effect(s) on 
the Track name. Then right-click the colored line to open the editor.

To use the VST plugins as insert or send effects in the audio mixer, see the section on “Working with Insert 
Effects, Send Effects and Busses”  on page 13-42.

Bypass Function

With audio effects, it is often necessary to make comparisons with the original sound in order to evaluate the 
results of the effect.

This is done using the Bypass function. When this function is activated, the effect is removed from the audio 
and you can then listen to the original sound in its unadulterated form.
If you do not see this button on the Toolbar below the parameter fields, right-click the toolbar, drag the button 
from the Library and drop it on the toolbar.

Leveler

This plugin helps you correct a problem typical of video recording, i.e. the uneven volume of natural sound, 
meaning the difference between soft and loud passages. The Leveler finds a target volume somewhere between 
the soft and loud sections of the original sound. For sounds below this target volume, the Leveler acts as an 
amplifier and for sounds above it, as an attenuator (compressor). This brings the average volumes closer to the 
target volume and evens out any fluctuations.

� Target Volume -
Determines the target volume.

� Compression -
Attenuates the loud tones; the louder the tone, the higher the value of this setting.

� Threshold -
This value determines the minimum volume as of which amplification is applied, thus preventing soft 
background noises from becoming too audible.

� Expansion -
Makes soft tones louder; the further to the right, the louder the tone.
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Grungelizer

The Grungelizer lets you add noise and crackle to the audio to create the impression of old records or vintage 
radio recordings.

The parameters are:

� Crackle -
This knob supplies the crackle typical of records. This parameter is adjustable; the most crackle is pro-
duced when it is set to the far right.

� RPM -
Turntable speed: 33, 45, 78

� Noise -
Produces a uniform noise base; the volume is adjustable.

� Distort -
Adds sound distortions.

� EQ (Equalizer) -
Turn the knob to the right to filter out the lower frequencies more and more, thus producing a thinner, 
softer “Lo-Fi Sound” (as opposed to Hi-Fi).

� AC (hum) -
Adds the AC hum associated with vintage tube radios to the audio.

� AC Frequency -
Toggles between a 50-Hertz and 60-Hertz AC frequency. Changes the pitch of the hum sound.

� Timeline -
Determines the extent of the overall Grungelizer effect; it is most drastic at “1900”.

Karaoke

This effect filters out the lead vocal from a musical number so that it can be used, for example, for karaoke per-
formances. Depending on how effective the filtering is, a vocal piece can also be used as instrumental back-
ground music for videos. The principle behind this effect is the fact that in vocal numbers, the lead vocal is 
usually is present on the right and left channels equally. This plugin compares the two channels and removes 
identical components. There is no way of knowing ahead of time whether a particular recording will be suitable 
(optimal or less so).

� Volume -
Lets you correct the change in volume that is a by-product of the Karaoke effect when it filters out the 
vocals. If the volume is too low, move the slider to the right.
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Reverb

This effect determines sound character by simulating the rooms in which tones/sounds/noises are created and 
perceived. The reflection of soundwaves (commonly referred to as echo) plays an important part. The size of 
the room and the nature of the reflecting surfaces create differences in the direct perception of the sound source 
and in the delayed perception altered by reflection.

A number of room simulations are available.

The following parameters allow you to configure individual acoustic spaces (Tip: Start with a similar preset):

� Initial Delay -
This parameter determines the starting time for the first “early reflection”, i.e. how the sound is 
reflected off the walls in the simulated room. Values range from 0 to 500 milliseconds. The lower the 
value, the earlier this initial reflection is audible.

� Room Size -
This setting determines the “size” of the simulated room and, therefore, the depth of the reverberation. 
Values range from 1 to 30. The higher the specified value, the larger the simulated reverberation space.

� Damping -
This parameter serves to attenuate the high frequencies in the reverberation in order to generate a 
softer, warmer sound. The higher the value, the more the high frequencies are attenuated.

� Duration -
This parameter determines the duration of the reverb effect.

� Mix -
This parameter defines the ratio of the effect signal to the original unedited audio signal. When the 
slider is set to the center position (default), the ratio is balanced. When moved all the way to the left, 
only the original signal is audible.

Equalizer

This is a ten-band equalizer for determining the sound characteristic. It allows you to emphasize or suppress 
specific frequency ranges. Values range from -24 to +24 dB.
A number of standard scenarios are available in a list. Selecting Flat sets all the bands to zero.
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StereoEcho

StereoEcho is a delay effect with separate settings for the left and right channels. It can also be configured as a 
single mono delay, in which case the maximum delay time will be doubled.

� Delay 1 (2) -
The delay time for the left channel. The maximum delay time is 1486 ms, unless you link the two chan-
nels and apply the effect to the mono channel. In this case, the maximum delay time is 2972 ms (1000 
ms = 1 second).

� Feedback 1 (2) -
This parameter determines the amount of the delayed signal to be routed back to the Delay 1 block in 
order to generate repetitions there. The higher the value, the more often the echo is repeated.

� Link 1,2 (off, linked) -
Select “off ” if you want Delay 1 and Delay 2 to be treated as independent units. Select “linked” to link 
the Delay1 output to the Delay2 input.

� Del2 Bal -
This parameter determines how much of the left-channel output is routed to the right-channel input. 
When set to “0.0” (far left), no signal is forwarded from the left-channel output to the right-channel 
input. When set to “0.0” (far right), the right-channel input receives both its normal source and the 
complete output of the left channel.

� Volume L/R -
Determines the output level for the left/right channel delay.

Chorus

The Chorus effect is used to generate a “warmer” sound. The following parameters are available:

� Time -
This parameter lets you define the basic delay for the Chorus signal as compared to the original signal. 
The higher the value, the more drastic the effect. Lower settings generate flanger-like effects, medium 
settings are used for a classic chorus effect, and higher settings are mainly used for special effects.

� Width -
This parameter determines the degree to which the delay time can vary with the modulation. It is just 
this change in the delay time that produces the modulation effect. Avoid setting this parameter to 0% 
because the result sometimes sounds as though a phase shift is taking place.

� Lfo Freq -
This parameter determines the modulation speed. The higher the value, the faster the modulation. 
Other than for special effects, it is unlikely that you will ever use values greater than 7 Hz.
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� Feedback -
This parameter determines the amount of the effect output to be routed back to the input. (Moreover, 
the phase of the returned signal is reversed.) The higher the value, the more drastic the effect. With 
shorter delay times, a flanger-like effect is produced. With longer delay times, the effect sounds more 
like multiple repetitions.

� Feed Bal -
This parameter determines the volume of the signal returned (see description above) for the mix. If its 
value is 100% and the feedback value is from 65% to 100%, this effect generates a natural oscillation/
vibration/resonance.

� Glimmer 1/2 -
The two Glimmer parameters determine the extent to which the chorus signal should be shifted around 
within the stereo image. Glimmer 1 processes the right-channel signal and Glimmer 2 processes a com-
bination of the right and left channels. (In this case, the left channel is always set to 0.)

� Out Lvl -
The stereo output level of the effect.

StereoSpread

This effect expands or contracts the spatial impression of a stereo signal. The sound sources that are distributed 
to the left and right move perceptibly closer together or farther apart.

Move the slider to the left or right until you like the spatial sound experience produced.

� Inverse -
This knob serves to reverse the channels (L>R, R>L).

� Center -
Should normally be On (knob is illuminated). When the slider is positioned anywhere within the right 
half of its range, deactivating Center will remove the “virtual” center from the signal. This can serve to 
simulate a “Karaoke effect” in that it removes or suppresses the lead vocal, which is usually mixed in the 
exact center. As long as the slider is positioned within the left half of its range, the knob has no effect.
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A member of the Pinnacle TitleDeko family of character generators is part of the software bundle that comes 
with Pinnacle Liquid. 

Please note:

� TitleDekoRT is the default integrated titler.
If TitleDekoPro is bundled with the editing software, it needs to be installed separately from its CD.

� If TitleDekoPro is installed, it will be launched when you click the CG symbol. If it is not installed, stan-
dard TitleDekoRT will be launched.

� The Reveal function of TitleDekoPro is not supported in Pinnacle Liquid.

Launching TitleDeko

If you want to create a title on the correct background (recommended), start by positioning the Playline over 
the background clip on the Timeline. This clip will then be visible in TitleDeko, which will help you evaluate the 
title effect (colors, font size).

Click the “CG” tool button shown on the left to call the titler directly, or click the “Cube” icon and select it from 
the menu.

The TitleDeko window is located above the Pinnacle Liquid window: As with any Windows program, you can 
resize this window as desired.

To use TitleDeko, refer to the instructions that came with the titler (online help or the PDF file located in the 
“TitleDeko” subdirectory of the Pinnacle Liquid installation directory).

Saving Title Graphics

The Save As... function lets you save a newly created title to the default directory Titles in the Pinnacle Liquid 
installation directory, in a file with the extension *.tdk. These files are editable title graphics from which you 
can create the bitmaps (*.bmp) that are then used on the Timeline in Pinnacle Liquid. You can also save the 
*.tdk files in a different directory and under a different name.

Importing Title Graphics to Pinnacle Liquid

To import title graphics, you can now use the Save as new in Liquid (CTRL+E) function. Note that the title will 
be saved as a clip in the Rack currently selected in the Project window or, if the Project Browser is open, it will be 
saved in the Rack selected there.
The procedure using the F12 and F11 keys that was the correct procedure before Version 6 is no longer valid.
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Title as Project Metadata / Save Title Path

As of version Pinnacle Liquid 5.6, all title metadata files (*.tdk) are part of the Pinnacle Liquid Project. Thus all 
titles can be shared by several users in the network. Copies of the metadata will be used on a local level.

If you want to keep a title file, you need to save it in TitleDeko (using the Save as... function) to a directory of 
your choice. The save path selection in the Titler Settings no longer exists.

Select Titler 

- This function is not currently supported - 

If there are two or more title generators installed on your system, you may select one as the default titler which is 
called when you click the “CG” button or select it from the effect editors shortcut menu. 

To do so, open Pinnacle Liquid Edit > Control Panel > User > Titler Properties and select a titler from the list. 
(Note: Not all characters generators currently on the market are supported; please consult your Pinnacle Liquid 
dealer.)

A version 2.55 roll or crawl title which was created with discrete speed settings may play back with a 
higher speed on the Timeline (that is, with a shorter duration). To avoid this effect, modify the title’s 
length by one frame. This resets the speed to the original selection.
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What is DVD?

A DVD (digital versatile disc) is a storage medium that is almost universally usable. DVDs provide superior 
image and audio quality, are easy to handle and, above all, interactive. With DVDs, viewers can help determine 
the program - for example, by retrieving different segments on the DVD directly using one or more menus and 
without rewinding, fast-forwarding or waiting.

What is DVD authoring?

Authoring is the designing of an interactive DVD with selection menus, images, sound and graphics. 

What does Pinnacle Liquid offer in the way of DVD authoring?

Pinnacle Liquid guides you from the importing of material to its editing and authoring and all the way to burn-
ing it to DVD. The entire production process is seamlessly coordinated. You can even design the DVD menus in 
Pinnacle Liquid.

The sections below contain the following information:

Step by step DVD authoring  page 15-3

Your first project: Not just for beginners!

DVD Menu Wizard  page 15-6

Helps you generate DVD menus

How DVD authoring works  page 15-7

Basics, structure and definition of terms 

DVD authoring: Reference  page 15-11

Overview and detailed description of all the functions and features of the Pinnacle Liquid Authoring Tool

Designing DVD menus  page 15-39

Texts, buttons and backgrounds

Burning a DVD  page 15-52

How to put the finished product on a disc
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Step by Step DVD Authoring

This section describes how to create a DVD (also known as DVD authoring) by taking you through a step-by-
step example. You can use it either to get a preliminary look at the functions or to start your first DVD project 
using your own material. However, only the most important functions will be described.

1 Build a Sequence or retrieve a finished Sequence from the Timeline. 

2 Take a moment to consider the individual segments (chapters) of the Sequence: What do you want to 
offer in the first menu? Then create a few seconds of space for the menu before the first clip in the 
Sequence.

3 If necessary, render the effects.

4 Open the Project Browser (for single-monitor systems); in the Library, go to the DVD Menus Rack.

5 Select a DVD menu, drag it to a Track and drop it ahead of the first clip in the Sequence. As soon as you 
drop it, the menu jumps to a new DVD Track added at the top. The menu clip is three seconds long.

6 Open the DVD Editor (double-click the DVD menu or click the DVD Editor button in the Timeline tool-
bar).

7 Now start assigning the chapters. This is easily done by Linking each menu button (also called Link) to 
a segment of the Sequence by means of drag and drop:

�
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8 Drag Link number 1 from the Link list to the beginning of your first chapter on the Timeline. The frame 
at the Playline position is displayed in the Master View. It will be easier to position the Link at the start 
of the clip if you also press the SHIFT key to activate magnet (snap) mode.
Drop the Link on the DVD Track. This sets an Absolute Target. The Marker remains in this position even 
if you move the clip being viewed.

9 Now drag Link number 2 to the start of chapter 2, but this time drop the Link on the video clip. This sets 
an Anchored Target. If you move the clip, the Marker moves with it.

10 Distribute the remaining Links. Each time the menu button is assigned a miniature of the frame at the 
Link position (assuming you selected a DVD menu offering these buttons).

11 What do you want to happen the end of a chapter? Do you want to return to the current menu or do you 
simply want to continue playing?

12 To set a Menu Return, position the Playline at the end of a chapter and click the button shown on the 
left. A Return Marker appears on the clip.

�

�
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13 Set additional Return Markers as desired.

14 And now for the preview that lets you test the menu and check navigation. Select the Preview tab. After 
a brief delay, the menu appears in the inlay.

15 Use the arrow buttons and click OK to activate and select the buttons. You can also jump from the 
beginning of one chapter to the beginning of another.

16 If contents and navigation are correct, you’re ready to export! Call the Export to DVD module (by select-
ing Tools > DVD > Editor).

17 From the list of prepared settings select, for example, DVD Image 1 to generate a file that you can play 
with a software DVD player. It’s best to test it before you burn the DVD. If you want to burn it immedi-
ately, skip this step.

18 Make sure that the Current Sequence option is selected on the Source tab, that a suitable target directory 
for the files is specified on the Destination tab, and that the burning operation is deactivated on the 
Burn tab. Then click OK.

19 Now load the DVD image to the software player. If you’re satisfied, return to Export to DVD. Select the 
image as the Source and your DVD burner as the Destination with the desired burner speed and num-
ber of disks. Then all you have to do is insert appropriate DVD media.

Software tools are available that simulate a virtual DVD player (i.e. a DVD drive) on which you can play 
a file instead of a disc. This allows you to play back a DVD image (the *.iso file generated) on a software 
player such as WinDVD and check it before burning. These tools are available on the Internet as free-
ware or shareware.
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DVD Menu Wizard

Pinnacle Liquid helps you generate DVD menus quickly and easily with the DVD Menu Wizard, which com-
bines menu template selection with the AutoLink function, i.e. it automatically links menu buttons to audio/
video.
If necessary, you can then fine-tune your work in the DVD Editor.

1 Call the DVD Menu Wizard.
(If the toolbar above the Timeline does not already contain this button, right-click the toolbar and select 
Customize. Find the button on the Special tab and drag it to the toolbar.)

2 Follow the instructions on the screen.
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How Does DVD Authoring Work?

This section introduces the basic terminology and the basics of authoring using Pinnacle Liquid. The interac-
tivity of a DVD is the result of authoring. If you only want to export a film to DVD instead of to a DV or VHS 
tape, use Export to DVD in Pinnacle Liquid.

Follow the usual procedure to assemble your material on the Timeline. Insert a DVD menu before the start of 
the Sequence. This is the main menu that is the first to be displayed when the DVD is inserted in the player. A 
separate Track (DVD TRack) is reserved on the Timeline for this and other DVD menus:

Everything you need for DVD authoring: Timeline with clips and DVD menu,
DVD Editor (shown here with four Links)

The actual authoring procedure takes place in the DVD Editor, which you can open as soon as at least one DVD 
menu appears on the Timeline.

Authoring generally means designing the navigation structure of a DVD and, more specifically:

� Linking the selection buttons in a menu to audio/video Sequences on the Timeline;

� Designing menus and sometimes even Linking them to each other;

� Setting Return Markers in order to return to menus.

DVD Track

Link list

DVD menu clip

DVD Marker 
(target)

DV
D 

Ed
it

or

“Chapter” 1
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Essential terms:

� DVD menu -
Presents the options for a DVD and is operated from the DVD player remote (or tested in the DVD Edi-
tor’s preview mode).
- With Pinnacle Liquid, you can use menu templates and modify them or even design new menus from 
scratch.
- DVD menus are always played in a loop. 
- Menu backgrounds and menu buttons can be animated (motion menus).
- The first menu on the Timeline is the main menu (top-level menu). Most DVD remotes have special 
buttons that return you to the main menu or the previous menu from any point.
- A DVD menu is a normal clip on the Timeline that you can, for example, trim and move.
- DVD menus are always stored on the DVD Track.

� Chapter -
Chapters are AV Sequences that can be activated from the menus. Chapters normally end with a Return 
Marker back to the menu from which they were activated, but this Marker can also connect to another 
menu or chapter.
Sometimes chapters are also called “titles”.
The area between the start of the chapter and the Return Marker or new chapter is also known as a “title 
stream” or “chapter stream”.

� Link -
A Link establishes the relationship between a menu button and a chapter. In Pinnacle Liquid, each Link 
has a unique number, a name (customizable) and a “target address” which is a timecode that refers to 
the Timeline TC.

� Target -
Each Link has a target, whether it’s an Absolute Target (relating to the Timeline master TC) or an Ancho-
red Target (relating to a clip). When the clip is moved, Anchored Targets move with it while Absolute Tar-
gets retain their positions.

� DVD Marker -
DVD Markers represent the start of chapters on the Timeline and, therefore, also represent the Links and 
their targets.
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DVD Timeline Layout

You build a DVD Sequence on the Timeline just as you would any other Sequence (meaning in a linear progres-
sion from left to right). Jumps, branches and Return Markers, i.e. the Links between menus and chapters, are 
created later by means of DVD navigation.

Timeline with two DVD menus (highest Track)
Left: menu has only Links to chapters, no Return Markers; playback up to the next menu

Right: With Return Markers to menu
Note the following:
� Links currently function in a horizontal Sequence only. This means that you cannot select individual 

Tracks at a particular position on the Timeline. When clips are arranged one above the other (according 
to the usual Timeline priority), the uppermost clip is always played. As the example below demon-
strates, there is no point in jumping from the menu to chapter 3 because only the highest chapter (chap-
ter 1) is burned to the DVD (although it will includes a mix of three audio Tracks. Thus it is not 
currently possible, for example, to design a language selection by arranging a video clip with two or 
three alternative audio clips.

Timeline priority continues to apply: 
Even if you jump to Link 3 (lowest Track), the highest Track is played back
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If you integrated effects based on multilayering (such as a key or frame within a frame), the layering of 
clips naturally retains its significance.

� The Sequence remains fully editable; even the Edit Style remains activated. So when you insert clips, 
make sure that nothing is overwritten or shifted by Film Style clips because then the DVD Markers 
might no longer be correct.

� Note the DVD capacity. Especially in the case of larger Sequences, be sure to use the Export to DVD... 
module at some point to check the volume of data currently pending. This module displays a “capacity 
indicator” that tells you how much space is available on the DVD ( page 16-23).

If you want to play it safe, protect the Tracks (right-click the name field for the Track and select Protec-
ted). You can set Links at any time but be careful that you don’t accidently modify the Sequence.

� How is the DVD Sequence transferred to the DVD?
The following basically applies: The DVD starts in the same way as the Timeline, meaning that if you 
position material before the first DVD menu (such as a trailer), the person viewing the DVD will also 
have to watch this material until he or she reaches the first or main (also called top) menu. From that 
point on, the Sequence is determined by the navigation structure you created. Although the export is 
performed sequentially, this has no effect on the interactive use of the DVD.
To transfer to DVD, use the Export to DVD module.

The procedure at a glance:

Generally speaking, the entire DVD production process follows this progression:

1 Edit Sequence, render all effects (if necessary).

2 Perform DVD authoring using the DVD Editor (with menu editing, if applicable)
as described in this chapter.

3 Output Sequence by means of Export to DVD in two stages: 
- Test the DVD image using a suitable software player (optional).
- Burn and copy.
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DVD Authoring: Reference

This section describes all the Pinnacle Liquid DVD authoring functions, organized according to the tabs in the 
DVD Editor. But first a brief summary of the individual elements you will need to create a DVD:

DVD Authoring: Elements 

The basic components are as follows:

� Timeline with Sequence-
This is where you arrange the contents of the DVD, including video, audio, graphics and...

� DVD menus -
The Timeline’s DVD Track must contain at least one DVD menu (template or blank menu).
You will find DVD menus in the Project window > Library tab > DVD Menus (prepared menus that you 
can edit).
Variant: Rack shortcut menu > Create > DVD Menu (this creates a blank menu without presettings).
Then drag the menu to the highest Track on the Timeline, which automatically becomes the DVD Track.

� DVD Editor -
Click the button shown on the left or double-click a DVD menu to open the DVD Editor.
If you open it using the button, the first menu on the Timeline (the main menu) is loaded to the Editor; if 
you double-click a menu, that menu is opened.
The following tabs contain the functions for the DVD Editor.

Links tab  page 15-12

AutoLink tab  page 15-25

Highlight tab  page 15-28

Templates tab  page 15-35

Master View tab  page 15-36

Preview tab  page 15-37

Options tab  page 15-38
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Links Tab

This tab contains the basic tools for rendering a DVD menu operational. Here you can assign individual menu 
buttons to the selected image Sequences.

Each menu, which can also consist of several pages, has one Link (or chapter) list.

Depending on your computer desktop’s resolution, you may be able to switch to fullscreen mode, which 
will allow you keep the DVD Editor Master View permanently displayed (see figure below).

DVD Editor in fullscreen mode with separate Master View

Link list

Master View
Menu preview

Fullscreen mode on/off
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Link List

This list contains an overview of all the chapters and Links between menu buttons and video/audio in the cur-
rent Sequence on the Timeline. The list refers to the menu currently displayed on the right side of the Viewer.

List of all the Links for a DVD menu and the associated DVD Markers
on the Timeline’s DVD Track as well as the menu buttons

� No (number)-
These are the numbers of all the chapters/Links for a DVD menu. It corresponds to the numbering of 
DVD Markers on the Timeline (provided numeric labels are activated; see “Options Tab”  on page 
15-38).
Each number represents a selection button in the DVD menu.

� Name -
The default setting is “Chapter #”; you can edit it by slowly double-clicking the name and entering a 
designation (then press ENTER).
Or: Double-click the menu button associated with the Link, edit the text box and press Enter.
If you move a Link to a Sequence position using the mouse (drag and drop), you can automatically edit 
the name (see “Options Tab”  on page 15-38).
When you use the AutoLink functions, the chapter names are assigned automatically (for example, 
“Edit03” or “Clip08”) but you can still edit them afterwards.

� Jump to -
The Timeline timecode for the Link, the “target address”. 
To avoid “VOB problems”, make sure the Links are not set too closely together ( page 15-27). 
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� Track -
Specifies the Track to which a Link relates: In the case of an Anchored Target (with relation to a Timeline 
clip), it specifies the name of the Track on which the clip is located.
If there is no entry or this field contains “---”, it specifies an Absolute Target, i.e. a Link with a permanent 
relation to the Timeline. In this way, you can easily distinguish between target types in the list.

� Auto(play) -
this column displays an asterisk (*), if the Autoplay function was enabled for a menu button.
Autoplay causes - after a user-defined period of time - a jump to a predefined chapter (Target), if no but-
ton was pressed within this time ( page 15-23).

� All other column headings -
refer to menu button highlights (see “Highlight tab”  on page 15-28).

Right-click a Link in the list to display its shortcut menu and access the commands and options described in the 
next section. 

Commands and Tool Buttons

To the right of the Link list is a series of commands in plaintext that allow you, among other things, to assign, 
delete and move Links. You can also call these commands using the tool buttons pictured.

S e t  A b s o l u t e  T a r g e t

An Absolute Target relates to the Timeline. It remains in its position even if you move clips and other compo-
nents of the Sequence. The DVD Marker for a Link set with an Absolute Target is positioned on the DVD Track. 
The eye of the anchor is square (for an Anchored Target, it’s round).

Here’s what you do:

1 Select a Link (click it in the list).

2 Move the Playline to the desired position.

3 Click Set Absolute Target.

or

1 Select a Link (list), hold down the left mouse button...

2 ... drag the Link to the DVD Track above the desired position (the Playline moves with it; the current 
frame in the Sequence appears in the Master View) and drop it.
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The Jump to and Track columns are updated, as is the Picon associated with the Link in the DVD menu - it now 
shows the frame at the Playline/target position. If this frame is not informative enough, refer to Set Picons 
( page 15-18) to define an individual frame.

� Move the Target -
Click the Target to select it and use one of the buttons shown to reposition it (step forward or back 1 or 
10 frames).

DVD Marker and tooltip for an Absolute Target

Don’t position the targets too closely together. Keep at least ten frames between them to avoid having a 
VOB problem ( page 15-27).

S e t  A n c h o r e d  T a r g e t

An Anchored Target relates to a clip and moves when the clip is moved. This is an advantage if you edit the 
Sequence later on. The eye of the anchor is round (for an Absolute Target, it’s square).

The Marker for a Link with an Anchored Target is inserted in the clip; an anchor symbol at the beginning of the 
clip indicates that an Anchored Target relates to this clip (it is “anchored” there with relation to the clip).

A DVD Marker is also set on the DVD Track. If the clip with an Anchored Target is moved, the Marker on the 
DVD Track moves with it.

1 Select a Link (click it in the list).

2 Move the Playline to the desired position.

3 Click Set Anchored Target.

or

1 Select a Link (list), hold down the left mouse button...

2 ...drag the Link to the desired clip at the desired position (the Playline moves with it) and drop it.

The Jump to and Track columns are updated, as is the Picon associated with the Link in the DVD menu - it now 
shows the frame at the Playline/target position. If this frame is not informative enough, refer to Set Picons 
( page 15-18) to define an individual frame.
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� Move the Target -
Click the Target to select it and use one of the buttons shown to reposition it (step forward or back 1 or 
10 frames).

Anchored target with anchor symbol and tooltip

Don’t position the targets too closely together. Keep at least ten frames between them to avoid having a 
VOB problem ( page 15-27).

In rare cases, Anchored Targets in Containers and copied Sequences may have to be manually re-
assigned; also, it may happen that Anchored Targets are converted to Absolute Targets. Generally we rec-
ommend to fine-edit a Sequence before you begin DVD authoring.

C r e a t e / D e l e t e / M o v e  R e t u r n  M a r k e r

A Return Marker is a Marker that triggers a return to the menu that was activated when the Return Marker was 
created.
This means that as soon as the Playline reaches the Return Marker in the Preview, or when the finished DVD is 
played to this point, the menu is activated (without a prompt) and played so that another item can be selected.
This allows you to incorporate “loops”. Usually a Return Marker is created at the end of a chapter if no menu 
follows it.

� Create Return Marker -
Select a menu, position the Playline at the desired location and click Set return to menu.

� Delete Return Marker -
Click to select and press DEL or select Delete from the shortcut menu 

� Move Return Marker -
Hold down the left mouse button and drag the Marker to the desired location.
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Note: The Undo function does not affect Return Markers.

Return Marker at the end of a chapter

I n s e r t  A d d i t i o n a l  L i n k / R e s e t  L i n k / D e l e t e  L i n k

The more Links you set in a menu, the more options you give the DVD user. Adding and deleting Links serves to 
structure the contents of a DVD.

� Insert additional Link -
Click this button to add a blank Link to the list; this Link must then be assigned a target.
The Link is always inserted above the current (= selected) list position.
Existing Links are shifted downward and, if necessary, another menu page is added (each with the full 
default number of Links, i.e. the number of Links is the same as the number of menu buttons).

� Reset Link -
This button deletes an assigned target (removes target timecode from the list and Markers from the 
Timeline). However, the Link remains in the list and can be reassigned (Set target).

� Delete Link -
Removes the Link from the list and the DVD Marker from the Timeline. Subsequent Links are shifted 
upward.
You can use the Delete Page function to delete unassigned Links on other menu pages page by page.

� Move Link up/down -
To reposition Links within the list, click the Link in the list and then click one of the two buttons shown 
(repeating as necessary) until the Link is in the correct position.
Naturally, the menu button picons move with the Links (unless you’re using buttons without picons).
The DVD Markers on the Timeline are renumbered in the process.
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S e t / R e s e t  P i c o n

Unless otherwise specified, the Picon for a menu button contains the frame from the target point (obviously, 
this applies only to buttons that can display a Picon, also called “thumbnails”). But this frame may not be the 
best choice. To define another frame as a Picon for a menu option:

1 Scrub the Playline at the desired position (monitor the Timeline frame in the Master View).

2 Click Set Picon. 
The target timecode remains the same.

� Reset Picon -
This button deletes the selected Picon but does not modify the Link.

A n i m a t e d  P i c o n

The menu Picon does not have to be static. You can underlay all suitable menu buttons with moving images. But 
please note: This is possible only for single-page menus and buttons with alpha (“thumbnail buttons”).
Technically speaking, the image area of each Picon is keyed out (by alpha plane) and transparent to reveal the 
image behind the DVD menu. Like looking through a window.

The process for setting animated picons can either be mostly automatic or manual.

Setting Animated Picons Automatically

1 Drag the first clip (from the Rack or Project Browser) directly to the desired menu button in the inlay 
(for example, the button for Link 1).

2 This clip is inserted on the Timeline directly below the DVD menu and has the exact same length as the 
DVD menu. A Track called DVD-1 is created.

Animated picons: Video clips of the same length as the menu and below it

3 Repeat this procedure until you have assigned all the menu buttons you want.
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Please note:

� The size and position of the clips are automatically adapted in the 2D Editor (GPU realtime only!) to fill 
the menu button cutouts:

� At the mark-out, the clips are adapted to the length of the DVD menu, meaning that they are trimmed. 
The mark-in remains the same. It is best to define the cutout and length of the clip ahead of time (Clip 
Viewer, Source Viewer).

� Note that, like DVD menus, animated picons are played in a loop. For this reason, it’s a good idea to 
coordinate the first and last frame; otherwise the image will “jump” as it does in a, well, jump cut.

� You can lengthen or shorten the DVD menu. In this case, you must also trim the clips of he animated 
picons.

� In the same way (i.e. using drag and drop), you can insert a menu background. However, the menu 
background must contain an alpha plane (at least in some parts), or else you can discard the actual 
menu background and replace it with a moving image on which the buttons are then arranged 
( page 15-39).
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Setting Animated Picons Manually

1 Select a Link or select a menu button from the DVD menu, which amounts to the same thing.

2 Click Animated Picon. The image range is now replaced by a black-and-white checkered field, which is 
the usual method for displaying an alpha plane. If desired, perform the same procedure for other 
picons.

Menu ready for animated picons (black-and-white checks)

3 Exit the DVD Editor.

4 If necessary, free Tracks on the Timeline below the DVD menu so that they can contain the animated 
picons. Continue to do so until you have enough to contain all the animated picons you plan to use.

5 Insert the clips that will supply the image material for the animated picons below the DVD menu. These 
clips must be (at least) as long as the menu.

6 Now use the 2D or 3D Editor to reduce or expand the images so they can be viewed in the appropriate 
Picon fields.

7 Verify the results on the Timeline or in the DVD Editor preview.
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A d d / D e l e t e  P a g e

A DVD menu is not limited to a single page. When it has more than one page, each page belonging to the same 
menu contains one or two buttons that allow you to page forward and back.
A list box above the menu inlay lets you select and go to specific pages.

� Add Page -
This button appends a page of the same type as the menu currently selected to the last page of the menu.

� Delete Page -
This button deletes the “current” page, meaning the page whose page number appears in the list above 
the inlay or the page that becomes current when a Link is selected.
Important: This command deletes the page along with its Links, regardless of whether or not targets 
have been set.

� Move Page -
These buttons let you change the order of the pages in a multi-page menu.

S e v e r a l  D i f f e r e n t  D V D  M e n u s

It is quite possible to insert several different menus (menu templates) in one DVD project. Position each menu 
on the DVD Track on the Timeline. 
Note the following when working with multiple menus:

� Different menus, same target -
This is possible; the DVD Marker changes its assignment depending on which menu is activated.

� A specific menu relates to a specific Link list.

Changing Menus

You can change from one DVD menu to another (that is, load in the DVD Editor) as follows:

� Either use the buttons shown on the left

or 

� double-click the menu clip desired on the DVD Track.

Linking Menus

To Link different menus together on the finished DVD, simply set a Link from one menu to another (Set target) 
and, if you wish, back again. This allows you, for example, to set up a hierarchical menu structure.
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Identifying DVD Markers and Menus

When working with more than one DVD menu, it is helpful to identify menus and their Markers uniquely. You 
can do this as follows:

� Select patterns and colors -
Click a colored square above the inlay to open a palette of colors and striped patterns and select a design 
for each menu. The menu and the associated DVD Markers and Return Marker take on the same design.

Select a menu and Marker design; rename the menu
If you don’t see immediate results, activate the Use colors for DVD menus and related markers in Timeline 
option on the Options tab.

� (Re)name menu -
You can rename the active menu in the text box above the inlay or assign a name to a blank template. 
The Marker tooltips display this name as their “home menu”.

Lengthening/Shortening Menus

DVD menus are inserted on the Timeline with a default length of three seconds. You can lengthen or shorten 
them by trimming them like any other Timeline object or by specifying a value in the Timecode Field above the 
inlay. Be sure to take the Edit Mode into account (overwrite or film style).

When a DVD menu is played back in a loop, the length shouldn’t make any difference unless animated picons 
( page 15-18) requiring a specific playing time are used.

D e s k t o p / I n l a y

In addition to viewing the current menu, you can also modify or switch views in order, for example, to view and 
modify the navigational relationships of the menu buttons.

Selecting a Menu Background (Motion Menu)

You can use any moving or still image as a background but the menu background must be either fully or par-
tially transparent, or non-existant (see also “Designing Menus with the DVD Menu Editor”  on page 15-43).

� Drag a video clip or still to the desktop (inlay). A clip with the same length as the menu is inserted on 
the Timeline on a Track named DVD-B (background).

Otherwise, the same applies to a moving background as to animated picons ( page 15-18).
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You can also use this button to render a menu background (fully) transparent. If necessary, drag the button 
from the DVD Editor’s tool library.

Navigation View

Click this button to view the relationships between menu buttons. Drag the colored connecting lines to change 
the navigation structure (see also Button Navigation on page 15-48).

Highlight Collisions

Button highlights must not touch one another. If they do, this symbol flashes and you must edit the DVD menu, 
particularly by changing the distance between buttons (see also Avoiding a Highlight Collision on page 15-33).

Updating the Video

(With IEEE-1394 output only:) If you also wish to output the image to a connected TV monitor, activate the 
Video Update function. Usually the signal has to be looped through a DV device (analog output, such as the 
camera). This function slightly reduces processor performance, meaning that editing could go a little less 
smoothly.

A u t o p l a y

This function initiates a jump from a menu to a certain chapter (Target) after a predefined period of time. 
There‘s no need to activate a button. That‘s how you do it:

1 Link menus and Targets the usual way.

2 Per each menu page you can define one single button for Autoplay. After the defined period of time the 
menu automatically connects to the button’s Link (chapter).

3 Rightclick either the button in the inlay or the line belonging to the button in the Link list.

4 From the shortcut menu select Autoplay. The menu entry now displays a checkmark and in the Auto 
column of the Link list an asterisk (*) appears.

5 Enable Autoplay by clicking the checkbox above the inlay and enter the desired wait time (in seconds) 
before the automatic jump is to be carried out:

6 Use the Preview to test the function.

There can be only one Autoplay Link per each menu page. Multiple page menus can have more than one Auto-
play Link.
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E f f e c t s  w i t h  D V D  M e n u s  ( T r a n s i t i o n  M e n u )

You can also apply effects to DVD menus - e.g. after a menu button is selected, the entire menu is turned like a 
page in a book before the actual jump command is executed. Such effects are often seen on commercial DVDs. 
In this case, however, you need the menu to be a “normal” graphics clip that you can edit on the Timeline. Do 
the following:

1 First create the DVD menu with all the Links, Picons, perhaps an animated background, labels and but-
tons.

2 In the DVD Editor, go to the Options tab and in the area for the Snapshot settings select:
- Use background video (if the menu background contains moving video). Optionally select Deinterlace. 
This is recommended when the background video contains a lot of movement or when the camera was 
shaky.
- One of the Highlight options to define the Highlight status with which the Snapshot will be recorded. 
For example, Active means that the Snapshot displays the menu button with a thick red border as 
though you had actually pressed the button.

3 Click a Project Rack to select it. The Snapshot graphics will be stored here.

4 Click the menu button to which the planned effect will be applied.

5 Click the Snapshot button. 
If this button is not in the toolbar, right-click the toolbar to display the shortcut menu, select Customize 
and drag the button from the Special tab in the Library to the desired location.
When taking a snapshot of a menu with background video, the current Playline position determines 
the picture.

6 Position the Snapshot produced before the target clip (video or audio) or menu but not on the DVD 
Track. (If you intend to create a more complex effect, exit the DVD Editor.)

7 Create the effect.
For example, the menu graphics turn like a page and disappear before the video, a Wipe effect is applied 
or the graphics stall and drop downward. All the FX tools from Pinnacle Liquid are available for your 
use.

8 When the effect is finished, move the original Target of the menu button to the beginning of the effect 
(if necessary - it depends on the structure of your effect) by clicking the Target and using the tool but-
tons shown.

9 Test the results in the DVD preview. Repeat the procedure as needed for other menu buttons.

If you’re working with animated buttons or an animated menu background, you must combine the Snapshot on 
the Timeline with the associated video clips (same layering as with the DVD menu itself). 
A menu Snapshot with animated buttons contains an alpha layer with perforated areas for the video animation. 
Tip: Simply copy the clips from below the DVD menu and move them below the graphics.
For a fully or partially animated background, you must arrange the background video below the Snapshot clip.
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AutoLink Tab

These functions save you from having to position each individual Link manually. If you use them, it helps to 
have a clearly structured Sequence. For example, let’s say you have combined the chapters of your film into six 
containers. These six Links can be created in just a few seconds.

When you reuse AutoLink, the Links previously generated are overwritten.

AutoLink to clip-ins in the four Timeline clips 
(numbering refers to summary below)

1

2

3
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Basics
1 Position the menu on the Timeline, open the DVD Editor and select the AutoLink tab.

1 Display the Sequence events and TRacks.

2 Select/remove Links by clicking the check box.

3 Click Apply.

4 Select a Marker design (see “Identifying DVD Markers and Menus”  on page 15-22).

5 If necessary, go to the Links tab and click the Set Picon option to update the menu with the correct 
picons.

6 Continue editing the Links as needed on the Links tab.

Details

D i s p l a y i n g  S e q u e n c e  E v e n t s

Click the check boxes to include or exclude possible Links. To improve overview, you can also sort the list by 
clicking the column headings; for example, you can combine all Sequence Markers.

� Sequence Marker and Clip Marker -
These options display the Sequence Markers (set on the Timeline) and clip Markers. However, Links to 
Sequence Markers are generated only if at least one clip is located at the Sequence Marker position.

� Edits -
This option displays all the Edits according to the Slice bar above the Timeline.

� Clip Ins -
This option lists all possible Links to the first frame of each clip on the Timeline.
Note: If you use dissolves at the beginning of the clip, AutoLink also offers the beginning of the dissolve 
as a “clip-in” since, technically speaking, the clip starts with the first frame of the dissolve.

� Tracks and clips -
The options in this list box allow you to further refine Link selection:
...of selected clips: The list contains only the clip(s) selected on the Timeline.
... of active Tracks: The list contains only the Tracks activated for editing. Click the Track name to 
(de)activate a Track.
... of all Tracks: All Tracks are listed

� Menu range -
This option reduces the range of Links listed to those in the Timeline range up to the next DVD menu (if 
any) or up to the end of the Sequence.
If this option is not activated, all the targets possible for the Sequence are listed (i.e. including those 
located before the current menu).
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Ve r i f y i n g  L i n k s

Click a Link in the list and the Playline jumps to the associated position on the Timeline (see the Jump to 
column).

Depending on the screen resolution, the Master View may be permanently visible below the list (provided fulls-
creen mode is activated; see figure); if not, you can click the Master View tab to view the image for the Link.

V O B  P r o b l e m

DVD specifications stipulate a minimum distance of about ten frames between two DVD-related objects on the 
Timeline.

AutoLink does not perform a preliminary check to determine whether Links are being positioned too closely 
together (i.e. with less than the minimum delay) and might result in a “VOB problem”.

However, a VOB problem will be indicated by the flashing symbol shown on the left. The problem area on the 
DVD Track is identified by a vertical colored (pink) marking. Click the flashing symbol to move the Playline to 
the position of the problem and, if necessary, continue clicking it to go to all the other VOB problems.

Resolving a VOB Problem

You must create a minimum gap of at least ten frames. To do so, change the two problem Links by means of

1 Reset Link and/or

2 Set target (absolute or anchored) -
Set the target in one of the ways described above ( page 15-14). You may also have to move a clip.
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Highlight tab

Highlights outline or overlay the menu buttons and indicate the button status in a manner similar to the way the 
tool buttons in Pinnacle Liquid change when you rest the mouse pointer on them or click the command. In the 
DVD player, highlights make it easier to select menu options and navigate the menus.

Note that the highlight effect does not appear until you view it in the DVD player or a DVD simulation because 
they use the subpicture capabilities of the DVD standard.

For fast and uncomplicated highlight editing, we recommend that you use the DVD Menu Editor ( page 15-39). 
The settings on this tab correspond to DVD specifications and are primarily aimed at advanced users.

Options selected and modifications made in the Highlight tab are reset to default when a DVD menu 
template is edited in the DVD Menu Editor. We recommend to edit Highlight options as the last step in 
the process.

Highlight states  page 15-29

Subpictures 

� Theory...  page 15-29

� ... and a practical example  page 15-30

Overview of the highlight functions

� Moving a text/Picon/highlight  page 15-32

� Defining a palette and transparency  page 15-33

� Text options  page 15-34
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Highlight States
The highlight buttons in DVD menus indicate three states, and a special visual highlight is assigned to each of 
these states. For this purpose, subpictures with a particular color and transparency are used and superimposed 
on the actual button (see below). This allows you to design graphically complex buttons and interactivity, 
because if you used only the subpictures permitted by DVD specifications, the results would not be very satisfy-
ing visually.
As specified, a highlight button comprises up to four “visual layers”:

1 The button (graphics in the background)

2 Normal highlight layer 
Normally, nothing is defined here because in the unselected, deactivated state, the graphically designed 
menu button should generally continue to be visible without anything superimposed on it. For this rea-
son, all the transparency values for the pixel types are set to 100% (= fully transparent).

3 Selected highlight layer
This layer appears as color shading and/or a change in transparency whenever the mouse pointer rests 
on the button or when you have navigated to this button in the DVD menu.

4 Activated highlight layer
This layer briefly confirms its selection by displaying color shading and/or a change in transparency. It’s 
like a visual “clicking” sound.

Why Subpictures?
Subpictures are superimposed on the video and can be used on a DVD for such things as subtitles and overlays 
as well as for menu button highlights. Even when created in a graphics program, a subpicture does not really 
have its “own” colors; the colors are assigned dynamically as soon as the subpicture is played in the DVD player. 
This assignment (mapping) of color and transparency is performed on the Highlight tab.
According to the DVD specification, there are four pixel types. Only these four types are used to create subpic-
tures. The following are the names of these types as per the specification plus the designation used by Pinnacle 
Liquid:

� Background / Color 1

� Emphasis 1 / Color 2

� Emphasis 2 / Color 3

� Foreground / Color 4

These designations should not be taken literally and in other DVD authoring programs are referred to by differ-
ent names such as “Red/Green/Blue”, “Color Map #1”, etc. The designations do not necessarily have anything 
to do with “background” or “emphasis”.
Each pixel type has a color from a palette of 16 colors and a degree of transparency that is also one of 16 degrees 
ranging from fully transparent to opaque. Each menu is checked to determine which colors and degrees of 
transparency are assigned to which pixel type. Thus, the same subpicture can appear differently from menu to 
menu, at least as far as its color is concerned. 
Volume II Chapter DVD Authoring 15 - 29



PINNACLE

DVD Authoring: Reference
Example
Since this is not such a simple topic, we recommend that you start by examining the subpicture and highlight 
structure based on an example:

1 Open the DVD Editor and select any DVD menu template.

2 Go to the DVD Menu Editor and, for simplicity’s sake, delete all menu buttons except one (click to select 
and then delete).
(See also “Designing Menus with the DVD Menu Editor”  on page 15-43).

3 Click OK to exit the DVD Menu Editor.

4 Click the button shown on the left. This will allow you to move the highlight on the remaining button. 
Move it away from the button.

5 Do the same with the text. To do so, deactivate the Highlight Button and activate the Text Button shown 
on the left.
(If all three buttons are activated, including the Picon Button, you can move the entire menu button.)

6 It should now look something like this:

Menu button (left, graphics) and highlight (right, subpicture) separated

Text

Highlight

Button
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7 From the list box, select the Selected state.

8 Now select the Color 1 to 4 pixel types one after the other and assign any colors you wish in the color 
field.

9 Move the mouse pointer across the highlight and observe which areas of the highlight change.

10 For each pixel type, play with the transparency as well.
(If the slider is in the white area, the pixel type is opaque; in the black area it is fully transparent). The 
opposite of transparency is opacity. Some applications use this term.

11 Move the highlight back onto the button (completely or partially overlapping) and observe the effect of 
the transparency colors on the button’s color background.

Highlight and customized pixel types

This should give you an idea of how pixel types can influence the appearance of a button based on a color palette 
and transparency.
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Overview of Button and Highlight Functions

This section provides an overview of the highlight functions.

M o v i n g  a  Te x t / P i c o n  a n d  H i g h l i g h t

You can move a

� button text,

� button highlight and

� button Picon (menu button graphics)

either individually or as a group.
To do so, activate one, two or all three of the tool buttons shown either simultaneously or in succession.
Then click a button and move the element to the desired position.

This movement is documented in separate columns in the Link list (Links tab):

The coordinates (e.g. -35,334) have the following meaning:
The first number is the horizontal position and the second is the vertical. Negative or positive values describe 
the direction.

-h,v = moved to the left horizontally
+h,v = moved to the right horizontally
h,-v = moved up vertically
h,+v = moved down vertically

Combinations are also possible, of course. 0,0 is the initial state. The numeric values refer to pixels (video pix-
els).

To reset a button to the initial state, right-click the associated Link in the list to display a shortcut menu and 
select Reset Position Offsets.
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Avoiding a Highlight Collision

DVD specifications prohibit the overlapping of highlights. Pinnacle Liquid’s DVD Editor is provided with an 
“alarm signal” for such situations. It should be located on the toolbar when you start moving highlights.
If you don’t see it on the toolbar, retrieve it from the function Library (right-click toolbar and select Customize).

� If highlights overlap, the button flashes.

� Click the button to display the collision areas in bright red.

� The button does not stop flashing until you have corrected the highlight collision(s).

Collisions are easy to correct; simply create a little more space between the buttons (see also Designing Menus 
with the DVD Menu Editor on page 15-43).

D e f i n i n g  a  P a l e t t e  a n d  T r a n s p a r e n c y

All the buttons you need to edit the palette and button statuses are located on the left.

Tools for designing highlights

Button status

Palette/
pixel types

Transpar-
ency

Reset

Opaque Fully transparent

Color selection: Hue/Saturation/Lightness

Color selection: RGB Color select.: Pipette

Color selection: Palette

Wheel
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Button Status List Box

Begin here by selecting which of the three possible button statuses you would like to edit.

Palette and Pixel Types

You can define a color and a degree of transparency for each of the four pixel types. Click the radio button to 
select the pixel type you want to edit.

Color Selection

You will probably recognize these variations from other areas of Pinnacle Liquid. There are five ways to define a 
color:

� HSL model (hue, saturation, lightness): Move the slider across the color bars.

� RGB (red, green, blue): Enter the values directly.

� Pipette: Click, hold down the left mouse button, drag to the desired location and drop. This applies to 
the entire desktop.

� Color wheel: Move the crosshairs in the color wheel.

� Color palette: Select a color.

Transparency

Use this slider to assign a specific transparency to the pixel type selected. 

Reset

Restores the initial state.

Text Options

Sharpen Text and Emphasize text contrast- these options improve readability of text in DVD menus.
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Templates Tab

Pinnacle Liquid comes with a set of standard DVD menus. You can select one on the Templates tab and then 
customize it using the DVD Menu Editor (see also Creating and Designing DVD menus on page 15-39).

Selecting a Menu Template

If you have already opened the DVD Editor with a template, you can replace this template with a different one. 
The Links already defined are transferred to the new template along with their picons and additional menu 
pages are added as necessary.

Click a template to select it and then click Apply or press ENTER. Or simply double-click the template.

Finding Other Menu Templates

The path specified above the list of templates indicates where the templates are currently stored. If there are 
other templates in another directory, click Browse to navigate to the directory and make a selection as described 
above.

Make sure you select a directory containing templates here, and not individual menu files.

You can use menu templates from Pinnacle Impression. Photoshop files (*.psd) are also permitted as templates. 
See “Designing Menus with Adobe Photoshop”  on page 15-50.

Editing Menu Templates and Creating New Menus

See “Creating and Designing DVD menus”  on page 15-39.
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Master View Tab

The Master View shows you the image on the Timeline, thus allowing you to set targets “on sight”. When you 
define targets using drag and drop, this tab is automatically opened as soon as the mouse pointer rests on the 
Timeline and when you scrub the Timeline position bar.

If you work with a computer monitor resolution greater than 768 vertical pixels, you can activate the Master 
View permanently:

Click this button to activate fullscreen mode. If the button isn’t already on the toolbar, retrieve it from the Time-
line function Library.
Please note, however, that activating this mode will slightly reduce the size of the list box.

(With IEEE-1394 output only:) If you also wish to output the image to a connected TV monitor, activate the 
Video Update function. Usually the signal has to be looped through a DV device (analog output, such as the 
camera). This function slightly reduces processor performance with the result that, depending on your system’s 
performance capability, editing could go a little less smoothly.
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Preview Tab

A preview or simulation allows you to test the DVD Sequence before exporting and/or burning it. Most impor-
tantly, you can test menu navigation.A menu without assigned Links cannot be viewed in the preview.

Go to the Templates tab or click the button shown on the left. On the right you will see the DVD menu, initially 
played in a loop, and on the left a DVD remote reduced to the basic functions:

DVD preview

Navigating with Arrow Buttons
Start by using these buttons to select the menu buttons and then click OK to confirm your selection and execute 
the command (jumps to selected chapter).

Player Buttons
Previous/Next Chapter: These buttons let you jump from chapter to chapter in either direction without previ-
ously selecting a button in the DVD menu. The order of the chapters is based on the Timeline.

The Stop button stops play and exits the preview.

Play and Pause apply both to the DVD menu and to the chapter.

Go to menu displays the previous menu.

Clicking a Picon/Button
� Single click: enables the highlight.

� Doubleclick: jumps to the chapter linked to the Picon or button and starts playback.

Arrow buttons for
navigating in the menu

ENTER confirms selection

Previous /next chapterPlayPause Stop/Exit

Go to menu
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Options Tab

You can select from among four options:

� Show numeric labels at Timeline markers -
This option makes it easier to assign Links and Timeline DVD Markers.

� Use colors for DVD Menus and related markers in Timline -
Activating this option is especially useful if you are working with more than one DVD menu. The Links 
are then assigned more clearly to their menus (See also “Several Different DVD Menus” on page 15-21.).

� Edit label if Link is dropped on target -
Select this option only if you assign Links using drag and drop. As soon as you drop the Link, a text box 
opens in which you can specify a name. Then press ENTER.

� Auto seek Sequence to selected Link -
This option synchronizes the Playline. In other words, click a Link in the list or click a menu option and 
the Playline is automatically shifted to the correct position on the Timeline.

� Set target picons with AutoLink function -
Grabs the frame at the Target position to be used in a thumbnail button; if not selected, the Picon can 
later be set individually. AutoLink only.

� Set target text with AutoLink function -
Same as above; only that the name at the Target position will be used, e.g. the clip’s name. AutoLink only.

� Set return marker with AutoLink function -
Sets a menu return jump marker for each link set by means of AutoLink.

Menu Snapshot Settings

(See “Effects with DVD Menus (Transition Menu)”  on page 15-24.)

� Use background video -
If the menu background contains moving video. Deinterlace is recommended especially for background 
video that contains a lot of movement.

� Highlight options -
These options define the Highlight status with which the Snapshot will be recorded. For example, Active 
means that the Snapshot displays the menu button with a thick red border as though you had actually 
pressed the button. 
Volume II Chapter DVD Authoring15 - 38



PINNACLE

Creating and Designing DVD menus
Creating and Designing DVD menus

Menus are the basic interactive components of a DVD; they present the DVD contents and options available for 
selection.
Technically speaking, a DVD menu is a graphics file with an integrated navigation structure. The file can have 
an alpha channel for fully or partially transparent areas, which means it can also be animated (for example, 
with a background video).
On the Pinnacle Liquid Timeline, a DVD menu is a clip placed on a special Track (DVD Track).
When you play a DVD, the DVD player stops when it reaches a menu position and waits for a command.

This section tells you how to create and edit DVD menus using the integrated DVD Menu Editor. Other sections 
describe the creation of manual Links ( page 15-12) and automatic Links (AutoLink,  page 15-25).

Creating DVD menus  page 15-40

DVD menus on the Timeline  page 15-42

Designing DVD menus  page 15-43

Designing Menus with Adobe Photoshop  page 15-50
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Creating DVD Menus

Basically, you have three options:

� Create a blank template and, little by little, insert the contents (backgrounds, text, buttons, etc.).

� Edit one of the prepared menu templates to meet your own requirements. You can also do this using the 
DVD Menu Wizard ( page 15-6).

� Import a menu that was created by means of another application (for example, Adobe Photoshop) or a 
menu from another Pinnacle DVD product (such as Impression).

This section will provide you with detailed information, especially on the first two options for which you can 
use the integrated Pinnacle Liquid DVD Menu Editor.

Blank Template

A blank template is an empty DVD menu without buttons, background, texts, etc. In this case, you start from 
scratch and have two options:

R e t r i e v e  B l a n k  T e m p l a t e  f r o m  L i b r a r y  R a c k

1 In either the Project window or Project Browser, open the Library tab.

2 Go to the Rack called DVD Menus.

3 Drag the blank menu to the Timeline and drop it at the desired location. It doesn’t matter which Track 
because the DVD menu automatically jumps to the DVD Track. If this Track does not yet exist, it is auto-
matically created.

4 Double-click the DVD menu and continue from the section entitled “DVD Menus on the Timeline”  on 
page 15-42.

C r e a t e  B l a n k  T e m p l a t e  i n  t h e  P r o j e c t

1 In the Project window Project Browser, right-click any Rack and from the shortcut menu displayed, 
select Create > DVD menu.

2 A blank DVD menu is placed in the Rack.

3 Drag the blank menu to the Timeline and drop it at the desired location. It doesn’t matter which Track 
because the DVD menu automatically jumps to the DVD Track. If this Track does not yet exist, it is 
automatically created.

4 Double-click the DVD menu and continue from the section entitled “Designing Menus with the DVD 
Menu Editor”  on page 15-43.
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Editing a Menu Template

1 In either the Project window or Project Browser, open the Library tab.

2 Go to the Rack called DVD Menus.

3 Select one of the prepared menus.

4 Drag the selected menu to the Timeline and drop it at the desired location. It doesn’t matter which Track 
because the DVD menu automatically jumps to the DVD Track. If this Track does not yet exist, it is 
automatically created.

5 Double-click the DVD menu and continue from the section entitled “Designing Menus with the DVD 
Menu Editor”  on page 15-43.

Later on you can replace any menu with another without losing the buttons, texts or navigation simply 
by selecting a new template. If necessary, one or more pages are added to accommodate all the Links.

Importing a DVD Menu

1 In either the Project window or Project Browser, open the Library tab.

2 Go to the Rack called DVD Menus.

3 Drag the blank menu to the Timeline and drop it at the desired location. It doesn’t matter which Track 
because the DVD menu automatically jumps to the DVD Track. If this Track does not yet exist, it is 
automatically created.

4 Double-click the DVD menu to open the DVD Editor.

5 On the Templates tab, use the Browse function to open a Windows dialog box.

6 Find the directory containing the DVD menu(s) and click OK.

7 The list of available menus is displayed. To select a menu, either double-click it or single-click to select it 
and then click Apply.

8 Now continue from the section entitled “Designing Menus with the DVD Menu Editor”  on page 15-43 
(or begin immediately to assign Links).
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DVD Menus on the Timeline

Like other clips, DVD menus can be

� trimmed, 

� moved,

� deleted,

� inserted,

� grouped with other clips (helpful with animated picons),

� integrated in a Container.

However, be sure to note the Edit Style: With Film Style, you change the position of other menus on the DVD 
Track when you move or trim a menu.
Also keep in mind that the first menu on the Timeline is the main menu.

Because the DVD menu is played back in a loop, its length on the Timeline makes no difference - unless you use 
animated picons or a motion background. In this case, it can be helpful to trim the menu to the length dictated 
by the moving images ( page 15-18).
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Designing Menus with the DVD Menu Editor

You may remember the DVD Menu Editor integrated in Pinnacle Liquid from TitleDeko; the two applications 
are also related.
The elements of a menu are buttons, text, backgrounds and images. The DVD Menu Editor adds the highlights 
for interactive button navigation in the menu.

The DVD Menu Editor

Editing tool

Menu bar Character properties

Background

Menu buttons

Menu text

Title

Menu elements

Looks (selection)
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Opening the DVD Menu Editor

First open the DVD Editor (for example, by double-clicking a DVD menu on the Timeline).

Then click this button in the Editor task bar or click Edit menu. Finish by clicking OK to return to the DVD Edi-
tor, where you will find the new or edited menu.
The functions are as follows: 

Drawing and text tools  page 15-45

Character properties  page 15-45

Looks  page 15-45

Backgrounds  page 15-46

Inserting images  page 15-46

DVD buttons  page 15-46

D r a w i n g  a n d  T e x t  To o l s

� With the Arrow, you can begin by selecting the objects (by clicking) and then scale and move them. 
When you rest the mouse pointer on an object, it changes according to the functionality. For example, if 
the mouse pointer shows a rotation symbol above the highest (green) handle, you can rotate the object.

� The T lets you generate a new text object. Click the desired location and start typing.

� The Circle and Rectangle generate round and rectangular objects. You can edit surfaces, edges and shad-
ows as though they were characters (see “Character and Object Looks”  on page 15-45). Note the layers - 
objects can overlap each other either partially or completely. You can control the layer Sequence by 
selecting menu bar > Titles> Layers.

� The Crosshairs represent scaling and moving mode and are automatically activated when an object is 
selected.

� Kerning and Leading control the “a-b” tool but only in the case of text objects. Select a text object and 
use the mouse pointer to drag the text frame to the left or right and change letter spacing (= kerning).
For multi-line text objects, you can change line spacing by dragging the mouse pointer vertically (= 
leading).
Drag one of the corner handles to distort the object.

Arrow

Text tool

Rectang. object

Round object
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� The Chain and Broken Chain are tools for grouping and ungrouping objects.
Use CTRL + click to select the objects you want to group together. Then click the chain button. You can 
ungroup objects by clicking one of the group elements and then clicking the broken chain button.

� To align objects, click the button with the two horizontal arrows. Select the relevant objects (CTRL + 
click) and select the desired option from the menu (click the buttons!).

� To position objects, click this button to open a small menu. After you select an option, a selected object 
is positioned at a defined location on the desktop, such as in the upper right-hand corner.
The scale is the “safe range” indicated by the red dashed line.

These are the standard copy, cut and paste buttons, plus the trash button for deleting objects.

C h a r a c t e r  P r o p e r t i e s

These buttons should also be familiar: B for bold, I for italics and U for underline, plus the font list and font 
sizes specified in points as provided by the Windows operating system. The line button (circled in red) provides 
a menu with additional text formatting commands, such as the left/right/centered alignment of text lines.
Select the text just as you would with a word processing program (by running the cursor over the text) so that 
the changes will be applied.

C h a r a c t e r  a n d  O b j e c t  L o o k s

The first tab contains the palette of prepared looks. Click the text object to select it and then click a look. 
Or first select a look and then write the text using the text tool.
These settings also apply to rectangular and round objects which, like the characters, can be assigned a 
color, edge or shadow.

The second tab, which is the Custom tab, provides a slider by means of which you can conveniently con-
trol the Face (surface of the letters), Edge and Shadow properties.

In each case, you can select a color (blend or single color) or Transparency. Click the color box to open the color 
dialog box.

The third tab (Favorites) is intended for customized looks. Click the suitcase button to add the look currently 
designed and selected with Custom.
Volume II Chapter DVD Authoring 15 - 45



PINNACLE

Creating and Designing DVD menus
B a c k g r o u n d s

Backgrounds completely fill the edit window (full menu format). You can select a background from the 
palette (single-click it) or create a color background (full tone or blend). If you don’t want to use a back-
ground (for example, if you want to superimpose the menu buttons on a video), click the Transparency 
option.

Click the Folder button to open a Windows dialog box for opening a file. This also lets you select any 
graphics file as a background. Select the directory containing the graphics. The graphics are then loaded 

in the palette as a miniature (along with any other images found in the directory). All the usual graphics file for-
mats are accepted, including TIFF, BMP and JPEG.
If necessary, make sure that the background graphics are scaled to the correct size while also maintaining the 
aspect ratio. If you create the graphics yourself, select a square pixel format of 640*480 (NTSC) or 720*576 
(PAL) to avoid scaling.
The background files that come with the product are stored in the.../Media/DVD/Backgrounds directory of 
your Pinnacle Liquid installation.

To insert a (animated) background in the DVD Editor, drag a (video) clip to the desktop and drop it 
(drag and drop).

I n s e r t i n g  i m a g e s

Unlike backgrounds, images are not scaled automatically. Use the handles on the image object to resize it 
to your specifications and position the image wherever you want.

Click the Folder button to open a Windows dialog box and select the folder containing the image(s). The 
images are loaded in the palette as miniatures. Drag an image to the desktop.

D V D  M e n u  B u t t o n s

These buttons allow you to turn a normal title into a DVD menu. They control navigation while also 
using visual highlights, if desired.
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Button Types

Except for the menu background, any object on the desktop can be declared a menu button. Click the object 
and assign it a button type from the list:

Normal button -
The standard button, a round or rectangular object, a text button.

Thumbnail button -
A button with a miniature field containing, for example, the first frame of a video chapter (Picon). These but-
tons usually appear as picture frames, meaning that they have an area of transparency (alpha).

Previous button -
In multi-page menus, the button that takes you to the previous page.

Next button -
In multi-page menus, the button that takes you to the next page.

Not a button - 
Lets you cancel a button assignment.

Prepared Buttons

You can simply drag these buttons from the palette to the desktop where you can position and scale them as 
desired. To change the button type, click the button to select it and select the desired type from the list.

According to the DVD specification, no more than 36 buttons are allowed on one DVD menu.

To replace a button, select it and then double-click another design in the palette.

The buttons that come with the product are located in the.../Media/DVD/Buttons directory of your Pinnacle 
Liquid installation.

Arranging Buttons: Be Careful of Highlights

Be sure to leave a gap between buttons, especially if the buttons have highlights. Highlights must not overlap.

In the DVD Editor, a button highlight problem (= “collision”) is indicated by this flashing symbol. You then 
need to change the distance between buttons in the DVD Menu Editor (See also “Avoiding a Highlight Collision” 
on page 15-33.).
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Button Highlights

Highlights provide visual emphasis that makes it easier to navigate a DVD menu. For example, you can see 
which menu button you just actuated with your DVD remote (Selected status).

Highlight style -
Three styles are available: Either a box around the button’s outer edge, a highlighting of the buttons entire sur-
face (regardless of its shape) or underlining. Click the check box and one of these variants.

Button status -
Select a color and transparency (or opacity) for each status, preferably using the same values for all the buttons 
in a menu.

Button Navigation

You should always try to arrange the buttons in a menu so that navigation with the DVD remote is intuitive. 
Generally, you have four arrow buttons - Up, Down, Left and Right. When four menu buttons are arranged side 
by side, for example, this would mean the following relationships:

Navigating with arrow buttons

In the DVD Editor, you can display the relationships that were automatically assigned at the start and also 
change them simply by dragging the colored lines.
Click the button shown on the left to change the menu view along the following lines:

Navigation view (DVD Editor)

Now when you press the right arrow on the DVD remote, in this example you will be returned to the first but-
ton (as seen from the left).
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The yellow line stands for “move up” the green for the “move down” navigation button, the colors orange and 
blue for the right and left relations, respectively. To reassign these connections

1 select a button 

2 move the cursor over the button close to the line that you want modify. The cursor now looks like a bold 
arrow

3 drag the line to the desired button and drop it when the small orange box appears.

Example: to edit the “move right” relation of a button, change the orange colored line.

The Next and Previous buttons, however, have a defined relationship with the next or previous menu page.
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Designing Menus with Adobe Photoshop

You can also use Adobe Photoshop to create DVD menus with highlight but-
tons for Pinnacle Liquid. For problem-free importing of these menus, note 
the conventions below. In particular, you must ensure that the layers of all the 
graphic elements used have specific designations in Photoshop.

Background Layer

The menu background must be created in the correct format (NTSC 
720*480 pixels; PAL 720*576 pixels) with a color depth of 24 or 32 bits and 
areas of transparency defined by alpha channel. The layer names must start 
with a “(B)”. For example: (B) Background.
A second descriptive designation, such as “Background” in the example 
here, is optional.

Button Layers

The two button types are link buttons and previous/next page buttons. Each button comprises two layers:

� Button background/mask (name starting with “(#)”) 

� Highlight layer: “(^)”

The button background layers are permanently linked to the menu background and must have a 32-bit color 
depth. The mask is used via an alpha channel, for example, to permit buttons with animated picons.
According to DVD specifications, the highlight layer can have no more than four colors.

Previous Page/Next Page

In order to be able to page through multi-page menus, you must create buttons that refer to the next and previ-
ous pages. These buttons have the following structure:

� (#<) background of previous page button / (^<) previous page highlight layer

� (#>) background of next page button / (^>) next page highlight layer

Important: Previous/next page buttons must be created in pairs; otherwise the Photoshop file will not be recog-
nized as a DVD menu.

Sample level structure of a 
DVD menu in Photoshop
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Link (Menu) Buttons

The name of a link button starts with “(#...” and a digit. A particular digit can occur only once for each menu 
because the digit serves to define the link to a highlight layer. For example: (#3) Button 3.
Two variants of link button exist: static and dynamic.

� A static button has no alpha and appears in the menu exactly as it was created in Photoshop, e.g. a text 
on a colored background (“Play video 1”).

� A dynamic button (thumbnail) has a user-defined alpha layer (mask) that can be used in the DVD Edi-
tor either as a surface for a normal picon or as a key area for an animated picon. 
See also “Links Tab” on page 15-12.

Highlights 

The name of a button highlight layer starts with “(^...” and the digit of the associated background layer. For 
example: (^3) Highlight. 

DVD specifications permit a palette of only four colors for highlight layers. Since these four colors can be edited 
using the Highlight Tool in the Pinnacle Liquid DVD Editor, it makes no difference which four colors you use to 
design highlights in Photoshop. If you use more than four colors, the number is reduced to four adapted colors. 
It is generally recommended that the four colors used be as easily distinguishable from one another as possible.
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Burning a DVD

In order to save blanks and time, before exporting and burning the DVD you should test it:

� in the DVD Editor preview and

� possibly, on a software DVD player (see remarks below).

For extensive projects, you should also check the volume of data from time to time while authoring to ensure 
that the length of the program, quality requirements and medium capacity are coordinated with one another. 
The Export to DVD... module contains a data capacity indicator that tells you exactly how much of the DVD’s 
capacity you will use ( page 16-23). If space starts getting tight, you can...

� ...reduce the program length (which means shortening the Sequence),

� ...reduce the bit rate for IPB encoding ( page 16-36),

� ...or allow this decision to be made automatically ( page 16-45).

If you don’t want to deal with the details of DVD export, use one of the DVD defaults. Here is a brief overview:

1 Insert a blank in the DVD recorder.

2 Open File > Export > DVD, (S)VCD...

3 Select the DVD Image 1 (constant bit rate, MP2 audio) or DVD Image 2 (variable bit rate, PCM audio) 
Reference Set.

4 Check the Capacity Indicator.

5 If everything fits, click OK.

6 During IPB conversion, the computer is blocked. You can continue editing as soon as compiling has 
started and during the burning process.

Software tools are available that simulate a virtual DVD player (i.e. a DVD drive) on which you can play 
a file instead of a disc. This allows you to play back an image (the *.iso file generated) on a software 
player such as WinDVD and check it before burning. These tools are available on the Internet as free-
ware or shareware.
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Pinnacle Liquid provides you with several options for transferring a Sequence to another medium and for pre-
paring it for further editing or finishing on an external system:

Recording to tape

� Transferring the audio/video signal to a recorder via the digital/analog interfaces  page 16-3

� Striping tapes and recording leaders  page 16-6

Exporting Sequences

... as AVI or QuickTime Movies, MPEG2-IPB (DVD/SVCD), MXF (MPEG2-I-Frame only, MPEG-IPB), Win-
dows Media, audio WAV files or sequences of single frames  page 16-8.

Fuse Sequence 

Outputting Sequences as an MPEG/YUV/DIF etc. file  page 16-16

Export to SVCD, VCD and DVD

Create and burn DVDs, VCDs and SVCD, Elementary and Program Streams, and VOBs for 
DVD authoring  page 16-18
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Record to Tape

In the File > Record To Tape to open the corresponding window. This window has two tabs named

� Record  page 16-4

� Stripe Tape  page 16-6

and a recorder toolbar, a drop-down menu for recorder selection and the video inlay.

The timecode of the current Timeline is the master TC, because in non-linear editing the Timeline is the 
master.
Therefore, the recording tape (or master tape) needs a compatible timecode. For example: Your 
sequence starts at 10:00:00.00 hours, but the tape has been striped (coded) starting at 02:00:00.00 hours 
- record to tape in insert mode will inevitably fail.
Solution: change the Timeline TC ( page 9-50) or stripe the tape according to the Timeline TC.
Also, when you use a precoded tape to perform an insert edit, Timeline TC and tape TC need to be com-
patible, and the corresponding clip(s) have to be placed at correct position(s) on the Timeline.

Record To Tape
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Record

To transfer a Sequence to a connected recorder, click the Record tab and consider the following options.

� The Record to Tape tool requires the presence of a recording device which can be remote controlled via 
the IEEE 1394 (i.Link DV) or the RS 422 interface. 

LiquidEdition

1: Select Recording Range and Device
1 Entire Sequence or Mark-In to Mark-Out - depending on whether you want to transfer the entire 

Sequence or the portion marked on the Timeline by mark-in and mark-out.

2 Check whether the device specified in the drop-down menu bottom left is the one you wish to record 
to. If not, select another one (Control Panel > Player Setings). 

3 Render yellow slice(s) -
Check this option to initiate the rendering of all realtime effects (yellow marked slices) on the Timeline 
prior to output. This is because only rendered realtime effects can be output via IEEE 1394 (DV) 
( page 10-35). 

2: Select Recording Mode
NOTE: The selection of available recording modes depends on the remote 
interface used by the recording device (IEEE 1394 or RS 422 Betacam proto-
col) as well as on your Pinnacle Systems editing solution. 

� Select Dump To Tape and the recorder will start as soon as you click 
Record. The transfer is made to all the available tracks on the 
recorder (V, A1....D4), i.e. all tracks are overwritten.

� Select Insert and you will have to activate the desired tracks manu-
ally.
These tracks refer to the actual Tracks offered by the video format 
and recorder and not the Audio Source Tracks or Timeline Tracks. The 
choice here depends on the technical options offered by the recorder 
selected under Player Settings.

NOTE: If you´re using Pinnacle Liquid with analog I/O hardware, please take note of the following facts:

� If you would like to keep all real time effects real time, or if you want to use the analog outputs, start 
Timeline playback and your recording device manually (on the fly).

Track Selection (Insert)
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� Assemble allows you to record on a tape that was not completely precoded (striped). The tape recorder 
continues writing the Timeline timecode. No segments can be inserted by means of Assemble, since the 
exit at the mark-out most probably includes breaks in the control track. As a rule, code for a few min-
utes or even just seconds at the beginning of the tape to enable a correct cut-in scene. Should the record-
ing be interrupted, you have to continue within the coded range. 
As is the case with Dump To Tape, this option offers no track selection, i.e. all tracks available on the 
machine are overwritten.

As with all toolbars, you can also customize the recorder controls below the inlay. Right-click the tool-
bar to open the Customize box (see also Customizing Toolbars on page 17-8). 

3: Start Recording

If everything is set correctly, click Record.

� In Insert and Assemble mode, the recorder now winds the tape to the timecode position of start of the 
Sequence or the specified mark-in - minus 15 seconds preroll - and starts to record. 

� In Dump To Tape mode, the recorder starts recording immediately at the actual tape position.

� Recording stops when the end of the Sequence or the mark-out is reached. 

For Insert mode you need a precoded tape (tape that contains timecode information, see below). This is 
not necessary for Dump To Tape.

You can follow the procedure in the video inlay. Click All Stop to stop the procedure.
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Stripe Tape

In order to be able to edit in Insert mode, the recording tape must have a consistent timecode (or, in Assemble 
mode, of at least a few seconds for a first cut-in scene, respectively). You should only do without a precoded 
tape when you select the Dump To Tape option and are sure that the Sequence can be transferred to the tape in 
one run. If there are interruptions, the recorder might no longer start with a clean cut.

During coding there is a black signal at the hardware video output, or a selected Sequence as leader. 

In the case of DV devices controlled via i.Link (IEEE 1394), striping is generally neither necessary nor 
useful, since the limitations of the 1394 protocol make editing in Insert mode impossible.
Nevertheless, this function is ideal if you need a tape with a continuous timecode for camera recording. 
However, you can also achieve the same effect simply by setting the camera to “Record” with the lens 
cap on and letting the tape run.

Open Stripe Tape

Click the Stripe Tape tab to call the coding options.

Select Stripe Sequence

Choose whether you want to start coding with a specific leader. Click Select 
Stripe Sequence and from the menu that opens select the Sequence you want 
(you can make your own Sequences and store them in Project templates so 
that they are always available whenever you create a Project. The list of avail-
able Sequences is always for the current Project).
The Head Frame and the Tail Frame of the Sequence are displayed in the 
image window.

Activate this function if you want to record a special leader, color bars or 
other test signals before the actual Sequence.

As an alternative to Dump To Tape, with this method you can quickly and directly output a Sequence to 
an uncoded tape by selecting it with Select Stripe Sequence. The Sequence does not have to be on the 
Timeline. The timecode is taken from the Start Timecode field and the Sequence’s original timecode is 
ignored (RS 422 control only). 
Additionally, in contrast to Dump To Tape, the tape is rewound to the beginning for recording.
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Set Start Timecode (RS 422 only)

Enter a timecode start value in the tc field (available only with RS 422 remote controlled device connected).

Start Striping

Click Start. A dialog box opens.

Make sure that the timecode generator on your recorder is 
set to Preset (if applicable).

� Click OK or the Eject button to change the tape and then OK. 
The recorder winds the tape to the beginning and starts to 
code at the time specified under Start Timecode. 

� Click Abort to stop coding.

15 seconds of preroll are recorded in black image before 
the actual start of the coding Sequence. This preroll starts always 15 seconds before the indicated start 
of Sequence in the case of machines that are controlled via the RS 422 interface. This means that coding 
starts at the entered timecode minus 15 seconds. (On some devices controlled via i.Link, you can 
change the preroll in the device settings.) 

Master tape TC and Timeline TC

The Start Timecode for striping and the Start Timecode of the Timeline (see also Set Start Timecode on page 
9-50) are directly related. To calculate the Start Timecode for striping, take the Start Timecode of the Timeline 
and subtract the duration of the leader.
A standard leader is usually about 60 seconds of color bars with reference tone plus about 30 seconds of black 
image.
For example, if your Sequence starts at 00:02:00,00, enter a value of 00:00:30,00 (or, for example, 09:58:30,00 for 
a Sequence start at 10:00:00,00).
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Exporting Sequences

The Export Sequence As... function allows you to export and save a Sequence on the Pinnacle Liquid Timeline in 
various data formats.

Overview of formats that can be exported  page 16-10

� AVI data format 

� QuickTime Movie (QuickTime codec required)

� Windows Media Video/Audio

� Single frames in a graphics format 

� WAV file (48 kHz or 44.1 kHz) 

� MPEG2-IPB for DVD/SVCD purposes (Elementary Stream)

� MXF (Material Exchange Format, MPEG2-I Frame only, 5 - 50 Mbit/s and MPEG IPB) 

Functions in the Export Sequence dialog box  page 16-9

Exporting...

� ... Single Frames  page 16-13

� ... AVI/Quicktime Movies and/or Audio  page 16-15

Note: Selecting Export Sequence allows you to define how Pinnacle Liquid will forward the data to the 
actual export module (for example, a QuickTime codec). So if the results are not what you wanted, it 
might be helpful to check the codec parameters. 
Windows Media: Please use a recent version (7.1 or later) of the Windows Media Player to playback 
Windows media files.
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Functions in the Export Sequence Dialog Box

To export a Sequence, click File > Export > Sequence (at least one clip must be located on the Timeline). The dia-
log box is divided into five areas (from top to bottom):

Export Sequence dialog box
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Export as...

First select the export format:

� AVI Movie and/or WAV Audio

� WAV Audio (48 KHz, stereo)

� QuickTime Movie 

� MPEG2-IPB for DVD/SVCD Elementary Stream purposes; see also IPB settings,  page 16-36

� MPEG MXF (MPEG2-I Frame only, 5 to 50 Mbit/s); see  page 7-16.

� MPEG IPB MXF (generates IPB-Stream in MXF file exchange format; 
see also “IPB Settings”  on page 16-36.)

� Windows Media Video/Audio

� TIFF Sequence (frame by frame in the *.tif format)

� TARGA Sequence (frame by frame in the *.tga format)

� Bitmap Sequence (frame by frame in the *.bmp format)

The options and functions below vary greatly as a function of the export format selected.

C r e a t e  F i l e s  F o r  P i n n a c l e  I n p r e s s i o n  D V D  A u t h o r i n g

To generate a set of files suitable for DVD authoring with Pinnacle Impression, use the Export to DVD... tool’s 
IMPRESSION DVD Reference Set ( page 16-43). 
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Video

You can completely disable the export of video data.
Example: When you export AVI Movie/WAV Audio, and Video is disabled (no checkmark), pure 
WAV(44.1 kHz) export results.
Additional options:

� Size -
You can select Full Size (Interlaced/Interpolated) or Quarter Size 
(1./2.Field) or enter the desired format (h*v = horizontal * vertical).

� Square Pixel Format -
Click this option if you want the pixels generated to be square. The default is rectangular (CCIR).

Adjust Frame Rate

If this checkbox is not selected (no checkmark), the export is performed using the system’s current frame rate:

� 29.97 or 30 frames/second (NTSC)

� 25 frames/second (PAL)

If you wish to change the rate, click the checkbox and select a value from the list (15, 24, 25, 29.97, 30 fps; fps = 
frames per second).

Method lets you optimize the output for various source materials. Select:

� Cut Fields or Mix Fields -
if the source material is video (60/50 fields/second with NTSC/PAL) and 

� Mix Frames or Cut Frames -
if the source material is film (24/25 frames/second).

� Progressive -
to output non-interlaced video.

� Motion Estimation
advisable with material that contains a lot of movement (or movement caused by shaky camera). 
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Audio

In the default configuration, this checkbox is selected. Delete the checkmark if you don’t want to include audio 
in the export. 

Select the appropriate sample rate (44.1 kHz or 48 kHz).

Options

� From Mark In to Mark Out only-
This option lets you limit the export to a specific area of the Sequence.

� Options -
Displays additional codec settings as a function of the export format selected.
MPEG2-IPB export options:  page 16-36.
MPEG-MXF export options:  page 7-16.
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Exporting Single Frames

If you want to split a Sequence into single frames (images), 

1 Load this Sequence to the Timeline, if necessary select a section by setting mark-in and mark-out 
points, click File > Export > Sequence and

2 From the Export as list, select one of the three available graphics file formats: Bitmap Sequence generates 
*.bmp files, TARGA Sequence generates *.tga files and TIFF Sequence generates *.tif files.

3 Click OK to open a further dialog box and, if necessary, change to the folder in which you wish to save 
the file(s).
Enter a master name for the file(s). The system then numbers the files in ascending order.
Example: "MasterName0001, MasterName0002, MasterName0003...".

Save A Copy dialog box
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4 Click Save or OK to begin exporting the Sequence. You can view the progress of the export in the inlay 
(click the arrow button) and interrupt it if necessary.

Exporting a Sequence
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Exporting Movies/WAV Audio

To export video as AVI or QuickTime or to export WAV audio files, proceed as follows:

1 Load the desired Sequence to the Timeline, if necessary select a section by setting mark-in and mark-out 
points, click File > Export > Sequence and

2 Select the desired format from the Export as... list.

3 Then select the options described, if necessary (“Functions in the Export Sequence Dialog Box”  on page 
16-9).

4 Click OK to open a further dialog box and, if necessary, change to the folder in which you wish to save 
the file(s), enter a name and save the file(s).

5 In the next field (with an inlay if you click the small triangle in the lower left-hand corner), you can view 
the progress of the export and cancel it if necessary.

When exporting WAV, MOV or AVI, please note:

� If the From Mark In to Mark Out option is selected when you export audio WAV files, the mark-out 
must not be positioned on an “empty” location on the Timeline; instead, it must be positioned on (or 
before) the last frame of the clip to be exported.

� AVI files cannot be larger than 4 Gigabytes. This restriction is defined by Microsoft. One exception 
though: AVI OpenDML files which are generated by the Fuse process may exceed aforesaid restrictions.

� (This note refers to graphics output.) To achieve the best image quality, use “non-interlaced” (full 
frame) output material (animation, graphics, MOV films and AVI films) whenever possible. In the Pin-
nacle Liquid Effect Editors under Options > Render Options, you must select Render Frames. For export, 
select interlaced/full frame mode.
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Fuse Sequence

The Fuse Sequence function allows you to output a Sequence as an individual media file, depending on system 
hardware and actual Media Format settings, respectively. Fuse Sequence “fuses” all identical Media File types of 
a Sequence into a single file (video and audio separately), thus allowing you, for example, to operate a playout 
server via the network. Another possible application would be a video and/or audio mixdown.
Technically speaking, Fuse Sequence is merely a copy operation and is therefore relatively fast.

Sequences with mixed formats, i.e. Sequences comprising video clips with different Media Formats, can also be 
fused with the Fuse function. Therefore the Fuse process of mixed format Sequences can take longer than fusing 
single format Sequences. It may also need more storage capacity.

Prepare a Sequence  page 16-16

Check and Select Fuse Format  page 16-17

Call Fuse Sequence  page 16-17

Start Fuse Sequence  page 16-17

Preparing a Sequence

Fuse Sequence processes the Sequence currently positioned on the Timeline. Before calling and starting the 
function, check the following:

� Are a mark-in and mark-out set for partial Fuse output (if desired)?

� Are all the relevant Tracks activated for audio/video playback?
Audio: Please check the Output Mapping settings (Audio Editor) for the Fuse/Export output. These set-
tings determine the number of audio files generated during the Fuse process.

� Are integrated render effects already rendered? It is recommended that a Sequence be completely ren-
dered before you start Fuse Sequence.

Timeline clips from different compression levels are transferred in an unmodified form to the file gener-
ated by Fuse Sequence. Therefore, in the fused clip’s Properties “NDQ33” is stated by default, regardless 
of the actual composition of the fused Sequence. 
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 Check and Select Fuse Format 

Right-click on the Timeline to open the Timeline Properties dialog. The Render/Fuse Codec Presets list displays 
the currently enabled Fuse codec und file format. Usually this preset matches the selected Sequence preset: if 
HDV 720/50p is selected, the Render/Fuse codec defaults to MPEG-IPG. This means that the Fuse process needs 
no transcoding.

If you have reasons to select a different Fuse format, choose one from the list. Check wether your selection is 
supported by your product variant; see  page 8-106.

Fuse to IPB-MPEG (Elementary Stream)

In this special case the current Timeline Properties selection does not count. Instead use the Post Processing 
Module option in the Fuse dialog. Select MPEG Elementary Stream and adjust the IPB Settings ( page 16-36).

Calling Fuse Sequence

Select File > Fuse Sequence. A Save As... dialog box is now displayed containing various options. Enter the 
directory path and file names, making sure you have enough disk space. Options:

� From Mark In to Mark Out only – Activate this option if you want to output a defined range.

� Create Clip in Active Rack – Creates a clip in the active Rack as an image of the Sequence to be output. 
This clip can then be edited like any other clip and, for example, positioned on the Timeline for a mix-
down.

� Create separate audio streams -
generates a separate file for each individual audio stream; when Render/Fuse mapping is fully assigned 
up to eight. More about this topic in the Audio chapter, section Output Mapping.

� Embed audio if possible -
vaild only with “wrapper” formats such as *.avi or *.mxf: all audio streams will be integrated in the 
same file as the video stream.

� Post Processing Module with Options -
To be used when MPEG-IPB is the Fuse destination format.

Starting Fuse Sequence

Once you have entered file names and a directory path and have selected any applicable options, click OK to 
start the fuse process. A progress indicator keeps you informed of the process.
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Export to VCD, SVCD, DVD

This chapter describes the output of “DVD” material. Pinnacle Liquid offers you several options, ranging from 
the elementary stream as a basis for DVD authoring to ready-to-play DVD, provided you have a DVD burner. If 
not, you can burn a Super Video CD or use a software player to play back the files generated.

To use the DVD functions, select File >Export > Export to (S)VCD, DVD. 

Overview / Step-by-step DVD 

How to export data  page 16-19

The fast track to (S)VCD and DVD  page 16-20

Source

� Selecting source material  page 16-21

� Capacity indicator  page 16-23

Destination 

Selecting output formats  page 16-25

Burning 

Burning to CD or DVD  page 16-33

IPB Settings 

Settings for advanced users  page 16-36

Options

Fine-tuning  page 16-45
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Exporting Data

Basically, you have two options: 
Standard Sets or Custom Sets are subgroups of Reference Sets, which are generally used to group and save certain 
parameters settings. 

Use a Standard Set

Select one of the Reference Sets supplied with the product, such as DVD VOB1. Note that the Destination format 
can then no longer be changed. However, it should normally be fine to use the default parameters. 
For an overview of the standard sets, see “Reference Sets (General/Standard)”  on page 16-43

Custom Set

For advanced users or special requirements: Put together a custom set.
To do so, you must first create a new Reference Set:
1 - Click the Plus sign.
2 - Enter a name.

3 - Press ENTER or click the checkmark.
4 - Enter all the desired settings (Source, Destination, Options, etc.)

5 - Confirm these changes when necessary by clicking the Double Plus sign to save them to the Reference Set.
In this way, you can design your own customized sets.

See also “Reference Sets (IPB Capture)” on page 16-43.
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Timeline Sequence to VCD/SVCD/DVD: Step-by-step 

1 Click File > Export > DVD, (S)VCD to open a dialog box containing the four tabs Source, Destination, 
Burning and Options.

2 Create a custom Reference Set as described in the previous section ( page 16-19).

3 On the Source tab, make sure Current Sequence is selected.

4 Click the Destination tab. Select the desired format, i.e. (S)VCD if you want to write to a standard CD 
burner or DVD Image if you have a DVD burner (some DVD burners can also produce (S)VCDs).
Accept the default IPB Settings.
If desired, select Destination and Temporary Folders. If you don’t select these folders, the data is written 
to the current render drive/folder (defined when Pinnacle Liquid was installed).

5 You can leave the Audio settings as they are.

6 Insert the “burnable” medium into the burner. 

7 Click the Burning tab. Your CD and/or DVD burner should appear in the list. 
A conservative burning speed (dependent on the burner type and model) is preset; if you experience 
any problems, start by reducing the Speed. 
Click Search to refresh the list of burners. If you repeatedly insert and remove the medium, sometimes 
the burner is not detected immediately.

8 Select one of the three options from Simulate or Simulate & Burn, or Burn and click OK (checkmark). 
Depending on the medium used, the program starts an erase process before burning.

9 The progress dialog boxes keep you informed of how the procedure is progressing. You can cancel the 
entire process at any time.

10 Once the process has been successfully completed, the burner ejects the disc; in any case, a dialog box is 
displayed at the end of the procedure.
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Source

On this tab, start by defining the source material for export.

� The information field at the bottom of the dialog box summarizes your selections (Source, Destination 
and Burning).

� You can store proven or frequently used configurations in the Reference Sets list and retrieve them from 
there (see Options,  page 16-43).

� The Capacity Indicator provides an estimate of the storage space required on the destination medium 
selected ( page 16-23).

DVD: Source tab
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Current Sequence (Timeline)

If this option is activated, the Sequence currently located on the Timeline is used; if the check box below this 
option is activated, only the area between the mark-in and mark-out on the Timeline is used.

� Possible destination formats include Elementary Stream, Program Stream, Video CD, Super Video CD, 
DVD VOB file, DVD image (see Destination tab).

MPEG-2 IPB File

If this option is activated, an IPB file that you select (file extension *.m2v) is used as source material.

Click Browse to open a file selection dialog box.

In this context, “IPB” represents MPEG elementary streams. The IPB box contains a checkmark if the selected 
file is by definition an IPB file; the bit rate and number of frames are specified. These values are determined 
during the loading operation, which can take a several minutes depending on the size of the file. Use Stop, or 
load another file to cancel the counting of frames.
The resolution (h by v) and the aspect ratio is displayed.

If the file does not conform to DVD-standard 4:2:0 chroma sampling format, a warning message will appear. 

� Possible destination formats include Elementary Stream, Program Stream, DVD VOB file, DVD Image 
(see Destination tab).

DVD Image

If this option is activated, a DVD image file (file extensions *.iso, *.img, *.pid) is used as source material. The 
file size is checked (max. 4.37 GB).

� The only possible destination format is DVD burning (see Burning tab).

Path

This option is not used for burning a DVD or (S)VCD. Instead, it lets you use a CD or DVD medium for data 
storage (for example, to back up Project or media data; also see “Backing Up and Restoring Projects”  on page 
8-18). 
Find the directory that you want to back up.

The list on the Destination tab contains only the Path to DVD and Path to CD options. Select the one that 
matches your volume and medium type.

� Destination format: CD or DVD burning only (see Burning tab,).
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Capacity Indicator

The blue area of the bar indicates the space required on the destination medium by the currently selected 
source material and the green area indicates the space still available.

If the bar is completely blue with a short red line on the far right, this indicates:

� Flashing line: Capacity of destination medium was exceeded; any excess material would not be burned, 
for example, to the SVCD.

� Non-flashing line: Size was reduced by changing the bit rate or omitting frames (see Options tab, “Size 
Correction by Reducing...”  on page 16-47).

C a p a c i t y  a n d  Q u a l i t y
Depending on the destination format, you have a certain number of options for solving capacity problems. If 
you use an (S)VCD with a fixed bit rate, your choices are basically limited to shortening the Sequence or divid-
ing the Sequence into several segments (from mark-in to mark-out) on several (S)VCDs. With a DVD image, 
you can change the Bitrate (elementary stream) and GOP size (see “IPB Settings”  on page 16-36); however, this 
will affect image quality. Even your selection of an audio format affects the data rate.

Information on Compiling Data
The source data passes through various stations depending on the destination formats. 
To protect the data, the Timeline is blocked during Elementary Stream conversion (export window with video); 
afterwards, you will again have full access to your computer. Data compilation and burning do run in the back-
ground.

S o u r c e :  C u r r e n t  T i m e l i n e

1 Conversion (encoding) to Elementary Stream (ES) 
Automatic detection of TV system as PAL or NTSC, aspect ratio of 4:3 or 16:9 (depending on current 
System Settings) and video size (resolution). Generates an m2v index file.

2 Audio conversion
Destination format: DVD VOB and DVD Image:
PCM Mono to PCM Stereo (1536 kbps bit rate; 48 kHz sample rate).
Destination format: Program stream, DVD VOB, DVD Image:
PCM Stereo to MPEG-1 Layer 2 (=MP2; 192-384 kbps bit rate; 44.1 kHz (PS); 48 kHz (DVD VOB, 
Image)).
Destination: VCD, SVCD:
Multiplexing of video and audio (MP2, 44.1 kHz) to VCD-compatible or SVCD-compatible program 
streams.

3 Compiling of destination files in the selected or standard directory.
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S o u r c e :  M P E G 2  I P B  F i l e

1 Analysis of MPEG file; verification of IPB compatibility
If the file does not conform to DVD-standard 4:2:0 chroma sampling format, a warning message will 
appear. 

2 Audio conversion
Destination format: DVD VOB and DVD Image:
PCM Mono to PCM Stereo (1536 kbps bit rate; 48 kHz sample rate).
Destination format: Program stream, DVD VOB, DVD Image:
PCM Stereo to MPEG-1 Layer 2 (=MP2; 192-384 kbps bit rate; 44.1 kHz (PS); 48 kHz (DVD VOB, 
Image)).

3 Compiling of destination files in the selected or standard directory.

S o u r c e :  D V D  I m a g e

No conversions (encoding) necessary.
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Destination

On this tab, you can define a destination format and destination folder for the source material selected.
When you select a destination format, the IPB Settings dialog box is automatically displayed. You can usually use 
the default settings. For more information, see “IPB Settings”  on page 16-36.
You do not have to select destination and temporary folders; if you leave these fields blank, the current standard 
render directory or folder is used.
The list of destination formats specifies the path and file name or the directory containing the file(s) to be gen-
erated.

Elementary Stream  page 16-26

Program Stream  page 16-27

VCD (Video CD)  page 16-28

SVCD (Super Video CD)  page 16-28

DVD-VOB (Video object, Video_TS)  page 16-29

DVD Image  page 16-30

Mini-DVD Image  page 16-31

Destination Folder, Temporary Folder  page 16-31

Surround Sound (5.1 encoder)  page 16-32
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At present, DLT is not supported. For files up to 4.37 GB DVD-R can be used as pre-master.

DVD: Destination tab

Elementary Stream (ES)

This option generates elementary streams only (for all other destination formats, elementary streams are 
required and generated as temporary files).

� Video: 
MPEG-2 IPB, file extension *.m2v

� Audio: 
PCM (WAV uncompressed, 44.1 kHz or 48 kHz; file extension *.wav), or
MP2 (MPEG-1, Layer 2, compressed, 44.1 kHz or 48 kHz with different bit rates available for selection; 
file extension *.mpa).
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Select a destination directory and temporary directories (optional).

� Files generated:
[name_sequence.m2v] Video elementary stream
[name_sequence_1.wav] and [name_sequenz_2.wav] PCM Audio mono
[name_sequence_s.wav] PCM Audio stereo
For MP2 Audio only: [name_sequence.mpa] MPEG 1 Layer 2 Audio (Stereo)
[name_sequence.m2v.index2] index file

� CRC -
(Cyclic Redundancy Check) The CRC data is written to the media data and permits error correction 
when the data is read from the medium.

Program Stream (PS) 

If activated, this option generates an MPEG program stream (file extension *. mpg), including stereo audio, by 
multiplexing elementary streams.

(See also “IPB Settings” on page 16-36.)

� The available audio format is MPEG-1, Layer 2 audio (compressed, MP2 with 44.1 kHz stereo, bit rate 
selectable from 192 to 384 kbit/second.)

� This format cannot be burned to DVD/CD for direct playback.

� You can play back program stream files and m2v files (IPB elementary stream) on a software player.

Select a destination directory and temporary directory (optional).

� Files generated:
[name_sequence.mpg] MPEG Audio/Video program stream
[name_sequence.mpa] MPEG 1 Layer 2 Audio (Stereo)
Temporary: [name_sequence.m2v] Video elementary stream
Temporary: [name_sequence_1.wav] and [name_sequence_2.wav] PCM Audio mono
Temporary: [name_sequence_s.wav] PCM Audio stereo
Temporary: [name_sequence.m2v.index2] Index file

The temporary files are automatically deleted if this option is activated ( page 16-45).
For the next step, see “Compile/Start Burning”  on page 16-35.
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VCD (Video CD)

This option generates play-ready data for a video CD. The quality of the result is lower than that of an SVCD. 
VCD requires minimal hardware resources for playback.

� Video is compressed to a reduced resolution by means of the MPEG-1 procedure (PAL: 352x288; 
NTSC: 352x240). The video bit rate in the IPB Settings ( page 16-36) is also permanently set to 1.15 
Mbps. File extension is *.mpg.

� Audio is defined at a bit rate of 224 kbit/second (kbps) and 44.1 kHz. Generates a stereo audio channel.

� Direct burning to CD is possible.

Select a destination directory and temporary directory.

� Files and folders generated:
[name_sequence.mpg] MPEG Audio/Video program stream
“VCD” folder with various *.vcd files)

For the next step, see “Burning”  on page 16-33.

SVCD 

You can record about 35 to 60 minutes of video on a Super Video CD. Although the quality achieved with 
SVCD is not as high as DVD - which is also due to the lower image resolution (PAL: 480 x 576; NTSC: 480 x 
480) - you need only a standard CD burner to burn video data.

� The variable video bit rate in the IPB Settings is preset to an average of 2.4 megabit/second (maximum = 
2.5 Mbps). You can also select a constant bit rate; see “IPB Settings”  on page 16-36.

� The SVCD image resolution is automatically adapted.

� Audio: MP2 with 44.1 kHz stereo, bit rate selectable from 192 to 384 kbit/second.

� All the files necessary for burning to CD are generated in the destination folder specified.

� You can play SVCD files (extension *.mpg), for example, on the Windows Media Player.

� You can select a burner and start the entire procedure, including burning, on the Burning tab.

Select a destination directory and temporary directory (optional).

� Files and folders generated:
[name_sequence.mpg] MPEG Audio/Video program stream
“SVCD” folder with various *.svd and *.dat files

� CRC -
See  page 16-27.

For the next step, see “Compile/Start Burning”  on page 16-35.
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DVD VOB Files (Video_TS)

VOBs (video objects) are essential components of a DVD. These files contain video, audio and subtitles and can 
attain a maximum size of one gigabyte each. VOBs are ideal for further processing in an authoring system. You 
can also burn them directly (without images).

See also “IPB Settings” on page 16-36.

� Audio: MP2 with 48 kHz stereo, bit rate selectable from 192 to 384 kbit/second, or PCM.

� The file extension is *.vob. Data and subfolders (Video_TS) are stored in the destination folder selected.

� You can play VOB files with a software player (such as WinDVD, DVD Express or MS Media Player).

Select a destination directory and temporary directory (optional).

� Folders and files generated:
[name_sequence.mpa] MPEG 1 Layer 2 Audio (Stereo)
Temporary: [name_sequence.m2v] Video elementary stream
Temporary: [name_sequence_1.wav] and [name_sequence_2.wav] PCM Audio mono
Temporary: [name_sequence_s.wav] PCM Audio stereo
Temporary: [name_sequence.m2v.index2] Index file
Video_TS folder (contains VOB files, among other things)
DVD folder (contains additional subfolders with DVD-related files)
The temporary files are automatically deleted if this option is activated ( page 16-45).

� CRC -
See  page 16-27.

For the next step, see “Compile/Start Burning”  on page 16-35.
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DVD Image

You can burn a DVD image to a DVD either immediately (Burning tab) or later on.

A DVD Image (disc image) with the file extension *.iso is generated using the “UDF Bridge” (Universal Disc 
Format), which contains all the information and data necessary for burning and playing.

See also “IPB Settings” on page 16-36.

� Audio encoding: MP2 (*.mpa) with 48 kHz stereo, bit rate selectable from 192 to 384 kbit/second, PCM 
(*.wav), or AC-3 (*.ac3, Dolby Digital).

� The VOBs created during the process can be retained (the Delete temporary files option on the Options 
tab must be deactivated).

Select a destination directory and temporary directory.

� Files and folders generated:
[name_sequence.iso] DVD Image
[name_sequence.mpa] MPEG 1 Layer 2 Audio (Stereo)
Temporary: [name_sequence.m2v] Video elementary stream
Temporary: [name_sequence_1.wav] and [name_sequence_2.wav] PCM Audio mono
Temporary: [name_sequence_s.wav] PCM Audio stereo
Temporary: [name_sequence.m2v.index2] Index file
Temporary: DVD folder (contains additional subfolders with DVD-related files, including the 
Video_TS folder with the VOB files)

� CRC -
See  page 16-27.

You can then start the burning process on the Burning tab.

There are Software tools are available that simulate a virtual DVD player (i.e. a DVD drive) on which 
you can play a file instead of a disk. This allows you to play back a DVD image (the *.iso file created) on 
a software player such as WinDVD and check it before burning. These tools are available on the Internet 
as freeware or shareware.
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Mini-DVD Image 

A mini-DVD has a diameter of 8 cm and a data storage capacity of either 1.46 or 2.92 Gigabytes (double-sided). 
Its data structure is that of a full-fledged DVD. 
A Mini-DVD Image can also be burned to a CD-R/RW. However, only the usual capacity of 703 Mbytes is avail-
able.

Note: Not all DVD players can work with mini-DVD formats on CD or DVD. 

Otherwise, everything is the same as described above for DVD images.

DVD Single Stream Export And Leader Menu

In the case of a “DVD single stream export”, i.e. the export of a sequence as a DVD (not as a DVD authoring 
sequence with menus and several chapter streams), the DVD is burned with a standard menu as a leader.
In the default configuration, this is a full-format play button with a highlight mask. You can replace this menu 
with an individualized design (e.g. your company logo).
The bit map files can be found in Pinnacle Liquid’s installation directory...\Program\ as Menu_001.bmp (PAL) 
or Menu_001_Ntsc.bmp and menuMask_001.bmp (PAL) and menuMask_001_Ntsc.bmp. 
If you want to replace the files, make sure you use the exact same file name, file format and file type: *.bmp, 24-
bit, with the correct pixel resolution for your TV standard (720*480 for NTSC or 720*576 for PAL).

In case you do not want this menu to appear at the start of your Sequence, enable Autoplay (in the Option tab), 
check Once or Loop, and set the timeout duration to 0 seconds. Then the menu will not show up (more details 
on  page 16-45).

Destination Folder and Temporary Folder

Enter the folders in which you want the resulting files to be stored.
Depending on the format selected, subfolders are also created. Temporary files, i.e. data created during compi-
lation, can also be stored in specific folders and, if desired, deleted automatically (see “Options”  on page 16-45).

If you don’t specify folders, all the files are saved in the current render drive/folder (Edit > Control Panel > Site > 
System Settings > General > Rendering > Destination volume.)

All the export procedures in this application can produce large amounts of data that include temporary 
files used as an intermediate step. Keep an eye on the capacity of all the storage media involved.
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S u r r o u n d S o u n d  ( M a t r i x  S u r r o u n d ,  5 . 1 - E n c o d e r  )

This option encodes surround sound audio in a stereo signal. By employing smart technologies, this encoder 
simulates the presence of five virtual signals encoded in one real stereo signal; five distinct signals mixed down 
to two. Thus you can burn surround sound on a DVD and enjoy it when you play back the DVD.
Most DVD players can decode the special signal (look for “ProLogic2” abilities in your player), and direct all 
five surround channels to their respective speakers - Front, Left, Center, Rear Left and Rear Right. In the 
absence of a surround system or a suitable decoder the signal is played back like a standard stereo signal.

For DVD purposes you should use this option together with AC-3 sound.

You have to use the Surround 5.1 Logical Output Bus in the Audio Editor. Please read the corresponding 
sections in the “Audio” chapter of this manual.
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Burning

On this tab, you can select and operate the CD and/or DVD burners installed in the system.

DVD: Burning tab
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Selecting the Burner
Find the model in the list of all available CD burners and/or DVD burners that support the destination format 
selected. 

If an integrated, operational device does not appear in the list, you can try to locate it again by means of the 
Search function. This may be necessary if you removed CDs or DVDs from the device and reinserted them 
while the DVD dialog box was open.

� A conservative burning speed is preset for the device selected: 4x or lower, or the slowest possible speed 
of the device.
If you experience any problems, start by reducing the burning speed. If successful, increase the burning 
speed incrementally.

� The type of medium inserted and the capacity available (MB or GB) are displayed. 

Pinnacle Liquid supports burning to the following media:

� CD-R, CD-RW (658 MB and 703 MB)

� DVD-R, DVD-RW, DVD+RW, DVD-RAM, DVD+R (4.37 GB = 4.7 BB)

Simulate and/or Burn
� If you select Don’t burn, all the temporary and final files and directories are created but the burning or 

simulation procedure does not take place (default setting).

Otherwise, select one of the following three options:

� Simulate - and nothing more (not with DVD+RW)

� Simulate && Burn - medium is burned following a successful simulation (not with DVD+RW).

� Burn - immediately and without a simulation.

And to generate additional discs:

� Number of discs [1 -...] - Enter the number of identical discs you want to generate. The default setting is 
1. As soon as one disc is completed, you are prompted to insert a new disk in the burner.

Erase/Format Disc
Rewritable media can (CD-RW) or must (DVD-RW, DVD+RW) be erased before first time burning. In the 
case of DVD-RW, the erase procedure is automatically started before burning.
Quick Erase enables only a minimal erase process. If Quick Erase is not selected, the whole medium will be 
erased in a process that takes about 30 minutes.

An indicator keeps you informed of the progress of the formatting process. 
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Compile/Start Burning

Once you have entered all the settings, click OK (checkmark). Depending on the procedure, you will be 
informed of the current situation by means of various progress dialog boxes: 

1 IPB encoding (with image)

2 Compilation and multiplexing

3 Burning or simulating (VCD, SVCD, DVD-VOB and DVD Image only)

These procedures can be canceled at any time. You can continue working with Pinnacle Liquid while these pro-
cesses run partially in the background. The capacity available on the storage medium is continuously updated 
and displayed. If the remaining capacity falls below 600 MB a warning message will be displayed.
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IPB Settings

IPB Settings determine the parameters of the MPEG elementary stream (for example, the bit rate) and, there-
fore, the quality of the result. Generally you will not need to change these parameters, unless you come close to 
exhausting the capacity of the DVD or CD used or have special requirements for subsequent DVD authoring.

The IPB settings are the shared, central switches for Export Sequence > MPEG IPB and Export to DVD. IPB Set-
tings for MPEG IPB Capture in the Logging Tool differ slightly. (Not all these functions are included in all prod-
ucts). 
These settings basically determine the quality and dataset of the result to be output.

“IPB” refers to the MPEG format used here; more specifically, it refers to the sequence of I, P and B frames. IPB 
sequences form a “GOP” (Group of Pictures,  page 16-38). MPEG IPB is an elementary stream (video) and as 
such forms the basis for DVD production. 
The following is an overview of the available parameters:

IPB Settings
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Bit rate  page 16-37

GOP  page 16-38

Minimum Base Quantization  page 16-41

Additional options  page 16-41

Quality and speed  page 16-42

Reference sets (IPB capture)  page 16-43

Tips on setting it right  page 16-43

Bit Rate

According to specifications, a DVD or rather a DVD player can handle a data stream of maximum 10.08 mega-
bits per second (Mbps) all inclusive, i.e. video plus audio plus subtitles plus reserve. You must raise or lower the 
maximum video bit rate depending on what you intend to do with the files generated.
For SVCD, the maximum is 2.6 Mbps plus the audio bit rate; for VCD, the maximum is 1.150.
Naturally, the bit rate also depends on how much program you want to accommodate on a disc, but using the 
Capacity Indicator, you can easily determine the “bit budget” and optimally utilize the medium.
A bitrate that goes beyond 15 Mbit/s (possible only at ES or PS export) is automatically signed as “High Level” 
in terms of MPEG standards.
Pinnacle Liquid features three bit rate modes in the Mode selection:

C o n s t a n t  ( C B R )

A constant bit rate (CBR) ensures that each image is handled with (nearly) the same compression. This has the 
advantage of allowing you to make an exact precise calculation but it ignores the fact that some simple frame 
sequences can be encoded equally as well at a lower bit rate, meaning that you would be “wasting” bandwidth. 
This is not so important, however, if you have a lot of free space available on the CD or DVD.

CBR is recommended for destination formats which require a fixed bit rate, such as VCD.

Selecting Constant enables the Maximum slider. Use the slider to set the desired video bit rate. Maximum value: 
15 Mbps (ES); 9.8 (DVD Image, VOB). The table below lists the approximate playing times for a 4.37 GB DVD:

3.0 Mbps > approx. 120 minutes
4.0 Mbps > approx. 100 minutes
6.0 Mbps > approx. 75 minutes
7.0 Mbps > approx. 65 minutes
7.5 Mbps > approx. 60 minutes
(with PCM audio)
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Va r i a b l e  M o d e s  ( V B R )

A variable bit rate (VBR) is the answer when you have frame sequences with different degrees of complexity 
where the rate and, therefore, the compression fluctuates around an Average. When you specify a Maximum 
value, you can encode particularly fast (high motion) or complex (high detail) scenes at a higher bit rate and 
thereby increase the quality of the visual impression. 
The Average can be no higher than the maximum value currently set. Note that the average value has a greater 
influence on data throughput than the maximum value.

� Storage VBR (StorVBR) -
This mode mostly keeps the bit rate at or slightly below the selected average value, which it does not 
exceed. Recommended for most applications. In contrast to CBR both VBR modes do not encode 
“empty” bits (what‘s called zero bit stuffing).

� Statistical VBR (StatVBR) -
Select an average value and a maximum value. Generally recommended for DVD and any recording 
longer than 15 minutes. This mode supports only 4:2:0 chroma sampling and long GOPs.

The disadvantage of VBR, however, is that the fluctuating average makes it impossible to accurately pre-
calculate the size. This means that the Capacity Indicator is not altogether reliable. Also see “Size Correc-
tion by Reducing...”  on page 16-47.

GOP

GOP (Group of Pictures) relates to the sequence of I, P and B frames used for MPEG compression. I frames 
(intra-codec picture) store the contents of an image at their full resolution; P and B frames each store changes in 
the image that occur between I frame and I frame. P stands for forward Predictive pictures and B stands for Bi-
directional pictures. GOPs are very basic elements of an MPEG stream. A GOP can have the following appear-
ance:
I-B-B-P-B-B-P-B-B-P-B-B-P-B-B-I

I-frame only 

In the case of the Elementary Stream and Program Stream Destination formats: Click this option to export a 
stream consisting entirely of I-frames.

GOP Size

The GOP size (aka N value) is measured from I frame to I frame. The shorter the GOP, the more I frames with 
relation to the overall MPEG sequence; the longer the GOP, the fewer the I frames in an MPEG stream. Short 
GOPs require a higher bit rate because more I frames also means more data.
Keep this in mind if you want to modify the GOP.
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� GOP sizes:
Software Encoding (export):
- NTSC 16 (4..16); closed GOP
- PAL 13 (4..13); closed GOP
(A closed GOP ends on a P frame; an open on a B frame.)
- NTSC 18 (4..18); open GOP
- PAL 15 (3..15) open GOP
Recommended for DVD: open GOP (standard), PAL 12, NTSC 15.

� IPB-Capture (Logging Tool):
NTSC 15 (4..16); closed GOP; recommended for DVD: 15
PAL 12 (3..15); closed GOP; recommended for DVD: 12

Closed GOP Frequency 
A closed GOP ends on a P frame, an open GOP on a B frame. Here you can select between several values, thus 
toggle between closed or open GOP:

� 0-
only the first GOP is closed, all other will be open.

� 1-
all GOPs are closed. If an open GOP is closed, the current GOP size increases by +1. Exception: NTSC 
@ GOP = 18 � 16; PAL @ GOP =15 � 13

� 0 to 10-
only IPB capture: every nth GOP is closed.

(These remarks refer to a single, consistent MPEG stream.)

Reference Picture Period
Reference Picture Period (aka “M value” or “P frame distance”) defines the distance between so called reference 
frames (I and P frames). This distance is specified by the number of B frames in between + 1. If you take the fol-
lowing GOP
I-B-B-P-B-B-P-B-B-P-B-B-P-B-B-I
 as an example, you can see that Reference Picture Period was set to 3: 2 B frames + 1 = 3. 

The N value (GOP size) must be an integer multiple of the M value in order to achieve optimum quality. 
Example: M = 3, N = 12. Even N+1 can be acceptable (closed GOP).

The optimum M value depends on the image content. High M values are good for images with not a lot of 
movement and only a few scene changes.

Valid M values:

� Chroma 4:2:0 -
1, 2, 3 

� Chroma 4:2:2 -
1, 2 (4:2:2 only on ES/PS export)
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2 and 3 only with open GOP. More info on Chroma format on  page 16-41.
With Liquid blue  IPB capture (Logging Tool) the available M values differ:
1 or 3 (CBR and StorVBR); 3 (StatVBR).

Reference Picture Period and open/closed GOP sizes (Overview)

� At Open GOP a Reference Picture Period of 1 is not available.

� At Closed GOP, a Reference Picture Period of 1 and a GOP size of 1 I-frame only will be activated.

The following GOP size ranges are available (in brackets the values available at IPB capture)…

� …at Reference Picture Period of 1 
2-16 [1-15], PAL, Open GOP
2-18 [1-15], NTSC, Open GOP
1-16 [1-15], PAL, Closed GOP
1-18 [1-15], NTSC, Closed GOP

� …at Reference Picture Period of 2
2-16 [2-14], PAL, Open GOP
2-18 [2-14], NTSC, Open GOP
3-15 [2-14], PAL, Closed GOP
3-17 [2-14], NTSC, Closed GOP

� ...at Reference Picture Period of 3
3-15 [3-15], PAL, Open GOP
3-18 [3-15], NTSC, Open GOP
4-13 [3-15], PAL, Closed GOP
4-16 [3-15], NTSC, Closed GOP

Sequence Header Frequency

The Sequence Header carries information such as bit rate or frame size that the decoder needs and belongs per 
DVD specifications at the start of every MPEG stream. If the decoder does not get this information the stream 
cannot be decoded. Usually the decoder attempts to start its job at the beginning of the sequence. If this is fore-
seeably not possible, additional Sequence Headers can be inserted in the stream. Per default this value = 1. This 
means that every single GOP of a stream gets its own Sequence Header. 0 means that only one Sequence Header 
is inserted, before the first GOP of the stream.

With Liquid blue  IPB capture (Logging Tool) the value is set to 1.
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GOP Structure Samples

With different settings for GOP type, N and M values, a wide range of GOP structures is possible:

Minimum Base Quantization

This parameter influences encoding quality and ranges between 1 and 20 (theoretically it can go up to 112, but 
that would generate inacceptable results). I, B and F slider move in sync. 1 specifies the optimum quality, 20 is 
not so good, but still ok.
Default = 2 (IPB Capture = 1).

One exception: IPB Settings when accessed via the Logging Tool (not in all products) let you move the three slid-
ers individually.

Additional Options

� Detect scene change -
This is a function of the Logging Tool. On detecting subsequent video images which differ greatly from 
one another, Pinnacle Liquid acknowledges the new scene by inserting an I-Frame at the start of the 
new scene.

� 4:2:2 -
is a color sampling procedure (Chroma Sampling; see also the Glossary for more information on vari-
ous sampling methods). DV and also DVD conforming to MP@ML employs a 4:2:0 sampling, which is 
the default for all MPEG related data export. When (S)VCD or DVD is selected as the Destination for-
mat, the 4:2:2 option remains inaccesible. 4:2:2 is not in line with DVD specs.
4:2:2 generates a better quality output for use in professional post production facilities. Valid Destinati-
ons are Elementary and Program Stream exclusively, at bit rates up to 50 Mbit/s.

GOP Size GOP Type (N) RefPicturePe-
riod (M)

IPB Structure

13 Closed 3 IPBBPBBPBBPBBIPBB...

12 Closed 3 IPBBPBBPBBPBIPBB...

12 Open 3 IBBPBBPBBPBBIBB...

1 Closed 1 IIIII...

2 Closed 1 IPIP...

4 Closed 1 IPPPIP...

2 Open 2 IBIBIB...
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� Extended resolution -
Generates larger images (extended height). NTSC: 512; PAL: 608. Attention: extended resolution is not 
conforming to DVD specs. 

� Inverse Telecine (NTSC; with Liquid blue  IPB Capture only) -
Inverse Telecine makes sense only in NTSC because it reverses a “trick” used when converting from film 
(24 frames per second) to NTSC video (29.97 or 30 frames per second). In the process known as “Tele-
cine”, individual film images are duplicated at specific intervals so that the playing time of the original 
film and video do not diverge too greatly. Inverse Telecine eliminates these identical and therefore 
redundant images during compression and consequently saves space.

Quality and Speed

This feature lets you choose your preferred optimization of the encoding process: speed, storage space on the 
medium or visual quality (Liquid blue  does not support the Quality <-> Speed selection in IPB Capture).

The bit rate also plays a role. You can select:

� Best (fast)

� Good (very fast)

� Standard (fastest)

This selection influences several encoding parameters. Between levels, encoding speed increases by approxi-
mately factor 2 (or decreases, when going down).
To illustrate the interdependency of the three criteria - speed, storage, quality - it is possible to set up a small 
matrix. Note that the user’s time (or patience...) and the available space on the medium are the defining criteria, 
and the quality the result:

Storage media has 
�

User has... �

... small capacity 
(bit rate <= 4 Mbit/s)

... medium capacity
(bit rate ~ 6 Mbit/s)

... large capacity
(bit rate >= 8 Mbit/s)

... little time
selection = Standard

draft quality decent quality good quality

... sufficient time
selection = Good

near decent quality decent quality good quality

... lots of time
selection = Best

decent quality good quality very good quality
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Tips on Setting it Right

In addition to all said about quality and speed settings, we recommend to keep the following facts in mind:

� Use open GOP whenever possible because image quality from frame to frame will maintain a similar 
level.

� Use variable bit rate (VBR). CBR is a must for VCD and other fixed bit rate applications, but otherwise, 
because of “zero bit stuffing”, a waste of bandwidth.

� Highest efficiency can be achieved by setting GOP Size and Reference Picture Period (M and N values) to 
the aforementioned “integer multiple” relation ( page 16-39). Example: M = 3, N = 12. N+1 can also be 
acceptable (closed GOP).

Reference Sets (IPB Capture)

Note: In DVD Export the Reference Sets section of the IPB Settings dialog is not accessible for any selections. 
Use the general References Sets instead. IPB Reference Sets are available only via Logging Tool IPB capture.

To save specific settings so that you can reuse them later on, first click the single plus sign, then enter a name in 
the text box.
To save changes to the current settings, click the double plus sign.

The general Reference Sets that are always visible in the upper section of the dialog box record the parameters of 
the entire Export to DVD module. Up to 99 sets can be administered.

A number of standard sets (see below) contain parameters that cannot be edited (for example, the Destination 
Format is fixed). If you want to be able to edit all the parameters in the dialog box, you will have to create a new 
set. 

R e f e r e n c e  S e t s  ( G e n e r a l / S t a n d a r d )

If you don’t want to bother with individual parameter settings, select one of the standard sets. Naturally, you 
can also select a set, set each parameter individually and store additional reference sets (maximum number of 
sets = 99). As long as you use an unmodified standard set, the color of the “Reference Sets” font is dark blue.
The following is an overview:

� (Customize) -
DVD Image; StatVBR: 6 Mbps (max. 8); Audio = PCM 1536 Kbps, 48 kHz.
This set cannot be saved under a specific name.

� DVD IMAGE 2 -
DVD Image; StatVBR: 6 Mbps (max. 8); Audio = PCM 1536 Kbps, 48 kHz
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� DVD IMAGE 1 -
DVD Image; CBR: 9 Mbps; Audio = MP2 224 Kbps, 48 kHz

� DVD VOB 2 -
DVD VOB; StatVBR: 6 Mbps (max. 8); Audio = PCM 1536 Kbps, 48 kHz

� DVD VOB 1 -
DVD VOB; CBR: 9 Mbps; Audio = MP2 224 Kbps, 48 kHz

� SUPER VIDEO CD 2 -
SVCD; StatVBR: 2.4 Mbps (max. 2.486); Audio = MP2 224 Kbps, 44.1 kHz

� SUPER VIDEO CD 1- 
SVCD; CBR: 2.486 Mbps; Audio = MP2 224 Kbps, 44.1 kHz

� VIDEO CD -
VCD; CBR: 1.15 Mbps; Audio = MP2 224 Kbps, 44.1 kHz

� PROGRAM STREAM 2 -
Program stream; StatVBR: 6 Mbps (max. 8); Audio = MP2 224 Kbps, 44.1 kHz

� PROGRAM STREAM 1 -
Program stream; CBR: 9 Mbps; Audio = MP2 224 Kbps, 44,1 kHz

� ELEMENTARY STREAM -
Elementary stream; StatVBR: 6 Mbps (max. 8); Audio = PCM 1536 Kbps, 48 kHz

� IMPRESSION DVD -
Elementary stream; StatVBR: 4 Mbps (max. 6); Audio = MP2 192 Kbps, 48 kHz.
This set is specially defined for authoring with Pinnacle Impression.
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Options

This tab contains the options that are used less frequently.

Options tab
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Video

The first three options apply to DVD authoring export from the Timeline only.

� Menu still picture -
Exports an animated (motion) menu as an individual still (the first frame of the menu is frozen).

� Don’t re-encode existing MENU files -
Checks which files from previous export runs can be reused without modification and then encodes 
only the modified files, thus saving time.

� Don’t re-encode existing CHAPTER files -
Same as above.

� Autoplay -
If the current export job is the consequence of completed DVD Authoring, what you find mirrored here 
are the Autoplay settings from the DVD Editor.

� Autoplay > Once -
is an exclusive option of single stream export (not available as a result of DVD Authoring). After the 
entered Timeout period the playback of the title stream starts. During the timeout period the default 
menu is shown (see  page 16-31). At the end of the stream the playback stops.

� Autoplay > Loop -
as above; only that the whole process goes into a loop (including the menu) and starts all over again - 
and again...

� Autoplay > Timeout -
defines the duration of the default menu playback. Enter zero seconds and the menu will not show.

Audio

Same as above but applied to audio.
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Size Correction by Reducing...

In cases where the destination is (S)VCD or DVD Image and the source material coming from the current 
Timeline would exceed the capacity limit of the selected burner medium, automatic data reduction kicks in. 
The current capacity limit (DVD) is 4.37 GB.

Choose:

� Bit rate - automatically scales down the encoding bit rate to fit all data on the medium (but not below 2 
Mbps). If necessary still, phase 2 is enabled:

� Number of frames - This causes the remaining overflow to be cut off. If you choose this option from the 
outset, the preset bitrate is kept at the selected level.

The capacity information used here and in the software is based on one kilobyte ~ 1024 bytes. Thus, a 
gigabyte is 1024 * 1024 * 1024 = 1,073,741,824 bytes. Occasionally the capacity of a DVD is specified as 
“4.7 gigabytes (GB)”, but it is actually 4.7 BB (= billion bytes) because it is based on one kilobyte ~ 1000 
bytes. These 4.7 BB correspond to 4.37 GB “real data”.

Confirm whether to overwrite destination file(s)

This option causes a confirmation prompt to be displayed before an existing file is overwritten.

Delete temporary files

Depending on the source and destination format, various temporary files are generated that can be deleted 
once the export procedure is completed. If you select this option, these files are deleted automatically.

Automatically close progress dialog

This option causes the status message at the end of the DVD export procedure to be closed automatically after a 
certain period of time; otherwise, it remains visible until the user closes it.

Close opened burner tray after successfully burning a disc

This option saves you the trouble of closing the burner tray manually.
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Pinnacle Liquid adapts itself to your way of working - not the other way around! You can customize the soft-
ware interface as well as assign functions to peripherals such as the keyboard or Liquid Control  as desired. 
Each user can individually optimize his or her working environment, store it on a diskette and use it on other 
Pinnacle Liquid systems. 

At the same time, certain settings are dependent on the particular system configuration or studio environment. 
For this reason, Pinnacle Liquid makes a distinction between User Settings and Site Settings:

User Settings  page 17-3

These include all settings that can be linked to a specific user name. 

� Basics and definition of terms  page 17-3

� Managing property sets  page 17-5

� Customizing toolbars  page 17-8

� Customizing the keyboard  page 17-11

� Keyboard shortcuts  page 17-15

� Assigning keys for Liquid Control   page 17-18

� Network settings  page 7-26 

Site Settings 

These are settings that apply to the specific system and its environment regardless of a specific user.

For more information, refer to the separate product manual supplied with your editing system.
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User Settings

Basics and Definition of Terms

Pinnacle Liquid comes with six standard toolbar assignments and specific default settings in other 
modules as well.  page 4-3

You can always restore the default settings, for example by logging on to the system under one of the defaults or 
by resetting the values in specific modules (see the tool button shown here).

What Is Saved?

Pinnacle Liquid constantly notes changes made to the software interface and dialog boxes. This means if you 
were logged in under a certain user name, your configuration (settings upon closing the software) is immedi-
ately activated when you log in again under the same name. Your configuration contains information on the last 
open Project, the position of the windows on the desktop, the views, size of the Timeline Tracks, toolbar setup, 
etc. 

In addition to all this configuration data saved in a user profile, property sets are also available for logged-in 
users to choose from.

What Are User Profiles?

When logging on, you can identify yourself as a specific user. If no User Profile exists for you, a new one is cre-
ated. If you want to change the configuration of the Pinnacle Liquid software by changing to another user, you 
have to close Pinnacle Liquid desktop and then log in again under the other name (to activate a different Pro-
file). When closing Pinnacle Liquid (File > Exit Pinnacle Liquid), the system asks you whether you want to log 
in under a different name. See “Logging on As an Existing User” on page 4-3.)

Property Sets

Property sets are used for adapting Pinnacle Liquid modules to your particular needs. For example, you can 
customize the key assignments of Liquid Control  and your computer’s keyboard. You can also switch 
between Property Sets during a given session to accommodate the demands of different tasks. Every user can 
create an unlimited number of Property Sets.
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Templates

Pinnacle Liquid offers two other types of Templates: Project Templates and Timeline Templates. These Templates 
are available to all users. Project Templates can be loaded when you create a new Project. Timeline Templates are 
available once you have opened a Project. (“Project Template”  on page 8-5 and “New Sequence from Template”  
on page 9-50.)

User Profile A

User Profile B

Property Sets

Property Sets

Toolbar and other 
settings

Toolbar and other 
settings

Project/Timeline Templates
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Managing Property Sets

Using Property Sets, you can quickly change user settings. 

Calling Property Sets

Select Edit > Control Panel.

The Control Panel is used for adjusting the main hardware and software settings. Pinnacle Liquid manages two 
types of Property Sets: Site (system-related settings) and User (user-related settings). These categories are 
divided up between the two tabs on the left side of the Control Panel. The area on the right side of the Control 
Panel window contains the icons of configurable hardware and software modules (called Property Items or 
modules). To “manage” sets means to create, load and delete them.

Control Panel with tabs and configurable modules (on right)
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Available Property Sets

The User tab is used for managing Property Sets created by logged-in users. In this tab you can save and load the 
settings for individual tasks, such as logging, raw editing, final editing and audio editing. The User tab typically 
contains the following modules:

� Keyboard Assignments  page 17-11

� Key assignments of Liquid Control  ( page 17-18)

� Project Properties  page 8-16

� Timeline Properties  page 9-7

� Logging Tool  page 6-7

� Graphics import global settings  page 6-49

� Audio Settings  page 13-67

� Media Management  page 8-97

� Network Settings  page 7-26

� Titler selection page 14-1

Where are Templates and Property Sets Saved?

Pinnacle Liquid saves Sets, Timeline Templates and Project Templates in certain directories on the system hard 
disk. Use Windows Explorer or another file management program to access these files if you need to.

� Timeline Templates have the “vmf ” extension added to the name you saved them under. Timeline Tem-
plates are saved under: [Pinnacle Liquid program path]...\Templates\.

� Project Templates are saved under: [Pinnacle Liquid program path]...\Templates\ “Template Name” \ 
File name extension: *.template

� Property Sets are saved under: [Pinnacle Liquid program path]...\User\ “User Template Name” \ Set-
tings \ “Property Set Name(s)”

Please note that you may have to copy entire folders with all subdirectories in order to have all necessary 
data. This is more important, for example, with Project Templates which have a more complex structure 
than Timeline Templates which only consist of one file.
Volume II Chapter Customize Pinnacle Liquid17 - 6



PINNACLE

User Settings
Creating New Property Sets

Depending on the category under which you want to create the new property set, first select the appropriate tab 
(Site or User). Right-click the list box. From the shortcut menu that opens select New Property Set. Pinnacle Liq-
uid inserts a set with the temporary name New Set into the list box. 

A c t i v a t i n g  S e t s

The active set has a check mark in front of its name. Click in front of the set name you want to become active 
and the check mark moves accordingly. 

Close the Control Panel to activate the set.

D e l e t i n g  S e t s

To delete a property set right-click the set name and select Delete. 

R e n a m i n g  S e t s

To change the name of a property set, right-click the name of the set, select Rename, type the name required 
and then press ENTER. 
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Customizing Toolbars

Many modules in Pinnacle Liquid are equipped with functions and toolbars that you can access with the 
mouse.

Customizing toolbars

You can define which functions will be included in the toolbars and the order in which they will appear on an 
individual basis  page 17-8

Calling tools once

You can call functions that are not often used from the Customize menu to execute them once  page 17-10

Customizing Toolbars

Customizable toolbars in the Sequence Editor
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1 Right-click a toolbar to find out whether it can be customized.

2 In the shortcut menu that appears, click Customize to open a dialog box with usually one to three tabs: 
Player, Edit and Special. Which tabs appear depends on the software module. The buttons that can be 
integrated in the particular toolbar you are using are available on the tabs.

Tool box: Player tab with tool buttons

To make changes to a toolbar, the Customize tool box has to be open:

3 Adding Tools: Drag the buttons from a given tab to the toolbar. The buttons already on the toolbar are 
shifted to make room for the new buttons.

� Removing Tools: Drag unnecessary buttons from the toolbar to the box or desktop to remove them from 
the toolbar; the mouse pointer turns into a Trash icon as soon as you are in an area where the element 
can be safely dropped. Buttons are not deleted - they are always available in the Customize box.
You can even have more than one copy of a button on the toolbar. Every button maintains its function, 
regardless of its position on the toolbar.

� Moving Tools: You can move the buttons on the toolbar as long as the Customize box is open. When you 
click a button, a grey box appears around it, indicating the actual size of the button. This shows you the 
invisible gaps for spacing buttons.

� Grouping Tools: To arrange buttons in groups, slightly push one button against another. This creates a 
narrow dividing line at the border(s) of this group.
When you remove a button from a toolbar the remaining buttons move together to fill the gap. The Spe-
cial tab contains gaps of various sizes for creating spaces between buttons.

4 When you are finished arranging the buttons, click Close. This saves the changes you made to the cur-
rent User Profile ( page 17-3).

You cannot access buttons that are forced out of the toolbar area when you add new buttons. To make 
room for existing buttons as well as new ones, you may have to remove some other buttons or spacing 
elements.
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Calling Tools Once

Tools that are not often used do not have to be placed on the toolbar to call 
them once. Click on the right side of the toolbar to open a shortcut menu:

Select the desired function from the list of tools. This function is carried out 
immediately and only once. A tool symbol is not placed on the toolbar. The 
first menu level reflects the arrangement of the toolbox in the tab (Player, 
Edit, Special...).
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Assign Functions to Keyboard

In Pinnacle Liquid, you can assign certain functions to certain keys. You can select whether 
these functions should only be effective in certain modules or whether they should be avail-
able everywhere (placed on the Global Layer). For example, you can specify that pressing 
the spacebar always executes Start/Stop Playback for the Timeline even while you are work-
ing in the Audio Editor. In addition, you can assign menu commands to keys.

This section covers the following topics:

Assignment layers  page 17-11

Selecting modules  page 17-12

Removing a function  page 17-13

Customizing the Global Layer  page 17-13

Key Caps  page 17-14

Modifier commands  page 17-15

Assignment Layers

There are two types of layers:

� Keyboard shortcuts valid only in modules (Master Viewer, Audio Editor, Logging Tool etc.).

� Global keyboard shortcuts which have the same function no matter what module you are in (Global 
Layer). However, if you assign a different function to the same key within the same module, this func-
tion takes precedence.

If a key is assigned two different functions, the module-specific function takes priority over the Global 
Layer function.
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Selecting Modules

1 Select Edit > Control Panel > User > Keyboard Settings to open a dialog box.

2 It is easy to assign keys: To do so, first select from the drop-down menu the software module you want 
to customize, then simply drag the desired functions from the tool box to the given keys (to open the 
tool box, click on the wrench icon in the lower left). Assignable keys appear “pushed” when you move 
the cursor over them. You cannot assign functions to certain reserved keys.
To assign the SHIFT, ALT and CTRL layers, hold down the desired key on the keyboard while placing the 
function. These software modules can be customized:

� Source Viewer, Master Viewer, Clip Viewer, Logging Tool, Trim Editor, Record to Tape, all Effect Editors

� The function icons are found in the tabs which vary from module to module.

� Functions executed from a shortcut menu, instead of an icon, are listed at the very right in the tab. 
When you drag such a function to a key, a “T” appears. The function name is displayed when you place 
the cursor on the key.
See also “Key Caps” on page 17-14.

Key assignments for modules
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Remove Function from Key

To remove a function from a key, click on the key and press DEL (or click on the Trash icon). Functions are 
never deleted permanently - they are always available in the tool box.

Customizing the Global Layer

Global keyboard shortcuts always have the same function, irrespective of what module is currently active.
Important: If a key is assigned two different functions, the module-specific function takes priority over the Glo-
bal Layer function.

You can enable and disable the Global Layer in its entirety. To assign global functions to keys, do the following:

1 Select the Global Shortcuts option from the drop-down menu on the left.

2 Click on the Global Shortcuts active checkbox.

3 Click on the wrench icon to open the tool box.

4 From the drop-down menu on the right, select the available modules for global layer functions.

5 Drag the desired functions to the desired keys.

The functions from the various modules are color-coded so you can easily recognize the assignment.

Keyboard assignments for the global layer
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Key Caps

Click on this icon displayed in the right-hand corner of the task bar to open the Key Caps window which shows 
the current keyboard assignments. This window contains a keyboard image with the assignment for the current 
module. 

You can execute functions by clicking on the respective key icon.

Global layer functions are color-coded.

Individual assignments: see “Assign Functions to Keyboard”  on page 17-11.

Key Caps window (Master Viewer assignment sample)
Volume II Chapter Customize Pinnacle Liquid17 - 14



PINNACLE

User Settings
Modifiers and Keyboard Shortcuts (Defaults)

The default keyboard shortcuts allow you to activate the most frequently used functions. For example, you can 
start and stop the playback of video and/or audio clips in any video inlay by pressing the SPACEBAR.

Please note that the keyboard shortcuts are default settings that come with the software. The actual functions 
may differ from those listed here because it is possible to assign functions to certain keys as described in the 
previous section (“Assign Functions to Keyboard”  on page 17-11).

The US keyboard layout is the reference keyboard for default key assignments

All keys referred to in this manual are based on the above shown keyboard (US keyboard layout).
If you are working with a different type of keyboard, the keys may be labeled differently, but their func-
tions remain the same. 
In other words, keyboard shortcut assignments are based on the physical keys and not how they are 
labeled.

Modifier Commands

Modifier commands are used to switch between different mouse modes. Hold down the indicated key(s) and 
drag, click etc. the mouse.

NOTE: In Windows the key sequence Alt + Shift is by default used to toggle “Input Locales”, i.e., among other 
things, to switch keyboard layouts. Since some Pinnacle Liquid keyboard shortcuts make use of the very same 
keyboard sequence, we recommend that you disable that sequence.
To do so, right-click the language symbol next to the Windows taskbar clock. In the Regional Options dialog, 
click the Input Locales tab, and in the Hot Keys for Input Locales area click Change Key Sequence. Next, disable 
or change the sequence.
Alternative procedure: Windows Start menu > Control Panel > Regional Options > Input Locales.
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T i m e l i n e

A c t i o n s
Ke y  o r  
K e y  
C o m b i n a t i o n

Snap object/Playline to closest edit SHIFT

Drag up/down to zoom in/out ], ARROW 
DOWN/UP

Scrub audio (toggle on/off) SCROLL

To copy Track, drag up/down CTRL

Switch to cursor Edit mode (temporarily) ALT

A c t i o n s  ( o n l y  i n  e d i t  m o d e )

Click objects to select several items SHIFT

Switch to Scrub mode (temporarily) ALT

S e q u e n c e  E d i t o r

Ac t i o n
K e y  o r  
K e y  
C o m b i na t i o n

Drag clip from Source Viewer CTRL

Scrub audio (toggle on/off) SCROLL

Drag Mark-In/ Mark-Out Alt
Volume II Chapter Customize Pinnacle Liquid17 - 16



PINNACLE

User Settings
Keyboard Shortcuts 
Use Pinnacle Liquid’s Key Caps function ( page 17-14) to obtain an overview of current key assignments. 

E f f e c t  E d i t o r s

A c t i o n s K e y  o r  K e y  C o m b i n a t i o n

Double-click returns image to original state

Po s i t i o n  b u t t o n  s e l e c t e d

Horizontal movement only SHIFT

Vertical movement only CTRL

S i z e  b u t t o n  s e l e c t e d

Drag up/down to adjust image size SHIFT

R o t a t i o n  b u t t o n  s e l e c t e d

 90-degree increments only SHIFT

45-degree increments only Ctrl

B o r d e r  i n s i d e  t o o l  s e l e c t e d

Drag up/down to adjust border size SHIFT

Pick border color from image ALT

B o r d e r  o u t s i d e  t o o l  s e l e c t e d

Drag up/down to adjust border size SHIFT

Pick color from image ALT

S h a do w  b u t t o n  s e l e c t e d

Drag up/down to adjust transparency SHIFT

Pick shadow color from image ALT

A n y  b u t t o n  s e l e c t e d

Toggle temporarily to Position tool SHIFT + CTRL
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Liquid Control Assigning Keys 

You can access these settings under Edit > Control Panel > User > Control Panel.

Liquid Control  is an control panel for remote control of the player/recorder connected. You can assign 
customizable tools to its keys. 
A Global Layer can also be defined (just like for the keyboard). 
See also “Customizing the Global Layer” on page 17-13.

Control Panel

Dialog Box Customizing: Control
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Assign Keys

1 From the menu bar, select Edit > Control Panel > User > Control Panel to open a dialog box.

2 To assign functions to the keys, first select a module form the list, e.g. Timeline/Master Viewer or Log-
ging Tool.

3 Then use the same procedure as for customizing toolbars: simply drag a given function to a particular 
key. 
It is also possible to assign shortcut menu functions to keys. These are represented by a “T”.

4 The two lowest keys function as SHIFT (right) or CTRL key (left). Functions can now be assigned to the 
seven upper keys on two further levels. Keep the SHIFT or CTRL key pressed while assigning functions 
to the keys.

If you attempt to make an unauthorized assignment, the function you are dragging turns into the Trash icon 
and cannot be dropped on the key.
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1 0 8 0 / 2 4 p  

One of the possible formats within the 
�DTV standard developed by the 
�ATSC for the digital broadcasting of 
TV programs in the US.
1080/24 p stands for the vertical reso-
lution of 1080 lines and an aspect ratio 
of 16:9. 

The addition 24 p determines the 
image frequency of 24 frames which 
corresponds to the exact image fre-
quency commonly used in film record-
ing and Projection.

Thanks to 24p systems planned by the 
industry, it will, in the future, be possi-
ble to represent movies without the 
�3:2 PULL-DOWN used for NTSC at an 
image rate corresponding to movie 
pictures on a DTV-compatible home 
device.

1 6 : 9  

In contrast to the aspect ratio of 4:3 
most commonly known in the field of 
TV, 16:9 offers a wider picture. Mod-
ern TV systems such as �PALPLUS or 
�HDTV prefer this wider picture.

16:9 supporters state that the wider 
picture corresponds much better to the 
human visual field than the almost 
square ratio of 4:3.

Many recording and post-production 
devices can nowadays be switched 
from 4:3 to 16:9.

3 : 2  P u l l - D o w n  

For a movie picture, 24 images per sec-
ond are usually exposed in the camera 
and Projected at the same image fre-
quency. This, however, causes prob-
lems as soon as the picture is scanned 
for later video editing, since video sys-
tems use different image frequencies. 

�NTSC works with 525 lines and 60 
fields. The 3:2 pull-down is used dur-
ing film scanning to receive 60 video 
fields from 24 film images. 3 video 
fields are generated from the first film 
image, 2 from the second, and so on. 
This results in (12 x 3) + (12 x 2) = 60 
fields per second. 

4 : 1 : 1  

The �SAMPLING RATIO used for a 
video format is commonly indicated as 
a ratio between a brightness signal 
(�LUMINANCE SIGNAL,�Y) and the 
two �COLOR DIFFERENCE SIGNALS 
(�CHROMINANCE SIGNAL, �R-Y, 
�B-Y).

In the ratio 4:1:1, values for Y, R-Y and 
B-Y are generated for each line of the 
video image. Four times as many Y-
values than color values are available. 
In comparison with the sampling ratio 
4:2:2, the horizontal chroma resolution 
is reduced to 50 %, whilst the vertical 
chroma resolution remains the same. 
The video format DVCPRO developed 
by Panasonic uses the sampling ratio 
4:1:1.

4 : 2 : 0  

The �SAMPLING RATIO used for a 
video format is commonly indicated as 
a ratio between a brightness signal 
(�LUMINANCE SIGNAL, �Y) and the 
two �COLOR DIFFERENCE SIGNALS 
(�CHROMINANCE SIGNAL, �R-Y, 
�B-Y).

In the ratio 4:2:0, the Y-signal is regis-
tered in each line, whereas only one of 
the two color difference signals R-Y or 
B-Y are registered alternately from line 
to line. In comparison with the sam-
pling ratio 4:2:2, the vertical chroma 
resolution is reduced by 50 % whilst 
the horizontal chroma resolution 
remains the same. The �DV FORMAT 
and the DVCAM format, a further 
development by Sony, as well as 
MPEG-2 MP@ML use the ratio 4:2:0.

4 : 2 : 2  

The �SAMPLING RATIO used for a 
video format is commonly indicated as 
a ratio between a brightness signal 
(�LUMINANCE SIGNAL, �Y) and the 
two �COLOR DIFFERENCE SIGNALS 
(�CHROMINANCE SIGNAL, �R-Y, 
�B-Y).

In the ratio 4:2:2, two complete color 
values consisting of the color differ-
ence signals R-Y and B-Y are available 
for four Y-values each. The chroma 
resolution of formats using 4:2:2 is 
twice as high as that of formats with 
4:2:0 or 4:1:1. This fact is of particular 
importance in �POST PRODUCTION, 
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e.g. when �CHROMA KEYS or �LAYER-
ING is supposed to be carried out. 

D9 by JVC, Digital Betacam by Sony 
and DVCPRO50 by Panasonic as well 
as MPEG-2 422 P@ML are just some of 
the formats using 4:2:2.

4 : 2 : 2 : 4  

This �SAMPLING RATIO corresponds 
to 4:2:2 but includes an additional 
�KEY SIGNAL (�ALPHA CHANNEL) 
with a �RESOLUTION as high as the Y-
signal.

4 2 2 P @ M L  

�MPEG

4 : 4 : 4  

The�SAMPLING RATIO of the�LUMI-
NANCE SIGNAL (�Y) and the two 
�COLOR DIFFERENCE SIGNALS 
(�CHROMINANCE SIGNALS, 
�R-Y, �B-Y) used in a video format 
or the ratio of color components 
within the �RGB COLOR SPACE are 
commonly indicated by a ratio. 

4:4:4 means that the three components 
of the video signal were registered with 
the same �SAMPLING RATIO of 13.5 
�MHZ normally used within the gen-
eral field of video. 4:4:4 is generally 
only used for RGB applications.

4 : 4 : 4 : 4  

This �SAMPLING RATIO corresponds 
to 4:4:4, but includes an additional 

�KEY SIGNAL (�ALPHA CHANNEL) 
with equally high �RESOLUTION.

5 . 1  A u d i o  

In contrast to the �STEREO SOUND SYS-
TEM and conventional �SURROUND 
SYSTEMS, this sound system offers five 
separate full band audio signals: Left, 
middle, right, rear left, rear right. An 
additional subwoofer channel is also 
provided.

6 0 1  

Common abbreviation for �ITU-R 
601.

A C - 3  

�DOLBY DIGITAL

A / D  C o n v e r s i o n  

Analog-to-digital conversion

Term mainly used to describe compo-
nents for �DIGITIZING or �QUANTI-
SIZING and refers to a converter which 
transforms analog signals into digital 
data. All analog signals have to be digi-
tized for subsequent use by computers. 
Furthermore, digital data allow lower 
�GENERATION LOSSES, are reproduc-
ible and allow image effects in post-
production that would not be possible 
with analog technologies.

A E S / E B U  

Is used as a term for a digital audio 
standard as defined together by the 

Audio Engineering Society (AES) and 
the European Broadcasting Union 
(EBU). An interface for serial trans-
mission of digital audio data has been 
defined on the basis of these standards. 
The AES/EBU standards have agreed 
upon 32, 44.1 and 48 kHz as possible 
sampling frequencies. Resolution can 
be up to 24 bits at maximum. Studios 
usually use a resolution of 16 bits (in 
special cases 20 bits) and a sampling 
frequency of 48 kHz (e.g. DAT). This 
results in a data rate of 768 kbits/s.

A l i a s i n g  

General term for disturbing effects that 
may be caused by sampling frequen-
cies being too low. An example for this 
is graphical aliasing, the principle of 
which is simple: Placing two screens 
upon each other can cause additional, 
finer patterns than those existing in 
one of the two screens. Such patterns 
can have a disturbing influence on the 
picture.

Temporal aliasing is known from wild-
west movies: When a wagon crosses 
the picture, we oftentimes see the 
wheels turning backward. Reason: The 
rotating frequency of the spokes col-
lides with the frequency with which the 
TV image repeats itself (50 Hz).

Also the undesirable steppiness visible 
in the case of diagonal or curved lines 
in computer graphics or along sharp 
key edges is known as aliasing effect � 
ANTIALIASING.
Volume II Glossary G - 3



PINNACLE

Glossary
A l p h a  C h a n n e l  

Alpha channel, in the case of com-
puter-based systems, is the function 
known as key channel or key level in 
conventional video technology 
(�KEYING). Masks can be superim-
posed on a picture signal, thus 
enabling different keying tricks such as 
inserting image signals or executing of 
�CHROMA KEYING.

One can also say that the alpha channel 
includes transparency information of a 
picture file by means of which the 
transparency between front and back-
ground of a picture can be controlled.

A n a l o g  

In very simple words one could say 
that analog processes work with con-
tinuously variable values in indefinite 
intermediate steps, while digital pro-
cesses only know two states: 1 or 0, yes 
or no. Continuous phenomena like 
curves can in fact be displayed contin-
uously in analog technology, while dig-
ital technology subdivides these 
phenomena into sections and disag-
gregates them into single events. 

Analog technology processes and 
transmits data in the form of concrete 
physical values (electric flows). The 
accuracy (�RESOLUTION) depends on 
the way of physical data storing. Ana-
log data can be invariably changed 
(e.g. audio/video level).

A n a l o g  c o m p o -
n e n t  s i g n a l s  

�COMPONENT SIGNALS

A n i m a t i o n  

Process in which a Sequence of moved 
images is created by combining differ-
ent frames. In the case of editing sys-
tems, single graphics or titles can be 
animated to form a moved image 
Sequence. Two versions, i.e. 2D and 3D 
animation, exist.

A n t i a l i a s i n g  

Smoothing or reducing disturbing pic-
ture effects caused by �ALIASING. Fil-
ters and �INTERPOLATION are used for 
this purpose. By means of interpola-
tion, i.e. the calculation of intermedi-
ate values along the sharp edges of 
types and graphics, these edges can be 
smoothed out, thus generating a 
smoother picture. The pixel structure 
along tilted or bent edges is mixed with 
the surrounding colors, i.e. the transi-
tion area becomes a bit "blurry".

A P I  

Application Programming Interface. 
These pre-defined software interfaces 
allow communication between differ-
ent software applications. �PLUG-INS, 
for example, can be included in the 
editing software application via API. 
Also the interplay between editing 
software and a video board, for exam-

ple the perfect utilization of effect 
hardware, is realized via API.

A r t e f a c t  

In video technology, this term 
describes visible, disturbing defects in 
pictures caused by technical limitation. 
Oftentimes they cannot be described 
by technical measured variables. Noise 
signals at object edges or undesired 
contours in picture sections often 
occur in picture areas in which smooth 
transitions should be displayed. Arte-
facts also often occur in cases where 
the amount of video data is consider-
ably decreased as a result of high 
�COMPRESSION RATES. The visible and 
typical "building block effects" of 
highly compressed video signals are 
called artefacts. Also �ALIASING is one 
kind of artefact.

A s s e m b l e  

In conventional video technology this 
terms describes one of the two editing 
modes that are possible with video 
tapes. In the case of assemble edit, all 
Tracks on the video tape are added free 
of disturbances at the cutting point, 
but all Tracks are newly written. The 
other editing method for video tapes is 
known as �INSERT EDIT. 

A S C I I  

American Standard Code for Informa-
tion Interchange.
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This standard determines how key-
board characters are stored as digital 
information. Only 127 characters have 
been determined, the fact of which 
causes major problems with special 
characters, such as Ä, Ö, Ü and ß.

A s p e c t  r a t i o  

This is the ratio between the length 
and the width of video images. The 
aspect ratio of 4:3 determined in the 
PAL, NTSC and Secam TV systems has 
had the upper hand thus far. The trend 
towards wider screen formats, which 
has been evident in cinema for some 
time now, is also hitting the small 
screen. More advanced TV systems 
such as �PALPLUS or �HDTV are 
banking on a wider screen with an 
aspect ratio of 16:9.

Those in favor of 16:9 argue that, in 
comparison with the almost square 4:3 
ratio, the wider screen corresponds 
more to the human visual range. In 
many recording and postproduction 
devices it is possible to change between 
the aspect ratios 4:3 and 16:9.

A s y m m e t r i c a l  

Asymmetrical lines are shielded with a 
single-wire and used, among other 
things, for transmitting audio signals 
(cinch). In contrast to symmetrical 
audio lines, they are more susceptible 
to disturbances. 

AT M  

Asynchronous Transfer Mode. A net-
work protocol which was originally 
designed for the telecommunications 
market. ATM enables the operation of 
networks that allow high-speed data 
transfer. ATM is capable of transmit-
ting digital high quality live video 
Sequences (�ITU-R 601) or of shifting 
extremely large files between different 
work places. It remains to be seen 
whether ATM will be widely used in 
the field of video technology. Efforts, 
however, are already materializing.

AT S C  

Advanced Television Systems Commit-
tee.

This American body was originally 
founded to determine standards for 
creating, broadcasting and receiving 
High Definition Television (�HDTV). 
In the US, this body established rele-
vant, technical regulations for digital 
broadcasting of TV programs via 
antenna or satellite. In general practice, 
the terms ATSC and �DTV are used as 
synonyms for the US version of digital 
television (in contrast with �DVB).

A u d i o  c l i p  

Digital audio data are often known as 
audio clips. This is true for audio ele-
ments that are placed on the �TIME-
LINE in the case of editing systems for 
further processing as well as for wave 

files (�WAV) that can be intended for 
completely different uses.

A U X  

Auxiliary.

Refers to an auxiliary input. In a video 
editing system, a channel reserved for 
connecting an external audio and/or 
video device.

AV I  

Audio Video Interleave.

A data format developed by Microsoft 
for digital video. AVI is software-
based, and the AVI files can be played 
with the respective software without 
the help of additional special video 
hardware. Compressed picture and 
sound data are interleaved in such a 
way that they proceed synchronous to 
one another.

AV  h a r d  d i s k s  

�HARD DISKS

B a c k g r o u n d  

1) Refers to the background of a key 
animated scene �BLUE BOX.
2) The second image plane in video 
mixer panels is sometimes referred to 
as background.

B a c k g r o u n d  R e n -
d e r i n g  

�RENDERING.
Background rendering systems may 
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render Sequences without requiring 
the full power of the computer. The 
user may continue processing his 
application while the computer renders 
in the background.

B a n d w i d t h  

1) Bandwidth is the spacing between 
the upper and the lower end of the fre-
quency range in a signal spectrum or a 
transmission channel. This applies for 
magnetic, audio and video tape 
widths.

2) Bandwidth describes the informa-
tion quantity that can be transmitted 
within a defined period of time. If an 
image is to be displayed or transmitted 
in great sharpness and resolution of 
detail, a high bandwidth is required.

B a t c h  D i g i t i z i n g  

If a great amount of original material 
exists, the material which has a higher 
compression factor or lower data rate is 
digitized in the non-linear cut and 
stored onto the hard disks connected. 
Although the image quality deterio-
rates because of the higher compres-
sion, it does, however, also require less 
hard disk capacity for storing the data. 
After finishing a rough version of the 
cut, material exists which is not used. 
The required hard disk capacity of the 
material to be used becomes smaller 
and it may be automatically re-digi-
tized by means of batch digitizing at a 
lower compression rate (or higher data 
rate).

This process may be repeated as often 
as desired in case capacities have 
become available after sorting out 
image material. It may be that finally 
the highest image quality of the system 
is available for the fine cut.

The process of initial digitizing by 
means of a logging list after sighting 
and logging the material on the tapes is 
referred to as batch digitizing. The 
clips generated in the logging list are 
also digitized automatically.

B e t a c a m  

1/2 inch video format operating with 
analog component signals.
Luminance and color difference signals 
are transmitted and recorded stag-
geredly (time multiplex method). With 
this method, a significantly improved 
image quality may be achieved com-
pared to for instance the S-VHS for-
mat.
Betacam has been developed through 
the years to Betacam SP. In this modi-
fied system the components are 
recorded in a frequency-modulated 
manner.

The luminance component (�Y) 
receives the higher frequency band-
width of 5.5 MHz compared to the 
chrominance components (�R-Y AND 
B-Y) which are recorded each at 2 
MHz each on a separate helical Track.
In order to preserve the recording 
quality in post production editing over 
many generations, the component sig-

nals must also be processed separately 
in post production.

B e t a c a m  S X  

Betacam SX is a digital recording sys-
tem of Sony, which compresses the 
data according to the �MPEG-2-STU-
DIO STANDARD (4:2:2: studio profile) 
by factor 10:1 and writes it onto tape at 
a video data rate of 18 Mbits/s.

MPEG-2 enables higher compression 
factors at equal or improved image 
quality than other compression meth-
ods, owing to the fact that this method 
combines a plurality of frames when 
compressing video streams (�MPEG). 
The other systems, however, compress 
frame by frame (�M-JPEG).
The formerly used Betacam SX devices 
may also reproduce analog Betacam SP 
tapes. With this format Sony aims at 
applications in the broadcast market 
and markets it as a successor of the 
Betacam SP format widely used by TV 
broadcasting stations.

B - f r a m e  

Bi-directional frame
�MPEG

B I O S  

Basic Input Output System
Designation for the automatic "start 
program" of a computer. It is stored on 
a separate chip. The BIOS basically 
controls the access to the microproces-
sor and prepares the acceptance of 
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commands. A program cannot operate 
without the BIOS.

B i t  

Binary Digit
Basic unit in �DIGITAL TECHNOLOGY. 
One bit may adopt two states: 0 or 1.

B i t  r a t e  

Number of bits transmitted serially per 
second.

B i t  s t r e a m  

�DATA STREAM

B l a c k b u r s t  

Black signal, burst blanking.

Video signal without luminance or 
chrominance components (except for 
bursts), which, however, includes all 
other elements of a video signal. The 
black burst is a reference/synchroniz-
ing signal which is usually used for 
timing audio and video samples.

B l u e b o x  

A frequently used type of �CHROMA 
KEYING, i.e. the color key trick, which 
is used with blue as key color.
A scene is recorded in front of a blue 
background. The blue portions of the 
image are keyed and replaced by other 
parts of a different image (�ALPHA 
CHANNEL).

B N C  

Bayonet Neil-Concelman.
A common plug connection used in 
professional video technology with an 
�IMPEDANCE of 75 ohms. BNC plugs 
are used in both analog and digital 
video technology.
Some few consumer recorders also 
have BNC terminals for image display. 
Using a metal adapter plug, a connec-
tion to cinch can easily be established 
by BNC. This adapter is available both 
in male and female form.

B r o a d c a s t  Q u a l i t y  

Although the expression broadcast 
quality is frequently used, a fixed defi-
nition does not exist. Generally 
accepted measurable variables do not 
exist.
Usually the tape format �BETACAM SP 
is selected as reference point: Broad-
cast quality usually describes the pic-
ture quality that the user subjectively 
considers as being equal to the Beta-
cam SP picture quality.
Also non-linear editing does not 
include any fixed measured variables 
to determine the broadcast quality. As 
a rule, video boards and editing sys-
tems with a �COMPRESSION RATE 
(approx. 1:2) as low as possible or a 
data rate of approx. 50 Mbits/s are 
understood by this. 

B r o w s e r  

Common word for a software by 
means of which Internet or World 
Wide Web contents can be displayed. 
Different manufacturers also use pro-
gram modules for their editing systems 
which are also known as browsers. 
They are widely used to display the 
existing digitized clips, graphics, titles 
or effects in a simple and clear way. The 
user can get an overview of the existing 
material with the help of a browser.

B u s  

An internal data pathway for transmit-
ting bit patterns. The access to a bus is 
usually microprocessor-controlled. 
The individual components of a com-
puter communicate via a bus system. 
Common bus systems in the PC field 
are: ISA, EISA and PCI.

B - Y  

Color difference signal of one of the 
analog �COMPONENT SIGNALs. It is 
created by subtraction of the lumi-
nance value (Y) from the blue contri-
bution of a pixel. The color difference 
signal B-Y includes information 
regarding chrominance and saturation. 

B y t e  

1 byte includes 8 bits and enables regis-
tration and reproduction of 256 dis-
crete values (brightness, color).
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C a p t u r e  

Refers to the process of digitizing and 
recording video and audio material 
from an external source onto the hard 
disk of a non-linear editing system.

C a r r i e r  f r e q u e n c y  

The carrier frequency is a �FRE-
QUENCY used as a carrier in order to 
transmit other signals. The actual 
information to be transmitted is 
impressed on the carrier frequency in 
accordance with one of many available 
procedures. This procedure is referred 
to as modulation (frequency modula-
tion, amplitude modulation, phase 
modulation).

C C I R  

Comité Consultatif International des 
Radiocommunications. Standardiza-
tion committee that has absorbed into 
�ITU.

C h r o m a  K e y i n g  

Color key. Video effects technique in 
which areas of a video picture that 
appear in a specific saturated hue 
(color shade) are replaced by corre-
sponding parts of a different video 
image. Blue is usually used as the key 
color (�BLUE BOX).

Example: In a studio, anchorpersons 
are usually placed in front of a blue or 
green screen into which the changing 
texts or images are included with the 
help of the chroma keying technique.

C h r o m i n a n c e  

Color, color part, chrominance signal.

Chrominance is the color part (con-
sisting of hue and saturation) of a 
video signal, while �LUMINANCE 
refers to the brightness part of a video 
signal.

C i n c h  

Most video devices within the field of 
consumer electronics are equipped 
with cinch connections for picture and 
sound output. The yellow jack is neces-
sary for the video signal, the red and 
white cinch jacks for the audio signal 
in �STEREO as in- and output.

C l i p  

Individual video and audio Sequences 
are often referred to as clips in post 
production. As a rule, the term clip 
only refers to the graphical display of 
images and sound Sequences in the 
Project files or in the �TIMELINE. Since 
clips are only links to the actual data 
(Media Files on the hard disks), they 
can be edited without modification of 
the actual data on the hard disk.

C l i p L i n k  

The ClipLink function developed by 
Sony includes a bundle of individual 
functions included into devices 
equipped with the DVCAM format. 
ClipLink mainly offers advantages in 
post production.

Different additional information, such 
as start and stop time code and picture 
icons, is stored together with each 
recorded scene. When Camcorder-
recording, an evaluation (NG=no 
good or OK=good) can be assigned to 
each take by pressing a button. A spe-
cially equipped editing system can 
read these data, adapt them if neces-
sary and load the takes marked as OK 
onto the hard disk. 

To make use of ClipLink functions, 
tapes including a storage chip have to 
be used in the case of original record-
ings. Disciplined and careful recording 
is a prerequisite for efficient use. 

C l i p p i n g  

Amplitude limiting.

1) Digital audio distortion. Digital 
audio systems exhibit less tolerance to 
overloading than analog audio sys-
tems. If you exceed a certain level, 
noticeable distortions can be heard. 
This is particularly important to keep 
in mind when converting audio sig-
nals, for example, from analog to digi-
tal or between different digital formats 
(�A/D CONVERSION). Converters only 
offer distortion-free operation up to a 
precisely defined level.

2) The threshold or the setting of a 
suitable threshold during �KEYING. 
For example, if �LUMINANCE KEYING 
is carried out, one has to predetermine 
up to which luminance value keying is 
supposed to take place. 
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C o l o r  d i f f e r e n c e  
s i g n a l  

Information regarding luminance and 
chrominance for each pixel is neces-
sary to create video images. In video 
technology, this information is com-
monly sampled in the form of a lumi-
nance signal and two color difference 
signals. 

The reason why two color difference 
signals are needed which together 
determine one certain color can be 
explained as follows: Imagine all pro-
ducible colors within the video system 
as being a circular area. When posi-
tioning a reticule in the middle of this 
circle, each color (more detailed: each 
color mode) can be explained as a 
combination of a value on the x-and y-
axis. In common practice, the value 
pairs U/V, Cr/Cb and R-Y/B-Y are 
referred to as color difference signals 
and used as if they all had the same 
meaning, although this is not true in 
reality, to be exact. (�YUV, Y, CR, CB 
and �Y,R-Y,B-Y)

C o l o r  s a t u r a t i o n  

A measurement for determining the 
intensity of the colors in a video signal.

C o l o r  s p a c e  

Depending on the defined reference 
points or limits, a color range known 
as color space can be defined on the 
basis of the spectrum of all colors 

existing in nature. To be able to repro-
duce images as detailed as possible, 
information regarding brightness and 
color from the predefined color space 
is necessary for each pixel to be dis-
played. 

There are various methods for being 
able to supply this necessary informa-
tion and to define the color space. One 
of them mainly used in conventional 
video processing is the determination 
of luminance values (�LUMINANCE, 
�Y) and color difference signals (R-Y, 
B-Y). The color space defined in such a 
way is most commonly referred to as 
YUV color space. 

In the field of computer graphics, 
images are commonly processed 
within the RGB color space in which all 
colors are defined as a mix of the three 
basic colors red, green and blue. The 
conversion of data from one into 
another color space is possible but may 
result in deteriorating quality and 
errors.

C o m p l e t e  s y s t e m s  

Non-linear editing systems are offered 
in different versions. A complete sys-
tem offers all components required for 
full operation of an editing system with 
the exception of peripherals such as 
video recorders. The user receives a 
completely configured, operable com-
puter system.

C o m p o n e n t  s i g n a l s  

To display video images, information 
on brightness and color is required for 
each pixel. In video technology, this 
information is commonly sampled by 
means of one brightness signal and 
two color difference signals. The three 
signals are also referred to as compo-
nent signals. 

In analog video technology, the analog 
component signals �YUV produce the 
best signal quality. The term YUV is 
commonly known and used although 
the correct term for analog component 
signals is: Y, R-Y, B-Y. Video formats 
working with component signals are: 
�BETACAM and MII. Digital compo-
nent signals are defined by �ITU-R 
601 standard. They are created from 
the analog component signals Y,R-Y 
and B-Y at a sampling ratio of �4:2:2 
and are called Y, Cr, Cb.

Compare: �COMPOSITE.

C o m p o s i t e  

Video signals can be coded in various 
ways: Composite systems process 
information on brightness and color 
(�LUMINANCE and �CHROMINANCE) 
in combination, that means they form 
one single signal. In �COMPONENT 
SYSTEMS, chrominance and luminance 
are separately processed. Composite 
and component systems are available 
in analog and digital versions. 
�CVBS. 
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C o m p o s i t i n g  

Simultaneous multi-layering of various 
focal planes. Compositing is often used 
for TV trailers, advertising produc-
tions or for special effects in feature 
films. Typical functions required for 
compositing are �LAYERING and key 
functions (�CHROMA KEYING).

The better the compositing results are 
supposed to be, the higher the system 
requirements. High end applications 
require 8 or 10 bit signal processing to 
maintain the quality throughout vari-
ous generations (�GENERATION 
LOSSES) and to ensure high-quality 
chroma keys. The quality of a compos-
iting system also depends on the num-
ber of layers, i.e. focal planes that can 
be simultaneously processed and on 
how fast the composition can be ren-
dered (�RENDERING).

C o m p r e s s i o n  

Digitization of large quantities of video 
and film material creates large 
amounts of data. To be able to process 
these data with commonly applied 
computer technology, the data quanti-
ties are being reduced by means of 
compression.

With the help of different calculation 
operations, one tries to recognize the 
irrelevant or least relevant information 
within a picture in order to leave it out. 
In the case of mild compression, all 
original data can be restored from the 
compressed data stream. In the case of 
stronger compression, picture infor-

mation is irretrievably lost. The data 
quantity results in a loss of picture 
quality.

There are several different compres-
sion methods with different efficiency 
levels. The goal is always to reach an 
image impression as natural as possible 
with a minimum amount of data.

The �COMPRESSION RATE is used as a 
measure for determining the strength 
of the compression carried out.

Common compression methods are 
�MPEG, �JPEG, �M-JPEG, DV.

C o m p r e s s i o n  r a t e  

The compression rate indicates the 
ratio of the original amount of data 
and the compressed data quantity. 

In general, picture quality and storage 
requirement depend on each other. A 
low compression rate generates good 
quality but requires a lot of storage 
capacity. Increasingly compressed 
material does not require a lot of stor-
age capacity but offers an impaired 
image quality. To find a compromise 
between existing storage capacity and 
image quality, many manufacturers 
offer variable compression rates that 
can be predetermined.

The compression rate of a system, 
however, is only of limited importance 
for comparing the quality of different 
systems with each other. Major differ-
ences in picture quality between the 
images compressed at 1:8 by one sys-
tem or by another system also offering 

1:8 compression can however exist. 
This is due to the fact that some com-
pression methods work more effec-
tively and produce better results than 
others.

In the case of �MPEG, one no longer 
talks of compression rates (e.g. 5:1) 
based on a different way of data reduc-
tion, but of �DATA RATES (such as 
25Mbits/s, for example). In general, 
the relation between image quality and 
storage capacity is more favorable in 
the case of �MPEG than in the case of 
�M-JPEG. 

C o n s o l i d a t e  

Consolidate is a function included in 
some editing systems to delete super-
fluous data that were not used in the 
current Project. The remaining data are 
written onto the hard disk in such a 
way that the shortest possible access 
times are realized (�FRAGMENTA-
TION). The write/read head does not 
permanently have to be moved 
between the different sectors, thus 
making the system faster and more 
efficient. This is of particular impor-
tance when connected storing media 
with low �COMPRESSION RATES are 
operated at maximum efficiency. 

C o n t r o l  I n t e r -
f a c e s  

When controlling camcorders or 
recorders by computer, the interface 
sockets of these devices are of particu-
lar importance. Consumer devices fea-
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ture the Sony or Panasonic versions of 
control sockets, if at all. Sometimes 
they are also incorporated in the 
devices of other manufacturers.

The Sony version is called LANC or 
Control L. Two designs are available, 
i.e. older devices feature a 5-pole spe-
cial connection, while most of the 
newer devices have a 2.5-millimeter 
stereo jack connection.

For device control, Panasonic are 
banking on a special five-pole edit jack 
mainly referred to as Panasonic Edit. 
However, this jack is not compatible 
with the old five-pole LANC terminal. 
The synchro-edit jack, which is also 
supplied by Panasonic, is not suitable 
for the control of the devices by the 
computer.

Most of the software program manu-
facturers attach special cables to their 
programs, with which the video 
devices can be remotely controlled by 
the computer. On the computer side, 
they fit into the serial port in most 
cases, while, on the video side, they fit 
the Sony LANC or Panasonic Edit jack.

In the professional area, the �RS-422 
and �RS-232 interface generate the 
control contact between the computer 
and video worlds.

C o n v e r s i o n  o f  
S t a n d a r d s  

The conversion of standards refers to 
the process of converting video signals 
from one TV standard to another. The 

fundamental differences between the 
various TV systems (PAL, NTSC, 
Secam) lie in the number of lines, the 
color transmission and the carrier fre-
quencies. The conversion of standards 
is implemented with special devices, 
whereby high levels of technical expen-
diture are required in order to achieve 
optimum results.

C o p y i n g  l o s s e s  

�GENERATION LOSSES

C r ,  C b  

�Y, CR, CB

C P U  

Central Processing Unit or central 
microprocessor. The hardware core or 
"switching center" of a computer. The 
CPU converts the commands of a pro-
gram and coordinates the necessary 
actions. For the CPU, video images are 
only a Sequence of data (�RENDER-
ING). The CPU receives the data from 
the internal memory (�RAM) and 
returns them to the internal memory 
after having calculated them.

C r o s s  C o l o r  

The "flickering" or "shimmering" of 
certain colors in video images. Cross 
color disturbances often occur in video 
images with fine black-and-white 
structures. In this case, high frequency 
black-and-white information is 

wrongly interpreted as chroma signals 
by the processing electronic unit.

Cross color effects are particularly visi-
ble in �COMPOSITE SYSTEMS and 
sometimes also linked to the signal 
mode (�CVBS) and the TV system 
(�PAL).

The effect is often visible in the case of 
checked patterns on cloth. Such fine 
structures which represent high band-
width frequencies change slightly in 
amplitude and phase from line to line.

C S D I  

�SDTI

C T L  

Capstan TRacking Logic.

In the case of video magnetic tape 
recording one has to make sure that the 
individual Tracks are accurately hit 
when playing. Synchronous pulses are 
recorded image by image on a separate 
Track of the video tape in the case of 
many video formats. They control the 
tape velocity. These pulses are referred 
to as CTL or control Track. The CTL 
Track does not include any absolute 
time information and is not a �TIME-
CODE such as �LTC or �VTIC. By 
counting the individual pulses (with 
the tape counter) the CTL can calculate 
a relative tape position used for calcu-
lating a relative time information. This 
is how the counters of most home 
video devices work. 
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C u t  

Transition from one scene to another. 
Linear editing by means of magnetic 
tape is subdivided into �ASSEMBLE 
and �INSERT EDIT. Most non-linear 
editing systems offer two different 
options, i.e. the user may choose 
whether he wants to replace or move 
the scene at the registered editing 
point.

C V B S  

Color Video Burst Signal.

C V B S  

Color Video Blanking Synchronous 
signal.

All components of a standardized ana-
log video signal in the PAL standard 
are combined to form one single com-
ponent that can be transmitted by 
means of a simple laminated coax. The 
only problem are the crosstalk effects 
between the individual signal compo-
nents that result in typical quality 
impairment. In professional post-pro-
duction, CVBS signals are not used 
anymore, as a rule. In transmission 
technology where places far apart have 
to be cable-connected, CVBS signals 
are sometimes still used for economic 
reasons. CVBS is also referred to as 
�COMPOSITE SIGNAL.

D 1  

A format for digital video tape record-
ing in the case of which digital �COM-

PONENT SIGNALS according to �ITU-R 
601 are recorded on a 3/4" (19 mm) 
wide oxide tape without data reduction 
(8 bits, �4:2:2). Four digital audio 
channels are available. The maximum 
recording time of D1 tapes is 94 min-
utes.

D1 devices are among the most expen-
sive video recorders and are mainly 
used in high end post production or 
archiving due to their extraordinary 
recording quality. Sony and BTS (Phil-
ips) offer D1 devices.

D 2  

A format for digital tape recording in 
the case of which digital �COMPOSITE 
VIDEO SIGNALS as well as four sound 
channels are recorded on a 3/4" (19 
mm) wide metal tape. The analog 
composite signal is quantisized at 8 
bits. The maximum recording time of a 
D2 tape is 208 minutes. D2 is not com-
patible with D1. Sony and Ampex were 
able to establish D2 as high end tape 
format in the United States at a point in 
time when the video industry still 
mainly worked with analog technol-
ogy. D2 has not been officially, but de 
facto discontinued.

D 3  

A format for digital tape recording in 
the case of which one digital �COM-
POSITE SIGNAL with four sound chan-
nels is recorded on a 1/2" (12.7 mm) 
wide technical pure iron tape. Quanti-
zation is at 8 bits, the maximum 

recording time of tapes is 245 minutes. 
D3 was developed by Panasonic and is 
the rival product of D2.

D 5  

A format for digital tape recording in 
the case of which digital �COMPO-
NENT VIDEO SIGNAL with four sound 
channels is recorded on a 1/2" wide 
technical pure iron tape according to 
�ITU-R 601. In contrast to D1, the 
signals are quantisized at 10 bits. The 
D5 format developed by Panasonic 
works without data reduction and is 
thus preferably used in post produc-
tion. The maximum recording time 
per tape is 123 minutes.

D 6  

A format for digital tape recording in 
the case of which a digital �HDTV 
component signal as well as 12 audio 
channels are recorded on an 3/4" (19 
mm) wide technical pure iron tape. D6 
is based on a D1 drive. The D6 format 
was developed by BTS (Philips).

D 7  

Official name under which the 
�DVCPRO recording format devel-
oped by Panasonic is standardized.

D 8  

In general practice, this abbreviation is 
becoming the short form of the video 
tape format �DIGITAL 8 developed by 
Sony. D8, however, is not a format 
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name adopted, determined and 
accepted by international standardiza-
tion bodies. 

D 9  

Digital video tape format by JVC 
which was initially marketed under the 
name Digital S. D9 records on High 
Density MP (Metal Particle) 1/2" (12.7 
mm) wide metal tapes. The Track 
width of D9 is 20 mm. D9 works with 
4:2:2 signal processing and compresses 
the image material on the basis of DCT 
(Discrete Cosine Transformation) at a 
factor of 3.3:1. Two Tracks are always 
written simultaneously. One frame 
consists of 12 adjacent diagonal Tracks 
in the individual segments of which 
video, subcode and up to four PCM 
audio Tracks are located. Moreover, 
the tape includes two cue audio Tracks 
and one control Track (�CTL). The 
video data rate amounts to 50 Mbits/s, 
the total digital data rate written onto 
the tape including the audio data, the 
subcodes and the error control 
amounts to 99 Mbits/s. The tape run 
velocity of D9 is 57.8 mm, the maxi-
mum recording time is 104 minutes. In 
the case of D9, the sound is sampled at 
16 bits and 48 KHz and written onto 
the tape as PCM sound in an uncom-
pressed way. Four channels are pro-
vided for this purpose. D9 was 
developed by JVC and is currently only 
available from this manufacturer.

D / A  c o n v e r s i o n  

Digital- to- analog conversion.

Term mainly referring to components 
for converting digital into analog sig-
nals. Digital signals must be converted 
into an analog format to enable presen-
tation on a video monitor. D/A conver-
sion is also necessary for producing 
non-linear digitally edited films on an 
analog video tape format such as 
�BETACAM SP. Many devices, such as 
digital video recorders emit digital as 
well as analog signals.

D AT  

Digital Audio Tape.

Recorder for digital sound recording 
with a sampling frequency of 48 KHz 
and a resolution of 16 (20) bits. �AES/
EBU.

D a t a  c o m p r e s s i o n  

�COMPRESSION, �DV, �MPEG, 
�M-JPEG.

D a t a  r a t e  ( d a t a  
s t r e a m )  

Amount of data transmitted in a cer-
tain period of time, usually indicated 
in Mbits/s. In comparison with 
�M-JPEG which indicates the 
�COMPRESSION RATE, �MPEG indi-
cates the data rate value. This value 
determines the dimension of the 
applied data reduction.

D a t a  r e c o r d e r  

Recorders that enable recording and 
playing of digital data by means of a 
magnetic tape. Data recorders are gen-
erally used for archiving digital data 
permanently as well as for backup pur-
poses.

There are, however, also data recorders 
that are used in video technology, for 
example in the field of server technol-
ogy or archiving of transmitted TV 
programs. Additional coder/decoder 
to transfer mere data into displayable 
video signals are however necessary. 
Different drives and formats such as 
�DST and �DLT are used.

d B  

Logarithmic unit for measuring the 
physical signal strength (voltage, 
power, sound).

D C T  c o m p r e s s i o n  

Discrete Cosine Transformation

DCT is a standard method for com-
pressing digital video images. It serves 
as a basis for many data reducing 
methods. �JPEG, �DV and �MPEG 
depend on DCT.

D C T  f o r m a t  

Digital video tape format where digital 
component signals as well as four 
sound Tracks are recorded. DCT func-
tions with a 3/4" (19 mm) wide techni-
cal pure iron tape with a maximum 
recording time of 190 minutes. DCT 
Volume II Glossary G - 13



PINNACLE

Glossary
was developed by Ampex and is today 
applied in the form of �DST �DATA 
RECORDERS.

D D R  

Digital Disk Recorder �DISK 
RECORDER.

D i g i t a l  

In simple terms, one could say that 
digital processes only know two states: 
1 or 0, yes or no. Continuous phenom-
ena like curves are subdivided into sec-
tions and disaggregated into single 
events.

Digital technology processes and 
transmits data as information pack-
ages. In contrast to analog systems, 
digital data can be identically pre-
sented and stored (light, electricity, 
characters, magnetic particles) in dif-
ferent media (data carriers). The accu-
racy of presentation (resolution) is 
independent of the medium. A large 
quantity of data is necessary for high-
quality signal processing. Since digital 
technology uses mere numerical val-
ues, the large amount of data can be 
reduced with the help of suitable math-
ematical methods (�COMPRESSION).

D i g i t a l  c o m p o -
n e n t  s i g n a l s  

�COMPONENT SIGNALS.

D i g i t a l  8  

Digital vide tape format used for 
recording �DV-coded digital image 
and sound data on Hi8 tapes instead of 
DV tapes. Besides the width of the tape 
material (8 mm for Digital 8, 6.35 mm 
for DV) Digital 8 differs from DV in 
that it only requires six Tracks for one 
image due to the used 8 mm tape (DV: 
12 Tracks). Like DV, Digital 8 records 
the sound either at 12 bits/32 kHz (4 
Tracks) or at 16 bits/48 kHz (2 Tracks). 
Digital 8 devices are currently only 
sold by Sony and can play Hi8 and 
Video 8 cassettes.

D i g i t a l  B e t a c a m  

VCR format for digital components 
with 10 bits resolution. Digital Beta-
cam makes use of a data compression 
of 2:1 (�DCT-based). Digital Betacam 
records on a 1/2" (12.7 mm) wide tech-
nical pure iron tape. Individual 
recorder models in the Digital Beta-
cam format can also play SP. Digital 
Betacam was developed by Sony.

D i g i t a l  r e c o r d e r s  

Video recorders that record digital sig-
nals on magnetic tapes.

D i g i t a l  S  

�D9

D i g i t i z e r  

Video board that offers connections 
for analog video signals and converts 

them into a digital format for further 
processing by PC. 

D I N  f o u r - p o l e  

Video device in S-VHS or Hi 8 tape 
format as well as S-Video-suitable 
monitors and other accessories gener-
ally include a DIN four-pole jacket, 
also known as 4-pole-mini DIN jacket. 
The manufacturers refer to this jacket 
as S-Video or �Y/C on their devices. 
The corresponding cables transmit the 
luminance and chrominance signal 
separate from one another, thereby 
making use of the increased picture 
quality of these devices even when 
transmitting from one device to 
another device or monitor.

D I N  s i x  p o l e  

Older audio devices are still equipped 
with a six pole DIN socket. Adapters 
and cinchs are available for them. This 
enables a connection of older devices 
to modern audio cards.

D i s c  r e c o r d e r  

Disc recorders are recorders that store 
image and sound on a hard disk 
instead of a magnetic tape. Depending 
on the manufacturer, the digital image 
and sound data are recorded either in 
an uncompressed or compressed way. 
As with non-linear editing systems, the 
manufacturer of disc recorders make 
use of different compression methods. 
As a rule, disc recorders are used as 
stand alone devices, but there are also 
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board-only solutions by means of 
which a PC can be transformed into a 
disc recorder.

D i s s o l v e  

Transition from one picture Sequence 
to the next. In an analog cut, the video 
level of the first picture Sequence is 
reduced while the level of the second 
picture Sequence is increased to the 
same extent. In the picture, the picture 
contents are superimposed and a soft 
transition between the scenes is cre-
ated.

D LT  

Digital Linear Tape.

DLT tape drives are used for storing 
and archiving of digital image and 
sound data. They enable fast access 
and storage times but are more expen-
sive than other tape drives.

D o l b y  

Dolby is a method for reducing noise 
in analog magnetic tape recording. 
There are different methods (Dolby A, 
B, C, SR) aiming at different require-
ments of professional technology and 
consumer electronics.

D o l b y  D i g i t a l  

Dolby Digital is a digital multichannel 
sound method. The individual chan-
nels are clearly separated from each 
other. Dolby Digital stores five separate 

channels as well as an additional 
woofer effect channel (LFE). The data 
are coded according to the AC-3 
method (audio coding-3). Dolby Digi-
tal enables constant data rates between 
64 kB/s up to 640 kB/s. This method is 
for example used for DVD, but also for 
laser disk or cinema.

D o l b y  S u r r o u n d  

Dolby Surround is an analog multi-
channel sound system that includes 
four sound channels (right, left, mid-
dle, surround)

D r i v e  

General term for component groups or 
complete devices including movable 
elements. The part of a video recorder 
threading up the tape or playing it is 
for example referred to as tape drive. 
Also devices by means of which CDs, 
disks or other removable storage 
media are played as well as �HARD 
DISKS and �RAIDS are referred to as 
drives.

D r o p  F r a m e  T i m e -
c o d e  

A type of �SMPTE TIMECODE 
designed to mach clock time for NTSC 
exactly. The technical background of 
this special timecode: NTSC does not 
work at a frame frequency of 60, but of 
59.94 Hz. This value corresponds to 
29.97 frames per second rather than 
30, the fact of which causes problems 
during timecoding. The 0.03 frames 

missing per second add up to form 
complete frames and cause a difference 
between timecode value and number 
of frames. This problem is technically 
solved by applying the drop frame 
method. Two frames per minute are 
simply left out. The time difference 
that would otherwise occur is elimi-
nated by applying this method. NTSC 
video recorders or timecode boards 
usually offer the possibility to work in 
drop-frame or �NON-DROP-FRAME 
MODE.

D S T  

Digital Storage Technology.

DST is based on the DCT format 
developed by Ampex. DST is fre-
quently used in high-end post produc-
tion as a backup medium.

D T V  

Digital Television.

Combination of various digital signal 
formats used in the US as a standard 
for broadcasting digital TV programs 
(terrestrially, i.e. via antenna or satel-
lite). DTV allows various quality steps 
and signal variations. 

Determining values within the US 
DTV-standard are: number of �LINES 
and �PIXELS, �ASPECT RATIO and 
�IMAGE FREQUENCY. It is also taken 
into consideration whether images are 
broadcast in �INTERLACED MODE 
(�INTERLACED, I) or simply line by line 
(�PROGRESSIVE, P). The detailed tech-
Volume II Glossary G - 15



PINNACLE

Glossary
nical regulations for DTV were devel-
oped by the Advanced Television 
Systems Comittee (ATSC). In general 
practice, the terms �ATSC and DTV 
are widely used as a synonym for the 
US version of digital television (in con-
trast with �DVB).

The US has developed first products 
that meet all DTV requirements.

In the medium run, DTV is supposed 
to be introduced as a substitute for the 
broadcasting standard NTSC all over 
the United States.

D V  

Digital VCR format for recording digi-
tal sound and image data on a 1/4" 
(6.35 mm) wide ME (Metal Evapo-
rated) tape. The DV format enables 8-
bit recording and compresses the data 
by factor 5:1. A mathematical method 
referred to as discrete cosine transfor-
mation (�DCT) is used for this pur-
pose. The irrelevant information 
within a frame is recognized and left 
out with the help of DCT and other 
computer operations. Moreover, the 
luminance and chrominance portions 
of the image signal are not sampled at 
�4:2:2 but at 4:2:0 (PAL). In the case of 
NTSC, DV is carried out at 4:1:1. The 
chroma resolution is a bit decreased for 
the sake of saving data information.

DV functions at a video data rate of 
approx. 25 megabits per second 
(abbreviated as Mbit/s or Mbps). The 
Track width of the tape is 10 mm.

The sound remains uncompressed and 
can be two-channel recorded with 16 
bits and 48 KHz. Some devices also 
enable recording with four sound 
channels. Recording is carried out at 
12 bits and 32 kHz. DV devices use the 
ultra-compact mini DV tapes (with a 
running time up to 60 minutes in stan-
dard play) or the bigger standard tapes 
(up to 270 minutes at max.). DV was 
originally intended for the consumer 
market, but proved to be absolutely 
suitable for DV professionals for acqui-
sition purposes. 

D - V H S  

Digital tape format with which for 
example coded digital TV signals 
(�DVB, DTV) can be recorded 
directly. The idea of a D-VHS recorder 
can be summarized in simple terms: 
the recorder simply writes all incoming 
data to the tape. The respective 
decoder then decodes the data during 
playback. D-VHS recorders are 
planned to be able to play back VHS 
tapes. 

Market introduction of this format 
developed by JVC and presented in 
1995 for the first time was repeatedly 
delayed due to the unclear situation 
regarding digital broadcasting stan-
dards and due to copyright problems.

D V B  

Digital Video Broadcasting

DVB includes a packet of features for 
broadcasting programs via a digital, 
terrestrial network. DVB is the Euro-
pean equivalent of the American 
�DTV.

D V C A M  

Digital video tape format. DVCAM is 
based on the �DV FORMAT and was 
developed by Sony. Sony changed a 
number of DV parameters for the 
DVCAM format. 4:2:0-sampling and 
data reduction by means of DCT was 
maintained, the Track width, however 
was increased to 15 mm. The tape 
speed is higher (28.2 mm/s) which 
results in shorter playing times com-
pared with DV. Depending on the cas-
sette, they are 12, 64, 124, 164 or 184 
minutes. DV uses metal evaporated 
(ME) tapes. DVCAM devices can also 
play DV cassettes.
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D V C P R O  

Panasonic developed the digital video 
tape format DVCPro on the basis of the 
�DV FORMAT. The technical data of 
the DVCPro standard are similar to 
those of DV. There are, however, some 
differences: DVCPro uses a Track 
width of 18 mm. Tape speed is 33.8 
mm/s, i.e. almost twice as fast as in the 
case of DV.

Moreover, DVCPro works with other 
tape material, i.e. metal particle tape. 
Other differences to DV: The sampling 
ratio of DVCPro was determined at 
4:1:1 and not at 4:2:0. In doing so, the 
developers are trying to reduce vertical 
chrominance errors that appear as 
color smears after repeated copying in 
DV. Also the DVCPro Track frame 
looks different than in the case of DV: 
DVCPro records an additional �CTL 
and a cue margin Track. The CTL 
Track has advantages for linear editing, 
since shorter preroll times can be real-
ized with equal or even better editing 
accuracy. The cue Track serves as an 
additional analog sound Track 
enabling the operator to hear the play-
ing sound of a video recorder in jog 
and shuttle mode.

D V C P R O 5 0  

The digital vid eo tape format 
DVCPro50 was developed by Pana-
sonic on the basis of �DVCPRO. It dif-
fers from other �DV FORMATS in that 
signal sampling is 4:2:2 and that the 

video data rate corresponds to 
50 Mbits/s.

For enhanced signal sampling quality 
and higher data rate, the tape is played 
at double speed, thus reducing the run-
ning time per cassette by 50 % in con-
trast to DVCPro. DVCPro50 in the PAL 
version records 24 Tracks per frame, 
i.e. twice as many helical Tracks as 
DVCPro. DVCPro50 provides four 
instead of two digital audio channels 
for sound recording. They enable a res-
olution of 16 bits/48 kHz.

D V D  

Digital Versatile Disc.

Digital optical storage medium in the 
form of an �OPTICAL DISC. The abbre-
viation was formerly used for the term 
Digital Video Disc, but was renamed 
later into Digital Versatile Disc to 
emphasize the variety of possibilities of 
this disc.

The outer dimensions of the DVD cor-
respond to those of an audio CD: 
diameter: 12 cm; 1.2 millimeters thick.

DVD is characterized by its high stor-
age capacity. It can be manufactured in 
various ways. The maximum version 
includes two layers on each side on 
which the data is stored. In this version 
the DVD can store 25 times as much 
information as the corresponding 
audio CD. One could, by making use 
of modern technology, manufacture 
audio discs with a playing time of 30 
hours. 

Feature films in good, digital image 
and sound quality can be stored on a 
DVD (�DVD-VIDEO). DVD is also 
suitable as a storage medium in the 
field of computers.

Here, the DVD is used as �DVD-
ROM and �DVD-RAM. The DVD-
RAM, however, is based on a different 
storage method than all other DVD 
standards. For this reason, DVD-RAM 
is not compatible with DVD-ROM or 
DVD-Video, which means that it can-
not be played back by means of Con-
sumer Electronic players, thus 
reducing the use of DVD-RAM exclu-
sively to the use as a mass storage 
medium in the computer sector. The 
DVD format enables construction of 
downward-compatible devices. DVD 
home devices can therefore also play 
audio CDs, DVD-PC-drives can play 
additional CD-ROMs. The existing 
CD stock can therefore be used for 
other purposes.

By including an number of refinements 
within the manufacturing and playing 
process, the storage capacity of the 
basic version of a DVD (single-sided, 
single storage layer) was enhanced by 
factor 7 in comparison with the CD. 
The functions, however, remained the 
same. The reached capacity of 4.7 GB 
will be enough for most applications in 
the following years (�DVD-5). A fea-
ture film with a running time of 133 
minutes can be stored on such a disc in 
various language and subtitle versions 
in the best picture quality nowadays 
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available for consumers. (More than 
500 lines horizontal resolution). 

Since it has to be expected that the 
demand for storage in the field of com-
puter applications will increase even 
further in the future, the developers 
have integrated additional extension 
features. The maximum capacity is 
reached at 17 GB (�DVD-18).

D V D - 5  

Single-sided, single-layer DVD on 
which a maximum of 4.7 GB of data 
can be stored. 

D V D - 9  

Single-sided, dual-layer DVD on 
which a maximum of 8.5 GB of data 
can be stored.

D V D - 1 0  

Double-sided, single-layer DVD. 
Offers a maximum storage capacity of 
9.4 GB.

D V D - 1 8  

Double-sided, dual-layer DVD which 
offers a maximum storage capacity of 
17 GB.

D V D - R  

DVD-Recordable.

A variant of of the Digital Versatile 
Disk which can be written once. A 
DVD-R is a preform and corresponds 
to an empty tape in terms of function-

ality. The DVD-R can be written by a 
PC in the formats DVD-Video, DVD-
Audio or DVD-ROM. Generally, it 
should be possible to play back a 
recorded DVD-R with DVD-drives of 
your PC and - in the case of DVD-
Video formatted versions - with DVD 
players. This, however, causes some 
problems from time to time, in partic-
ular with first generation devices. The 
maximum storage capacity of a DVD-
R is 3.9 GB, next-generation DVD-Rs, 
however, will have a storage capacity of 
4.7 GB.

D V D - R A M  

DVD-Random Access Memory.

A DVD-RAM basically differs from a 
DVD-ROM in that both formats are 
not compatible with each other. This 
fact can be seen with the naked eye: the 
DVD-RAM is delivered in a housing 
referred to as "Caddy" and looks more 
like a large diskette. A DVD-RAM can 
be written and later deleted. It offers a 
maximum storage capacity of 2.6 GB 
on both sides. It can be read and 
played-back exclusively with DVD-
RAM PC drives. Since DVD-RAMs 
can be written and deleted, they are 
perfectly suitable as a fast and large 
exhangeable storage medium. DVD-
RAM drives can also play DVD-ROMs 
if they are inserted in a caddy.

D V D - R O M  

DVD-Read Only Memory.

A DVD-ROM is not manufactured as a 
preform and recorded later, but is cop-
ied from a matrix similar to a record or 
audio CD. The already recorded or 
written DVD leaves the manufacturing 
site and can, under no circumstances, 
be written later. The DVD-ROM can 
include any kind of data and is there-
fore mainly used as a computer storage 
medium. It can be compared with a 
CD-ROM, but offers increased storage 
capacity. DVD-ROMs will soon be 
available in all DVD-storage versions 
(DVD, DVD-5, DVD-9, DVD-10, 
DVD-18). As a rule, DVD-ROMs 
include PC data, such as softwares or 
data bases. It is, however, also possible 
to save video data on a DVD-ROM. A 
DVD-Video is basically only a special 
version of the DVD-ROM. DVD-
ROMs can be played back with PC-
DVD-drives.

D V D - V i d e o  

Digital Versatile Disc-Video.

One possible �DVD FORMAT. Com-
mon especially in the field of home 
entertainment with movies as content. 
According to plans, the DVD Video 
will replace the recorded VHS tape in 
the near future. Compared with a VHS 
cassette, the DVD not only offers 
enhanced image quality, but also sev-
eral additional features: the sound on a 
DVD-Video can be set to different lan-
guages, and subtitles in even more dif-
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ferent languages can be integrated. The 
same video Sequence can be located on 
the disk in different camera positions. 
The user can then select the desired 
sound, fade-in subtitles and switch 
between the different camera posi-
tions. All these functions can be real-
ized, but are only partly used in the 
case of current DVDs.

In the case of DVD-Video, the picture 
material is coded according to MPEG-
2 (MP@ML), thus realizing data rates 
of up to 9.8 Mbps. As a rule, only data 
rates between 2 and 8 Mbps are used. 
A motion picture with a duration of 
approx. 135 minutes can be stored on a 
�DVD-5 in this quality. The standard 
provides DVD-variants for which 
video material is coded with a reduced 
resolution (according to MPEG-2 
SP@ML and MPEG-1). These versions 
are suitable for DVD applications that 
require storage of a maximum of mate-
rial. 

The sound for DVD-Video can be 
stored in different formats. It is gener-
ally possible to store the sound on a 
DVD as uncompressed �PCM SOUND 
(up to 24 bits/96 kHz) or uncom-
pressed audio format (�DOLBY DIGI-
TAL AC-3 or �MPEG-1 Layer 2 MP2). 
A DVD-Video has to offer at least one 
of these formats.

Right after the introduction of DVD, 
the US and Europe disagreed on the 
question in which format the sound 
was to be stored. The NTSC countries 
soon chose Dolby Digital (AC-3), 

whereas the PAL countries concen-
trated on MPEG. Meanwhile both for-
mats are allowed in Europe, and both 
compression standards are also sup-
ported in NTSC countries.

D V E  

Digital Video Effect.

Abbreviation for digital video effects 
or device for generating them.

D V T R  

Digital Video Tape Recorder

�DIGITAL RECORDER

E B U  

European Broadcasting Union.

Organization of European broadcast-
ing stations located in Geneva. The 
EBU submits standardization propos-
als to the �ITU-R.

E d i t  D e c i s i o n  L i s t  
( E D L )  

The EDL (Edit Decision List) is a list, 
in table format, of the cutting data of 
the film in the form of timecode val-
ues. The EDL is generated automati-
cally during editing by many editing 
systems and can be saved to a disk. 
When working in off-line/on-line 
mode, the editing decision list is of 
vital importance: The EDL generated 
in �OFF-LINE EDITING is read into the 
�ON-LINE SYSTEM as a basis for the 
final cut. The problem inherent in this 

process is that while the EDL contains 
all of the timecode values required for 
post-editing, it does not include any 
information about effects, color cor-
rections, sound level settings or similar 
items of information. Hence, inserting 
a diskette containing the EDL into the 
on-line editing control is generally not 
all there is to on-line editing; instead, 
effects and picture corrections must be 
reproduced.

There are various EDL formats such as 
Sony, CMX and CVG which can, how-
ever, be converted to one another by 
means of appropriate software tools.

E D L  

�EDIT DECISION LIST

E l e m e n t a r y  S t r e a m  

�MPEG-2 data streams can consist of 
different components. If video and 
audio data are saved and handled sepa-
rately, the data stream is referred to as 
Elementary Stream which is, among 
other applications, also suitable as a 
source for DVD-Authoring Systems. 
Video and audio linked to each other 
in bundles is referred to as �PROGRAM 
STREAM which is also used in the case 
of �DVD-VIDEO.

E m b e d d e d  A u d i o  

Audio signal included in a digital sig-
nal like the �SDI SIGNAL.
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E N G  

Electronic News Gathering. This term 
is nowadays mainly used for describing 
the shooting of short news reports with 
teams consisting of one or two mem-
bers. The equipment used for this pur-
pose is easier to handle and more 
robust than studio equipment.

E Q  ( E q u a l i z e r )  

The loudness of certain frequency 
ranges can be selectively increased or 
decreased by means of an equalizer.

E t h e r n e t  

Standardized network that can be used 
with different data rates. 10 Base-T and 
100 Base-T (100 MB/s) are the most 
common ones. Gigabit-Ethernet is 
supposed to handle even higher data 
rates of 1000 MB/s and is currently 
being developed and refined.

F a d e r  

Slider control of electronic devices 
such as audiomixers, amplifiers and 
recorders by means of which the 
amplitude of a signal can be invariably 
changed. This traditional user element 
is often displayed in graphical software 
interfaces.

F a d e  t o  b l a c k  

The video amplitude is slowly reduced 
to zero, the picture content in the end 
position is uniformly black.

F i b e r  C h a n n e l  

Fiber Channel was developed as a 
serial interface specifically designed 
for transmitting extremely large quan-
tities of data. Fiber Channel includes 
quite a few standards and can be 
applied in various ways: Point-to-
Point, Arbitrated Loop (AL) and 
Switched Fabric.

Point-to-point is specifically suitable 
for direct high speed connections, for 
example between a workstation and a 
disk array. By means of Arbitrated 
Loop (AL), up to 126 devices can be 
loop-connected, thus enabling data 
rates up to 200 MB/s. The third possi-
bility is a distributor known as Fabric 
by means of which large quantities of 
data can be transmitted in the GB area 
via Fiber Channel.

F i e l d  

Each video image displayed by inter-
lacing comprises two fields. One field 
of a video image includes all uneven 
lines, the other one the even lines. 
�PROGRESSIVE SAMPLING does not 
know any fields.

F i e l d  S e q u e n c e  

Each PAL video frame (�FRAME) con-
sists of two fields. When editing, one 
has to pay attention that - explained in 
simple terms - the right Sequence is 
adhered to. Each first and second field 
has to follow alternately, and the two 

first fields may not be edited succes-
sively. 

It becomes even more intricate when 
working with composite signals. Based 
on technical circumstances that we will 
not explained in detail, only every 
eighth field is identical in technical 
terms. Precise operation to avoid 
potential problems requires editing of 
this signal at a certain point and not at 
any given point, which means that the 
editing point has to be displaced by up 
to seven fields from the desired loca-
tion. This is of course an obstacle for 
creativity and results in the fact that no 
editors in the professional, creative 
sector use composite signal editing any 
longer.

Component video signals are not sub-
ject to such restrictions and allow edit-
ing any field boundary.

F i l e  S e r v e r  

�SERVER

F i r e W i r e  

�IEEE 1394

F r a g m e n t a t i o n  

Changing, partial deletion or comple-
tion of existing data on a �HARD DISK 
leads to increased hard disk fragmen-
tation. The created gaps between the 
sectors are written on over and over 
again. Linked �CLIPS or files are sub-
divided into individual parts on the 
hard disk and recorded across numer-
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ous, incoherent disk sectors. The read 
head of the hard disk has to be reposi-
tioned during reading of a clip, thus 
constantly crossing the complete disk 
radius in the worst case. This takes 
time, leads to reduced disk velocity 
and to interrupted rendition, all of 
which should be avoided. Certain ser-
vice programs should therefore be 
used to regularly defragment the hard 
disk to optimize the reading velocity.

F r a m e  

Each video frame in PAL standard is 
composed of 625 picture lines and 
divided into two subsequent �FIELDS. 
PAL works with 25 frames per second. 
The first field contains the uneven, the 
second one the even lines. The division 
into fields is intended to represent pic-
tures to the human eye in such a way 
that flickers are almost absent. In addi-
tion, it leads to a frame rate of 50 Hz 
with PAL, at which the human brain 
does not perceive the frames as indi-
vidual ones but as a continuous 
Sequence instead. 

F r a m e  r a t e  

In motion picture and video technol-
ogy this is the frequency with which 
picture information is renewed on a 
screen within one second (measured in 
�HZ).

Minimum frame rates of 50 Hz are 
necessary in order to achieve a flicker-
free picture on a monitor. Computer 

monitors generally work with a repeat 
frequency of 75 Hz or more.

F r a m e  B u f f e r  

Digital storage for individual video 
frames, generally offered as a compo-
nent of �TBCS or �STANDARD CON-
VERTERS only.

F r a m e s t o r e  

�FRAME STORAGE

F r e e z e  

If a video recorder is switched to pause 
during playback, it outputs a freeze 
frame. In the freeze frame signal, the 
data of the same individual picture is 
output in a continuous Sequence. Nat-
urally it is also possible to read out 
freeze frames from a memory (frame 
buffer).

F r e q u e n c y  

The number of oscillations within a 
certain period of time measured in 
�HZ. Since the video sector mainly 
works high frequencies, the abbrevia-
tion MHz meaning Megahertz is very 
common. Frequency indications are 
often used in video technology for var-
ious purposes, e.g. for determining 
bandwidths, sampling rates and carrier 
frequencies.

F X  

Abbreviation for effects. It is used in 
various different fields, of film and TV 
production.

In post production, the FX is com-
monly referred to as a general term for 
any kind of image manipulation such 
as wipes and keying effects, 3-D image 
manipulation, color variations etc.

G B  

�GIGABYTE

G e n e r a t i o n  l o s s e s  

Generation losses are any kind of qual-
ity impairment caused by duplicating 
material. Every recording or re-record-
ing causes a degradation in terms of 
signal quality. Generation losses are 
clearly visible in analog magnetic tape 
recordings.

Digital systems, however, that use 
compression, may also cause such 
losses. Realization of elaborate digital 
tricks by making use of various effects 
may lead to �SEQUENCING of various 
compression or decompression steps. 
If the same picture material is com-
pressed and decompressed over and 
over again, a loss in picture quality 
becomes visible as a result of rounding 
errors after a few generations. This dig-
ital recording loss is higher, the higher 
the compression factor. Digital dupli-
cation losses are usually of no impor-
tance in normal editing without 
multiple effect levels.
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G i g a b i t  E t h e r n e t  

�ETHERNET

G i g a b y t e  
Measuring unit for data quantity. One 
gigabyte corresponds to 1 024 mega-
byte. This value is a result of the com-
puting tradition to count by power of 
two: 
1GB=210MB=220kb=230bytes=1, 
073, 741, 824 bytes.

Many manufacturers nowadays have 
do no longer work with this traditional 
binary system and are using the deci-
mal system instead in which one 
gigabyte corresponds to 1, 000, 000, 
000 bytes.

G O P  

Group of pictures

�MPEG

G P I  

General Purpose Interface.

Interface that creates simple start/stop 
commands. GPI jacks are often located 
in genlocks and linear editing controls. 
GPI impulses are used for triggering 
external devices and to start a 
Sequence of effects via GPI or to fetch 
the next stored page of a title generator 
or fixed image system.

G U I  

Graphical User Interface.

Graphical user interface, i.e. the moni-
tor screen by means of which the user 
operates a computer or other devices.

H a r d  d i s k  

Magnetic storage medium for record-
ing bigger quantities of digital data. 
The hard disk is subdivided into sec-
tors in which data are stored. An 
address book makes sure that the 
stored data can be found later on. The 
magnetic disk rotates, and an axially 
movable write/read head is positioned 
in such a way that the individual sec-
tors can be read or newly written.
The most important factor apart from 
the storage capacity indicated in 
�GIGABYTE is the velocity of the disk. 
In particular in the case of non-linear 
editing systems, very fast hard disks 
are required, since the performance of 
the systems is, among other aspects, 
also determined by the performance of 
the hard disk.
It is of particular importance that a 
data transmission rate as high as possi-
ble be reached without interruption of 
the write and read operations (sus-
tained data rate). A good measure for 
the quality of a disk is the minimum 
data rate guaranteed by the manufac-
turer. The maximum top values often 
mentioned are of lesser importance in 
video operations. If longer video 
scenes are to be disk-recorded, the 
continuously reached data rate should 
not drop, since this could cause drop-
outs, i.e. interruptions in the motions. 
Some manufacturers offer special AV 
hard disks. Their special controlling 
software suppresses recalibration of 
the disk during writing or reading pro-
cesses. Background of this modifica-

tion for AV use: "Normal" hard disks 
recalibrate as soon as the hard disk gets 
too hot during operation, the fact leads 
to inaccurate reading or writing of the 
data Tracks. This thermal recalibration 
is normally automatically activated 
and can, in extreme cases, take longer 
than one second, thus causing the data 
rate to drop to zero. This, however, is 
not acceptable for continuous video 
playing. �RAID, �SCSI.

H D C A M  

The digital video tape format HDCAM 
by Sony is based on digital Betacam. It 
was designed for �HDTV APPLICA-
TIONS and enables a resolution of 1920 
x 1080 pixels in 16:9 format (59.94 or 
60 Hz). The carrier is a 14 mm wide 
metal particle tape with extremely fine 
particles (length: 0.125 mm) reeled in 
a Betacam cassette housing.
HDCAM records 12 Tracks with a 
width of 20 mm each per frame and 
compresses the digital data internally 
by factor 4:1. The tape is described as 
having a video data rate of 140 Mbits/s.

H D T V  

High Definition Television.
General term for all kinds of TV sig-
nals offering increased �RESOLUTION, 
i.e. pictures with enhanced sharpness 
in comparison with most commonly 
known TV systems. Unfortunately, no 
worldwide uniform HDTV standard 
exists. Despite a large bandwidth of 
different versions with different line 
numbers and frame frequency, there 
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are some uniformly valid parameters: 
HDTV works with a 16:9 aspect ratio 
and a number of lines that is consider-
ably higher than that compared with 
PAL or NTSC. (1250 lines/50 Hertz 
and 1125 lines/60 Hertz) is nowadays 
actively used. HDTV is only used on a 
small scale worldwide. �DTV regula-
tion in the United States will increase 
the number of HDTV playing modes, 
among them 1080i (1080 lines, 
�INTERLACED) as well as 720 p (720 
lines, �PROGRESSIVE).

H e r t z  ( H z )  

Hz = Abbreviation for Hertz
Measuring unit for a frequency named 
after Heinrich Hertz. X Hertz corre-
spond to x oscillations per second.

H i  8  

Analog video tape format from the 
field of consumer electronics using 8 
mm wide ME or MP tape. Hi 8 was 
further developed by Sony from 
�VIDEO 8. Separate processing of 
luminance (Y) and chrominance (C) 
signal and a larger video frequency of 
bandwidth of Hi 8 enables a higher res-
olution than with Video 8.

H o r i z o n t a l  r e s o l u -
t i o n  

Vertical resolution is determined in 
today's TV systems by the number of 
lines (PAL: 625, NTSC: 525). The hori-
zontal resolution may vary between 
different devices and formats. Hori-

zontal resolution is determined by 
means of test signals or test charts. 
They show vertically arranged, parallel 
�LINES. The number of lines (or the 
frequency corresponding to it) that the 
respective device can display as a pat-
tern consisting of individual lines is 
used as a measure.
Maximum resolution of a system or 
device can be expressed in lines or fre-
quency. The conversion formula is: 
Cutoff frequency in MHz x 82 = reso-
lution in lines.
The maximum horizontal resolution of 
the PAL standard is 5 MHz, i.e. 410 
lines. VHS devices reach a maximum 
horizontal resolution of approx. 3 
MHz (approx. 250 lines).

H o s t  

Main computer of a system, either rep-
resenting the central computer or car-
rying out certain controlling or 
monitoring functions.

H u f f m a n  

Algorithm used in many �COMPRES-
SION METHODS for loss-free data quan-
tity reduction.

H y b r i d  s y s t e m s  

Hybrid systems are editing and pro-
cessing systems which simultaneously 
control non-linear sources (hard disks, 
MO disks) as well as linear sources 
(video recorders), capable of mixing 
signals from both sources.

I E E E  1 3 9 4  

Standard for fast, serial data transmis-
sion at up to 400 Mbits/s. The slightly 
modified version for transmitting DV 
signals is referred to as �I.LINK.

IEEE 1394 was developed by Apple and 
introduced under the name 
�FIREWIRE. Different devices such as 
Camcorders, recorders as well as print-
ers, scanners, CD drives and hard disks 
can be linked to one another via IEEE 
1394. 

IEEE 1394 today supports up to 16 
devices per system and enables a maxi-
mum of 63 devices to be connected. 
Until today, the cable length was lim-
ited to 4.5 meters, but this problem will 
be solved in the future by using fiber-
glass cables. IEEE 1394 networks are 
then also possible.

i . L I N K  

i.LINK (�FIREWIRE) is the technical 
term for the IEEE 1394-1995 standards 
and their supplements. DV signals can 
be transmitted at a speed of up to 100 
Mbits/s via i.LINK.

I - f r a m e  

�MPEG

I - F r a m e  o n l y  

�MPEG
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I l l e g a l  C o l o r s  

Computer-based systems can generate 
colors that cannot be video-processed 
due to technical restrictions (they are 
located outside the �COLOR SPACE 
defined for video). Those creating 
graphics including increasingly satu-
rated red with a high luminance ratio 
will notice during video processing 
that this color cannot be displayed or is 
displayed in an altered or distorted 
way. Several paint and editing systems 
therefore include a function by means 
of which these illegal colors can be 
either displayed and excluded.

I m p e d a n c e  

Resistance.

Electric characteristic of components 
measured in ohms.

If various devices are combined or net-
work-linked, the impedance of the 
individual devices has to be adapted. 
Certain networks and video lines 
require a terminating resistor at their 
open ends to avoid distortions and sig-
nal changes.

I n l a y  

Window within a software interface in 
which a video signal is displayed.

I n s e r t  

Cut which is inserted into an existing 
video Sequence. In the case of mag-
netic tape recordings, insert editing 
exchanges image and/or sound signals 

without damaging the control Track. 
The other editing method used in 
video editing is �ASSEMBLE EDITING.

I n t e r f r a m e  C o m -
p r e s s i o n  

�MPEG

I n t e r l a c e  

For interlaced scanning the video 
frame is divided into two fields. These 
are transmitted and built up in succes-
sion. The first field contains all uneven 
lines of the picture, the second one all 
of the even lines. In the �PAL STAN-
DARD, 25 frames (hence 50 fields are 
transmitted per second. The human 
eye does not perceive these 50 fields as 
a Sequence of individual pictures, but 
as a continuous event.

I n t e r p o l a t i o n  

In the case of interpolation, a new 
intermediate value is calculated on the 
basis of known values.

Editing and compositing systems for 
example make use of interpolation to 
design movement effects.

Distorted images caused for example 
by �ALIASING can also be partially 
reduced by interpolation (�ANTI-
ALIASING).

I n t r a f r a m e  C o m -
p r e s s i o n  

�MPEG

I T U  

International Telecommunications 
Union.

This body determines standards. Man-
ufacturers in ITU often suggest certain 
standardization facts and solutions 
which are then examined by the ITU, 
possibly amended and then turned 
into a mandatory standard.

The standard ITU-R 601 is very well 
known.

The ITU includes different divisions 
dealing with standardization issues. 
The ITU-R is responsible for broad-
casting issues, whereas the ITU-T 
develops and passes on recommenda-
tions within the field of telecommuni-
cations. The ITU-R was previously 
known as CCIR, the ITU-T as CCITT.

I T U - R  6 0 1  

This standard defines the A/D conver-
sion of �COMPONENT SIGNALS. ITU-R 
601 defines 4:2:2 sampling which 
means that the luminance signal (Y) is 
sampled at 13.5 MHz, whereas the 
�COLOR DIFFERENCE SIGNALS (�B-Y, 
�R-Y) are sampled (quantisized) at 
6.75 MHz each.

J a c k  c o n n e c t o r s  

Jack connectors are used for analog 
audio signals and are available in dif-
ferent sizes: 6.3 mm and 3.5 mm are for 
example used for headphones, micro-
phones or active loudspeakers. In the 
course of miniaturization, manufac-
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turers are also supplying 2.5 mm ver-
sions. Adapters are available for all 
sizes. Stereo requires three-pole cables 
and connectors, mono two-pole con-
nectors.

J a m - S y n c  

Abbreviation for the capability of a 
device to read the timecode from the 
video tape and to continue writing this 
timecode in case of further recordings.

J a v a  

Java is a programming language devel-
oped by Sun Microsystems. It enables 
the programming of platform-inde-
pendent tools.

J i t t e r  

Small vibrations when displaying 
video on a screen. This phenomenon 
can often be seen in the case of facades 
with many straight edges.

Jitter is caused by many factors, mainly 
during tape-recording, as a result of 
phase fluctuations.

J o g / S h u t t l e  

Operating wheel for controlling video 
(tape) drives. The jog/shuttle wheel 
enables easy change between playing 
and winding as well as detailed cross 
connecting frame per frame.

Jog/Shuttle wheels are very common in 
conventional technology, but are now-
adays often available in many non-lin-
ear editing systems in the form of 

certain, separate operating consoles as 
an optional feature.

J P E G  

Joint Photographic Experts Group.

JPEG refers to a standard for com-
pressing digital frames. The JPEG 
method is based on �DISCRETE COSINE 
TRANSFORMATION (DCT).

K e y  

1) Collective term for different func-
tions enabling partial combination of 
two video frames to form one new 
frame. Examples for this are 
�CHROMA KEYING and �LUMA KEY-
ING.

2) When working with a key function 
(�KEYING), the key signal has the 
function of a mask and determines 
which part of the frame results from 
which original source is sometimes 
simply referred to as key.

K e y c o d e  

In the field of film, keycode is synony-
mous to timecode and serves as a 
means for numbering the frames in a 
machine-readable way. 

A code is applied to the negative stock 
at the perforations. This code can be 
read by certain devices and includes, 
besides the numeration, information 
such as data regarding manufacturer of 
the respective material. Furthermore, 
the keycode is used to re-edit the origi-
nal negative stock more or less auto-

matically (in an ideal case) after non-
linear offline-editing based on an 
�EDIT LIST (�EDL).

K e y f r a m e  

Keyframes are frames within an effect 
Sequence determined by the user as 
start, turning or finish of an effect.

To be able to calculate or execute a key-
frame-based effect, at least two key-
frames have to be determined, i.e. start 
and finish. If the effect is not supposed 
to be run in a smooth linear way or 
according to a curve defined by the 
manufacturer, further keyframes have 
to be set within the Sequence indicat-
ing the progression. The effect pro-
gression between the keyframes is then 
automatically calculated (�INTERPO-
LATION).

K e y i n g  

Keying is the process of combining two 
video pictures to form a new picture in 
which a certain area of the video pic-
ture is superimposed on the other 
video picture. With each used �KEY, 
the user defines which areas of the pic-
tures should be superimposed in what 
form on the other picture (�KEY, 
�CHROMAKEY, �LUMINANCE KEY).

L A N C  

�CONTROL INTERFACES
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L a y e r  

In postproduction, in particular in 
�COMPOSITING, a term for describing 
the individual image elements or chan-
nels that are supposed to be combined 
with each other or superimposed on 
each other and which form a common 
source image. To be able to link up the 
different layers, �KEYS AND MASK 
TECHNIQUES are used.

L a y e r i n g  

Working with �LAYERS. In compli-
cated postproduction Projects many 
individual picture elements are com-
bined to form one common video 
image. Some time ago this had to be 
done in a number of successive copy-
ing steps. Modern non-linear editing 
and compositing systems nowadays 
offer channels or layers that can be 
graphically displayed to enable a better 
overview of the layering. Later changes 
of a layer are possible with non-linear 
systems without having to newly carry 
out all other work steps.

L e v e l  

This term was originally used to 
describe a value to be set, such as loud-
ness. The term, however, is nowadays 
also used to describe the quality steps 
within �MPEG.

L i n e a r  e d i t i n g  

The term linear editing is derived from 
linear editing systems. Up to then the 

commonly used term was video edit-
ing. In the case of linear editing, at least 
two video recorders are controlled in 
such a way that scenes can be marked 
on the original tape in order later to be 
copied onto another recorder scene by 
scene. There are, however, two limita-
tions for creative work: If a scene with a 
different length is supposed to be cop-
ied onto the already edited tape, all 
successive scenes have to be recopied 
again, since all scenes have to be on the 
tape in linear order. Simple insertion as 
in conventional film editing is not pos-
sible. Furthermore, access to the indi-
vidual scenes of the original material is 
not directly possible. The tape has to 
be spooled to the respective place for 
access because the scenes are also 
recorded on the original tape in linear 
Sequences. Linear editing in the case of 
video tapes prolongs the effective edit-
ing time due to the required �PRE-
ROLL, cue review and winding times of 
the recorders.

L i n e s  

In opposition to the horizontal TV-
lines the number of which is predeter-
mined by TV systems (PAL:625, 
NTSC:525) vertical lines serve as a 
measure for horizontal �RESOLUTION 
OF A DEVICE (or system or format). 

It is indicated how many vertical, par-
allel adjacent lines the respective 
device can display as a pattern consist-
ing of individual lines.

The maximum horizontal resolution in 
lines can also be expressed as fre-
quency and referred to as cut-off fre-
quency. The formula is: Cut-off 
frequency in MHz x 82 = resolution in 
TV-lines.

L o g g i n g  

Term used for searching, selecting and 
marking of the original material, on 
the occasion of which it is determined 
which video and audio Sequences will 
be used in the final film. Only these 
parts are then digitized. This saves you 
time and storage capacity and enables 
a broader overview. As a rule, a time-
code list is produced during logging 
which includes all start and finish 
points of the usable scenes. Dubbing of 
the marked passages can be carried out 
during logging or later in a separate 
step known as �BATCH DIGITIZING.

LT C  

Longitudinal timecode
This �TIMECODE, like a sound signal, 
is written onto an outer audio Track or 
a special separate longitudinal Track of 
the video tape specially provided for 
the timecode. Later recording of the 
LTC is also possible. LTC can be read 
during forward or backward playing of 
the tape but not if the tape is stopped, 
i.e. in the case of fixed images. �VITC 
serves as an alternative or supplement 
to LTC.
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L u m i n a n c e  S i g n a l  

To display video images, information 
on brightness and color are required 
for every single pixel. This information 
is commonly sampled in video tech-
nology in the form of one brightness 
and two color difference signals. The 
brightness ratio of a video signal is 
referred to as luminance signal (Y).
In the beginning of electronic image 
processing, in cameras and film scan-
ners, three signals are generated at first 
which correspond to the blue color 
ratio of the light. Three new signals are 
calculated from these three signals: one 
brightness signal and two color differ-
ence signals by using the following for-
mula: Y=0.3R + 0.59G + 0.12 B.
This evaluation was developed empiri-
cally and is based on the brightness 
perception of the eye and the charac-
teristics of tube cameras and monitors.

L u m i n a n c e  K e y  

An effect making use of luminance 
information of an image to create a 
"keying template" 
(�ALPHA CHANNEL). If, for example, a 
black font is used on a white back-
ground as a luminance key model, 
either the black font or the white back-
ground can be removed by keying and 
replaced by an image content of a dif-
ferent video image. Fonts and logos are 
often inserted into video images by 
means of luma keying.

M a i n  L e v e l  

�MPEG

M a i n  P r o f i l e  

�MPEG

M a s t e r  

The master or master tape is the tape 
on which the final cut is recorded.

M a x i m i z e r  

Maximizers are intelligent audio pro-
cessors. Through the use of targeted 
compression of audio material they 
effect a subjective volume increase 
without actually increasing the audio 
level.

M B  

�MEGABYTE

M e g a b y t e  

Unit of measure for data quantities.

According to the traditional definition 
of 1 �BYTE is 210 x210, then 1 MB 
comprises 1,024 x 1,024 bytes = 
1,048,576 bytes. Recently, some of the 
manufacturers have stopped using this 
traditional binary calculation method, 
and are using the decimal system 
instead. According to this version, one 
megabyte corresponds to 1,000,000 
bytes.

To display a full uncompressed frame 
with full resolution in accordance with 

ITU-R 601, graphics data of slightly 
less than 1 MB are required (830 KB).

M e g a h e r t z  

A �FREQUENCY of one million oscilla-
tions (samples) per second. (�HERTZ)

M e t a d a t a  

Data about data: Metadata comprises 
all information stored by the system 
about the actual useful data used for 
the work. Metadata are particularly 
important for archiving or other data-
base functions.

M H z  

�MEGAHERTZ.

M I D I  

Musical Instruments Digital Interface.

MIDI is a digital communications 
standard for electronic musical instru-
ments and effects devices. Controlling 
of such devices by means of a PC 
requires a MIDI interface.

M i x e d  R e s o l u t i o n  
E d i t i n g  

If an editing system features the Mixed 
Resolution Editing function, this func-
tion permits the use of material of dif-
ferent quality levels in one and the 
same Project. This is important if the 
material was digitized in various reso-
lutions in order to save fixed disk 
capacity.
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M - J P E G  

Motion JPEG is a video compression 
process which is based on �JPEG 
(JOINT PHOTOGRAPHIC EXPERTS 
GROUP). During this process, each sin-
gle frame is compressed separately, and 
the data stream generated in this way is 
processed as a linked Sequence of 
JPEG-compressed single frames. There 
is no universal M-JPEG standard - the 
individual manufacturers have stipu-
lated their own formats in this regard.

M L  

�MPEG

M O  D i s k  

Magneto-optical disk.

MO disks combine the technical bene-
fits of an optical medium (CD) with 
the advantages of magnetic recording.

The �STORAGE CAPACITIES per disk 
are in the �GIGABYTE range. Because 
they are secure and robust, MO disks 
are particularly well suited to 
archiving.

M o t i o n  v e c t o r s  

Direction and distance information 
used in �MPEG encoding. This 
defines the movement of an image por-
tion from one �FRAME to the next.

M P  

�MPEG

M P @ M L  

�MPEG

M P E G  

MPEG is a standardized compression 
procedure particularly suitable for the 
compression of data of full-motion 
pictures.

In the case of MPEG being an asym-
metrical compression method, coding 
is far more complicated than decoding. 
Important: MPEG specifies the data 
format and the decoding process, but 
lets the manufacturer decide how to 
create the data. Each manufacturer can 
use his/her own coding method and 
algorithms, as long as standard MPEG-
coded data streams are created that can 
be read and played-back with any stan-
dard MPEG decoder.

An important difference between 
MPEG and other compression proce-
dures such as �M-JPEG is that MPEG 
does not necessarily compress single 
frames (intraframe) only, but can also 
analyze the data of several successive 
images and use the information 
derived from this for compression. On 
this basis a video Sequence can be 
compressed far more effectively, as 
frame information of several single 
frames can be collated. In technical jar-
gon this is referred to as Interframe 
Compression. The single frames of a 
video Sequence are composed of I, B 
and P frames, in accordance with the 
MPEG standard. I frames are index 
frames. They contain all important 

frame information and are generally 
compressed in the same fashion as is 
done for each single frame during a 
motion JPEG compression. However, 
with MPEG it is also possible to imple-
ment different levels of compression in 
different sections within a frame, for 
example, the compression imple-
mented for the frame center is less than 
that implemented at the edges. Com-
pared to motion JPEG, this feature 
permits a 10 - 15% data reduction with 
the same level of optical quality. B 
frames are bi-directional frames, i.e. 
frames which only contain the differ-
ences between a frame and the previ-
ous or following one. The term "P 
frame" stands for Predicted Frames. 
They are interpolated on the basis of 
frames which have appeared so far.

The MPEG standard refers to the 
Sequence of I, B and P frames as a 
Group of Pictures (GOP). Each manu-
facturer can use GOPs of any length 
and composition. The only prerequi-
site is that a GOP must contain at least 
one I frame.

The subject area of GOP also incorpo-
rates a restriction or, at least an obsta-
cle which is typical of MPEG: Cutting 
in the middle of a GOP is either not 
possible at all or requires considerable 
technical effort. Therefore, MPEG-
based interfaces work with very short 
GOPs or exclusively with I frames.

Initially, MPEG was defined as a com-
mon basis for four individual stan-
dards.
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Both MPEG-1 and MPEG-4 work with 
low data rates and are therefore prima-
rily suited for multimedia or telecom-
munications applications. MPEG-3 
was originally used in HDTV applica-
tions but is today only used for audio 
compression (MP3), whereas video 
compression was later integrated into 
the MPEG-2 standard. In professional 
video systems, the MPEG-2 standard 
plays the most important role.

MPEG-2 is divided into various pro-
files and levels for which different 
parameters were stipulated: data rates, 
GOP structures, resolution, i.e. the 
number of of lines and pixels as well as 
the �SAMPLING and �FRAME fre-
quency.

In post-editing, MPEG-2 422P@ML 
has been established (also referred to 
as 422 Studio Profile@Level). This 
MPEG version only operates with I 
frames and 4:2:2 sampling; the resolu-
tion is 720 x 608 pixels. The standard-
ized maximum data rate is around 50 
Mbits/s.

Hence, MPEG-2 provides a special 
sub-procedure for different applica-
tions. It is equally important to note 
that, while MPEG-2 prescribes the 
decoding in detail, it is up to the indi-
vidual manufacturers to use their own 
coding procedure. The only prerequi-
site is that MPEG-2-coded data must 
be readable and playable on any type of 
MPEG-2 decoder. Therefore, in con-
trast to �M-JPEG, exchangeability of 
MPEG data between two systems is 
ensured.

M P E G - 1  

�MPEG

M P E G - 1  L a y e r  1 ,  
2 ,  3  A u d i o  

Different audio codecs are provided in 
the MPEG standard, i.e. layer 1, layer 2 
and layer 3. The complexity and per-
formance of these schemes increases 
from layer to layer. The layers are 
upward-compatible with each other, 
i.e. a layer-2 decoder also accepts layer-
1 audio, but not layer-3 audio. All 3 
layers can use 32, 44.1 or 48 kHz sam-
pling frequencies. Layer 2 is of impor-
tance in creating DVD.

M P E G - 2  

�MPEG

M P E G - 3  

�MPEG

M P E G - 4  

�MPEG

M u l t i m e d i a  

This heavily abused term, which is at 
times used rather randomly for totally 
different subject matters and circum-
stances, is undergoing continuous 
semantic change. According to one of 
the more precise definitions, multime-
dia is the combination of the most var-
ied of media communication methods 
in one interactive medium.

M u l t i - p r o c e s s o r  

Some of the newer workstations and 
computers can be equipped with more 
than just one processor (�CPU) and 
are not limited to one processor, as is 
the case with normal PCs. This can 
considerably increase the efficiency 
and speed of these workstations.

M u l t i - T r a c k i n g  

The multi-tRacking function is pre-
dominantly found in compositing sys-
tems. This function permits the 
marking of objects within a frame 
Sequence, by the definition of one or, 
preferably, several (up to 4) distinctive 
points edges or transitions and the 
tRacking of the movements of the 
object over the complete scene.

The tRacker analyses and records the 
movements and also permits the allo-
cation of these movement Sequences to 
other objects. In this way, moving 
objects can also be used as a template 
for masks and keys. Furthermore, the 
recorded movement Sequences also 
allow computer-generated objects to 
be realistically integrated into scenes, 
during which the camera is moving.

N a t i v e  D i g i t a l  
E d i t i n g  

Editing systems featuring Native Digi-
tal Editing maintain the quality of the 
initial material during editing, by 
retaining the native original format 
during the editing process to as great 
an extent as possible.
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Hence, no unnecessary, avoidable con-
versions or decompression and recom-
pression steps are implemented with 
the material played in. Therefore, the 
best possible picture quality is main-
tained.

Conversions are only implemented 
when absolutely unavoidable, e.g. in 
the event that analog material is played 
in or if dissolves or effects are sup-
posed to be performed with the picture 
material.

N o i s e  

Irregular level variations of a low order 
of magnitude. All analog video signals 
contain noise contents. Ideally, the 
noise level may not be more than an 
LSB (Least Significant Bit) of the digi-
tal dynamic range. Signals which are 
pure digital generations do not contain 
any noise.

N o n - d r o p  f r a m e  

Strictly speaking, NTSC does not work 
at a frame rate of 60 Hz, but of 59.94 
Hz. This corresponds to 29.97 frames 
per second.

Due to this uneven figure, problems 
may arise in relation to the timecode. 
The 0.03 fields which are missing per 
second, add up to form whole pictures, 
leading to a mismatch between the 
timecode value and the number of 
frames. In technical terms, this prob-
lem is solved by using the drop frame 
procedure. In this process, two frames 

are simply left out per minute. The 
time mismatch which would normally 
occur is thus prevented. However, it is 
also possible to operate NTSC record-
ers in the non-drop-frame mode. In 
this case all 30 frames are displayed 
and the described time displacement 
occurs.

N o n - l i n e a r  E d i t i n g

In non-linear editing the editor can 
access each frame of the existing mate-
rial directly and without any spooling/
pre-rolls or search periods. The storage 
medium used does not specify any 
Sequence within the picture material 
which would have to be observed dur-
ing processing. It is possible to imple-
ment changes at any point of a Project 
and at all times.This permits a mixture 
of film and video cutting methods. 
Picture material can be handled in a 
speedy and flexible manner.

N o n - S q u a r e - P i x e l  

�PIXEL

N T S C  

National Television Standards Com-
mittee.

The NTSC was developed in the USA 
and is the oldest standard for color pic-
ture broadcasting. NTSC operates at 
60 Hz and with 525 lines, 60 fields and 
30 frames per second. NTSC is used in 
the USA, Canada and Japan and in 
many other countries. In Europe, PAL 

is mainly used for TV broadcasting. 
The bandwidth of NTSC is 4.2 MHz, 
the color signal is modulated on an 
auxiliary signal (subcarrier) at a fre-
quency of 3.58 MHz. 

O f f l i n e  E d i t i n g  

During offline editing, films are gener-
ally cut with a reduced picture quality 
and on a cheap system for cost reasons. 
On completion of the off-line editing 
process, the editor stores his 
�EDITING DECISION LIST (EDL).

This EDL is used as a basis for the 
post-editing of the film in a second 
work phase in the on-line studio, with 
the full quality and the more expensive 
devices required for this purpose.

O n l i n e  E d i t i n g  

During online editing the master of a 
film is edited in the best possible qual-
ity. The end product is generated in 
one work step. In the event that the 
Project was previously edited off-line, 
the �EDITING DECISION LIST derived 
from off-line editing is used as the 
basis for on-line editing.

O p t i c a l  D i s k  

�OPTICAL STORAGE MEDIA

O p t i c a l  s t o r a g e  
m e d i a  

The basic principle of optical disks 
such as CD and DVD is the same: a 
disk of transparent polycarbonate is 
vaporized on one side with reflective 
coating and coated with wafer-thin 
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varnish. In the polycarbonate disk a 
helical, narrow-wound Track extends 
from the inside to the outside through 
the plastic. On this Track, digital infor-
mation in the form of lands and pits 
are lined up one behind the other. Each 
transition, irrespective of its direction, 
stands for a digital 1; the absence of a 
transition represents a digital 0.

The windings of the data spiral are 1.6 
mm apart; thus 50 windings would be 
as wide as a single human hair. The 
individual pits are between 0.8 and 1 
mm. When played, the disk rotates 
while an axially mobile scanner unit 
follows the data Track. This combined 
scanner unit consists of a laser diode 
and a lens with a photodiode at the 
back. The laser beam of the laser diode 
is thrown back by the reflective rear 
side coating of the CD. If the beam hits 
the lands, it is directly reflected into the 
lens system at high intensity, while the 
pits, by contrast, scatter the beam and 
only a little light falls on the photo-
diode. The changing intensity of the 
reflected light impulses therefore 
reproduces the bit Sequence or data 
stream.

O r i g i n a l  

The tapes which were used for the ini-
tial recording, are referred to as the 
original or original tapes. In most 
cases, original tapes are produced by 
the camcorder or the studio recorder 
in the case of studio productions or 
film scanning. The best scenes of the 

original tapes are selected during edit-
ing, compiled to the finished film and 
recorded on the �MASTER.

PA L  

Phase Alternating Line.

PAL is the predominant TV standard 
in Europe. PAL operates at a frequency 
of 50 hertz which corresponds to 25 
frames or 50 fields and with 625 lines. 
Compared to NTSC, the type of color 
transmission is different for PAL which 
yields advantages for the color stability 
of the transmitted pictures, but also 
requires higher technical expenditure 
and causes problems in post-editing.

(�FIELD SEQUENCE). In the case of 
PAL, the bandwidth is 5.5 MHz, the 
color carrier Sequence 4.43 MHz.

PA L p l u s  

PALplus is a TV standard which was 
developed on the basis of PAL and is 
compatible with PAL. The fundamen-
tal differences between PALplus and 
PAL are that PALplus operates with a 
aspect ratio of 16:9 and pre-filtering of 
the PALplus signal to ensure a better 
picture quality.

In PALplus the 575 lines of the active 
picture content is composed of a cen-
tral band signal which consists of 432 
lines and a helper signal containing 
143 lines. With a PALplus receiver the 
complete picture can be represented, 
i.e. the 575 active lines. On the other 
hand, a conventional 4:3 receiver rep-

resents the 432 lines of the central band 
in letterbox format, that is, with a black 
bar at the top and bottom edge of the 
picture.

P a n a s o n i c  E d i t  

�CONTROL INTERFACE

P C M  

Pulse Code Modulation.

The Pulse Code Modulation method is 
one of several methods used in analog/
digital conversion. The PCM sound 
named after this method of �DVDS 
and different video tape formats usu-
ally includes two digital audio chan-
nels.

P  F r a m e  

�MPEG

P i x e l  

Picture element, picture point.

A pixel is the smallest unit within a ras-
ter image.

Pixels are further divided into square 
pixels (square picture points) and non 
square pixels.

The reasons for this are as follows:
In contrast to computer monitors, 
video monitors operate with rectangu-
lar instead of square pixels, as they are 
also defined in �ITU-R 601 (non 
square pixel). A PAL picture on a video 
monitor has 720 x 576 pixels. 
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In the computer field, however, square 
pixels are the norm. A 4:3 PAL picture 
must be represented on a computer 
monitor with 768 x 576 pixels, due to 
the square pixel form, in order to 
maintain the same aspect ratios.

In the event that the difference between 
square and non-square pixels is not 
taken into account by the manufac-
turer of a computer-based video sys-
tem, there may be slight distortions in 
the representation of video images on 
computer monitors.

P l a t f o r m  

In our somewhat narrower definition, 
a platform is the combination of pro-
cessor and operating system with 
which a computer or a workstation 
operates.

In postproduction, the term "plat-
form" mostly relates to the operating 
system only. The operating systems 
Windows, MacOS and Unix are widely 
used.

Most of the manufacturers offer their 
interface systems on one of the three 
specified standard platforms. Hence, a 
normal computer from the Intel family, 
a Macintosh or a silicon graphics com-
puter is used and extended to form a 
non-linear system with hardware 
(mostly plug-in cards), software and 
standard peripheral devices (SCSI 
hard disks).

P l a y b a c k  S e r v e r  

�VIDEO SERVER

P l u g - I n  

A plug-in is a software extension which 
can change, expand or update the 
scope of performance of editing or 
compositing software in partial areas. 
Plug-ins are frequently used in post-
production to expand the effects capa-
bilities of a system.

P o s t p r o d u c t i o n  

The work processes used by the 
motion picture and video industry can 
be divided into several phases. Post-
production describes the production 
phase of post-editing the recorded 
material. It therefore comprises work 
steps such as cutting, effect editing, 
post-addition of sound to the film and 
graphical editing.

P o s t r o l l  

The period required by a video 
recorder to bring the tape to a stand-
still and to change over from playback 
or recording to pause. This also applies 
to linear cuts with video recorders 
which do not stop abruptly upon com-
pletion of the cutting, but run slightly 
past the cut end.

P r e c o d i n g  
( S t r i p i n g )  

Generally the recording of a blackburst 
signal, a timecode and a �CTL SIGNAL 
to a magnetic tape. A recording tape 
must be precoded so that �INSERT 

CUTS can be implemented. The pre-
coding of tapes also offers advantages 
in terms of quality, as the roughness of 
unplayed tapes is initially more pro-
nounced and is then smoothed out 
during precoding which, in turn, 
improves recording quality.

P r e r e a d  

The preread function allows a video 
recorder to play a video signal and to 
record this video signal at precisely the 
same tape point at which it was played, 
in the same work step. This function 
makes it possible to achieve effects 
such as dissolves with a linear two-
machine editing workstation (for 
example for �ON-LINE EDITING). Nor-
mally three or more machines are 
required to produce such effects.

P r e r o l l  

1) The period required by a video 
recorder for the run-up from the pause 
function and switching into the play or 
recording mode is referred to as pre-
roll.

2) For linear cuts with video recorders, 
preroll is also understood to mean the 
rewinding of the tape to a defined 
point before the actual cutting point. 
The tape is parked at that point and 
also runs up from there during editing, 
such that playback is allowed to stabi-
lize until the cutting point.
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P r o f i l e  

�MPEG

P r o g r e s s i v e  S c a n -
n i n g  

During progressive scanning, a picture 
is built up line by line. PAL on the 
other hand uses �INTERLACED SCAN-
NING instead. Progressive scanning is 
commonly used with computers, but 
has also recently been used in some 
video devices which are marketed in 
the USA and which take into account 
the �DTV SPECIFICATIONS.

P r o g r a m  S t r e a m  

In contrast to the �ELEMENTARY 
STREAM, the Program Streams consist 
of only one file in which audio and 
video are linked to each other (multi-
plexed). This enables simultaneous 
playback of sound and image. Program 
Streams are mainly used for computer-
ized playback of high-quality videos 
(archiving, kiosk systems, etc.)

Q S D I  

�SDTI.

Q u a l i t y  S p e c i f i c a -
t i o n s  

Since there is no objective procedure 
for assessing the quality of pictures 
from non-linear systems as yet, it is 
customary to compare it with the pic-
ture quality of tape systems - even if 
this is like comparing chalk and 
cheese.

In order to grade the various picture 
quality levels within the own product 
range, various companies have created 
their own value systems.

Q u a n t i s a t i o n  

Quantisation describes the sampling of 
an analog signal during A/D conver-
sion. Video signals are frequently 
quantised with 8 or 10 bits, while val-
ues of 12 or 16 bits have been estab-
lished in professional audio systems.

Q u i c k t i m e  

Originally developed by Apple as a 
video format for Macintosh comput-
ers, Quicktime was initially compara-
ble with Video for Windows. However, 
Quicktime was then further developed 
and significantly expanded. Now 
numerous computer-based editing 
systems use Quicktime as an internal 
data format. Quicktime can be used on 
all platforms and is no longer exclu-
sively limited to Macintosh computers, 
but can also be used on Windows com-
puters.

R A I D  

Redundant Array of Inexpensive/Inde-
pendent Drives

This arrangement links up whole 
batches of hard drives in one device. 
They operate like one single large hard 
drive with a high storage capacity and 
fast access. Depending on the operat-

ing mode, RAIDs offer increased data 
security (�RAID LEVEL).

While RAIDs are the backbone of most 
of the hard disk recorders and servers, 
they are also increasingly used in con-
junction with editing systems.

R A I D  A r r a y s  

�RAIDS

R A I D  L e v e l  

Along with a high data throughput, 
RAID arrays also offer increased data 
security in most cases, provided that 
the RAID arrays are operated accord-
ing to the relevant level (0 to 5).

RAID 0: Several hard disks are oper-
ated in striping mode. During this pro-
cess the data is distributed to the 
various disks. While this process does 
not offer an increased level of data 
security, the write/read rate is very 
high.

RAID 1: The data is mirrored, i.e. writ-
ten to two disks. While this process 
requires double storage space, it offers 
a high level of data security.

RAID 2: Similar to RAID-1 arrays, but 
this level requires even more storage 
space as additional error correction is 
implemented.

RAID 3: Frequently used for disk 
recorders and servers. These arrays are 
highly efficient and, compared to 
RAID 0, offer an increased level of data 
security by storing back-up informa-
tion on an additional disk which can 
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be used to reconstruct data even if one 
of the other disks of the arrays fails to 
operate.

RAID 4: Based on RAID 3 but in con-
trast to that, it is also possible to trans-
mit smaller data blocks. 

RAID 5: Read access processes can be 
administrated in parallel, and are 
hence distributed to all drives. Other-
wise as for level 4.

R A M  

Random Access Memory

Temporary memory for data with 
which the processor is currently work-
ing. When the computer shuts down, 
the data contained therein are deleted.

R C T C  

Rewritable Consumer Timecode.

Sony developed the RCTC for con-
sumer devices of the Video8 and Hi8 
format. The RCTC is recorded in a spe-
cial tape range between picture and 
sound information. With devices that 
are equipped accordingly, the RCTC 
can be recorded later on any Hi8 or 
Video8 tape. Any timecode that may 
already be present is overwritten in this 
process.

During playback, the RCTC is read 
separately by the tape and output as a 
separate signal via the LANC remote 
terminal (�CONTROL INTERFACE) of 
these devices.

R e c o r d e r  

The term "recorder" refers to various 
types of recording devices. During lin-
ear editing the recording device is 
referred to as the recorder. The �MAS-
TER is recorded by the recorder; the 
slave device is called the player.

R e n d e r i n g  

Effects which are not available in real 
time must be calculated. This process 
is referred to as rendering. Numerous 
non-linear systems offer only a limited 
repertoire of real-time effects and to a 
large extent work with effects which 
must be rendered.

R e s o l u t i o n  

The better the resolution of a system, 
format or device, the finer the visible 
picture details. The resolution is often 
used as a synonym for sharpness. As a 
standard, the maximum resolution is 
indicated in �LINES or �MEGAHERTZ. 
The number of lines is predetermined 
by the individual TV systems and indi-
cates the respective vertical resolution 
(PAL: 625 lines; 576 of them are active 
lines that are in fact used for the pic-
ture content). For this reason, only the 
horizontal resolution is indicated.

�PIXEL NUMBERS are often stated as a 
measure for resolution, e.g. 720 x 576 
which corresponds to the PAL resolu-
tion. In common practice one should 
pay attention to the fact that these indi-
cations often refer to system limits and 

not to values attainable in reality, for 
they are influenced by individual com-
ponents ranging from Camcorders to 
monitors. Each component within the 
signal path can influence the attained 
resolution.

R G B  

RGB is the abbreviation for the pri-
mary colors, i.e. red, green and blue. 
Cameras, video and computer moni-
tors work internally with RGB signals. 
In video systems, RGB signals are not 
generally transmitted between the dif-
ferent devices; instead, other signals 
which are derived from RGB (�LUMI-
NANCE SIGNAL, �COLOR DIFFERENCE 
SIGNALS) are used.

R O M  

Read Only Memory

Non-writable memory with perma-
nently stored data.

(�RAM).

R o t o s c o p i n g  

Animation technology for which live 
footage is used as a reference for ani-
mated cartoon Sequences which were 
drawn in individual frames. Rotoscop-
ing was already in use back when ani-
mated films were still drawn manually. 
Advanced computer systems have sim-
plified rotoscoping with numerous 
semi-automatic functions.
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R S - 2 3 2  

Standard for the transmission of serial 
data over short distances. For example 
PCs have RS-232 interfaces (�CON-
TROL INTERFACES).

R S - 4 2 2  

Standard for the transmission of serial 
data over medium distances (up to 300 
m).

RS-422 interfaces are a very common 
feature in professional video systems 
and are used for the remote control of 
the devices.

(�CONTROL INTERFACES).

Sampling

Process with which analog signals can 
be converted into a series of digital 
data.

Continuous phenomena such as 
curves are divided into sections in dig-
ital technology and then further 
divided into individual events.

The more precise the sampling imple-
mented, i.e. the higher the sampling 
rate, the more precise is the original 
recorded during sampling and the 
finer the details that can be sampled 
and reproduced digitally.

S a m p l i n g  r a t e  

�SAMPLING

S a m p l i n g  r a t i o  

The display of video images requires 
information on brightness and color 
for each pixel. In video technology, this 
information is normally processed in 
the form of a brightness signal (�Y) 
and two color difference signals (�R-
Y, �B-Y). The brightness information 
is generally registered in more detail 
than the color information. This is 
made possible by sampling the bright-
ness signals at a �FREQUENCY OF 13.5 
�MHZ when transforming the video 
images into digital data. The color dif-
ference signals however, are sampled at 
6.75 MHz. To simplify work in general 
practice, only the used ratio of the 
sampling frequencies for a digital 
video format or a digital video stan-
dard is indicated, such as �4:2:2 or 
�4:1:1. 4 generally represents the sam-
pling frequency of 13.5 MHz.

S a t u r a t i o n  

�COLOR SATURATION

S c a r t  

Irrespective of whether it is a TV set or 
a video recorder - most consumer 
devices are equipped with this het-
eropolar terminal which is also fre-
quently referred to as Euro AV. The 
appropriate 21-pole flat connector 
combines all picture and sound con-
nections of the relevant device.

In principle, only scart cables where all 
of the 21 poles are assigned, offer the 
full functional range in both directions 

and are therefore suitable for playback 
and recording between the devices 
connected therewith. Along with these 
full-range cables, the market also offers 
economy solutions which are only 
equipped in part and only function in 
one direction.

S c r u b b i n g  

This function allows one to hear the 
digital sound as one would when play-
ing a videotape using �JOG/SHUTTLe. 
This permits the exact localization of 
cutting points in the audio range.

S C S I  

Small Computer Systems Interface.

Widely used parallel computer inter-
face for the transmission of high data 
rates. The SCSI interface has also been 
established in non-linear editing sys-
tems in terms of hard disk connection. 
With SCSI, up to 8 devices can be con-
nected to one another. The standard 
SCSI achieves a data transfer rate of 
close to 5 MB/s. Fast SCSIs enable a 
data transfer rate of 10 MB/s, while 
Ultra SCSIs transmit 20 MB/s. With all 
of these variants the standard bus 
width can be extended from 8 bits to 
16 or 32 bits (wide).

Naturally, the data transmission rates 
also increase as a result. An ultrawide 
SCSI interface with maximum bus 
width achieves 40 MB/s. The ultrawide 
SCSI 2 bus manages a maximum data 
throughput of 80 MB/s.
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S D I  

Serial Digital Interface

This interface initially and primarily 
developed by Sony, was standardized 
under the name SMPTE 259M. Via 
this interface, uncompressed digital 
component signals (in accordance 
with ITU-R 601) are transmitted in 
series.

BNC standard connectors with 75 
Ohm and coaxial cables are used, as 
they are for common analog video sig-
nals. (�COMPOSITE, �FBAS). Cable 
connections with a maximum length 
of 200 m are possible with SDI.

SDI achieves a transmission rate of 270 
Mbit/s. It is also possible to embed 
audio data into the data stream 
(�EMBEDDED AUDIO).

S D T I  

Serial Digital Transport Interface

SDTI is based on SDI and uses the 
same physical bases, i.e. cables and 
sockets.

The development of SDTI originated 
from the desire to be able to copy even 
compressed digital signals directly and 
to distribute them via studio infra-
structures. Initially, Sony and Pana-
sonic developed various format-
specific interfaces: SCDI for DVCPro, 
QSDI for DVCAM and SDDI for 
�BETACAM SX.

SDTI brings these starting points 
under one umbrella, but only deter-

mines the data transmission method 
and not the data format. The SDTI 
standard regulates the external form of 
the signal stream such that the signal 
can be distributed via SDI infrastruc-
tures. The type of useful data which is 
transported in this fashion, is up to the 
users. Therefore, SDTI enables the 
most varied types of compressed video 
data, such as MPEG and DV-com-
pressed video data to be distributed in 
existing digital video networks, at high 
transfer speeds.

In future, SDTI is to enable the distri-
bution of both compressed and 
uncompressed data streams in one and 
the same network. The relevant end 
device recognizes by the signal 
whether it contains uncompressed or 
compressed picture data and whether 
it can process these data.

S e c a m  

Séquential Couleur à Mémoire.

This TV standard was developed in 
France. Today it is used in France, 
some former Eastern block countries 
and the former French colonies. Over-
all, the use of Secam is on the retreat. 
Secam is similar to PAL. For this rea-
son, conversion (�STANDARD CON-
VERSION) between these systems is 
comparably simple. Secam processes 
625 lines and the frame rate is 50 Hz.

S e q u e n c i n g  

Repeated compression and decom-
pression of digital material in succes-
sive processing steps and/or signal 
conversion of this material are referred 
to as sequencing. The problem of 
sequencing different digital compres-
sion and signal conversion steps is the 
fact that these calculation operations 
may lead to rounding errors which 
manifest themselves as image distor-
tions (�GENERATION LOSSES).

S e r v e r  

The term "server" generally stands for 
central equipment which is accessed by 
several users or workstations via a net-
work.

File servers are computers which pro-
vide central data inventories such as 
databases for use by the connected 
computers (clients).

In general, video servers are devices 
that are especially aligned to the 
recording and playing of video and 
audio Sequences. There is a wide range 
of video servers for various application 
purposes: news servers, transmission 
servers and postproduction servers. 
Video servers are available in single or 
multi-channel designs.

S h o r t c u t s  

1) In Windows, shortcuts are place-
holders which refer to original files at 
another location. By opening the 
Volume II GlossaryG - 36



PINNACLE

Glossary
shortcut, the original file is opened and 
also modified, where applicable.

2) Keyboard shortcuts are predefined 
key combinations which permit cer-
tain functions to be executed directly 
via the keyboard.

S h u t t l e  

�JOG/SHUTTLE

S i g n a l - t o - N o i s e -
R a t i o  

Used as a parameter for the quality of a 
signal or even of a recording system: it 
specifies in decibels the ratio between 
the actual useful signal and the junk 
content superimposed on it. The useful 
signal is the actual signal content 
which is to be recorded or transmitted. 
Junk signals are almost unavoidable. 
The only way to deal with them is to 
keep them as small as possible. They 
can be caused by outside influences, 
for example magnetic fields, but may 
also be attributed to the tolerances of 
the components used or to the con-
struction of a device such as crosstalk 
effects between conducting Tracks.

With analog systems in particular it is 
difficult to achieve and maintain high 
signal-to-noise-ratios.

S M P T E  

Society of Motion Picture and Televi-
sion Engineers

US lobby group with international sec-
tions comprising representatives of 
studios, broadcasting stations and 

manufacturers and various profes-
sional groups from the entire motion 
picture and television industry. The 
SMPTE maintains a series of commit-
tees dealing with standards and stan-
dardization proposals.

S M P T E / E B U  T i m e -
c o d e  

This is the currently normal and 
widely used �TIMECODE STANDARD 
(�VITC and �LTC) which was intro-
duced by the �SMPTE. 

Time data in the format of 
hour:minute:second:image are 
assigned to each video picture. In the 
PAL system, the last digit contains val-
ues from 00 to 24; the other digits may 
adopt values from 00 to 59. A valid 
timecode value would be 01:24:56:22.

S / N  

�SIGNAL-TO-NOISE-RATIO

S t o r a g e  R e q u i r e -
m e n t s  

The computer-based processing of 
video pictures requires a far greater 
quantity of storage space than conven-
tional PC applications.

For example, a video image digitized 
with a resolution of 8 bits in accor-
dance with �ITU-R 601, takes up 810 
KB. With 25 pictures per seconds this 
amounts to 21 MB per second of video. 
(All details relate to 625 lines and 50 
Hz).

When working with pictures in HDTV 
quality, this value is approximately 6 
times higher. For digital pictures with 
motion picture resolution which are to 
be Projected in the cinema, the 
required data volume is even higher 
again.

S q u a r e  P i x e l  

�PIXEL

S S A  

SSA stands for Serial Storage Architec-
ture, authoritative network architec-
ture forged by Siemens and IBM. SSA 
makes it possible to network printers, 
scanners and magnetic storage media 
or even workstations, servers and PCs 
with a high-speed and efficient con-
nection. 

SSA is based on loop architecture (cir-
cular networking) and can work with 
up to eight controllers (e.g. worksta-
tions) per loop. The workstations 
themselves can be connected to a max-
imum of 128 devices within the loop 
(e.g. hard disks).

The American company, Pathlight 
developed the IMageNet SSA Work-
group Storage Network on the basis of 
SSA. This network currently offers a 
bandwidth of 80 MB/s; 160 MB/s is 
planned. For this reason it is particu-
larly suited to the data-intensive appli-
cations so typical of digital post-
editing.
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S t a b i l i z e r  

1) Simplified version of a timebase cor-
rector (�TBC). With simplified 
switchings, the stabilizer ensures that 
the video signals passing through it are 
freed from �JITTER and other instabil-
ities, but does not offer the, at times, 
comprehensive functional range of a 
full TBC.

2) In some compositing systems, 
motion information which was 
acquired with the help of a �(MULTI-) 
TRACKER can be used in order to stabi-
lize distorted original recordings dur-
ing post-editing.

S t e r e o  
System for surround sound reproduc-
tion with two channels (right and left).

S t o r a g e  C a p a c i t y  
Maximum data volume that can be 
stored on a certain data carrier. Never-
theless, in order to be able to work in 
an efficient manner with the existing 
and generally limited storage capacity 
of a non-linear editing system, the ini-
tial data volume incurred is reduced by 
�COMPRESSION. Storage media, the 
storage capacity and work speed of 
which are sufficient for them to be used 
for non-linear digital video editing, 
include �RAID drives and �AV HARD 
DISKS.

S u b p i x e l  
The smallest unit of a digital video 
image is the pixel. Nevertheless, in 
many cases better and more natural 

results can be achieved if the devices 
used offer a finer �RESOLUTION inter-
nally, the smallest unit of which is even 
smaller than a pixel, hence is in the 
subpixel range.

In this way curves take on a far more 
natural and even shape when gener-
ated with a device or software that 
operates and interpolates in the sub-
pixel range.

Even when �TRACKING PICTURE ELE-
MENTS, when �ANTIALIASING and 
when working with digital effects, bet-
ter results can be achieved by interpo-
lating in the subpixel range.

S u r r o u n d  
Generic term for various room sound 
procedures. Surround systems are 
geared towards achieving a more natu-
ral spatial sound reproduction, during 
which the listener is not only exposed 
to acoustic irradiation from the front, 
but sits in the center of sound events.

S - V H S  

Analog videotape format which is used 
in the consumer and partially in the 
semi-professional area. S-VHS is based 
on �VHS, but employs different tape 
material (MP = Metal Particle tape) 
and works with a higher �RESOLU-
TION, i.e. close to 400 �LINES. In addi-
tion to the �FBAS SIGNAL 
(�COMPOSITE), S-VHS devices also 
output a �Y/C SIGNAL.

S - V i d e o  

�Y/C

S y m m e t r i c a l  

Symmetrical cables are twin-core 
shielded leads in which noise fields are 
mutually eliminated. Symmetrical 
audio connections are customary on 
the professional market; �XLR sockets 
and plug connectors are used as con-
nections.

S y n c h r o n i z a t i o n  

1) The linking of image and sound sig-
nals in order to run image and sound 
events simultaneously.

2) The balanced coupling of individual 
devices with a timing signal, e.g. studio 
clocking.

T B C  

Time Base Corrector

A TBC balances out time faults in 
video signals which, for example, may 
occur due to flutters. Such time faults 
may take the form of a jittering picture 
or jittering object edges in the picture 
(�JITTER).

In general, professional video record-
ers, switchers or other video devices 
are equipped with an integrated TBC. 
However, stand-alone TBCs are also 
available which can be synchronized 
with the remaining studio equipment 
via a reference signal (Genlock).
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T C P / I P  

Transfer Control Protocol/Internet 
Protocol

TCP/IP is a combination of various 
standards which permit data to be 
exchanged between several comput-
ers. TCP/IP is particularly common in 
Internet applications. 

T i m e c o d e  

The timecode incorporates numbering 
of each individual picture. A timecode 
is assigned to each individual frame 
which is then recorded together with 
the video picture.

Different procedures can be used to 
write the timecode onto a video band 
(YVITC, �LTC). The logics and speci-
fication of the values is a common fea-
ture of all procedures.

The pictures are numbered in ascend-
ing order from the start of the tape. 
The time is specified in hours, minutes, 
seconds and individual pictures. For 
example, the value 01:59:59:24 is fol-
lowed by the next logical value 
02:00:00:00. At the last digit, values of 
00 to 24 are possible, since our TV sys-
tem (�PAL) works with 25 frames per 
second.

T i m e  l i n e  

Many non-linear editing systems work 
with a user interface, the central ele-
ment of which is a time line. The time 
line is the graphical representation of a 
film. The individual scenes are 

arranged as bars or symbols, via a time 
axis, as they are to be reproduced in 
the film.

When editing with time line, the cutter 
edits his picture and sound clips by 
placing them on the time line in the 
desired Sequence. The complete film is 
produced in this way.

Time lines are also used for mixing 
desks or effects devices where they are 
used in order to input a Sequence of 
effects or tricks.

T i m i n g  r a t e  

�FREQUENCY

T r a c k i n g  

�MULTI-TRACKING

T r a n s i t i o n  

Transition, flag

The simplest form of transition is the 
�DISSOLVE, i.e. the soft transition 
from the picture of one scene to the 
picture of the next scene.

T r i m m i n g  

Trimming is the exact fitting of the 
length of a clip at a cutting point. For 
non-linear systems, this can be imple-
mented at any point in time of the cut. 
In many systems, this can also be done 
by means of a trim editor which would, 
ideally, provide the relevant function-
ality.

U - m a t i c  

Old-fashioned videotape format which 
records video signals and two sound 
Tracks to a 3/4" tape (19 mm) in the 
color-under procedure. In Europe, the 
procedures used included related for-
mats U-matic High Band, U-matic 
Low Band and U-matic SP. U-matic 
devices are no longer produced.

U n b a l a n c e d  

�ASYMMETRICAL

U n d e r s c a n  

An underscan switching on the moni-
tor makes it possible to view the com-
plete video signal on the monitor. In 
underscan mode, even those parts of 
the video picture can be viewed which 
are normally not shown on the screen 
(�VITC, blanking intervals, copy pro-
tection signals).

V C R  

Video Cassette Recorder

Ve c t o r - b a s e d  

Effects or graphics which are not 
stored in the form of pixel patterns, but 
are based on geometric construction 
regulations instead.

Vector graphics can be enlarged and 
reduced to almost any extent without 
object edges showing step effects.
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Ve n t r i c u l a t i o n  

Actually the generation of ventricles, 
i.e. hollows or chambers. In digital 
video technology, ventriculation refers 
to an effect that may occur during mul-
tiple copying of digital data. When 
using specific calculation regulations, 
minor copying faults may result which 
are reflected in distortions and alien-
ation of the original picture content 
(�ALIASING,� ANTIALIASING). Dis-
turbances may occur in extreme cases.

V H S  

Video Home System.

The analog video tape format VHS was 
developed by JVC for the consumer 
market and has gained comprehensive 
acceptance there. With the VHS sys-
tem, recording is implemented with a 
half-inch (12.7 mm) tape.

VHS is not suitable for professional use 
due to the low �RESOLUTION.

V i d e o - 8  

The analog video tape format Video-8 
was developed by Sony for use in com-
pact consumer camcorders. Recording 
is implemented with an 8mm wide 
videotape.

VHS is not suitable for professional 
use, due to the low �RESOLUTION.

V i d e o  S e r v e r  

�SERVER

V I T C  

Vertical Interval Timecode.

One of the different procedures to 
record a �TIMECODE.

During recording, the VITC is written 
into one or more of the unused lines at 
the start of each individual full picture 
(blanking interval). For this purpose 
the recording device must be equipped 
with a VITC generator. During normal 
operation, the VITC is stored on the 
videotape as a non-visible part of the 
picture signal. During reproduction it 
is output as a part of the video signal, 
and the timecode information must be 
filtered out of the picture signal using a 
VITC reader.

The VITC must be recorded simulta-
neously with the picture signal; it is not 
possible to code recordings with VITC 
at a later stage.

V O B  

Video Object

A VOB file is a >DVD-compatible file 
which was not yet incorporated into a 
disk-format according to the DVD 
standard. VOB files can (in contrast to 
>Program Streams) often be read and 
played back by standard DVD-soft-
ware, thus, by using VOB-files, making 
it possible to use other storage media 
than the DVD and to use them similar 
to a DVD in a computer.

WAV  

Designation used for the waveform 
(.wav) audio file format, the standard 
file format for audio files on the Win-
dows operating system.

Wo r k s t a t i o n  

Powerful computer with a fast proces-
sor, high clocking rate and equipment 
which is geared towards professional 
work.

W O R M  

Write Once Read Many.

Storage medium that allows to be writ-
ten on only once. WORM CDs are suit-
able for the long-term archiving of data 
and for backups. They can only be 
written on once, but can be read out 
any number of times.

X L R  

Multi-pole, stable plug connection. In 
audio technology, three XLR-3 con-
nections are used to transmit analog, 
symmetric or digital audio signals. The 
four-pole version of the XLR connec-
tion is generally used to transmit sup-
ply voltages, i.e. between battery 
charging devices, batteries, power sup-
plies and camcorders.

Y / C  

Video signal standard with which color 
and brightness information is trans-
mitted separately. (Luminance Y, 
chrominance C). The quality achieved 
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by this method is better than that 
achieved with �COMPOSITE SIGNALS 
(FBAS). The Y/C socket (Hosiden, 
four-pole mini DIN) was introduced as 
a signal interface between �S-VHS 
and �HI8. The Y/C connection is fre-
quently referred to as S-Video.

Y ,  C r ,  C b  

The digital luminance and color differ-
ence signals for ITU-R 601 coding. 
The � LUMINANCE SIGNAL Y is 
scanned at 13.5 MHz, the two �COLOR 
DIFFERENCE SIGNALS at 6.75 MHz.

CR is the digital version of the analog 
component R-Y. Cb is the digital ver-
sion of B-Y.

Y ,  R - Y ,  B - Y  

This is the analog �LUMINANCE SIG-
NAL (Y) and the two �COLOR DIFFER-
ENCE SIGNALS (R-Y, B-Y) of 
�COMPONENT VIDEO SYSTEMS.

Y contains the brightness information 
while the two color difference signals 
together provide the color informa-
tion.

Signals in the form of Y, R-Y, B-Y are 
essential for many TV areas. ITU-R 
601 stipulates that these signals are the 
output signals for digital component 
video signals (�Y, CR, CB). They are 
digitized in the ratio �4:2:2 for this 
purpose.

Y U V  

Common designation for analog com-
ponent signals. Brightness and color 
information are transmitted separately, 
in the form of a �LUMINANCE SIGNAL 
(Y) and two �COLOR DIFFERENCE SIG-
NALS (R-Y, B-Y). The quality of YUV 
pictures is therefore significantly better 
than that of �COMPOSITE (�FBAS) or 
YY/C.

Strictly speaking, the designation YUV 
signal is inaccurate because U and V 
are not signals, but instead refer to the 
coordinate axes for color processing in 
the �PAL SYSTEM.
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Numerics
0 dB (Audio Editor) 13 – 24

1080/24p Glossary G – 2

16:9 Glossary G – 2

16:9 Aspect Ratio
Import Images 6 – 49

1-Click Fade In/Out 13 – 58

2D Editor
Clips 10 – 56

Realtime FX 11 – 31

Transitions 10 – 42

3:2 Pull-Down Glossary G – 2

3D Editor
Clip FX 10 – 57

Realtime FX 11 – 31

Transitions 10 – 57

3D Transition Effects 10 – 66

4:1:1 Glossary G – 2

4:2:0 Glossary G – 2

4:2:2 Glossary G – 2

4:2:2:4 Glossary G – 3

4:4:4 Glossary G – 3

4:4:4:4 Glossary G – 3

422P@ML Glossary G – 3

5.1 Audio Glossary G – 3

5.1 Encoder
Audio Editor 13 – 55

5.1 Surround 13 – 47

601 Glossary G – 3

75% Color 8 – 64, 12 – 26

A
A/D Conversion Glossary G – 3

A/V Input
Select (Logging Tool) 6 – 17

absolute targets 
(DVD authoring) 15 – 14

AC-3 Glossary G – 3

Acceleration Curve (Effects) 10 – 23

Default 10 – 25

Linear Acceleration 10 – 24

Positive-Negative 10 – 27

Splined Acceleration 10 – 24

Access Rights 
(Media Management) 8 – 119

Accordion (realtime effect) 11 – 32

Activated 
(button highlights DVD) 15 – 29

Active
for Edit (Timeline Tracks) 9 – 17

Active Rack 8 – 8

Add Dissolve (Auto Dissolve) 13 – 60

Add Matte Track 9 – 18

Adjust Audio (Global Modification of 
Audio) 13 – 59

Adobe AfterEffects 7 – 13

Adobe Premiere
AVI import 6 – 48

AES/EBU Glossary G – 3

AIFF 
(Audio Format OMFI Export) 7 – 34

ALE/XML Import/Export of 
Projects 7 – 3

Alias (Media Management) 8 – 118

Aliasing Glossary G – 3

Align (Transition FX) 9 – 36

Alpha 10 – 19

Alpha Channel Glossary G – 4

Image Import 8 – 124

View Mode 10 – 19

Wipe Effect 10 – 52

Alt + Shift Key Sequence 17 – 15

Amplification/Attenuation
Equalizer 13 – 73

Analog Glossary G – 4

Analog Audio Scrub
Activating 13 – 11

Analog component 
signals Glossary G – 4

anchored targets 
(DVD authoring) 15 – 15

Animation Glossary G – 4

Change Field Order 8 – 124

Detect Automatically 6 – 53

Import 6 – 51

Antialiasing Glossary G – 4

API Glossary G – 4

Apply & Close (Dialog Boxes) 3 – 8

Artefact Glossary G – 4

ASCII Glossary G – 4

ASIO
Audio Drivers 13 – 4

Multiple Drivers 13 – 5

Multiple Sound Cards 13 – 4

Aspect Ratio Glossary G – 5

Lock Width/Height 
(Effect Editors) 10 – 43

Assemble Glossary G – 4

Assemble Edit (Record To Tape) 16 – 5

Asymmetrical Glossary G – 5

Asynchronicity 
(General Remarks) 9 – 104

ATM Glossary G – 5

ATSC Glossary G – 5

Attributes Activated 8 – 70

Audio 13 – 3

Adjust Audio 13 – 59

Assigning Timeline Tracks 13 – 8

Auxiliary Level 13 – 15

Balance 13 – 10

Clipping 13 – 15

Destructive/Non-Destructive 6 – 27

Disband Clip 13 – 7

Effects 13 – 69

Global Modification of 
(Adjust Audio) 13 – 59

Grouped Video and Audio 9 – 23

Key Frame Toolbar 13 – 29

Level Too High 6 – 28

Mixer 13 – 19

Mute Tracks 13 – 11
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Pan/Balance Lines (Show) 13 – 6

Panorama 13 – 10

Playback Level 6 – 28

Playback On/Off 13 – 11

Rubberbanding 13 – 27

Scrubbing (Clip Viewer) 8 – 56

Scrubbing (Timeline) 13 – 11

Select Audio Monitor 6 – 20

Settings 13 – 67

Special Characteristics of 
Audio Clips 13 – 5

Stereo/ Mono 13 – 8

Tab in Logging Tool 6 – 27

Timeline (General Remarks) 9 – 104

Volume Lines (Show) 13 – 6

VST PlugIns 13 – 76

Waveform Display 13 – 7

Waveform Inlay in Clip/
Source Viewer 8 – 59

Audio clip Glossary G – 5

Audio Editing
More than 16 Source Tracks 13 – 13

Audio Editor 13 – 17

0 dB 13 – 24

Audio Levels 13 – 24

Faders 13 – 24

Fuse/Export Routing 13 – 36

Insert Effects, Send Effects 13 – 42

Key Frame Toolbar 13 – 29

Mixer 13 – 19

Open 13 – 18

Output Mapping 13 – 32

Settings 13 – 42

signal path (the way of the audio sig-
nal) 13 – 19

Solo 13 – 26

Audio Effects 13 – 69

Apply in Real Time 13 – 71

Cross Fade 13 – 57

Dry 13 – 72

Echo 13 – 75

Equalizer 13 – 72

FX Properties 13 – 71

Maximizer 13 – 74

Output Level 13 – 72

Save Effect Settings 13 – 71

VST 13 – 76

Audio Fader (External) 13 – 63

Audio Key Frames 13 – 27

Delete Several Keyframes 13 – 30

Delete Single Key Frame 13 – 29

Jump from Keyframe to 
Keyframe 13 – 30

Move 13 – 29

Move Sections Between 
Key Frames 13 – 29

Rubberbanding with 
Key Frames 13 – 27

Set 13 – 27

Tool Tip 13 – 29

Toolbar 13 – 29

Undo/Redo 13 – 30

Audio Mix Automation 13 – 61

Key Frame Resolution 13 – 62

Preroll 13 – 61

Start 13 – 61

Stop 13 – 62

Audio Mixer 13 – 19

Assigning Tracks and Faders 13 – 21

Clip Fader 13 – 24

Clip Panning 13 – 23

Input Volume (Track) 13 – 24

Insert FX and Send FX 13 – 24

Lock Faders 13 – 26

Logical Output Bus 13 – 25

Mute 13 – 26

Output Volume (Track) 13 – 25

Pan, Balance, Surround 
Panner 13 – 25

Send Bus fader 13 – 27

Solo 13 – 26

Track Type 13 – 23

Audio Mode 13 – 60

Audio Monitor 13 – 16

Audio Peak Meter (Audio Tool) 13 – 14

Audio Routing
Custom Sets 13 – 41

Interpreting 13 – 39

Multi Channel Set (blue) 13 – 41

Outputs 13 – 41

Routing of Stereo Source 
Tracks 13 – 38

Single Out Set 13 – 40

Standard Routing Set 13 – 40

Stereo-Mono Set 13 – 40

Submix 13 – 41

Track Matrix 13 – 41

Audio Routing (Classic) 13 – 38

Audio Scrubbing 13 – 11

Digital, Trim Editor 9 – 73

Selecting Tracks 
(Clip/Source Viewer) 13 – 12

Selecting Tracks (Timeline) 13 – 12

Audio Settings 13 – 67

Digital Audio Scrub 13 – 68

Audio Tool 13 – 14

Clipping 13 – 15

Digital Scale 13 – 15

Headroom 13 – 15

Lock Faders 13 – 14

Max dB 13 – 14

Open Audio Tool 13 – 14

Output Levels 13 – 14

Overload Thresholds 13 – 14

Response Time 13 – 15

Signal Peaks 13 – 14

Authoring
see DVD authoring 15 – 2

Auto 3pt 
(Logging Tool, options) 6 – 32

Auto increment reel numbers 6 – 12

Auto update project Picons 8 – 16

AutoLink (DVD) 15 – 25

Automatic Scene Detection 
(Clip Viewer)

based on metadata 8 – 96

based on video content 8 – 94
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Multiframe Scan 8 – 95

Sensitivity 8 – 95

Step by Step 8 – 94

Automatic Scene Detection 
(Logging Tool) 6 – 40

Automatically update Picons 
(Timeline) 9 – 7

Autoplay (DVD authoring) 15 – 23

AUX Glossary G – 5

Auxiliary Level (Audio) 13 – 15

AV hard disks Glossary G – 5

AVI Glossary G – 5

Export Sequence in 
AVI File Format 16 – 10

Import from Adobe Premiere 6 – 48

AVI index files (network) 7 – 26

Avid Media Log 7 – 22

Axes of Rotation 10 – 59

B
Background Glossary G – 5

Background (pixel type DVD) 15 – 29

Background Capture 6 – 45

Background 
Rendering 10 – 35, Glossary G – 5

enable/disable 10 – 35

Background/Foreground 
(Transition Effects) 10 – 41

Balance and Panorama
see Panorama and Balance

Balancing Faders 
(External Audio Fader) 13 – 64

Band Wipe (realtime effect) 11 – 38

Bandwidth Glossary G – 6

Bandwidth (Equalizer) 13 – 73

Barn Doors (realtime effect) 11 – 38

Base Color Correction 
(realtime FX) 11 – 33

Batch Capture = Batch Digitize 8 – 77

Batch Digitize 8 – 77, Glossary G – 6

Call 8 – 77

Defaults/Checklist 8 – 82

Digitize Sequence 8 – 77

EDL 7 – 22

Functions 8 – 78

Handle Length 8 – 79

Merge gaps below (Clips) 8 – 79

Merge Overlapping Clips 8 – 79

Options 6 – 31

Select Media Format 6 – 18

Slomo Clips 8 – 84

Start 8 – 82

Timeline Clip(s) 9 – 65

Batchlist 7 – 6

Bell Equalizer 13 – 73

Betacam Glossary G – 6

Betacam SX Glossary G – 6

Bevel Crystal (realtime effect) 11 – 32

B-frame Glossary G – 6

BIOS Glossary G – 6

Bit Glossary G – 7

Bit rate Glossary G – 7

Bit stream Glossary G – 7

Bitmap
Export 16 – 10

Black (Insert on Timeline) 9 – 22

Black 
(Primary Color Correction) 12 – 30

Black Stretch 
(Gamma, Color Editor) 10 – 72

Black, Gamma, Gain
Color Correction Clip Viewer 8 – 62

Contrast 12 – 31

Logging Tool 6 – 24

Black-and-White (realtime FX) 11 – 35

Blackburst Glossary G – 7

blank menus (DVD) 15 – 40

Blend with Original 
(Filter Editor) 10 – 85

Block size (network) 7 – 26

Blue Channel
Color Gain 10 – 71

Blue Screen Key 10 – 81

Luma Cutoff 10 – 82

Luma Threshold 10 – 82

RGB Spill Suppression 10 – 82

Threshold 10 – 82

Transition 10 – 82

YUV Spill Suppression 10 – 82

Bluebox Glossary G – 7

Blur
Gaussian, Filter Editor 10 – 87

Realtime FX 11 – 33

BNC Glossary G – 7

Border Inside/Outside (Tool, Effect 
Editor) 10 – 44

Brightness
Clip FX 10 – 71

Gamma 12 – 30

Broadcast Quality Glossary G – 7

Browser Glossary G – 7

Build Container 9 – 113

Burn DVD/SVCD 16 – 33

Bus Glossary G – 7

Bus type 13 – 25

Bus Type (Output Mapping) 13 – 34

B-Y Glossary G – 7

Bypass (Audio Function) 13 – 78

Byte Glossary G – 7

C
Calling Tools Once 17 – 10

Camera (3D) 10 – 63

Perspective 3D 10 – 66

Camera (Clip Properties) 8 – 69

Cancel (Functions, Dialog Boxes) 3 – 8

Canvas
Effect Editor 10 – 17

Move Canvas 10 – 22
Volume II IndexI - 4



PINNACLE

Index
Capacity (Drives) 6 – 19

Capacity indicator 
(DVD Export) 16 – 23

Capture Glossary G – 8

Capture (Batch Digitize) 8 – 77

Capture (Digitizing with Logging 
Tool) 6 – 3

Carrier frequency Glossary G – 8

Cascade Objects on Desktop 8 – 75

CBR (Constant Bit Rate) 16 – 37

CCIR Glossary G – 8

CCIR pixels vs square pixels 9 – 119

CD-R 16 – 34

CD-RW 16 – 34

Center Frequency (Equalizer) 13 – 72

Center Image 
(Effect Editor, Position) 10 – 43

Central Axis (3D) 10 – 59

Change Edit Mode (Scrub/Edit) 9 – 28

Channel (Filter Editor) 10 – 85

Channel Display (Color Correction Edi-
tor) 12 – 26

Chapters (DVD) 15 – 8

Checkboxes (Basics) 3 – 7

Choirus (VST PlugIn) 13 – 81

Chroma
Color Editor 10 – 71

Chroma Key Editor 10 – 79

Luminance Range 10 – 80

Select Color 10 – 79

Chroma Keying Glossary G – 8

ChromaKeyer YUV 
(realtime FX) 11 – 34

Chrominance Glossary G – 8

Cinch Glossary G – 8

Circle (Shape, Wipe Editor) 10 – 53

Classic bus (Output Mapping) 13 – 35

Clear Mark-In/out on Timeline after 
insert 9 – 7

Clear TC fields 6 – 9, 6 – 40

Clip 9 – 63, Glossary G – 8

see also Object
Cut/Copy/Paste 8 – 29

Digitize/Re-Digitize 6 – 40

Disband 9 – 66

Disband (Audio) 13 – 7

Disband (Several) 9 – 67

Display Speed 9 – 14

Edit properties (multiple) 8 – 70

Find 8 – 41

FX Properties 9 – 68

Link Clips 9 – 80

Match Frame 9 – 65

Name/Number (Logging Tool) 6 – 21

Preview 8 – 30

Properties 8 – 66

Rename/Number 
(Project/Timeline) 8 – 30

Select 9 – 57

Select (Several) 9 – 57

Send to Background 10 – 41

Send to Foreground 10 – 41

Send to Timeline 
(Logging Tool) 6 – 30

Shortcut Menu (Project) 8 – 29

Shortcut Menu (Timeline) 9 – 63

Show Recurrent Use (Timeline) 9 – 14

Undo/Redo 9 – 65

used in current Sequence 8 – 16

Clip Effects 10 – 4

2D Editor 10 – 56

3D Editor 10 – 57

Blue Screen Key 10 – 81

Chroma Key 10 – 79

Color Correction Editor 12 – 3

Color Editor 10 – 70

Echo (Audio) 13 – 75

Editors 10 – 10

Equalizer (Audio) 13 – 72

Filter Editor 10 – 84

Green Screen Key
Luminance Key 10 – 76

Maximizer (Audio) 13 – 74

Preview 11 – 6

RealTime ColorFX 12 – 44

RGB Difference Key 10 – 83

Timewarp Editor 12 – 50

Wipe Editor 10 – 69

Clip Fader (Audio Mixer) 13 – 24

Clip Info (Timeline) 9 – 63

Clip numbering 
(Automatic/Manual) 6 – 21

Clip Panning (Audio Mixer) 13 – 23

Clip Viewer 8 – 50

Automatic Scene Detection 8 – 93

Color Correction 8 – 61

Functions (basic) 8 – 52

Go To Marker List 8 – 58

Make Subclip 8 – 61

Markers and Comments 8 – 57

Position Bar 8 – 53

Primary Color Correction 8 – 61

Scrubbing (Audio) 8 – 56

Scrubbing (Video) 8 – 54

Select Audio Tracks 8 – 56

Set Mark-In/Out 8 – 54

Shuttle Playback 8 – 60

Timecode Fields 8 – 55

Underscan/Overscan 8 – 56

ClipLink 6 – 37, Glossary G – 8

Clipping 13 – 15, Glossary G – 8

ClipSync 8 – 90

Clock Wipe (realtime effect) 11 – 38

Clockwise/Counter Clockwise 
(Rotation) 10 – 44

Close Effect Editors 10 – 34

CMX 3600 (EDL Format) 7 – 20

Code Tape
see Stripe Tape 16 – 6

Codecs 8 – 102

Media File Format, 
Media Format 8 – 123

Collision (highlight DVD) 15 – 33
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Color 
(backside image) 10 – 62, 10 – 68

Color 1 (pixel type DVD) 15 – 29

Color 2 (pixel type DVD) 15 – 29

Color 3 (pixel type DVD) 15 – 29

Color 4 (pixel type DVD) 15 – 29

Color Adjust (realtime effect) 11 – 32

Color Area (Chroma Key) 10 – 79

Color Blend
Effect Editors, Border Tool 10 – 44

Color Cast 
(Primary Color Correction) 12 – 32

Color Clip 6 – 57

Background 6 – 57

Circular Gradient 6 – 57

Color Gradient 6 – 57

Color Picker 6 – 57

Create 6 – 57

Linear Gradient 6 – 57

Color Correction
also see Color Correction Editor 12 – 3

Color Editor 10 – 70

Primary (Logging Tool) 6 – 22

Tips 12 – 11

Color Correction (Clip Viewer)
75% Color 8 – 64

Black, gamma, gain 8 – 62

Save Settings 8 – 64

Work only in CCIR-601 8 – 64

Color Correction Editor 12 – 3

75% Color 12 – 26

Channel Display 12 – 26

Colors (Theory) 12 – 8

Compact Display and 
Magnifying Glass 12 – 6

Correction Area 12 – 6

Cube Display 12 – 21

Diagnostic Area 12 – 5

Diagnostic Displays 12 – 19

Histo Match 12 – 36

Histogram 12 – 24

Hue Match 12 – 37

Introduction 12 – 13

Legalizer 12 – 26

Lightning Display 12 – 22

Models 12 – 8

Open 12 – 4

Primary Color Correction (see Primary 
Color Correction) 12 – 27

RGB Color Space 12 – 9

Save Settings 12 – 26

Selective Color Correction 12 – 39

Six Vector Color Correction 12 – 38

SoftClipping 12 – 26

Tone Balance 12 – 35

Tools 12 – 7

Vector Display 12 – 19

Vectorlight Display 12 – 23

Waveform Display 12 – 20

White-Balancing 
(Subsequent) 12 – 32

Work only in CCIR-601 12 – 26

YUV Color Space 12 – 10

Color difference signal Glossary G – 9

Color Editor 10 – 70

Brightness, Contrast 10 – 71

Color Gain 10 – 71

Equalize 10 – 72

Gamma 10 – 72

Hue, Saturation 10 – 71

Transparency 10 – 72

Color Gain (Color Editor) 10 – 71

Color Isolation (Selective Color Cor-
rection) 12 – 41

Color Picker 6 – 57

HLS Color Model 6 – 57

Pipette 6 – 57

RGB Color Model 6 – 57

Select Color(s) 6 – 57

Color saturation Glossary G – 9

Color space Glossary G – 9

Color Wheel 12 – 8

Basics 6 – 23, 8 – 64

Chroma Key 10 – 80

ColorWash 
(Selective Color Correction) 12 – 43

Compilation (DVD) 16 – 23

Complete systems Glossary G – 9

Component signals Glossary G – 9

Composite Glossary G – 9

Compositing Glossary G – 10

Composition
OMFI 7 – 33

XSend to... 7 – 12

Compression Glossary G – 10

Compression rate Glossary G – 10

Compressor (Maximizer) 13 – 74

Condense 8 – 88

Call 8 – 89

Consolidate 8 – 85, Glossary G – 10

Call 8 – 86

Delete Media Files 8 – 87

New Rack 8 – 86, 8 – 89

Consolidate Media 
(OMFI Export) 7 – 34

Container 9 – 112

Build 9 – 113

Copy of a Sequence 9 – 116

Dismantle 9 – 116

Edit 9 – 115

Insert Further Containers 9 – 115

Nested Sequences 9 – 112

Step Into (Open) 9 – 114

Contrast
Adaptation 
(Primary Color Correction) 12 – 31

Color Editor 10 – 71

Primary Color Correction 12 – 31

Control Interfaces Glossary G – 10

Control Panel
User Settings 17 – 3

Controls 
(Player, Clip Viewer, etc.) 6 – 14

Conversion of 
Standards Glossary G – 11
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Conveting TC systems 5 – 15

Copy
All kinds of objects 8 – 29

Range (Timeline) 9 – 60

what is... 8 – 27

Copying losses Glossary G – 11

CPU Glossary G – 11

Cr, Cb Glossary G – 11

Cracked Slab (realtime effect) 11 – 33

Crop (realtime effect) 11 – 32

Cropping Tool (Effect Editor) 10 – 45

Cross Color Glossary G – 11

Cross Dissolve 
(realtime effect) 11 – 37

Cross Fade (Audio) 13 – 57

CSDI Glossary G – 11

CTL Glossary G – 11

Cube Display 
(Color Correction Editor) 12 – 21

Cue Marker 9 – 33

Curl 10 – 67

Current Rack 8 – 8

Curtain (realtime effect) 11 – 33

Configure
see Customize

Customize 17 – 2

Dividing Line between Tools 17 – 9

Gaps (Toolbar) 17 – 9

Keyboard 17 – 11

Keyboard Shortcuts and 
Modifiers 17 – 15

Liquid Control 17 – 18

Object Properties 8 – 68

Property Sets 17 – 3, 17 – 5, 17 – 7

Save User Profile 4 – 8

Templates 17 – 4

Tool Box 17 – 9

Toolbars 17 – 8

User Profile 17 – 3

User Settings 17 – 3

Cut Glossary G – 12

Fields/Frames 16 – 11

Cut/Mix Fields/Frames
Export Sequence 16 – 11

Timewarp Editor 12 – 64

Cutoff (Luminance Key) 10 – 77

CVBS Glossary G – 12

Cylinder (realtime effect) 11 – 33

D
D/A conversion Glossary G – 13

D1 Glossary G – 12

D2 Glossary G – 12

D3 Glossary G – 12

D5 Glossary G – 12

D6 Glossary G – 12

D7 Glossary G – 12

D8 Glossary G – 12

D9 Glossary G – 13

DAT Glossary G – 13

Data compression Glossary G – 13

Data exchange MXF 7 – 16

Data rate (data stream) Glossary G – 13

Data recorder Glossary G – 13

dB Glossary G – 13

dB Display
Audio Tool 13 – 14

DCT compression Glossary G – 13

DCT format Glossary G – 13

DDR Glossary G – 14

Default magnet for scrubbing and 
editing 9 – 8

Delay, Echo Audio Effect 13 – 75

Delete
Audio Key Frames 13 – 30

Folder/Racks 8 – 13

Media files and Project data 8 – 6

Media Files, Render Files, Clips, 
etc. 8 – 128

Project 8 – 6

render files 8 – 6

Restore, Damage Control 8 – 132

Delete Original Media 8 – 87

Destination Volume
Logging Tool, Batch Digitize 6 – 19

Destructive/Non-Destructive (Audio 
Adjustment) 6 – 27

Detail View 8 – 31

Edit View 8 – 32

Object Icons 8 – 36

Properties 8 – 32

Save Sets 8 – 33

Standard View 8 – 32

Diagnose project 8 – 18

Diagnostic Displays 
(Color Correction Editor) 12 – 19

Dialog Boxes (Basics) 3 – 6

Digital Glossary G – 14

Digital 8 Glossary G – 14

Digital Audio
AES/EBU 6 – 28

AIFF 7 – 34

Clipping 13 – 15

Embedded SDI/DV 6 – 28

Headroom 13 – 15

Digital Audio Scrub
Activating 13 – 11

Parameter 13 – 68

Trim Editor 9 – 73

Digital Betacam Glossary G – 14

Digital component 
signals Glossary G – 14

Digital recorders Glossary G – 14

Digital S Glossary G – 14

Digital Scale (Audio Tool) 13 – 15

Digitizer Glossary G – 14

Digitizing 6 – 37

Batch Digitize 8 – 77

Cancel 6 – 40

Create Subclips 6 – 39
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Definition 6 – 4

Destination Drives 6 – 19

Full Control Digitize 6 – 37

Individual Clip 6 – 40

Methods (Overview) 6 – 37

Open End 6 – 38

Options 6 – 31

DIN four-pole Glossary G – 14

DIN six pole Glossary G – 14

Direction 10 – 67

Disband
Clip 9 – 66

Clip (Audio) 13 – 7

Several Selected Clips 9 – 67

Disc Full State 6 – 34

Disc recorder Glossary G – 14

Dissolve 10 – 5, Glossary G – 15

Add Dissolve (Automatically) 13 – 60

DissolveThroughColor 
(realtime FX) 11 – 37

Dividing Line (Toolbar) 17 – 9

DLT 16 – 26, Glossary G – 15

Dolby Glossary G – 15

Digital Glossary G – 15

Surround Glossary G – 15

Double-Click (Timeline Clip) 9 – 55

Downsampling 
(WAV 48 > 44.1 kHz) 16 – 12

Drag & Drop (Adding Object to 
Timeline) 9 – 56

Drive Glossary G – 15

Change drive 6 – 34

Drop Frame Timecode Glossary G – 15

Drop Shadow 10 – 45

Drop-Down (Lists and Menus) 3 – 7

Dry (Audio Effects) 13 – 72

DST Glossary G – 15

DTV Glossary G – 15

Dump to Tape (Record) 16 – 4

DV Glossary G – 16

DV Tools (AVI-Import) 6 – 48

DVB Glossary G – 16

DVCAM Glossary G – 16

DVCPRO Glossary G – 17

DVCPRO50 Glossary G – 17

DVD Glossary G – 17

Burn 16 – 33

creating (authoring)
see DVD authoring 15 – 2

Elementary Stream destination 
format 16 – 26

Mini-DVD Image Destination
Format 16 – 31

see Export to DVD 16 – 18

Step by step burning 16 – 20

Surround 16 – 32

VCD destination format 16 – 28

VOB destination format 16 – 29

DVD authoring
absolute targets 15 – 14

Activated (button highlights) 15 – 29

adding/deleting menu pages 15 – 21

anchored targets 15 – 15

animated picons 15 – 18

arrow button navigation 15 – 37

AutoLink 15 – 25

Autoplay 15 – 23

Background (pixel type) 15 – 29

basics and terminology 15 – 7

blank template menu 15 – 40

button navigation 15 – 23

button status (highlight) 15 – 34

Chapters 15 – 8
Color 1 (pixel type) 15 – 29
Color 2 (pixel type) 15 – 29
Color 3 (pixel type) 15 – 29
Color 4 (pixel type) 15 – 29
colored menus and markers 15 – 22
colored menus and markers 
(Options) 15 – 38

commands and tool buttons 15 – 14
desktop (inlay) 15 – 22
DVD Editor

opening 15 – 11
overview 15 – 12

DVD markers
identifying 15 – 22

DVD Menu Editor 
(see main entry) 15 – 43

DVD Menu Wizard 15 – 6

DVD menus (basics) 15 – 8

DVD timeline 15 – 9

DVD-B (background track) 15 – 22

Emphasis 1 (pixel type) 15 – 29

Emphasis 2 (pixel type) 15 – 29

Foreground (pixel type) 15 – 29

highlight
all functions 15 – 32
example 15 – 30
palette and transparency 15 – 33

Highlight (tab) 15 – 28

highlight buttons 15 – 29

highlight collision 15 – 33

important elements 15 – 11

importing (DVD menus) 15 – 41

inlay (desktop) 15 – 22

introduction/overview 15 – 2

link list 15 – 13

link names (chapter names) 15 – 13

link numbers 
(chapter numbers) 15 – 13

links
basics 15 – 8
moving 15 – 17

Links (tab) 15 – 12

Master View (tab) 15 – 36

menu background
animating 15 – 22
selecting 15 – 22

menu design, marker design 15 – 22

menu range (AutoLink) 15 – 26

menu templates 15 – 35

menus
basics 15 – 8
changing 15 – 21
creating and designing 15 – 39
designing 15 – 43
identifying 15 – 22
lengthening/shortening/
trimming 15 – 22
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linking 15 – 21
naming 15 – 22
renaming 15 – 22
using different menus 15 – 21

menus on the timeline 15 – 42

motion menus 15 – 22

multi-page menus 15 – 21

navigation (preview) 15 – 37

navigation view 15 – 23

Normal (button highlights) 15 – 29

numeric labels 15 – 38

Options (tab) 15 – 38

picons setting 15 – 18

pixel types 15 – 29

Preview (tab) 15 – 37

reference (all functions) 15 – 11

return marker 15 – 16

Selected (button highlights) 15 – 29

sequence events (AutoLink) 15 – 26

step by step 15 – 3

subpictures 15 – 29

tabs
Highlight 15 – 28
Master View 15 – 36
Options 15 – 38
Preview 15 – 37
Templates 15 – 35

targets 15 – 8

targets (absolute) 15 – 14

targets (anchored) 15 – 15

templates 15 – 41

Templates (tab) 15 – 35

thumbnail buttons 15 – 18

video update 15 – 36

VOB problem 15 – 27

Wizard 15 – 6

DVD Editor
also see DVD authoring 15 – 12

Autoplay 15 – 23

DVD formats 16 – 34

DVD Image 
(as a source in DVD export) 16 – 22

DVD Image (Export to DVD) 16 – 30

DVD Menu Editor 15 – 43

backgrounds 15 – 46
button highlights 15 – 48
button navigation 15 – 48
character and text tools 15 – 44
character properties 15 – 45
highlight styles 15 – 48
inserting images 15 – 46
looks 15 – 45
menu buttons 15 – 46
opening 15 – 44
Photoshop menus 15 – 50
thumbnail buttons 15 – 47

DVD menus
blank templates 15 – 40
creating 15 – 40
creating templates 15 – 41
designing using Photoshop 15 – 50
importing templates 15 – 41

DVD preview 15 – 37

DVD transition menu 15 – 24

DVD+R 16 – 34

DVD+RW 16 – 34

DVD-10 Glossary G – 18

DVD-18 Glossary G – 18

DVD-5 Glossary G – 18

DVD-9 Glossary G – 18

DVD-R 16 – 34, Glossary G – 18

DVD-RAM 16 – 34, Glossary G – 18

DVD-ROM Glossary G – 18

DVD-RW 16 – 34

DVD-Video Glossary G – 18

DVE Glossary G – 19

D-VHS Glossary G – 16

DVTR Glossary G – 19

E
Easy Freeze Frame 9 – 66

EBU Glossary G – 19

Echo (Audio Effect) 13 – 75

Delay 13 – 75
Feedback 13 – 75
Mixup 13 – 75

Edge Softness (Transparency) 10 – 46

Edit Buttons
Mark-In/Out, etc. 6 – 16

Edit Decision List (EDL) Glossary G – 19

Edit Mode 9 – 55

Change (Scrub/Edit) 9 – 28

Scrub Mode 9 – 28

Switch Temporarily to 
Scrub Modus 9 – 55

Edit Styles 9 – 25

Film Style (Insert) 9 – 26

Overwrite Style 9 – 25

Edit Tools (Timeline) 9 – 55

Editing
Directly on the Timeline 9 – 54

Examples and Illustrations 9 – 83

Three-Point Editing 9 – 52

Using the Sequence Editor 9 – 38

EDL 7 – 18, Glossary G – 19

Available Formats 7 – 20

Batch Digitize 7 – 22

Events Contained 7 – 18

Export 7 – 20

Import 7 – 22

Multilayer 7 – 21

Print 7 – 21

Save 7 – 21

Without Audio Information 7 – 21

Effect 10 – 4

see also Effect Editors
Apply to Clips 10 – 7

Audio (Overview) 13 – 69

Clip Effect Editors 10 – 10

Clip Effects 10 – 4

Copying Parameters Using 
Drag&Drop 10 – 33

Delete and Remove 10 – 8

Icon (Picon View) 10 – 9

Icon (Timeline Clip) 10 – 8

Key Frames 10 – 20

Multilayering 10 – 4
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Order in which effects are 
rendered 10 – 8

Outgoing/Incoming Clip 10 – 40

Preview 10 – 17, 11 – 6

Preview Quality 10 – 37

Priorities (of Layers) 10 – 4

RealTime ColorFX 12 – 44

Render Quality 10 – 37

saving individually created 
effect 10 – 38

Superimposition of Clips 10 – 4

Transition Effect Editors 10 – 12

Transition Effects 10 – 5

Types 10 – 5

Where to Find Them 10 – 5

Effect Editors 10 – 10

2D Editor (Clips) 10 – 56

2D Editor (Transitions) 10 – 42

3D Clip FX 10 – 57

3D Transition 10 – 57

see also Effect Parameters
Acceleration Curve 10 – 23

Clip Effect Editors 10 – 10

Close 10 – 34

Color Editor (Clips) 10 – 70

Deactivate Modified Settings 10 – 34

Effect Viewer 10 – 17

Filter Editor (Clips) 10 – 84

Full Screen Mode 10 – 15

Functions and Elements 10 – 16

Key Frames 10 – 20

Keying Editor (Clips) 10 – 73

Open 10 – 13

Parameters and Options 10 – 29

Position Bar 10 – 18

Preview Image 10 – 14

Safe Action Area/Title Marks 10 – 22

Shortcut Menu 10 – 32

Toolbar 10 – 31

Transition Effect Editors 10 – 12

Wipe Editor (Clips) 10 – 69

Wipe Editor (Transitions) 10 – 52

Effect Icon
Picon View 10 – 9

Timeline Clip 10 – 8

Effect Parameters
Aspect Ratio 10 – 43

Border Inside/Outside 10 – 44

Center Image 10 – 43

Color Blend 10 – 44

Copy Parameters Using 
Drag&Drop 10 – 33

Counter-/Clockwise 10 – 44

Cropping 10 – 45

Edges 10 – 45

Mirror 10 – 46

Offset 10 – 45

Offset (Trailing) 10 – 46

Position 10 – 43

Rotation 10 – 44

Shadow 10 – 45

Size 10 – 43

Softness 10 – 44

Spins (Rotation) 10 – 44

Trailing 10 – 46

Transparency 10 – 46

Transparency (Trailing) 10 – 46

Effect preview 11 – 5

Effect Viewer 10 – 17

Canvas View 10 – 17

Default Graphics 10 – 17

Position Bar 10 – 18

Toolbar 10 – 22

Zoom 10 – 17

Effects
HD 5 – 19

Elementary Stream Glossary G – 19

Elementary Stream 
(Export to DVD) 16 – 22, 16 – 26

Embedded Audio Glossary G – 19

Emphasis 13 – 74

Emphasis 1 (pixel type DVD) 15 – 29

Emphasis 2 (pixel type DVD) 15 – 29

Empty Timeline 9 – 5

Enable background rendering 10 – 35

Encoding (DVD, source to 
Elementary Stream) 16 – 23

ENG Glossary G – 20

EQ (Equalizer) Glossary G – 20

Equalize (Color Editor) 10 – 72

Equalizer 13 – 72

Amplification/Attenuation 13 – 73

Bandwidth 13 – 73

Bell Shape 13 – 73

Center Frequency 13 – 72

Q Slider 13 – 73

Slope 13 – 73

VST PlugIn 13 – 80

Error Indicator 3 – 12

Ethernet Glossary G – 20

Exclamation Point (Taskbar, Error In-
dicator) 3 – 12

Expand Clip
Timeline 8 – 61, 9 – 64

Explosion (realtime effect) 11 – 33

Export
*.tga, *.bmp, *.tif 
(Single Frames) 16 – 13

ALE project 7 – 5

AVI 16 – 15

Bitmap 16 – 10

DVD 16 – 18

EDL 7 – 20

Elementary Stream (m2v) 16 – 26

Fuse Sequence 16 – 16

Media Files (Fuse Sequence) 16 – 16

Mini-DVD Image 16 – 31

MPEG-IPB 16 – 10

MXF 7 – 16

MXF MPEG IPB 7 – 16

OMFI 7 – 31

Program Stream 16 – 18

QuickTime 16 – 15

Sequences 16 – 8

Single Frames (Graphics) 16 – 13

SVCD 16 – 18
Volume II IndexI - 10



PINNACLE

Index
TARGA 16 – 10

TIFF 16 – 10

VCD 16 – 28

VOB 16 – 18, 16 – 29

WAV (48 kHz or 44.1 kHz) 16 – 10

XML project 7 – 5

XSend to... 7 – 9

Export Sequence
MPEG-IPB 16 – 10

Export to DVD 16 – 18

Burn to CD/DVD 16 – 33

Compile and/or burn 16 – 35

Destination Folder and Temporary 
Folder 16 – 31

Destination format selection 16 – 25

DVD Image 16 – 30

formats supported (CD-R, CD-RW, DVD-
R, DVD-RW, DVD+RW, DVD-RAM, 
DVD+R) 16 – 34

IPB Settings 16 – 36

Program Stream 16 – 27

Reduce bit rate 16 – 47

Source selection 16 – 21

SVCD 16 – 28

Video bit rate 16 – 37

Extend 
(Function for Trimming Clips) 9 – 61

External Audio Fader 13 – 63

F
Fade to black Glossary G – 20

Fade-In (1-click Fade In/Out) 13 – 58

Fade-Out 
(1-click Fade In/Out) 13 – 58

Fader Glossary G – 20

Audio Editor 13 – 24

Balancing Faders 
(External Audio Fader) 13 – 64

Lock 13 – 14

Falling Crystals 
(realtime effect) 11 – 33

FAT32 8 – 117

Feedback (Echo Audio Effect) 13 – 75

Fiber Channel Glossary G – 20

Field Glossary G – 20

Field of View 10 – 65

Field sequence Glossary G – 20

Fields/Frames Rendering 10 – 30

File Formats
Import Media Clips 6 – 48

Media Management 8 – 102

File Ingest 6 – 42

File Server Glossary G – 20

File Types
Animations/Single Frames 
(Images) 16 – 8

Import/Export EDL 7 – 20

Film Style (Edit Style) 9 – 26

Filter
see Clip Effects 10 – 4

Filter Editor (Clips) 10 – 84

Find
Quick Finder (Project) 8 – 40

Find Tool 8 – 41

Command Bar 8 – 48

Linking Search Attributes 8 – 44

Search Attributes 8 – 42

Search Results 8 – 47

Select Media Types 8 – 45

FireWire Glossary G – 20

Fit to Fill
Linear Timewarp 12 – 46

Timewarp Editor 12 – 64

Flash Macromedia 7 – 11

Flip horizontal/vertical
Backside image (3D Editor) 10 – 68

Image (3D Editor) 10 – 62

Folder (Project) 8 – 8

Create 8 – 9

Cut/Copy/Paste 8 – 10, 8 – 29

Delete 8 – 13

Foreground
Luminance Key 10 – 77

Priority (Multi Layer) 10 – 4

Transition Effects 10 – 41

Foreground (pixel type DVD) 15 – 29

fps
frames per second 3 – 12

frames per second, 
see Frame Rate 16 – 11

indicator 3 – 12

Fragmentation Glossary G – 20

Frame Glossary G – 21

Frame Buffer Glossary G – 21

Frame Rate Glossary G – 21

Adjust 16 – 11

Frames/Fields Rendering 10 – 30

Framestore Glossary G – 21

Freeze 12 – 49, Glossary G – 21

Freeze frame (Timeline) 9 – 66

Freeze Frame 
(Timewarp Editor) 12 – 49

Linear Timewarp 12 – 46

Timewarp Editor 12 – 63

Frequency Glossary G – 21

Frequency Bands 13 – 72

Front Light 10 – 67

Full Control Digitize 6 – 37

Full Screen Mode 
(Effect Editor) 10 – 15

Full size monitor 9 – 117

Fuse Export Routing 13 – 36

Fuse Sequence 16 – 16

Calling 16 – 17

Preparations 16 – 16

Start 16 – 17

FX 10 – 6, Glossary G – 21

see Effect and Effect Editors

FX Properties 
(Object Shortcut Menu) 8 – 71
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G
Gain

Color Correction 12 – 29

Color Editor 10 – 71

Headroom (Maximizer) 13 – 74

Gamma
Color Correction 12 – 30

Color Editor 10 – 72

Gap
Delete on Timeline 9 – 88

Insert on Timeline 9 – 22

On Toolbar 17 – 9

Garbage 
(Selective Color Correction) 12 – 43

Gaussian Blur (Filter Editor) 10 – 87

GB Glossary G – 21

Generation losses Glossary G – 21

Gigabit Ethernet Glossary G – 22

Gigabyte Glossary G – 22

Global Layer (Keyboard) 17 – 13

Global Modification of Audio 
(Adjust Audio) 13 – 59

GOP Glossary G – 22

GOP size (IPB Settings) 16 – 38

Goto
Marker (Clip Viewer) 8 – 58

specific TC Position 
(Logging Tool) 6 – 9

GPI 9 – 33, Glossary G – 22

Grab Picons 8 – 29, 8 – 34

Gradient
Color Blend/Border Tool 10 – 44

Color Clip 6 – 57

Gradient Wipe (realtime FX) 11 – 37

Gradient Wipe with Border 
(realtime FX) 11 – 37

Graphics Files
Import 6 – 49

Graphics Formats *.tga, *.bmp, *.tif 
(Sequence

Export As...) 16 – 13

Gray Balance 12 – 32

Green Channel
Color Gain 10 – 71

Green Screen Key
see Blue Screen Key

Grouped/Ungrouped (Assigning 
Source Track) 9 – 22

Grungelizer (VST PlugIn) 13 – 79

GUI Glossary G – 22

GVG (EDL Format) 7 – 20

H
Handle Length

Batch Digitize 8 – 79
Condense 8 – 89
Consolidate 8 – 86
OMF Export 7 – 34
Scene Detection (Clip Viewer) 8 – 95
Scene Detection 
(Logging Tool) 6 – 41

Hard disk Glossary G – 22

HD, HDTV, see High Definition 5 – 1

HDCAM Glossary G – 22

HDTV Glossary G – 22

HDV
capture 5 – 18
output 5 – 21
standards 5 – 9

Head/Tail Picons
Display/Hide 9 – 14
Update 9 – 6

Headroom 13 – 15

Audio Tool 13 – 15

Maximizer 13 – 74

Hertz (Hz) Glossary G – 23

Hi 8 Glossary G – 23

High Definition 5 – 1

basics and overview 5 – 3
capture HDV 5 – 18
converting TC systems 5 – 15
DV out (HDV) 5 – 21
editing HD (MPEG2) clips 5 – 19

editing HD (overview) 5 – 6
effects 5 – 19
filming in HD 5 – 6
HDV capture 5 – 18
HDV standards 5 – 9
implementation in Liquid 
(overview) 5 – 10

import HD material 5 – 18
input 5 – 18
mixing SD and HD clips on 
Timeline 5 – 20

monitoring 5 – 19
MPEG2 output 5 – 21
multiformat handling 5 – 12
Output (overview) 5 – 21
Quality Ranks 5 – 16
standards (production and 
transmission) 5 – 7

Timecode systems in Liquid 5 – 11
Timeline (overview) 5 – 19

Highlight
Backside image 10 – 68

Direction 10 – 68

Falloff 10 – 68

Highlight buttons (DVD) 15 – 29

Highlight collision (DVD) 15 – 33

Highlights 
(Primary Color Correction) 12 – 29

Histo Match 
(Primary Color Correction) 12 – 36

Histogram 
(Color Correction Editor) 12 – 24

History of Undos 9 – 33

HLS Color Model
Color Picker 6 – 57

Horizontal resolution Glossary G – 23

Host Glossary G – 23

HSB Color Code
Color Editor 10 – 71

Hue
Color Correction 12 – 30

Color Editor 10 – 71

Color Picker 6 – 57

Primary Color Correction 12 – 30
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Hue Match 
(Primary Color Correction) 12 – 37

Huffman Glossary G – 23

Hybrid systems Glossary G – 23

I
i.LINK Glossary G – 23

Icons
for Objects in Detail View 8 – 36

for Objects in Picon View 8 – 37

Idle (Render Viewer) 10 – 36

IEEE 1394 Glossary G – 23

I-frame Glossary G – 23

I-Frame only Glossary G – 23

Illegal Colors Glossary G – 24

Image
Center 
(Effect Editor, Position) 10 – 43

Image Import (Global Settings) 6 – 52

Impedance Glossary G – 24

Import 6 – 47

ALE project 7 – 4

Animations 6 – 51

Avid MediaLog 7 – 22

Copy/Move/Link 6 – 50

EDL 7 – 22

Global Settings Image Import 6 – 52

Images in 16/9 Format 6 – 49

Media Clips (Images, Animations, 
etc.) 6 – 49

Permissible File Formats 6 – 48

Photo CD 6 – 53

Sources and Destinations 6 – 47

Trust Media Meta Data 6 – 51

XML project 7 – 4

Imported Media Files 8 – 8

Impression (DVD authoring) 16 – 10

Include identical files 
(move to new location) 8 – 86

Incoming/Outgoing Clip 10 – 40

Index Picture
On Timeline Clip 9 – 14

Set Index Picture 
(Logging Tool) 6 – 17

Show (Object Properties) 8 – 70

Inlay Glossary G – 24

Inlay quality 9 – 119

Input Volume (Audio Mixer) 13 – 24

Insert Glossary G – 24

Black (Video) on Timeline 9 – 22

Clip (Using Drag & Drop) 9 – 56

Clip in Timeline (Send To...) 9 – 56

Gap on Timeline 9 – 22

Using Film Style 9 – 26

Using Overwrite Style 9 – 25

Insert Arrow (Sequence Editor) 9 – 42

Insert Edit (Record To Tape) 16 – 4

Insert FX
Audio Mixer 13 – 24

how to use them in 
Audio Mixer 13 – 44

Inset (realtime effect) 11 – 38

InterCom (messaging for members of 
a workgroup) 7 – 28

Interlace Glossary G – 24

Interpolation Glossary G – 24

Interpolation (Key Frames) 10 – 20

Intraframe 
Compression Glossary G – 24

Intraframe Sensitivity 8 – 95

Inverse Telecine 
(IPB Settings) 16 – 42

Invert
Filter Editor 10 – 85

Selected Objects 8 – 38

Invert (realtime FX) 11 – 34

IPB file (Export to DVD) 16 – 22

IPB Settings 16 – 36

GOP size 16 – 38

Inverse Telecine 16 – 42

Scene Detection 16 – 41

Iris Cross (realtime effect) 11 – 38

Iris Diamond (realtime effect) 11 – 38

Iris Round (realtime effect) 11 – 38

Iris Square (realtime effect) 11 – 38

Item Link 9 – 80

Add Item 9 – 81

Autoselect 
(Activate/Deactivate) 9 – 80

Edit of Linked Items 9 – 81

Link Item 9 – 80

Link Vertically 9 – 80

Unlink Item 9 – 80

ITU Glossary G – 24

ITU-R 601 Glossary G – 24

J
Jack connectors Glossary G – 24

Jam-Sync Glossary G – 25

Java Glossary G – 25

Jitter Glossary G – 25

JKL shuttle playback 9 – 29

Jog/Shuttle Glossary G – 25

JPEG Glossary G – 25

K
Karaoke (VST PlugIn) 13 – 79

Keep stereo Audio Mode... 9 – 7

Key Glossary G – 25

Key Caps (Keyboard) 17 – 14

Key Frames 10 – 20, Glossary G – 25

see also Audio Key Frames
Acceleration Curve 10 – 23

Commenting 10 – 21

Copy/Paste/Delete 10 – 21

Copying Settings to 10 – 34

Example 10 – 23

Interpolation 10 – 20

Moving 10 – 21

Set 10 – 21

Toolbar 10 – 22
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Key Transparency 
(Luminance Key) 10 – 77

Keyboard
Assignment Layers 17 – 11

Customize 17 – 11

Global Layer 17 – 13

Key Caps 17 – 14

Shortcuts and Modifiers 17 – 15

Keycode Glossary G – 25

Keying Glossary G – 25

Keying Editors 
(General Functions) 10 – 73

Key Mask 10 – 75

Lasso 10 – 75

Transparency 10 – 76

Keying Editors (Types) 10 – 75

Blue Screen Key 10 – 81

Chroma Key 10 – 79

Green Screen Key 10 – 75

Luminance Key 10 – 76

RGB Difference Key 10 – 83

L
Labels (numeric DVD) 15 – 38

LANC Glossary G – 25

Lasso
Keying Editor 10 – 75

Select Objects 9 – 57

Layer Glossary G – 26

Layering Glossary G – 26

Leeway (with Transitions) 9 – 36

Legalizer 
(Color Correction Editor) 12 – 26

Lens Flare 11 – 31

Level Glossary G – 26

Level Tone 6 – 59

Level Too High 6 – 28

Leveler (VST PlugIn) 13 – 78

Lightness
Color Editor 10 – 71

Lightning Display 
(Color Correction Editor) 12 – 22

Linear Acceleration (Effects) 10 – 24

Linear editing Glossary G – 26

Linear Timewarp 12 – 45

Motion Detection 12 – 48

Progressive 12 – 48

Strobe Effect 12 – 48

Trailing 12 – 48

Linearize/delinearize segment (Time-
warp Editor) 12 – 53

Lines Glossary G – 26

Link list (DVD Editor) 15 – 13

Linking (Hue and Saturation) 12 – 30

Linking (Objects) 9 – 80

Links (DVD) 15 – 8

Liquid Control
Assigning Keys 17 – 18

List
of Clip Names (Source Viewer) 9 – 41

of Sequences (Master Viewer) 9 – 44

Presentation of Objects as List 8 – 31

Live
Input (Logging Tool) 6 – 10

Mixing 
(Audio Mix Automation) 13 – 61

Recording Narration 
(Voice-Over) 13 – 65

Lock Faders
Audio Mixer 13 – 26

Audio Tool 13 – 14

Logging 6 – 36, Glossary G – 26

Definition 6 – 4

Offline 6 – 37

With Log Button 6 – 36

With Mark-In/Out 6 – 36

Logging and Digitizing 6 – 3

Basics 6 – 4

Checklist 6 – 35

Digitizing Methods 6 – 37

Logging Methods 6 – 36

Logging list 7 – 6

Logging Tool 6 – 7

(Re-)Digitize Individual Clip 6 – 40

Cancel Button 6 – 40

Clear TC fields 6 – 40

ClipLink 6 – 37

Create Subclips 6 – 39

Define Stereo/Mono 6 – 18

Disc Full 6 – 34

Edit Buttons 
(Mark-In/Out, etc.) 6 – 16

Go to Specific TC Position 6 – 9

Index Picture 6 – 17

Master (Register) 6 – 29

Media tab 6 – 29

MPEG-IMX-Transfer 
(Logging Tool) 6 – 10

Multicam 9 – 129

Name/Number Clips 6 – 21

Options (Overview) 6 – 31

Player Control (Remote) 6 – 14

Primary Color Correction 6 – 22

Rapid Capture 6 – 32

Select A/V Inputs 6 – 17

Select Audio Monitor 6 – 20

Select Destination Drives for 
Digitizing 6 – 19

Select Media Format 6 – 18

Select Play Source 6 – 10

Select Source Tracks 6 – 17

Select/Create Rack 6 – 12

Select/Create Reel 6 – 12

Send to Timeline (Clips) 6 – 30

Shuttle Playback 6 – 15

TC Fields, Status Field 6 – 8

Textual Clip Presets 6 – 34

Timecode Shift 6 – 13

Video Tool 6 – 20

Logical Output Bus
Audio Mixer 13 – 25

Output Mapping 13 – 32

Login 4 – 2

Comments 4 – 6

Existing User 4 – 3
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Password 4 – 7

Remove User 4 – 8

User Details 4 – 6

Looks (DVD Menu Editor) 15 – 45

Loss of Sync 6 – 33

Lost Media Files 8 – 39

Loudness (Maximizer) 13 – 74

LTC Glossary G – 26

Luma Keyer (realtime FX) 11 – 35

Luminance
Color Picker 6 – 57

Luminance Key 10 – 76, Glossary G – 27

Creating a Luma Key 10 – 77

Cutoff 10 – 77

Foreground 10 – 77

Graph Modes 10 – 78

Key Transparency 10 – 77

Threshold 10 – 77

Luminance Range 
(Chroma Key Editor) 10 – 80

Luminance Signal Glossary G – 27

M
m2v (Elementary Stream) 16 – 26

Magnetism (Snap Mode to Align 
Objects) 9 – 59

Magnify (FX) 11 – 31

Main Level Glossary G – 27

Main menu (DVD) 15 – 8

Main Profile Glossary G – 27

Mapping
see Source Track Mapping 9 – 22

Mappings Enabled (Timeline) 9 – 22

Mark clip(s) under Playline 9 – 57

Mark clips used in current Sequence 
(Project Properties) 8 – 16

Markers 8 – 57

Attach Comment 8 – 57

Delete TC Break Marker 6 – 33

Display Comments 8 – 58

Marker List 8 – 58

Setting and Deleting 8 – 57

Mark-In/Mark-Out
are inclusive 9 – 41

Move 9 – 41

Priority 9 – 41

Set 9 – 41

Mask (Keying Editors) 10 – 75

Invert 10 – 75

Lasso 10 – 75

Show 10 – 76

Softness 10 – 75

Transparency 10 – 76

Master Glossary G – 27

Master (tab in Logging Tool) 6 – 29

Master Timecode 9 – 50, 16 – 3

Master View (DVD) 15 – 36

Master Viewer 9 – 43

Load Sequences 9 – 44

New Sequence 9 – 47

New Sequence from Template 9 – 50

Save a Copy of Sequence 9 – 50

Save Timeline as Template 9 – 50

Sequence 9 – 47

Sequence List 9 – 44

Sequence Menu 9 – 49

Mastering (Record to Tape) 16 – 3

Match Frame
to clip 9 – 65

to Project 9 – 65

to tape 9 – 65

Matchback 8 – 99

Material Exchange Format 
(MXF) 7 – 16

Matrix (Audio Routing) 13 – 41

Matrix Surround 13 – 55, 16 – 32

Matte Track
add to Timeline 9 – 18

Effect composition 9 – 108

Max dB (Audio Tool) 13 – 14

Maximizer Glossary G – 27

Maximizer (Audio Effect) 13 – 74

Emphasis 13 – 74

Gain Headroom 13 – 74

Loudness 13 – 74

Normalized Audio 13 – 74

Signal Peaks 13 – 74

Maximum inlay size 9 – 120

MB Glossary G – 27

Media (OMFI Export) 7 – 34

Media (Tab in Project) 8 – 111

Media Clips
Import 6 – 49

Media Directory 8 – 108

Media File
Create Clip 8 – 114

Delete (Media Tab) 8 – 114

Delete (Options) 8 – 128

Find 8 – 41

Identical Media Files 8 – 107

Identify 8 – 99

Information in Object 
Properties 8 – 123

Naming 8 – 100

Open 8 – 114

search and import 8 – 126

Tag used media 8 – 114

unavailable (Symbol on Picon) 8 – 37

Various Functions 8 – 114

Also see Media Management

Media Files
Search and import 8 – 126

Media Format
Media Management 8 – 102

Select (Logging Tool) 6 – 18

Media Management 8 – 97

“Matchback” 8 – 99

Access Rights 8 – 119

Alias 8 – 118

Basics 8 – 98

Clip-Based View 8 – 112

Edit Media Directories 8 – 118

File Formats 8 – 102
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File-Based View 8 – 112

Identical Media Files 8 – 107

Identify Media File 8 – 99

Matching 8 – 110

Media Directories 8 – 108

Media Directories, Media 
Volumes 8 – 117

Media File Functions 8 – 114

Media Formats 8 – 102

Media Tab 8 – 111

Media Types 8 – 98

Metadata 8 – 98

Mixed View 8 – 112

Naming of Media Files 8 – 100

Overview 8 – 97

Primary Drive 8 – 118

Refresh View 8 – 111, 8 – 115

Render Formats 8 – 104

Rescan Directories 8 – 115

Save Audio and Video 
Separately 8 – 117

Settings 8 – 116

Streamed Media 8 – 98

System Formats 8 – 102

Tags 8 – 112

Views and Lists 8 – 112

Media Search 
(and import files) 8 – 126

Media tab
in Logging Tool 6 – 29

in Project window 8 – 111

Media Volumes 8 – 117

Megabyte Glossary G – 27

Megahertz Glossary G – 27

Menu buttons 
(DVD Menu Editor) 15 – 46

Menu return markers (DVD) 15 – 16

Menu templates (DVD) 15 – 35

Menus (DVD authoring) 15 – 8

Menus (DVD)
creating 15 – 40

Menus (Shortcut Menus) 3 – 4

Merge (Batch Digitize) 8 – 79

Metadata 6 – 50, 8 – 98, 
Glossary G – 27

Metadata-based Scene Detection 
(Clip Viewer) 8 – 96

MHz Glossary G – 27

MIDI Glossary G – 27

MIDI (External Audio Fader) 13 – 63

Mini DVD Image 16 – 31

Mirror Tool (Effect Editor) 10 – 46

Mix
Fields/Frames (Speed Control) 16 – 11

Mix Down
Container 9 – 112

Fuse Sequence 16 – 16

OMFI Export 7 – 33

Mixed Resolution 
Editing Glossary G – 27

Mixup (Echo) 13 – 75

M-JPEG Glossary G – 28

ML Glossary G – 28

MO Disk Glossary G – 28

Mode
Change (Scrub/Edit) 9 – 28

Modify Audio 9 – 67

Monitoring
Audio Monitor 13 – 16

Solo Function in the 
Audio Editor 13 – 26

Timeline Audio Playback 9 – 12

Mono/Stereo 13 – 8

see Stereo/Mono 13 – 60

Mosaic (Filter Editor) 10 – 85

Motion Detection
Linear Timewarp 12 – 48

Timewarp Editor 12 – 65

Motion FX
see 2 D Editor or 3D Editor

Motion menus (animated DVD menu 
background) 15 – 22

Motion vectors Glossary G – 28

Mouse Pointer
Different Modes & Shapes 9 – 10

Move Range (Timeline) 9 – 60

Movies (AVI, QuickTime)
Export 16 – 15

MP Glossary G – 28

MP@ML Glossary G – 28

MP2 audio 16 – 27

MP3 Audio (Import) 6 – 48

MPEG Glossary G – 28

MPEG-1 Glossary G – 29

MPEG-1 (Video CD) 16 – 28

MPEG-1 Layer 1, 2, 3 Audio 
Glossary G – 29

MPEG-1 Layer 2 Audio 16 – 27

MPEG-2 Glossary G – 29

MPEG-3 Glossary G – 29

MPEG-4 Glossary G – 29

MPEG-IMX (Logging Tool) 6 – 10

MPEG-IPB Elementary Stream (Export 
Sequence) 16 – 10

Multicamera Editing 9 – 121

Capture in the Logging Tool 9 – 129

Determining Sync Points 9 – 122

Editing Multicam Clips on the 
Timeline 9 – 128

MultiKamSync Command 9 – 123

Overview 9 – 121

Source Viewer 9 – 125

Synchronizing Multiple Clips 9 – 123

Synchronizing with TC Shift 9 – 130

Multiformat handlling on Liquid 5 – 12

Multiframe Scan (Clip Viewer Scene 
Detection) 8 – 95

MultiKamSync 9 – 121

Multilayer 3D Clip Effects 10 – 66

Multilayer EDL 7 – 21

Multimedia Glossary G – 29

Multi-processor Glossary G – 29

MultiShape Crop (realtime FX) 11 – 31
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MultiShape PiP 
(realtime effect) 11 – 31

MultiShape Spotlight 
(realtime effect) 11 – 31

Multi-tracking Glossary G – 29

Mute
Audio Monitor 13 – 16

Audio Timeline Tracks 13 – 11

MXF data exchange 7 – 16

N
Name/Number Clips

in Logging Tool 6 – 21

Native Digital Editing Glossary G – 29

Navigation (Timeline) 9 – 28

Scrub Mode 9 – 28

Scrubbing (Video) 9 – 29

Using the Keyboard 9 – 29

Using the Mouse 9 – 28

Using Tool Buttons 9 – 29

Zoom Control & Scroll Bars 9 – 28

Nesting Sequences 9 – 112

Network 7 – 24

and Pinnacle Liquid 7 – 24

assign drive or directory 7 – 24

AVI index files 7 – 26

Block size 7 – 26

Peak files 7 – 26

save network data locally 7 – 25

settings 7 – 26

share Projects 7 – 27

Network Settings
Windows XP settings 7 – 27

Noise Glossary G – 30

Non-drop frame Glossary G – 30

Non-linear Editing Glossary G – 30

Non-Square-Pixel Glossary G – 30

Normal 
(button highlights DVD) 15 – 29

Normalized Audio (Maximizer) 13 – 74

Notch Filter 
(Equalizer Audio Effect) 13 – 73

NTFS 8 – 117

NTSC Glossary G – 30

Pixel Format 8 – 124

O
Object

Add to Timeline 9 – 56

Align (Timeline) 9 – 58

Basics 8 – 27

Cascade Selected Objects 8 – 75

Copy to Another Project 6 – 54

Create (Overview) 6 – 56

Customize Properties 8 – 68

Cut/Copy/Paste 8 – 29

Delete 8 – 128

Delete (Timeline) 9 – 62

Detail View Icons 8 – 36

Edit properties (multiple) 8 – 70

Find 8 – 41

Icons (Detail View) 8 – 36

Icons (Picon View) 8 – 37

Import (Overview) 6 – 47

Insert in Timeline (Send To...) 9 – 56

Invert Selection 8 – 38

Link Objects 9 – 80

Move Horizontally on Timeline 9 – 59

Move Vertically on Timeline 9 – 59

Move/Copy Range 9 – 60

Picon Play 8 – 74

Positioning (Timeline) 9 – 58

Properties (General) 8 – 66

Rename/Number 
(Project/Timeline) 8 – 30

Select 9 – 57

Select All 8 – 38

Shortcut Menu (Project) 8 – 29

Shortcut Menu (Timeline) 9 – 63

Shuffle Selection 8 – 75

Sort Objects 8 – 38

Storyboarding 8 – 73

Trimming (Timeline)
View Object (Clip Viewer) 8 – 50

Odd/Even (TV lines) 8 – 124

Offline (Logging) 6 – 37

Offline Editing Glossary G – 30

Offset
Shadow Tool 10 – 45

Trailing Tool, Effect Editor 10 – 46

OK/NG
Object Properties 8 – 70

OMFI Export 7 – 31

Composition 7 – 33

Consolidate Media 7 – 34

Media 7 – 34

Open 7 – 32

Options 7 – 35

Online Editing Glossary G – 30

Open End (Logging Tool) 6 – 38

Open Media Framework Interchange
see OMFI Export

Open/Create (Project) 8 – 4

Optical Disk Glossary G – 30

Optical storage media Glossary G – 30

Optimize realtime preview 11 – 8

Order (Render Effects) 10 – 8

Original Glossary G – 31

Outgoing/Incoming Clip 10 – 40

Output 16 – 2

Export Sequence as... 16 – 8

Fuse Sequence 16 – 16

Leader 16 – 6

OMFI Export
Record to Tape 16 – 3

see also Export
Stripe Sequence 16 – 6

Stripe Tape 16 – 6

XSend to... 7 – 9

see also Inputs/Outputs
Output Levels (Audio Tool) 13 – 14

Output Mapping 13 – 32

Bus type 13 – 34
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Classic bus 13 – 35

Fuse/Export routing 13 – 36

Overview (table) 13 – 37

physical outputs 13 – 35

Stereo bus 13 – 34

Surround 5.1 bus 13 – 34

Track type 13 – 34

Why busses? 13 – 32

Output Volume (Audio Mixer) 13 – 25

Overlap (see also leeway) 9 – 36

Overlapping 
(Objects on Desktop) 8 – 75

Overload Thresholds 
(Audio Tool) 13 – 14

Overscan
Clip Viewer (Source Viewer) 8 – 56

Overwrite (Edit Style) 9 – 25

P
P Frame Glossary G – 31

Page Curl (realtime effect) 11 – 32

Page Peel (realtime effect) 11 – 32

Pages
adding/deleting (DVD) 15 – 21

Pageturn Effect 10 – 66

PAL Glossary G – 31

Pixel Format 8 – 124

PALplus Glossary G – 31

Pan/Balance Lines
Edit (Rubberbanding) 13 – 27

Show 13 – 6

Panasonic Edit Glossary G – 31

Panorama and Balance
Show Pan/Balance (Timeline) 13 – 6

Parameters and Options
Effect Editors 10 – 29

Parametric Equalizer 13 – 72

Parent Project 
(Object Properties) 8 – 70

Password (Login) 4 – 7

Paste
Clip FX (Paste FX Parameters) 9 – 64

Clips at Playline Position 9 – 59

Volume/Panning 9 – 64

PCM Glossary G – 31

Peak files (network) 7 – 26

Peak Level Meter (Audio Tool) 13 – 15

Pedestal 
(Primary Color Correction) 12 – 30

Personalize software interface
see Customize

Photo CD (Import Media Clip) 6 – 53

Physical outputs 
(Output Mapping) 13 – 35

Picon
automatic update (Project) 8 – 16

Desktop Storyboarding 8 – 73

DVD authoring 15 – 18

Grab picons 8 – 34

Head/Tail (Timeline Clip) 9 – 6

Picon Play 8 – 74

setting animated picons 
(DVD) 15 – 18

Size 8 – 34

update automatically (Timeline) 9 – 7

update manually (Project) 8 – 29

updating at new cuts 9 – 55

View 8 – 34

Picon View
Icons 8 – 37

Mark-In/-Out 8 – 35

Media File Unavailable 
(Symbol on Picon) 8 – 37

Pinnacle Impression 16 – 10

Pipette
Chroma Key Editor 10 – 79

Color Matte Clip 6 – 57

Pivot Point 10 – 60, 10 – 65

Pixel Glossary G – 31

Pixel Format
Export 16 – 11

Global Graphics Settings 6 – 53

Pixel types (DVD) 15 – 29

Pixels (CCIR vs square) 9 – 119

Platform Glossary G – 32

Playback Level (Audio) 6 – 28

Playback On/Off 
(Timeline Audio) 13 – 11

Playback Server Glossary G – 32

Player Control (Logging Tool) 6 – 14

Playline 9 – 5

Move 9 – 28

see also Navigation (Timeline)

Plug-In Glossary G – 32

PlugIns (Audio, VST) 13 – 76

Position 10 – 58

Position Bar (overview) 8 – 53

Position Tool (Effect Editor) 10 – 43

Positive/Negative 
Acceleration 10 – 25

Posterize (Filter Editor) 10 – 86

Posterize (realtime FX) 11 – 35

Postproduction Glossary G – 32

Postroll Glossary G – 32

Audio Settings (Voice-Over, 
Mix Automation) 13 – 67

Precoding (Striping) Glossary G – 32

Preread Glossary G – 32

Preroll Glossary G – 32

Audio Mix Automation 13 – 61

Voice Over 13 – 66

Preset (Recorder Setting During Pre-
coding) 16 – 7

Preview
Clips in Rack 8 – 30
DVD 15 – 37
Effect 10 – 17
Preview Image 
(Effect Editors) 10 – 14

Quality (Rendering) 10 – 37
Realtime effects 11 – 5
Realtime effects 
(optimization) 11 – 8

Trim Editor 9 – 71, 9 – 77
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Preview of Effects 11 – 6

Primary 
Color Correction 12 – 27, 12 – 30

Black 12 – 30

Black-Gamma-Gain (Contrast) 12 – 31

Color Cast Correction 12 – 32

Contrast 12 – 31

Contrast Adaptation 12 – 31

Gain 12 – 29

Gamma (Midtones) 12 – 30

Gray Balance 12 – 32

Highlights 12 – 29

Histo Match 12 – 36

Hue 12 – 30

Hue Match 12 – 37

Linked Control (Mouse) 12 – 28

Parameters 12 – 29

Reference Source 12 – 28

Saturation 12 – 30

Separate Control 12 – 28

Tone Balance 12 – 35

White-Balancing 
(Subsequent) 12 – 32

Primary Drive 
(Media Management) 8 – 118

Print EDL 7 – 21

Priority
Background/Foreground 
(Transitions Effects) 10 – 41

Clip FX (Timeline) 10 – 4

Mark-In/Mark-Out 9 – 41

Mark-In/Out 
(Three-Point Editing) 9 – 52

Multilayering 10 – 4

of Timeline Tracks 9 – 21

Order of Effects (FX Properties) 10 – 8

Render Effects 8 – 71

Profile Glossary G – 33

Program Stream Glossary G – 33

Program Stream 
(Export to DVD) 16 – 27

Progressive Scanning Glossary G – 33

Project 8 – 4

Clean Up 3 – 20, 8 – 6, 8 – 133

Create Rack 8 – 9

Create Rack Folder 8 – 9

Delete 8 – 6

Delete Rack 8 – 13

Delete Rack Folder 8 – 13

Delete Render Files 3 – 20

Delete Template 8 – 5

Detail View (List) 8 – 31

Diagnose project 8 – 18

Import Objects (see Import)
InterCom 7 – 28

Media Directories 8 – 108

Multiple Folder Levels 8 – 9

Objects in the Project
(Overview) 8 – 31

Objects, Shortcuts, Copies and Media 
Files 8 – 27

Open/Create Project 8 – 4

Picon Play 8 – 74

Picon View 8 – 34

Project Browser 8 – 14

Properties 8 – 16

Quick Finder 8 – 40

Rack Folder 8 – 8

Racks 8 – 8

Save Project 8 – 6

Save Template 8 – 5

share Projects in network 7 – 27

Sort Objects 8 – 38

Storyboarding (Desktop) 8 – 73

Structure (Overview) 8 – 7

Toolbar 8 – 30

Tree Area 8 – 7

two projects simultaneous 8 – 4

Verify Imported Media 8 – 39

Viewing Several Racks 
Simultaneously 8 – 12

Window (resize, move, etc.) 8 – 8

Project Browser 8 – 14

Project Window (Basics) 3 – 21

Properties
Attributes 8 – 70

FX (Audio Clip) 13 – 71

FX (Video Clip) 8 – 71

Object (edit multiple clips 
simultaneously) 8 – 70

Object (General) 8 – 66

Project 8 – 16

Timeline 9 – 7

Property Sets 17 – 3, 17 – 5

Activate 17 – 7

Calling 17 – 5

Create New 17 – 7

Delete 17 – 7

Where Are They Saved? 17 – 6

Protecting Tracks 9 – 17

Proxy (network) 7 – 30

PSD (Photoshop DVD menus) 15 – 50

Pseudo 16:9 5 – 14

Pseudo-Stereo 13 – 10

Push (realtime effect) 11 – 38

Q
Q Slider (Equalizer) 13 – 73

QSDI Glossary G – 33

Quality (Inlay, display) 9 – 119

Quality Ranks 5 – 16

Quality Specifications Glossary G – 33

Quantisation Glossary G – 33

Quick Finder (Project) 8 – 40

Quicktime Glossary G – 33

QuickTime (Export Sequence) 16 – 10

R
Rack

Create 8 – 9

current (active) 8 – 8

Cut/Copy/Paste 8 – 10, 8 – 29

Delete 8 – 13

Desktop Shortcuts 8 – 12
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Rack Folder 8 – 9

Select/Create (Logging Tool) 6 – 12

Several Racks Simultaneously 8 – 12

Sort Objects 8 – 38

Radial Wipe (realtime effect) 11 – 39

Radius 10 – 67

RAID Glossary G – 33

RAID Arrays Glossary G – 33

RAID Level Glossary G – 33

RAM Glossary G – 34

Ranks (quality) 5 – 16

Rapid Capture 6 – 32

Razor cut (= Add Edit function) 9 – 55

RCTC Glossary G – 34

Reading in Avid Media Log 7 – 22

RealTime ColorFX 12 – 44

Realtime Effects
Audio 13 – 70

Realtime effects
all editors 11 – 25

background info 11 – 4

optimize preview 11 – 8

Preview 11 – 5

Render management 11 – 7

Render Viewer 11 – 9

when to render 11 – 4

Record To Tape 16 – 3

Assemble Edit 16 – 5

Dump To Tape 16 – 4

Insert Edit 16 – 4

Recorder Control 16 – 5

Start Recording 16 – 5

Stripe Tape 16 – 6

Recorder Glossary G – 34

Rectangle
Generate Signal Clip 6 – 59

Pattern (Wipe Editor) 10 – 53

Recurrent Use of Clips 9 – 14

Red Channel
Color Gain 10 – 71

Red Marker (Indicating Timecode 
Break) 6 – 33

Red-green-yellow 
(Timeline Slice ) 9 – 9

Redo/Undo 8 – 30

Reel
increment number 
automatically 6 – 12

Match Frame 9 – 65

Select/Create (Logging Tool) 6 – 12

Reference Level Tone 6 – 59

Reference Source (Primary Color Cor-
rection) 12 – 28

Reflection (realtime effect) 11 – 33

Refresh View 
(Media Management) 8 – 111, 8 – 115

Re-link media 8 – 39

Remove User (Login) 4 – 8

Rename/Number
Clip/Object in Timeline/Project 8 – 30

Render
Delete Render Files 8 – 131

Formats 8 – 104

Order of Render Effects 8 – 71

Viewer 10 – 35

Render Viewer 11 – 9

Rendering Glossary G – 34

Background 10 – 35

enable/disable 10 – 35

Frames/Fields 10 – 30

Idle 10 – 36

Idle Status 10 – 36

Options (Effect Editors) 10 – 30

Problems 10 – 35

Quality (final) 10 – 37

Quality (Preview) 10 – 37

Render Viewer 10 – 35

Sigma Icon (Taskbar) 3 – 12

Start/Stop 10 – 35

yellow slices 10 – 35

Replicate (realtime effect) 11 – 32

Rescan Directories 
(Media Management) 8 – 115

Resolution Glossary G – 34

Response Time 
(Peak Level Audio Tool) 13 – 15

Restore
Default State (Function) 3 – 8

Initial State (Function) 3 – 8

Restrict dragged Transitions to avail-
able handles 9 – 7

Return Marker (DVD) 15 – 16

Reverb (VST PlugIn) 13 – 80

Reverberation 
(Echo Audio Effect) 13 – 75

Reverse Playback
Timeline (Shuttle Playback) 8 – 60

Timewarp Editor 12 – 63

RGB Glossary G – 34

RGB (Gamma, Color Editor) 10 – 72

RGB channels 10 – 19

RGB Color Model
Color Correction (basics) 8 – 65

Color Correction Editor 12 – 9

Color Picker 6 – 57

Logging Tool 6 – 24

RGB Difference Key 10 – 83

Pick Color 10 – 83

Similarity 10 – 83

Softness 10 – 80, 10 – 83

RGBA (view channels) 10 – 19

Right Mouse Click 3 – 4

Roll 10 – 67

Roll / Crawl (realtime FX) 11 – 35

ROM Glossary G – 34

Rotation
3D Camera 10 – 64

3D Effect 10 – 59

Tool (Effect Editor) 10 – 44

Rotoscoping Glossary G – 34
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Rounded or Right-Angled Border 
Edges 
(Effect Editors, Border Tool) 10 – 45

RS-232 Glossary G – 35

RS-422 Glossary G – 35

Rubberbanding
Audio Editing Using 
Key Frames 13 – 27

S
S/N Glossary G – 37

Safe Action Area/Title Marks 10 – 22

Sampling rate Glossary G – 35

Sampling ratio Glossary G – 35

Saturation Glossary G – 35

Color Editor 10 – 71

Primary Color Correction 12 – 30

Save a Copy
Project 8 – 6

Sequence 9 – 50

Save Template
Project 8 – 5

Timeline 9 – 50

Sawtooth 
(Generate Signal Clip) 6 – 59

Scart Glossary G – 35

Scene and Take Number 
(Project Properties) 8 – 16

Scene Detection 
(Automatic, Logging Tool) 6 – 40

Scene Detection (Clip Viewer)
based on metadata 8 – 96

based on video content 8 – 94

Multiframe Scan 8 – 95

Sensitivity 8 – 95

Step by Step 8 – 94

Scene Detection 
(IPB Settings) 16 – 41

Scene splitter (see Automatic Scene 
Detection) 8 – 93

Scroll Bars (Timeline) 9 – 5

Scrub Mode 9 – 28

Scrubbing Glossary G – 35

Audio 8 – 56, 13 – 11

Selecting Tracks 
(Clip/Source Viewer) 13 – 12

Selecting Tracks (Timeline) 13 – 12

Trim Editor 9 – 73

Video 9 – 29

SCSI Glossary G – 35

SDI Glossary G – 36

SDTI Glossary G – 36

Search Attributes (Find Tool) 8 – 42

Secam Glossary G – 36

Select (Timeline Objects)
After Playline 9 – 57

Click 9 – 57

Drag a Lasso 9 – 57

Under Playline 9 – 57

Select All (Objects) 8 – 38

Select all Overlapping 
(Desktop) 8 – 75

Select Audio Monitor
Logging Tool 6 – 20

Select Audio Tracks (Scrubbing) 8 – 56

Selected 
(button highlights DVD) 15 – 29

Selective Color Correction 12 – 39

Color Editing 12 – 43

Color Isolation 12 – 41

Color Isolation (Mouse) 12 – 43

ColorWash 12 – 43

Garbage 
(Non-Selected Range) 12 – 43

Target Vector Selection 12 – 44

Vector Definition 12 – 40

Send Bus fader (Audio Mixer) 13 – 27

Send Captured Clips to Timeline 
(Logging Tool) 6 – 30

Send Clip to
Background 10 – 41

Foreground 10 – 41

Send Effects
how to use them in 
Audio Mixer 13 – 45

Send FX (Audio Mixer) 13 – 24

Send To
Timeline 8 – 76

see also XSend to...

Sensitivity (Clip Viewer Scene 
Detection) 8 – 95

Sequence 9 – 47

as a Clip 9 – 52

Batch Digitize 8 – 77

Build Container 9 – 112

Creating Sequences 
(Sample Step by Step) 9 – 83

Export Sequence as ... 16 – 8

Fit Sequence to Mark In and
Mark Out 9 – 45

Fuse Sequence 16 – 16

List 9 – 44

Loop Playback 9 – 51

Menu 9 – 49

New Sequence 9 – 47

New Sequence from Template 9 – 50

Playback 9 – 51

Save a Copy 9 – 50

Set Start Timecode 9 – 50

Stripe Sequence 16 – 6

Sequence Editor 9 – 38

Editing with the Insert Arrow 9 – 42

Insert Arrow 9 – 42

Master Viewer 9 – 43

New Sequence from Template 9 – 50

Save a Copy of Sequence 9 – 50

Save Timeline as Template 9 – 50

Sequence 9 – 47

Sequence List 9 – 44

Sequence Menu 9 – 49

Source Viewer 9 – 39

Sequence events (DVD) 15 – 26

Sequencing Glossary G – 36

Server Glossary G – 36
Volume II Index I - 21



PINNACLE

Index
Set Audio Mode 
(Stereo/Mono) 13 – 60

Set Start Timecode 9 – 50

Shadow Tool (Effect Editor) 10 – 45

Shapes of Mouse Pointer 9 – 10

Shared projects 7 – 27

Shift Timecode 6 – 13

Shortcut Glossary G – 36

Basics 8 – 27

Picon 8 – 11

Rack 8 – 11

Shortcut Menu
Basics 3 – 4

Desktop Object 8 – 75

Effect Editors 10 – 32

Project Clip (Object) 8 – 29

Timeline 9 – 6

Timeline Clip 9 – 63

Tracks 9 – 8

Transition Effect 9 – 35

Shortcuts and Modifiers 
(Keyboard) 17 – 15

Shotlist 7 – 6

Show only full result 
(Trim Editor) 9 – 77

Shuttle Glossary G – 37

Shuttle Playback 8 – 60

Sigma Icon (Render Viewer) 3 – 12

Signal Clip 6 – 59

Properties 6 – 59

Silence 6 – 59

Sine 6 – 59

Waveform 6 – 59

Signal Peaks
Audio Tool 13 – 14

Maximizer 13 – 74

Signal-to-Noise-Ratio Glossary G – 37

Silence (Generate Signal Clip) 6 – 59

Similarity 
(RGB Difference Key) 10 – 83

Simulate burn process (DVD) 16 – 34

Sine (Generate Signal Clip) 6 – 59

Single Frames (Images)
Export 16 – 13

Single Trim (Trim Editor) 9 – 74

Six Vector Color Correction 12 – 38

Size Tool (Effect Editor) 10 – 43

Slice
color coding 9 – 9

Colors indicating non-rendered pas-
sages 10 – 7

numbers 9 – 9

Slide (realtime effect) 11 – 39

Slide Clips 
(Timeline Trim Function) 9 – 61

Slip Clip (Trim Editor) 9 – 75

Slope (Equalizer) 13 – 73

Slow Motion
Digitizing Slow Motion Clips 8 – 84

Linear-Timewarp 12 – 45

Timewarp Editor 12 – 62

SMPTE Glossary G – 37

SMPTE/EBU Timecode Glossary G – 37

Snap Mode (Align Objects) 9 – 59

SoftClipping 
(Color Correction Editor) 12 – 26

Softness
Chroma, RGB Difference Key 10 – 80

Effect Editor, Border Tool 10 – 44

Effect Editor, Shadow Tool 10 – 45

Effect Editors (General) 10 – 46

RGB Difference Key 10 – 83

Solarize (Filter Editor) 10 – 86

Solo (Audio Editor) 13 – 26

Sony BVE 9100 (EDL Format) 7 – 20

Sony ClipLink 6 – 37

Sort
Objects (Project) 8 – 38

Source (Player)
Select 6 – 10

Source Timecode 9 – 15

Source Track Mapping 9 – 22

Individual Tracks 9 – 24

Insert Black 9 – 22

Insert Clips Grouped/
Ungrouped 9 – 22

Mapping Enabled/disabled 9 – 22

Menu 9 – 22

Stereo mappings separate 9 – 22

Track Labels 9 – 23

Source Tracks 13 – 8

Assign to Timeline Tracks 9 – 22

More than 8/16 Source Tracks 13 – 13

Select (Logging Tool) 6 – 17

Source Viewer 9 – 39

Clip Name List 9 – 41

Dragging Clips from 9 – 40

Insert Arrow 9 – 42

Loading Clips to 9 – 40

Make Subclip 8 – 61

Multicamera Editing 9 – 125

Shuttle Playback 8 – 60

Speed
change (Linear Timewarp) 12 – 46

Display Speed of Timeline Clip 9 – 14

see Timewarp Editor 9 – 14

Shuttle Playback 8 – 60

Spins 
(Effect Editor/Rotation Tool) 10 – 44

Splined Acceleration (Effects) 10 – 24

Square Pixel Glossary G – 37

Square Pixel Format 16 – 11

SSA Glossary G – 37

Stabilizer Glossary G – 38

Stained Glass (realtime effect) 11 – 33

StandbyOff 
(Logging Tool, options) 6 – 31

Star (Symbol on Picon) 8 – 37

Start Timecode
Stripe Tape 16 – 7

Timeline (Sequence) 9 – 50

Stereo Glossary G – 38

Separate Mapping 9 – 22

Stereo bus (Output Mapping) 13 – 34
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Stereo mappings separate 9 – 22

Stereo Waveform Indicator 13 – 7

Stereo/Mono 13 – 8

Audio Routing 13 – 38

Clip Property 13 – 9

for Logging/Digitizing 6 – 18

Pseudo Stereo 13 – 10

Set Audio Mode 13 – 60

StereoEcho (VST PlugIn) 13 – 81

StereoSpread (VST PlugIn) 13 – 82

Still 12 – 49

Freeze (Linear Timewarp) 12 – 49

Freeze Frame (Timeline) 9 – 66

Linear Timewarp 12 – 46

Single Frame Export 16 – 10

Timewarp Editor 12 – 63

Still Media 8 – 98

Storage Location 8 – 109

Stop (Button, Logging Tool) 6 – 40

Storage Capacity Glossary G – 38

Storage Requirements Glossary G – 37

Storyboarding
In a Rack 8 – 76

On the Desktop 8 – 73

Send to Timeline 8 – 76

Streamed Media 8 – 98

Storage Location 8 – 108

Stripe Tape 16 – 6

Leader 16 – 6

Start Timecode 16 – 7

Stripe Sequence 16 – 6

Strobe
Linear Timewarp 12 – 48

Timewarp Editor 12 – 65

Subclip 6 – 39, 8 – 61

Create (Logging Tool) 6 – 39

Create (Source/Clip Viewer) 8 – 61

Submix (Audio Routing) 13 – 41

Subpictures (DVD) 15 – 29

Subpixel Glossary G – 38

Super Video CD (SVCD) 16 – 28

Surround Glossary G – 38

Surround (5.1 Encoder) 13 – 55

Surround (Option DVD Export) 16 – 32

Surround 5.1 bus 
(Output Mapping) 13 – 34

Surround 5.1 Sound 13 – 47

5.1 encoding 13 – 55
configuring the Mixer 13 – 50
output 13 – 55
Requirements 13 – 47
Surround lines on Timeline 13 – 52
the concept 13 – 48
Timeline preparation 13 – 49
tips for surround mixing 13 – 53

SVCD
Burn 16 – 33

Export to DVD 16 – 28

Step by step burning 16 – 20

S-VHS Glossary G – 38

S-Video Glossary G – 38

Swap Sources 
(Transition Effect) 10 – 31

Symmetrical Glossary G – 38

Sync Break 9 – 14

Sync Lock 9 – 78

Synchronicity
General Remarks 9 – 104
Sync Break Function 9 – 14
Sync Lock Function 9 – 78

Synchronization Glossary G – 38

Synchronize clips 
(ClipSync function) 8 – 90

System Formats 8 – 102

Background Information 8 – 102

T
Tabs (Basics) 3 – 7

Tag used media 
(Media Management) 8 – 114

Tags (Media Management) 8 – 112

Tape
Match to timeline clip 9 – 65

Tape, Striping 16 – 6

TARGA Export 16 – 10

Targets (DVD) 15 – 8

Taskbar (Desktop) 3 – 11

TBC Glossary G – 38

TC Shift
Timecode (Logging Tool) 6 – 13

TCP/IP Glossary G – 39

Template 8 – 5

Delete (Project) 8 – 5

editing (DVD menus) 15 – 41

Save (Project) 8 – 5

Timeline (Default Template) 9 – 50

Timeline (Save) 9 – 50

Where They Are Saved 17 – 6

Text Information on Clips 
(Timeline) 9 – 15

Textual Clip Presets 6 – 34

Three-Point Editing 9 – 52

Threshold
Luminance Key 10 – 77

Solarize 10 – 86

Thumbnail (buttons DVD) 15 – 47

Thumbs-up 
(see Error Indicator) 3 – 12

TIFF Export 16 – 10

Timecode Glossary G – 39

Activate TC Shift 6 – 31

clear TC fields 6 – 9

Edit/Calculate Timecode Fields 6 – 9

Formats 6 – 9

Leader 16 – 6

Start Timeline TC 9 – 50

Stripe Sequence 16 – 6

Stripe Tape 16 – 6

TC Shift 6 – 13

Timecode Bar 9 – 5

Timecode Systems 5 – 11, 6 – 9

converting TC systems 5 – 15

Timeline 9 – 3, Glossary G – 39

ABC of Effects 9 – 34
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Add Objects 9 – 56

Align Objects 9 – 58

Build Container (Nesting) 9 – 112

Clip Display 9 – 14

Clip FX Properties 9 – 68

Clip Info 9 – 63

Clip Undo/Redo 9 – 65

Delete Objects 9 – 62

Delete Range 9 – 62

Display Speed of Clip 9 – 14

Edit Active/Inactive 9 – 17

Edit Mode 9 – 55

Edit Styles 9 – 25

Edit Tools 9 – 55

Editing Directly on the 
Timeline 9 – 54

Empty Timeline 9 – 5

Grouped Video and Audio 9 – 23

HD editing 5 – 19

Insert Objects with 
Insert Arrow 9 – 42

Layout (Basics) 9 – 4

Markers 9 – 32

Master Viewer 9 – 43

Match Frame to tape and clip 9 – 65

Move/Copy Range 9 – 60

Moving Objects with Keyboard 9 – 59

Multicam 9 – 128

Navigating the Timeline 9 – 28

New Sequence from Template 9 – 50

Objects (Overview) 9 – 63

Playline 9 – 5

Positioning Objects 9 – 58

Properties 9 – 7

Protected Tracks 9 – 17

Recurrent Use (of Clips) 9 – 14

Save a Copy of Sequence 9 – 50

Save Timeline as 
Default Template 9 – 50

Save Timeline as Template 9 – 50

Scroll Bars 9 – 5

Select Objects 9 – 57

Set Start Timecode 9 – 50

Slice Numbers 9 – 9
Source Track Mapping 9 – 22
Source Viewer 9 – 39
Sync Break 9 – 14
Text Information on Clips 9 – 15
Three-Point Editing 9 – 52
Timecode Bar 9 – 5
Track Headers 9 – 11
Track Name Header 9 – 13
Track Priority 9 – 21
Track Shortcut Menu 9 – 8
Undo/Redo 9 – 33
Video / Audio Playback 9 – 12
Zoom Control 9 – 6

timeline
for DVD authoring 15 – 9

Timeline Markers
see Markers 9 – 32

Timeline Properties 9 – 7

Timeline Tracks
see Tracks 9 – 8

Timewarp (Linear) 12 – 45

Timewarp Editor 12 – 50

Adjust Scale 12 – 54
Cut/Mix Fields/Frames 12 – 64
Fit to Fill (Adjust to Length) 12 – 64
Freeze (Still) 12 – 63
Individual Applications 12 – 66
Introduction, Examples 12 – 55
Large Display 12 – 54
linearize/delinearize segment 12 – 53
Locate Keyframe 12 – 54
Motion Detection 12 – 65
Move segment 12 – 54
Open and use 12 – 51
Position Bars 12 – 54
Progressive 12 – 65
Render Options 12 – 64
Reverse Playback 12 – 63
Set and edit keyframes 12 – 53
Slow Motion 12 – 62
Standard Applications 12 – 62
Strobe Effect 12 – 65

Trailing 12 – 65

Timing rate Glossary G – 39

Title Clip
Safe Action Area 10 – 22

Titles (DVD) 15 – 8

Tone Balance (Primary Color Correc-
tion) 12 – 35

Tool Box (Customize) 17 – 9

Toolbars (Customize) 17 – 8

Tools, Tool Buttons and Toolbars 
(Basics) 3 – 5

Top-level menu (DVD) 15 – 8

Track Headers 9 – 11

Audio Playback 9 – 12

Matte Track 9 – 11

Source Track Mapping 9 – 11

Subtrack 9 – 11

Sync Lock 9 – 11

Track Name 9 – 12

Video Playback 9 – 12

Track Matte
working with Matte Track and Track 
Matte 9 – 108

Track type
Audio Mixer 13 – 23

Output Mapping 13 – 34

Tracking Glossary G – 39

Tracks 9 – 8

Add Matte Track 9 – 18

Assign (Audio) 13 – 8

Clip Display 9 – 14

Configure 9 – 13

Delete 9 – 18

Duplicate 9 – 18

Edit Active 9 – 17

Grouped Video and Audio 9 – 23

Headers 9 – 11

Height 9 – 16

Mappings Enabled/Disabled 9 – 23

Mute (Audio Playback Off) 13 – 11

Protect 9 – 17

Selecting Objects 9 – 57

Shortcut Menu 9 – 8
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Slice Numbers 9 – 9

Source Track Mapping 9 – 22

Track Priority 9 – 21

Video / Audio Playback 9 – 12

Trailing
Linear Timewarp 12 – 48

Timewarp Editor 12 – 65

Transfer Mode
Background/Foreground (FX Editors) 

10 – 42

Transition Glossary G – 39

Preview 11 – 6

Transition Effects 10 – 5, 10 – 40

2D Editor 10 – 42

3D Editor 10 – 57

Background / Foreground 10 – 41

Creating 
a Transition Motion FX 10 – 47

Creating a Transition Wipe FX 10 – 54

Editors 10 – 12

Leeway 9 – 36

Outgoing/Incoming Clip 10 – 40

Pattern (Wipe Editor) 10 – 53

Swap Sources 10 – 31

Trailing 10 – 46

Wipe Editor 10 – 52

Transition Menu (DVD) 15 – 24

Transparency 10 – 46

Backside image 10 – 68

Effect Editor, Border Tool 10 – 44

Effect Editor, Shadow Tool 10 – 45

Effect Editor, Trailing Tool 10 – 46

Key Mask 10 – 76

Softness 10 – 46

Trash (Desktop) 3 – 20

Clean up Project 3 – 20

Delete Render Files 3 – 20

Empty Trash 3 – 20

Open 3 – 20

Paste 3 – 20

Tree Area (Project) 8 – 7

Triangle (Generate Signal Clip) 6 – 59

Trim Both (Trim Editor) 9 – 75

Trim Editor
Digital Audio Scrub 9 – 73

Jump from Edit to Edit 9 – 76

Multiple Trimming Points 9 – 74

Preview 9 – 71

Preview Range 9 – 77

Selecting Trim Mode 9 – 72

show only full result 9 – 77

Single Trim 9 – 74

Slip Clip 9 – 75

Tool Buttons 9 – 76

Trim Both 9 – 72, 9 – 75

Trim Incoming Clip 9 – 72

Trim Mode 9 – 72

Trim Outgoing Clip 9 – 72

Trimming (Examples) 9 – 74

Trimming Glossary G – 39

Trimming on the Timeline
see also Timeline Editing
Examples 9 – 89

Extend Tool 9 – 61

Several Objects Simultaneously 9 – 93

Simultaneously Trimming Several Ob-
jects 9 – 93

Single Trim in Film Style 9 – 90

Single Trim in Overwrite Style 9 – 91

Slide Tool 9 – 61

Slip Clip 9 – 92

Trim Both 9 – 92

Trimming Transitions 9 – 93

Trimming with the Trim Editor (Exam-
ples) 9 – 94

Trust Media Meta Data 6 – 51

U
U-matic Glossary G – 39

Unbalanced Glossary G – 39

Underscan Glossary G – 39

Clip Viewer (Source Viewer) 8 – 56

Undo History 9 – 33

Undo/Redo 8 – 30

Used clips 8 – 16

User
Comments (Login) 4 – 6

Details 4 – 6

Existing User 4 – 3

Login 4 – 2

Password (Login) 4 – 7

Remove User (Login) 4 – 8

Settings (Overview) 17 – 3

User Profile 17 – 3

Load 4 – 5

Save 4 – 8

V
VBR (Variable Bit Rate) 16 – 38

VCD (DVD Export) 16 – 28

VCR Glossary G – 39

VCR (Video tool option) 6 – 20

Vector Display 12 – 19

Vector-based Glossary G – 39

Vectorlight Display (Color Correction 
Editor) 12 – 23

Ventriculation Glossary G – 40

Verify Imported Media (Project) 8 – 39

Verify Media (imported) 8 – 39

VHS Glossary G – 40

Video bit rate
IPB Settings 16 – 37

Video CD 16 – 28

Video Content 
(Scene Detection) 8 – 94

Video Data
Export 16 – 11

Video Effects 10 – 4

Video Mix Down (OMFI) 7 – 33

Video Object (VOB) 16 – 29

Video Server Glossary G – 40

Video Tool 6 – 20

Video-8 Glossary G – 40
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View
Detail View 8 – 31

Picon View 8 – 34

View alpha channel 10 – 19

View Switcher (Taskbar) 3 – 13

Viewing
see Logging 6 – 4

VITC Glossary G – 40

VOB Glossary G – 40

VOB problem (DVD) 15 – 27

VOB, export 16 – 29

Voice-Over 13 – 65

Control Input 13 – 66

Requirements 13 – 65

Session Procedure 13 – 65

using the blue.Box 13 – 66

Volume Lines
Edit (Rubberbanding) 13 – 27

Show 13 – 6

VST PlugIns 13 – 76

W
Water Drop (realtime effect) 11 – 32

Water Wave (realtime effect) 11 – 32

WAV Glossary G – 40

48 to 44.1 kHz, Convert 16 – 12

Downsampling 48 > 44.1 kHz 16 – 12

Export (48 or 44.1 kHz) 16 – 10

Waveform
Display in Audio Clip 13 – 7

Stereo Indicator 13 – 7

Waveform Display (Color Correction 
Editor) 12 – 20

Waveform Inlay 
(Clip/Source Viewer) 8 – 59

Wedge Wipe (realtime effect) 11 – 39

White-Balancing (Subsequent) 12 – 32

Windows Media Video/Audio 16 – 10

Wipe (realtime effect) 11 – 39

Wipe Editor
Circle 10 – 53

Clips 10 – 69

Creating a Transition Wipe FX 10 – 54

Pattern 10 – 53

Rectangle 10 – 53

Transitions 10 – 52

Workstation Glossary G – 40

WORM Glossary G – 40

X
X, Y, Z Position (Camera) 10 – 65

XLR Glossary G – 40

XML/ALE Import/Export of 
Projects 7 – 3

XReceive 7 – 14

XSend to... 7 – 9

Calling 7 – 10

Compatible Programs (Other) 7 – 11

Flash (Macromedia) 7 – 11

Location 7 – 10

Location (MPEG2-IPB) 7 – 11

Objects for XSend 7 – 9

Options 7 – 12

Using Adobe AfterEffects 7 – 13

Vortex (playlist, single file) 7 – 11

Y
Y, Cr, CB Glossary G – 41

Y, R-Y, B-Y Glossary G – 41

Y/C Glossary G – 40

YUV Glossary G – 41

Color Space 12 – 10

Z
Z Position 10 – 66

Zoom (Effect Viewer) 10 – 17

Zoom Control (Timeline) 9 – 6
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